Evergreen Documentation

Documentation Interest Group
## Table of Contents

1. Introduction .................................................................................................................. 16
   1. About This Documentation .................................................................................. 18
   2. About Evergreen ................................................................................................. 19

II. Evergreen 3.1 Release Notes ..................................................................................... 20
   3. Evergreen 3.1.16 .................................................................................................. 24
      Bug Fixes .................................................................................................................. 24
      Acknowledgements ................................................................................................. 24
   4. Evergreen 3.1.15 .................................................................................................. 26
      Security Issue: XSS Vulnerability in Public Catalog ................................................. 26
      Other Bugfixes ......................................................................................................... 26
      Acknowledgements ................................................................................................. 27
   5. Evergreen 3.1.14 .................................................................................................. 28
      Bug Fixes .................................................................................................................. 28
      Acknowledgements ................................................................................................. 29
   6. Evergreen 3.1.13 .................................................................................................. 30
      Bug Fixes .................................................................................................................. 30
      Acknowledgements ................................................................................................. 31
   7. Evergreen 3.1.12 .................................................................................................. 33
      Bug Fixes .................................................................................................................. 33
      Acknowledgements ................................................................................................. 33
   8. Evergreen 3.1.11 .................................................................................................. 35
      Bug Fixes .................................................................................................................. 35
      Acknowledgements ................................................................................................. 35
   9. Evergreen 3.1.10 .................................................................................................. 37
      Bug Fixes .................................................................................................................. 37
      Acknowledgements ................................................................................................. 37
   10. Evergreen 3.1.9 .................................................................................................... 39
      Bug Fixes .................................................................................................................. 39
      Acknowledgements ................................................................................................. 39
   11. Evergreen 3.1.8 .................................................................................................... 41
      Bug Fixes .................................................................................................................. 41
      Acknowledgements ................................................................................................. 42
   12. Evergreen 3.1.7 .................................................................................................... 43
      Bug Fixes .................................................................................................................. 43
      Acknowledgements ................................................................................................. 43
   13. Evergreen 3.1.6 .................................................................................................... 45
      Bug Fixes .................................................................................................................. 45
      Acknowledgements ................................................................................................. 46
   14. Evergreen 3.1.5 .................................................................................................... 48
      Bug Fixes .................................................................................................................. 48
      Acknowledgements ................................................................................................. 48
   15. Evergreen 3.1.4 .................................................................................................... 50
      Bug Fixes .................................................................................................................. 50
      Acknowledgements ................................................................................................. 51
   16. Evergreen 3.1.3 .................................................................................................... 52
      Bug Fixes .................................................................................................................. 52
      Acknowledgements ................................................................................................. 52
   17. Evergreen 3.1.2 .................................................................................................... 54
      Bug Fixes .................................................................................................................. 54
      Acknowledgements ................................................................................................. 56
   18. Evergreen 3.1.1 .................................................................................................... 59
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgements</td>
<td>59</td>
</tr>
<tr>
<td>19. 3.1.0 Upgrade Notes</td>
<td>60</td>
</tr>
<tr>
<td>20. 3.1.0 New Features</td>
<td>61</td>
</tr>
<tr>
<td>Administration</td>
<td>61</td>
</tr>
<tr>
<td>Architecture</td>
<td>61</td>
</tr>
<tr>
<td>Cataloging</td>
<td>63</td>
</tr>
<tr>
<td>Circulation</td>
<td>64</td>
</tr>
<tr>
<td>Public Catalog</td>
<td>66</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>67</td>
</tr>
<tr>
<td>21. 3.1.0 Acknowledgments</td>
<td>69</td>
</tr>
<tr>
<td>III. Software Installation</td>
<td>71</td>
</tr>
<tr>
<td>22. Introduction</td>
<td>73</td>
</tr>
<tr>
<td>23. System Requirements</td>
<td>74</td>
</tr>
<tr>
<td>Server Minimum Requirements</td>
<td>74</td>
</tr>
<tr>
<td>Web Client Requirements</td>
<td>74</td>
</tr>
<tr>
<td>Staff Client Requirements</td>
<td>74</td>
</tr>
<tr>
<td>24. Installing the Evergreen server</td>
<td>75</td>
</tr>
<tr>
<td>Preamble: referenced user accounts</td>
<td>75</td>
</tr>
<tr>
<td>Preamble: developer instructions</td>
<td>75</td>
</tr>
<tr>
<td>Installing prerequisites</td>
<td>76</td>
</tr>
<tr>
<td>Extra steps for web staff client</td>
<td>77</td>
</tr>
<tr>
<td>Configuration and compilation instructions</td>
<td>77</td>
</tr>
<tr>
<td>Installation instructions</td>
<td>78</td>
</tr>
<tr>
<td>Change ownership of the Evergreen files</td>
<td>78</td>
</tr>
<tr>
<td>Run ldconfig</td>
<td>78</td>
</tr>
<tr>
<td>Additional Instructions for Developers</td>
<td>78</td>
</tr>
<tr>
<td>Configure the Apache Web server</td>
<td>79</td>
</tr>
<tr>
<td>Configure OpenSRF for the Evergreen application</td>
<td>80</td>
</tr>
<tr>
<td>Configure action triggers for the Evergreen application</td>
<td>81</td>
</tr>
<tr>
<td>Creating the Evergreen database</td>
<td>81</td>
</tr>
<tr>
<td>Starting Evergreen</td>
<td>83</td>
</tr>
<tr>
<td>Testing connections to Evergreen</td>
<td>83</td>
</tr>
<tr>
<td>Getting help</td>
<td>84</td>
</tr>
<tr>
<td>License</td>
<td>84</td>
</tr>
<tr>
<td>25. Upgrading the Evergreen Server</td>
<td>85</td>
</tr>
<tr>
<td>Software Prerequisites</td>
<td>85</td>
</tr>
<tr>
<td>Upgrade the Evergreen code</td>
<td>85</td>
</tr>
<tr>
<td>Upgrade the Evergreen database schema</td>
<td>87</td>
</tr>
<tr>
<td>Restart Evergreen and Test</td>
<td>89</td>
</tr>
<tr>
<td>Review Release Notes</td>
<td>90</td>
</tr>
<tr>
<td>26. Setting Up EDI Acquisitions</td>
<td>91</td>
</tr>
<tr>
<td>Introduction</td>
<td>91</td>
</tr>
<tr>
<td>Installation</td>
<td>91</td>
</tr>
<tr>
<td>Configuration</td>
<td>92</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>93</td>
</tr>
<tr>
<td>IV. System Configuration and Customization</td>
<td>95</td>
</tr>
<tr>
<td>27. Introduction</td>
<td>100</td>
</tr>
<tr>
<td>28. Describing your organization</td>
<td>101</td>
</tr>
<tr>
<td>Organization Unit Types</td>
<td>101</td>
</tr>
<tr>
<td>Organizational Units</td>
<td>101</td>
</tr>
<tr>
<td>29. Describing your people</td>
<td>103</td>
</tr>
<tr>
<td>Setting the staff user’s working location</td>
<td>103</td>
</tr>
<tr>
<td>Comparing approaches for managing permissions</td>
<td>104</td>
</tr>
<tr>
<td>Managing permissions in the staff client</td>
<td>105</td>
</tr>
</tbody>
</table>
30. Migrating Patron Data .................................................. 112
   Introduction .............................................................. 112
   Batch Updating Patron Data ......................................... 114
   Batch Updating Patron Data ......................................... 115
31. Migrating from a legacy system .................................... 116
   Introduction .............................................................. 116
   Migrating your bibliographic records .............................. 117
   Migrating your call numbers, copies, and parts .................. 118
32. Importing materials in the staff client ............................ 121
   Staff client batch record imports .................................. 121
33. Ordering materials ..................................................... 127
   Introduction .............................................................. 127
   When should libraries use acquisitions? ......................... 127
   Managing Funds ......................................................... 127
   Ordering ................................................................. 129
34. Designing your catalog ............................................... 133
   Configuring and customizing the public interface .............. 133
   Setting the default physical location for your library environment .................................................. 137
   Setting a default language and adding optional languages .................................................. 138
   Change Date Format in Patron Account View ..................... 139
   Including External Content in Your Public Interface ......... 139
   Including Locally Hosted Content in Your Public Interface .................................................. 144
35. Designing the patron search experience ........................... 146
   Editing the formats select box options in the search interface .................................................. 146
   Adding and removing search fields in advanced search ........ 147
   Changing the display of facets and facet groups ............... 147
   Facilitating search scope changes ................................. 148
36. Borrowing items: who, what, for how long ........................ 149
   Data elements that affect your circulation policies ............ 149
   Circulation Rules ....................................................... 150
   Creating Circulation Policies ....................................... 154
37. Hard due dates ......................................................... 158
   Creating a hard due date ............................................. 158
38. TPAC Configuration and Customization ............................ 160
   Template toolkit documentation .................................. 160
   TPAC URL ................................................................ 160
   Perl modules used directly by TPAC ............................... 160
   Default templates ....................................................... 160
   Apache configuration files ......................................... 160
   TPAC CSS and media files ........................................... 161
   Mapping templates to URLs ....................................... 161
   How to override templates ......................................... 161
   Changing some text in the TPAC ................................... 163
   Troubleshooting ......................................................... 164
39. Creating a New Skin: the Bare Minimum .......................... 165
   Introduction .............................................................. 165
   Apache directives ....................................................... 165
   Customizing templates .............................................. 165
40. Auto Suggest in Catalog Search .................................... 168
   Enabling this Feature .................................................. 168
   Using this Feature ...................................................... 168
VI. System Administration From the Staff Client

57. Introduction ................................................................. 233
58. Acquisitions Administration ............................................. 238
   Acquisitions Settings ................................................. 238
   Cancel/Delay reasons ................................................. 238
   Claiming ................................................................. 239
   Currency Types ......................................................... 241
   Distribution Formulas ................................................. 242
   Electronic Data Interchange ......................................... 243
   Exchange Rates ......................................................... 248
   MARC Federated Search ................................................. 249
   Fund Tags ................................................................. 250
   Funding Sources ......................................................... 251
   Funds ................................................................. 252
   Invoice menus ......................................................... 256
   Line Item Features ..................................................... 257
   Providers ................................................................. 258
59. Age hold protection ..................................................... 261
   Active date display in OPAC ........................................... 261
60. Authorities ................................................................. 262
   Authority Control Sets ............................................... 262
   Thesauri ................................................................. 263
   Authority Fields ......................................................... 264
   Browse Axes .............................................................. 266
61. Best-Hold Selection Sort Order ......................................... 268
   Preconfigured Best-Hold Orders ..................................... 268
   Create a New Best-Hold Selection Sort Order ....................... 268
   Edit an Existing Best-Hold Selection Sort Order ................... 269
   Choosing the Best-Hold Selection Sort Order ....................... 269
   Permissions to use this Feature ...................................... 270
62. Booking Module Administration ....................................... 271
   Creating Bookable Non-Bibliographic Resources .................... 271
   Editing Non-Bibliographic Resources ................................ 278
   Deleting Non-bibliographic Resources ................................ 279
63. Call Number Prefixes and Suffixes ................................... 280
   Configure call number prefixes ..................................... 280
   Configure call number suffixes ...................................... 281
   Apply Call Number Prefixes and Suffixes ........................... 281
64. Cash Reports ............................................................... 282
65. Circulation Limit Sets .................................................. 283
   Maximum Checkout by Copy Location .................................. 283
66. Copy Status ............................................................... 286
   Adding Copy Statuses .................................................. 287
   Deleting Copy Statuses ............................................... 288
   Editing Copy Statuses ................................................ 288
67. Floating Groups .......................................................... 289
   Floating Groups ........................................................ 289
   Examples ............................................................... 290
68. MARC Import Remove Fields ........................................... 293
   Create a MARC Import Remove Fields profile ....................... 293
   Import Options ......................................................... 294
   Permissions to use this Feature ...................................... 296
69. Copy Tags (Digital Bookplates) ......................................... 297
   Administration ......................................................... 297
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>70. MARC Record Attributes</td>
<td>300</td>
</tr>
<tr>
<td>Managing Fixed Field Drop-down Context Menus</td>
<td>300</td>
</tr>
<tr>
<td>Multi Valued Fields and Composite Record Attributes</td>
<td>300</td>
</tr>
<tr>
<td>Multilingual Search in Evergreen</td>
<td>307</td>
</tr>
<tr>
<td>Infrastructure Changes to Authority Browse</td>
<td>309</td>
</tr>
<tr>
<td>Virtual Index Definitions</td>
<td>310</td>
</tr>
<tr>
<td>71. Org Unit Proximity Adjustments</td>
<td>313</td>
</tr>
<tr>
<td>Org Unit Proximity Adjustments</td>
<td>313</td>
</tr>
<tr>
<td>Absolute and Relative Adjustments</td>
<td>314</td>
</tr>
<tr>
<td>Create an Org Unit Proximity Adjustment</td>
<td>314</td>
</tr>
<tr>
<td>Permissions to use this Feature</td>
<td>315</td>
</tr>
<tr>
<td>72. Administering the Physical Characteristics Wizard</td>
<td>316</td>
</tr>
<tr>
<td>73. User and Group Permissions</td>
<td>317</td>
</tr>
<tr>
<td>Staff Accounts</td>
<td>317</td>
</tr>
<tr>
<td>74. SMS Text Messaging</td>
<td>321</td>
</tr>
<tr>
<td>Administrative Setup</td>
<td>321</td>
</tr>
<tr>
<td>Receiving Holds Notices via Text Message</td>
<td>324</td>
</tr>
<tr>
<td>Sending Copy Details via Text Message</td>
<td>325</td>
</tr>
<tr>
<td>75. User Activity Types</td>
<td>328</td>
</tr>
<tr>
<td>Enabling this Feature</td>
<td>328</td>
</tr>
<tr>
<td>Using this Feature</td>
<td>328</td>
</tr>
<tr>
<td>76. Z39.50 Servers</td>
<td>330</td>
</tr>
<tr>
<td>Restrict Z39.50 Sources by Permission Group</td>
<td>330</td>
</tr>
<tr>
<td>Storing Z39.50 Server Credentials</td>
<td>332</td>
</tr>
<tr>
<td>VII. Local Administration</td>
<td>333</td>
</tr>
<tr>
<td>77. Introduction</td>
<td>336</td>
</tr>
<tr>
<td>78. Library Settings Editor</td>
<td>337</td>
</tr>
<tr>
<td>Introduction</td>
<td>337</td>
</tr>
<tr>
<td>Editing Library Settings</td>
<td>337</td>
</tr>
<tr>
<td>Exporting/Importing Library Settings</td>
<td>338</td>
</tr>
<tr>
<td>Settings Overview</td>
<td>339</td>
</tr>
<tr>
<td>79. Address Alert</td>
<td>382</td>
</tr>
<tr>
<td>General Usage Examples</td>
<td>382</td>
</tr>
<tr>
<td>Access Control and Scoping</td>
<td>382</td>
</tr>
<tr>
<td>Adding a new Address Alert</td>
<td>382</td>
</tr>
<tr>
<td>Editing an Address Alert</td>
<td>383</td>
</tr>
<tr>
<td>Deleting an Address Alert</td>
<td>384</td>
</tr>
<tr>
<td>Staff View of Address Alerts</td>
<td>384</td>
</tr>
<tr>
<td>Regular Expressions / Wildcards</td>
<td>384</td>
</tr>
<tr>
<td>Examples</td>
<td>384</td>
</tr>
<tr>
<td>Development</td>
<td>385</td>
</tr>
<tr>
<td>80. Barcode Completion</td>
<td>386</td>
</tr>
<tr>
<td>Scoping and Permissions</td>
<td>386</td>
</tr>
<tr>
<td>Access Points</td>
<td>386</td>
</tr>
<tr>
<td>Multiple Matches</td>
<td>388</td>
</tr>
<tr>
<td>Barcode Completion Data Fields</td>
<td>389</td>
</tr>
<tr>
<td>Create, Update, Filter, Delete/Disable Rules</td>
<td>390</td>
</tr>
<tr>
<td>Examples</td>
<td>391</td>
</tr>
<tr>
<td>Testing</td>
<td>393</td>
</tr>
<tr>
<td>81. Hold-driven recalls</td>
<td>394</td>
</tr>
<tr>
<td>Enabling hold-driven recalls</td>
<td>394</td>
</tr>
<tr>
<td>Editing the item recall notification email template</td>
<td>394</td>
</tr>
</tbody>
</table>
82. Notifications / Action Triggers ................................................................. 395
   Introduction ......................................................................................... 395
   Event Definitions ................................................................................. 395
   Creating Action Triggers ................................................................... 396
   Processing Action Triggers ................................................................. 400
83. Recent Staff Searches ........................................................................ 402
   Administrative Settings ......................................................................... 402
   Recent Staff Searches ........................................................................ 403
84. Standing Penalties ................................................................................ 404
85. Statistical Categories Editor ............................................................... 405
86. Statistical Popularity Badges ............................................................... 409
   Popularity Rating and Calculation ..................................................... 409
   Creating Popularity Badges ................................................................. 409
   New Global Flags ............................................................................... 412
   Sorting by Popularity in the OPAC ...................................................... 412
   Popularity Badge Example .................................................................. 413
87. Work Log ............................................................................................. 416
   Expanding the Work Log ..................................................................... 416
VIII. Acquisitions ...................................................................................... 417
88. Acquisitions ......................................................................................... 419
   Initial Configuration ............................................................................ 419
   Acquisitions Workflow ......................................................................... 419
89. Selection Lists and Purchase Orders ................................................... 421
   Selection Lists .................................................................................... 421
   Purchase Orders .................................................................................. 423
   Brief Records ...................................................................................... 423
   MARC Federated Search ....................................................................... 428
   Line Items ............................................................................................ 429
90. Invoices ................................................................................................. 431
   Introduction ......................................................................................... 431
   Creating invoices and adding line items ............................................ 433
   Electronic Invoicing ............................................................................ 433
   View an invoice .................................................................................. 441
   Receive Items From an Invoice ............................................................ 441
91. Load MARC Order Records ................................................................. 442
   Introduction ......................................................................................... 442
   Basic Upload Options ......................................................................... 447
   Record Matching Options ................................................................... 447
   Default Upload Settings ....................................................................... 448
   Sticky Settings ................................................................................... 449
   Use Cases for MARC Order Upload form ............................................ 450
92. Placing purchase requests from a patron record .................................... 455
93. Managing patron purchase requests .................................................... 456
   Introduction ......................................................................................... 456
   Adding a request .................................................................................. 456
   Adding requests to selection lists ....................................................... 456
94. "Blanket" Orders ................................................................................... 458
   Example .............................................................................................. 458
   More details about blanket orders ....................................................... 458
IX. Cataloging ............................................................................................. 459
95. Introduction ........................................................................................ 460
96. Copy Buckets ....................................................................................... 463
   Managing Copy Buckets ....................................................................... 464
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Copies to a Bucket</td>
<td>469</td>
</tr>
<tr>
<td>Removing Copies from a Bucket</td>
<td>473</td>
</tr>
<tr>
<td>Editing Copies in a Bucket</td>
<td>473</td>
</tr>
<tr>
<td>Deleting Copies from the Catalog</td>
<td>475</td>
</tr>
<tr>
<td>Placing Holds on Copies in a Bucket</td>
<td>476</td>
</tr>
<tr>
<td>Transferring Copies to Volumes</td>
<td>478</td>
</tr>
<tr>
<td><strong>97. Copy Tags</strong></td>
<td></td>
</tr>
<tr>
<td>Adding Existing Copy Tags to Copies</td>
<td>481</td>
</tr>
<tr>
<td>Creating and Applying a Copy Tag During Cataloging</td>
<td>482</td>
</tr>
<tr>
<td>Removing Copy Tags from Copies</td>
<td>482</td>
</tr>
<tr>
<td>Adding Copy Tags to Copies in Batch</td>
<td>483</td>
</tr>
<tr>
<td>Searching Copy Tags</td>
<td>483</td>
</tr>
<tr>
<td><strong>98. Working with the MARC Editor</strong></td>
<td></td>
</tr>
<tr>
<td>Editing MARC Records</td>
<td>486</td>
</tr>
<tr>
<td><strong>99. Record Buckets</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>490</td>
</tr>
<tr>
<td>Creating Record Buckets</td>
<td>490</td>
</tr>
<tr>
<td>Adding Records to a Bucket</td>
<td>490</td>
</tr>
<tr>
<td><strong>100. MARC 007 Field Physical Characteristics Wizard</strong></td>
<td></td>
</tr>
<tr>
<td><strong>101. Return to Search Results from MARC Record</strong></td>
<td></td>
</tr>
<tr>
<td><strong>102. Batch Importing MARC Records</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>497</td>
</tr>
<tr>
<td>Permissions</td>
<td>497</td>
</tr>
<tr>
<td>Record Display Attributes</td>
<td>497</td>
</tr>
<tr>
<td>Record Match Sets</td>
<td>497</td>
</tr>
<tr>
<td>Merge/Overlay Profiles</td>
<td>501</td>
</tr>
<tr>
<td>Import Item Attributes</td>
<td>502</td>
</tr>
<tr>
<td>Import Records</td>
<td>504</td>
</tr>
<tr>
<td>Default Values for Item Import</td>
<td>510</td>
</tr>
<tr>
<td><strong>103. Overlay Existing Catalog Record via Z39_50 Import</strong></td>
<td></td>
</tr>
<tr>
<td><strong>104. Z39_50 Search Enhancements</strong></td>
<td></td>
</tr>
<tr>
<td><strong>105. Monograph Parts</strong></td>
<td></td>
</tr>
<tr>
<td>Add a Monograph Part to an Existing Record</td>
<td>520</td>
</tr>
<tr>
<td>Monograph Part Merging</td>
<td>523</td>
</tr>
<tr>
<td><strong>106. Conjoined Items</strong></td>
<td></td>
</tr>
<tr>
<td>Using the Conjoined Items Feature</td>
<td>525</td>
</tr>
<tr>
<td><strong>107. Cataloging Electronic Resources — Finding Them in Catalog Searches</strong></td>
<td></td>
</tr>
<tr>
<td>Adding a Located URI to the Record</td>
<td>530</td>
</tr>
<tr>
<td>Using Transcendant Bib Sources for Electronic Resources</td>
<td>532</td>
</tr>
<tr>
<td><strong>108. Using the Item Status interface</strong></td>
<td></td>
</tr>
<tr>
<td>Accessing the Item Status interface</td>
<td>534</td>
</tr>
<tr>
<td>Specific fields</td>
<td>534</td>
</tr>
<tr>
<td>Printing spine labels</td>
<td>535</td>
</tr>
<tr>
<td><strong>109. Using the Volume/Copy Editor</strong></td>
<td></td>
</tr>
<tr>
<td>Specific fields</td>
<td>537</td>
</tr>
<tr>
<td>Accessing the Volume/Copy Editor by barcode</td>
<td>537</td>
</tr>
<tr>
<td>Accessing the Volume/Copy editor from a catalog record</td>
<td>537</td>
</tr>
<tr>
<td><strong>10. MARC Batch Edit</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>539</td>
</tr>
<tr>
<td>Setting Up a Batch Edit Session</td>
<td>539</td>
</tr>
<tr>
<td>Examples</td>
<td>540</td>
</tr>
<tr>
<td><strong>11. Managing Authorities</strong></td>
<td></td>
</tr>
<tr>
<td>Introduction</td>
<td>542</td>
</tr>
<tr>
<td>Creating Authorities</td>
<td>542</td>
</tr>
<tr>
<td>127. Booking Module</td>
<td>638</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Creating a Booking Reservation</td>
<td>638</td>
</tr>
<tr>
<td>Reservation Pull List</td>
<td>648</td>
</tr>
<tr>
<td>Capturing Items for Reservations</td>
<td>650</td>
</tr>
<tr>
<td>Picking Up Reservations</td>
<td>651</td>
</tr>
<tr>
<td>Returning Reservations</td>
<td>652</td>
</tr>
<tr>
<td>Cancelling a Reservation</td>
<td>654</td>
</tr>
<tr>
<td>128. Circulation - Patron Record</td>
<td>656</td>
</tr>
<tr>
<td>Searching Patrons</td>
<td>656</td>
</tr>
<tr>
<td>Retrieve Recent Patrons</td>
<td>658</td>
</tr>
<tr>
<td>Registering New Patrons</td>
<td>658</td>
</tr>
<tr>
<td>Patron Self-Registration</td>
<td>660</td>
</tr>
<tr>
<td>Updating Patron Information</td>
<td>661</td>
</tr>
<tr>
<td>Renewing Library Cards</td>
<td>662</td>
</tr>
<tr>
<td>Lost Library Cards</td>
<td>664</td>
</tr>
<tr>
<td>Resetting Patron’s Password</td>
<td>665</td>
</tr>
<tr>
<td>Barring a Patron</td>
<td>666</td>
</tr>
<tr>
<td>Barred vs. Blocked</td>
<td>666</td>
</tr>
<tr>
<td>Staff-Generated Messages</td>
<td>667</td>
</tr>
<tr>
<td>Patron Alerts</td>
<td>667</td>
</tr>
<tr>
<td>Patron Notes</td>
<td>669</td>
</tr>
<tr>
<td>Staff-Generated Penalties/Messages</td>
<td>670</td>
</tr>
<tr>
<td>User Baskets</td>
<td>674</td>
</tr>
<tr>
<td>129. Patron self-registration administration</td>
<td>683</td>
</tr>
<tr>
<td>Library Settings</td>
<td>683</td>
</tr>
<tr>
<td>130. Triggered Events and Notices</td>
<td>685</td>
</tr>
<tr>
<td>Introduction</td>
<td>685</td>
</tr>
<tr>
<td>Access and View</td>
<td>685</td>
</tr>
<tr>
<td>Filter</td>
<td>686</td>
</tr>
<tr>
<td>Sort</td>
<td>686</td>
</tr>
<tr>
<td>Print</td>
<td>687</td>
</tr>
<tr>
<td>Reset</td>
<td>687</td>
</tr>
<tr>
<td>131. Offline Circulation</td>
<td>688</td>
</tr>
<tr>
<td>Introduction</td>
<td>688</td>
</tr>
<tr>
<td>Using Offline Circulation</td>
<td>688</td>
</tr>
<tr>
<td>Checkout</td>
<td>689</td>
</tr>
<tr>
<td>Renew</td>
<td>690</td>
</tr>
<tr>
<td>In-House Use</td>
<td>691</td>
</tr>
<tr>
<td>Checkin</td>
<td>691</td>
</tr>
<tr>
<td>Patron Registration</td>
<td>692</td>
</tr>
<tr>
<td>Managing Offline Transactions</td>
<td>693</td>
</tr>
<tr>
<td>132. Self checkout</td>
<td>698</td>
</tr>
<tr>
<td>Introduction</td>
<td>698</td>
</tr>
<tr>
<td>Initializing the self check</td>
<td>698</td>
</tr>
<tr>
<td>Basic Check Out</td>
<td>698</td>
</tr>
<tr>
<td>View Items Out</td>
<td>700</td>
</tr>
<tr>
<td>View Holds</td>
<td>701</td>
</tr>
<tr>
<td>View Fines</td>
<td>702</td>
</tr>
<tr>
<td>XII. Reports</td>
<td>704</td>
</tr>
<tr>
<td>133. Introduction</td>
<td>706</td>
</tr>
<tr>
<td>134. Starting and Stopping the Reporter Daemon</td>
<td>707</td>
</tr>
<tr>
<td>Starting the Reporter Daemon</td>
<td>707</td>
</tr>
<tr>
<td>Stopping the Reporter Daemon</td>
<td>707</td>
</tr>
<tr>
<td>135. Folders</td>
<td>709</td>
</tr>
</tbody>
</table>
XIII. Using the Public Access Catalog

145. Introduction .................................................. 751

146. Using the Public Access Catalog

  Basic Search .................................................. 752
  Advanced Search ............................................... 754
  Boolean operators ............................................. 757
  Search Tips .................................................... 757
  Search Methodology ........................................... 758
  Search Results ................................................ 759
  Details ........................................................ 763

147. My Lists ..................................................... 768

  Create New Lists ............................................... 768
  Local Call Number in My Lists ............................... 770
  My Lists Preferences ......................................... 771

148. Kids OPAC .................................................. 772

  Introduction .................................................. 772
  Choose a Skin .................................................. 772
  Search the Catalog ............................................ 773
  Place a Hold ................................................... 777
  Save Items to a List ......................................... 780
  Third Party Content .......................................... 782
  Configuration Files ............................................ 784

149. Catalog Browse ............................................ 785

150. Bibliographic Search Enhancements ......................... 786

  Use the Catalog to Retrieve Records with Specified Date Ranges: .............................................. 786
  Use a Feed to Retrieve Records with Specified Date Ranges: .................................................. 787

151. Binary MARC21 Feeds ....................................... 788

152. TPAC Metarecord Search and Metarecord Level Holds ................................................................. 789

153. Library Information Pages ................................ 794

154. Adding Evergreen Search to Web Browsers ............... 795

  Adding OpenSearch to Firefox browser ........................ 795
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>XIV.</td>
<td>Developer Resources</td>
<td>799</td>
</tr>
<tr>
<td>156.</td>
<td>Introduction</td>
<td>801</td>
</tr>
<tr>
<td>157.</td>
<td>Support Scripts</td>
<td>802</td>
</tr>
<tr>
<td></td>
<td>authority_control_fields: Connecting Bibliographic and Authority records</td>
<td>803</td>
</tr>
<tr>
<td></td>
<td>marc_export: Exporting Bibliographic Records into MARC files</td>
<td>803</td>
</tr>
<tr>
<td></td>
<td>Importing Authority Records from Command Line</td>
<td>805</td>
</tr>
<tr>
<td></td>
<td>Juvenile-to-adult batch script</td>
<td>806</td>
</tr>
<tr>
<td></td>
<td>MARC Stream Importer</td>
<td>806</td>
</tr>
<tr>
<td>158.</td>
<td>Developing with pgTAP tests</td>
<td>808</td>
</tr>
<tr>
<td></td>
<td>Setting up pgTAP on your development server</td>
<td>808</td>
</tr>
<tr>
<td></td>
<td>Running pgTAP tests</td>
<td>808</td>
</tr>
<tr>
<td>159.</td>
<td>Easing gently into OpenSRF</td>
<td>809</td>
</tr>
<tr>
<td></td>
<td>Abstract</td>
<td>809</td>
</tr>
<tr>
<td></td>
<td>Introducing OpenSRF</td>
<td>809</td>
</tr>
<tr>
<td></td>
<td>Enough jibber-jabber: writing an OpenSRF service</td>
<td>814</td>
</tr>
<tr>
<td></td>
<td>Getting under the covers with OpenSRF</td>
<td>826</td>
</tr>
<tr>
<td></td>
<td>Evergreen-specific OpenSRF services</td>
<td>829</td>
</tr>
<tr>
<td></td>
<td>Evergreen after one year: reflections on OpenSRF</td>
<td>830</td>
</tr>
<tr>
<td></td>
<td>Summary</td>
<td>832</td>
</tr>
<tr>
<td></td>
<td>Appendix: Python client</td>
<td>832</td>
</tr>
<tr>
<td>160.</td>
<td>Updating translations using Launchpad</td>
<td>834</td>
</tr>
<tr>
<td></td>
<td>Prerequisites</td>
<td>834</td>
</tr>
<tr>
<td></td>
<td>Updating the translations</td>
<td>834</td>
</tr>
<tr>
<td>XV.</td>
<td>Getting Data from Evergreen</td>
<td>836</td>
</tr>
<tr>
<td>161.</td>
<td>Introduction</td>
<td>838</td>
</tr>
<tr>
<td>162.</td>
<td>Using Supercat</td>
<td>839</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>839</td>
</tr>
<tr>
<td></td>
<td>ISBNs</td>
<td>839</td>
</tr>
<tr>
<td></td>
<td>Records</td>
<td>840</td>
</tr>
<tr>
<td>163.</td>
<td>Using UnAPI</td>
<td>844</td>
</tr>
<tr>
<td></td>
<td>URL format</td>
<td>844</td>
</tr>
<tr>
<td>164.</td>
<td>Using Opensearch as a developer</td>
<td>846</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>846</td>
</tr>
<tr>
<td>A.</td>
<td>Attributions</td>
<td>847</td>
</tr>
<tr>
<td>B.</td>
<td>Licensing</td>
<td>849</td>
</tr>
<tr>
<td>C.</td>
<td>Admonitions</td>
<td>850</td>
</tr>
<tr>
<td>Index</td>
<td></td>
<td>851</td>
</tr>
</tbody>
</table>
List of Tables

31.1. 856 field for electronic resources: indicators and subfields ............................................................. 116
44.1. Parameters for the phonelist program .................................................................................................. 179
44.2. Columns in the holds CSV file: .......................................................................................................... 181
44.3. Columns in the overdues CSV file: ...................................................................................................... 182
56.1. List of Receipts .......................................................... 227
66.1. Stock copy statuses and default settings .............................................................................................. 286
78.1. Acquisitions ......................................................................................................................................... 339
78.2. Booking and Cataloging ....................................................................................................................... 341
78.3. Circulation ............................................................................................................................................ 344
78.4. Credit Card Processing ....................................................................................................................... 353
78.5. Finances ................................................................................................................................................ 354
78.6. GUI: Graphic User Interface ............................................................................................................... 357
78.7. Global .................................................................................................................................................. 364
78.8. Holds ................................................................................................................................................... 365
78.9. Library .................................................................................................................................................. 368
78.10. OPAC .................................................................................................................................................. 370
78.11. Offline and Program ............................................................................................................................ 373
78.12. Receipt Templates and SMS Text Message ....................................................................................... 375
78.13. Security ............................................................................................................................................... 376
78.14. Self Check and Others ......................................................................................................................... 378
78.15. Vandelay ............................................................................................................................................. 380
78.16. Data Types in the Library Settings Editor ........................................................................................... 381
79.1. New Address Alert Fields ..................................................................................................................... 383
80.1. Barcode Completion Fields .................................................................................................................. 389
99.1. Record Bucket search keys .................................................................................................................. 491
102.1. Holdings Import Profile Fields ........................................................................................................... 503
146.1. Boolean symbolic operators .............................................................................................................. 757
Part I. Introduction
# Table of Contents

1. About This Documentation ........................................................................................................... 18  
2. About Evergreen ....................................................................................................................... 19
Chapter 1. About This Documentation

This guide was produced by the Evergreen Documentation Interest Group (DIG), consisting of numerous volunteers from many different organizations. The DIG has drawn together, edited, and supplemented pre-existing documentation contributed by libraries and consortia running Evergreen that were kind enough to release their documentation into the creative commons. Please see the Attributions section for a full list of authors and contributing organizations. Just like the software it describes, this guide is a work in progress, continually revised to meet the needs of its users, so if you find errors or omissions, please let us know, by contacting the DIG facilitators at docs@evergreen-ils.org.

This guide to Evergreen is intended to meet the needs of front-line library staff, catalogers, library administrators, system administrators, and software developers. It is organized into Parts, Chapters, and Sections addressing key aspects of the software, beginning with the topics of broadest interest to the largest groups of users and progressing to some of the more specialized and technical topics of interest to smaller numbers of users.

Copies of this guide can be accessed in PDF and HTML formats from http://docs.evergreen-ils.org/.
Chapter 2. About Evergreen

Evergreen is an open source library automation software designed to meet the needs of the very smallest to the very largest libraries and consortia. Through its staff interface, it facilitates the management, cataloging, and circulation of library materials, and through its online public access interface it helps patrons find those materials.

The Evergreen software is freely licensed under the GNU General Public License, meaning that it is free to download, use, view, modify, and share. It has an active development and user community, as well as several companies offering migration, support, hosting, and development services.

The community’s development requirements state that Evergreen must be:

• Stable, even under extreme load.
• Robust, and capable of handling a high volume of transactions and simultaneous users.
• Flexible, to accommodate the varied needs of libraries.
• Secure, to protect our patrons’ privacy and data.
• User-friendly, to facilitate patron and staff use of the system.

Evergreen, which first launched in 2006 now powers over 544 libraries of every type – public, academic, special, school, and even tribal and home libraries – in over a dozen countries worldwide.
Part II. Evergreen 3.1 Release Notes
# Table of Contents

3. Evergreen 3.1.16
   - Bug Fixes .................................................................................................................... 24
   - Acknowledgements ..................................................................................................... 24

4. Evergreen 3.1.15
   - Security Issue: XSS Vulnerability in Public Catalog .............................................. 26
   - Other Bugfixes .......................................................................................................... 26
   - Circulation .................................................................................................................... 26
   - Reports ....................................................................................................................... 26
   - Acknowledgements .................................................................................................... 27

5. Evergreen 3.1.14
   - Bug fixes ..................................................................................................................... 28
   - General ....................................................................................................................... 28
   - Acquisitions .............................................................................................................. 28
   - Cataloging .................................................................................................................. 28
   - Circulation ................................................................................................................ 28
   - Reports ....................................................................................................................... 29
   - Acknowledgments ..................................................................................................... 29

6. Evergreen 3.1.13
   - Bug fixes ..................................................................................................................... 30
   - Circulation .................................................................................................................. 30
   - Cataloging .................................................................................................................. 30
   - Client ......................................................................................................................... 30
   - Public Catalog ........................................................................................................... 31
   - Reports ....................................................................................................................... 31
   - System administration .............................................................................................. 31
   - Automated tests ....................................................................................................... 31
   - Database .................................................................................................................... 31
   - Acknowledgments ..................................................................................................... 31

7. Evergreen 3.1.12
   - Bug fixes ..................................................................................................................... 33
   - Booking ...................................................................................................................... 33
   - Circulation .................................................................................................................. 33
   - Cataloging .................................................................................................................. 33
   - Public Catalog ........................................................................................................... 33
   - System administration .............................................................................................. 33
   - Acknowledgments ..................................................................................................... 33

8. Evergreen 3.1.11
   - Bug fixes ..................................................................................................................... 35
   - Circulation .................................................................................................................. 35
   - Cataloging .................................................................................................................. 35
   - System administration .............................................................................................. 35
   - Acknowledgments ..................................................................................................... 35

9. Evergreen 3.1.10
   - Bug fixes ..................................................................................................................... 37
   - Cataloging .................................................................................................................. 37
   - Reports ....................................................................................................................... 37
   - System administration .............................................................................................. 37
   - Acknowledgments ..................................................................................................... 37

10. Evergreen 3.1.9
   - Bug fixes .................................................................................................................... 39
   - Acquisitions .............................................................................................................. 39

Part II. Evergreen 3.1 Release Notes 21
Cataloging .......................................................... 39
Circulation .......................................................... 39
Acknowledgments .................................................. 39
11. Evergreen 3.1.8 ...................................................... 41
   Bug fixes .......................................................... 41
      General ......................................................... 41
      Cataloging ................................................... 41
      Circulation ................................................... 41
      Public catalog ............................................... 41
      System administration ...................................... 41
   Acknowledgements ............................................. 42
12. Evergreen 3.1.7 ...................................................... 43
   Bug fixes .......................................................... 43
   Acknowledgements ............................................. 43
13. Evergreen 3.1.6 ...................................................... 45
   Bug fixes .......................................................... 45
   Acknowledgements ............................................. 46
14. Evergreen 3.1.5 ...................................................... 48
   Bug fixes .......................................................... 48
   Acknowledgements ............................................. 48
15. Evergreen 3.1.4 ...................................................... 50
   Bug fixes .......................................................... 50
   Acknowledgements ............................................. 51
16. Evergreen 3.1.3 ...................................................... 52
   Bug fixes .......................................................... 52
   Acknowledgements ............................................. 52
17. Evergreen 3.1.2 ...................................................... 54
   Bug fixes .......................................................... 54
      Cataloging ................................................... 54
      Circulation ................................................... 54
      Command-line system administration ...................... 55
      Public catalog ............................................... 56
      Serials ......................................................... 56
      General ......................................................... 56
   Acknowledgements ............................................. 56
18. Evergreen 3.1.1 ...................................................... 59
   Acknowledgements ............................................. 59
19. 3.1.0 Upgrade Notes ............................................... 60
20. 3.1.0 New Features ............................................... 61
   Administration .................................................. 61
      New Latency Tester Tool .................................... 61
      marc_export --uris option ................................... 61
   Architecture .................................................... 61
      Sample Data Includes Surveys .............................. 61
      Virtual Index Definitions ................................. 61
   Cataloging ....................................................... 63
      Track Record Merges ....................................... 63
   Circulation ....................................................... 64
      Alternate Patron Hold Pickup ............................. 64
      New Patron Billing Statement ............................. 64
      Enhanced Billing Timestamp Support ..................... 64
      Copy Alerts and Suppression Matrix ..................... 65
      Place Multiple Holds At Once ............................ 65
      New Notice Columns in Items Out Grid .................. 65
Patron Email Addresses Now Clickable In Web Staff Client ................................................................. 66
Pickup Library for Staff-placed Holds ................................................................................................. 66
Public Catalog ..................................................................................................................................... 66
Search Term Highlighting ..................................................................................................................... 66
Copy Location Filter Displays for System Searches ............................................................................ 66
Multi-source Attributes ....................................................................................................................... 67
Optional Display of Badges in Catalog .............................................................................................. 67
Miscellaneous ....................................................................................................................................... 67
Fixes to patron name/username search indexes .................................................................................. 67
21. 3.1.0 Acknowledgments .................................................................................................................. 69
Chapter 3. Evergreen 3.1.16

This release contains bug fixes improving on Evergreen 3.1.15.

**Bug Fixes**

- Add missing columns to patron record ([Bug 1739607](https://example.com/bug1739607))
- Mark the permission.grp_descendants database table as STABLE ([Bug 1768141](https://example.com/bug1768141))
- Webstaff locale picker repair ([Bug 1560805](https://example.com/bug1560805))
- Assign copy alert permissions ([Bug 1811442](https://example.com/bug1811442))
- Fix issue where reports interface was partially loaded ([Bug 1845050](https://example.com/bug1845050))
- Reduce the cost of utility functions, speeding up search ([Bug 1836963](https://example.com/bug1836963))
- Fixes Current Date in Date Returned in Circ History CSV ([Bug 1813056](https://example.com/bug1813056))
- Only include OPAC-visible copies in SRU/Z39.50 holdings ([Bug 1609556](https://example.com/bug1609556))
- Allow saving Bill Full Details grids ([Bug 1729435](https://example.com/bug1729435))
- Improve usability of Patron Bill History date selector ([Bug 1841089](https://example.com/bug1841089))
- Fix when the "duplicate barcode" alert appears ([Bug 1777698](https://example.com/bug1777698))
- Fix paging of pending patrons ([Bug 1749970](https://example.com/bug1749970))
- Check bib visibility for located URI auto suggest ([Bug 1802952](https://example.com/bug1802952))
- Do not include Tag Owner in Tag ([Bug 1825403](https://example.com/bug1825403))
- Require some Storage submodules instead of use them ([Bug 1835620](https://example.com/bug1835620))

**Acknowledgements**

We would like to thank the following individuals who contributed code, testing and documentation patches to the 3.1.16 point release of Evergreen:

- Bill Erickson
- Chris Sharp
- Dan Briem
- Dan Wells
- Galen Charlton
Chapter 4. Evergreen 3.1.15

This release is a security release that fixes cross-site scripting (XSS) vulnerabilities in the Evergreen public catalog. This release also includes several other bugfixes improving on Evergreen 3.1.14.

Security Issue: XSS Vulnerability in Public Catalog

This release fixes several cross-site scripting (XSS) vulnerabilities in the public catalog. When upgrading, Evergreen administrators should review whether any of the following templates have been customized or overridden. If so, either the template should be replaced with the stock version or the XSS fix (which entails adding the | html filter in several places) applied to the customized version.

- Open-ILS/src/templates/opac/browse.tt2
- Open-ILS/src/templates/opac/part/ebook_api/base_js.tt2
- Open-ILS/src/templates/opac/part/header.tt2
- Open-ILS/src/templates/opac/part/place_hold.tt2
- Open-ILS/src/templates/opac/part/place_hold_result.tt2
- Open-ILS/src/templates/opac/part/result/adv_filter.tt2

They should also review the following templates. If these templates have been customized or overridden, either the template should be replaced with the stock version or the XSS fix (which entails adding rel="nofollow to external links) applied to the customized version.

- Open-ILS/src/templates/opac/part/record/summary.tt2
- Open-ILS/src/templates/opac/part/result/table.tt2

Other Bugfixes

Evergreen 3.1.15 also includes the following changes:

Circulation

- Default hold transit slips no longer include patron’s personal information (Bug 1735847)
- Fixes an issue with the reshelving process (Bug 1018011)

Reports

- Fixes issues related to cloning templates made in the XUL client (Bug 1796945)
Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.15 security release of Evergreen:

• Thomas Berezansky
• Jason Boyer
• Jeff Davis
• Blake Graham-Henderson
• Andrea Buntz Neiman
• Debbie Luchenbill
• Jane Sandberg
• Chris Sharp
• Jason Stephenson
• Dan Wells
Chapter 5. Evergreen 3.1.14

This release contains bug fixes improving on Evergreen 3.1.13. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

General

• Accessibility improvements to the date picker calendar button (Bug #1796903)
• Blank values in CSV grid downloads now show as blank instead of null (Bug #1766982)
• Fixes invalid language codes in the staff client and KPAC (Bug #1802593)
• Fixes display issue with menus at certain screen resolutions (Bug 1813078)

Acquisitions

• Adds fund year to Distribution Formula fund dropdown menu (Bug 1329920)

Cataloging

• Extra whitespace in 856$9 subfields no longer prevents located URIs from being displayed in electronic resource records. (Bug #1722827)
• Fixes issue in Item Status import where spaces or empty lines in barcode files caused an import failure (Bug #1798187)
• Fixes issue in Bucket grids where grid configurations were not saving correctly (Bug# 1805895)
• "Local catalog" is now at the top of the list of Z39.50 sources. (Bug #1787676)
• Fixes issue with authority_control_field.pl script (Bug #1650409)

Circulation

• Fixes slowness issues with checkin and checkout grids (Bug #1777207)
• Fixes an issue that allowed staff to renew items to dates in the past. (Bug #1034058)
• Fixes an error that occurred when checking in lost items when a certain setting was enabled. (Bug #1511765)
• Fixes an issue that caused the money summary to be missing from the patron record Bills tab. (Bug #1800484)
• Improves translations in Mark Damaged Popup. (Bug #1742523)
Reports

• Users can now hard code a list of filter values in a report template ([Bug #1785061](https://launchpad.net/bugs/1785061)).

• Fixes an issue that caused column labels to re-sort when deleting fields in a template. ([Bug #1751800](https://launchpad.net/bugs/1751800)).

• Fixes column type for Billing Totals and Billing Paid columns ([Bug #1681930](https://launchpad.net/bugs/1681930)).

Acknowledgments

We would like to thank the following individuals who contributed code, testing and documentation patches to the 3.1.14 point release of Evergreen:

• Kristy Bauman
• Jason Boyer
• Dan Briem
• Andrea Buntz Neiman
• Galen Charlton
• Garry Collum
• Jeff Davis
• James Fournie
• Rogan Hamby
• Kyle Huckins
• Tiffany Little
• Geoff Sams
• Jane Sandberg
• Chris Sharp
• Remington Steed
• Jason Stephenson
• Josh Stompro
• Meg Stroup
• Dan Wells
Chapter 6. Evergreen 3.1.13

This release contains bug fixes improving on Evergreen 3.1.12. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Circulation

• Corrects a rounding error that caused fines to exceed the max fines amount (Bug #1704819)
• Corrects an issue with printing Items Out receipts (Bug #1790896)
• SIP Visa payments are now recorded as credit card, rather than cash payments (Bug #1796942)
• Converting change to patron credit no longer requires staff members to refresh the screen to see the new credit (Bug #1775639)
• The patron summary now includes tooltips that were available in the XUL client (Bug #1772206)
• The patron holds grid now includes a SMS Carrier column (Bug #1748265)
• When registering a new patron from Pending Patrons, the address type dropdown now supports a default value (Bug #1816180)
• The Items Out grid now includes a Monograph Parts column (Bug #1789257)
• The annotate checkbox on the bill payment screen is now sticky (Bug #1759343)

Cataloging

• The holdings editor saves default values more consistently (Bug #1812900)
• Statistical categories and their entries are now alphabetized in the holdings editor (Bugs Bug #1744386 and Bug #1777184)
• The holdings editor now lists monograph parts in reverse alphabetical order (Bug #1760893)
• Buckets created from the MARC Batch Import process are now available in the MARC Batch Edit interface (Bug #1440890)
• The record bucket interface only displays the Merge action when multiple records are selected (Bug #1760599)

Client

• The menu in the top right corner is now named "Logout and more..." (Bug #1796914)
Public Catalog

• Avoids Internal Server Errors on search result page (Bug #1155706)
• Double clicking the Place Hold button can no longer result in multiple holds (Bug #1029601)

Reports

• Adds a more user-friendly interface for boolean filters (Bug #1642337)

System administration

• Improves consistency in terminology in the Local Administration screen (Bug #1776913)

Automated tests

• Fixes an automated test related to translations and internationalization (Bug #1768987)

Database

• Adds some foreign key functions that may be missing from your database (Bug #1772028)

Acknowledgments

We would like to thank the following individuals who contributed code, testing and documentation patches to the 3.1.13 point release of Evergreen:

• John Amundson
• a. bellenir
• Jason Boyer
• Galen Charlton
• Garry Collum
• Dawn Dale
• Jeff Davis
• Bill Erickson
• Jason Etheridge
• Lynn Floyd
• Jeff Godin
Chapter 7. Evergreen 3.1.12

This release contains bug fixes improving on Evergreen 3.1.11. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Booking

• Fixes a bug in the Booking URL path that failed with newer Apache (Bug #1823387)

Circulation

• Fixes a display bug with the patron record Group Members list (Bug #1642036)
• Fixes title sort on the patron Items Out Screen (Bug #1782014)
• Fixes the ability to place holds from item buckets (Bug #1806394)
• Fixes a bug with editing the due date of an hourly loan that would lose the time (Bug #1552778)

Cataloging

• Fixes a bug where copy templates would not apply properly (Bug #1788680)
• Fixes the default cursor focus on the holdings editor (Bug #1752968)
• Fixes a bug that failed to honor the "Retain empty bib records" (cat.bib.keep_on_empty) setting when transferring items (Bug #1333893)

Public Catalog

• Restores ability to request password resets (Bug #1804038)

System administration

• Fixes the help text in action_trigger_aggregator.pl related to the remote-acct argument (Bug #1803729)
• Adds a missing page title for the Statistical Popularity Badges admin page (Bug #1826890)

Acknowledgments

We would like to thank the following individuals who contributed code, testing and documentation patches to the 3.1.12 point release of Evergreen:
Chapter 7. Evergreen 3.1.12

Report errors in this documentation using Launchpad.
Chapter 8. Evergreen 3.1.11

This release contains bug fixes improving on Evergreen 3.1.10. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Circulation

• Allows the Title Hold screen to remember previously selected pickup library (Bug #1665534)
• Sorting improvements for printing the Holds Pull List (Bug #1749502)
• Better display for non-catalogued checkouts in the offline checkout preview pane (Bug #1818576)

Cataloging

• Fixes a bug that changed subfield order in bib record after editing a linked authority (Bug #712490)
• Allows opening multiple selected copies in Item Status screen from the Holdings View (Bug #1734775)
• Adds missing "Deleted?" column choice to Record Buckets (Bug #1746360)
• Fixes the batch Call Number label field on the Volume editor to populate from the MARC record (Bug #1793196)
• Fixes a bug to allow editing the call number label for some but not all attached copies (Bug #1794588)
• Fixes the sort order of Parts on the Holdings View (Bug #1800178)

System administration

• Web client (websocket) logins are now properly tracked as user activity (Bug #1818153)
• Fixes some log warnings related to Holds Depth (Bug #1667497)
• Fixes a bug in the fine generator related to Bookings (Bug #1819796)

Acknowledgments

We would like to thank the following individuals who contributed code, testing and documentation patches to the 3.1.11 point release of Evergreen:

• John Amundson
• Jason Boyer
• Garry Collum
• Bill Erickson
• Jason Etheridge
• Rogan Hamby
• Kyle Huckins
• Terran McCanna
• Michele Morgan
• Jane Sandberg
• Janet Schrader
• Remington Steed
• Jason Stephenson
• Josh Stompro
• Dan Wells
Chapter 9. Evergreen 3.1.10

This release contains bug fixes improving on Evergreen 3.1.9. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Cataloging

• Catalogers can now set the Bib Source in the Z39.50 Overlay and Import interfaces (Bug #1727345)

• Fixes an issue where publishers display in the publication date column in copy buckets (Bug #1812698)

• Electronic resources no longer display a call number called URI in the Volume Editor (Bug #1752665)

• Spine/pocket label templates can now include circulation library and owning library (Bug #1726568)

Reports

• Fixes an issue where external documentation links can open in the reports module (Bug #1784893)

• Fixes an issue where publishers display as a publication date in reports (Bug #1812698)

System administration

• The DELETE_COPY_ALERT permission no longer needs to be granted on the consortium level (Bug #1783421)

Acknowledgments

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.10 point release of Evergreen:

• John Amundson
• Galen Charlton
• Jeff Davis
• James Fournie
• Terran McCanna
Chapter 10. Evergreen 3.1.9

This release contains bug fixes improving on Evergreen 3.1.8. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Acquisitions

• The new edi_order_pusher.pl now only pushes purchase orders with a state of "on-order", to prevent older purchase orders from being unintentionally pushed to vendors.

Cataloging

• The template dropdown in the holdings editor now provides more space to accommodate longer template names.

• The drop-down of copy tag types in the Manage Copy Tags dialog now includes the owning library of the copy tag type.

Circulation

• Fixes an issue with recalling checked-out materials.

• Added several missing columns to the patron bills grid.

• Corrected the display of the Bill Type column in the patron bills grid.

• Clarified the names of the "Billing Location" and "Grocery Billing Location" columns in the patron bills grid.

• The Bill Full Details grid now includes a billing location column for both circulation and grocery bills, as well as the owning library for circulation bills.

• The Billing History transactions grid now remembers any changes that users make to the column settings.

• Fixes an issue with printing multiple copies of bills.

Acknowledgments

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.9 point release of Evergreen:

• John Amundson

• Jason Boyer
Chapter 10. Evergreen 3.1.9

Report errors in this documentation using Launchpad.
Chapter 11. Evergreen 3.1.8

This release contains bug fixes improving on Evergreen 3.1.7. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

General

• Fixes a bug that blocked logging in from mobile browsers
• Fixes a readability issue with mobile menus
• Fixes performance issue related to grid tooltips.

Cataloging

• Improves the functionality of setting a default tab of a bib record
• The web client now remembers the most recently selected copy template
• Adds help tips to Print Item Labels Settings tab
• If you add or edit copies and/or volumes from the Holdings View tab, the view now automatically refreshes to show your changes.
• Provides an upgrade to MODS 3.3 for older Evergreen installations.
• Improves usability of Z39.50 MARC View.

Circulation

• Staff can now place multiple email addresses into the patron registration/ edit form, depending on the value of the $ui.patron.edit.au.email.regex$ library setting.
• Fixes an issue with the offline circulation module.
• When merging two users, the non-lead account is now completely purged from the database, rather than simply being marked as deleted.

Public catalog

• Removes incorrect copy counts from metarecord search results pages
• Electronic resources now display in the browse interfaces

System administration

• The example Apache 2.4 configuration now enables remoteip.
• Improves syntax in the fm_idl file.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.8 point release of Evergreen:

• Jason Boyer
• Galen Charlton
• Garry Collum
• Bill Erickson
• Rogan Hamby
• Rosie Le Faive
• Jeanette Lundgren
• Kathy Lussier
• Mike Rylander
• Jane Sandberg
• Janet Schrader
• Chris Sharp
• Ben Shum
• Remington Steed
• Jason Stephenson
• Cesar Velez
• Dan Wells
Chapter 12. Evergreen 3.1.7

This release contains bug fixes improving on Evergreen 3.1.6. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

• Adds several columns to the items out grid.
• Adds the ability to copy patron addresses to the clipboard.
• Fixes several issues with adding new items and call numbers.
• Adds links to catalog records from the query and pending tabs of the Record Buckets interface.
• Corrects the date format used in several bucket interfaces.
• Adds a loading spinner to interfaces that are embedded in the web staff client via iframe (such as the catalog).

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.7 point release of Evergreen:

• John Amundson
• a. bellenir
• Jason Boyer
• Galen Charlton
• Garry Collum
• Dawn Dale
• Bill Erickson
• Jason Etheridge
• Kathy Lussier
• Mike Rylander
• Jane Sandberg
• Jason Stephenson
• Cesar Velez
Chapter 13. Evergreen 3.1.6

This release contains bug fixes improving on Evergreen 3.1.5. All bug fixes refer to the web staff client unless otherwise specified.

**Bug fixes**

- Fixes an issue that caused catalog searches to fail after a new library was added to the org tree.
- When you mouse over a grid cell in the client, a tooltip will display the full contents of the cell.
- Fixes issues with columns in the Item Status, Holdings View, Checkout, Patron Bill, Recent Circ History,
- Fixes various misspellings and capitalization issues in the interface.
- Circulation staff can now override a patron block that is placed from Messages/Apply Penalty.
- Fixes an issue with checking in hourly loans.
- Staff can now approve pending patron addresses in the patron edit interface.
- Prevents patron records from being merged with themselves.
- Fixes a bug where the patron card dialog would not allow the user to change the primary barcode under certain circumstances.
- Fixes issues with duplicate transit records.
- Adds the transit cancel time to the Most Recent Transits section of the Item Status Holds / Transit tab.
- Adds the "Show in Catalog" action back to the Item Status grid.
- Improvements to the Item Attribute Editor.
- Staff can now set a default search box in the Z39.50 search interface.
- Staff can now delete copy notes.
- Fixes an issue in which transferring items and vol/items caused statistical categories to disappear.
- In the MARC editor, the 007 physical characteristics wizard now has a different icon than the authority linker.
- Protects backordered acquisitions items from having their catalog items deleted.
- Fixes a problem where EDI ORDERS message were not visible in the EDI Messages interface.
- Fixes problems that occur when cloning a report template created in the XUL client.
• Fixes bugs that caused activity metric data when performing searches.

• Fixes an issue where the "Predict New Issues" button in the Serials module did not use the correct pattern.

• The KPAC now respects the `opac.holds.org_unit_not_pickup_lib` setting.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.6 point release of Evergreen:

• John Amundson
• a. bellenir
• Jason Boyer
• Steven Callender
• Galen Charlton
• Garry Collum
• Amy Constantino
• Jeff Davis
• Bill Erickson
• Jason Etheridge
• Joan Kranich
• Sam Link
• Jeanette Lundgren
• Kathy Lussier
• Michele Morgan
• Mike Rylander
• Jane Sandberg
• Dan Scott
• Chris Sharp
• Ben Shum
• Jason Stephenson
• Dan Wells
• Beth Willis
Chapter 14. Evergreen 3.1.5

This release contains bug fixes improving on Evergreen 3.1.4. All bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

• Several strings are now displayed in the correct translation.

• Right clicking in grids results in more intuitive behavior.

• Usernames and barcodes containing the % character no longer experience problems logging in.

• Fixes cases in which the web client stops loading after the toolbar.

• Fixes problems in which using the web client in multiple tabs leads to data inconsistency.

• Fixes an issue that caused authentication session checks to spam the system and needlessly fill up logs.

• Boolean fields within grid views now say "Yes"/"No" instead of "true"/"false".

• Fixes sorting issues in the patron search.

• Staff can now choose to print out only a selection of items out, instead of having to print them all.

• The patron triggered event screen now respects the circ.staff.max_visible_event_age library setting.

• Fixes an issue which caused an exception to be thrown during non-cataloged item checkout.

• Fixes permission issues related to merging users.

• The bibliographic record summary now displays the call number that matches the library’s classification system.

• The copy editor now makes shelving locations visible to catalogers from other libraries as needed.

• Once a record is overlayed in the Z39.50 screen, it is no longer marked for overlay.

• Fixes several issues with the item status list view.

• When adding new copies, the circulation library now defaults to the call number’s owning library.

• Fixes display issues with the Print Item Labels page.

• Fixes an issue in which the staff client and the OPAC displayed different counts of available items.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.5 point release of Evergreen:
• John Amundson
• a. bellenir
• Jason Boyer
• Garry Collum
• Jeff Davis
• Bill Erickson
• Rogan Hamby
• Kathy Lussier
• Terran McCanna
• Michele Morgan
• Mike Rylander
• Jane Sandberg
• Chris Sharp
• Jason Stephenson
• Ben Shum
• Cesar Velez
• John Yorio
Chapter 15. Evergreen 3.1.4

This release contains bug fixes improving on Evergreen 3.1.3. Note that all bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

• Fixes right-click issues with the Web client grids

• Fixes an issue with the Default SMS Carrier in the patron edit form.

• Fixes an issue that allowed overdue notices to be sent to a patron whose long overdue item has been paid for.

• Checking in precat items now displays the "Route to Cataloging" alert each time the item is checked in.

• Fixes an issue where alerts that had been cleared by a check-in continued to display.

• Fixes an issue in which the Adjust to Zero feature does not close a checked-in lost circ.

• Deleted copies that are still checked out can now be checked in.

• Fixes a mislabeled column in the patron checkout grid.

• Grocery bills are no longer styled the same way as overdue bills.

• Fixes an error with the missing pieces functionality.

• Courier codes now display in the transit slip receipt preview.

• Fixes several issues related to adding volumes.

• Fixes several issues related to empty volumes.

• Fixes several issues related to item and volume transfers.

• Fixes several issues with checkboxes in the volume/copy editor.

• The Item Status grid now displays OU shortnames instead of full names for the "Circulation Library" column.

• The Volume/Copy editor now allows users to remove a value from the Age Hold Protection field.

• Barcode completion now works in copy buckets.

• The Z39.50 interface now notices when another record has been marked for overlay.

• Fixes a display issue for the Remove MARC Field Groups checkboxes in the Z39.50 interface.

• Fixes a performance issue for the Validate button in the MARC Editor.
• Fixes an incorrect close tag in the Print Item Labels toolbar.
• Better scoping of copy tags in search results.
• Prevents sending invalid search.highlight_display_fields calls.
• Electronic Resource links now open in a new tab.
• Fixes an issue with the fiscal year close-out operation.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.4 point release of Evergreen:

• A. Bellenir
• Adam Bowling
• Jason Boyer
• Galen Charlton
• Garry Collum
• Jeff Davis
• Bill Erickson
• Kathy Lussier
• Terran McCanna
• Michele Morgan
• Jennifer Pringle
• Mike Rylander
• Jane Sandberg
• Chris Sharp
• Jason Stephenson
• Cesar Velez
• Dan Wells
Chapter 16. Evergreen 3.1.3

This release contains bug fixes improving on Evergreen 3.1.2. Note that all bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

• Fixes specific cases in which deleted records appear in search results.
• Fixes a performance issue with deleting patrons.
• The hold shelf dialog popup now lists the patron’s notification preferences.
• Fixes an issue that prevented editing items when a monograph part is present.
• Patron information is now available for use in the bills_current and bills_historical receipt templates.
• The browser’s "This page may contain unsaved data" warning now appears when users click the update expire date button in a patron account and attempt to navigate away without saving.
• The holds tab of the patron record now includes a monograph part column.
• The barcode box in the checkout screen no longer hovers above patron record tabs when staff users scroll down.
• Fixes an issue with the date of birth in the patron edit screen.
• The patron account bills grid are now color-coded by the item’s status.
• Fixes an issue with the dropdown of billing type options.
• The Item Status screen now includes as a floating group column.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.3 point release of Evergreen:

• BC Libraries Cooperative
• A. Bellenir
• Jason Boyer
• Galen Charlton
• Garry Collum
• Dawn Dale
• Bill Erickson
• Blake Graham-Henderson
• Kyle Huckins
• Jeanette Lundgren
• Kathy Lussier
• Terran McCanna
• Michele Morgan
• Dan Pearl
• Mike Rylander
• Geoff Sams
• Jane Sandberg
• Chris Sharp
• Remington Steed
• Jason Stephenson
• Cesar Velez
• Dan Wells
Chapter 17. Evergreen 3.1.2

This release contains bug fixes improving on Evergreen 3.1.1. Note that all bug fixes refer to the web staff client unless otherwise specified.

Bug fixes

Cataloging

• The MARC editor now handles 008 fields better.

• Adds spaces between subfields when suggesting a call number for a new volume.

• MarcXML exports from the MARC Batch Import/Export → Export Records screen now downloads the file, rather than opening it in the browser.

• The Item Status Circulation Library column now displays a shortname rather than the full library name.

• The Item Status Remaining Renewals column now displays correctly.

• The Item Status now has a "Last Renewal Workstation" column available.

• Fixes the circulation counts displayed in Item Status Details.

• Removes an error that got thrown in the Holdings View when a call number contains no copy.

• Fixes an issue where multiple copies with different values for required statistical categories could not be edited and saved in batch.

• Add an option to remove floating in the copy editor.

• Fixes an issue with the floating dropdown in the copy editor.

• Fixes a problem in which the copy template didn’t properly copy certain objects.

• Reduces the number of API calls that the MARC Editor requires.

• The order of the Z39.50 servers on the Z39.50 import screen no longer relies on capitalization.

Circulation

• Fixes an issue that prevented the offline patron registration screen from loading.

• Fixes an issue with searching patrons by permission group.

• The barcodes in the patron search are now clickable.

• Staff members can now manually override the patron juvenile flag value, regardless of the patron’s date of birth.
Checkboxes on patron registration screen are now properly aligned with other fields.

The user permission group dropdowns in the patron registration, edit, and search interfaces now have scrollbars.

The date picker on the checkout screen is now hidden unless circ staff activates a specific due date option.

The check-in screen now includes a copy status column.

The Merge Patrons interface now displays the date of birth.

The user bucket screen now displays the Bucket ID.

The payment button on patron bills screen is now inactive if the Payment Received field is blank.

The Bill History receipt now includes a Finish date and a Last Payment date.

When a patron summary contains an image of the patron, that image tag now has a null alt attribute to remove it from the flow of a screen reader.

Corrects an issue that caused the transit dialog to show the wrong branch.

Corrects an issue with printing transit lists.

"Find another target" on transiting hold no longer leaves the copy "in-transit".

The images now display to distinguish hold and transit slips.

The Clearable Holds list printout now only shows holds that have expired.

Restores the call number prefix and suffix fields to the holds pull list.

The documentation at the top of the hold shelf slip template adds `patron alias`.

The cursor in the in-house use screen now automatically goes to the barcode field.

The in-house use screen now shows a copy status column.

Add support for converting change to patron credit in the patron bills interface, consistent with the XUL feature.

Fixes a bug that caused pickup/request library fields to be blank sometimes.

Fixes a bug in the offline org unit tree.

### Command-line system administration

The novelist entry in `eg_vhost.conf` includes two new parameters.

Corrects an issue with the `--max-sleep` argument on the `action_trigger_runner.pl` support script.

Corrects an issue with how the `eg_pbx_allocator.pl` script detects an existing lock file.
• The 3.0.2-3.0.3 upgrade script disables triggers before recalculating bib visibility.

Public catalog

• Fixes an issue that caused records with located URIs to be retrieved in Copy Location and Copy Location Group searches.
• Fixes an error message that appeared in the search box in the public catalog while placing hold after an advanced search.
• Restores the display of copy information for the user’s preferred library in the public catalog.
• Author and contributor names are no longer highlighted in search results when the user has turned off highlighting.
• Fixes regression errors in the search results page.
• Removes redundant call numbers from the Show More Details search results.
• The cast field in the catalog is now taken from the 511 field when first indicator = 1, rather than the 508.
• Fixes a display issue caused by editing holds.
• Repairs broken author search links on the catalog record page.

Serials

• Fixes an issue that prevented users from searching for receivable issues using Database ID or ISSN in the Serials Batch Receive interface.

General

• Pins AngularJS support to version 1.6, which prevents unsupported AngularJS versions (such as 1.7) from breaking the build process.
• Adds some padding to the bottom of Web Client interfaces.
• Logins now honor all org unit timeout settings.
• Evergreen will now identify and handle invalid timezones.
• Fixes an issue where a column header in some interfaces were automatically highlighted in green when retrieving the interface.
• The parts column in the Item Status screen now displays parts data.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.2 point release of Evergreen:
Chapter 17. Evergreen 3.1.2

Report errors in this documentation using Launchpad.
Chapter 18. Evergreen 3.1.1

This release contains bug fixes improving on Evergreen 3.1.0.

• Fixes a performance issue with the Patron Billing History screen and other screens that cause Flattener.pm to re-create joins unnecessarily.

• Fixes an issue that prevented patron alerts from showing to staff at other libraries.

• Corrects the "Holdable" attribute display on the Item Status detailed view.

• Fixes the ability to delete multiple copies from Item Status.

Acknowledgements

We would like to thank the following individuals who contributed code, tests and documentation patches to the 3.1.1 point release of Evergreen:

• Jason Boyer
• Bill Erickson
• Morkor Quarshie
• Jane Sandberg
• Remington Steed
• Jason Stephenson
• Kevin Tran
• Dan Wells
Chapter 19. 3.1.0 Upgrade Notes

Like many major Evergreen upgrades, 3.1 requires a full reingest of your bibliographic records before the system is usable again. While a basic reingest is included at the end of the upgrade script, it happens after the main COMMIT, so it is safe to cancel that and run the required reingest as you see fit (e.g. via pingest.pl).
Chapter 20. 3.1.0 New Features

Administration

New Latency Tester Tool

The Evergreen Web Staff Client now includes a section called Tests linked from Administration → Workstation. The Tests page houses a simple tool that can be used to test the latency of the websocket connection between the client and the server (via the opensrf.echo service).

This page displays which Evergreen host server is being queried. Upon hitting the blue "Start Test" button for the first time, it will issue 10 sequentially fired requests in order to get a solid initial average. Clicking the button a second time will take one more measurement and recalculate the average latency. The results can be copied to clipboard for troubleshooting purposes and also cleared from display.

marc_export --uris option

The marc_export support script now has a --uris option (short form: -u) to export records with located URIs (i.e. electronic resources). When used by itself, it will export only records that have located URIs. When used in conjunction with --items, it will add records with located URIs but no items/copies to the output. If combined with a --library or --descendants option, this option will limit its output to those records with URIs at the designated libraries. The best way to use this option is in combination with the --items and one of the --library or --descendants options to export all of a library’s holdings both physical and electronic.

Architecture

Sample Data Includes Surveys

The Concerto sample data set now includes patron surveys, questions, answers, and responses.

Virtual Index Definitions

The practical purpose of Virtual Index Definitions is to supply an Evergreen administrator with the ability to control the weighting and field inclusion of values in the general keyword index, commonly referred to as "the blob," without requiring tricky configuration that has subtle semantics, an over-abundance of index definitions which can slow search generally, or the need to reingest all records on a regular basis as experiments are performed and the configuration refined. Significant results of recasting keyword indexes as a set of one or more Virtual Index Definitions will be simpler search configuration management, faster search speed overall, and more practical reconfiguration and adjustment as needed.

Previously, in order to provide field-specific weighting to keyword matches against titles or authors, an administrator must duplicate many other index definitions and supply overriding weights to
those duplicates. This not only complicates configuration, but slows down record ingest as well as search. It is also fairly ineffective at achieving the goal of weighted keyword fields. Virtual Index Definitions will substantially alleviate the need for these workarounds and their consequences.

• A Virtual Index Definition does not require any configuration for extracting bibliographic data from records, but instead can become a sink for data collected by other index definitions, which is then colocated together to supply a search target made up of the separately extracted data. Virtual Index Definitions are effectively treated as aggregate definitions, matching across all values extracted from constituent non-virtual index definitions. They can further make use of the Combined class functionality to colocate all values in a class together for matching even across virtual fields.

• Configuration allows for weighting of constituent index definitions that participate in a Virtual Index Definition. This weighting is separate from the weighting supplied when the index definition itself is a search target.

• The Evergreen QueryParser driver returns the list of fields actually searched using every user-supplied term set, including constituent expansion when a Virtual Index Definition is searched. In particular, this will facilitate Search Term Highlighting described below.

• Stock configuration changes make use of pre-existing, non-virtual index definitions mapped to new a Virtual Index Definition that implements the functionality provided by the keyword|keyword index definition. The keyword|keyword definition is left in place for the time being, until more data can be gathered about the real-world effect of removing it entirely and replacing it with Virtual Index Definition mappings.

• New system administration functions will be created to facilitate modification of Virtual Index Definition mapping, avoiding the need for a full reingest when existing index definitions are added or removed from a virtual field.

**Increased use of Metabib Display Fields**

We use Metabib Display Fields (newly available in 3.0) to render catalog search results, intermediate metarecord results, and record detail pages. This requires the addition of several new Metabib Display Field definitions, as well as Perl services to gather and render the data.

We also use more Metabib Display Fields in the client. As a result, bibliographic fields will display in proper case in more client interfaces and in Evergreen reports.

**Interfaces**

A new AngularJS "MARC Search/Facet Fields" interface has been created to replace the Dojo version, and both have been extended to support Virtual Index Definition data supplier mapping and weighting.

**Settings & Permissions**

The new Virtual Index Definition data supplier mapping table, `config.metabib_field_virtual_map`, requires the same permissions as the MARC Search/Facet
Fields interface: CREATE_METABIB_FIELD, UPDATE_METABIB_FIELD, DELETE_METABIB_FIELD, or ADMIN_METABIB_FIELD for all actions

Backend

There now exist several new database tables and functions primarily in support of search highlighting. Additionally, the QueryParser driver for Evergreen has been augmented to be able to return a data structure describing how the search was performed, in a way that allows a separate support API to gather a highlighted version of the Display Field data for a given record.

Default Weights

By default, the following fields will be weighted more heavily in keyword searches. Administrators can change these defaults by changing the values in the "All searchable fields" virtual index in the "MARC Search/Facet Fields" interface.

- Title proper
- Main title (a new index limited to the words in the 245a)
- Personal author
- All subjects

In addition, note indexes and the physical description index will receive less weight in default keyword searches.

Re-ingest or Indexing Dependencies

With the addition and modification of many Index Definitions, a full reingest is recommended. However, search will continue to work as it did previously for those records that have not yet been reingested. Therefore a slow, rolling reingest is recommended.

Performance Implications or Concerns

Because the Metabib Display Fields infrastructure will eventually replace functionality that is significantly more CPU-intensive in the various forms of XML parsing, XSLT transformation, XPath calculation, and Metabib Virtual Record construction, it is expected that the overall CPU load will be reduced by this development, and ideally the overall time required to perform and render a search will likewise drop. It is unlikely that the speed increase will be visible to users on a per-search basis, but that search in aggregate will become a smaller consumer of resources.

Cataloging

Track Record Merges

When 2 or more bib records are merged, all records involved are stamped with a new merge_date value. For any bib record, this field indicates the last time it was involved in a merge. At the same
time, all subordinate records (i.e. those deleted as a product of the merge) are stamped with a *merged_to* value indicating which bib record the source record was merged with.

In the browser client bib record display, a warning alert now appears along the top of the page (below the Deleted alert) indicating when a record was used in a merge, when it was merged, and which record it was merge with, rendered as a link to the target record.

### Circulation

#### Alternate Patron Hold Pickup

This feature adds a bit of convenience to a common task: checking out an item on hold to another patron (typically a family member or helper).

When you checkout the item, you will get a pop-up window with warnings associated with this item. The "ITEM_ON_HOLD_ON_SHELF" message is now expanded to

- Let you know the name of the person who had placed the hold.
- Give you the option (in the form of a checkbox) of cancelling the hold placed by the above-named patron. (Checked = Cancel the hold; Unchecked = Leave the hold in place)

The initial value of the checkbox is derived from the *circ.clear_hold_on_checkout* organizational setting.

If the operator has CANCEL_HOLD privilege, then if the checkbox is checked and the checkout is allowed to proceed, the hold will be cancelled with a note that the item was checked out to another patron.

This feature is available in the browser-based staff client.

#### New Patron Billing Statement

The Evergreen web staff client now includes a patron billing statement, which summarizes a patron’s bills, credits and payments in a familiar layout. This can be found on the "Statement" tab of the Patron Bill Details page. (From the Patron Bills page, double-click a row to view its details, or choose "Full Details" from the Actions menu.)

#### Enhanced Billing Timestamp Support

Previously, billings had to make do with a single timestamp attempting to fill two different roles. In the case of an overdue fine, the timestamp represented the end of the fine period for that billing, while for all other fines, the timestamp was merely the time the bill was created. This setup generally worked, but not without confusion, and limited our ability to understand and process the data.

Billings will now have up to three timestamps: a create date, and when applicable, a fine period start and a fine period end. This clarifies and simplifies things like backdating, retrospective fine generation, account balancing for negative balance avoidance, and billing timeline views.
Copy Alerts and Suppression Matrix

The Copy Alerts feature allows library staff to add customized alert messages to copies. The copy alerts will appear when a specific event takes place, such as when the copy is checked in, checked out, or renewed. Alerts can be temporary or persistent: temporary alerts will be disabled after the initial alert and acknowledgement from staff, while persistent alerts will display each time the alert event takes place. Copy Alerts can be configured to display at the circulating or owning library only or, alternatively, when the library at which the alert event takes place is not the circulating or owning library. Copy Alerts can also be configured to provide options for the next copy status that should be applied to an item. Library administrators will have the ability to create and customize Copy Alert Types and to suppress copy alerts at specific org units.

Copy alerts can be added via the volume/creator and the check in, check out, and renew pages. Copy alerts can also be managed at the item status page.

Copy alert types can be managed via the Copy Alert Types page in Local Administration, and suppression of them can be administered via the Copy Alert Suppression page under Local Administration.

Place Multiple Holds At Once

Users with the appropriate permissions now have the ability to place multiple title/metarecords holds at once. This feature is especially beneficial for book clubs and reading groups, which need to place holds on multiple copies of a title.

In order to use the feature:

- Set the Maximum number of duplicate holds allowed Library Setting (circ.holds.max_duplicate_holds) to a number higher than 1
- Log in as a user with the CREATE_DUPLICATE_HOLDS

When placing a title or metarecord hold, a Number of copies field will display for these users. This field is not available when placing part, volume or copy holds.

This feature does not change the way in which the system fills holds. The multiple holds will fill in the same way that they would if the user had placed multiple holds separately.

New Notice Columns in Items Out Grid

The grid in the patron "items out" page in the Evergreen web staff client has two new columns indicating the number of notifications generated for a given loan and the date of the most recent notification. These columns will allow circulation staff to better respond to patron questions about whether they were sent notification about an overdue item.

The columns are based on the number of completed Action Trigger events on the loan that have a checkout.due hook. In other words, they would include overdue and courtesy notices.

A new library setting, "Exclude Courtesy Notices from Patrons Itemsout Notices Count", if set will cause the notice count and date fields to exclude courtesy notices.
Patron Email Addresses Now Clickable In Web Staff Client

Adds a mailto link to the patron’s email in their profile so it can be clicked to send and email to the patron. No new settings or permissions are included in this feature.

Pickup Library for Staff-placed Holds

Adds a new library setting, circ.staff_placed_holds_fallback_to_ws_ou, that helps determine the hold pickup library in cases where patrons don’t have a preferred hold pickup library in their account and a staff member is placing the hold on their behalf.

• When this setting is true and the patron doesn’t have a preferred library listed, the hold pickup library will default to the workstation’s organizational unit.

• When this setting is false and the patron doesn’t have a preferred library listed, the hold pickup library will default to the patron’s home library.

Public Catalog

Search Term Highlighting

Evergreen now highlights search terms on the public catalog’s main search results page, the record detail page, and intermediate pages such as metarecord grouped results page. Highlighting search terms will help the user determine why a particular record (or set of records) was retrieved.

Highlighting of matched terms uses the same stemming used to accomplish the search, as configured per field and class.

This feature will help the user more quickly determine the relevance of a particular record by calling their attention to search terms in context. Lastly, it will help familiarize the user with how records are searched, including which fields are searched as well as exposing concepts like stemming.

You can turn off search term highlighting by uncommenting the line search.no_highlight = 1; in config.tt2.

When highlighting is generally enabled, it may be turned on or off on a per-page basis through the use of a UI component which will request the page again without highlighting.

Highlighting of terms uses Template::Toolkit-driven CSS. A generic CSS class identifying a highlighted term, along with CSS classes identifying the search class and each search field are available for use for customization of the highlighting. A stock CSS template is provided as a baseline upon which sites may expand.

Copy Location Filter Displays for System Searches

The Shelving Location filter now displays on the advanced search page when a search is scoped to a library system, not just to an individual branch. If a library system is selected as the Search
Library, the shelving location limiter will display any shelving location that is owned by the selected system or by the consortium. It will NOT display shelving locations owned by child branches.

**Multi-source Attributes**

We now allow record attribute definitions to extract data using more than one strategy (XPath, tag + subfield, fixed field, etc.) as long as the values from various sources would, after normalization, have the same shape.

**Multilingual Search**

This change allows us to configure multilingual search, by extracting values from both the 008 controlfield and the 041 datafield. Because the values in each can be normalized to the same controlled list (and, in practice, are already from the same normalized value set), catalog searches can now use normal boolean search semantics to find records with various combinations of language attributes.

E.g., in the concerto test data:

- **keyword**: piano item_lang(eng) item_lang(ita)

**Optional Display of Badges in Catalog**

A new setting controls whether badges (popularity, etc.) are displayed in the catalog. If you do not wish badges to be displayed, set the `ctx.hide_badge_scores` setting to "true" in `config.tt2`.

**Miscellaneous**

**Fixes to patron name/username search indexes**

When using pg_restore to restore an Evergreen database, some of the indexes used to speed up patron searches on names and usernames could be lost.

This release fixes the underlying issue and re-creates the indexes in question.

**Details**

When using pg_restore to restore an affected database, the "unaccent" indexes on actor.usr would not be created due to an unqualified function reference in `evergreen.unaccent_and_squash`. The function will be replaced to resolve the search path issue, and the following indexes on actor.usr will be dropped and then re-created:

- `actor_usr_first_given_name_unaccent_idx`;
- `actor_usr_second_given_name_unaccent_idx`;
- `actor_usr_family_name_unaccent_idx`;
• `actor_usr_usrname_unaccent_idx`;

This will be done even if the indexes are already present, and may take a few minutes on a database with many patrons.
Chapter 21. 3.1.0 Acknowledgments

The Evergreen project would like to acknowledge the following organizations that commissioned developments in this release of Evergreen:

• Albany Public Library (Oregon)
• Consortium of Ohio Libraries
• CW MARS
• Indiana State Library
• Georgia Public Library Service
• Hagerstown - Jefferson Township Library
• Linn-Benton Community College
• MassLNC
• Pennsylvania Integrated Library System
• Sage Library System
• Union County Public Library (Indiana)

We would also like to thank the following individuals who contributed code, translations, documentations patches and tests to this release of Evergreen:

• Eva Cerninakova
• Andi Chandler
• Galen Charlton
• Jeff Davis
• Bill Erickson
• Jeff Godin
• Rogan Hamby
• Angela Kilsdonk
• Sam Link
• Jeanette Lundgren
• Kathy Lussier
• Fares Othman
• Dan Pearl
• Mike Rylander
• Jane Sandberg
• Chris Sharp
• Ben Shum
• Remington Steed
• Jason Stephenson
• Kevin Tran
• Cesar Velez
• Dan Wells

We also thank the following organizations whose employees contributed patches:

• Bibliomation
• British Columbia Libraries Cooperative
• Calvin College
• CW MARS
• Equinox Open Library Initiative
• Georgia Public Library Service
• Greater Clarks Hill Regional Library System
• Jordanian Library and Information Association
• King County Library System
• Knihovna Jabok
• Linn-Benton Community College
• MassLNC
• Sigio
• Traverse Area District Library

We regret any omissions. If a contributor has been inadvertently missed, please open a bug at http://bugs.launchpad.net/evergreen/ with a correction.
Part III. Software Installation
## Table of Contents

22. Introduction ................................................................. 73
23. System Requirements .................................................... 74
  Server Minimum Requirements ............................................. 74
  Web Client Requirements ................................................ 74
  Staff Client Requirements ............................................... 74
24. Installing the Evergreen server ......................................... 75
  Preamble: referenced user accounts .................................... 75
  Preamble: developer instructions ....................................... 75
  Installing prerequisites .................................................. 76
  Extra steps for web staff client ....................................... 77
    Install dependencies for web staff client ......................... 77
    Install files for web staff client .................................. 77
  Configuration and compilation instructions ......................... 77
  Installation instructions ............................................... 78
  Change ownership of the Evergreen files ......................... 78
  Run ldconfig ............................................................ 78
  Additional Instructions for Developers ............................. 78
  Configure the Apache Web server .................................... 79
  Configure OpenSRF for the Evergreen application ............... 80
  Configure action triggers for the Evergreen application ........ 81
  Creating the Evergreen database ..................................... 81
    Setting up the PostgreSQL server ................................ 81
    Creating the Evergreen database and schema ................... 82
    Loading sample data ............................................... 82
    Creating the database on a remote server ....................... 83
  Starting Evergreen ..................................................... 83
  Testing connections to Evergreen ................................... 83
  Getting help ................................................................ 84
  License ................................................................. 84

25. Upgrading the Evergreen Server ....................................... 85
  Software Prerequisites .................................................. 85
  Upgrade the Evergreen code .......................................... 85
  Upgrade the Evergreen database schema ............................ 87
  Restart Evergreen and Test ........................................... 89
  Review Release Notes .................................................. 90

26. Setting Up EDI Acquisitions ............................................ 91
  Introduction ............................................................. 91
  Installation ................................................................ 91
  Install EDI Translator .................................................. 91
  Install EDI Scripts ...................................................... 92
  Configuration ................................................................ 92
    Configuring Providers ............................................... 92
    Configuring EDI Accounts .......................................... 93
    Configuring Organizational Unit SAN code ..................... 93
  Troubleshooting .......................................................... 93
    PO JEDI Template Issues ............................................. 93
Chapter 22. Introduction

This part will guide you through the installation steps installation or upgrading your Evergreen system. It is intended for system administrators.
Chapter 23. System Requirements

Server Minimum Requirements

The following are the base requirements setting Evergreen up on a test server:

- An available desktop, server or virtual image
- 4GB RAM, or more if your server also runs a graphical desktop
- Linux Operating System (community supports Debian, Ubuntu, or Fedora)
- Ports 80 and 443 should be opened in your firewall for TCP connections to allow OPAC and staff client connections to the Evergreen server.

Web Client Requirements

The current stable release of Firefox or Chrome is required to run the web client in a browser.

Staff Client Requirements

Staff terminals connect to the central database using the Evergreen staff client, available for download from The Evergreen download page. The staff client must be installed on each staff workstation and requires at minimum:

- Windows, Mac OS X, or Linux operating system
- a reliable high speed Internet connection
- 2GB RAM
- The staff client uses the TCP protocol on ports 80 and 443 to communicate with the Evergreen server.

Barcode Scanners

Evergreen will work with virtually any barcode scanner – if it worked with your legacy system it should work on Evergreen.

Printers

Evergreen can use any printer configured for your terminal to print receipts, check-out slips, holds lists, etc. The single exception is spine label printing, which is still under development. Evergreen currently formats spine labels for output to a label roll printer. If you do not have a roll printer manual formatting may be required.
Chapter 24. Installing the Evergreen server

Preamble: referenced user accounts

In subsequent sections, we will refer to a number of different accounts, as follows:

- **Linux user accounts**:
  - The user Linux account is the account that you use to log onto the Linux system as a regular user.
  - The root Linux account is an account that has system administrator privileges. On Debian you can switch to this account from your user account by issuing the `su -` command and entering the password for the root account when prompted. On Ubuntu you can switch to this account from your user account using the `sudo su -` command and entering the password for your user account when prompted.
  - The opensrf Linux account is an account that you create when installing OpenSRF. You can switch to this account from the root account by issuing the `su - opensrf` command.
  - The postgres Linux account is created automatically when you install the PostgreSQL database server. You can switch to this account from the root account by issuing the `su - postgres` command.

- **PostgreSQL user accounts**:
  - The evergreen PostgreSQL account is a superuser account that you will create to connect to the PostgreSQL database server.

- **Evergreen administrator account**:
  - The egadmin Evergreen account is an administrator account for Evergreen that you will use to test connectivity and configure your Evergreen instance.

Preamble: developer instructions

Skip this section if you are using an official release tarball downloaded from [http://evergreen-ils.org/egdownloads](http://evergreen-ils.org/egdownloads)

Developers working directly with the source code from the Git repository, rather than an official release tarball, must perform one step before they can proceed with the `.configure` step.

As the user Linux account, issue the following command in the Evergreen source directory to generate the configure script and Makefiles:

```
autoreconf -i
```
Installing prerequisites

- PostgreSQL: The minimum supported version is 9.4.

- Linux: Evergreen has been tested on Debian Stretch (9), Debian Jessie (8), Debian Wheezy (7), Ubuntu Xenial Xerus (16.04), and Ubuntu Trusty Tahr (14.04). If you are running an older version of these distributions, you may want to upgrade before upgrading Evergreen. For instructions on upgrading these distributions, visit the Debian or Ubuntu websites.

- OpenSRF: The minimum supported version of OpenSRF is 3.0.0.

Evergreen has a number of prerequisite packages that must be installed before you can successfully configure, compile, and install Evergreen.

1. Begin by installing the most recent version of OpenSRF (3.0.0 or later). You can download OpenSRF releases from http://evergreen-ils.org/opensrf-downloads/

2. On some distributions, it is necessary to install PostgreSQL 9.4+ from external repositories.

   - Debian (Wheezy) and Ubuntu (Trusty) comes with older versions of PostgreSQL, so steps are taken to automatically utilize the PostgreSQL community’s apt sources. (For complete details, see: https://wiki.postgresql.org/wiki/Apt)

   - Debian (Jessie/Stretch) and Ubuntu (Xenial) comes with PostgreSQL 9.4+, so no additional steps are required.

3. Issue the following commands as the root Linux account to install prerequisites using the Makefile.install prerequisite installer, substituting debian-stretch, debian-jessie, debian-wheezy, ubuntu-xenial, or ubuntu-trusty for <osname> below:

   ```
   make -f Open-ILS/src/extras/Makefile.install <osname>
   ```

4. Add the libdbi-libdbd libraries to the system dynamic library path by issuing the following commands as the root Linux account:

   ```
   echo "/usr/local/lib/dbd" > /etc/ld.so.conf.d/eg.conf
   ldconfig
   ```

   You should skip this step if installing on Ubuntu Trusty/Xenial or Debian Jessie/Stretch. The Ubuntu and Debian Jessie/Stretch targets use libdbd-pgsql from packages.

- Debian Wheezy.

   ```
   echo "/usr/local/lib/dbd" > /etc/ld.so.conf.d/eg.conf
   ldconfig
   ```

5. OPTIONAL: Developer additions

   To perform certain developer tasks from a Git source code checkout, additional packages may be required. As the root Linux account:

   - To install packages needed for retrieving and managing web dependencies, use the <osname>-developer Makefile.install target. Currently, this is only needed for building and installing the (preview) browser staff client.
Extra steps for web staff client

Skip this entire section if you are using an official release tarball downloaded from http://evergreen-ils.org/downloads

Install dependencies for web staff client

You may skip this section if you have installed the optional developer additions. You will still need to do the following steps in Install files for web staff client.

1. Install the long-term stability (LTS) release of Node.js. Add the Node.js /bin directory to your environment variable PATH.

Install files for web staff client

1. Building, Testing, Minification: The remaining steps all take place within the staff JS web root:
   
   cd $EVERGREEN_ROOT/Open-ILS/web/js/ui/default/staff/

2. Install Project-local Dependencies. npm inspects the package.json file for dependencies and fetches them from the Node package network.
   
   npm install   # fetch JS dependencies

3. Run the build script.
   
   # build, run tests, concat+minify
   npm run build-prod
   npm run test

Configuration and compilation instructions

For the time being, we are still installing everything in the /openils/ directory. From the Evergreen source directory, issue the following commands as the user Linux account to configure and build Evergreen:
PATH=/openils/bin:$PATH ./configure --prefix=/openils --sysconfdir=/openils/conf
make

These instructions assume that you have also installed OpenSRF under /openils/. If not, please adjust PATH as needed so that the Evergreen configure script can find osrf_config.

Installation instructions

1. Once you have configured and compiled Evergreen, issue the following command as the root Linux account to install Evergreen, build the server portion of the staff client, and copy example configuration files to /openils/conf. Change the value of the STAFF_CLIENT_STAMP_ID variable to match the version of the staff client that you will use to connect to the Evergreen server.

     make STAFF_CLIENT_STAMP_ID=rel_name install

2. The server portion of the staff client expects http://hostname/xul/server to resolve. Issue the following commands as the root Linux account to create a symbolic link pointing to the server subdirectory of the server portion of the staff client that we just built using the staff client ID rel_name:

     cd /openils/var/web/xul
     ln -sf rel_name/server server

Change ownership of the Evergreen files

All files in the /openils/ directory and subdirectories must be owned by the opensrf user. Issue the following command as the root Linux account to change the ownership on the files:

     chown -R opensrf:opensrf /openils

Run ldconfig

On Debian Stretch, run the following command as the root user:

     ldconfig

Additional Instructions for Developers

Developers working directly with the source code from the Git repository, rather than an official release tarball, need to install the Dojo Toolkit set of JavaScript libraries. The appropriate version of Dojo is included in Evergreen release tarballs. Developers should install the Dojo 1.3.3 version of Dojo by issuing the following commands as the opensrf Linux account:

     wget http://download.dojotoolkit.org/release-1.3.3/dojo-release-1.3.3.tar.gz
tar -C /openils/var/web/js -xzf dojo-release-1.3.3.tar.gz
cp -r /openils/var/web/js/dojo-release-1.3.3/* /openils/var/web/js/dojo/.

Chapter 24. Installing the Evergreen server
Report errors in this documentation using Launchpad.
Configure the Apache Web server

1. Use the example configuration files in Open-ILS/examples/apache/ (for Apache versions below 2.4) or Open-ILS/examples/apache_24/ (for Apache versions 2.4 or greater) to configure your Web server for the Evergreen catalog, staff client, Web services, and administration interfaces. Issue the following commands as the root Linux account:

   Debian Wheezy.

   ```bash
   cp Open-ILS/examples/apache/eg.conf /etc/apache2/sites-available/
   cp Open-ILS/examples/apache/eg_vhost.conf /etc/apache2/
   cp Open-ILS/examples/apache/eg_startup /etc/apache2/
   # Now set up SSL
   mkdir /etc/apache2/ssl
   cd /etc/apache2/ssl
   ```

   Ubuntu Trusty/Xenial and Debian Jessie/Stretch.

   ```bash
   cp Open-ILS/examples/apache_24/eg_24.conf /etc/apache2/sites-available/eg.conf
   cp Open-ILS/examples/apache_24/eg_vhost_24.conf /etc/apache2/eg_vhost.conf
   cp Open-ILS/examples/apache/eg_startup /etc/apache2/
   # Now set up SSL
   mkdir /etc/apache2/ssl
   cd /etc/apache2/ssl
   ```

2. The `openssl` command cuts a new SSL key for your Apache server. For a production server, you should purchase a signed SSL certificate, but you can just use a self-signed certificate and accept the warnings in the staff client and browser during testing and development. Create an SSL key for the Apache server by issuing the following command as the root Linux account:

   ```bash
   openssl req -new -x509 -days 365 -nodes -out server.crt -keyout server.key
   ```

3. As the root Linux account, edit the `eg.conf` file that you copied into place.

   a. To enable access to the offline upload / execute interface from any workstation on any network, make the following change (and note that you must secure this for a production instance):

      • (Apache 2.2): Replace `Allow from 10.0.0.0/8` with `Allow from all`
      • (Apache 2.4): Replace `Require host 10.0.0.0/8` with `Require all granted`

4. Change the user for the Apache server.

   • (Debian and Ubuntu): As the root Linux account, edit `/etc/apache2/envvars`. Change `export APACHE_RUN_USER=www-data` to `export APACHE_RUN_USER=opensrf`.

5. As the root Linux account, configure Apache with KeepAlive settings appropriate for Evergreen. Higher values can improve the performance of a single client by allowing multiple requests to be sent over the same TCP connection, but increase the risk of using up all available Apache child processes and memory.

   • (Debian and Ubuntu): Edit `/etc/apache2/apache2.conf`

     b. Change `MaxKeepAliveRequests` to 100.
6. As the root Linux account, configure the prefork module to start and keep enough Apache servers available to provide quick responses to clients without running out of memory. The following settings are a good starting point for a site that exposes the default Evergreen catalogue to the web:

Debian Wheezy (/etc/apache2/apache2.conf).

```xml
<IfModule mpm_prefork_module>
  StartServers         15
  MinSpareServers       5
  MaxSpareServers      15
  MaxClients           75
  MaxRequestsPerChild 500
</IfModule>
```

Ubuntu Trusty/Xenial, Debian Jessie/Stretch (/etc/apache2/mods-available/mpm_prefork.conf).

```xml
<IfModule mpm_prefork_module>
  StartServers            15
  MinSpareServers          5
  MaxSpareServers         15
  MaxRequestWorkers       75
  MaxConnectionsPerChild 500
</IfModule>
```

7. (Ubuntu Trusty/Xenial, Debian Jessie/Stretch) As the root user, enable the mpm_prefork module:

```bash
a2dismod mpm_event
a2enmod mpm_prefork
```

8. (Debian Wheezy): As the root Linux account, enable the Evergreen site:

```bash
a2dissite default  # OPTIONAL: disable the default site (the "It Works" page)
a2ensite eg.conf
```

(Ubuntu Trusty/Xenial, Debian Jessie/Stretch):

```bash
a2dissite 000-default  # OPTIONAL: disable the default site (the "It Works" page)
a2ensite eg.conf
```

9. (Debian and Ubuntu): As the root Linux account, enable Apache to write to the lock directory; this is currently necessary because Apache is running as the opensrf user:

```bash
chown opensrf /var/lock/apache2
```

Learn more about additional Apache options in the following sections:

- [Apache Rewrite Tricks](#)
- [Apache Access Handler Perl Module](#)

## Configure OpenSRF for the Evergreen application

There are a number of example OpenSRF configuration files in `/openils/conf/` that you can use as a template for your Evergreen installation. Issue the following commands as the opensrf Linux account:

```bash
cp -b /openils/conf/opensrf_core.xml.example /openils/conf/opensrf_core.xml
```
When you installed OpenSRF, you created four Jabber users on two separate domains and edited the `opensrf_core.xml` file accordingly. Please refer back to the OpenSRF README and, as the opensrf Linux account, edit the Evergreen version of the `opensrf_core.xml` file using the same Jabber users and domains as you used while installing and testing OpenSRF.

The `-b` flag tells the `cp` command to create a backup version of the destination file. The backup version of the destination file has a tilde (`~`) appended to the file name, so if you have forgotten the Jabber users and domains, you can retrieve the settings from the backup version of the files.

`eg_db_config`, described in [Creating the Evergreen database](#), sets the database connection information in `opensrf.xml` for you.

## Configure action triggers for the Evergreen application

Action Triggers provide hooks for the system to perform actions when a given event occurs; for example, to generate reminder or overdue notices, the `checkout.due` hook is processed and events are triggered for potential actions if there is no checkin time.

To enable the default set of hooks, issue the following command as the opensrf Linux account:

```
cp -b /openils/conf/action_trigger_filters.json.example /openils/conf/action_trigger_filters.json
```

For more information about configuring and running action triggers, see [Notifications / Action Triggers](#).

## Creating the Evergreen database

### Setting up the PostgreSQL server

For production use, most libraries install the PostgreSQL database server on a dedicated machine. Therefore, by default, the `Makefile.install` prerequisite installer does not install the PostgreSQL 9 database server that is required by every Evergreen system. You can install the packages required by Debian or Ubuntu on the machine of your choice using the following commands as the root Linux account:

(Debian / Ubuntu) Installing PostgreSQL server packages. Each OS build target provides the postgres server installation packages required for each operating system. To install Postgres server packages, use the make target `postgres-server-<OSTYPE>`.

```
make -f Open-ILS/src/extras/Makefile.install postgres-server-debian-stretch
make -f Open-ILS/src/extras/Makefile.install postgres-server-debian-jessie
make -f Open-ILS/src/extras/Makefile.install postgres-server-debian-wheezy
make -f Open-ILS/src/extras/Makefile.install postgres-server-ubuntu-trusty
make -f Open-ILS/src/extras/Makefile.install postgres-server-ubuntu-xenial
```
For a standalone PostgreSQL server, install the following Perl modules for your distribution as the root Linux account:

(Debian and Ubuntu). No extra modules required for these distributions.

You need to create a PostgreSQL superuser to create and access the database. Issue the following command as the postgres Linux account to create a new PostgreSQL superuser named `evergreen`. When prompted, enter the new user’s password:

```
createuser -s -P evergreen
```

Enabling connections to the PostgreSQL database. Your PostgreSQL database may be configured by default to prevent connections, for example, it might reject attempts to connect via TCP/IP or from other servers. To enable TCP/IP connections from localhost, check your `pg_hba.conf` file, found in the `/etc/postgresql/` directory on Debian and Ubuntu. A simple way to enable TCP/IP connections from localhost to all databases with password authentication, which would be suitable for a test install of Evergreen on a single server, is to ensure the file contains the following entries before any "host ... ident" entries:

```
host    all             all             ::1/128                 md5
host    all             all             127.0.0.1/32            md5
```

When you change the `pg_hba.conf` file, you will need to reload PostgreSQL to make the changes take effect. For more information on configuring connectivity to PostgreSQL, see [http://www.postgresql.org/docs/devel/static/auth-pg-hba-conf.html](http://www.postgresql.org/docs/devel/static/auth-pg-hba-conf.html)

### Creating the Evergreen database and schema

Once you have created the `evergreen` PostgreSQL account, you also need to create the database and schema, and configure your configuration files to point at the database server. Issue the following command as the root Linux account from inside the Evergreen source directory, replacing `<user>`, `<password>`, `<hostname>`, `<port>`, and `<dbname>` with the appropriate values for your PostgreSQL database (where `<user>` and `<password>` are for the `evergreen` PostgreSQL account you just created), and replace `<admin-user>` and `<admin-pass>` with the values you want for the egadmin Evergreen administrator account:

```
perl Open-ILS/src/support-scripts/eg_db_config --update-config
    --service all --create-database --create-schema --create-offline
    --user <user> --password <password> --hostname <hostname> --port <port> \
    --database <dbname> --admin-user <admin-user> --admin-pass <admin-pass>
```

This creates the database and schema and configures all of the services in your `/openils/conf/opensrf.xml` configuration file to point to that database. It also creates the configuration files required by the Evergreen `cgi-bin` administration scripts, and sets the user name and password for the egadmin Evergreen administrator account to your requested values.

You can get a complete set of options for `eg_db_config` by passing the `--help` parameter.

### Loading sample data

If you add the `--load-all-sample` parameter to the `eg_db_config` command, a set of authority and bibliographic records, call numbers, copies, staff and regular users, and transactions will be loaded into your target database. This sample dataset is commonly referred to as the concerto...
sample data, and can be useful for testing out Evergreen functionality and for creating problem reports that developers can easily recreate with their own copy of the concerto sample data.

**Creating the database on a remote server**

In a production instance of Evergreen, your PostgreSQL server should be installed on a dedicated server.

**PostgreSQL 9.4 and later**

To create the database instance on a remote database server running PostgreSQL 9.4 or later, simply use the `--create-database` flag on `eg_db_config`.

**Starting Evergreen**

1. As the root Linux account, start the `memcached` and `ejabberd` services (if they aren’t already running):

   ```bash
   /etc/init.d/ejabberd start
   /etc/init.d/memcached start
   ```

2. As the opensrf Linux account, start Evergreen. The `-l` flag in the following command is only necessary if you want to force Evergreen to treat the hostname as `localhost`; if you configured `opensrf.xml` using the real hostname of your machine as returned by `perl -E'print Net::Domain::hostfqdn() . "\n";` , you should not use the `-l` flag.

   ```bash
   osrf_control -l --start-all
   ```

   • If you receive the error message `bash: osrf_control: command not found`, then your environment variable `PATH` does not include the `/openils/bin` directory; this should have been set in the opensrf Linux account’s `.bashrc` configuration file. To manually set the `PATH` variable, edit the configuration file `~/.bashrc` as the opensrf Linux account and add the following line:

   ```bash
   export PATH=$PATH:/openils/bin
   ```

3. As the opensrf Linux account, generate the Web files needed by the staff client and catalogue and update the organization unit proximity (you need to do this the first time you start Evergreen, and after that each time you change the library org unit configuration. ):

   ```bash
   autogen.sh
   ```

4. As the root Linux account, restart the Apache Web server:

   ```bash
   /etc/init.d/apache2 restart
   ```

   If the Apache Web server was running when you started the OpenSRF services, you might not be able to successfully log in to the OPAC or staff client until the Apache Web server is restarted.

**Testing connections to Evergreen**

Once you have installed and started Evergreen, test your connection to Evergreen via `srfsh`. As the opensrf Linux account, issue the following commands to start `srfsh` and try to log onto the
Evergreen server using the egadmin Evergreen administrator user name and password that you set using the **eg_db_config** command:

```
$ /openils/bin/srfsh
  srfsh% login <admin-user> <admin-pass>
```

You should see a result like:

```
Received Data: "250bf1518c7527a03249858687714376"
Request Completed Successfully
Request Time in seconds: 0.045286

Received Data: { 
  "ilsevent":0, 
  "textcode":"SUCCESS", 
  "desc":"", 
  "pid":21616, 
  "stacktrace":"oils_auth.c:304", 
  "payload":{ 
    "authtoken":"e5f9827cc0f93b503a1cc66bee6bddd1a", 
    "authtime":420
  }
}
Request Completed Successfully
Request Time in seconds: 1.336568
```

If this does not work, it’s time to do some troubleshooting.

- As the opensrf Linux account, run the **settings-tester.pl** script to see if it finds any system configuration problems. The script is found at Open-ILS/src/support-scripts/settings-tester.pl in the Evergreen source tree.

- Follow the steps in the troubleshooting guide.

- If you have faithfully followed the entire set of installation steps listed here, you are probably extremely close to a working system. Gather your configuration files and log files and contact the Evergreen development mailing list for assistance before making any drastic changes to your system configuration.

## Getting help

Need help installing or using Evergreen? Join the mailing lists at [http://evergreen-ils.org/communicate/mailing-lists/](http://evergreen-ils.org/communicate/mailing-lists/) or contact us on the Freenode IRC network on the #evergreen channel.

## License

This work is licensed under the Creative Commons Attribution-ShareAlike 3.0 Unported License. To view a copy of this license, visit [http://creativecommons.org/licenses/by-sa/3.0/](http://creativecommons.org/licenses/by-sa/3.0/) or send a letter to Creative Commons, 444 Castro Street, Suite 900, Mountain View, California, 94041, USA.
Chapter 25. Upgrading the Evergreen Server

Before upgrading, it is important to carefully plan an upgrade strategy to minimize system downtime and service interruptions. All of the steps in this chapter are to be completed from the command line.

Software Prerequisites

- PostgreSQL: The minimum supported version is 9.4.
- Linux: Evergreen 3.1.1 has been tested on Debian Stretch (9.0), Debian Jessie (8.0), Debian Wheezy (7.0), Ubuntu Xenial Xerus (16.04), and Ubuntu Trusty Tahr (14.04). If you are running an older version of these distributions, you may want to upgrade before upgrading Evergreen. For instructions on upgrading these distributions, visit the Debian or Ubuntu websites.
- OpenSRF: The minimum supported version of OpenSRF is 3.0.0.

In the following instructions, you are asked to perform certain steps as either the root or opensrf user.

- Debian: To become the root user, issue the `su` command and enter the password of the root user.
- Ubuntu: To become the root user, issue the `sudo su` command and enter the password of your current user.

To switch from the root user to a different user, issue the `su - [user]` command; for example, `su - opensrf`. Once you have become a non-root user, to become the root user again simply issue the `exit` command.

Upgrade the Evergreen code

The following steps guide you through a simplistic upgrade of a production server. You must adjust these steps to accommodate your customizations such as catalogue skins.

1. Stop Evergreen and back up your data:
   a. As root, stop the Apache web server.
   b. As the opensrf user, stop all Evergreen and OpenSRF services:

```
  osrf_control --localhost --stop-all
```
   c. Back up the /openils directory.

2. Upgrade OpenSRF. Download and install the latest version of OpenSRF from the [OpenSRF download page](#).

3. As the opensrf user, download and extract Evergreen 3.1.1:
wget https://evergreen-ils.org/downloads/Evergreen-ILS-3.1.1.tar.gz
tar xzf Evergreen-ILS-3.1.1.tar.gz

For the latest edition of Evergreen, check the Evergreen download page and adjust upgrading instructions accordingly.

4. As the root user, install the prerequisites:

   cd /home/opensrf/Evergreen-ILS-3.1.1

   On the next command, replace [distribution] with one of these values for your distribution of Debian or Ubuntu:

   • **debian-jessie** for Debian Jessie (8.0) (See Bug 134222 if you want to use EDI)
   • **debian-wheezy** for Debian Wheezy (7.0)
   • **ubuntu-xenial** for Ubuntu Xenial Xerus (16.04) (EDI compatibility in progress)
   • **ubuntu-trusty** for Ubuntu Trusty Tahr (14.04) (See Bug 134222 if you want to use EDI)

   make -f Open-ILS/src/extras/Makefile.install [distribution]

5. As the opensrf user, configure and compile Evergreen:

   cd /home/opensrf/Evergreen-ILS-3.1.1

   PATH=/openils/bin:$PATH ./configure --prefix=/openils --sysconfdir=/openils/conf

   make

   These instructions assume that you have also installed OpenSRF under /openils/. If not, please adjust PATH as needed so that the Evergreen configure script can find osrf_config.

6. As the root user, install Evergreen:

   cd /home/opensrf/Evergreen-ILS-3.1.1

   make STAFF_CLIENT_STAMP_ID=rel_3_1_1 install

7. As the root user, change all files to be owned by the opensrf user and group:

   chown -R opensrf:opensrf /openils

8. As the opensrf user, update the server symlink in /openils/var/web/xul/:

   cd /openils/var/web/xul/

   rm server

   ln -sf rel_3_1_1/server server

9. As the opensrf user, update opensrf_core.xml and opensrf.xml by copying the new example files (/openils/conf/opensrf_core.xml.example and /openils/conf/opensrf.xml). The -b option creates a backup copy of the old file.

   cp -b /openils/conf/opensrf_core.xml.example /openils/conf/opensrf_core.xml
   cp -b /openils/conf/opensrf.xml.example /openils/conf/opensrf.xml
10. As the opensrf user, update the configuration files:

   cd /home/opensrf/Evergreen-ILS-3.1.1
cperl Open-ILS/src/support-scripts/eg_db_config --update-config --service all --create-offline --database evergreen --host localhost --user evergreen --password evergreen

11. As the root user, update the Apache files:

   Use the example configuration files in Open-ILS/examples/apache/ (for Apache versions below 2.4) or Open-ILS/examples/apache_24/ (for Apache versions 2.4 or greater) to configure your Web server for the Evergreen catalog, staff client, Web services, and administration interfaces. Issue the following commands as the root Linux account:

   Copying these Apache configuration files will remove any customizations you have made to them. Remember to redo your customizations after copying them. For example, if you purchased an SSL certificate, you will need to edit eg.conf to point to the appropriate SSL certificate files. The diff command can be used to show the differences between the distribution version and your customized version. `diff <customized file> <dist file>`

   a. Update /etc/apache2/eg_startup by copying the example from Open-ILS/examples/apache/eg_startup.

      cp /home/opensrf/Evergreen-ILS-3.1.1/Open-ILS/examples/apache/eg_startup /etc/apache2/eg_startup

   b. Update /etc/apache2/eg_vhost.conf by copying the example from Open-ILS/examples/apache/eg_vhost.conf.

      cp /home/opensrf/Evergreen-ILS-3.1.1/Open-ILS/examples/apache/eg_vhost.conf /etc/apache2/eg_vhost.conf

   c. Update /etc/apache2/sites-available/eg.conf by copying the example from Open-ILS/examples/apache/eg.conf.

      cp /home/opensrf/Evergreen-ILS-3.1.1/Open-ILS/examples/apache/eg.conf /etc/apache2/sites-available/eg.conf

**Upgrade the Evergreen database schema**

The upgrade of the Evergreen database schema is the lengthiest part of the upgrade process for sites with a significant amount of production data.

Before running the upgrade script against your production Evergreen database, back up your database, restore it to a test server, and run the upgrade script against the test server. This enables
Evergreen provides incremental upgrade scripts that allow you to upgrade from one minor version to the next until you have the current version of the schema. For example, if you want to upgrade from 2.9.0 to 2.11.0, you would run the following upgrade scripts:

- 2.9.0-2.9.1-upgrade-db.sql
- 2.9.1-2.9.2-upgrade-db.sql
- 2.9.2-2.9.3-upgrade-db.sql
- 2.9.3-2.10.0-upgrade-db.sql (this is a major version upgrade)
- 2.10.0-2.10.1-upgrade-db.sql
- 2.10.1-2.10.2-upgrade-db.sql
- 2.10.2-2.10.3-upgrade-db.sql
- 2.10.3-2.10.4-upgrade-db.sql
- 2.10.4-2.10.5-upgrade-db.sql
- 2.10.5-2.10.6-upgrade-db.sql
- 2.10.6-2.10.7-upgrade-db.sql
- 2.10.7-2.11.0-upgrade-db.sql (this is a major version upgrade)

Note that you do not necessarily want to run additional upgrade scripts to upgrade to the newest version, since currently there is no automated way, for example to upgrade from 2.9.4+ to 2.10. Only upgrade as far as necessary to reach the major version upgrade script (in this example, as far as 2.9.3).

Pay attention to error output as you run the upgrade scripts. If you encounter errors that you cannot resolve yourself through additional troubleshooting, please report the errors to the Evergreen Technical Discussion List.

Run the following steps (including other upgrade scripts, as noted above) as a user with the ability to connect to the database server.

```bash
cd /home/opensrf/Evergreen-ILS-3.1.1/Open-ILS/src/sql/Pg
psql -U evergreen -h localhost -f version-upgrade/3.1.0-3.1.1-upgrade-db.sql evergreen
```

After the some database upgrade scripts finish, you may see a note on how to reingest your bib records. You may run this after you have completed the entire upgrade and tested your
system. Reingesting records may take a long time depending on the number of bib records in your system.

## Restart Evergreen and Test

1. As the root user, restart memcached to clear out all old user sessions.
   
   ```
   service memcached restart
   ```

2. As the opensrf user, start all Evergreen and OpenSRF services:
   
   ```
   osrf_control --localhost --start-all
   ```

3. As the opensrf user, run autogen to refresh the static organizational data files:
   
   ```
   cd /openils/bin
   ./autogen.sh
   ```

4. Start srfsh and try logging in using your Evergreen username and password:
   
   ```
   /openils/bin/srfsh
   srfsh% login username password
   ```

   You should see a result like:

   ```
   Request Completed Successfully
   Request Time in seconds: 0.045286
   ```

   ```
   Received Data: { "ilsevent":0, "textcode":"SUCCESS", "desc":"", "pid":21616, "stacktrace":"oils_auth.c:304", "payload":{ "authtoken":"e5f9827cc0f93b503a1cc66bee6bddd1a", "authtime":420 }
   }
   ```

   ```
   Request Completed Successfully
   Request Time in seconds: 1.336568
   ```

   If this does not work, it’s time to do some troubleshooting.

5. As the root user, start the Apache web server.

   If you encounter errors, refer to the troubleshooting section of this documentation for tips on finding solutions and seeking further assistance from the Evergreen community.
Review Release Notes

Review this version’s release notes for other tasks that need to be done after upgrading. If you have upgraded over several major versions, you will need to review the release notes for each version also.
Chapter 26. Setting Up EDI Acquisitions

Introduction

Electronic Data Interchange (EDI) is used to exchange information between participating vendors and Evergreen. This chapter contains technical information for installation and configuration of the components necessary to run EDI Acquisitions for Evergreen.

Installation

Install EDI Translator

The EDI Translator is used to convert data into EDI format. It runs on localhost and listens on port 9191 by default. This is controlled via the edi_webrick.cnf file located in the edi_translator directory. It should not be necessary to edit this configuration if you install EDI Translator on the same server used for running Action/Triggers events.

If you are running Evergreen with a multi-server configuration, make sure to install EDI Translator on the same server used for Action/Trigger event generation.

Steps for Installing

1. As the opensrf user, copy the EDI Translator code found in Open-ILS/src/edi_translator to somewhere accessible (for example, /openils/var/edi):
   
   ```
   cp -r Open-ILS/src/edi_translator /openils/var/edi
   ```

2. Navigate to where you have saved the code to begin next step:
   
   ```
   cd /openils/var/edi
   ```

3. Next, as the root user (or a user with sudo rights), install the dependencies, via "install.sh". This will perform some apt-get routines to install the code needed for the EDI translator to function. (Note: subversion must be installed first)
   
   ```
   ./install.sh
   ```

4. Now, we’re ready to start "edi_webrick.bash" which is the script that calls the "Ruby" code to translate EDI. This script needs to be started in order for EDI to function so please take appropriate measures to ensure this starts following reboots/upgrades/etc. As the opensrf user:
   
   ```
   ./edi_webrick.bash
   ```

5. You can check to see if EDI translator is running.

   • Using the command "ps aux | grep edi" should show you something similar if the script is running properly:

   ```
   root 30349  0.8  0.1 52620 10824 pts/0   S   13:04 0:00 ruby ./edi_webrick.rb
   ```
To shutdown EDI Translator you can use something like `pkill` (assuming no other ruby processes are running on that server):

```
kill -INT $(pgrep ruby)
```

## Install EDI Scripts

The EDI scripts are "edi_pusher.pl" and "edi_fetcher.pl" and are used to "push" and "fetch" EDI messages for configured EDI accounts.

1. As the opensrf user, copy `edi_pusher.pl` and `edi_fetcher.pl` from `Open-ILS/src/support-scripts` into `/openils/bin`:

   ```
cp Open-ILS/src/support-scripts/edi_pusher.pl /openils/bin
   cp Open-ILS/src/support-scripts/edi_fetcher.pl /openils/bin
   ```

2. Setup the `edi_pusher.pl` and `edi_fetcher.pl` scripts to run as cron jobs in order to regularly push and receive EDI messages.

   - Add to the `opensrf` user’s crontab the following entries:

     ```
     10 * * * * cd /openils/bin && /usr/bin/perl ./edi_pusher.pl > /dev/null
     0 1 * * * cd /openils/bin && /usr/bin/perl ./edi_fetcher.pl > /dev/null
     ```

   - The example for `edi_pusher.pl` sets the script to run at 10 minutes past the hour, every hour.

   - The example for `edi_fetcher.pl` sets the script to run at 1 AM every night.

---

You may choose to run the EDI scripts more or less frequently based on the necessary response times from your vendors.

### Configuration

#### Configuring Providers

Look in Administration → Acquisitions Administration → Providers

<table>
<thead>
<tr>
<th>Column</th>
<th>Description/Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>A unique name to identify the provider</td>
</tr>
<tr>
<td>Code</td>
<td>A unique code to identify the provider</td>
</tr>
<tr>
<td>Owner</td>
<td>The org unit who will &quot;own&quot; the provider.</td>
</tr>
<tr>
<td>Currency</td>
<td>The currency format the provider accepts</td>
</tr>
<tr>
<td>Active</td>
<td>Whether or not the Provider is &quot;active&quot; for use</td>
</tr>
<tr>
<td>Default Claim Policy</td>
<td>??</td>
</tr>
<tr>
<td>EDI Default</td>
<td>The default &quot;EDI Account&quot; to use (see EDI Accounts Configuration)</td>
</tr>
<tr>
<td>Email</td>
<td>The email address for the provider</td>
</tr>
</tbody>
</table>
Configuring EDI Accounts

Look in Administration → Acquisitions Administration → EDI Accounts

<table>
<thead>
<tr>
<th>Column</th>
<th>Description/Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Phone</td>
<td>A fax number for the provider</td>
</tr>
<tr>
<td>Holdings Tag</td>
<td>The holdings tag to be utilized (usually 852, for Evergreen)</td>
</tr>
<tr>
<td>Phone</td>
<td>A phone number for the provider</td>
</tr>
<tr>
<td>Prepayment Required</td>
<td>Whether or not prepayment is required</td>
</tr>
<tr>
<td>SAN</td>
<td>The vendor provided, org unit specific SAN code</td>
</tr>
<tr>
<td>URL</td>
<td>The vendor website</td>
</tr>
</tbody>
</table>

Configuring Organizational Unit SAN code

Look in Administration → Server Administration → Organizational Units

This interface allows a library to configure their SAN, alongside their address, phone, etc.

Troubleshooting

PO JEDI Template Issues

Some libraries may run into issues with the action/trigger (PO JEDI). The template has to be modified to handle different vendor codes that may be used. For instance, if you use "ingra" instead of
INGRAM this may cause a problem because they are hardcoded in the template. The following is an example of one modification that seems to work.

Original template has:

```
"buyer": [
    [%- IF target.provider.edi_default.vendcode && (target.provider.code == 'BT' ||
    target.provider.name.match('(?i)^BAKER & TAYLOR') ) -%]
    {"id-qualifier": 91, "id": "[% target.ordering_agency.mailing_address.san ' ' _
    target.provider.edi_default.vendcode %]"}
    [%- ELSIF target.provider.edi_default.vendcode && target.provider.code == 'INGRAM' -%]
    {"id": "[% target.ordering_agency.mailing_address.san %]",
    {"id-qualifier": 91, "id": "[% target.provider.edi_default.vendcode %]"}
    [%- ELSE -%]
    {"id": "[% target.ordering_agency.mailing_address.san %]"}
    [%- END -%]
],
```

Modified template has the following where it matches on provider SAN instead of code:

```
"buyer": [
    [%- IF target.provider.edi_default.vendcode && (target.provider.code == 'BT' ||
    target.provider.name.match('(?i)^BAKER & TAYLOR') ) -%]
    {"id-qualifier": 91, "id": "[% target.ordering_agency.mailing_address.san ' ' _
    target.provider.edi_default.vendcode %]"}
    [%- ELSIF target.provider.edi_default.vendcode && target.provider.code == 'INGRAM' -%]
    {"id": "[% target.ordering_agency.mailing_address.san %]",
    {"id-qualifier": 91, "id": "[% target.provider.edi_default.vendcode %]"}
    [%- ELSE -%]
    {"id": "[% target.ordering_agency.mailing_address.san %]"}
    [%- END -%]
],
```
Part IV. System Configuration and Customization
# Table of Contents

27. Introduction .......................................................... 100
28. Describing your organization ........................................... 101
    Organization Unit Types .................................................. 101
    Create and edit Organization Unit Types ................................ 101
    Organizational Units ...................................................... 101
    Remove or edit default Organizational Units ......................... 102
    Create and edit Organizational Units .................................. 102
    Organizational Unit data ................................................ 102
    After Changing Organization Unit Data ................................ 102
29. Describing your people ................................................ 103
    Setting the staff user’s working location .............................. 103
    Comparing approaches for managing permissions ...................... 104
    Managing permissions in the staff client ............................... 105
    Where to find existing permissions and what they mean .............. 105
    Where to find existing Permission Groups ............................. 105
    Adding or removing permissions from a Permission Group ............ 105
    Managing role-based permission groups in the staff client ........ 106
    Secondary Group Permissions ........................................... 106
    Managing role-based permission groups in the database ............. 109
30. Migrating Patron Data .................................................. 112
    Introduction .................................................................. 112
    Creating an sql Script for Importing Patrons ......................... 114
    Batch Updating Patron Data .............................................. 115
31. Migrating from a legacy system ....................................... 116
    Introduction .................................................................. 116
    Making electronic resources visible in the catalog ................... 116
    Migrating your bibliographic records .................................... 117
    Migrating your call numbers, copies, and parts ........................ 118
32. Importing materials in the staff client ................................. 121
    Staff client batch record imports ....................................... 121
    When to use the MARC Batch Importer .................................. 121
    Record Match Sets ......................................................... 121
    Create Match Sets ........................................................ 122
    Quality Metrics ........................................................... 123
    Import Item Attributes .................................................... 123
    Overlay/Merge Profiles ................................................... 124
    Importing the records ..................................................... 125
33. Ordering materials ....................................................... 127
    Introduction .................................................................. 127
    When should libraries use acquisitions? ................................ 127
    Managing Funds ................................................................ 127
    Funding Sources (Required) .............................................. 127
    Funds (Required) ............................................................ 128
    Fund Tags (Optional) ....................................................... 129
    Ordering ....................................................................... 129
    Providers (Required) ....................................................... 129
    Distribution Formulas (Optional) ........................................ 129
    Helpful acquisitions Library Settings ................................... 130
    Preparing for order record loading ...................................... 130
    Preparing to send electronic orders from Evergreen ................. 131
34. Designing your catalog ..................................................... 133
Configuring and customizing the public interface .................................................. 133
  Locating the default template files ................................................................. 133
  Mapping templates to URLs ............................................................................. 133
  How to override template files ........................................................................... 134
  Configuring the custom templates directory in Apache’s cg.conf ...................... 134
  Adjusting colors for your public interface ......................................................... 135
  Adjusting fonts in your public interface ............................................................ 135
  Media file locations in the public interface ....................................................... 135
  Changing some text in the public interface ....................................................... 135
  Adding translations to PO file ............................................................................ 136
  Adding and removing MARC fields from the record details display page .......... 137
Setting the default physical location for your library environment ...................... 137
Setting a default language and adding optional languages .................................... 138
  Updating translations in Evergreen using current translations from Launchpad .... 138
Change Date Format in Patron Account View ....................................................... 139
Including External Content in Your Public Interface ............................................ 139
  OpenLibrary ........................................................................................................ 139
  ChiliFresh ........................................................................................................... 140
  Content Café ....................................................................................................... 140
  Obalkynih.cz ...................................................................................................... 141
  Google Analytics ............................................................................................... 142
  NoveList ............................................................................................................ 142
  RefWorks ............................................................................................................ 142
  SFX OpenURL Resolver ...................................................................................... 142
  Syndetic Solutions ............................................................................................. 142
  Clear External/Added Content Cache ............................................................... 143
  Configure a Custom Image for Missing Images ................................................. 144
Including Locally Hosted Content in Your Public Interface .................................. 144
  File Location and Format .................................................................................... 144
  Example .............................................................................................................. 144
35. Designing the patron search experience ............................................................ 146
  Editing the formats select box options in the search interface ............................ 146
  Adding and removing search fields in advanced search .................................... 147
  Changing the display of facets and facet groups .............................................. 147
  Facilitating search scope changes ...................................................................... 148
36. Borrowing items: who, what, for how long ....................................................... 149
  Data elements that affect your circulation policies .......................................... 149
    Copy data ........................................................................................................... 149
    Copy location data .......................................................................................... 149
    User data .......................................................................................................... 150
  Circulation Rules ................................................................................................. 150
    Circulation Limit Sets ....................................................................................... 153
  Creating Circulation Policies ............................................................................ 154
    Best practices for creating policies .................................................................. 155
    Settings Relevant to Circulation ...................................................................... 156
37. Hard due dates .................................................................................................. 158
  Creating a hard due date .................................................................................... 158
38. TPAC Configuration and Customization .......................................................... 160
  Template toolkit documentation ........................................................................ 160
  TPAC URL ......................................................................................................... 160
  Perl modules used directly by TPAC ............................................................... 160
  Default templates .............................................................................................. 160
  Apache configuration files ............................................................................... 160
  TPAC CSS and media files ............................................................................... 161
Part IV. System Configuration and Customization

39. Creating a New Skin: the Bare Minimum ................................................................. 165
   Introduction .................................................................................................................. 165
   Apache directives ....................................................................................................... 165
   Customizing templates ............................................................................................... 165
   Considerations for Community Adoption .................................................................. 167
   Outstanding Development (Unsponsored) .................................................................. 167

40. Auto Suggest in Catalog Search .............................................................................. 168
   Enabling this Feature .................................................................................................. 168
   Using this Feature ....................................................................................................... 168

41. Authentication Proxy ............................................................................................... 170

42. Kid’s OPAC Configuration ..................................................................................... 172
   Configuration ............................................................................................................. 172
      Apache ..................................................................................................................... 172
      XML Configuration File ......................................................................................... 172
      Skin Configuration .................................................................................................. 173
   Considerations for Community Adoption .................................................................. 173
   Outstanding Development (Unsponsored) .................................................................. 174

43. Patron Address City/State/County Pre-Populate by ZIP Code .............................. 175
   Scoping and Permissions ............................................................................................ 175
   Setup Steps ................................................................................................................ 175
      Step 1 - Setup Data File ......................................................................................... 175
      Step 2 - Enable Feature ......................................................................................... 176
      Step 3 - Test ............................................................................................................ 177
   ZIP Code Data ........................................................................................................... 177
      Manual Entry .......................................................................................................... 177
      Geonames.org Data ............................................................................................... 177
      Commercial Data .................................................................................................... 177
      Existing Patron Database ....................................................................................... 178
   Development .............................................................................................................. 178

44. Phonelist.pm Module ............................................................................................... 179
   Introduction ................................................................................................................. 179
   Adding Parameters ..................................................................................................... 180
   Output ........................................................................................................................ 181
   Holds .......................................................................................................................... 181
   Overdues .................................................................................................................... 181
   Skipping patrons with email notification of holds ......................................................... 182
   Using the ws_ou parameter ....................................................................................... 182
   Automating the download ......................................................................................... 182

45. SIP Server ................................................................................................................ 183
   About the SIP Protocol .............................................................................................. 183
   Installing the SIP Server ........................................................................................... 183
      Getting the code ....................................................................................................... 183
      Configuring the Server ............................................................................................ 183
      Adding SIP Users .................................................................................................... 184
      Running the server .................................................................................................. 185
      Logging-SIP ............................................................................................................. 185
      Testing Your SIP Connection .................................................................................. 186
      More Testing ............................................................................................................ 187
   SIP Communication .................................................................................................... 188
      01 Block Patron ....................................................................................................... 189
      09/10 Checkin ........................................................................................................... 190

Mapping templates to URLs ......................................................................................... 161
How to override templates ............................................................................................ 161
   Defining multiple layers of overrides ....................................................................... 162
   Changing some text in the TPAC .............................................................................. 163
   Troubleshooting ........................................................................................................ 164
Part IV. System Configuration and Customization

Report errors in this documentation using Launchpad.
Chapter 27. Introduction

The Evergreen system allows a free range of customizations to every aspect of the system. Use this part of the documentation to become familiar with the tools for configuring the system as well as customizing the catalog and staff client.
Chapter 28. Describing your organization

Your Evergreen system is almost ready to go. You’ll need to add each of the libraries that will be using your Evergreen system. If you’re doing this for a consortium, you’ll have to add your consortium as a whole, and all the libraries and branches that are members of the consortium. In this chapter, we’ll talk about how to get the Evergreen system to see all your libraries, how to set each one up, and how to edit all the details of each one.

Organization Unit Types

The term Organization Unit Types refers to levels in the hierarchy of your library system(s). Examples could include: All-Encompassing Consortium, Library System, Branch, Bookmobile, Sub-Branch, etc.

You can add or remove organizational unit types, and rename them as needed to match the organizational hierarchy that matches the libraries using your installation of Evergreen. Organizational unit types should never have proper names since they are only generic types.

When working with configuration, settings, and permissions, it is very important to be careful of the Organization Unit Context Location - this is the organizational unit to which the configuration settings are being applied. If, for example, a setting is applied at the Consortium context location, all child units will inherit that setting. If a specific branch location is selected, only that branch and its child units will have the setting applied. The levels of the hierarchy to which settings can be applied are often referred to in terms of "depth" in various configuration interfaces. In a typical hierarchy, the consortium has a depth of 0, the system is 1, the branch is 2, and any bookmobiles or sub-branches is 3.

Create and edit Organization Unit Types

1. Open Administration > Server Administration > Organization Types.
2. In the left panel, expand the Organization Unit Types hierarchy.
3. Click on a organization type to edit the existing type or to add a new organization unit.
4. A form opens in the right panel, displaying the data for the selected organization unit.
5. Edit the fields as required and click Save.

To create a new dependent organization unit, click New Child. The new child organization unit will appear in the left panel list below the parent. Highlight the new unit and edit the data as needed, click Save.

Organizational Units

Organizational Units are the specific instances of the organization unit types that make up your library’s hierarchy. These will have distinctive proper names such as Main Street Branch or Townsville Campus.
Remove or edit default Organizational Units

After installing the Evergreen software, the default CONS, SYS1, BR1, etc., organizational units remain. These must be removed or edited to reflect actual library entities.

Create and edit Organizational Units

1. Open Administration > Server Administration > Organizational Units.
2. In the left panel, expand the the Organizational Units hierarchy, select a unit.
3. A form opens in the right panel, displaying the data for the selected organizational unit.
4. To edit the existing, default organizational unit, enter system or library specific data in the form; complete all three tabs: Main Settings, Hours of Operation, Addresses.
5. Click Save.

To create a new dependent organizational unit, click New Child. The new child will appear in the hierarchy list below the parent unit. Click on the new unit and edit the data, click Save

Organizational Unit data

The Addresses tab allows you to enter library contact information. Library Phone number, email address, and addresses are used in patron email notifications, hold slips, and transit slips. The Library address tab is broken out into four address types: Physical Address, Holds Address, Mailing Address, ILL Address.

The Hours of Operation tab is where you enter regular, weekly hours. Holiday and other closures are set in the Closed Dates Editor. Hours of operation and closed dates impact due dates and fine accrual.

After Changing Organization Unit Data

After you change Org Unit data, you must run the autogen.sh script. This script updates the Evergreen organization tree and fieldmapper IDL. You will get unpredictable results if you don’t run this after making changes.

Run this script as the opensrf Linux account.

autogen.sh
Chapter 29. Describing your people

Many different members of your staff will use your Evergreen system to perform the wide variety of tasks required of the library.

When the Evergreen installation was completed, a number of permission groups should have been automatically created. These permission groups are:

- Users
- Patrons
- Staff
- Catalogers
- Circulators
- Acquisitions
- Acquisitions Administrator
- Cataloging Administrator
- Circulation Administrator
- Local Administrator
- Serials
- System Administrator
- Global Administrator
- Data Review
- Volunteers

Each of these permission groups has a different set of permissions connected to them that allow them to do different things with the Evergreen system. Some of the permissions are the same between groups; some are different. These permissions are typically tied to one or more working location (sometimes referred to as a working organizational unit or work OU) which affects where a particular user can exercise the permissions they have been granted.

Setting the staff user’s working location

To grant a working location to a staff user in the staff client:

1. Search for the patron. Select Search > Search for Patrons from the top menu.

2. When you retrieve the correct patron record, select Other > User Permission Editor from the upper right corner. The permissions associated with this account appear in the right side of the client, with the Working Location list at the top of the screen.
3. The Working Location list displays the Organizational Units in your consortium. Select the check box for each Organization Unit where this user needs working permissions. Clear any other check boxes for Organization Units where the user no longer requires working permissions.

4. Scroll all the way to the bottom of the page and click Save. This user account is now ready to be used at your library.

As you scroll down the page you will come to the Permissions list. These are the permissions that are given through the Permission Group that you assigned to this user. Depending on your own permissions, you may also have the ability to grant individual permissions directly to this user.

Comparing approaches for managing permissions

The Evergreen community uses two different approaches to deal with managing permissions for users:

• Staff Client

Evergreen libraries that are most comfortable using the staff client tend to manage permissions by creating different profiles for each type of user. When you create a new user, the profile you assign to the user determines their basic set of permissions. This approach requires many permission groups that contain overlapping sets of permissions: for example, you might need to create a Student Circulator group and a Student Cataloger group. Then if a new employee needs to perform both of these roles, you need to create a third Student Cataloger / Circulator group representing the set of all of the permissions of the first two groups.

The advantage to this approach is that you can maintain the permissions entirely within the staff client; a drawback to this approach is that it can be challenging to remember to add a new permission to all of the groups. Another drawback of this approach is that the user profile is also used to determine circulation and hold rules, so the complexity of your circulation and hold rules might increase significantly.

• Database Access

Evergreen libraries that are comfortable manipulating the database directly tend to manage permissions by creating permission groups that reflect discrete roles within a library. At the database level, you can make a user belong to many different permission groups, and that can simplify your permission management efforts. For example, if you create a Student Circulator group and a Student Cataloger group, and a new employee needs to perform both of these roles, you can simply assign them to both of the groups; you do not need to create an entirely new permission group in this case. An advantage of this approach is that the user profile can represent only the user’s borrowing category and requires only the basic Patrons permissions, which can simplify your circulation and hold rules.

Permissions and profiles are not carved in stone. As the system administrator, you can change them as needed. You may set and alter the permissions for each permission group in line with what your library, or possibly your consortium, defines as the appropriate needs for each function in the library.
Managing permissions in the staff client

In this section, we’ll show you in the staff client:

• where to find the available permissions
• where to find the existing permission groups
• how to see the permissions associated with each group
• how to add or remove permissions from a group

We also provide an appendix with a listing of suggested minimum permissions for some essential groups. You can compare the existing permissions with these suggested permissions and, if any are missing, you will know how to add them.

Where to find existing permissions and what they mean

In the staff client, in the upper right corner of the screen, click on Administration > Server Administration > Permissions.

The list of available permissions will appear on screen and you can scroll down through them to see permissions that are already available in your default installation of Evergreen.

There are over 500 permissions in the permission list. They appear in two columns: Code and Description. Code is the name of the permission as it appear in the Evergreen database. Description is a brief note on what the permission allows. All of the most common permissions have easily understandable descriptions.

Where to find existing Permission Groups

In the staff client, in the upper right corner of the screen, navigate to Administration > Server Administration > Permission Groups.

Two panes will open on your screen. The left pane provides a tree view of existing Permission Groups. The right pane contains two tabs: Group Configuration and Group Permissions.

In the left pane, you will find a listing of the existing Permission Groups which were installed by default. Click on the + sign next to any folder to expand the tree and see the groups underneath it. You should see the Permission Groups that were listed at the beginning of this chapter. If you do not and you need them, you will have to create them.

Adding or removing permissions from a Permission Group

First, we will remove a permission from the Staff group.

1. From the list of Permission Groups, click on Staff.

2. In the right pane, click on the Group Permissions tab. You will now see a list of permissions that this group has.
3. From the list, choose CREATE_CONTAINER. This will now be highlighted.

4. Click the Delete Selected button. CREATE_CONTAINER will be deleted from the list. The system will not ask for a confirmation. If you delete something by accident, you will have to add it back.

5. Click the Save Changes button.

You can select a group of individual items by holding down the Ctrl key and clicking on them. You can select a list of items by clicking on the first item, holding down the Shift key, and clicking on the last item in the list that you want to select.

Now, we will add the permission we just removed back to the Staff group.

1. From the list of Permission Groups, click on Staff.

2. In the right pane, click on the Group Permissions tab.

3. Click on the New Mapping button. The permission mapping dialog box will appear.

4. From the Permission drop down list, choose CREATE_CONTAINER.

5. From the Depth drop down list, choose Consortium.

6. Click the checkbox for Grantable.

7. Click the Add Mapping button. The new permission will now appear in the Group Permissions window.

8. Click the Save Changes button.

If you have saved your changes and you don’t see them, you may have to click the Reload button in the upper left side of the staff client screen.

**Managing role-based permission groups in the staff client**

Main permission groups are granted in the staff client through Edit in the patron record using the Main (Profile) Permission Group field. Additional permission groups can be granted using secondary permission groups.

**Secondary Group Permissions**

The Secondary Groups button functionality enables supplemental permission groups to be added to staff accounts. The CREATE_USER_GROUP_LINK and REMOVE_USER_GROUP_LINK permissions are required to display and use this feature.

In general when creating a secondary permission group do not grant the permission to login to Evergreen.

**Granting Secondary Permissions Groups**

1. Open the account of the user you wish to grant secondary permission group to.
2. Click Edit.

3. Click Secondary Groups, located to the right of the Main (Profile) Permission Group.

4. From the dropdown menu select one of the secondary permission groups.

5. Click Add.

6. Click Apply Changes.

7. Click Save in the top right hand corner of the Edit Screen to save the user’s account.
Removing Secondary Group Permissions

1. Open the account of the user you wish to remove the secondary permission group from.

2. Click Edit.

3. Click Secondary Groups, located to the right of the Main (Profile) Permission Group.

4. Click Delete beside the permission group you would like to remove.

5. Click Apply Changes.

6. Click Save in the top right hand corner of the Edit Screen to save the user’s account.
Managing role-based permission groups in the database

While the ability to assign a user to multiple permission groups has existed in Evergreen for years, a staff client interface is not currently available to facilitate the work of the Evergreen administrator. However, if you or members of your team are comfortable working directly with the Evergreen database, you can use this approach to separate the borrowing profile of your users from the permissions that you grant to staff, while minimizing the amount of overlapping permissions that you need to manage for a set of permission groups that would otherwise multiply exponentially to represent all possible combinations of staff roles.

In the following example, we create three new groups:

- a Student group used to determine borrowing privileges
- a Student Cataloger group representing a limited set of cataloging permissions appropriate for students
- a Student Circulator group representing a limited set of circulation permissions appropriate for students

Then we add three new users to our system: one who needs to perform some cataloging duties as a student; one who needs perform some circulation duties as a student; and one who needs to perform both cataloging and circulation duties. This section demonstrates how to add these permissions to the users at the database level.

To create the Student group, add a new row to the permission.grp_tree table as a child of the Patrons group:

```sql
INSERT INTO permission.grp_tree (name, parent, usergroup, description, application_perm)
SELECT 'Students', pgt.id, TRUE, 'Student borrowers', 'group_application.user.patron.student'
FROM permission.grp_tree pgt
WHERE name = 'Patrons';
```

To create the Student Cataloger group, add a new row to the permission.grp_tree table as a child of the Staff group:

```sql
INSERT INTO permission.grp_tree (name, parent, usergroup, description, application_perm)
SELECT 'Student Catalogers', pgt.id, TRUE, 'Student catalogers',
'group_application.user.staff.student_cataloger'
FROM permission.grp_tree pgt
WHERE name = 'Staff';
```

To create the Student Circulator group, add a new row to the permission.grp_tree table as a child of the Staff group:

```sql
INSERT INTO permission.grp_tree (name, parent, usergroup, description, application_perm)
SELECT 'Student Circulators', pgt.id, TRUE, 'Student circulators',
'group_application.user.staff.student_circulator'
FROM permission.grp_tree pgt
WHERE name = 'Staff';
```

We want to give the Student Catalogers group the ability to work with MARC records at the consortial level, so we assign the UPDATE_MARC, CREATE_MARC, and IMPORT_MARC permissions at depth 0:
WITH pgt AS (  
  SELECT id  
  FROM permission.grp_tree  
  WHERE name = 'Student Catalogers'
)  
INSERT INTO permission.grp_perm_map (grp, perm, depth)  
SELECT pgt.id, ppl.id, 0  
FROM permission.perm_list ppl, pgt  
WHERE ppl.code IN ('UPDATE_MARC', 'CREATE_MARC', 'IMPORT_MARC');

Similarly, we want to give the Student Circulators group the ability to check out copies and record  
in-house uses at the system level, so we assign the COPY_CHECKOUT and CREATE_IN_HOUSE_USE  
permissions at depth 1 (overriding the same Staff permissions that were granted only at depth 2):

WITH pgt AS (  
  SELECT id  
  FROM permission.grp_tree  
  WHERE name = 'Student Circulators'
)  
INSERT INTO permission.grp_perm_map (grp, perm, depth)  
SELECT pgt.id, ppl.id, 1  
FROM permission.perm_list ppl, pgt  
WHERE ppl.code IN ('COPY_CHECKOUT', 'CREATE_IN_HOUSE_USE');

Finally, we want to add our students to the groups. The request may arrive in your inbox from  
the library along the lines of "Please add Mint Julep as a Student Cataloger, Bloody Caesar as a  
Student Circulator, and Grass Hopper as a Student Cataloguer / Circulator; I’ve already created  
their accounts and given them a work organizational unit." You can translate that into the following  
SQL to add the users to the pertinent permission groups, adjusting for the inevitable typos in the  
names of the users.

First, add our Student Cataloger:

WITH pgt AS (  
  SELECT id FROM permission.grp_tree  
  WHERE name = 'Student Catalogers'
)  
INSERT INTO permission.usr_grp_map (usr, grp)  
SELECT au.id, pgt.id  
FROM actor.usr au, pgt  
WHERE first_given_name = 'Mint' AND family_name = 'Julep';

Next, add the Student Circulator:

WITH pgt AS (  
  SELECT id FROM permission.grp_tree  
  WHERE name = 'Student Circulators'
)  
INSERT INTO permission.usr_grp_map (usr, grp)  
SELECT au.id, pgt.id  
FROM actor.usr au, pgt  
WHERE first_given_name = 'Bloody' AND family_name = 'Caesar';

Finally, add the all-powerful Student Cataloger / Student Circulator:

WITH pgt AS (  
  SELECT id FROM permission.grp_tree  
  WHERE name IN ('Student Catalogers', 'Student Circulators')
)  
INSERT INTO permission.usr_grp_map (usr, grp)  
SELECT au.id, pgt.id  
FROM actor.usr au, pgt  
WHERE first_given_name = 'Grass' AND family_name = 'Hopper';
While adopting this role-based approach might seem labour-intensive when applied to a handful of students in this example, over time it can help keep the permission profiles of your system relatively simple in comparison to the alternative approach of rapidly reproducing permission groups, overlapping permissions, and permissions granted on a one-by-one basis to individual users.
Chapter 30. Migrating Patron Data

Introduction

This section will explain the task of migrating your patron data from comma delimited files into Evergreen. It does not deal with the process of exporting from the non-Evergreen system since this process may vary depending on where you are extracting your patron records. Patron could come from an ILS or it could come from a student database in the case of academic records.

When importing records into Evergreen you will need to populate 3 tables in your Evergreen database:

- actor.usr - The main table for user data

- actor.card - Stores the barcode for users; Users can have more than 1 card but only 1 can be active at a given time;

- actor.usr_address - Used for storing address information; A user can have more than one address.

Before following the procedures below to import patron data into Evergreen, it is a good idea to examine the fields in these tables in order to decide on a strategy for data to include in your import. It is important to understand the data types and constraints on each field.

1. Export the patron data from your existing ILS or from another source into a comma delimited file. The comma delimited file used for importing the records should use Unicode (UTF8) character encoding.

2. Create a staging table. A staging table will allow you to tweak the data before importing. Here is an example sql statement:

   ```sql
   CREATE TABLE students (
   student_id int, barcode text, last_name text, first_name text, email text,
   address_type text, street1 text, street2 text,
   city text, province text, country text, postal_code text, phone text, profile
   int DEFAULT 2, ident_type int, home_ou int, claims_returned_count int DEFAULT 0, usrname text, net_access_level int DEFAULT 2, password text
   );
   ```

   The default variables allow you to set default for your library or to populate required fields in Evergreen if your data includes NULL values.

   The data field profile in the above SQL script refers to the user group and should be an integer referencing the id field in permission.grp_tree. Setting this value will affect the permissions for the user. See the values in permission.grp_tree for possibilities.

   ident_type is the identification type used for identifying users. This is a integer value referencing config.identification_type and should match the id values of that table. The default values are 1 for Drivers License, 2 for SSN or 3 for other.
home_ou is the home organizational unit for the user. This value needs to match the corresponding id in the actor.org_unit table.

3. Copy records into staging table from a comma delimited file.

```sql
COPY students (student_id, last_name, first_name, email, address_type, street1, street2, city, province, country, postal_code, phone)
FROM '/home/opensrf/patrons.csv'
WITH CSV HEADER;
```

The script will vary depending on the format of your patron load file (patrons.csv).

4. Formatting of some fields to fit Evergreen filed formatting may be required. Here is an example of sql to adjust phone numbers in the staging table to fit the evergreen field:

```sql
UPDATE students phone = replace(replace(replace(rpad(substring(phone from 1 for 9), 10, '-') ||
substring(phone from 10), '(', ''), ')', ''), ' ', '-');
```

Data “massaging” will be required to fit formats used in Evergreen.

5. Insert records from the staging table into the actor.usr Evergreen table:

```sql
INSERT INTO actor.usr (profile, usrname, email, passwd, ident_type, ident_value, first_given_name,
family_name, day_phone, home_ou, claims_returned_count, net_access_level)
SELECT profile, students.usrname, email, password, ident_type, student_id,
first_name, last_name, phone, home_ou, claims_returned_count, net_access_level
FROM students;
```

6. Insert records into actor.card from actor.usr.

```sql
INSERT INTO actor.card (usr, barcode)
SELECT actor.usr.id, students.barcode
FROM students
INNER JOIN actor.usr
ON students.usrname = actor.usr.usrname;
```

This assumes a one to one card patron relationship. If your patron data import has multiple cards assigned to one patron more complex import scripts may be required which look for inactive or active flags.

7. Update actor.usr.card field with actor.card.id to associate active card with the user:

```sql
UPDATE actor.usr
SET card = actor.card.id
FROM actor.card
WHERE actor.card.usr = actor.usr.id;
```

8. Insert records into actor.usr_address to add address information for users:

```sql
INSERT INTO actor.usr_address (usr, street1, street2, city, state, country, post_code)
SELECT actor.usr.id, students.street1, students.street2, students.city, students.province,
students.country, students.postal_code
FROM students
INNER JOIN actor.usr
ON students.usrname = actor.usr.usrname;
```

9. Update actor.usr.address with address id from address table.

```sql
UPDATE actor.usr
SET mailing_address = actor.usr_address.id, billing_address = actor.usr_address.id
FROM actor.usr_address
```
WHERE actor.usr.id = actor.usr_address.usr;

This assumes 1 address per patron. More complex scenarios may require more sophisticated SQL.

Creating an sql Script for Importing Patrons

The procedure for importing patron can be automated with the help of an sql script. Follow these steps to create an import script:

1. Create an new file and name it import.sql
2. Edit the file to look similar to this:

```sql
BEGIN;

-- Remove any old staging table.
DROP TABLE IF EXISTS students;

-- Create staging table.
CREATE TABLE students (student_id text, barcode text, last_name text, first_name text, email text, address_type text, street1 text, street2 text, city text, province text, country text, postal_code text, phone text, profile int, ident_type int, home_ou int, claims_returned_count int DEFAULT 0, username text, net_access_level int DEFAULT 2, password text, already_exists boolean DEFAULT FALSE);

--Copy records from your import text file
COPY students (student_id, last_name, first_name, email, address_type, street1, street2, city, province, country, postal_code, phone, password)
FROM '/home/opensrf/patrons.csv' WITH CSV HEADER;

--Determine which records are new, and which are merely updates of existing patrons
--You may with to also add a check on the home_ou column here, so that you don't
--accidentaly overwrite the data of another library in your consortium.
--You may also use a different matchpoint than actor.usr.ident_value.
UPDATE students
SET already_exists = TRUE
FROM actor.usr
WHERE students.student_id = actor.usr.ident_value;

--Update the names of existing patrons, in case they have changed their name
UPDATE actor.usr
SET first_given_name = students.first_name, family_name=students.last_name
FROM students
WHERE actor.usr.ident_value=students.student_id
AND (first_given_name != students.first_name OR family_name != students.last_name)
AND students.already_exists;

--Update email addresses of existing patrons
--You may wish to update other fields as well, while preserving others
--actor.usr.passwd is an example of a field you may not wish to update,
--since patrons may have set the password to something other than the
--default.
UPDATE actor.usr
SET email=students.email
FROM students
WHERE actor.usr.ident_value=students.student_id
AND students.email != ''
AND actor.usr.email != students.email
AND students.already_exists;

--Insert records from the staging table into the actor.usr table.
```

Chapter 30. Migrating Patron Data

Report errors in this documentation using Launchpad.
INSERT INTO actor.usr (profile, username, email, passwd, ident_type, ident_value, first_given_name, family_name, day_phone, home_ou, claims Returned count, net_access_level)
SELECT profile, students.usrname, email, password, ident_type, student_id, first_name, last_name, phone, home_ou, claims Returned count, net_access_level
FROM students WHERE NOT already_exists;

--Insert records from the staging table into the actor.card table.
INSERT INTO actor.card (usr, barcode)
SELECT actor.usr.id, students.barcode
FROM students
INNER JOIN actor.usr
ON students.usrname = actor.usr.usrname
WHERE NOT students.already_exists;

--Update actor.usr.card field with actor.card.id to associate active card with the user:
UPDATE actor.usr
SET card = actor.card.id
FROM actor.card
WHERE actor.card.usr = actor.usr.id;

--INSERT records INTO actor.usr_address from staging table.
INSERT INTO actor.usr_address (usr, street1, street2, city, state, country, post_code)
SELECT actor.usr.id, students.street1, students.street2, students.city, students.province, students.country, students.postal_code
FROM students
INNER JOIN actor.usr ON students.usrname = actor.usr.usrname
WHERE NOT students.already_exists;

--Update actor.usr mailing address with id from actor.usr_address table:.
UPDATE actor.usr
SET mailing_address = actor.usr_address.id, billing_address = actor.usr_address.id
FROM actor.usr_address
WHERE actor.usr.id = actor.usr_address.usr;

COMMIT;

Placing the sql statements between BEGIN; and COMMIT; creates a transaction block so that if any sql statements fail, the entire process is canceled and the database is rolled back to its original state. Lines beginning with — are comments to let you know what each sql statement is doing and are not processed.

Batch Updating Patron Data

For academic libraries, doing batch updates to add new patrons to the Evergreen database is a critical task. The above procedures and import script can be easily adapted to create an update script for importing new patrons from external databases. If the data import file contains only new patrons, then, the above procedures will work well to insert those patrons. However, if the data load contains all patrons, a second staging table and a procedure to remove existing patrons from that second staging table may be required before importing the new patrons. Moreover, additional steps to update address information and perhaps delete inactive patrons may also be desired depending on the requirements of the institution.

After developing the scripts to import and update patrons have been created, another important task for library staff is to develop an import strategy and schedule which suits the needs of the library. This could be determined by registration dates of your institution in the case of academic libraries. It is important to balance the convenience of patron loads and the cost of processing these loads vs staff adding patrons manually.
Chapter 31. Migrating from a legacy system

Introduction

When you migrate to Evergreen, you generally want to migrate the bibliographic records and copy information that existed in your previous library system. For anything more than a few thousand records, you should import the data directly into the database rather than use the tools in the staff client. While the data that you can extract from your legacy system varies widely, this section assumes that you or members of your team have the ability to write scripts and are comfortable working with SQL to manipulate data within PostgreSQL. If so, then the following section will guide you towards a method of generating common data formats so that you can then load the data into the database in bulk.

Making electronic resources visible in the catalog

Electronic resources generally do not have any call number or copy information associated with them, and Evergreen enables you to easily make bibliographic records visible in the public catalog within sections of the organizational unit hierarchy. For example, you can make a set of bibliographic records visible only to specific branches that have purchased licenses for the corresponding resources, or you can make records representing publicly available electronic resources visible to the entire consortium.

Therefore, to make a record visible in the public catalog, modify the records using your preferred MARC editing approach to ensure the 856 field contains the following information before loading records for electronic resources into Evergreen:

Table 31.1. 856 field for electronic resources: indicators and subfields

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator 1</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Indicator 2</td>
<td>0 or 1</td>
<td></td>
</tr>
<tr>
<td>Subfield u</td>
<td>URL for the electronic resource</td>
<td></td>
</tr>
<tr>
<td>Subfield y</td>
<td>Text content of the link</td>
<td></td>
</tr>
<tr>
<td>Subfield z</td>
<td>Public note</td>
<td>Normally displayed after the link</td>
</tr>
<tr>
<td>Subfield 9</td>
<td>Organizational unit short name</td>
<td>The record will be visible when a search is performed specifying this organizational unit or one of its children. You can repeat this subfield as many times as you need.</td>
</tr>
</tbody>
</table>

Once your electronic resource bibliographic records have the required indicators and subfields for each 856 field in the record, you can proceed to load the records using either the command-line bulk import method or the MARC Batch Importer in the staff client.
Migrating your bibliographic records

Convert your MARC21 binary records into the MARCXML format, with one record per line. You can use the following Python script to achieve this goal; just install the pymarc library first, and adjust the values of the input and output variables as needed.

```python
#!/usr/bin/env python
# -*- coding: utf-8 -*-
import codecs
import pymarc

input = 'records_in.mrc'
output = 'records_out.xml'

reader = pymarc.MARCReader(open(input, 'rb'), to_unicode=True)
writer = codecs.open(output, 'w', 'utf-8')

for record in reader:
    record.leader = record.leader[:9] + 'a' + record.leader[10:]
    writer.write(pymarc.record_to_xml(record) + '
')

Once you have a MARCXML file with one record per line, you can load the records into your Evergreen system via a staging table in your database.

1. Connect to the PostgreSQL database using the psql command. For example:

   ```
   psql -U <user-name> -h <hostname> -d <database>
   ```

2. Create a staging table in the database. The staging table is a temporary location for the raw data that you will load into the production table or tables. Issue the following SQL statement from the psql command line, adjusting the name of the table from staging_records_import, if desired:

   ```
   CREATE TABLE staging_records_import (id BIGSERIAL, dest BIGINT, marc TEXT);
   ```

3. Create a function that will insert the new records into the production table and update the dest column of the staging table. Adjust "staging_records_import" to match the name of the staging table that you plan to create when you issue the following SQL statement:

   ```
   CREATE OR REPLACE FUNCTION staging_importer() RETURNS VOID AS $$
   DECLARE stage RECORD;
   BEGIN
   FOR stage IN SELECT * FROM staging_records_import ORDER BY id LOOP
       INSERT INTO biblio.record_entry (marc, last_xact_id) VALUES (stage.marc, 'IMPORT');
       UPDATE staging_records_import SET dest = currval('biblio.record_entry_id_seq')
       WHERE id = stage.id;
   END LOOP;
   END;
   $$ LANGUAGE plpgsql;
   ```

4. Load the data from your MARCXML file into the staging table using the COPY statement, adjusting for the name of the staging table and the location of your MARCXML file:

   ```
   COPY staging_records_import (marc) FROM '/tmp/records_out.xml';
   ```

5. Load the data from your staging table into the production table by invoking your staging function:

   ```
   SELECT staging_importer();
   ```

When you leave out the id value for a BIGSERIAL column, the value in the column automatically increments for each new record that you add to the table.
Once you have loaded the records into your Evergreen system, you can search for some known records using the staff client to confirm that the import was successful.

**Migrating your call numbers, copies, and parts**

Holdings, comprised of call numbers, copies, and parts, are the set of objects that enable users to locate and potentially acquire materials from your library system.

Call numbers connect libraries to bibliographic records. Each call number has a label associated with a classification scheme such as a the Library of Congress or Dewey Decimal systems, and can optionally have either or both a label prefix and a label suffix. Label prefixes and suffixes do not affect the sort order of the label.

Copies connect call numbers to particular instances of that resource at a particular library. Each copy has a barcode and must exist in a particular copy location. Other optional attributes of copies include circulation modifier, which may affect whether that copy can circulate or for how long it can circulate, and OPAC visibility, which controls whether that particular copy should be visible in the public catalog.

Parts provide more granularity for copies, primarily to enable patrons to place holds on individual parts of a set of items. For example, an encyclopedia might be represented by a single bibliographic record, with a single call number representing the label for that encyclopedia at a given library, with 26 copies representing each letter of the alphabet, with each copy mapped to a different part such as A, B, C, ... Z.

To migrate this data into your Evergreen system, you will create another staging table in the database to hold the raw data for your materials from which the actual call numbers, copies, and parts will be generated.

Begin by connecting to the PostgreSQL database using the psql command. For example:

```
psql -U <user-name> -h <hostname> -d <database>
```

Create the staging materials table by issuing the following SQL statement:

```sql
CREATE TABLE staging_materials (  
bibkey BIGINT, -- biblio.record_entry_id  
callnum TEXT, -- call number label  
callnum_prefix TEXT, -- call number prefix  
callnum_suffix TEXT, -- call number suffix  
callnum_class TEXT, -- classification scheme  
create_date DATE,  
location TEXT, -- shelving location code  
item_type TEXT, -- circulation modifier code  
owning_lib TEXT, -- org unit code  
barcode TEXT, -- copy barcode  
part TEXT  );
```

For the purposes of this example migration of call numbers, copies, and parts, we assume that you are able to create a tab-delimited file containing values that map to the staging table properties, with one copy per line. For example, the following 5 lines demonstrate how the file could look for 5 different copies, with non-applicable attribute values represented by \N, and 3 of the copies connected to a single call number and bibliographic record via parts:
Once your holdings are in a tab-delimited format—which, for the purposes of this example, we will name holdings.tsv—you can import the holdings file into your staging table. Copy the contents of the holdings file into the staging table using the COPY SQL statement:

```
COPY staging_items (bibkey, callnum, callnum_prefix,
    callnum_suffix, callnum_class, create_date, location,
    item_type, owning_lib, barcode, part) FROM 'holdings.tsv';
```

Generate the copy locations you need to represent your holdings:

```
INSERT INTO asset.copy_location (name, owning_lib)
SELECT DISTINCT location, 1 FROM staging_materials
WHERE NOT EXISTS (
    SELECT 1 FROM asset.copy_location
    WHERE name = location
);
```

Generate the circulation modifiers you need to represent your holdings:

```
INSERT INTO config.circ_modifier (code, name, description, sip2_media_type)
SELECT DISTINCT circmod, circmod, circmod, '001'
FROM staging_materials
WHERE NOT EXISTS (
    SELECT 1 FROM config.circ_modifier
    WHERE circmod = code
);
```

Generate the call number prefixes and suffixes you need to represent your holdings:

```
INSERT INTO asset.call_number_prefix (owning_lib, label)
SELECT DISTINCT aou.id, callnum_prefix
FROM staging_materials sm
INNER JOIN actor.org_unit aou
    ON aou.shortname = sm.owning_lib
WHERE NOT EXISTS (
    SELECT 1 FROM asset.call_number_prefix acnp
    WHERE callnum_prefix = acnp.label
    AND aou.id = acnp.owning_lib
) AND callnum_prefix IS NOT NULL;
```

```
INSERT INTO asset.call_number_suffix (owning_lib, label)
SELECT DISTINCT aou.id, callnum_suffix
FROM staging_materials sm
INNER JOIN actor.org_unit aou
    ON aou.shortname = sm.owning_lib
WHERE NOT EXISTS (
    SELECT 1 FROM asset.call_number_suffix acns
    WHERE callnum_suffix = acns.label
    AND aou.id = acns.owning_lib
) AND callnum_suffix IS NOT NULL;
```

Generate the call numbers for your holdings:

```
INSERT INTO asset.call_number (creator, editor, record, owning_lib, label, prefix, suffix, label_class)
SELECT DISTINCT 1, 1, bibkey, aou.id, callnum, acnp.id, acns.id,
    CASE WHEN callnum_class = 'LC' THEN 1
    WHEN callnum_class = 'DEWEY' THEN 2
```
BEGIN
FROM staging_materials sm
    INNER JOIN actor.org_unit aou
    ON aou.shortname = owning_lib
    INNER JOIN asset.call_number_prefix acnp
    ON COALESCE(acnp.label, '') = COALESCE(callnum_prefix, '')
    INNER JOIN asset.call_number_suffix acns
    ON COALESCE(acns.label, '') = COALESCE(callnum_suffix, '')
;
Generate the copies for your holdings:

INSERT INTO asset.copy (
    circ_lib, creator, editor, call_number, location,
    loan_duration, fine_level, barcode
) 
    SELECT DISTINCT aou.id, 1, 1, acn.id, acl.id, 2, 2, barcode
FROM staging_materials sm
    INNER JOIN actor.org_unit aou
    ON aou.shortname = sm.owning_lib
    INNER JOIN asset.copy_location acl
    ON acl.name = sm.location
    INNER JOIN asset.call_number acn
    ON acn.label = sm.callnum
    WHERE acn.deleted IS FALSE
;

Generate the parts for your holdings. First, create the set of parts that are required for each record based on your staging materials table:

INSERT INTO biblio.monograph_part (record, label)
    SELECT DISTINCT bibkey, part
    FROM staging_materials sm
    WHERE part IS NOT NULL AND NOT EXISTS ( 
        SELECT 1 FROM biblio.monograph_part bmp
        WHERE sm.part = bmp.label
        AND sm.bibkey = bmp.record
    );

Now map the parts for each record to the specific copies that you added:

INSERT INTO asset.copy_part_map (target_copy, part)
    SELECT DISTINCT acp.id, bmp.id
    FROM staging_materials sm
        INNER JOIN asset.copy acp
        ON acp.barcode = sm.barcode
        INNER JOIN biblio.monograph_part bmp
        ON bmp.record = sm.bibkey
    WHERE part IS NOT NULL
    AND part = bmp.label
    AND acp.deleted IS FALSE
    AND NOT EXISTS ( 
        SELECT 1 FROM asset.copy_part_map
        WHERE target_copy = acp.id
        AND part = bmp.id
    );

At this point, you have loaded your bibliographic records, call numbers, call number prefixes and suffixes, copies, and parts, and your records should be visible to searches in the public catalog within the appropriate organization unit scope.
Chapter 32. Importing materials in the staff client

Evergreen exists to connect users to the materials represented by bibliographic records, call numbers, and copies—so getting these materials into your Evergreen system is vital to a successful system. There are two primary means of getting materials into Evergreen:

- The Evergreen staff client offers the MARC Batch Importer, which is a flexible interface primarily used for small batches of records;
- Alternately, import scripts can load data directly into the database, which is a highly flexible but much more complex method of loading materials suitable for large batches of records such as the initial migration from your legacy library system.

Staff client batch record imports

The staff client has a utility for importing batches of bibliographic and copy records available through Cataloging > MARC Batch Import/Export. In addition to importing new records, this interface can be used to match incoming records to existing records in the database, add or overlay MARC fields in the existing record, and add copies to those records.

The MARC Batch Import interface may also be colloquially referred to as "Vandelay" in the Evergreen community, referring to this interface’s internals in the system. You will also see this name used in several places in the editor. For instance, when you click on the Record Match Sets, the title on the screen will be Vandelay Match Sets.

When to use the MARC Batch Importer

- When importing in batches of up to 500 to 1,000 records.
- When you need the system to match those incoming records to existing records and overlay or add fields to the existing record.
- When you need to add copies to existing records in the system.

⚠️ If you are importing copies that do not have barcodes or call numbers, you must enable the Vandelay Generate Default Barcodes and Vandelay Default Barcode Prefix (vandelay.item.barcode.prefix) settings.

Record Match Sets

Click the Record Match Sets button to identify how Evergreen should match incoming records to existing records in the system.
These record match sets can be used when importing records through the MARC Batch Importer or when importing order records through the Acquisitions Load MARC Order Records interface.

Common match points used when creating a match set include:

- MARC tag 020a (ISBN)
- MARC tag 022a (ISSN)
- MARC tag 024a (UPC)
- MARC tag 028a (Publisher number)

**Create Match Sets**

1. On the Record Match Sets screen, click New Match Set to create a set of record match points. Give the set a Name. Assign the Owning Library from the dropdown list. The Match Set Type should remain as biblio. Click Save.

2. If you don’t see your new set in the list, in the upper left corner of the staff client window, click the Reload button.

3. If you had to reload, click the Record Match Sets button to get back to that screen. Find your new set in the list and click its name. (The name will appear to be a hyperlink.) This will bring you to the Vandelay Match Set Editor.

4. Create an expression that will define the match points for the incoming record. You can choose from two areas to create a match: Record Attribute (MARC fixed fields) or MARC Tag and Subfield. You can use the Boolean operators AND and OR to combine these elements to create a match set.

5. When adding a Record Attribute or MARC tag/subfield, you also can enter a Match Score. The Match Score indicates the relative importance of that match point as Evergreen evaluates an incoming record against an existing record. You can enter any integer into this field. The number that you enter is only important as it relates to other match points.

Recommended practice is that you create a match score of one (1) for the least important match point and assign increasing match points to the power of 2 to working points in increasing importance. After creating a match point, drag the completed match point under the folder with the appropriately-named Boolean folder under the Expression tree.
6. Click Save Changes to Expression.

Quality Metrics

- Quality metrics provide a mechanism for Evergreen to measure the quality of records and to make importing decisions based on quality.
- Metrics are configured in the match set editor.
- Quality metrics are not required when creating a match set.
- You can use a value in a record attribute (MARC fixed fields) or a MARC tag as your quality metric.
- The encoding level record attribute can be one indicator of record quality.

<table>
<thead>
<tr>
<th>Quality</th>
<th>Record Attribute</th>
<th>Tag</th>
<th>Subfield</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>E</td>
</tr>
<tr>
<td>2</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>J</td>
</tr>
<tr>
<td>3</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>5</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>M</td>
</tr>
<tr>
<td>7</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>8</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>K</td>
</tr>
<tr>
<td>9</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>8</td>
</tr>
<tr>
<td>10</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>L</td>
</tr>
<tr>
<td>11</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>I</td>
</tr>
<tr>
<td>12</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>13</td>
<td>ene_level</td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>14</td>
<td>ene_level</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Import Item Attributes

If you are importing copies with your records, you will need to map the data in your holdings tag to fields in the copy record. Click the Holdings Import Profile button to map this information.

1. Click the New Definition button to create a new mapping for the holdings tag.
2. Add a Name for the definition.
3. Use the Tag field to identify the MARC tag that contains your holdings information.
4. Add the subfields that contain specific copy information to the appropriate copy field.
5. At a minimum, you should add the subfields that identify the Circulating Library, the Owning Library, the Call Number and the Barcode.
6. For more details, see the full list of import fields.
All fields (except for Name and Tag) can contain a MARC subfield code (such as "a") or an XPATH query. You can also use the related library settings to set defaults for some of these fields.

Overlay/Merge Profiles

If Evergreen finds a match for an incoming record in the database, you need to identify which fields should be replaced, which should be preserved, and which should be added to the record. Click the Merge/Overlay Profiles button to create a profile that contains this information.

These overlay/merge profiles can be used when importing records through the MARC Batch Importer or when importing order records through the Acquisitions Load MARC Order Records interface.

Evergreen comes pre-installed with two default profiles:

- **Default merge** - No fields from incoming record are added to match. This profile is useful for item loads or for order record uploads.
- **Default overlay** - Incoming record will replace existing record.

You can customize the overlay/merge behavior with a new profile by clicking the New Merge Profile button. Available options for handling the fields include:

- **Preserve specification** - fields in the existing record that should be preserved.
• Replace specification - fields in existing record that should be replaced by those in the incoming record.

• Add specification - fields from incoming record that should be added to existing record (in addition to any already there.)

• Remove specification - fields that should be removed from incoming record.

You can add multiple tags to these specifications, separating each tag with a comma.

**Importing the records**

After making the above configurations, you are now ready to import your records.

1. Click the Import Records button

2. Provide a unique name for the queue where the records will be loaded

3. Identify the match set that should be used for matching

4. If you are importing copies, identify the Import Item Attributes definition in the Holdings Import Profile

5. Select a record source

6. Select the overlay/merge profile that defines which fields should be replaced, added or preserved

7. Identify which records should be imported, the options are:

   • Import Non-Matching Records will automatically import records that have no match in the system
   • Merge on Exact Match will automatically import records that match on the 901c (record ID)
   • Merge on Single Match will automatically import records when there is only one match in the system
   • Merge on Best Match will automatically import records for the best match in the system; the best match will be determined by the combined total of the records match point scores

You do not need to select any of these import options at this step. You may also opt to review the records first in the import queue and then import them.

• Best Single Match Minimum Quality Ratio should only be changed if quality metrics were used in the match set

   • Set to 0.0 to import a record regardless of record quality
   • Set to 1.0 if the incoming record must be of equal or higher quality than the existing record to be imported
   • Set to 1.1 if the incoming record must be of higher quality than the existing record to be imported
• Insufficient Quality Fall-Through Profile can also be used with quality metrics. If an incoming record does not meet the standards of the minimum quality ratio, you can identify a back-up merge profile to be used for those records. For example, you may want to use the default overlay profile for high-quality records but use the default merge profile for lower quality records.
Chapter 33. Ordering materials

Introduction

Acquisitions allows you to order materials, track the expenditure of your collections funds, track invoices and set up policies for manual claiming. In this chapter, we’re going to be describing how to use the most essential functions of acquisitions in the Evergreen system.

When should libraries use acquisitions?

- When you want to track spending of your collections budget.
- When you want to use Evergreen to place orders electronically with your vendors.
- When you want to import large batches of records to quickly get your on-order titles into the system.

If your library simply wants to add on-order copies to the catalog so that patrons can view and place holds on titles that have not yet arrived, acquisitions may be more than you need. Adding those on-order records via cataloging is a simpler option that works well for this use case.

Below are the basic administrative settings to be configured to get started with acquisitions. At a minimum, a library must configure Funding Sources, Funds, and Providers to use acquisitions.

Managing Funds

Funding Sources (Required)

Funding sources allow you to specify the sources that contribute monies to your fund(s). You can create as few or as many funding sources as you need. These can be used to track exact amounts for accounts in your general ledger.

Example funding sources might be:

- A municipal allocation for your materials budget;
- A trust fund used for collections;
- A revolving account that is used to replace lost materials;
- Grant funds to be used for collections.

Funding sources are not tied to fiscal or calendar years, so you can continue to add money to the same funding source over multiple years, e.g. County Funding. Alternatively, you can name funding sources by year, e.g. County Funding 2010 and County Funding 2011, and apply credits each year to the matching source.

1. To create a funding source, select Administration → Acquisitions Administration → Funding Sources. Click the New Funding Source button. Give the funding source a name, an owning library, and code. You should also identify the type of currency that is used for the fund.
2. You must add money to the funding source before you can use it. Click the hyperlinked name of the funding source and then click the Apply Credit button. Add the amount of funds you need to add. The Note field is optional.

**Funds (Required)**

Funds allow you to allocate credits toward specific purchases. They typically are used to track spending and purchases for specific collections. Some libraries may choose to define very broad funds for their collections (e.g. children’s materials, adult materials) while others may choose to define more specific funds (e.g. adult non-fiction DVDs for BR1).

If your library does not wish to track fund accounting, you can create one large generic fund and use that fund for all of your purchases.

1. To create a fund, select Administration → Acquisitions Administration → Funds. Click the New Fund button. Give the fund a name and code.

2. The Year can either be the fiscal or calendar year for the fund.

3. If you are a multi-branch library that will be ordering titles for multiple branches, you should select the system as the owning Org Unit, even if this fund will only be used for collections at a specific branch. If you are a one-branch library or if your branches do their own ordering, you can select the branch as the owning Org Unit.

4. Select the Currency Type that will be used for this fund.

5. You must select the Active checkbox to use the fund.

6. Enter a Balance Stop Percent. The balance stop percent prevents you from making purchases when only a specified amount of the fund remains. For example, if you want to spend 95 percent of your funds, leaving a five percent balance in the fund, then you would enter 95 in the field. When the fund reaches its balance stop percent, it will appear in red when you apply funds to copies.

7. Enter a Balance Warning Percent. The balance warning percent gives you a warning that the fund is low. You can specify any percent. For example, if you want to spend 90 percent of your funds and be warned when the fund has only 10 percent of its balance remaining, then enter 90 in the field. When the fund reaches its balance warning percent, it will appear in yellow when you apply funds to copies.

8. Check the Propagate box to propagate funds. When you propagate a fund, the system will create a new fund for the following fiscal year with the same parameters as your current fund. All of the settings transfer except for the year and the amount of money in the fund. Propagation occurs during the fiscal year close-out operation.

9. Check the Rollover box if you want to roll over remaining encumbrances and funds into the same fund next year. If you need the ability to roll over encumbrances without rolling over funds, go to the Library Settings Editor (Administration → Local Administration → Library Settings Editor) and set Allow funds to be rolled over without bringing the money along to True.
You must add money to the fund before you can begin using it. Click the hyperlinked name of the fund. Click the Create Allocation button. Select a Funding Source from which the allocation will be drawn and then enter an amount for the allocation. The Note field is optional.

**Fund Tags (Optional)**

You can apply tags to funds so that you can group funds for easy reporting. For example, you have three funds for children’s materials: Children’s Board Books, Children’s DVDs, and Children’s CDs. Assign a fund tag of children’s to each fund. When you need to report on the amount that has been spent on all children’s materials, you can run a report on the fund tag to find total expenditures on children’s materials rather than reporting on each individual fund.

1. To create a fund tag, select Administration → Acquisitions Administration → Fund Tags. Click the New Fund Tag button. Select a owning library and add the name for the fund tag.

2. To apply a fund tag to a fund, select Administration → Acquisitions Administration → Funds. Click on the hyperlinked name for the fund. Click the Tags tab and then click the Add Tag button. Select the tag from the dropdown menu.

For convenience when propagating or rolling over a fund for a new fiscal year, fund tags will be copied from the current fund to the new year’s fund.

**Ordering**

**Providers (Required)**

Providers are the vendors from whom you order titles.

1. To add a provider record, select Administration → Acquisitions Administration → Providers.

2. Enter information about the provider. At a minimum, you need to add a Provider Name, Code, Owner, and Currency. You also need to select the Active checkbox to use the provider.

**Distribution Formulas (Optional)**

If you are ordering for a multi-branch library system, distribution formulas are a useful way to specify the number of copies that should be distributed to specific branches and copy locations.

1. To create a distribution formula, select Administration → Acquisitions Administration → Distribution Formulas. Click the New Formula button. Enter the formula name and select the owning library. Ignore the Skip Count field.

2. Click New Entry. Select an Owning Library from the drop down menu. This indicates the branch that will receive the items.

3. Select a Shelving Location from the drop down menu.

4. In the Item Count field, enter the number of items that should be distributed to that branch and copy location. You can enter the number or use the arrows on the right side of the field.
5. Keep adding entries until the distribution formula is complete.

### Helpful acquisitions Library Settings

There are several acquisitions Library Settings available that will help with acquisitions workflow. These settings can be found at Administration → Local Administration → Library Settings Editor.

- **Default circulation modifier** - Automatically applies a default circulation modifier to all of your acquisitions copies. Useful if you use a specific circulation modifier for on-order copies.
- **Default copy location** - Automatically applies a default copy location (e.g. On Order) to acquisitions copies.
- **Temporary barcode prefix** - Applies a unique prefix to the barcode that is automatically generated during the acquisitions process.
- **Temporary call number prefix** - Applies a unique prefix to the start of the call number that is automatically generated during the acquisitions process.

### Preparing for order record loading

If your library is planning to upload order records in a batch, you need to add some information to your provider records so that Evergreen knows how to map the copy data contained in the order record.

1. Retrieve the record for the provider that has supplied the order records by selecting Administration → Acquisitions Administration → Providers. Click on the hyperlinked Provider name.
2. In the top frame, add the MARC tag that contains your holdings data in the Holdings Tag field (this tag can also be entered at the time you create the provider record.)
3. To map the tag’s subfields to the appropriate copy data, click the Holding Subfield tab. Click the New Holding Subfield button and select the copy data that you are mapping. Add the subfield that contains that data and click Save.

#### Holding Subfield

<table>
<thead>
<tr>
<th>#</th>
<th>Provider</th>
<th>Name</th>
<th>Subfield</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>bt</td>
<td>quantity</td>
<td>q</td>
</tr>
<tr>
<td>2</td>
<td>bt</td>
<td>estimated_price</td>
<td>p</td>
</tr>
<tr>
<td>3</td>
<td>bt</td>
<td>owning_lib</td>
<td>b</td>
</tr>
<tr>
<td>4</td>
<td>bt</td>
<td>fund_code</td>
<td>u</td>
</tr>
<tr>
<td>5</td>
<td>bt</td>
<td>copy_location</td>
<td>t</td>
</tr>
<tr>
<td>6</td>
<td>bt</td>
<td>circ_modifier</td>
<td>g</td>
</tr>
</tbody>
</table>
4. If your vendor is sending other data in a MARC tag that needs to be mapped to a field in acquisitions, you can do so by clicking the Attribute Definitions tab. As an example, if you need to import the PO Name, you could set up an attribute definition by adding an XPath similar to:

```xml
<code=> purchase_order
.xpath => //*[tag="962"]/*[@code="p"]
Is Identifier => false
```

where 962 is the holdings tag and p is the subfield that contains the PO Name.

## Preparing to send electronic orders from Evergreen

If your library wants to transmit electronic order information to a vendor, you will need to configure your server to use EDI. You need to install the EDI translator and EDI scripts on your server by following the instructions in the command line system administration manual.

Configure your provider’s EDI information by selecting Administration → Acquisitions Administration → EDI Accounts. Click New Account Button. Give the account a name in the Label box.

1. Host is the vendor-assigned FTP/SFTP/SSH hostname.
2. Username is the vendor-assigned FTP/SFTP/SSH username.
3. Password is the vendor-assigned FTP/SFTP/SSH password.
4. Account This field enables you to add a supplemental password for entry to a remote system after log in has been completed. This field is optional for the ILS but may be required by your provider.
5. Owner is the organizational unit who owns the EDI account
6. Last Activity is the date of last activity for the account
7. Provider is a link to the codes for the Provider record.
8. Path is the path on the vendor’s server where Evergreen will deposit its outgoing order files.
9. Incoming Directory is the path on the vendor’s server where Evergreen will retrieve incoming order responses and invoices.
10. Vendor Account Number is the Vendor assigned account number.
11. Vendor Assigned Code is usually a sub-account designation. It can be used with or without the Vendor Account Number.

You now need to add this EDI Account and the SAN code to the provider’s record.

1. Select Administration → Acquisitions Administration → Providers.
2. Click the hyperlinked Provider name.
3. Select the account you just created in the EDI Default field.
4. Add the vendor-provided SAN code to the SAN field.
The last step is to add your library’s SAN code to Evergreen.

1. Select Administration → Server Administration → Organizational Units.
2. Select your library from the organizational hierarchy in the left pane.
3. Click the Addresses tab and add your library’s SAN code to the SAN field.
Chapter 34. Designing your catalog

When people want to find things in your Evergreen system, they will check the catalog. In Evergreen, the catalog is made available through a web interface, called the OPAC (Online Public Access Catalog). In the latest versions of the Evergreen system, the OPAC is built on a set of programming modules called the Template Toolkit. You will see the OPAC sometimes referred to as the TPAC.

In this chapter, we’ll show you how to customize the OPAC, change it from its default configuration, and make it your own.

Configuring and customizing the public interface

The public interface is referred to as the TPAC or Template Toolkit (TT) within the Evergreen community. The template toolkit system allows you to customize the look and feel of your OPAC by editing the template pages (.tt2) files as well as the associated style sheets.

Locating the default template files

The default URL for the TPAC on a default Evergreen system is http://localhost/eg/opac/home (adjust localhost to match your hostname or IP address).

The default template file is installed in /openils/var/templates/opac.

You should generally avoid touching the installed default template files, unless you are contributing changes for Evergreen to adopt as a new default. Even then, while you are developing your changes, consider using template overrides rather than touching the installed templates until you are ready to commit the changes to a branch. See below for information on template overrides.

Mapping templates to URLs

The mapping for templates to URLs is straightforward. Following are a few examples, where <templates> is a placeholder for one or more directories that will be searched for a match:

• http://localhost/eg/opac/home ⇒ /openils/var/<templates>/opac/home.tt2
• http://localhost/eg/opac/advanced ⇒ /openils/var/<templates>/opac/advanced.tt2
• http://localhost/eg/opac/results ⇒ /openils/var/<templates>/opac/results.tt2

The template files themselves can process, be wrapped by, or include other template files. For example, the home.tt2 template currently involves a number of other template files to generate a single HTML file.

Example Template Toolkit file: opac/home.tt2.

[% PROCESS "opac/parts/header.tt2";]
How to override template files

Overrides for template files or TPAC pages go in a directory that parallels the structure of the default templates directory. The overrides then get pulled in via the Apache configuration.

The following example demonstrates how to create a file that overrides the default "Advanced search page" (advanced.tt2) by adding a new templates_custom directory and editing the new file in that directory.

```
bash$ mkdir -p /openils/var/templates_custom/opac
bash$ cp /openils/var/templates/opac/advanced.tt2 /openils/var/templates_custom/opac/
bash$ vim /openils/var/templates_custom/opac/advanced.tt2
```

Configuring the custom templates directory in Apache’s eg.conf

You now need to teach Apache about the new custom template directory. Edit /etc/apache2/sites-available/eg.conf and add the following `<Location /eg>` element to each of the `<VirtualHost>` elements in which you want to include the overrides. The default Evergreen configuration includes a VirtualHost directive for port 80 (HTTP) and another one for port 443 (HTTPS); you probably want to edit both, unless you want the HTTP user experience to be different from the HTTPS user experience.

```
<VirtualHost *:80>
    # <snip>
    # - absorb the shared virtual host settings
    Include eg_vhost.conf
    <Location /eg>
        PerlAddVar OILSWebTemplatePath "/openils/var/templates_custom"
    </Location>
    # <snip>
</VirtualHost>
```

Finally, reload the Apache configuration to pick up the changes. You should now be able to see your change at http://localhost/eg/opac/advanced where localhost is the hostname of your Evergreen server.
Adjusting colors for your public interface

You may adjust the colors of your public interface by editing the colors.tt2 file. The location of this file is in /openils/var/templates/opac-parts/css/colors.tt2. When you customize the colors of your public interface, remember to create a custom file in your custom template folder and edit the custom file and not the file located in your default template.

Adjusting fonts in your public interface

Font sizes can be changed in the colors.tt2 file located in /openils/var/templates/opac-parts/css/. Again, create and edit a custom template version and not the file in the default template.

Other aspects of fonts such as the default font family can be adjusted in /openils/var/templates/opac/css/style.css.tt2.

Media file locations in the public interface

The media files (mostly PNG images) used by the default TPAC templates are stored in the repository in Open-ILS/web/images/ and installed in /openils/var/web/images/.

Changing some text in the public interface

Out of the box, TPAC includes a number of placeholder text and links. For example, there is a set of links cleverly named Link 1, Link 2, and so on in the header and footer of every page in TPAC. Here is how to customize that for a custom templates skin.

To begin with, find the page(s) that contain the text in question. The simplest way to do that is with the grep -s command. In the following example, search for files that contain the text "Link 1":

bash$ grep -r "Link 1" /openils/var/templates/opac
/openils/var/templates/opac-parts/topnav_links.tt2
4: <a href="http://example.com">[% l('Link 1') %]</a>

Next, copy the file into our overrides directory and edit it with vim.

Copying the links file into the overrides directory.

bash$ cp /openils/var/templates/opac-parts/topnav_links.tt2
/openils/var/templates_custom/opac-parts/topnav_links.tt2
bash$ vim /openils/var/templates_custom/opac-parts/topnav_links.tt2

Finally, edit the link text in opac-parts/header.tt2. Content of the opac-parts/header.tt2 file.

```html
<div id="gold-links-holder">
  <div id="gold-links">
    <div id="header-links">
      <a href="http://example.com">[% l('Link 1') %]</a>
      <a href="http://example.com">[% l('Link 2') %]</a>
      <a href="http://example.com">[% l('Link 3') %]</a>
      <a href="http://example.com">[% l('Link 4') %]</a>
      <a href="http://example.com">[% l('Link 5') %]</a>
    </div>
  </div>
</div>
```
For the most part, the page looks like regular HTML, but note the \[%_(" ")%\] that surrounds the text of each link. The \[% ... %\] signifies a TT block, which can contain one or more TT processing instructions. \(\texttt{l(" ... ")};\) is a function that marks text for localization (translation); a separate process can subsequently extract localized text as GNU gettext-formatted PO (Portable Object) files.

As Evergreen supports multiple languages, any customization to Evergreen’s default text must use the localization function. Also, note that the localization function supports placeholders such as \[%_1\], \[%_2\] in the text; these are replaced by the contents of variables passed as extra arguments to the \(\texttt{l()}\) function.

Once the link and link text has been edited to your satisfaction, load the page in a Web browser and see the live changes immediately.

**Adding translations to PO file**

After you have added custom text in translatable form to a TT2 template, you need to add the custom strings and its translations to the PO file containing the translations. Evergreen PO files are stored in `/openils/var/template/data/locale/`

The PO file consists of pairs of the text extracted from the code: Message ID denoted as `msgid` and message string denoted as `msgstr`. When adding the custom string to PO file:

- The line with English expressions must start with `msgid`. The English term must be enclosed in double apostrophes.

- The line with translation start with `/msgstr/`. The translation to local language must be and enclosed in enclosed in double apostrophes.

- It is recommended to add a note in which template and on which line the particular string is located. The lines with notes must be marked as comments i.e., start with number sign (#)

Example:

```plaintext
#: ../../Open-ILS/src/custom_templates/opac/parts/topnav_links.tt2:1
msgid "Union Catalog of the Czech Republic"
msgstr "Souborný katalog České republiky"

#: ../../Open-ILS/src/custom_templates/opac/parts/topnav_links.tt2:1
msgid "Uniform Information Gateway "
msgstr "Jednotná informační brána"
```

It is good practice to save backup copy of the original PO file before changing it.

After making changes, restart Apache to make the changes take effect. As root run the command:

```
service apache2 restart
```
Adding and removing MARC fields from the record details display page

It is possible to add and remove the MARC fields and subfields displayed in the record details page. In order to add MARC fields to be displayed on the details page of a record, you will need to map the MARC code to variables in the /openils/var/templates/opac/parts/misc_util.tt2 file.

For example, to map the template variable args.pubdates to the date of publication MARC field 260, subfield c, add these lines to misc_util.tt2:

```plaintext
args.pubdates = []; 
FOR sub IN xml.findnodes('//@[@tag="260"]//@[@code="c"];'); 
  args.pubdates.push(sub.textContent); 
END; 
args.pubdate = (args.pubdates.size) ? args.pubdates.0 : ''; 
```

You will then need to edit the /openils/var/templates/opac/parts/record/summary.tt2 file in order to get the template variable for the MARC field to display.

For example, to display the date of publication code you created in the misc_util.tt2 file, add these lines:

```plaintext
[% IF attrs.pubdate; %]
  <span itemprop="datePublished">[% attrs.pubdate | html; %]</span>
[% END; %]
```

You can add any MARC field to your record details page. Moreover, this approach can also be used to display MARC fields in other pages, such as your results page.

Using bibliographic source variables

For bibliographic records, there is a "bib source" that can be associated with every record. This source and its ID are available as record attributes called bib_source.source and bib_source.id. These variables do not present themselves in the catalog display by default.

**Example use case**

In this example, a library imports e-resource records from a third party and uses the bib source to indicate where the records came from. Patrons can place holds on these titles, but they must be placed via the vendor website, not in Evergreen. By exposing the bib source, the library can alter the Place Hold link for these records to point at the vendor website.

Setting the default physical location for your library environment

physical_loc is an Apache environment variable that sets the default physical location, used for setting search scopes and determining the order in which copies should be sorted. This variable is set in /etc/apache2/sites-available/eg.conf. The following example demonstrates the default physical location being set to library ID 104:
Setting a default language and adding optional languages

OILSWebLocale adds support for a specific language. Add this variable to the Virtual Host section in `/etc/apache2/eg_vhost.conf`.

OILSWebDefaultLocale specifies which locale to display when a user lands on a page in TPAC and has not chosen a different locale from the TPAC locale picker. The following example shows the `fr_ca` locale being added to the locale picker and being set as the default locale:

```
PerlAddVar OILSWebLocale "fr_ca"
PerlAddVar OILSWebDefaultLocale "/openils/var/data/locale/opac/fr-CA.po"
PerlAddVar OILSWebDefaultLocale "fr-CA"
```

Below is a table of the currently supported languages packaged with Evergreen:

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
<th>PO file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic - Jordan</td>
<td>ar_jo</td>
<td>/openils/var/data/locale/opac/ar-JO.po</td>
</tr>
<tr>
<td>Armenian</td>
<td>hy_am</td>
<td>/openils/var/data/locale/opac/hy-AM.po</td>
</tr>
<tr>
<td>Czech</td>
<td>cs_cz</td>
<td>/openils/var/data/locale/opac/cs-CZ.po</td>
</tr>
<tr>
<td>English - Canada</td>
<td>en_ca</td>
<td>/openils/var/data/locale/opac/en-CA.po</td>
</tr>
<tr>
<td>English - Great Britain</td>
<td>en_gb</td>
<td>/openils/var/data/locale/opac/en-GB.po</td>
</tr>
<tr>
<td>*English - United States</td>
<td>en_us</td>
<td>not applicable</td>
</tr>
<tr>
<td>French - Canada</td>
<td>fr_ca</td>
<td>/openils/var/data/locale/opac/fr-CA.po</td>
</tr>
<tr>
<td>Portuguese - Brazil</td>
<td>pt_br</td>
<td>/openils/var/data/locale/opac/pt-BR.po</td>
</tr>
<tr>
<td>Spanish</td>
<td>es_es</td>
<td>/openils/var/data/locale/opac/es-ES.po</td>
</tr>
</tbody>
</table>

*American English is built into Evergreen so you do not need to set up this language and there are no PO files.

Updating translations in Evergreen using current translations from Launchpad

Due to Evergreen release workflow/schedule, some language strings may already have been translated in Launchpad, but are not yet packaged with Evergreen. In such cases, it is possible to manually replace the PO file in Evergreen with an up-to-date PO file downloaded from Launchpad.

1. Visit the Evergreen translation site in Launchpad
2. Select required language (e.g. Czech or Spanish)

3. Open the tpac template and then select option Download translation. Note: to be able to download the translation file you need to be logged in to Launchpad.

4. Select PO format and submit the request for download button. You can also request for download of all existing templates and languages at once, see https://translations.launchpad.net/evergreen/master/+export. The download link will be sent to your email address provided.

5. Download the file and name it according to the language used (e.g., cs-CZ.po for Czech or es-ES.po for Spanish)

6. Copy the downloaded file to /openils/var/template/data/locale. It is a good practice to backup the original PO file before.

7. Be sure that the desired language is set as default, using the Default language procedures.

Analogously, to update the web staff client translations, download the translation template webstaff and copy it to openils/var/template/data/locale/staff.

Changes require web server reload to take effect. As root run the command

```
service apache2 restart
```

**Change Date Format in Patron Account View**

Libraries with same-day circulations may want their patrons to be able to view the due time as well as due date when they log in to their OPAC account. To accomplish this, go to opac/myopac/circs.tt2. Find the line that reads:

```
[% date.format(due_date, DATE_FORMAT) %]
```

Replace it with:

```
[% date.format(due_date, '%D %I:%M %p') %]
```

**Including External Content in Your Public Interface**

The public interface allows you to include external services and content in your public interface. These can include book cover images, user reviews, table of contents, summaries, author notes, annotations, user suggestions, series information among other services. Some of these services are free while others require a subscription.

The following are some of the external content services which you can configure in Evergreen.

**OpenLibrary**

The default install of Evergreen includes OpenLibrary book covers. The settings for this are controlled by the `<added_content>` section of /openils/conf/opensrf.xml. Here are the key elements of this configuration:
This section calls the OpenLibrary Perl module. If you wish to link to a different book cover service other than OpenLibrary, you must refer to the location of the corresponding Perl module. You will also need to change other settings accordingly.

Max number of seconds to wait for an added content request to return data. Data not returned within the timeout is considered a failure.

This setting is the amount of time to wait before we try again.

Maximum number of consecutive lookup errors a given process can have before added content lookups are disabled for everyone. To adjust the site of the cover image on the record details page edit the config.tt2 file and change the value of the record.summary.jacket_size. The default value is "medium" and the available options are "small", "medium" and "large."

ChiliFresh

ChiliFresh is a subscription-based service which allows book covers, reviews and social interaction of patrons to appear in your catalog. To activate ChiliFresh, you will need to open the Apache configuration file /etc/apache2/eg_vhost.conf and edit several lines:

1. Uncomment (remove the "#" at the beginning of the line) and add your ChiliFresh account number:
   
   #SetEnv OILS_CHILIFRESH_ACCOUNT

1. Uncomment this line and add your ChiliFresh Profile:

   #SetEnv OILS_CHILIFRESH_PROFILE

Uncomment the line indicating the location of the Evergreen JavaScript for ChiliFresh:

   #SetEnv OILS_CHILIFRESH_URL http://chilifresh.com/on-site /js/evergreen.js

1. Uncomment the line indicating the secure URL for the Evergreen JavaScript:

   #SetEnv OILS_CHILIFRESH_HTTPS_URL https://secure.chilifresh.com/on-site/js/evergreen.js

Content Café

Content Café is a subscription-based service that can add jacket images, reviews, summaries, tables of contents and book details to your records.

In order to activate Content Café, edit the /openils/conf/opensrf.xml file and change the <module> element to point to the ContentCafe Perl Module:

   <module>OpenILS::WWW::AddedContent::ContentCafe</module>

To adjust settings for Content Café, edit a couple of fields with the <ContentCafe> Section of /openils/conf/opensrf.xml.
Edit the userid and password elements to match the user id and password for your Content Café account.

This provider retrieves content based on ISBN or UPC, with a default preference for ISBNs. If you wish for UPCs to be preferred, or wish one of the two identifier types to not be considered at all, you can change the "identifier_order" option in opensrf.xml. When the option is present, only the identifier(s) listed will be sent.

**Obalkyknih.cz**

**Setting up Obalkyknih.cz account**

If your library wishes to use added content provided by Obalkyknih.cz, a service based in the Czech Republic, you have to create an Obalkyknih.cz account. Please note that the interface is only available in Czech. After logging in your Obalkyknih.cz account, you have to add your IP address and Evergreen server address to your account settings. (In case each library uses an address of its own, all of these addresses have to be added.)

**Enabling Obalkyknih.cz in Evergreen**

Set obalyknyh_cz.enabled to true in /openils/var/templates/opac/parts/config.tt2:

```perl
obalyknyh_cz.enabled = 'true';
```

Enable added content from Obalkyknih.cz in /openils/conf/opensrf.xml configuration file (and – at the same time – disable added content from Open Library, i.e., Evergreen's default added content provider):

```xml
<!-- <module>OpenILS::WWW::AddedContent::OpenLibrary</module> -->
<module>OpenILS::WWW::AddedContent::ObalkyKnih</module>
```

Using default settings for Obalkyknih.cz means all types of added content from Obalkyknih.cz are visible in your online catalog. If the module is enabled, book covers are always displayed. Other types of added content (summaries, ratings or tables of contents) can be:

- switched off using false option,
- switched on again using true option.

The following types of added content are used:

- summary (or annotation)
- tocPDF (table of contents available as image)
- tocText (table of contents available as text)
- review (user reviews)

An example of how to switch off summaries:

```xml
<summary>false</summary>
```
Google Analytics

Google Analytics is a free service to collect statistics for your Evergreen site.Statistic tracking is disabled by default through the Evergreen client software when library staff use your site within the client, but active when anyone uses the site without the client. This was a preventive measure to reduce the potential risks for leaking patron information. In order to use Google Analytics you will first need to set up the service from the Google Analytics website at http://www.google.com/analytics/. To activate Google Analytics you will need to edit config.tt2 in your template. To enable the service set the value of google_analytics.enabled to true and change the value of google_analytics.code to be the code in your Google Analytics account.

NoveList

NoveList is a subscription-based service providing reviews and recommendation for books in your catalog. To activate your NoveList service in Evergreen, open the Apache configuration file /etc/apache2/eg_vhost.conf and edit the line:

```
#SetEnv OILS_NOVELIST_URL
```

You should use the URL provided by NoveList.

RefWorks

RefWorks is a subscription-based online bibliographic management tool. If you have a RefWorks subscription, you can activate RefWorks in Evergreen by editing the config.tt2 file located in your template directory. You will need to set the ctx.refworks.enabled value to true. You may also set the RefWorks URL by changing the ctx.refworks.url setting on the same file.

SFX OpenURL Resolver

An OpenURL resolver allows you to find electronic resources and pull them into your catalog based on the ISBN or ISSN of the item. In order to use the SFX OpenURL resolver, you will need to subscribe to the Ex Libris SFX service. To activate the service in Evergreen edit the config.tt2 file in your template. Enable the resolver by changing the value of openurl.enabled to true and change the openurl.baseurl setting to point to the URL of your OpenURL resolver.

Syndetic Solutions

Syndetic Solutions is a subscription service providing book covers and other data for items in your catalog. In order to activate Syndetic, edit the /openils/conf/opensrf.xml file and change the <module> element to point to the Syndetic Perl Module:

```
<module>OpenILS::WWW::AddedContent::Syndetic</module>
```

You will also need to edit the <userid> element to be the user id provided to you by Syndetic.

Then, you will need to uncomment and edit the <base_url> element so that it points to the Syndetic service:

```
<base_url>http://syndetics.com/index.aspx</base_url>
```

For changes to be activated for your public interface you will need to restart Evergreen and Apache.
The Syndetic Solutions provider retrieves images based on the following identifiers found in bibliographic records:

- ISBN
- UPC
- ISSN

**Clear External/Added Content Cache**

On the catalog’s record summary page, there is a link for staff that will forcibly clear the cache of the Added Content for that record. This is helpful for when the Added Content retrieved the wrong cover jacket art, summary, etc. and caches the wrong result.

Once clicked, there is a pop up that will display what was cleared from the cache.
You will need to reload the record in the staff client to obtain the new images from your Added Content Supplier.

**Configure a Custom Image for Missing Images**

You can configure a "no image" image other than the standard 1-pixel blank image. The example eg_vhost.conf file provides examples in the comments. Note: Evergreen does not provide default images for these.

**Including Locally Hosted Content in Your Public Interface**

It is also possible to show added content that has been generated locally by placing the content in a specific spot on the web server. It is possible to have local book jackets, reviews, TOC, excerpts or annotations.

**File Location and Format**

By default the files will need to be placed in directories under /openils/var/web/opac/extras/ac/ on the server(s) that run Apache.

The files need to be in specific folders depending on the format of the added content. Local Content can only be looked up based on the record ID at this time.

**URL Format:**

http://catalog/opac/extras/ac/{type}/{format}/r/{recordid}

- type is one of jacket, reviews, toc, excerpt or anotes.
- format is type dependent:
  - for jacket, one of small, medium or large
  - others, one of html, xml or json ... html is the default for non-image added content
- recordid is the bibliographic record id (bre.id).

**Example**

If you have some equipment that you are circulating such as a laptop or eBook reader and you want to add an image of the equipment that will show up in the catalog.

If you are adding jacket art for a traditional type of media (book, CD, DVD) consider adding the jacket art to the [http://openlibrary.org](http://openlibrary.org) project instead of hosting it locally. This would allow other libraries to benefit from your work.
Make note of the Record ID of the bib record. You can find this by looking at the URL of the bib in the catalog. http://catalog/eg/opac/record/123, 123 is the record ID. These images will only show up for one specific record.

Create 3 different sized versions of the image in png or jpg format.

- Small - 80px x 80px - named 123-s.jpg or 123-s.png - This is displayed in the browse display.
- Medium - 240px x 240px - named 123-m.jpg or 123-m.png - This is displayed on the summary page.
- Large - 400px x 399px - named 123-l.jpg or 123-l.png - This is displayed if the summary page image is clicked on.

The image dimensions are up to you, use what looks good in your catalog.

Next, upload the images to the evergreen server(s) that run apache, and move/rename the files to the following locations/name. You will need to create directories that are missing.

- Small - Move the file 123-s.jpg to /openils/var/web/opac/extras/ac/jacket/small/r/123
- Medium - Move the file 123-m.jpg to /openils/var/web/opac/extras/ac/jacket/medium/r/123.
- Large - Move the file 123-l.jpg to /openils/var/web/opac/extras/ac/jacket/large/r/123.

The system doesn’t need the file extension to know what kind of file it is.

Reload the bib record summary in the web catalog and your new image will display.
Chapter 35. Designing the patron search experience

Editing the formats select box options in the search interface

You may wish to remove, rename or organize the options in the formats select box. This can be accomplished from the staff client.

1. From the staff client, navigate to Administration → Server Administration → Marc Coded Value Maps

2. Select Type from the Record Attribute Type select box.

3. Double click on the format type you wish to edit.

To change the label for the type, enter a value in the Search Label field.

To move the option to a top list separated by a dashed line from the others, check the Is Simple Selector check box.

To hide the type so that it does not appear in the search interface, uncheck the OPAC Visible checkbox.

Changes will be immediate.
Adding and removing search fields in advanced search

It is possible to add and remove search fields on the advanced search page by editing the opac/parts/config.tt2 file in your template directory. Look for this section of the file:

```plaintext
search.adv_config = [
    {adv_label => l("Item Type"), adv_attr => ["mattype", "item_type"]},
    {adv_label => l("Item Form"), adv_attr => "item_form"},
    {adv_label => l("Language"), adv_attr => "item_lang"},
    {adv_label => l("Audience"), adv_attr => ["audience_group", "audience"], adv_break => 1},
    {adv_label => l("Video Format"), adv_attr => "vr_format"},
    {adv_label => l("Bib Level"), adv_attr => "bib_level"},
    {adv_label => l("Literary Form"), adv_attr => "lit_form", adv_break => 1},
    {adv_label => l("Search Library"), adv_special => "lib_selector"},
    {adv_label => l("Publication Year"), adv_special => "pub_year"},
    {adv_label => l("Sort Results"), adv_special => "sort_selector"},
];
```

For example, if you delete the line:

```plaintext
{adv_label => l("Language"), adv_attr => "item_lang"},
```

the language field will no longer appear on your advanced search page. Changes will appear immediately after you save your changes.

You can also add fields based on Search Facet Groups that you create in the staff client's Local Administration menu. This can be helpful if you want to simplify your patrons' experience by presenting them with only certain limiters (e.g. the most commonly used languages in your area). To do this,

1. Click Administration → Local Administration → Search Filter Groups.
2. Click New.
3. Enter descriptive values into the code and label fields. The owner needs to be set to your consortium.
4. Once the Facet Group is created, click on the blue hyperlinked code value.
5. Click the New button to create the necessary values for your field.
6. Go to the opac/parts/config.tt2 file, and add a line like the following, where Our Library's Field is the name you’d like to be displayed next to your field, and facet_group_code is the code you’ve added using the staff client.

```plaintext
{adv_label => l("Our Library’s Field"), adv_filter => "facet_group_code"},
```

Changing the display of facets and facet groups

Facets can be reordered on the search results page by editing the opac/parts/config.tt2 file in your template directory.
Edit the following section of config.tt2, changing the order of the facet categories according to your needs:

```
facet.display = [
    {facet_class => 'author', facet_order => ['personal', 'corporate']},
    {facet_class => 'subject', facet_order => ['topic']},
    {facet_class => 'series', facet_order => ['seriestitle']},
    {facet_class => 'subject', facet_order => ['name', 'geographic']}
];
```

You may also change the default number of facets appearing under each category by editing the facet.default_display_count value in config.tt2. The default value is 5.

**Facilitating search scope changes**

Users often search in a limited scope, such as only searching items in their local library. When they aren’t able find materials that meet their needs in a limited scope, they may wish to repeat their search in a system-wide or consortium-wide scope. Evergreen provides an optional button and checkbox to alter the depth of the search to a defined level.

The button and checkbox are both enabled by default and can be configured in the Depth Button/Checkbox section of config.tt2.

Noteworthy settings related to these features include:

- **ctx.depth_sel_checkbox** — set this to 1 to display the checkbox, 0 to hide it.
- **ctx.depth_sel_button** — set this to 1 to display the button, 0 to hide it.
- **ctx.depth_sel_depth** — the depth that should be applied by the button and checkbox. A value of 0 would typically search the entire consortium, and 1 would typically search the library’s system.
Chapter 36. Borrowing items: who, what, for how long

Circulation policies pull together user, library, and item data to determine how library materials circulate, such as: which patrons, from what libraries can borrow what types of materials, for how long, and with what overdue fines.

Individual elements of the circulation policies are configured using specific interfaces, and should be configured prior to setting up the circulation policies.

Data elements that affect your circulation policies

There are a few data elements which must be considered when setting up your circulation policies.

Copy data

Several fields set via the copy editor are commonly used to affect the circulation of an item.

• Circulation modifier - Circulation modifiers are fields used to control circulation policies on specific groups of items. They can be added to copies during the cataloging process. New circulation modifiers can be created in the staff client by navigating to Administration → Server Administration → Circulation Modifiers.

• Circulate? flag - The circulate? flag in the copy editor can be set to False to disallow an item from circulating.

• Reference? flag - The reference? flag in the copy editor can also be used as a data element in circulation policies.

Copy location data

• To get to the Copy Locations Editor, navigate to Administration → Local Administration → Copy Locations Editor.

• Set OPAC Visible to "No" to hide all copies in a copy location from the public catalog. (You can also hide individual copies using the Copy Editor.)

• Set Hold Verify to "Yes" if when a copy checks in you want to always ask for staff confirmation before capturing a hold.

• Set Checkin Alert to "Yes" to allow routing alerts to display when copies are checked in.

• Set Holdable to "No" to prevent copies in an entire copy location from being placed on hold.

• Set Circulate to "No" to disallow circulating copies in an entire copy location.
• If you delete a copy location, it will be removed from display in the staff client and the catalog, but it will remain in the database. This allows you to treat a copy location as deleted without losing statistical information for circulations related to that copy location.

![Copy Locations Editor](image)

• Copy locations can also be used as a data element in circulation policies.

**User data**

Finally, several characteristics of specific patrons can affect circulation policies. You can modify these characteristics in a patron’s record (Search → Search for Patrons, select a patron, choose Edit tab) or when registering a new patron (Circulation → Register Patron).

• The user permission group is also commonly used as a data element in circulation policies.

• Other user data that can be used for circulation policies include the juvenile flag in the user record.

**Circulation Rules**

Loan duration describes the length of time for a checkout. You can also identify the maximum renewals that can be placed on an item.

You can find Circulation Duration Rules by navigating to Administration → Server Administration → Circulation Duration Rules.
Recurring fine describes the amount assessed for daily and hourly fines as well as fines set for other regular intervals. You can also identify any grace periods that should be applied before the fine starts accruing.

You can find Recurring Fine Rules by navigating to Administration → Server Administration → Circulation Recurring Fine Rules.
Max fine describes the maximum amount of fines that will be assessed for a specific circulation. Set the Is Percent field to True if the maximum fine should be a percentage of the item’s price.

You can find Circ Max Fine Rules by navigating to Administration → Server Administration → Circulation Max Fine Rules.

### Recurring Fine Rules

<table>
<thead>
<tr>
<th>#</th>
<th>name</th>
<th>recurrence_int</th>
<th>low</th>
<th>normal</th>
<th>high</th>
<th>grace_period</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10c_pd</td>
<td>1 day</td>
<td>0.10</td>
<td>0.10</td>
<td>0.10</td>
<td>00:00:00</td>
</tr>
<tr>
<td>2</td>
<td>2d_pdl</td>
<td>1 day</td>
<td>2.00</td>
<td>2.00</td>
<td>2.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>3</td>
<td>1d_pdl</td>
<td>1 day</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>4</td>
<td>10d_pdl</td>
<td>1 day</td>
<td>10.00</td>
<td>10.00</td>
<td>10.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>5</td>
<td>50c_pdl</td>
<td>1 day</td>
<td>0.50</td>
<td>0.50</td>
<td>0.50</td>
<td>00:00:00</td>
</tr>
<tr>
<td>6</td>
<td>0c_pdl</td>
<td>1 day</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>7</td>
<td>5c_pdl</td>
<td>1 day</td>
<td>0.05</td>
<td>0.05</td>
<td>0.05</td>
<td>00:00:00</td>
</tr>
<tr>
<td>8</td>
<td>5d_pdl</td>
<td>1 day</td>
<td>5.00</td>
<td>5.00</td>
<td>5.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>9</td>
<td>25c_pdl</td>
<td>1 day</td>
<td>0.25</td>
<td>0.25</td>
<td>0.25</td>
<td>00:00:00</td>
</tr>
<tr>
<td>10</td>
<td>25d_pdl</td>
<td>1 day</td>
<td>25.00</td>
<td>25.00</td>
<td>25.00</td>
<td>00:00:00</td>
</tr>
<tr>
<td>11</td>
<td>15c_pdl</td>
<td>1 day</td>
<td>0.15</td>
<td>0.15</td>
<td>0.15</td>
<td>00:00:00</td>
</tr>
<tr>
<td>12</td>
<td>20c_pdl</td>
<td>1 day</td>
<td>0.20</td>
<td>0.20</td>
<td>0.20</td>
<td>00:00:00</td>
</tr>
<tr>
<td>13</td>
<td>3d_pdl</td>
<td>1 day</td>
<td>3.00</td>
<td>3.00</td>
<td>3.00</td>
<td>00:00:00</td>
</tr>
</tbody>
</table>
Circ Max Fine Rules

<table>
<thead>
<tr>
<th>#</th>
<th>Rule Name</th>
<th>Max Fine Amount</th>
<th>Is Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10d_max_fine</td>
<td>10.00</td>
<td>False</td>
</tr>
<tr>
<td>2</td>
<td>40d_max_fine</td>
<td>40.00</td>
<td>False</td>
</tr>
<tr>
<td>3</td>
<td>5d_max_fine</td>
<td>5.00</td>
<td>False</td>
</tr>
<tr>
<td>4</td>
<td>999d_max_fine</td>
<td>999.00</td>
<td>False</td>
</tr>
<tr>
<td>5</td>
<td>0d_max_fine</td>
<td>0.00</td>
<td>False</td>
</tr>
<tr>
<td>6</td>
<td>2d_max_fine</td>
<td>2.00</td>
<td>False</td>
</tr>
<tr>
<td>7</td>
<td>25d_max_fine</td>
<td>25.00</td>
<td>False</td>
</tr>
<tr>
<td>8</td>
<td>100d_max_fine</td>
<td>100.00</td>
<td>False</td>
</tr>
<tr>
<td>9</td>
<td>30d_max_fine</td>
<td>30.00</td>
<td>False</td>
</tr>
<tr>
<td>10</td>
<td>6d_max_fine</td>
<td>6.00</td>
<td>False</td>
</tr>
<tr>
<td>11</td>
<td>22d_max_fine</td>
<td>22.00</td>
<td>False</td>
</tr>
<tr>
<td>12</td>
<td>150d_max_fine</td>
<td>150.00</td>
<td>False</td>
</tr>
<tr>
<td>13</td>
<td>20d_max_fine</td>
<td>20.00</td>
<td>False</td>
</tr>
<tr>
<td>14</td>
<td>15d_max_fine</td>
<td>15.00</td>
<td>False</td>
</tr>
<tr>
<td>15</td>
<td>50d_max_fine</td>
<td>50.00</td>
<td>False</td>
</tr>
</tbody>
</table>

These rules generally cause the most variation between organizational units.

Loan duration and recurring fine rate are designed with 3 levels: short, normal, and extended loan duration, and low, normal, and high recurring fine rate. These values are applied to specific items, when copy records are created.

When naming these rules, give them a name that clearly identifies what the rule does. This will make it easier to select the correct rule when creating your circ policies.

Circulation Limit Sets

Circulation Limit Sets allow you to limit the maximum number of copies for different types of materials that a patron can check out at one time. Evergreen supports creating these limits based on circulation modifiers, shelving locations, or circulation limit groups, which allow you to create limits based on MARC data. The below instructions will allow you to create limits based on circulation modifiers.

- Configure the circulation limit sets by selecting Administration → Local Administration → Circulation Limit Sets.

- Items Out - The maximum number of items circulated to a patron at the same time.
• Min Depth - Enter the minimum depth in the org tree that Evergreen will consider as valid circulation libraries for counting items out. The min depth is based on org unit type depths. For example, if you want the items in all of the circulating libraries in your consortium to be eligible for restriction by this limit set when it is applied to a circulation policy, then enter a zero (0) in this field.

• Global - Check the box adjacent to Global if you want all of the org units in your consortium to be restricted by this limit set when it is applied to a circulation policy. Otherwise, Evergreen will only apply the limit to the direct ancestors and descendants of the owning library.

• Linked Limit Groups - Add any circulation modifiers, copy locations, or circ limit groups that should be part of this limit set.

Example Your library (BR1) allows patrons to check out up to 5 videos at one time. This checkout limit should apply when your library’s videos are checked out at any library in the consortium. Items with DVD, BLURAY, and VHS circ modifiers should be included in this maximum checkout count.

To create this limit set, you would add 5 to the Items Out field, 0 to the Min Depth field and select the Global flag. Add the DVD, BLURAY and VHS circ modifiers to the limit set.

Creating Circulation Policies

Once you have identified your data elements that will drive circulation policies and have created your circulation rules, you are ready to begin creating your circulation policies.

If you are managing a small number of rules, you can create and manage circulation policies in the staff client via Administration → Local Administration → Circulation Policies. However, if you are managing a large number of policies, it is easier to create and locate rules directly in the database by updating config.circ_matrix_matchpoint.

The config.circ_matrix_matchpoint table is central to the configuration of circulation parameters. It collects the main set of data used to determine what rules apply to any given circulation. It is useful for us to think of their columns in terms of match columns, those that are used to match the particulars of a given circulation transaction, and result columns, those that return the various parameters that are applied to the matching transaction.

• Circulation policies by checkout library or owning library?
  • If your policies should follow the rules of the library that checks out the item, select the checkout library as the Org Unit (org_unit).
  • If your policies should follow the rules of the library that owns the item, select the consortium as the Org Unit (org_unit) and select the owning library as the Copy Circ Lib (copy_circ_lib).

• Renewal policies can be created by setting Renewals? (is_renewal) to True.

• You can apply the duration rules, recurring fine rules, maximum fine rules, and circulation sets created in the above sets when creating the circulation policy.
Best practices for creating policies

- Start by replacing the default consortium-level circ policy with one that contains a majority of your libraries' duration, recurring fine, and max fine rules. This first rule will serve as a default for all materials and permission groups.

- If many libraries in your consortium have rules that differ from the default for particular materials or people, set a consortium-wide policy for that circ modifier or that permission group.

- After setting these consortium defaults, if a library has a circulation rule that differs from the default, you can then create a rule for that library. You only need to change the parameters that are different from the default parameters. The rule will inherit the values for the other parameters from that default consortium rule.

- Try to avoid unnecessary repetition.

- Try to get as much agreement as possible among the libraries in your consortium.

Example 1

<table>
<thead>
<tr>
<th>org_unit</th>
<th>duration_rule</th>
<th>recurring_fine_rule</th>
<th>max_fine_rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONS</td>
<td>21_day_2_renew</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>SYS1</td>
<td>NULL</td>
<td>25_cents</td>
<td>3_dollars</td>
</tr>
</tbody>
</table>

In this example, the consortium has decided on a 21_day_2_renew loan rule for general materials, i.e. books, etc. Most members do not charge overdue fines. System 1 charges 25 cents per day to a maximum of $3.00, but otherwise uses the default circulation duration.

Example 2

<table>
<thead>
<tr>
<th>org_unit</th>
<th>grp</th>
<th>circ_modifier</th>
<th>circulate</th>
<th>duration_rule</th>
<th>recurring_fine_rule</th>
<th>max_fine_rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONS</td>
<td>Users</td>
<td>book</td>
<td>TRUE</td>
<td>21_day_2_renew</td>
<td>5_cents</td>
<td>2_dollars</td>
</tr>
<tr>
<td>CONS</td>
<td>Users</td>
<td>dvd</td>
<td>FALSE</td>
<td>14_day_1_renew</td>
<td>25_cents</td>
<td>5_dollars</td>
</tr>
<tr>
<td>CONS</td>
<td>Users</td>
<td>music</td>
<td>TRUE</td>
<td>14_day_2_renew</td>
<td>10_cents</td>
<td>3_dollars</td>
</tr>
</tbody>
</table>

This example includes a basic set of fields and creates a situation where items with a circ modifier of "book" or "music" can be checked out, but "dvd" items will not circulate. The associated rules would apply during checkouts.
Example 3

<table>
<thead>
<tr>
<th>org_unit</th>
<th>grp</th>
<th>circ_modifier</th>
<th>circulate</th>
<th>duration_rule</th>
<th>recurring_fine_rule</th>
<th>max_fine_rule</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONS</td>
<td>Users</td>
<td>book</td>
<td>TRUE</td>
<td>21_day_2_renew</td>
<td>5_cents</td>
<td>2_dollars</td>
</tr>
<tr>
<td>CONS</td>
<td>Users</td>
<td>dvd</td>
<td>FALSE</td>
<td>14_day_1_renew</td>
<td>25_cents</td>
<td>5_dollars</td>
</tr>
<tr>
<td>SYS1</td>
<td>Adult</td>
<td>dvd</td>
<td>TRUE</td>
<td>14_day_1_renew</td>
<td>25_cents</td>
<td>5_dollars</td>
</tr>
<tr>
<td>CONS</td>
<td>Users</td>
<td>music</td>
<td>TRUE</td>
<td>14_day_2_renew</td>
<td>10_cents</td>
<td>3_dollars</td>
</tr>
<tr>
<td>SYS2</td>
<td>Users</td>
<td>music</td>
<td>FALSE</td>
<td>14_day_2_renew</td>
<td>10_cents</td>
<td>3_dollars</td>
</tr>
<tr>
<td>BR3</td>
<td>Users</td>
<td>music</td>
<td>TRUE</td>
<td>14_day_2_renew</td>
<td>10_cents</td>
<td>3_dollars</td>
</tr>
</tbody>
</table>

This example builds on the earlier example and adds some more complicated options.

It is still true that "book" and "music" items can be checked out, while "dvd" is not circulated. However, now we have added new rules that state that "Adult" patrons of "SYS1" can circulate "dvd" items.

**Settings Relevant to Circulation**

The following circulation settings, available via Administration → Local Administration → Library Settings Editor, can also affect your circulation duration, renewals and fine policy.

- **Auto-Extend Grace Periods** - When enabled, grace periods will auto-extend. By default this will be only when they are a full day or more and end on a closed date, though other options can alter this.

- **Auto-Extending Grace Periods extend for all closed dates** - If enabled and Grace Periods auto-extending is turned on, grace periods will extend past all closed dates they intersect, within hard-coded limits.

- **Auto-Extending Grace Periods include trailing closed dates** - If enabled and Grace Periods auto-extending is turned on, grace periods will include closed dates that directly follow the last day of the grace period.

- **Checkout auto renew age** - When an item has been checked out for at least this amount of time, an attempt to check out the item to the patron that it is already checked out to will simply renew the circulation.

- **Cap Max Fine at Item Price** - This prevents the system from charging more than the item price in overdue fines.
• Lost Item Billing: New Min/Max Price Settings - Patrons will be billed at least the Min Price and at most the Max price, even if the item’s price is outside that range. To set a fixed price for all lost items, set min and max to the same amount.

• Charge fines on overdue circulations when closed - Normally, fines are not charged when a library is closed. When set to True, fines will be charged during scheduled closings and normal weekly closed days.
Chapter 37. Hard due dates

This feature allows you to specify a specific due date within your circulation policies. This is particularly useful for academic and school libraries, who may wish to make certain items due at the end of a semester or term.

To work with hard due dates, you will need the CREATE_CIRC_DURATION, UPDATE_CIRC_DURATION, and DELETE_CIRC_DURATION permissions at the consortium level.

Creating a hard due date

Setting up hard due dates is a two-step process. You must first create a hard due date, and then populate it with specific values.

To create a hard due date:

1. Click Administration → Server Administration → Hard Due Date Changes.
2. Click New Hard Due Date.
3. In the Name field, enter a name for your hard due date. Note that each hard due date can have multiple values, so it’s best to use a generic name here, such as "End of semester."
4. In the Owner field, select the appropriate org unit for your new hard due date.
5. In the Current Ceiling Date field, select any value. This field is required, but its value will be overwritten in subsequent steps, so you may enter an arbitrary date here.
6. Check the Always Use? checkbox if you want items to only receive the due dates you specify, regardless of when they would ordinarily be due. If you leave this box unchecked, your specified due dates will serve as "ceiling" values that limit, rather than override, other circulation rules. In other words, with this box checked, items may be due only on the specified dates. With the box unchecked, items may be due on or before the specified dates, simply not after.
7. Click Save.

To add date values to your hard due date:

1. Click the hyperlinked name of the due date you just created.
2. Click on New Hard Due Date Value
3. In the Ceiling Date field, enter the specific date you would like items to be due.
4. In the Active Date field, enter the date you want this specific due date value to take effect.
5. Click Save.
6. Each Hard Due Date can include multiple values. For example, you can repeat these steps to enter specific due dates for several semesters using this same screen.

After creating a hard due date and assigning it values, you can apply it by adding it to a circulation policy.
Chapter 38. TPac Configuration and Customization

Template toolkit documentation

For more general information about template toolkit see: [official documentation](#).

The purpose of this chapter is to focus on the Evergreen-specific uses of Template Toolkit (TT) in the OPAC.

**TPAC URL**

The URL for the TPAC on a default Evergreen system is [http://localhost/eg/opac/home](http://localhost/eg/opac/home) (adjust *localhost* to match your hostname or IP address, naturally!)

**Perl modules used directly by TPAC**

- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader.pm
- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader/Account.pm
- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader/Container.pm
- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader/Record.pm
- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader/Search.pm
- Open-ILS/src/perlmods/lib/OpenILS/WWW/EGCatLoader/Util.pm

**Default templates**

The source template files are found in *Open-ILS/src/templates/opac*.

These template files are installed in */openils/var/templates/opac*.

**NOTE.** You should generally avoid touching the installed default template files, unless you are contributing changes that you want Evergreen to adopt as a new default. Even then, while you are developing your changes, consider using template overrides rather than touching the installed templates until you are ready to commit the changes to a branch. See below for information on template overrides.

**Apache configuration files**

The base Evergreen configuration file on Debian-based systems can be found in */etc/apache2/sites-enabled/eg.conf*. This file defines the basic virtual host configuration for Evergreen
(hostnames and ports), then single-sources the bulk of the configuration for each virtual host by including `/etc/apache2/eg_vhost.conf`.

**TPAC CSS and media files**

The CSS files used by the default TPAC templates are stored in the repo in `Open-ILS/web/css/skin/default/opac/` and installed in `/openils/var/web/css/skin/default/opac/`.

The media files—mostly PNG images—used by the default TPAC templates are stored in the repo in `Open-ILS/web/images/` and installed in `/openils/var/web/images/`.

**Mapping templates to URLs**

The mapping for templates to URLs is straightforward. Following are a few examples, where `<templates>` is a placeholder for one or more directories that will be searched for a match:

- `http://localhost/eg/opac/home ⇔ /openils/var/<templates>/opac/home.tt2`
- `http://localhost/eg/opac/advanced ⇔ /openils/var/<templates>/opac/advanced.tt2`
- `http://localhost/eg/opac/results ⇔ /openils/var/<templates>/opac/results.tt2`

The template files themselves can process, be wrapped by, or include other template files. For example, the `home.tt2` template currently involves a number of other template files to generate a single HTML file:

**Example Template Toolkit file: opac/home.tt2.**

```tt2
[\% PROCESS "opac/parts/header.tt2";
 WRAPPER "opac/parts/base.tt2";
 INCLUDE "opac/parts/topnav.tt2";
 ctx.page_title = l("Home") %]
 <div id="search-wrapper">
  [% INCLUDE "opac/parts/searchbar.tt2" %]
 </div>
 <div id="content-wrapper">
  <div id="main-content-home">
   <div class="common-full-pad"></div>
   [% INCLUDE "opac/parts/homesearch.tt2" %]
   <div class="common-full-pad"></div>
  </div>
 </div>
[\% END %]
```

We will dissect this example in some more detail later, but the important thing to note is that the file references are relative to the top of the template directory.

**How to override templates**

Overrides for templates go in a directory that parallels the structure of the default templates directory. The overrides then get pulled in via the Apache configuration.
In the following example, we demonstrate how to create a file that overrides the default "Advanced search page" (advanced.tt2) by adding a new templates directory and editing the new file in that directory.

Adding an override for the Advanced search page (example).

```
bash$ mkdir -p /openils/var/templates_custom/opac
bash$ cp /openils/var/templates/opac/advanced.tt2 /openils/var/templates_custom/opac/.
bash$ vim /openils/var/templates_custom/opac/advanced.tt2
```

We now need to teach Apache about the new templates directory. Open eg.conf and add the following `<Location /eg>` element to each of the `<VirtualHost>` elements in which you want to include the overrides. The default Evergreen configuration includes a VirtualHost directive for port 80 (HTTP) and another one for port 443 (HTTPS); you probably want to edit both, unless you want the HTTP user experience to be different from the HTTPS user experience.

Configuring the custom templates directory in Apache’s eg.conf.

```
<VirtualHost *:80>
    # <snip>
    # - absorb the shared virtual host settings
    Include eg_vhost.conf
    <Location /eg>
        PerlAddVar OILSWebTemplatePath "/openils/var/templates_algoma"
    </Location>
    # <snip>
</VirtualHost>
```

Finally, reload the Apache configuration to pick up the changes:

Reloading the Apache configuration.

```
bash# /etc/init.d/apache2 reload
```

You should now be able to see your change at http://localhost/eg/opac/advanced

**Defining multiple layers of overrides**

You can define multiple layers of overrides, so if you want every library in your consortium to have the same basic customizations, and then apply library-specific customizations, you can define two template directories for each library.

In the following example, we define the template_CONS directory as the set of customizations to apply to all libraries, and template_BR# as the set of customizations to apply to library BR1 and BR2.

As the consortial customizations apply to all libraries, we can add the extra template directory directly to eg_vhost.conf:

Apache configuration for all libraries (eg_vhost.conf).

```
# Templates will be loaded from the following paths in reverse order.
PerlAddVar OILSWebTemplatePath "/openils/var/templates"
PerlAddVar OILSWebTemplatePath "/openils/var/templates_CONS"
```
Then we define a virtual host for each library to add the second layer of customized templates on a per-library basis. Note that for the sake of brevity we only show the configuration for port 80.

Apache configuration for each virtual host (eg.conf).

```apache
<VirtualHost *:80>
    ServerName br1.concat.ca
    DocumentRoot /openils/var/web/
    DirectoryIndex index.html index.xhtml
    Include eg_vhost.conf
    <Location /eg>
        PerlAddVar OILSWebTemplatePath "/openils/var/templates_BR1"
    </Location>
</VirtualHost>

<VirtualHost *:80>
    ServerName br2.concat.ca
    DocumentRoot /openils/var/web/
    DirectoryIndex index.html index.xhtml
    Include eg_vhost.conf
    <Location /eg>
        PerlAddVar OILSWebTemplatePath "/openils/var/templates_BR2"
    </Location>
</VirtualHost>
```

Changing some text in the TPAC

Out of the box, the TPAC includes a number of placeholder text and links. For example, there is a set of links cleverly named Link 1, Link 2, and so on in the header and footer of every page in the TPAC. Let’s customize that for our templates_BR1 skin.

To begin with, we need to find the page(s) that contain the text in question. The simplest way to do that is with the handy utility `ack`, which is much like `grep` but with built-in recursion and other tricks. On Debian-based systems, the command is `ack-grep` as `ack` conflicts with an existing utility. In the following example, we search for files that contain the text "Link 1":

```
Searching for text matching "Link 1".

bash$ ack-grep "Link 1" /openils/var/templates/opac
/openils/var/templates/opac/parts/topnav_links.tt2
4:            <a href="http://example.com">[% l('Link 1') %]</a>
```

Next, we copy the file into our overrides directory and edit it with `vim`:

```
Copying the links file into the overrides directory.

bash$ cp /openils/var/templates/opac/parts/topnav_links.tt2 \
/openils/var/templates_BR1/opac/parts/topnav_links.tt2
bash$ vim /openils/var/templates_BR1/opac/parts/topnav_links.tt2
```

Finally, we edit the link text in `opac/parts/header.tt2`.

Content of the opac/parts/header.tt2 file.

```
<div id="gold-links-holder">
    <div id="gold-links">
        <div id="header-links">
            <a href="http://example.com">[% l('Link 1') %]</a>
            <a href="http://example.com">[% l('Link 2') %]</a>
            <a href="http://example.com">[% l('Link 3') %]</a>
```
For the most part, the page looks like regular HTML, but note the [%_(' ')] that surrounds the text of each link. The [% ... %] signifies a TT block, which can contain one or more TT processing instructions. l(" ... "); is a function that marks text for localization (translation); a separate process can subsequently extract localized text as GNU gettext-formatted PO files.

NOTE. As Evergreen supports multiple languages, any customizations to Evergreen’s default text must use the localization function. Also, note that the localization function supports placeholders such as [_1], [_2] in the text; these are replaced by the contents of variables passed as extra arguments to the l() function.

Once we have edited the link and link text to our satisfaction, we can load the page in our Web browser and see the live changes immediately (assuming we are looking at the BR1 overrides, of course).

**Troubleshooting**

If there is a problem such as a TT syntax error, it generally shows up as a an ugly server failure page. If you check the Apache error logs, you will probably find some solid clues about the reason for the failure. For example, in the following example the error message identifies the file in which the problem occurred as well as the relevant line numbers:

Example error message in Apache error logs.

```
bash# grep "template error" /var/log/apache2/error_log
[Tue Dec 06 02:12:09 2011] [warn] [client 127.0.0.1] egweb: template error:
 file error - parse error - opac/parts/record/summary.tt2 line 112-121:
 unexpected token (!=)
 % last_cn = 0;
 FOR copy_info IN
 ctx.copies;
 callnum = copy_info.call_number_label;
```

Chapter 38. TPac Configuration and Customization

Report errors in this documentation using Launchpad.
Chapter 39. Creating a New Skin: the Bare Minimum

Introduction

When you adopt the TPAC as your catalog, you must create a new skin. This involves a combination of overriding template files and setting Apache directives to control the look and feel of your customized TPAC.

Apache directives

There are a few Apache directives and environment variables of note for customizing TPAC behavior. These directives should generally live within a `<vhost>` section of your Apache configuration.

- **OILSWebDefaultLocale** specifies which locale to display when a user lands on a page in the TPAC and has not chosen a different locale from the TPAC locale picker. The following example shows the `fr_ca` locale being added to the locale picker and being set as the default locale:

  ```
  PerlAddVar OILSWebLocale "fr_ca"
  PerlAddVar OILSWebLocale "/openils/var/data/locale/opac/fr-CA.po"
  PerlAddVar OILSWebDefaultLocale "fr-CA"
  ```

- **physical_loc** is an Apache environment variable that sets the default physical location, used for setting search scopes and determining the order in which copies should be sorted. The following example demonstrates the default physical location being set to library ID 104:

  ```
  SetEnv physical_loc 104
  ```

Customizing templates

When you install Evergreen, the TPAC templates include many placeholder images, text, and links. You should override most of these to provide your users with a custom experience that matches your library. Following is a list of templates that include placeholder images, text, or links that you should override.

All paths are relative to `/openils/var/templates/opac`

- **parts/config.tt2**: contains many configuration settings that affect the behavior of the TPAC, including:
  - hiding the Place Hold button for available items
  - enabling RefWorks support for citation management
• adding OpenURL resolution for electronic resources
• enabling Google Analytics tracking for your TPAC
• displaying the "Forgot your password?" prompt
• controlling the size of cover art on the record details page
• defining which facets to display, and in which order
• controlling basic and advanced search options
• controlling if the "Show More Details" button is visible or activated by default in OPAC search results
• hiding phone notification options (useful for libraries that do not do phone notifications)
• disallowing password or e-mail changes (useful for libraries that use centralized authentication or single sign-on systems)
• displaying a maintenance message in the public catalog and KPAC (this is controlled by the ctx.maintenance_message variable)
• displaying previews of books when available from Google Books. This is controlled by the ctx.google_books_preview variable, which is set to 0 by default to protect the privacy of users who might not want to share their browsing behavior with Google.
• disabling the "Group Formats and Editions" search. This is controlled by setting the metarecords.disabled variable to 1.
• setting the default search to a Group Formats and Editions search. This is done by setting the search.metarecord_default variable to 1.
• parts/footer.tt2 and parts/topnav_links.tt2: contains customizable links. Defaults like Link 1 will not mean much to your users!
• parts/homesearch.tt2: holds the large Evergreen logo on the home page of the TPAC. Substitute your library's logo, or if you are adventurous, create a "most recently added items" carousel... and then share your customization with the Evergreen community.
• parts/topnav_logo.tt2: holds the small Evergreen logo that appears on the top left of every page in the TPAC. You will also want to remove or change the target of the link that wraps the logo and leads to the Evergreen site.
• parts/login/form.tt2: contains some assumptions about terminology and examples that you might prefer to change to be more consistent with your own site's existing practices. For example, you may not use PIN at your library because you want to encourage users to use a password that is more secure than a four-digit number.
• parts/login/help.tt2: contains links that point to http://example.com, images with text on them (which is not an acceptable practice for accessibility reasons), and promises of answers to frequently asked questions that might not exist at your site.
• **parts/login/password_hint.tt2**: contains a hint about your users' password on first login that is misleading if your library does not set the initial password for an account to the last four digits of the phone number associated with the account.

• **parts/myopac/main_refund_policy.tt2**: describes the policy for refunds for your library.

• **parts/myopac/prefs_hints.tt2**: suggests that users should have a valid email on file so they can receive courtesy and overdue notices. If your library does not send out email notices, you should edit this to avoid misleading your users.

• **myopac/update_password_msg.tt2**: defines the password format that needs to be used when setting a user password. If your Evergreen site has set Password format regex in the Library Settings Editor, you should update the language to describe the format that should be used.

• **password_reset.tt2**: in the msg_map section, you might want to change the NOT_STRONG text that appears when the user tries to set a password that does not match the required format. Ideally, this message will tell the user how they should format the password.

• **parts/css/fonts.tt2**: defines the font sizes for the TPAC in terms of one base font size, and all other sizes derived from that in percentages. The default is 12 pixels, but some design sites strongly suggest a base font size of 16 pixels. Perhaps you want to try 1em as a base to respect your users' preferences. You only need to change one number in this file if you want to experiment with different options for your users.

• **parts/css/colors.tt2**: chances are your library's official colors do not match Evergreen's wall of dark green. This file defines the colors in use in the standard Evergreen template. In theory you should be able to change just a few colors and everything will work, but in practice you will need to experiment to avoid light-gray-on-white low-contrast combinations.

The following are templates that are less frequently overridden, but some libraries benefit from the added customization options.

• **parts/advanced/numeric.tt2**: defines the search options of the Advanced Search > Numeric search. If you wanted to add a bib call number search option, which is different from the item copy call number; you would add the following code to **numeric.tt2**.

```plaintext
<option value="identifier|bibcn">[% l('Bib Call Number') %]</option>
```
Chapter 40. Auto Suggest in Catalog Search

The auto suggest feature suggestions for completing search terms as the user enters his search query. Ten suggestions are the default, but the number of suggestions is configurable at the database level. Scroll through suggestions with your mouse, or use the arrow keys to scroll through the suggestions. Select a suggestion to view records that are linked to this suggestion. This feature is not turned on by default. You must turn it on in the Administration module.

Enabling this Feature

1. To enable this feature, click Administration → Server Administration → Global Flags.

2. Scroll down to item 10, OPAC.

3. Double click anywhere in the row to edit the fields.

4. Check the box adjacent to Enabled to turn on the feature.

5. The Value field is optional. If you checked Enabled in step 4, and you leave this field empty, then Evergreen will only suggest searches for which there are any corresponding MARC records.

   If you checked Enabled in step 4, and you enter the string, opac_visible, into this field, then Evergreen will suggest searches for which there are matching MARC records with copies within your search scope. For example, it will suggest MARC records with copies at your branch.

6. Click Save.

Using this Feature

1. Enter search terms into the basic search field. Evergreen will automatically suggest search terms.

2. Select a suggestion to view records that are linked to this suggestion.
To support integration of Evergreen with organizational authentication systems, and to reduce the proliferation of user names and passwords, Evergreen offers a service called open-ils.auth_proxy. If you enable the service, open-ils.auth_proxy supports different authentication mechanisms that implement the authenticate method. You can define a chain of these authentication mechanisms to be tried in order within the <authenticators> element of the opensrf.xml configuration file, with the option of falling back to the native mode that uses Evergreen’s internal method of password authentication.

This service only provides authentication. There is no support for automatic provisioning of accounts. To authenticate using any authentication system, the user account must first be defined in the Evergreen database. The user will be authenticated based on the Evergreen username and must match the user’s ID on the authentication system.

In order to activate Authentication Proxy, the Evergreen system administrator will need to complete the following steps:

1. Edit opensrf.xml.
   
   a. Set the open-ils.auth_proxy app settings enabled tag to true
      
   b. Add the authenticator to the list of authenticators or edit the existing example authenticator:

   ```xml
   <authenticator>
     <name>ldap</name>
     <module>OpenILS::Application::AuthProxy::LDAP_Auth</module>
     <hostname>name.domain.com</hostname>
     <basedn>ou=people,dc=domain,dc=com</basedn>
     <authid>cn=username,ou=specials,dc=domain,dc=com</authid>
     <id_attr>uid</id_attr>
     <password>my_ldap_password_for_authid_user</password>
     <login_types>
       <type>staff</type>
       <type>opac</type>
     </login_types>
     <org_units>
       <unit>103</unit>
       <unit>104</unit>
     </org_units>
   </authenticator>
   ```

   • name : Used to identify each authenticator.
   
   • module : References to the perl module used by Evergreen to process the request.
   
   • hostname : Hostname of the authentication server.
   
   • basedn : Location of the data on your authentication server used to authenticate users.
   
   • authid : Administrator ID information used to connect to the Authentication server.
• id_attr: Field name in the authenticator matching the username in the Evergreen database.
• password: Administrator password used to connect to the authentication server. Password for the authid.
• login_types: Specifies which types of logins will use this authenticator. This might be useful if staff use a different LDAP directory than general users.
• org_units: Specifies which org units will use the authenticator. This is useful in a consortium environment where libraries will use separate authentication systems.

2. Restart Evergreen and Apache to activate configuration changes.

If using proxy authentication with library employees that will click the Change Operator feature in the client software, then add “Temporary” as a login_types.
Chapter 42. Kid’s OPAC Configuration

Configuration

Apache

The KPAC is already included and ready to be used with new Evergreen installs. So you only need to change the apache config if you need to change template locations or if you want to use a different kpac.xml config file. The defaults for the KPAC are set in /etc/apache2/eg_vhosts.conf.

```apache
<Location /eg/kpac>
    PerlSetVar OILSWebContextLoader "OpenILS::WWW::EGKPacLoader"
    PerlSetVar KPacConfigFile "/openils/conf/kpac.xml.example"
</Location>
```

XML Configuration File

- The XML configuration file defines the layout of the kid’s OPAC.
- It is read with each restart/reload of the Apache web server.
- The file lives by default at /openils/conf/kpac.xml.example
- There are two top-level elements: <pages> and <layout>.
- The layout defines the owning org unit and the start page, both by ID.
- At runtime, the layout is determined by the context org unit. If no configuration is defined for the context org unit, the layout for the closest ancestor is used.

```xml
<layout owner="1" page="1"/>
```

- The pages section is a container for <page> elements.
- Each page defines an ID, the number of columns to display for the page, the page name, and an icon.

```xml
<page id="1" columns="5" name="Home" img="/images/home.jpg">
```

- Each page is a container of cells
- Each cell defines
  - type (topic, search, link)
  - name
  - icon
  - content
Skin Configuration

The following example enables you to configure the alternate skin (Monster Skin, kpac2) for the Kids Catalog.

You should be familiar with how the [Evergreen TPAC handles template folders](#) before you make these changes.

If you already have a custom template directory setup you can copy the Open-ILS/examples/web/templates/kpac files to that directory instead, and then skip any Apache config changes.

```bash
% cp -r Open-ILS/examples/web/css/skin/kpac2 /openils/var/web/css/skin/
% cp -r Open-ILS/examples/web/images/kpac/* /openils/var/web/images/kpac/ #does not clobber
% mkdir /openils/var/templates_kpac2
% cp -r Open-ILS/examples/web/templates/kpac /openils/var/templates_kpac2/
% cp -r /openils/var/web/css/skin/default/kpac/fonts /openils/var/web/css/skin/kpac2/kpac
```

Then set up 443/80 vhosts for serving the alternate skin in eg.conf, something along the lines of:

```conf
<VirtualHost *:80>
  ServerName xyz.dev198.esilibrary.com:80
  DocumentRoot /openils/var/web/
  DirectoryIndex index.html index.xhtml
  Include eg_vhost.conf
  <Location /eg/kpac>
    #Point to a different kpac.xml config file if needed
    #PerlSetVar KPacConfigFile "'/openils/conf/kpac.xml.example"
    PerlAddVar OILSWebTemplatePath "'/openils/var/templates_kpac2"
  </Location>
</VirtualHost>
```

Considerations for Community Adoption

The templates for the Kid’s OPAC were developed long before the TPAC was integrated into Evergreen and it has many of the same limitations that were part of the TPAC.

- Fixed width elements (divs, images, etc.), which complicates the addition of new features and local customizations.
- Images with text, which prevents l10n/i18n.
• While the KPAC does not attempt to match the color scheme of any one institution, it’s inconsistent with the standard Evergreen color palette. Creating an additional skin to act as the Evergreen default may be necessary.

Outstanding Development (Unsponsored)

• Port the XML configuration file to a DB structure, complete with UI for managing the various components and upgrade path.
Chapter 43. Patron Address City/State/County Pre-Populate by ZIP Code

This feature saves staff time and increases accuracy when entering patron address information by automatically filling in the City, State and County information based on the ZIP code entered by the staff member.

Released: Evergreen 0.1, available in all versions.

Please be aware of the following when using this feature.

• ZIP codes do not always match 1 to 1 with City, State and County. ZIP codes were designed for postal delivery and represent postal delivery zones that may cover more than one city, state or county.

• It is currently only possible to have one match per ZIP code, but you can add an alert to those entries to prompt staff to double check the entered data.

• Only the first 5 digits of the ZIP are used. ZIP+4 is not currently supported.

• The zips.txt data is loaded once at service startup and stored in memory, so changes to the zips.txt data file require that Evergreen be restarted. Specifically, you need to restart the "openils.search" OpenSRF service.

Scoping and Permissions

There are no staff client permissions associated with this feature since there is no staff client interface.

This feature affects all users of the system; there is no way to have separate settings per Org Unit.

Setup Steps

Step 1 - Setup Data File

The default location and name of the data file is /openils/var/data/zips.txt on your Evergreen server. You can choose a different location if needed.

The file format of your zips.txt will look like this (delimited by the .):

ID|StateAbb|City|ZIP|IsDefault|StateID|County|AreaCode|AlertMesg

The only fields that are used are StateAbb, City, ZIP, IsDefault, County and AlertMesg.

Most fields can be left blank if the information is not available and that data will not be entered.
Data Field Descriptions

1. ID - ID field to uniquely identify this row. Not required, can be left blank.
2. StateAbb - State abbreviation like "MN" or "ND".
3. City - Name of city.
4. ZIP - ZIP code, only first 5 digits used.
5. IsDefault - Must be set to 1 for the row to be used. Easy way to disable/enable a row.
6. StateID - Unknown and unused.
7. County - County name.
8. AreaCode - Phone number area code, unused.
9. AlertMesg - Message to display to staff to alert them of any special circumstances.

The Address Alerts feature — described in the Staff Client Sysadmin manual — can also be used to alert staff about certain addresses.

Here is an example of what the data file should look like.

Example zips.txt.

| MN | Moorhead | 56561 | 1 | || Clay ||
| MN | Moorhead | 56562 | 1 | || Clay ||
| MN | Moorhead | 56563 | 1 | || Clay ||
| MN | Sabin | 56580 | 1 | || Clearwater County ||
| MN | Ulen | 56585 | 1 | || Clay ||
| MN | Lake Itasca | 56468 | 1 | || Clearwater County ||
| MN | Bagley | 56621 | 1 | || Clearwater ||
| MN | Clearbrook | 56634 | 1 | || Clearwater ||
| MN | Gonvick | 56644 | 1 | || Clearwater ||

Step 2 - Enable Feature

The next step is to tell the system to use the zips.txt file that you created. This is done by editing /openils/conf/opensrf.xml. Look about halfway into the file and you may very well see a commented section in the file that looks similar to this:

```xml
<!-- zip code database file -->
<!--<zips_file>/openils/var/data/zips.txt</zips_file>-->  
</app_settings>
</open-ils.search>
```

Uncomment the area by . .. Change the file path if you placed your file in a different location. The file should look like this after you are done.

```xml
<!-- zip code database file -->
<zips_file>/openils/var/data/zips.txt</zips_file>
```
Save and Restart. Save your changes to the opensrf.xml file, restart Evergreen and restart Apache.

The specific opensrf services you need to restart are "opensrf.setting" and "open-ils.search".

---

**Step 3 - Test**

Open up the staff client and try to register a new patron. When you get to the address section, enter a ZIP code that you know is in your zips.txt file. The data from the file that matches your ZIP will auto fill the city, state and county fields.

**ZIP Code Data**

There are several methods you can use to populate your zips.txt with data.

**Manual Entry**

If you only have a few communities that you serve, entering data manually may be the simplest approach.

**Geonames.org Data**

Geonames.org provides free ZIP code to city, state and county information licensed under the Creative Commons Attribution 3.0 License, which means you need to put a link to them on your website. Their data includes primary city, state and county information only. It doesn’t include info about which other cities are included in a ZIP code. Visit [http://www.geonames.org](http://www.geonames.org) for more info.

The following code example shows you how to download and reformat the data into the zips.txt format. You have the option to filter the data to only include certain states also.

```bash
## How to get a generic Evergreen zips.txt for free
wget http://download.geonames.org/export/zip/US.zip
unzip US.zip
cut -f2,3,5,6 US.txt | perl -ne 'chomp; @f=split(/t/); print | . join("","",@f[2,1,0],"",""); print "\n";' > zips.txt

##Optionally filter the data to only include certain states
egrep "^[|ND\|MN\|WI\|SD\]|" zips.txt > zips-mn.txt
```

**Commercial Data**

There are many vendors that sell databases that include ZIP code to city, state and county information. A web search will easily find them. Many of the commercial vendors will include more...
information on which ZIP codes cover multiple cities, counties and states, which you could use to populate the alert field.

**Existing Patron Database**

Another possibility is to use your current patron database to build your zips.txt. Pull out the current ZIP, city, state, county unique rows and use them to form your zips.txt.

Small Sites. For sites that serve a small geographic area (less than 30 ZIP codes), an sql query like the following will create a zips.txt for you. It outputs the number of matches as the first field and sorts by ZIP code and number of matches. You would need to go through the resulting file and deal with duplicates manually.

```
psql egdb26 -A -t -F $'|' -c "SELECT count(substring(post_code from 1 for 5)) as zipcount, state, city, substring(post_code from 1 for 5) as pc, '1', '', county, '', '' FROM actor.usr_address group by pc, city, state, county order by pc, zipcount DESC" > zips.txt
```

Larger Sites. For larger sites Ben Ostrowsky at ESI created a pair of scripts that handles deduplicating the results and adding in county information. Instructions for use are included in the files.

- [http://git.esilibrary.com/?p=migration-tools.git;a=blob;f=elect_ZIPs](http://git.esilibrary.com/?p=migration-tools.git;a=blob;f=elect_ZIPs)
- [http://git.esilibrary.com/?p=migration-tools.git;a=blob;f=enrich_ZIPs](http://git.esilibrary.com/?p=migration-tools.git;a=blob;f=enrich_ZIPs)

**Development**

If you need to make changes to how this feature works, such as to add support for other postal code formats, here is a list of the files that you need to look at.

1. Zips.pm - contains code for loading the zips.txt file into memory and replying to search queries. Open-ILS / src / perlmods / lib / OpenILS / Application / Search / Zips.pm

2. register.js - This is where patron registration logic is located. The code that queries the ZIP search service and fills the address is located here. Open-ILS / web / js / ui / default / actor / user / register.js
Chapter 44. Phonelist.pm Module

Introduction

PhoneList.pm is a mod_perl module for Apache that works with Evergreen to generate callings lists for patron holds or overdues. It outputs a csv file that can be fed into an auto-dialer script to call patrons with little or no staff intervention. It is accessed and configured via a special URL and passing any parameters as a Query String on the URL. The parameters are listed in the table below.

Table 44.1. Parameters for the phonelist program:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user</td>
<td>Your Evergreen login. Typically your library’s circ account. If you leave this off, you will be prompted to login.</td>
</tr>
<tr>
<td>passwd</td>
<td>The password for your Evergreen login. If you leave this off you will be prompted to login.</td>
</tr>
<tr>
<td>ws_ou</td>
<td>The ID of the system or branch you want to generate the list for (optional). If your account does not have the appropriate permissions for the location whose ID number you have entered, you will get an error.</td>
</tr>
<tr>
<td>skipemail</td>
<td>If present, skip patrons with email notification (optional).</td>
</tr>
<tr>
<td>addcount</td>
<td>Add a count of items on hold (optional). Only makes sense for holds.</td>
</tr>
<tr>
<td>overdue</td>
<td>Makes a list of patrons with overdues instead of holds. If an additional, numeric parameter is supplied, it will be used as the number of days overdue. If no such extra parameter is supplied, then the default of 14 days is used.</td>
</tr>
</tbody>
</table>

The URL is

https://your.evergreen-server.tld/phonelist

A couple of examples follow:

https://your.evergreen-server.tld/phonelist?
user=circuser&passwd=password&skipemail

The above example would sign in as user circuser with password of password and get a list of patrons with holds to call who do not have email notification turned on. It would run at whatever branch is normally associated with circuser.

https://your.evergreen-server.tld/phonelist?skipemail
The above example would do more or less the same, but you would be prompted by your browser for the user name and password.

If your browser or download script support it, you may also use conventional HTTP authentication parameters.

```
https://user:password@your.evergreen-server.tld/phonelist?overdue&ws_ou=2
```

The above logs in as user with password and runs overdues for location ID 2.

The following sections provide more information on getting what you want in your output.

### Adding Parameters

If you are not familiar with HTTP/URL query strings, the format is quite simple.

You add parameters to the end of the URL, the first parameter is separated from the URL page with a question mark (?) character. If the parameter is to be given an extra value, then that value follows the parameter name after an equals sign (=). Subsequent parameters are separated from the previous parameter by an ampersand (&).

Here is an example with 1 parameter that has no value:

```
https://your.evergreen-server.tld/phonelist?skipemail
```

An example of 1 argument with a value:

```
https://your.evergreen-server.tld/phonelist?overdue=21
```

An example of 2 arguments, 1 with a value and 1 without:

```
https://your.evergreen-server.tld/phonelist?overdue=21&skipemail
```

Any misspelled or parameters not listed in the table above will be ignored by the program.

### Output

On a successful run, the program will return a CSV file named phone.csv. Depending on your browser or settings you will alternately be prompted to open or save the file. Your browser may also automatically save the file in your Downloads or other designated folder. You should be able to open this CSV file in Excel, LibreOffice Base, any other spread sheet program, or a text editor.

If you have made a mistake and have mistyped your user name or password, or if you supply a ws_ou parameter with an ID where your user name does not have permission to look up holds or overdue information, then you will get an error returned in your browser.

Should your browser appear to do absolutely nothing at all. This is normal. When there is no information for you to download, the server will return a 200 NO CONTENT message to your browser. Most browsers respond to this message by doing nothing at all. It is possible for there to be no
information for you to retrieve if you added the skipemail option and all of your notices for that
day were sent via email, or if you ran this in the morning and then again in the afternoon and there
was no new information to gather.

The program does indicate that it has already looked at a particular hold or overdue and will skip it
on later runs. This prevents duplicates to the same patron in the same run. It will, however, create a
duplicate for the same patron if a different copy is put on hold for that patron in between two runs.

The specific content of the CSV file will vary if you are looking at holds or overdues. The specific
contents are described in the appropriate sections below.

## Holds

The phonelist program will return a list of patrons with copies on hold by default, so long as you
do not use the overdue parameter. You may optionally get a number of items that patron currently
has on hold by adding the addcount parameter.

As always, you can add the skipemail parameter to skip patrons with email notifications of their
overdues, see  Skipping patrons with email notification of holds  as described below.

### Table 44.2. Columns in the holds CSV file:

<table>
<thead>
<tr>
<th>Name</th>
<th>Patron’s name first and last.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone</td>
<td>Patron’s phone number.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Patron’s barcode.</td>
</tr>
<tr>
<td>Count</td>
<td>Number of copies on hold, if addcount parameter is used, otherwise this column is not present in the file.</td>
</tr>
</tbody>
</table>

## Overdues

If you add the overdue parameter, you can get a list of patrons with overdue copies instead of
a list of patrons with copies on the hold shelf. By default, this will give you a list of patrons with
copies that are 14 days overdue. If you’d like to specify a different number of days you can add
the number after the parameter with an equals sign:

https://your.evergreen-server.tld/phonelist?overdue=21&ws_ou=2

The above will retrieve a list of patrons who have items that are 21 days overdue at the location
with ID of 2.

The number of days is an exact lookup. This means that the program will look only at patrons who
have items exactly 14 days or exactly the number of days specified overdue. It does not pull up
any that are less than or greater than the number of days specified.

As always, you can add the skipemail parameter to skip patrons with email notifications of their
overdues, see  Skipping patrons with email notification of holds  as described below.
Table 44.3. Columns in the overdues CSV file:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Patron’s name first and last.</td>
</tr>
<tr>
<td>Phone</td>
<td>Patron’s phone number.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Patron’s barcode.</td>
</tr>
<tr>
<td>Titles</td>
<td>A colon-separated list of titles that the patron has overdue.</td>
</tr>
</tbody>
</table>

**Skipping patrons with email notification of holds**

Skipping patrons who have email notification for their holds or overdues is very simple. You just need to add the `skipemail` parameter on the URL query string. Doing so will produce the list without the patrons who have email notification for overdues, or for all of their holds. Please note that if a patron has multiple holds available, and even one of these holds requests a phone-only notification, then that patron will still show on the list. For this option to exclude a patron from the holds list, the patron must request email notification on all of their current holds. In practice, we find that this is usually the case.

**Using the ws_ou parameter**

Generally, you will not need to use the `ws_ou` parameter when using the phonelist program. The phonelist will look up the branch where your login account works and use that location when generating the list. However, if you are part of a multi-branch systems in a consortium, then the `ws_ou` parameter will be of interest to you. You can use it to specify which branch, or the whole system, you wish to search when running the program.

**Automating the download**

If you’d like to automate the download of these files, you should be able to do so using any HTTP programming toolkit. Your client must accept cookies and follow any redirects in order to function.
Chapter 45. SIP Server

About the SIP Protocol

SIP, standing for Standard Interchange Protocol, was developed by the 3M corporation to be a common protocol for data transfer between ILS' (referred to in SIP as an ACS, or Automated Circulation System) and a third party device. Originally, the protocol was developed for use with 3M SelfCheck (often abbreviated SC, not to be confused with Staff Client) systems, but has since expanded to other companies and devices. It is now common to find SIP in use in several other vendors' SelfCheck systems, as well as other non-SelfCheck devices. Some examples include:

- Patron Authentication (computer access, subscription databases)
- Automated Material Handling (AMH)
  - The automated sorting of items, often to bins or book carts, based on shelving location or other programmable criteria

Installing the SIP Server

This is a rough intro to installing the SIP server for Evergreen.

Getting the code

Current SIP server code lives at in the Evergreen git repository:

```bash
cd /opt
git clone git://git.evergreen-ils.org/SIPServer.git SIPServer
```

Configuring the Server

1. Type the following commands from the command prompt:

   ```bash
   $ sudo su opensrsf
   $ cd /openils/conf
   $ cp oils_sip.xml.example oils_sip.xml
   ```

2. Edit oils_sip.xml. Change the commented out `<server-params>` section to this:

   ```xml
   <server-params
     min_spare_servers='1'
     max_spare_servers='2'
     min_servers='3'
     max_servers='25'
   />
   ```

3. max_servers will directly correspond to the number of allowed SIP clients. Set the number accordingly, but bear in mind that too many connections can exhaust memory. On a 4G RAM/4
CPU server (that is also running evergreen), it is not recommended to exceed 100 SIP client connections.

Setting the encoding

SIPServer looks for the encoding in the following places:

1. An `encoding` attribute on the `account` element for the currently active SIP account.

2. The `encoding` element that is a child of the `institution` element of the currently active SIP account.

3. The `encoding` element that is a child of the `implementation_config` element that is itself a child of the `institution` element of the currently active SIP account.

4. If none of the above exist, then the default encoding (ASCII) is used.

Option 3 is a legacy option. It is recommended that you alter your configuration to move this element out of the `implementation_config` element and into its parent `institution` element. Ideally, SIPServer should not look into the implementation config, and this check may be removed at some time in the future.

Datatypes

The `msg64_hold_datatype` setting is similar to `msg64_summary_datatype`, but affects holds instead of circulations. When set to `barcode`, holds information will be delivered as a set of copy barcodes instead of title strings for patron info requests. With barcodes, SIP clients can both find the title strings for display (via item info requests) and make subsequent hold-related action requests, like holds cancellation.

Adding SIP Users

1. Type the following commands from the command prompt:

   ```
   $ sudo su opensrf
   $ cd /openils/conf
   ```

2. In the `<accounts>` section, add SIP client login information. Make sure that all `<logins>` use the same institution attribute, and make sure the institution is listed in `<institutions>`. All attributes in the `<login>` section will be used by the SIP client.

3. In Evergreen, create a new profile group called SIP. This group should be a sub-group of Users (not Staff or Patrons). Set Editing Permission as group_application.user.sip_client and give the group the following permissions:

   ```
   COPY_CHECKIN
   COPY_CHECKOUT
   CREATE_PAYMENT
   RENEW_CIRC
   VIEW_CIRCULATIONS
   VIEW_COPY_CHECKOUT_HISTORY
   VIEW_PERMIT_CHECKOUT
   VIEW_USER
   ```
VIEW_USER_FINES_SUMMARY
VIEW_USER_TRANSACTIONS

OR use SQL like:

```sql
INSERT INTO permission.grp_tree (name,parent,description,application_perm)
VALUES ('SIP', 1, 'SIP2 Client Systems', 'group_application.user.sip_client');

INSERT INTO
    permission.grp_perm_map (grp, perm, depth, grantable)
SELECT
    g.id, p.id, 0, FALSE
FROM
    permission.grp_tree g,
    permission.perm_list p
WHERE
    g.name = 'SIP' AND
    p.code IN ('COPY_CHECKIN', 'COPY_CHECKOUT', 'RENEW_CIRC', 'VIEW_CIRCULATIONS', 'VIEW_COPY_CHECKOUT_HISTORY', 'VIEW_PERMIT_CHECKOUT', 'VIEW_USER', 'VIEW_USER_FINES_SUMMARY', 'VIEW_USER_TRANSACTIONS');
```

Verify:

```sql
SELECT *
FROM permission.grp_perm_map pgpm
INNER JOIN permission.perm_list ppl ON pgpm.perm = ppl.id
INNER JOIN permission.grp_tree pgt ON pgt.id = pgpm.grp
WHERE pgt.name = 'SIP';
```

4. For each account created in the `<login>` section of oils_sip.xml, create a user (via the staff client user editor) that has the same username and password and put that user into the SIP group.

The expiration date will affect the SIP users' connection so you might want to make a note of this somewhere.

### Running the server

To start the SIP server type the following commands from the command prompt:

```
$ sudo su opensrf
$ oils_ctl.sh -a [start|stop|restart]_sip
```

### Logging-SIP

Syslog
It is useful to log **SIP** requests to a separate file especially during initial setup by modifying your syslog config file.

1. Edit syslog.conf.
   
   ```bash
   $ sudo vi /etc/syslog.conf  # maybe /etc/rsyslog.conf
   ```

2. Add this:
   
   ```bash
   local6.*                -/var/log/SIP_evergreen.log
   ```

3. Syslog expects the logfile to exist so create the file.
   
   ```bash
   $ sudo touch /var/log/SIP_evergreen.log
   ```

4. Restart sysklogd.
   
   ```bash
   $ sudo /etc/init.d/sysklogd restart
   ```

### Syslog-NG

1. Edit logging config.
   
   ```bash
   sudo vi /etc/syslog-ng/syslog-ng.conf
   ```

2. Add:
   
   ```bash
   # +SIP2+ for Evergreen
   filter    f_eg_sip { level(warn, err, crit) and facility(local6); }; 
   destination eg_sip { file("var/log/SIP_evergreen.log"); }; 
   log { source(s_all); filter(f_eg_sip); destination(eg_sip); }; 
   ```

3. Syslog-ng expects the logfile to exist so create the file.
   
   ```bash
   $ sudo touch /var/log/SIP_evergreen.log
   ```

4. Restart syslog-ng
   
   ```bash
   $ sudo /etc/init.d/syslog-ng restart
   ```

### Testing Your SIP Connection

- In the root directory of the SIPServer code:
  
  ```bash
  $ cd SIPServer/t
  ```

- Edit SIPtest.pm, change the $instid, $server, $username, and $password variables. This will be enough to test connectivity. To run all tests, you’ll need to change all the variables in the Configuration section.
  
  ```bash
  $ PERL5LIB=../ perl 00sc_status.t
  ```

  This should produce something like:

  ```
  1..4
  ```
More Testing

Once you have opened up either the SIP OR SIP2 ports to be accessible from outside you can do some testing via telnet. In the following tests:

- Replace $server with your server hostname (or localhost if you want to skip testing external access for now);
- Replace $username, $password, and $instid with the corresponding values in the <accounts> section of your SIP configuration file;
- Replace the $user_barcode and $user_password variables with the values for a valid user.
- Replace the $item_barcode variable with the values for a valid item.

1. Start by testing your ability to log into the SIP server:

   We are using 6001 here which is associated with SIP2 as per our configuration.

   $ telnet $server 6001
   Connected to $server.
   Escape character is '^]'.
   9300CN$username|CO$password|CP$instid

   If successful, the SIP server returns a 941 result. A result of 940, however, indicates an unsuccessful login attempt. Check the <accounts> section of your SIP configuration and try again.

2. Once you have logged in successfully, replace the variables in the following line and paste it into the telnet session:

   2300120080623 172148A0$instid|AA$user_barcode|AC$password|AD$user_password

   If successful, the SIP server returns the patron information for $user_barcode, similar to the following:

   24  Y 00120100113 170738AEFirstName MiddleName LastName|AA$user_barcode|BLY|CQY|BHUSD|BV0.00|AFOK|AO$instid|

   The response declares it is a valid patron BLY with a valid password CQY and shows the user's $name.

3. To test the SIP server’s item information response, issue the following request:

   1700120080623 172148A0$instid|AB$item_barcode|AC$password
If successful, the SIP server returns the item information for $item_barcode, similar to the following:

1803020120160923    190132AB30007003601852|AJRégion de Kamouraska|CK001|AQOSUL|APOSUL|BHCAD
|BV0.00|BGOSUL|CSCA2 PQ NR46 73R

The response declares it is a valid item, with the title, owning library, permanent and current locations, and call number.

**SIP Communication**

SIP generally communicates over a TCP connection (either raw sockets or over telnet), but can also communicate via serial connections and other methods. In Evergreen, the most common deployment is a RAW socket connection on port 6001.

SIP communication consists of strings of messages, each message request and response begin with a 2-digit “command” - Requests usually being an odd number and responses usually increased by 1 to be an even number. The combination numbers for the request command and response is often referred to as a Message Pair (for example, a 23 command is a request for patron status, a 24 response is a patron status, and the message pair 23/24 is patron status message pair). The table in the next section shows the message pairs and a description of them.

For clarification, the “Request” is from the device (selfcheck or otherwise) to the ILS/ACS. The response is... the response to the request ;).

Within each request and response, a number of fields (either a fixed width or separated with a | pipe symbol) and preceded with a 2-character field identifier) are used. The fields vary between message pairs.

<table>
<thead>
<tr>
<th>Pair</th>
<th>Name</th>
<th>Supported?</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Block Patron</td>
<td>Yes</td>
<td>01/Block_Patron - ACS responds with 24 Patron Status Response</td>
</tr>
<tr>
<td>09-10</td>
<td>Checkin</td>
<td>Yes (with extensions)</td>
<td>09/10 Checkin</td>
</tr>
<tr>
<td>11-12</td>
<td>Checkout</td>
<td>Yes (no renewals)</td>
<td>11/12 Checkout</td>
</tr>
<tr>
<td>15-16</td>
<td>Hold</td>
<td>Partially supported</td>
<td>15/16 Hold</td>
</tr>
<tr>
<td>17-18</td>
<td>Item Information</td>
<td>Yes (no extensions)</td>
<td>17/18 Item Information</td>
</tr>
<tr>
<td>19-20</td>
<td>Item Status Update</td>
<td>No</td>
<td>19/20 Item Status Update - Returns Patron Enable response, but doesn’t make any changes in EG</td>
</tr>
<tr>
<td>23-24</td>
<td>Patron Status</td>
<td>Yes</td>
<td>23/24 Patron Status - 63/64 “Patron Information” preferred</td>
</tr>
<tr>
<td>25-26</td>
<td>Patron Enable</td>
<td>No</td>
<td>25/26 Patron Enable - Used during system testing and validation</td>
</tr>
<tr>
<td>-------</td>
<td>---------------</td>
<td>----</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>29-30</td>
<td>Renew</td>
<td>Yes</td>
<td>29/30 Renew</td>
</tr>
<tr>
<td>35-36</td>
<td>End Session</td>
<td>Yes</td>
<td>35/36 End Session</td>
</tr>
<tr>
<td>37-38</td>
<td>Fee Paid</td>
<td>Yes</td>
<td>37/38 Fee Paid</td>
</tr>
<tr>
<td>63-64</td>
<td>Patron Information</td>
<td>Yes (no extensions)</td>
<td>63/64 Patron Information</td>
</tr>
<tr>
<td>65-66</td>
<td>Renew All</td>
<td>Yes</td>
<td>65/66 Renew All</td>
</tr>
<tr>
<td>93-94</td>
<td>Login</td>
<td>Yes</td>
<td>93/94 Login - Must be first command to Evergreen ACS (via socket) or SIP will terminate</td>
</tr>
<tr>
<td>97-96</td>
<td>Resend last message</td>
<td>Yes</td>
<td>97/96 Resend</td>
</tr>
<tr>
<td>99-98</td>
<td>SC-ACS Status</td>
<td>Yes</td>
<td>99/98 SC and ACS Status</td>
</tr>
</tbody>
</table>

01 Block Patron

A selfcheck will issue a Block Patron command if a patron leaves their card in a selfcheck machine or if the selfcheck detects tampering (such as attempts to disable multiple items during a single item checkout, multiple failed pin entries, etc).

In Evergreen, this command does the following:

- User alert message: CARD BLOCKED BY SELF-CHECK MACHINE (this is independent of the AL Blocked Card Message field).

- Card is marked inactive.

The request looks like:

```
01<card retained><date>[fields AO, AL, AA, AC]
```

Card Retained: A single character field of Y or N - tells the ACS whether the SC has retained the card (ex: left in the machine) or not.

Date: An 18 character field for the date/time when the block occurred.

Format: YYYYMMDDZZZHHMMSS (ZZZZ being zone - 4 blanks when local time, “Z” (3 blanks and a Z) represents UTC(GMT/Zulu)

Fields: See Fields for more details.

The response is a 24 “Patron Status Response” with the following:

- Charge privileges denied
• Renewal privileges denied
• Recall privileges denied (hard-coded in every 24 or 64 response)
• hold privileges denied
• Screen Message 1 (AF): blocked
• Patron

09/10 Checkin

~The request looks like:

09<No block (Offline)><xact date><return date>[Fields AP,A0,AB,AC,CH,BI]

No Block (Offline): A single character field of Y or N - Offline transactions are not currently supported so send N.

xact date: an 18 character field for the date/time when the checkin occurred. Format: YYYYMMDDZZZZHHMMSS (ZZZZ being zone - 4 blanks when local time, “Z” (3 blanks and a Z) represents UTC(GMT/Zulu))

Fields: See Fields for more details.

The response is a 10 “Checkin Response” with the following:

10<resensitize><magnetic media><alert><xact date>[Fields AO,AB,AQ,AJ,CL,AA,CK,CH,CR,CS,CT,CV,CY,DA,AF,AG]

Example (with a remote hold):

09N20100507 16593720100507 165937APCheckin Bin 5|AOBR1|AB1565921879|ACsip_01|
101YNY20100623 165731AOBR1|AB1565921879|AQBR1|AJPerl 5 desktop reference|CK001|CSQA76.73.P33V76 1996 |CTBR3|CY373827|DANicholas Richard Woodard|CV02|

Here you can see a hold alert for patron CY 373827, named DA Nicholas Richard Woodard, to be picked up at CT “BR3”. Since the transaction is happening at AO “BR1”, the alert type CV is 02 for hold at remote library. The possible values for CV are:

• 00: unknown
• 01: local hold
• 02: remote hold
• 03: ILL transfer (not used by EG)
• 04: transfer
• 99: other

Chapter 45. SIP Server
Report errors in this documentation using Launchpad.
The logic for Evergreen to determine whether the content is magnetic_media comes from or search_config_circ_modifier. The default is non-magnetic. The same is true for media_type (default 001). Evergreen does not populate the collection_code because it does not really have any, but it will provide the call_number where available.

Unlike the item_id (barcode), the title_id is actually a title string, unless the configuration forces the return of the bib ID.

Don’t be confused by the different branches that can show up in the same response line.

- AO is where the transaction took place,
- AQ is the “permanent location”, and
- CT is the destination location (i.e., pickup lib for a hold or target lib for a transfer).

11/12 Checkout

15/16 Hold

Evergreen supports the Hold message for the purpose of canceling holds. It does not currently support creating hold requests via SIP2.

17/18 Item Information

The request looks like:

17<xact_date>[fields: AO,AB,AC]

The request is very terse. AC is optional.

The following response structure is for SIP2. (Version 1 of the protocol had only 6 total fields.)

18<circulation_status><security_marker><fee_type><xact_date>

Example:

1720060110 215612A0BR1|ABno_such_barcode|
1801010120100609 162510ABno_such_barcode|AJ|
1720060110 215612A0BR1|AB1565921879|
1810020120100623 171415AB1565921879|AJPerl 5 desktop reference|CK001|AQBR1|APBR1|BGBR1
The first case is with a bogus barcode. The latter shows an item with a circulation_status of 10 for in transit between libraries. The known values of circulation_status are enumerated in the spec.

EXTENSIONS: The CT field for destination location and CS call number are used by Automated Material Handling systems.

19/20 Item Status Update

23/24 Patron Status

Example:

```
2300120060101 084235AOUWOLS|AAbad_barcode|ACsip_01|ADbad_password|
24YYYY          00120100507 013934AE|AAbad_barcode|BLN|AOUWOLS|
2300120060101 084235AOCONS|AA999999|ACsip_01|ADbad_password|
24 Y           00120100507 022318AEDoug Fiander|AA999999|BLY|CQN|BHUSD|BV0.00|AFOK|AOCONS|
2300120060101 084235AOCONS|AA999999|ACsip_01|ADuserpassword|LY|CQN|BHUSD|BV0.00|AFOK|AOCONS|
24 Y           00120100507 022803AEDoug Fiander|AA999999|BLY|CQY|BHUSD|BV0.00|AFOK|AOCONS|
```

1. The BL field (SIP2, optional) is valid patron, so the N value means bad_barcode doesn't match a patron, the Y value means 999999 does.

2. The CQ field (SIP2, optional) is valid password, so the N value means bad_password doesn't match 999999's password, the Y means userpassword does.

So if you were building the most basic SIP2 authentication client, you would check for |CQY| in the response to know the user’s barcode and password are correct (|CQY| implies |BLY|, since you cannot check the password unless the barcode exists). However, in practice, depending on the application, there are other factors to consider in authentication, like whether the user is blocked from checkout, owes excessive fines, reported their card lost, etc. These limitations are reflected in the 14-character patron status string immediately following the 24 code. See the field definitions in your copy of the spec.

25/26 Patron Enable

Not yet supported.
29/30 Renew

Evergreen supports the Renew message. Evergreen checks whether a penalty is specifically configured to block renewals before blocking any SIP renewal.

35/36 End Session

3520100505  115901AOBR1|AA999999|
36Y20100507  161213ACCONS|AA999999|AFThank you!|

The Y/N code immediately after the 36 indicates success/failure. Failure is not particularly meaningful or important in this context, and for evergreen it is hardcoded Y.

37/38 Fee Paid

Evergreen supports the Fee Paid message.

63/64 Patron Information

Attempting to retrieve patron info with a bad barcode:

6300020060329  201700  A0BR1|AAbad_barcode|
64YYYY  00020100623  1413000000000000000000000000000000AE|AAbad_barcode|BLN|A0BR1|

Attempting to retrieve patron info with a good barcode (but bad patron password):

6300020060329  201700  A0BR1|AA999999|Abadpwd|
64 Y  00020100623  1411300000000000000000000000000000AA999999|AEDavid J. Fiander|BHUSD|BV0.00
|BD2 Meadowvale Dr. St Thomas, ON Canada
90210|BEdjfiander@somemail.com|BF(519) 555 1234|A0BR1|BLY|CQNPB19640925|PCPatrons
|PIUnfiltered|AF0K|A0BR1|

See 23/24 Patron Status for info on BL and CQ fields.

65/66 Renew All

Evergreen supports the Renew All message.

93/94 Login

Example:
9300CNsip_01|CObad_value|CPBR1|
[Connection closed by foreign host.]
...
9300CNsip_01|COsip_01|CPBR1|
941

941 means successful terminal login. 940 or getting dropped means failure.

When using a version of SIPServer that supports the feature, the Location (CP) field of the Login (93) message will be used as the workstation name if supplied. Blank or missing location fields will be ignored. This allows users or reports to determine which selfcheck performed a circulation.

97/96 Resend

99/98 SC and ACS Status

99<status code><max print width><protocol version>

All 3 fields are required:

• 0: SC is OK
• 1: SC is out of paper
• 2: SC shutting down
• status code - 1 character
• max print width - 3 characters - the integer number of characters the client can print
• protocol version - 4 characters - x.xx

98<on-line status><checkin ok><checkout ok><ACS renewal policy> <status update ok><offline ok><timeout period> <retries allowed><date/time sync><protocol version><institution id> <library name><supported messages><terminal> <location><screen message><print line>

Example:

9910302.00
98YYYYNN60000320100510 1717202.00AOCONS|BXYYYYYYYYYN3YNYNYN|

The Supported Messages field BX appears only in SIP2, and specifies whether 16 different SIP commands are supported by the ACS or not.
Fields

All fixed-length fields in a communication will appear before the first variable-length field. This allows for simple parsing. Variable-length fields are by definition delimited, though there will not necessarily be an initial delimiter between the last fixed-length field and the first variable-length one. It would be unnecessary, since you should know the exact position where that field begins already.

Patron privacy and the SIP protocol

SIP traffic includes a lot of patron information, and is not encrypted by default. It is strongly recommended that you encrypt any SIP traffic.

SIP server configuration

On the SIP server, use `iptables` or `etc/hosts` to allow SSH connections on port 22 from the SIP client machine. You will probably want to have very restrictive rules on which IP addresses can connect to this server.

SSH tunnels on SIP clients

SSH tunnels are a good fit for use cases like self-check machines, because it is relatively easy to automatically open the connection. Using a VPN is another option, but many VPN clients require manual steps to open the VPN connection.

1. If the SIP client will be on a Windows machine, install cygwin on the SIP client.
2. On the SIP client, use `ssh-keygen` to generate an SSH key.
3. Add the public key to `/home/my_sip_user/.ssh/authorized_keys` on your SIP server to enable logins without using the UNIX password.
4. Configure an SSH tunnel to open before every connection. You can do this in several ways:
   a. If the SIP client software allows you to run an arbitrary command before each SIP connection, use something like this:
      ```bash
      ssh -f -L 6001:localhost:6001 my_sip_user@my_sip_server.com sleep 10
      ```
   b. If you feel confident that the connection won’t get interrupted, you can have something like this run at startup:
      ```bash
      ssh -f -N -L 6001:localhost:6001 my_sip_user@my_sip_server.com
      ```
   c. If you want to constantly poll to make sure that the connection is still running, you can do something like this as a cron job or scheduled task on the SIP client machine:
      ```bash
      #!/bin/bash
      instances=`/bin/ps -ef | /bin/grep ssh | /bin/grep -v grep | /bin/wc -l`
      if [ $instances -eq 0 ]; then
        echo "Restarting ssh tunnel"
      fi
      ```
Chapter 46. Apache Rewrite Tricks

It is possible to use Apache’s Rewrite Module features to perform a number of useful tricks that can make people’s lives much easier.

Short URLs

Making short URLs for common destinations can simplify making printed media as well as shortening or simplifying what people need to type. These are also easy to add and require minimal maintenance, and generally can be implemented with a single line addition to your eg_vhost.conf file.

# My Account - http://host.ext/myaccount -> My Account Page
RewriteRule ^/myaccount https://%{HTTP_HOST}/eg/opac/myopac/main [R]

RewriteRule ^/search/isbn/(.*) /eg/opac/results?_special=1&qtype=identifier|isbn&query=$1 [R]

Domain Based Content with RewriteMaps

One creative use of Rewrite features is domain-based configuration in a single eg_vhost.conf file. Regardless of how many VirtualHost blocks use the configuration you don’t need to duplicate things for minor changes, and can in fact use wildcard VirtualHost blocks to serve multiple subdomains.

For the wildcard blocks you will want to use a ServerAlias directive, and for SSL VirtualHost blocks ensure you have a wildcard SSL certificate.

ServerAlias *.example.com

For actually changing things based on the domain, or subdomain, you can use RewriteMaps. Each RewriteMap is generally a lookup table of some kind. In the following examples we will generally use text files, though database lookups and external programs are also possible.

Note that in the examples below we generally store things in Environment Variables. From within Template Toolkit templates you can access environment variables with the ENV object.

Template Toolkit ENV example, link library name/url if set.

[% IF ENV.eglibname && ENV.egliburl %]<a href="[% ENV.egliburl %]">[% ENV.eglibname %]</a>[% END %]

The first lookup to do is a domain to identifier, allowing us to re-use identifiers for multiple domains. In addition we can also supply a default identifier, for when the domain isn't present in the lookup table.

Apache Config.

# This internal map allows us to lowercase our hostname, removing case issues in our lookup table
# If you prefer uppercase you can use "uppercase int:toupper" instead.
RewriteMap lowercase int:tolower
# This provides a hostname lookup
RewriteMap eglibid txt:/openils/conf/libid.txt
# This stores the identifier in a variable (eglibid) for later use
# In this case CONS is the default value for when the lookup table has no entry
RewriteRule . - [E=eglibid:${eglibid:${lowercase:%{HTTP_HOST}}}|CONS]]

Contents of libid.txt File.

# Comments can be included
# Multiple TLDs for Branch 1
branch1.example.com BRANCH1
branch1.example.net BRANCH1
# Branches 2 and 3 don't have alternate TLDs
branch2.example.com BRANCH2
branch3.example.com BRANCH3

Once we have identifiers we can look up other information, when appropriate. For example, say we want to look up library names and URLs:

Apache Config.

# Library Name Lookup - Note we provide no default in this case.
RewriteMap eglibname txt:/openils/conf/libname.txt
RewriteRule . - [E=eglibname:${eglibname:%{ENV:eglibid}}]

# Library URL Lookup - Also with no default.
RewriteMap egliburl txt:/openils/conf/liburl.txt
RewriteRule . - [E=egliburl:${egliburl:%{ENV:eglibid}}]

Contents of libname.txt File.

# Note that we cannot have spaces in the "value", so instead &amp;#32; is used. &nbsp; is also an option.
BRANCH1 Branch One
BRANCH2 Branch Two
BRANCH3 Branch Three
CONS Example Consortium Name

Contents of liburl.txt File.

BRANCH1 http://branch1.example.org
BRANCH2 http://branch2.example.org
BRANCH3 http://branch3.example.org
CONS http://example.org

Or, perhaps set the "physical location" variable for default search/display library:

Apache Config.

# Lookup "physical location" IDs
RewriteMap eglibphysloc txt:/openils/conf/libphysloc.txt
RewriteRule . - [E=physical_loc:${eglibphysloc:%{ENV:eglibid}}]

Contents of libphysloc.txt File.

BRANCH1 4
BRANCH2 5
BRANCH3 6
CONS 1

Going further, you could also replace files to be downloaded, such as images or stylesheets, on the fly:

Apache Config.

# Check if a file exists based on eglibid and the requested file name
# Say, BRANCH1/opac/images/main_logo.png
RewriteCond %{DOCUMENT_ROOT}/%{ENV:eglibid}%{REQUEST_URI} -f
# Serve up the eglibid version of the file instead
RewriteRule (.*) /%(ENG:eglibid)$1

Note that template files themselves cannot be replaced in that manner.
Chapter 47. Apache Access Handler Perl Module

The OpenILS::WWW::AccessHandler Perl module is intended for limiting patron access to configured locations in Apache. These locations could be folder trees, static files, non-Evergreen dynamic content, or other Apache features/modules. It is intended as a more patron-oriented and transparent version of the OpenILS::WWW::Proxy and OpenILS::WWW::Proxy::Authen modules.

Instead of using Basic Authentication the AccessHandler module instead redirects to the OPAC for login. Once logged in additional checks can be performed, based on configured variables:

- Permission Checks (at Home OU or specified location)
- Home OU Checks (Org Unit or Descendant)
- "Good standing" Checks (Not Inactive or Barred)

Use of the module is a simple addition to a Location block in Apache:

```apache
<Location /path/to/be/protected>
    PerlAccessHandler OpenILS::WWW::AccessHandler
    # For each option you wish to set:
    PerlSetVar OPTION "VALUE"
</Location>
```

The available options are:

- **OILSAccessHandlerLoginURL**  
  • Default: /eg/opac/login  
  • The page to redirect to when Login is needed

- **OILSAccessHandlerLoginURLRedirectVar**  
  • Default: redirect_to  
  • The variable the login page wants the "destination" URL stored in

- **OILSAccessHandlerFailURL**  
  • Default: <unset>  
  • URL to go to if Permission, Good Standing, or Home OU checks fail. If not set a 403 error is generated instead. To customize the 403 you could use an ErrorDocument statement.

- **OILSAccessHandlerCheckOU**  
  • Default: <User Home OU>  
  • Org Unit to check Permissions at and/or to load Referrer from. Can be a shortname or an ID.

- **OILSAccessHandlerPermission**  
  • Default: <unset>  
  • Permission, or comma- or space-delimited set of permissions, the user must have to access the protected area.

- **OILSAccessHandlerGoodStanding**  
  • Default: 0
• If set to a true value the user must be both Active and not Barred.

OILSAccessHandlerHomeOU • Default: <unset>

• An Org Unit, or comma- or space-delimited set of Org Units, that the user’s Home OU must be equal to or a descendant of to access this resource. Can be set to shortnames or IDs.

OILSAccessHandlerReferrerSetting • Default: <unset>

• Library Setting to pull a forced referrer string out of, if set.

As the AccessHandler module does not actually serve the content it is protecting, but instead merely hands control back to Apache when it is done authenticating, you can protect almost anything else you can serve with Apache.

Use Cases

The general use of this module is "protect access to something else" - what that something else is will vary. Some possibilities:

• Apache features
  • Automatic Directory Indexes
  • Proxies (see below)
    • Electronic Databases
    • Software on other servers/ports
• Non-Evergreen software
  • Timekeeping software for staff
  • Specialized patron request packages
• Static files and folders
  • Semi-public Patron resources
  • Staff-only downloads

Proxying Websites

One potentially interesting use of the AccessHandler module is to protect an Apache Proxy configuration. For example, after installing and enabling mod_proxy, mod_proxy_http, and mod_proxy_html you could proxy websites like so:

```xml
<Location /proxy/>
  # Base "Rewrite URLs" configuration
</Location>
```
As mentioned above, this can be used for multiple reasons. In addition to websites such as online databases for patron use you may wish to proxy software for staff or patron use to make it appear on your catalog domain, or perhaps to keep from needing to open extra ports in a firewall.
Chapter 48. ebook_api service

The `open-ils.ebook_api` service looks up title and patron information from specified ebook vendor APIs.

The Evergreen catalog accesses data from this service through OpenSRF JS bindings.

The `OpenILS::Utils::HTTPClient` module is required for this service.
Chapter 49. hold-targeter service

The **open-ils.hold-targeter** service is used to target holds.
Chapter 50. Backing up your Evergreen System

Database backups

Although it might seem pessimistic, spending some of your limited time preparing for disaster is one of the best investments you can make for the long-term health of your Evergreen system. If one of your servers crashes and burns, you want to be confident that you can get a working system back in place — whether it is your database server that suffers, or an Evergreen application server.

At a minimum, you need to be able to recover your system’s data from your PostgreSQL database server: patron information, circulation transactions, bibliographic records, and the like. If all else fails, you can at least restore that data to a stock Evergreen system to enable your staff and patrons to find and circulate materials while you work on restoring your local customizations such as branding, colors, or additional functionality. This section describes how to back up your data so that you or a colleague can help you recover from various disaster scenarios.

Creating logical database backups

The simplest method to back up your PostgreSQL data is to use the `pg_dump` utility to create a logical backup of your database. Logical backups have the advantage of taking up minimal space, as the indexes derived from the data are not part of the backup. For example, an Evergreen database with 2.25 million records and 3 years of transactions that takes over 120 GB on disk creates just a 7.0 GB compressed backup file. The drawback to this method is that you can only recover the data at the exact point in time at which the backup began; any updates, additions, or deletions of your data since the backup began will not be captured. In addition, when you restore a logical backup, the database server has to recreate all of the indexes—so it can take several hours to restore a logical backup of that 2.25 million record Evergreen database.

As the effort and server space required for logical database backups are minimal, your first step towards preparing for disaster should be to automate regular logical database backups. You should also ensure that the backups are stored in a different physical location, so that if a flood or other disaster strikes your primary server room, you will not lose your logical backup at the same time.

To create a logical dump of your PostgreSQL database:

1. Issue the command to back up your database: `pg_dump -Fc <database-name> > <backup-filename>`. If you are not running the command as the postgres user on the database server itself, you may need to include options such as `-U <user-name>` and `-h <hostname>` to connect to the database server. You can use a newer version of the PostgreSQL to run `pg_dump` against an older version of PostgreSQL if your client and server operating systems differ. The `-Fc` option specifies the "custom" format: a compressed format that gives you a great deal of flexibility at restore time (for example, restoring only one table from the database instead of the entire schema).

2. If you created the logical backup on the database server itself, copy it to a server located in a different physical location.
You should establish a routine of nightly logical backups of your database, with older logical backups being automatically deleted after a given interval.

**Restoring from logical database backups**

To increase your confidence in the safety of your data, you should regularly test your ability to restore from a logical backup. Restoring a logical backup that you created using the custom format requires the use of the `pg_restore` tool as follows:

1. On the server on which you plan to restore the logical backup, ensure that you have installed PostgreSQL and the corresponding server package prerequisites. The `Makefile.install` prerequisite installer than came with your version of Evergreen contains an installation target that should satisfy these requirements. Refer to the installation documentation for more details.

2. As the `postgres` user, create a new database using the `createdb` command into which you will restore the data. Base the new database on the template0 template database to enable the combination of UTF8 encoding and C locale options, and specify the character type and collation type as "C" using the `--lc-ctype` and `--lc-collate` parameters. For example, to create a new database called "testrestore":

   ```
   createdb --template=template0 --lc-ctype=C --lc-collate=C testrestore
   ```

3. As the `postgres` user, restore the logical backup into your newly created database using the `pg_restore` command. You can use the `-j` parameter to use more CPU cores at a time to make your recovery operation faster. If your target database is hosted on a different server, you can use the `-U <user-name>` and `-h <hostname>` options to connect to that server. For example, to restore the logical backup from a file named `evergreen_20121212.dump` into the "testrestore" database on a system with 2 CPU cores:

   ```
   pg_restore -j 2 -d testrestore evergreen_20171212.dump
   ```

**Creating physical database backups with support for point-in-time recovery**

While logical database backups require very little space, they also have the disadvantage of taking a great deal of time to restore for anything other than the smallest of Evergreen systems. Physical database backups are little more than a copy of the database file system, meaning that the space required for each physical backup will match the space used by your production database. However, physical backups offer the great advantage of almost instantaneous recovery, because the indexes already exist and simply need to be validated when you begin database recovery. Your backup server should match the configuration of your master server as closely as possible including the version of the operating system and PostgreSQL.

Like logical backups, physical backups also represent a snapshot of the data at the point in time at which you began the backup. However, if you combine physical backups with write-ahead-log (WAL) segment archiving, you can restore a version of your database that represents any point in time between the time the backup began and the time at which the last WAL segment was archived, a feature referred to as point-in-time recovery (PITR). PITR enables you to undo the damage that an accidentally or deliberately harmful UPDATE or DELETE statement could inflict on your production data, so while the recovery process can be complex, it provides fine-grained insurance for the
integrity of your data when you run upgrade scripts against your database, deploy new custom functionality, or make global changes to your data.

To set up WAL archiving for your production Evergreen database, you need to modify your PostgreSQL configuration (typically located on Debian and Ubuntu servers in `/etc/postgresql/<version>/postgresql.conf`):

1. Change the value of `archive_mode` to on

2. Set the value of `archive_command` to a command that accepts the parameters `%f` (representing the file name of the WAL segment) and `%p` (representing the complete path name for the WAL segment, including the file name). You should copy the WAL segments to a remote file system that can be read by the same server on which you plan to create your physical backups. For example, if `/data/wal` represents a remote file system to which your database server can write, a possible value of `archive_command` could be: `test ! -f /data/wal/%f && cp %p /data/wal/%f`, which effectively tests to see if the destination file already exists, and if it does not, copies the WAL segment to that location. This command can be and often is much more complex (for example, using `scp` or `rsync` to transfer the file to the remote destination rather than relying on a network share), but you can start with something simple.

Once you have modified your PostgreSQL configuration, you need to restart the PostgreSQL server before the configuration changes will take hold: . Stop your OpenSRF services. . Restart your PostgreSQL server. . Start your OpenSRF services and restart your Apache HTTPD server.

To create a physical backup of your production Evergreen database:

1. From your backup server, issue the `pg_basebackup -x -D <data-destination-directory> -U <user-name> -h <hostname> <database-name>` command to create a physical backup of database `<database-name>` on your backup server.

You should establish a process for creating regular physical backups at periodic intervals, bearing in mind that the longer the interval between physical backups, the more WAL segments the backup database will have to replay at recovery time to get back to the most recent changes to the database. For example, to be able to relatively quickly restore the state of your database to any point in time over the past four weeks, you might take physical backups at weekly intervals, keeping the last four physical backups and all of the corresponding WAL segments.

Creating a replicated database

If you have a separate server that you can use to run a replica of your database, consider replicating your database to that server. In the event that your primary database server suffers a hardware failure, having a database replica gives you the ability to fail over to your database replica with very little downtime and little or no data loss. You can also improve the performance of your overall system by directing some read-only operations, such as reporting, to the database replica. In this section, we describe how to replicate your database using PostgreSQL’s streaming replication support.

You need to prepare your master PostgreSQL database server to support streaming replicas with several configuration changes. The PostgreSQL configuration file is typically located on Debian and Ubuntu servers at `/etc/postgresql/<version>/postgresql.conf`. The PostgreSQL host-based authentication (`pg_hba.conf`) configuration file is typically located on Debian and Ubuntu servers at
/etc/postgresql/<version>/pg_hba.conf. Perform the following steps on your master database server:

1. Turn on streaming replication support. In postgresql.conf on your master database server, change `max_wal_senders` from the default value of 0 to the number of streaming replicas that you need to support. Note that these connections count as physical connections for the sake of the `max_connections` parameter, so you might need to increase that value at the same time.

2. Enable your streaming replica to endure brief network outages without having to rely on the archived WAL segments to catch up to the master. In `postgresql.conf` on your production database server, change `wal_keep_segments` to a value such as 32 or 64.

3. Increase the maximum number of log file segments between automatic WAL checkpoints. In `postgresql.conf` on your production database server, change `checkpoint_segments` from its default of 3 to a value such as 16 or 32. This improves the performance of your database at the cost of additional disk space.

4. Create a database user for the specific purpose of replication. As the postgres user on the production database server, issue the following commands, where replicant represents the name of the new user:

   ```
   createuser replicant
   psql -d <database> ALTER ROLE replicant WITH REPLICATION;
   ```

5. Enable your replica database to connect to your master database server as a streaming replica. In `pg_hba.conf` on your master database server, add a line to enable the database user replicant to connect to the master database server from IP address 192.168.0.164:

   ```
   host    replication   replicant       192.168.0.164/32          md5
   ```

6. To enable the changes to take effect, restart your PostgreSQL database server.

To avoid downtime, you can prepare your master database server for streaming replication at any maintenance interval; then weeks or months later, when your replica server environment is available, you can begin streaming replication. Once you are ready to set up the streaming replica, perform the following steps on your replica server:

1. Ensure that the version of PostgreSQL on your replica server matches the version running on your production server. A difference in the minor version (for example, 9.1.3 versus 9.1.5) will not prevent streaming replication from working, but an exact match is recommended.

2. Create a physical backup of the master database server.

3. Add a `recovery.conf` file to your replica database configuration directory. This file contains the information required to begin recovery once you start the replica database:

   ```
   # turn on standby mode, disabling writes to the database
   standby_mode = 'on'
   # assumes WAL segments are available at network share /data/wal
   restore_command = 'cp /data/wal/%f %p'
   # connect to the master database to being streaming replication
   primary_conninfo = 'host=kochab.cs.uoguelph.ca user=replicant password=<password>
   ```

4. Start the PostgreSQL database server on your replica server. It should connect to the master. If the physical backup did not take too long and you had a high enough value for
**wal_keep_segments** set on your master server, the replica should begin streaming replication. Otherwise, it will replay WAL segments until it catches up enough to begin streaming replication.

5. Ensure that the streaming replication is working. Check the PostgreSQL logs on your replica server and master server for any errors. Connect to the replica database as a regular database user and check for recent changes that have been made to your master server.

Congratulations, you now have a streaming replica database that reflects the latest changes to your Evergreen data! Combined with a routine of regular logical and physical database backups and WAL segment archiving stored on a remote server, you have a significant insurance policy for your system’s data in the event that disaster does strike.
Part V. Using the Browser Staff Client
## Table of Contents

51. Introduction .................................................................................................................. 212
52. Logging into Evergreen .................................................................................................. 213
   Registering a Workstation .............................................................................................. 213
   Basic Login .................................................................................................................. 213
   Logging Out .................................................................................................................. 213
53. Best Practices for Using the Browser ............................................................................. 215
   Pop-up Blockers ............................................................................................................. 215
   Setting Browser Defaults for Web Client ....................................................................... 215
      Setting the Web Client as the Home Page in Chrome ................................................. 215
      Setting the Web Client as the Home Page in Firefox ............................................... 215
      Turning off print headers and footers in Firefox ....................................................... 215
      Turning off print headers and footers in Chrome ...................................................... 216
   Tab Buttons and Keyboard Shortcuts ............................................................................. 216
      Setting New Tab Behavior .......................................................................................... 217
54. Column Picker ............................................................................................................... 218
55. Recent Staff Searches .................................................................................................... 220
   Administrative Settings ............................................................................................... 220
   Recent Staff Searches ................................................................................................. 221
56. Workstation Administration .......................................................................................... 222
   Copy Editor: Copy Location Name First ....................................................................... 222
   Font and Sound Settings .............................................................................................. 222
      In the Staff Client ....................................................................................................... 222
      In the OPAC ............................................................................................................... 223
   Select Hotkeys ............................................................................................................. 223
   Configure Printers ........................................................................................................ 224
      Advanced Settings ..................................................................................................... 226
   Print (Receipt) Templates .............................................................................................. 226
      Receipt Templates ....................................................................................................... 227
      Editing Receipts .......................................................................................................... 227
      Exporting and importing Customized Receipts ......................................................... 231
Chapter 51. Introduction

This part of the documentation deals with general Browser Client usage including logging in, navigation and shortcuts.

For information about the XUL client, consult the Evergreen 2.11 documentation.
Chapter 52. Logging into Evergreen

Registering a Workstation

Before logging into Evergreen, you must first register a workstation from your browser.

You will need the permissions to add workstations to your network. If you do not have these permissions, ask your system administrator for assistance.

1. When you login for the first time, you will arrive at a screen asking that you register your workstation

2. Create a unique workstation name.

3. Click Register

4. After confirming the new workstation is listed in the Workstations Registered With This Browser menu, click Use Now to return to the login page. Your newly-registered workstation should be selected by default on the login page.

Basic Login,

1. The default URL to log into the client is https://localhost/eg/staff/login

2. Enter your Username and Password.

3. Verify that the correct workstation is selected and click Sign In.

Logging Out
To log out of the client:

1. Click the menu button to the right of your user name in the top-right corner of the window.
2. Select Log Out

Exiting all browser windows will automatically log you out of the web client. If you only close the tab where the web client is loaded, you will remain logged in.
Chapter 53. Best Practices for Using the Browser

Pop-up Blockers

Before using the web client, be sure to disable pop-up blockers for your Evergreen system’s domain.

- In Chrome, select Settings from the Chrome menu and click on Content settings in the advanced section. Select Popups and then add your domain to the Allowed list.

- In Firefox, select Preferences from the Firefox menu and then select the Content panel. Click the Exceptions button and add your domain to the Allowed Sites list.

Setting Browser Defaults for Web Client

To ensure that staff can easily get to the web client portal page on login without additional steps, you can set the browser’s home page to default to the web client.

Setting the Web Client as the Home Page in Chrome

1. In the top-right corner of your browser, click the Chrome menu.
2. Select Settings.
3. In the On startup section, select Open a specific page or set of pages.
4. Click the Set Pages link.
5. Add https://localhost/eg/staff/ to the Enter URL box and click OK.

Setting the Web Client as the Home Page in Firefox

1. In the top-right corner of your browser, click the menu button.
2. Click Options.
3. In the When Firefox starts: dropdown menu, select Show my home page.
4. In the Home Page box, add https://localhost/eg/staff/ and click OK.

Turning off print headers and footers in Firefox

If you are not using Hatch for printing, you will probably want to configure your browser so that Firefox does not add headers and footers to items printed on certain printers. For example, if you
are printing spine labels, you likely will not want Firefox to add a date or URL to the margins of your label.

You can turn off these headers and footers using the following steps:

1. In the Firefox menu, click Print... to open the print preview screen.
2. Click the Page Setup... button.
3. Go to the Margins & Header/Footer tab.
4. Make sure that all dropdown menus are set to --blank--.

If you only want to turn off those headers and footers for a specific printer, use these steps:

1. In the Firefox address bar, type about:config.
2. If a warning appears, click I accept the risk.
3. Type print_header into this screen’s search box.
4. Double-click on the relevant print_headerleft, print_headerright, and print_headercenter entries in the grid.
5. Delete any existing data for that setting and click OK.
6. Type print_footer into the screen’s search box and repeat these steps for the footer settings.

**Turning off print headers and footers in Chrome**

If you are not using Hatch for printing, you will probably want to configure your browser so that Chrome does not add headers and footers to items printed on certain printers. For example, if you are printing spine labels, you likely will not want Chrome to add a date or URL to the margins of your label.

You can turn off these headers and footers using the following steps:

1. In the Chrome menu, click Print... to open the print preview screen.
2. Click More Settings.

**Tab Buttons and Keyboard Shortcuts**

Now that the client will be loaded in a web browser, users can use browser-based tab controls and keyboard shortcuts to help with navigation. Below are some tips for browser navigation that can be used in Chrome and Firefox on Windows PCs.

- Use CTRL-T or click the browser’s new tab button to open a new tab.
• Use CTRL-W or click the x in the tab to close the tab.

• Undo closing a tab by hitting CTRL-Shift-T.

• To open a link from the web client in a new tab, CTRL-click the link or right-click the link and select Open Link in New Tab. Using this method, you can also open options from the web client’s dropdown menus in a new tab.

• Navigate to the next tab using CTRL-Tab. Go to the previous tab with CTRL-Shift-Tab.

### Setting New Tab Behavior

Some users may want to automatically open the web client’s portal page in a new tab. Neither Chrome nor Firefox will open your home page by default when you open a new tab. However, both browsers have optional add-ons that will allow you to set the browsers to automatically open the home page whenever open opening a new tab. These add-ons may be useful for those libraries that want the new tab to open to the web client portal page.
Chapter 54. Column Picker

From many screens and lists, you can click on the column picker drop-down menu to change which columns are displayed.

To show or hide a column, simply click the column name in the menu. For more advanced control of column visibility and their position in the grid, choose Manage Columns from the menu. The popup saves changes as they are made.

Columns at the top of the list will appear at the left end of the grid.
To adjust the width of columns, choose Manage Column Widths from the menu, then click the "Expand" or "Shrink" icons in each column. These can be clicked multiple times to reach the desired width.

After customizing the display you may save your changes by choosing Save Columns from the drop-down menu. These settings are stored in the browser and are not connected with a specific login or registered workstation. Each computer will need to be configured separately.

Some lists have a different design, and some of them can also be customized. Simply right-click the header row of any of the columns, and the column picker will appear. When you are finished customizing the display, scroll to the bottom of the Column Picker window and click Save.
Chapter 55. Recent Staff Searches

This feature enables you to view your recent searches as you perform them in the staff client. The number of searches that you can view is configurable. This feature is only available through the staff client; it is not available to patrons in the OPAC.

Administrative Settings

By default, ten searches will be saved as you search the staff client. If you want to change the number of saved searches, then you can configure the number of searches that you wish to save through the Library Settings Editor in the Admin module.

To configure the number of recent staff searches:

1. Click Administration → Local Administration → Library Settings Editor.
2. Scroll to OPAC: Number of staff client saved searches to display on left side of results and record details pages
3. Click Edit.
4. Select a Context from the drop down menu.
5. Enter the number of searches that you wish to save in the Value field.
6. Click Update Setting

To retain this setting, the system administrator must restart the web server.

If you do not want to save any searches, then you can turn off this feature.

To deactivate this feature:

1. Follow steps 1-4 (one through four) as listed in the previous section.
2. In the value field, enter 0 (zero).

3. Click Update Setting. This will prevent you from viewing any saved searches.

Recent Staff Searches

Evergreen will save staff searches that are entered through either the basic or advanced search fields. To view recent staff searches:

1. Enter a search term in either the basic or advanced search fields.

2. Your search results for the current search will appear in the middle of the screen. The most recent searches will appear on the left side of the screen.
Chapter 56. Workstation Administration

Copy Editor: Copy Location Name First

By default, when editing item records, library code is displayed in front of shelving location in Shelving Location field. You may reverse the order by going to Administration → Workstation Administration → Copy Editor: Copy Location Name First. Simply click it to make copy location name displayed first. The setting is saved on the workstation.

Font and Sound Settings

In the Staff Client

You may change the size of displayed text or turn staff client sounds on and off. These settings are specific to each workstation and stored on local hard disk. They do not affect OPAC font sizes.

1. Select Administration → Workstation Administration → Global Font and Sound Settings.

2. To turn off the system sounds, like the noise that happens when a patron with a block is retrieved, check the disable sound box and click Save to Disk.

3. To change the size of the font, pick the desired option and click Save to Disk.
In the OPAC

It is also possible to zoom in and zoom out when viewing the OPAC in the staff client, making the font appear larger or smaller. (This will not affect other screens.) Use CTRL + + (plus sign, to zoom in), CTRL + - (minus sign, to zoom out), and CTRL + 0 (to restore default). The workstation will remember the setting.

Select Hotkeys

All or partial hotkeys can be turned on or off. It can be done for a particular workstation:

1. Navigate to Administration → Workstation Administration → Hotkeys → Current.
2. Select Default, Minimal, and None.
• Default: including all hotkeys
• Minimal: including those hotkeys using CTRL key
• None: excluding all hotkeys

3. Go back to the above menu.

4. Click Set Workstation Default to Current.

To clear the existing default click Clear Workstation Default.

You can use the Toggle Hotkeys button, included in some toolbars, on top right corner, to switch your selected Hotkeys on or off for the current login session. It has the same effect as when you click Disable Hotkeys on the Hotkeys menu.

Configure Printers

Use the Printer Settings Editor to configure printer output for each workstation. If left unconfigured Evergreen will use the default printer set in the workstation’s operating system (Windows, OSX, Ubuntu, etc).

Evergreen printing works best if you are using recent, hardware-specific printer drivers.

1. Select Administration → Workstation Administration → Printer Settings Editor.

2. Select the Printer Context. At a minimum set the Default context on each Evergreen workstation. Repeat the procedure for other contexts if they differ from the default (e.g. if spine labels should output to a different printer.)
- Default: Default settings for staff client print functions (set for each workstation).
- Receipt: Settings for printing receipts.
- Label: Printer settings for spine and pocket labels.
- Mail: Settings for printing mailed notices (not yet active).
- Offline: Applies to all printing from the Offline Interface.

3. After choosing Printer Context click Set Default Printer and Print Test Page and follow the prompts. If successful, test output will print to your chosen printer.

4. (optional) To further format or customize printed output click Page Settings and adjust settings. When finished click OK and print another test page to view changes.
Advanced Settings

If you followed the steps above and still cannot print there are two alternate print strategies:

- DOS LPT1 Print (sends unformatted text directly to the parallel port)
- Custom/External Print (configuration required)

---

Evergreen cannot print using the Windows Generic/Text Only driver. If this driver is the only one available try one of the alternate print strategies instead.

---

Print (Receipt) Templates

The print templates follow W3C HTML standards (see http://w3schools.com/html/default.asp) and can make use of CSS and Angular JS to a certain extent.

The Receipt Template Editor can be found at: Administration → Workstation → Print Templates

The Editor can also be found on the default home page of the staff client.
Receipts come in various types: Bills, checkout, items, holds, transits and Payments.

**Receipt Templates**

This is a complete list of the receipts currently in use in Evergreen.

**Table 56.1. List of Receipts**

<table>
<thead>
<tr>
<th>Receipt Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bills, Current</td>
<td>Listing of current bills on an account.</td>
</tr>
<tr>
<td>Bills, Historic</td>
<td>Listing of bills that have had payments made on them. This used on the Bill History Transaction screen.</td>
</tr>
<tr>
<td>Bills, Payment</td>
<td>Patron payment receipt</td>
</tr>
<tr>
<td>Checkin</td>
<td>List of items that have been entered in to the check-in screen.</td>
</tr>
<tr>
<td>Checkout</td>
<td>List of items currently checked out by a patron during the transaction.</td>
</tr>
<tr>
<td>Hold</td>
<td>Transit This is printed when a hold goes in-transit to another library.</td>
</tr>
<tr>
<td>Hold Slip</td>
<td>This prints when a hold is fulfilled.</td>
</tr>
<tr>
<td>Hold Shelf</td>
<td>This prints when a hold is fulfilled.</td>
</tr>
<tr>
<td>Holds for Bib Record</td>
<td>Prints a list of holds on a Title record.</td>
</tr>
<tr>
<td>Holds for Patron</td>
<td>Prints a list of holds on a patron record.</td>
</tr>
<tr>
<td>Hold Pull List</td>
<td>Prints the Holds Pull List.</td>
</tr>
<tr>
<td>Hold Shelf List</td>
<td>Prints a list of hold that are waiting to be picked up.</td>
</tr>
<tr>
<td>In-House Use List</td>
<td>Prints a list of items imputed into In-house use.</td>
</tr>
<tr>
<td>Item Status</td>
<td>Prints a list of items imputed into Item Status.</td>
</tr>
<tr>
<td>Items Out</td>
<td>Prints the list of items a patron has checked out.</td>
</tr>
<tr>
<td>Patron Address</td>
<td>Prints the current patrons address.</td>
</tr>
<tr>
<td>Patron Note</td>
<td>Prints a note on a patron’s record.</td>
</tr>
<tr>
<td>Renew</td>
<td>List of items that have been renewed using the Renew Item Screen.</td>
</tr>
<tr>
<td>Transit List</td>
<td>Prints the list of items in-transit from the Transit List.</td>
</tr>
<tr>
<td>Transit Slip</td>
<td>This is printed when an items goes in-transit to another location.</td>
</tr>
</tbody>
</table>

**Editing Receipts**

To edit a Receipt:

1. Select Administration → Workstation → Print Templates.
2. Choose the Receipt in the drop down list.
3. If you are using Hatch, you can choose different printers for different types of receipts with the Force Content field. If not, leave that field blank. Printer Settings can be set at Administration → Workstation → Printer Settings.

4. Make edits to the Receipt on the right hand side.

5. Click out of the section you are editing to see what your changes will look right on the Left hand side.

6. Click Save Locally in the Upper right hand corner.

**Formatting Receipts**

Print templates use variables for various pieces of information coming from the Evergreen database. These variables deal with everything from the library name to the due date of an item. Information from the database is entered in the templates with curly brackets `{{term}}`.

**Example:** `{{checkout.title}}`

Some print templates have sections that are repeated for each item in a list. For example, the portion of the Checkout print template below repeats every item that is checked out in HTML list format by means of the ng-repeat in the li tag.

```html
<ol>
<li ng-repeat="checkout in circulations">
</li>
</ol>
```
Text Formatting

General text formatting

<table>
<thead>
<tr>
<th>Goal</th>
<th>Original</th>
<th>Code</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold (HTML)</td>
<td>hello</td>
<td><code>&lt;b&gt;</code>hello<code>&lt;b&gt;</code></td>
<td>hello</td>
</tr>
<tr>
<td>Bold (CSS)</td>
<td>hello</td>
<td><code>&lt;span style=&quot;font-weight:bold;&quot;&gt;hello&lt;/span&gt;</code></td>
<td>hello</td>
</tr>
<tr>
<td>Capitalize</td>
<td>circulation</td>
<td><code>&lt;span style=&quot;text-transform:capitalize;&quot;&gt;circulation&lt;/span&gt;</code></td>
<td>circulation</td>
</tr>
<tr>
<td>Currency</td>
<td>1</td>
<td>`{1</td>
<td>currency}`</td>
</tr>
</tbody>
</table>

Date Formatting

If you do not format dates, they will appear in a system format which isn’t easily readable.

<table>
<thead>
<tr>
<th>Code</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{today</td>
<td>date:'short'}`</td>
</tr>
<tr>
<td>`{today</td>
<td>date:'M/d/yyyy'}`</td>
</tr>
</tbody>
</table>

Currency Formatting

Add " | currency" after any dollar amount that you wish to display as currency.

Example: `{xact.summary.balance_owed | currency}` prints as $2.50

Conditional Formatting

You can use Angular JS to only print a line if the data matches. For example:

```
<div ng-if="hold.email_notify == 't'">Notify by email: {{patron.email}}</div>
```

This will only print the "Notify by email:" line if email notification is enabled for that hold.

Example for checkout print template that will only print the amount a patron owes if there is a balance:

```
<span ng-if="patron_money.balance_owed">You owe the library ${{patron_money.balance_owed}}</span>
```

See also: [https://docs.angularjs.org/api/ng/directive/ngIf](https://docs.angularjs.org/api/ng/directive/ngIf)
Substrings

To print just a sub-string of a variable, you can use a limitTo function. `{{variable | limitTo:limit:begin}}` where limit is the number of characters you are wanting, and begin (optional) is where you want to start printing those characters. To limit the variable to the first four characters, you can use `{{variable | limitTo:4}}` to get "vari". To limit to the last five characters you can use `{{variable | limitTo:-5}}` to get "iable". And `{{variable | limitTo:3:3}}` will produce "ria".

<table>
<thead>
<tr>
<th>Original</th>
<th>Code</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Sisterhood of the Traveling Pants</td>
<td>{{checkout.title</td>
<td>limitTo:10}}</td>
</tr>
<tr>
<td>123456789</td>
<td>{{patron.card.barcode</td>
<td>limitTo:-5}}</td>
</tr>
<tr>
<td>Roberts</td>
<td>{{patron.family_name</td>
<td>limitTo:3:3}}</td>
</tr>
</tbody>
</table>

Images

You can use HTML and CSS to add an image to your print template if you have the image uploaded onto a publicly available web server. (It will currently only work with images on a secure (https) site.) For example:

```html
```

Sort Order

You can sort the items in an ng-repeat block using orderBy. For example, the following will sort a list of holds by the shelving location first, then by the call number:

```html
<tr ng-repeat="hold_data in holds | orderBy : ['copy.location.name','volume.label']">
```

Subtotals

You can use Angular JS to add information from each iteration of a loop together to create a subtotal. This involves setting an initial variable before the ng-repeat loop begins, adding an amount to that variable from within each loop, and then displaying the final amount at the end.

```html
<div>You checked out the following items:</div>
<br/>
<ol ng-init="transactions.subtotal=0"> <!-- 1 -->
<li ng-repeat="checkout in circulations">
    {{checkout.title}}<br/>
    Barcode: {{checkout.copy.barcode}}<br/>
    Due: {{checkout.circ.due_date | date:"M/d/yyyy"}}
</li>
</ol>
```
Exporting and importing Customized Receipts

Once you have your receipts set up on one machine you can export your receipts, and then load them on to another machine. Just remember to Save Locally once you import the receipts on the new machine.

Exporting templates

As you can only save a template on to the computer you are working on you will need to export the template if you have more than one computer that prints out receipts (i.e., more than one computer on the circulation desk, or another computer in the workroom that you use to checkin items or capture holds with)

1. Export.
2. Select the location to save the template to, name the template, and click Save.
3. Click OK.

Importing Templates

1. Click Import.
2. Navigate to and select the template that you want to import. Click Open.
3. Click OK.
4. Click Save Locally.
5. Click OK.

Clearing your browser’s cache/temporary files will clear any print template customizations that you make unless you are using Hatch to store your customizations. Be sure to export a copy of your customizations as a backup so that you can import it as needed.

If you are modifying your templates and you do not see the updates appear on your printed receipt, you may need to go into Administration → Workstation → Stored Preferences and
delete the stored preferences related to the print template that you modified (for example, eg.print.template_context.bills_current).
Part VI. System Administration
From the Staff Client
# Table of Contents

58. Acquisitions Administration ........................................................................................................ 238

   - Acquisitions Settings .................................................................................................................. 238
   - Cancel/Delay reasons .................................................................................................................. 238
     - Create a cancel/delay reason ................................................................................................. 239
     - Delete a custom cancel/delay reason ..................................................................................... 239
   - Claiming ...................................................................................................................................... 239
     - Create a claim policy .............................................................................................................. 240
     - Create a claim type ................................................................................................................ 240
     - Create a claim event type ..................................................................................................... 240
     - Create a claim policy action ................................................................................................. 241
   - Currency Types ....................................................................................................................... 241
     - Create a currency type .......................................................................................................... 242
     - Edit a currency type ............................................................................................................. 242
   - Distribution Formulas ............................................................................................................. 242
     - Create a distribution formula ............................................................................................... 242
     - Edit a distribution formula .................................................................................................. 243
   - Electronic Data Interchange ....................................................................................................... 243
     - Entering SANs (Standard Address Numbers) ...................................................................... 244
     - Create an EDI Account ......................................................................................................... 245
     - EDI Messages ....................................................................................................................... 248
   - Exchange Rates .......................................................................................................................... 248
     - Create an exchange rate ....................................................................................................... 248
     - Edit an exchange rate .......................................................................................................... 249
   - MARC Federated Search ............................................................................................................ 249
   - Fund Tags ..................................................................................................................................... 250
   - Funding Sources ....................................................................................................................... 251
     - Create a funding source ....................................................................................................... 251
     - Allocate credits to funding sources ...................................................................................... 251
     - Allocate credits to funds ....................................................................................................... 252
     - Track debits and credits ........................................................................................................ 252
   - Funds .......................................................................................................................................... 252
     - Create a fund .......................................................................................................................... 252
     - Allocate credits from funding sources to funds .................................................................. 253
     - Transfer credits between funds ............................................................................................ 254
     - Track balances and expenditures ......................................................................................... 254
     - Fund reporting .......................................................................................................................... 254
     - Edit a fund .............................................................................................................................. 255
     - Perform fiscal year close-out operation ................................................................................. 255
   - Invoice menus ............................................................................................................................ 256
     - Invoice item type ................................................................................................................... 256
     - Invoice payment method ..................................................................................................... 257
   - Line Item Features ..................................................................................................................... 257
     - Create a line item alert ......................................................................................................... 258
     - Line item MARC attribute definitions .................................................................................. 258
   - Providers ...................................................................................................................................... 258
     - Create a provider .................................................................................................................. 258
     - Add contact and holdings information to providers ............................................................. 259
     - Edit a provider ....................................................................................................................... 260
   - Active date display in OPAC ...................................................................................................... 261
Chapter 57. Introduction

This part deals with the options in the Server Administration menu found in the staff client.
Chapter 58. Acquisitions Administration

Acquisitions Settings

Several setting in the Library Settings area of the Administration module pertain to functions in the Acquisitions module. You can access these settings by clicking Administration → Local Administration → Library Settings Editor.

• CAT: Delete bib if all copies are deleted via Acquisitions lineitem cancellation - If you cancel a line item, then all of the on order copies in the catalog are deleted. If, when you cancel a line item, you also want to delete the bib record, then set this setting to TRUE.

• Allow funds to be rolled over without bringing the money along - enables you to move a fund’s encumbrances from one year to the next without moving unspent money. Unused money is not added to the next year’s fund and is not available for use.

• Allows patrons to create automatic holds from purchase requests.

• Default circulation modifier - This modifier would be applied to items that are created in the acquisitions module

• Default copy location - This copy location would be applied to items that are created in the acquisitions module

• Fund Spending Limit for Block - When the amount remaining in the fund, including spent money and encumbrances, goes below this percentage, attempts to spend from the fund will be blocked.

• Fund Spending Limit for Warning - When the amount remaining in the fund, including spent money and encumbrances, goes below this percentage, attempts to spend from the fund will result in a warning to the staff.

• Rollover Distribution Formulae Funds - When set to true, during fiscal rollover, all distribution formulae will update to use new funds.

• Set copy creator as receiver - When receiving a copy in acquisitions, set the copy "creator" to be the staff that received the copy

• Temporary barcode prefix - Temporary barcode prefix for items that are created in the acquisitions module

• Temporary call number prefix - Temporary call number prefix for items that are created in the acquisitions module

Cancel/Delay reasons
The Cancel reasons link enables you to predefine the reasons for which a line item or a PO can be cancelled. A default list of reasons appears, but you can add custom reasons to this list. Applying the cancel reason will prevent the item from appearing in a claims list and will allow you to cancel debits associated with the purchase. Cancel reasons also enable you to delay a purchase. For example, you could create a cancel reason of back ordered, and you could choose to keep the debits associated with the purchase.

**Create a cancel/delay reason**

1. To add a new cancel reason, click Administration → Acquisitions Administration → Cancel reasons.
2. Click New Cancel Reason.
3. Select a using library from the drop-down menu. The using library indicates the organizational units whose staff can use this cancel reason. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units.)
4. Create a label for the cancel reason. This label will appear when you select a cancel reason on an item or a PO.
5. Create a description of the cancel reason. This is a free text field and can comprise any text of your choosing.
6. If you want to retain the debits associated with the cancelled purchase, click the box adjacent to Keep Debits→
7. Click Save.

**Delete a custom cancel/delay reason**

You can delete custom cancel reason.

1. Select the checkbox for the custom cancel reason that should be deleted.
2. Click the Delete Selected button.

You cannot select the checkbox for any of the default cancel reasons because the system expects those reasons to be available to handle EDI order responses.

**Claiming**

Currently, all claiming is manual, but the admin module enables you to build claim policies and specify the action(s) that users should take to claim items.
Create a claim policy

The claim policy link enables you to name the claim policy and specify the organization that owns it.

1. To create a claim policy, click Administration → Acquisitions Administration → Claim Policies.

2. Create a claim policy name. No limits exist on the number of characters that can be entered in this field.

3. Select an org unit from the drop-down menu. The org unit indicates the organizational units whose staff can use this claim policy. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

4. Enter a description. No limits exist on the number of characters that can be entered in this field.

5. Click Save.

Create a claim type

The claim type link enables you to specify the reason for a type of claim.

1. To create a claim type, click Administration → Acquisitions Administration → Claim types.

2. Create a claim type. No limits exist on the number of characters that can be entered in this field.

3. Select an org unit from the drop-down menu. The org unit indicates the organizational units whose staff can use this claim type. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

4. Enter a description. No limits exist on the number of characters that can be entered in this field.

5. Click Save.

Create a claim event type

The claim event type describes the physical action that should occur when an item needs to be claimed. For example, the user should notify the vendor via email that the library is claiming an item.
1. To access the claim event types, click Administration → Acquisitions Administration → Claim event type.

2. Enter a code for the claim event type. No limits exist on the number of characters that can be entered in this field.

3. Select an org unit from the drop-down menu. The org unit indicates the organizational units whose staff can use this event type. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

4. Enter a description. No limits exist on the number of characters that can be entered in this field.

5. If this claim is initiated by the user, then check the box adjacent to Library Initiated.

6. Click Save.

Create a claim policy action

The claim policy action enables you to specify how long a user should wait before claiming the item.

1. To access claim policy actions, click Administration → Acquisitions Administration → Claim Policy Actions.

2. Select an Action (Event Type) from the drop-down menu.

3. Enter an action interval. This field indicates how long a user should wait before claiming the item.

4. In the Claim Policy ID field, select a claim policy from the drop-down menu.

5. Click Save.

You can create claim cycles by adding multiple claim policy actions to a claim policy.

Currency Types
Currency types can be created and applied to funds in the administrative module. When a fund is applied to a copy or line item for purchase, the item will be purchased in the currency associated with that fund.

**Create a currency type**

1. To create a new currency type, click Administration → Acquisitions Administration → Currency types.
2. Enter the currency code. No limits exist on the number of characters that can be entered in this field.
3. Enter the name of the currency type in Currency Label field. No limits exist on the number of characters that can be entered in this field.
4. Click Save.

**Edit a currency type**

1. To edit a currency type, click your cursor in the row that you want to edit. The row will turn blue.
2. Double click. The pop-up box will appear, and you can edit the fields.
3. After making changes, click Save.

From the currency types interface, you can delete currencies that have never been applied to funds or used to make purchases.

**Distribution Formulas**

Distribution formulas allow you to specify the number of copies that should be distributed to specific branches. They can also serve as templates allowing you to predefine settings for your copies. You can create and reuse formulas as needed.

**Create a distribution formula**

1. Click Administration → Acquisitions Administration → Distribution Formulas.
2. Click New Formula.
3. Enter a Formula Name. No limits exist on the number of characters that can be entered in this field.
4. Choose a Formula Owner from the drop-down menu. The Formula Owner indicates the organizational units whose staff can use this formula. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).
5. Ignore the Skip Count field which is currently not used.

6. Click Save.

7. Click New Entry.

8. Select an Owning Library from the drop-down menu. This indicates the branch that will receive the items. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

9. Select/enter any of the following copy details you want to predefine in the distribution formula.
   • Copy Location
   • Fund
   • Circ Modifier
   • Collection Code

10. In the Item Count field, enter the number of items that should be distributed to the branch. You can enter the number or use the arrows on the right side of the field.

11. Click Apply Changes. The screen will reload.

12. To view the changes to your formula, click Administration → Acquisitions Administration → Distribution Formulas. The item_count will reflect the entries to your distribution formula.

To edit the Formula Name, click the hyperlinked name of the formula in the top left corner. A pop-up box will enable you to enter a new formula name.

**Edit a distribution formula**

To edit a distribution formula, click the hyperlinked title of the formula.

**Electronic Data Interchange**

Many libraries use Electronic Data Interchange (EDI) accounts to send purchase orders and receive invoices from providers electronically. In Evergreen users can setup EDI accounts and manage EDI messages in the admin module. EDI messages and notes can be viewed in the acquisitions module.
See also the command line system administration manual, which includes some initial setup steps that are required for use of EDI.

**Entering SANs (Standard Address Numbers)**

For EDI to work your library must have a SAN and each of your providers must each supply you with their SAN.

A SAN (Standard Address Number) is a unique 7 digit number that identifies your library.

**Entering a Library’s SAN**

These steps only need to be done once per library.

1. In Evergreen select Administration → Server Administration → Organizational Units
2. Find your library in the tree on the left side of the page and click on it to open the settings.

Multi-branch library systems will see an entry for each branch but should select their system’s top organization unit.

3. Click on the Address tab.
4. Click on the Mailing Address tab.
5. Enter your library’s SAN in the field labeled SAN.
6. Click Save.

**Entering a Provider’s SAN**

These steps need to be repeated for every provider with which EDI is used.

1. In Evergreen select Administration → Acquisitions Administration → Providers.
2. Click the hyperlinked name of the provider you would like to edit.

3. Enter your provider’s SAN in the field labeled SAN.

4. Click Save.

Create an EDI Account

You must create your provider before you create an EDI account for the provider.

1. Contact your provider requesting the following information:
   - Host
   - Username
   - Password
   - Path
2. In Evergreen select Administration → Acquisitions Administration → EDI Accounts.


4. Fill in the following fields:

   - In the Label field, enter a name for the EDI account.
   - In the Host field, enter the requisite FTP or SCP information supplied by your provider. Be sure to include the protocol (e.g. `ftp://ftp.vendorname.com`).
   - In the Username field, enter the username supplied by your provider.
   - In the Password field, enter the password supplied by your provider.
   - Select your library as the Owner from the drop down menu. Multi-branch libraries should select their top level organizational unit.
   - The Last Activity updates automatically with any inbound or outbound communication.
   - In the Provider field, enter the code used in Evergreen for your provider.
   - In the Path field, enter the path supplied by your provider. The path indicates a directory on the provider’s server where Evergreen will deposit its outgoing order files.

   If your vendor requests a specific file extension for EDI purchase orders, such as `.ord`, enter the name of the directory, followed by a slash, followed by an asterisk, followed by a period, followed by the extension. For example, if the vendor requests that EDI purchase orders be sent to a directory called `in` with the file extension `.ord`, your path would be `in/* .ord`.

   - In the Incoming Directory field, enter the incoming directory supplied by your provider. This indicates the directory on the vendor’s server where Evergreen will retrieve incoming order responses and invoices.
Don’t worry if your incoming directory is named **out** or **outgoing**. From your vendor’s perspective, this directory is outgoing, because it contains files that the vendor is sending to Evergreen. However, from Evergreen’s perspective, these files are incoming.

5. Click Save.

6. Click on the link in the Provider field.

7. Select the EDI account that has just been created from the EDI Default drop down menu.
8. Click Save.

**EDI Messages**

The EDI Messages screen displays all incoming and outgoing messages between the library and its providers. To see details of a particular EDI message, including the raw EDIFACT message, double click on a message entry. To find a specific EDI message, the Filter options can be useful. Outside the Admin interface, EDI messages that pertain to a specific purchase order can be viewed from the purchase order interface (See Acquisitions → Purchase Orders).

**Exchange Rates**

Exchange rates define the rate of exchange between currencies. Evergreen will automatically calculate exchange rates for purchases. Evergreen assumes that the currency of the purchasing fund is identical to the currency of the provider, but it provides for two unique situations: If the currency of the fund that is used for the purchase is different from the currency of the provider as listed in the provider profile, then Evergreen will use the exchange rate to calculate the price of the item in the currency of the fund and debit the fund accordingly. When money is transferred between funds that use different currency types, Evergreen will automatically use the exchange rate to convert the money to the currency of the receiving fund. During such transfers, however, staff can override the automatic conversion by providing an explicit amount to credit to the receiving fund.

**Create an exchange rate**

1. To create a new exchange rate, click Administration → Acquisitions Administration → Exchange Rates.

2. Click New Exchange Rate.
3. Enter the From Currency from the drop-down menu populated by the currency types.
4. Enter the To Currency from the drop-down menu populated by the currency types.
5. Enter the exchange Ratio.
6. Click Save.

**Edit an exchange rate**

Edit an exchange rate just as you would edit a currency type.

**MARC Federated Search**

The MARC Federated Search enables you to import bibliographic records into a selection list or purchase order from a Z39.50 source.

1. Click Acquisitions → MARC Federated Search.
2. Check the boxes of Z39.50 services that you want to search. Your local Evergreen Catalog is checked by default. Click Submit.

**Search Sources**

- [x] Evergreen Catalog
- [ ] OCLC
- [x] Library of Congress
- [ ] biblios.net

**Search Fields**

- **Author**: 
- **ISBN**: 978-1439164631
- **ISSN**: 
- **Item Type**: 
- **LCCN**: 
- **Publication Date**: 
- **Publisher**: 
- **Title**: left neglected
- **Title Control Number**: 
- **Hits Per Source**: 10

[Submit]  [Clear Form]
3. A list of results will appear. Click the Copies link to add copy information to the line item. See Line Item Features for more information.

4. Click the Notes link to add notes or line item alerts to the line item. See Line Item Features for more information.

5. Enter a price in the Estimated Price field.

6. You can save the line item(s) to a selection list by checking the box on the line item and clicking Actions → Save Items to Selection List. You can also create a purchase order from the line item(s) by checking the box on the line item and clicking Actions → Create Purchase Order.

<table>
<thead>
<tr>
<th>Items</th>
<th>Notes</th>
<th>Actions</th>
<th>Status</th>
<th>Estimated Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copies(6) Notes(0)</td>
<td>Actions</td>
<td>New</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Fund Tags

You can apply tags to funds so that you can group funds for easy reporting. For example, you have three funds for children’s materials: Children’s Board Books, Children’s DVDs, and Children’s CDs. Assign a fund tag of children’s to each fund. When you need to report on the amount that has been spent on all children’s materials, you can run a report on the fund tag to find total expenditures on children’s materials rather than reporting on each individual fund.

### Create a Fund Tag

1. To create a fund tag, click Administration → Acquisitions Administration → Fund Tags.

2. Click New Fund Tag. No limits exist on the number of characters that can be entered in this field.

3. Select a Fund Tag Owner from the drop-down menu. The owner indicates the organizational unit(s) whose staff can use this fund tag. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

   ![The rule of parental inheritance applies to this list.](image)

4. Enter a Fund Tag Name. No limits exist on the number of characters that can be entered in this field.

5. Click Save.
Funding Sources

Funding sources allow you to specify the sources that contribute monies to your fund(s). You can create as few or as many funding sources as you need. These can be used to track exact amounts for accounts in your general ledger. You can then use funds to track spending and purchases for specific collections.

Create a funding source

1. To create a new funding source, click Administration → Acquisitions Administration → Funding Source.
2. Enter a funding source name. No limits exist on the number of characters that can be entered in this field.
3. Select an owner from the drop-down menu. The owner indicates the organizational unit(s) whose staff can use this funding source. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).
4. Create a code for the source. No limits exist on the number of characters that can be entered in this field.
5. Select a currency from the drop-down menu. This menu is populated from the choices in the Currency Types interface.
6. Click Save.

Allocate credits to funding sources

1. Apply a credit to this funding source.
2. Enter the amount of money that the funding source contributes to the organization. Funding sources are not tied to fiscal or calendar years, so you can continue to add money to the same funding source over multiple years, e.g. County Funding. Alternatively, you can name funding sources by year, e.g. County Funding 2010 and County Funding 2011, and apply credits each year to the matching source.
3. To apply a credit, click on the hyperlinked name of the funding source. The Funding Source Details will appear.
4. Click Apply Credit.
5. Enter an amount to apply to this funding source.

6. Enter a note. This field is optional.

7. Click Apply.

**Allocate credits to funds**

If you have already set up your funds, then you can then click the Allocate to Fund button to apply credits from the funding sources to the funds. If you have not yet set up your funds, or you need to add a new one, you can allocate credits to funds from the funds interface. See section 1.2 for more information.

1. To allocate credits to funds, click Allocate to Fund.

2. Enter the amount that you want to allocate.

3. Enter a note. This field is optional.

4. Click Apply.

**Track debits and credits**

You can track credits to and allocations from each funding source. These amounts are updated when credits and allocations are made in the Funding Source Details. Access the Funding Source Details by clicking on the hyperlinked name of the Funding Source.

**Funds**

Funds allow you to allocate credits toward specific purchases. In the funds interface, you can create funds; allocate credits from funding sources to funds; transfer money between funds; and apply fund tags to funds. Funds are created for a specific year, either fiscal or calendar. These funds are owned by org units. At the top of the funds interface, you can set a contextual org unit and year. The drop-down menu at the top of the screen enables you to focus on funds that are owned by specific organizational units during specific years.

**Create a fund**

1. To create a new fund, click Administration → Acquisitions Administration → Funds.

2. Enter a name for the fund. No limits exist on the number of characters that can be entered in this field.

3. Create a code for the fund. No limits exist on the number of characters that can be entered in this field.

4. Enter a year for the fund. This can be a fiscal year or a calendar year. The format of the year is YYYY.
5. Select an org unit from the drop-down menu. The org unit indicates the organizational units whose staff can use this fund. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

6. Select a currency type from the drop-down menu. This menu is comprised of entries in the currency types menu. When a fund is applied to a line item or copy, the price of the item will be encumbered in the currency associated with the fund.

7. Click the Active box to activate this fund. You cannot make purchases from this fund if it is not active.

8. Enter a Balance Stop Percent. The balance stop percent prevents you from making purchases when only a specified amount of the fund remains. For example, if you want to spend 95 percent of your funds, leaving a five percent balance in the fund, then you would enter 95 in the field. When the fund reaches its balance stop percent, it will appear in red when you apply funds to copies.

9. Enter a Balance Warning Percent. The balance warning percent gives you a warning that the fund is low. You can specify any percent. For example, if you want to spend 90 percent of your funds and be warned when the fund has only 10 percent of its balance remaining, then enter 90 in the field. When the fund reaches its balance warning percent, it will appear in yellow when you apply funds to copies.

10. Check the Propagate box to propagate funds. When you propagate a fund, the ILS will create a new fund for the following fiscal year with the same parameters as your current fund. All of the settings transfer except for the year and the amount of money in the fund. Propagation occurs during the fiscal year close-out operation.

11. Check the Rollover box if you want to roll over remaining funds into the same fund next year. You should also check this box if you only want to roll over encumbrances into next year's fund.

12. Click Save.

Allocate credits from funding sources to funds

Credits can be applied to funds from funding sources using the fund interface. The credits that you apply to the fund can be applied later to purchases.

1. To access funds, click Administration → Acquisitions Administration → Funds.

2. Click the hyperlinked name of the fund.

3. To add a credit to the fund, click the Create Allocation tab.

4. Choose a Funding Source from the drop-down menu.
5. Enter an amount that you want to apply to the fund from the funding source.

6. Enter a note. This field is optional.

7. Click Apply.

**Transfer credits between funds**

The credits that you allocate to funds can be transferred between funds if desired. In the following example, you can transfer $500.00 from the Young Adult Fiction fund to the Children’s DVD fund.

1. To access funds, click Administration → Acquisitions Administration → Funds.

2. Click the hyperlinked name of the originating fund.

3. The Fund Details screen appears. Click Transfer Money.

4. Enter the amount that you would like to transfer.

5. From the drop-down menu, select the destination fund.

6. Add a note. This field is optional.

7. Click Transfer.

**Track balances and expenditures**

The Fund Details allows you to track the fund’s balance, encumbrances, and amount spent. It also allows you to track allocations from the funding source(s), debits, and fund tags.

1. To access the fund details, click on the hyperlinked name of the fund that you created.

2. The Summary allows you to track the following:

3. Balance - The balance is calculated by subtracting both items that have been invoiced and encumbrances from the total allocated to the fund.

4. Total Allocated - This amount is the total amount allocated from the Funding Source.

5. Spent Balance - This balance is calculated by subtracting only the items that have been invoiced from the total allocated to the fund. It does not include encumbrances.

6. Total Debits - The total debits are calculated by adding the cost of items that have been invoiced and encumbrances.

7. Total Spent - The total spent is calculated by adding the cost of items that have been invoiced. It does not include encumbrances.

8. Total Encumbered - The total encumbered is calculated by adding all encumbrances.

**Fund reporting**
A core source, Fund Summary, is available in the reports interface. This core source enables librarians to easily run a report on fund activity. Fields that are accessible in this interface include Remaining Balance, Total Allocated, Total Encumbered, and Total Spent.

Edit a fund

Edit a fund just as you would edit a currency type.

Perform fiscal year close-out operation

The Fiscal Year Close-Out Operation allows you to deactivate funds for the current year and create analogous funds for the next year. It transfers encumbrances to the analogous funds, and it rolls over any remaining funds if you checked the rollover box when creating the fund.

1. To access the year end closeout of a fund, click Administration → Server Administration → Acquisitions → Funds.
2. Click Fund Propagation and Rollover.
3. Check the box adjacent to Perform Fiscal Year Close-Out Operation.
4. For funds that have the "Rollover" setting enabled, if you want to move the fund’s encumbrances to the next year without moving unspent money, check the box adjacent to Limit Fiscal Year Close-out Operation to Encumbrances.

The Limit Fiscal Year Close-out Operation to Encumbrances will only display if the Allow funds to be rolled over without bringing the money along Library Setting has been enabled. This setting is available in the Library Setting Editor accessible via Administration → Local Administration → Library Settings Editor.
5. Notice that the context org unit reflects the context org unit that you selected at the top of the Funds screen.

6. If you want to perform the close-out operation on the context org unit and its child units, then check the box adjacent to Include Funds for Descendant Org Units.

7. Check the box adjacent to dry run if you want to test changes to the funds before they are enacted. Evergreen will generate a summary of the changes that would occur during the selected operations. No data will be changed.

8. Click Process.

9. Evergreen will begin the propagation process. Evergreen will make a clone of each fund, but it will increment the year by 1.

**Invoice menus**

Invoice menus allow you to create drop-down menus that appear on invoices. You can create an invoice item type or invoice payment method.

**Invoice item type**

The invoice item type allows you to enter the types of additional charges that you can add to an invoice. Examples of additional charge types might include taxes or processing fees. Charges for
bibliographic items are listed separately from these additional charges. A default list of charge
types displays, but you can add custom charge types to this list. Invoice item types can also be
used when adding non-bibliographic items to a purchase order. When invoiced, the invoice item
type will copy from the purchase order to the invoice.

1. To create a new charge type, click Administration → Acquisitions Administration → Invoice Item
   Type.

2. Click New Invoice Item Type.

3. Create a code for the charge type. No limits exist on the number of characters that can be
   entered in this field.

4. Create a label. No limits exist on the number of characters that can be entered in this field. The
   text in this field appears in the drop-down menu on the invoice.

5. If items on the invoice were purchased with the monies in multiple funds, then you can divide
   the additional charge across funds. Check the box adjacent to Prorate→ if you want to prorate
   the charge across funds.

6. Click Save.

**Invoice payment method**

The invoice payment method allows you to predefine the type(s) of invoices and payment
method(s) that you accept. The text that you enter in the admin module will appear as a drop-down
menu in the invoice type and payment method fields on the invoice.

1. To create a new invoice payment method, click Administration → Acquisitions Administration →
   Invoice Payment Method.

2. Click New Invoice Payment Method.

3. Create a code for the invoice payment method. No limits exist on the number of characters that
   can be entered in this field.

4. Create a name for the invoice payment method. No limits exist on the number of characters that
   can be entered in this field. The text in this field appears in the drop-down menu on the invoice.

5. Click Save.

Payment methods can be deleted from this screen.

**Line Item Features**

Line item alerts are predefined text that can be added to line items that are on selection lists or
purchase orders. You can define the alerts from which staff can choose. Line item alerts appear in
a pop-up box when the line item, or any of its copies, are marked as received.
Create a line item alert

1. To create a line item alert, click Administration → Acquisitions Administration → Line Item Alerts.
2. Click New Line Item Alert Text.
3. Create a code for the text. No limits exist on the number of characters that can be entered in this field.
4. Create a description for the text. No limits exist on the number of characters that can be entered in this field.
5. Select an owning library from the drop-down menu. The owning library indicates the organizational units whose staff can use this alert. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).
6. Click Save.

Line item MARC attribute definitions

Line item attributes define the fields that Evergreen needs to extract from the bibliographic records that are in the acquisitions database to display in the catalog. Also, these attributes will appear as fields in the New Brief Record interface. You will be able to enter information for the brief record in the fields where attributes have been defined.

Providers

Providers are vendors. You can create a provider profile that includes contact information for the provider, holdings information, invoices, and other information.

Create a provider

1. To create a new provider, click Administration → Acquisitions Administration → Providers.
2. Enter the provider name.
3. Create a code for the provider. No limits exist on the number of characters that can be entered in this field.
4. Select an owner from the drop-down menu. The owner indicates the organizational units whose staff can use this provider. This menu is populated with the shortnames that you created for your libraries in the organizational units tree (See Administration → Server Administration → Organizational Units).

The rule of parental inheritance applies to this list.
5. Select a currency from the drop-down menu. This drop-down list is populated by the list of 
currencies available in the currency types.

6. A provider must be active in order for purchases to be made from that provider. To activate the 
provider, check the box adjacent to Active. To deactivate a vendor, uncheck the box.

7. Add the default # of copies that are typically ordered through the provider. This number will 
automatically populate the line item’s Copies box on any PO’s associated with this provider. If 
another quantity is entered during the selection or ordering process, it will override this default. 
If no number is specified, the default number of copies will be zero.

8. Select a default claim policy from the drop-down box. This list is derived from the claim policies 
that can be created.

9. Select an EDI default. This list is derived from the EDI accounts that can be created.

10. Enter the provider’s email address.

11. In the Fax Phone field, enter the provider’s fax number.

12. In the holdings tag field, enter the tag in which the provider places holdings data.

13. In the phone field, enter the provider’s phone number.

14. If prepayment is required to purchase from this provider, then check the box adjacent to 
prepayment required.

15. Enter the Standard Address Number (SAN) for your provider.

16. Enter the web address for the provider’s website in the URL field.

17. Click Save.

Add contact and holdings information to providers

After you save the provider profile, the screen reloads so that you can save additional information 
about the provider. You can also access this screen by clicking the hyperlinked name of the provider 
on the Providers screen. The tabs allow you to add a provider address and contact, attribute 
definitions, and holding subfields. You can also view invoices associated with the provider.

1. Enter a Provider Address, and click Save.

   Required fields for the provider address are: Street 1, city, state, country, post code. You may 
have multiple valid addresses.

2. Enter the Provider Contact, and click Save.

3. Your vendor may include information that is specific to your organization in MARC tags. You 
can specify the types of information that should be entered in each MARC tag. Enter attribute
definitions to correlate MARC tags with the information that they should contain in incoming vendor records. Some technical knowledge is required to enter XPath information. As an example, if you need to import the PO Name, you could set up an attribute definition by adding an XPath similar to:

```plaintext
code => purchase_order
xpath => //*[tag="962"]/*[code="p"]
Is Identifier => false
```

where 962 is the holdings tag and p is the subfield that contains the PO Name.

4. You may have entered a holdings tag when you created the provider profile. You can also enter holdings subfields. Holdings subfields allow you to specify subfields within the holdings tag to which your vendor adds holdings information, such as quantity ordered, fund, and estimated price.

5. Click invoices to access invoices associated with a provider.

**Edit a provider**

Edit a provider just as you would edit a currency type.

You can delete providers only if no purchase orders have been assigned to them.
Chapter 59. Age hold protection

Age hold protection prevents new items from filling holds requested for pickup at a library other than the owning library for a specified period of time.

You can define the protection period in Administration → Server Administration → Age Hold Protect Rules.

The protection period when applied to a copy record can start with the copy record create date (default) or active date. You can change this setting in Administration → Local Administration → Library Settings Editor: Use Active Date for Age Protection.

In addition to time period, you can set the proximity value to define which organizational units are allowed to act as pickup libraries. The proximity values affect holds as follows:

- "0" allows only holds where pickup library = owning library
- "1" allows holds where pickup library = owning library, parent, and child organizational units
- "2" allows holds where pickup library = owning library, parent, child, and/or sibling organizational units

Age protection only applies to individual copy records. You cannot configure age protection rules in hold policies.

Active date display in OPAC

If a library uses the copy’s active date to calculate holds age protection, the active date will display with the copy details instead of the create date in the staff client view of the catalog. Libraries that do not enable the Use Active Date for Age Protection library setting will continue to display the create date.
Chapter 60. Authorities

Authority Control Sets

The tags and subfields that display in authority records in Evergreen are proscribed by control sets. The Library of Congress control set is the default control set in Evergreen. You can create customized control sets for authority records. Also, you can define thesauri and authority fields for these control sets.

Patrons and staff will be able to browse authorities in the OPAC. The following fields are browsable by default: author, series, subject, title, and topic. You will be able to add custom browse axes in addition to these default fields.

You can specify the MARC tags and subfields that an authority record should contain. The Library of Congress control set exists in the staff client by default. The control sets feature enables librarians to add or customize new control sets.

To access existing control sets, click Administration → Server Administration → Authority Control Sets.

Add a Control Set

1. Click Administration → Server Administration → Authority Control Sets.
2. Click New Control Set.

3. Add a Name to the control set. Enter any number of characters.

4. Add a Description of the control set. Enter any number of characters.

5. Click Save.

![Control Sets Table]

### Thesauri

A thesaurus describes the semantic rules that govern the meaning of words in a MARC record. The thesaurus code, which indicates the specific thesaurus that should control a MARC record, is encoded in a fixed field using the mnemonic Subj in the authority record. Eleven thesauri associated with the Library of Congress control set exist by default in the staff client.

To access an existing thesaurus, click Administration → Server Administration → Authority Control Sets, and choose the hyperlinked thesaurus that you want to access, or click Administration → Server Administration → Authority Thesauri.

### Add a Thesaurus

1. Click Administration → Server Administration → Authority Control Sets, and choose the hyperlinked thesaurus that you want to access, or click Admin → Server Administration → Authority Thesauri.

2. Click New Thesaurus.

3. Add a Thesaurus Code. Enter any single, upper case character. This character will be entered in the fixed fields of the MARC record.

4. Add a Name to the thesaurus. Enter any number of characters.

5. Add a Description of the thesaurus. Enter any number of characters.
Authority Fields

Authority fields indicate the tags and subfields that should be entered in the authority record. Authority fields also enable you to specify the type of data that should be entered in a tag. For example, in an authority record governed by a Library of Congress control set, the 100 tag would contain a "Heading - Personal Name." Authority fields also enable you to create the corresponding tag in the bibliographic record that would contain the same data.

Create an Authority Field

1. Click Administration → Server Administration → Authority Control Sets.

2. Click Authority Fields. The number in parentheses indicates the number of authority fields that have been created for the control set.

3. Click New Authority Field.

4. Add a Name to the authority field. Enter any number of characters.

5. Add a Description to describe the type of data that should be entered in this tag. Enter any number of characters.

6. Select a Main Entry if you are linking the tag(s) to another entry.

7. Add a Tag in the authority record.

8. Add a subfield in the authority record. Multiple subfields should be entered without commas or spaces.

9. Add a Non-filing indicator (either 1 or 2) to denote which indicator contains non-filing information. Leave empty if not applicable.

10. Click Save.
11. Create the corresponding tag in the bibliographic record that should contain this information. Click the None link in the Controlled Bib Fields column.

12. Click New Control Set Bib Field.

13. Add the corresponding tag in the bibliographic record.

14. Click Save.
Browse Axes

Authority records can be browsed, by default, along five axes: author, series, subject, title, and topic. Use the Browse Axes feature to create additional axes.

Create a new Browse Axis

1. Click Administration → Server Administration → Authority Browse Axes
2. Click New Browse Axis.
3. Add a code. Do not enter any spaces.
4. Add a name to the axis that will appear in the OPAC. Enter any number of characters.
5. Add a description of the axis. Enter any number of characters.
6. Add a sorter attribute. The sorter attribute indicates the order in which the results will be displayed.

7. Assign the axis to an authority so that users can find the authority record when browsing authorities. Click Administration → Server Administration → Authority Control Sets.
8. Choose the control set to which you will add the axis. Click Authority Fields.
9. Click the link in the Axes column of the tag of your choice.
10. Click New Browse Axis-Authority Field Map.
11 Select an Axis from the drop down menu.

12 Click Save.

Permissions to use this Feature

To use authority control sets, you will need the following permissions:

- CREATE_AUTHORITY_CONTROL_SET
- UPDATE_AUTHORITY_CONTROL_SET
- DELETE_AUTHORITY_CONTROL_SET

include::admin/infrastructure_auth_browse.adoc
Chapter 61. Best-Hold Selection Sort Order

Best-Hold Selection Sort Order allows libraries to configure customized rules for Evergreen to use to select the best hold to fill at opportunistic capture. When a copy is captured for a hold upon check-in, Evergreen evaluates the holds in the system that the item could fill. Evergreen uses a set of rules, or a Best-Hold Selection Sort Order, to determine the best hold to fill with the item. In previous version of Evergreen, there were two sets of rules for Evergreen to use to determine the best hold to fulfill: Traditional and FIFO (First In, First Out). Traditional uses Org Unit Proximity to identify the nearest hold to fill. FIFO follows a strict order of first-in, first-out rules. This feature allows new, custom Best-Hold Selection Sort Orders to be created. Existing Best-Hold Selection Sort Orders can also be modified.

Preconfigured Best-Hold Orders

Evergreen comes with six preconfigured Best-Hold Selection Sort Orders to choose from:

- Traditional
- Traditional with Holds-go-home
- Traditional with Holds-always-go-home
- FIFO
- FIFO with Holds-go-home
- FIFO with Holds-always-go-home

The Holds-go-home and Holds-always-go-home options allow libraries to determine how long they want to allow items to transit outside of the item’s home library, before it must return to its home library to fulfill any holds that are to be picked up there. Libraries can set this time limit in the library setting Holds: Max foreign-circulation time. The Library Settings Editor can be found under Administration → Local Administration → Library Settings Editor.

Create a New Best-Hold Selection Sort Order

To create a new Best-Hold Selection Sort Order, go to Administration → Server Administration → Best-Hold Selection Sort Order.

1. Click Create New.

2. Assign your Best-Hold Selection Sort Order a Name.

3. Next, use the Move Up and Move Down buttons to arrange the fields in the order that you would like Evergreen to check when looking for the best hold to fill with a copy at opportunistic capture.

4. Click Save Changes to create your custom Best-Hold Selection Sort Order.
Edit an Existing Best-Hold Selection Sort Order

To edit an existing Best-Hold Selection Sort Order, go to Administration → Server Administration → Best-Hold Selection Sort Order.

1. Click Edit Existing.
2. Choose the Best-Hold Selection Sort Order that you would like to edit from the drop down menu.
3. Next, use the Move Up and Move Down buttons to arrange the fields in the new order that you would like Evergreen to check when looking for the best hold to fill with a copy at opportunistic capture.
4. Click Save Changes to save your edits.

Choosing the Best-Hold Selection Sort Order

The Best-Hold Selection Sort Order can be set for an Org Unit in the Library Settings Editor.

To select the Best-Hold Selection Sort Order that your Org Unit will use:

1. Go to Administration → Local Administration → Library Settings Editor.
2. Locate the setting Holds: Best-hold selection sort order, and click Edit.
3. Choose the Context org unit for this setting.
4. Select the Best-hold selection sort order, or Value, from the drop down menu.
5. Click Update Setting.
Permissions to use this Feature

To administer the custom Best-Hold Selection Sort Order interface, you need the following permission:

• ADMIN_HOLD_CAPTURE_SORT
Chapter 62. Booking Module Administration

Creating Bookable Non-Bibliographic Resources

Staff with the required permissions (Circulator and above) can create bookable non-bibliographic resources such as laptops, projectors, and meeting rooms.

The following pieces make up a non-bibliographic resource:

- Resource Type
- Resource Attribute
- Resource Attribute Values
- Resource
- Resource Attribute Map

You need to create resource types and resource attributes (features of the resource types), and add booking items (resources) to individual resource type. Each resource attribute may have multiple values. You need to link the applicable features (resource attributes and values) to individual item (resource) through the Resource Attribute Map. Before you create resources (booking items) you need to have a resource type and associated resource attributes and values, if any, for them.

Create New Resource Type

1) Select Administration → Booking Administration → Resource Types.

2) A list of current resource types will appear. Use Back and Next buttons to browse the whole list.
You may also see cataloged items in the list. Those items have been marked bookable or booked before.

3) To create a new resource type, click New Resource Type in the top right corner.

4) A box will appear in which you create your new type of resource.
• Resource Type Name - Give your resource a name.

• Fine Interval - How often will fines be charged? This period can be input in several ways:
  - second(s), minute(s), hour(s), day(s), week(s), month(s), year(s)
  - sec(s), min(s)
  - s, m, h
  - 00:00:30, 00:01:00, 01:00:00

• Fine Amount - The amount that will be charged at each Fine Interval.

• Owning Library - The home library of the resource.

• Catalog Item - (Function not currently available.)

• Transferable - This allows the item to be transferred between libraries.

• Inter-booking and Inter-circulation Interval - The amount of time required by your library between the return of a resource and a new reservation for the resource. This interval uses * the same input conventions as the Fine Interval.

• Max Fine Amount - The amount at which fines will stop generating.

5) Click Save when you have entered the needed information.
6) The new resource type will appear in the list.

Create New Resource Attribute

1) Select Administration → Booking Administration → Resource Attributes.

2) Click New Resource Attribute in the top right corner.

3) A box will appear in which you can add the attributes of the resource. Attributes are categories of descriptive information that are provided to the staff member when the booking request is made. For example, an attribute of a projector may be the type of projector. Other attributes might be the number of seats available in a room, or the computing platform of a laptop.
• Resource Attribute Name - Give your attribute a name.

• Owning Library - The home library of the resource.

• Resource Type - Type in the first letter to list then choose the Resource Type to which the Attribute is applicable.

• Is Required - (Function not currently available.)

4) Click Save when the necessary information has been entered.

5) The added attribute will appear in the list.

---

One resource type may have multiple attributes. You may repeat the above procedure to add more.

---

Create New Resource Attribute Value

1) One resource attribute may have multiple values. To add new attribute value, select Administration → Booking Administration → Resource Attribute Values.

2) Click New Resource Attribute Value in the top right corner.

3) A box will appear in which you assign a value to a particular attribute. Values can be numbers, words, or a combination of them, that describe the particular aspects of the resource that have been defined as Attributes. As all values appear on the same list for selection, values should be as unique as possible. For example, a laptop may have a computing platform that is either PC or Mac.
• Owning Library - The home library of the resource.

• Resource Attribute - The attribute you wish to assign the value to.

• Valid Value - Enter the value for your attribute.

4) Click Save when the required information has been added.

5) The attribute value will appear in the list. Each attribute should have at least two values attached to it; repeat this process for all applicable attribute values.

Create New Resource

1) Add items to a resource type. Click Administration → Booking Administration → Resources.

2) Click New Resource in the top right corner.

3) A box will appear. Add information for the resource.
• Owning Library - The home library of the resource.

• Resource Type - Type in the first letter of the resource type’s name to list then select the resource type for your item.

• Barcode - Barcode for the resource.

• Overbook - This allows a single item to be reserved, picked up, and returned by multiple patrons during overlapping or identical time periods.

• Is Deposit Required - (Function not currently available.)

• Deposit Amount - (Function not currently available.)

• User Fee - (Function not currently available.)

4) Click Save when the required information has been added.

5) The resource will appear in the list.

One resource type may have multiple resources attached.

Map Resource Attributes and Values to Resources

1) Use Resource Attribute Maps to bring together the resources and their attributes and values. Select Administration → Booking Administration → Resource Attribute Maps.

2) Click New Resource Attribute Map in the right top corner.

3) A box will appear in which you will map your attributes and values to your resources.

• Resource - Enter the barcode of your resource.

• Resource Attribute - Select an attribute that belongs to the Resource Type.
• Attribute Value - Select a value that belongs to your chosen attribute and describes your resource. If your attribute and value do not belong together you will be unable to save.

4) Click Save once you have entered the required information.

A resource may have multiple attributes and values. Repeat the above steps to map all.

5) The resource attribute map will appear in the list.

Once all attributes have been mapped your resource will be part of a hierarchy similar to the example below.

```
Resource
  +------------------------+
  | 98723000112255         |
  +------------------------+
Resource Type
  +-------------------+
  | Laptop            |
  +-------------------+
Resource Attribute
  +------------------+
  | Operating System |
  +------------------+
  +------------------+
  | Computing Platform |
  +------------------+
Value
  +----------------+
  | Windows 7      |
  +----------------+
  +----------------+
  | PC              |
  +----------------+
```

**Editing Non-Bibliographic Resources**

Staff with the required permissions can edit aspects of existing non-bibliographic resources. For example, resource type can be edited in the event that the fine amount for a laptop changes from $2.00 to $5.00.

**Editing Resource Types**

1) Bring up your list of resource types. Select Administration → Booking Administration → Resource Types.

2) A list of current resource types will appear.

3) Double click anywhere on the line of the resource type you would like to edit.
4) The resource type box will appear. Make your changes and click Save.

5) Following the same procedure you may edit Resource Attributes, Attributes Values, Resources and Attribute Map by selecting them on Administration → Booking Administration.

Deleting Non-bibliographic Resources

1) To delete a booking resource, go to Administration → Booking Administration → Resources.

2) Select the checkbox in front the resource you want to delete. Click Delete Selected. The resource will disappear from the list.

Following the same procedure you may delete Resource Attributes Maps.

You may also delete Resource Attribute Values, Resource Attributes and Resource Types. But you have to delete them in the reverse order when you create them to make sure the entry is not in use when you try to delete it.

This is the deletion order: Resource Attribute Map/Resources → Resource Attribute Values → Resource Attributes → Resource Types.
Chapter 63. Call Number Prefixes and Suffixes

You can configure call number prefixes and suffixes in the Admin module. This feature ensures more precise cataloging because each cataloger will have access to an identical drop down menu of call number prefixes and suffixes that are used at his library. In addition, it may streamline cataloging workflow. Catalogers can use a drop down menu to enter call number prefixes and suffixes rather than entering them manually. You can also run reports on call number prefixes and suffixes that would facilitate collection development and maintenance.

Configure call number prefixes

Call number prefixes are codes that precede a call number.

To configure call number prefixes:

1. Select Administration → Server Administration → Call Number Prefixes.

2. Click New Prefix.

3. Enter the call number label that will appear on the item.

4. Select the owning library from the drop down menu. Staff at this library, and its descendant org units, with the appropriate permissions, will be able to apply this call number prefix.

5. Click Save.
Configure call number suffixes

Call number suffixes are codes that succeed a call number.

To configure call number suffixes:

1. Select Administration → Server Administration → Call Number Suffixes.
2. Click New Suffix.
3. Enter the call number label that will appear on the item.
4. Select the owning library from the drop down menu. Staff at this library, and its descendant org units, with the appropriate permissions, will be able to apply this call number suffix.
5. Click Save.

Apply Call Number Prefixes and Suffixes

You can apply call number prefixes and suffixes to items from a pre-configured list in the Unified Volume/Copy Creator. See the document, Unified Volume/Copy Creator, for an example.
Chapter 64. Cash Reports

Cash reports are useful for quickly getting information about money that your library has collected from patrons. This can be helpful in a few different scenarios, such as:

1. Reconciling a cash drawer at the end of the day.

2. Seeing how popular a specific payment type is (perhaps when evaluating a food-for-fines program).

To use the cash reports,

1. Under the Administration menu, choose Local Administration.

2. Click Cash reports.

3. Select the time period and library you are interested in. This interface defaults to showing payments accepted during the current day.

4. Click Submit.

You can click on the names of columns to sort the reports.

You need the VIEW_TRANSACTION permission to view these reports.

These payments are divided into two different types: Desk payments — in which a staff member simply accepted a credit card, check, or cash payment — and User payments — in which a staff member had to make a specific decision about whether to accept a payment of goods or work; or forgave or granted credit to a particular patron.
Chapter 65. Circulation Limit Sets

Maximum Checkout by Copy Location

This feature enables you to specify the maximum number of checkouts of items by copy location and is an addition to the circulation limit sets. Circulation limit sets refine circulation policies by limiting the number of items that users can check out. Circulation limit sets are linked by name to circulation policies.

To limit checkouts by copy location:

1. Click Administration → Local Administration → Circulation Limit Sets.

2. Click New to create a new circulation limit set.

3. In the Owning Library field, select the library that can create and edit this limit set.

4. Enter a Name for the circulation set. You will select the Name to link the circulation limit set to a circulation policy.

5. Enter the number of Items Out that a user can take from this copy location.

6. Enter the Min Depth, or the minimum depth in the org tree that Evergreen will consider as valid circulation libraries for counting items out. The min depth is based on org unit type depths. For example, if you want the items in all of the circulating libraries in your consortium to be eligible for restriction by this limit set when it is applied to a circulation policy, then enter a zero (0) in this field.

7. Check the box adjacent to Global Flag if you want all of the org units in your consortium to be restricted by this limit set when it is applied to a circulation policy. Otherwise, Evergreen will only apply the limit to the direct ancestors and descendants of the owning library.

8. Enter a brief Description of the circulation limit set.

9. Click Save.
To link the circulation limit set to a circulation policy:

1. Click Administration → Local Administration → Circulation Policies
2. Select an existing circulation policy, or create a new one.
3. Scroll down to the Linked Limit Sets.
4. Select the Name of the limit set that you want to add to the circulation policy.
5. Click Add.
6. Click Save.
### Chapter 65. Circulation Limit Sets

Report errors in this documentation using [Launchpad](https://launchpad.net).

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circulate?</td>
<td>True</td>
</tr>
<tr>
<td>Duration Rule</td>
<td>default</td>
</tr>
<tr>
<td>Renewals Override</td>
<td></td>
</tr>
<tr>
<td>Hard Due Date</td>
<td></td>
</tr>
<tr>
<td>Recurring Fine Rule</td>
<td>default</td>
</tr>
<tr>
<td>Grace Period Override</td>
<td></td>
</tr>
<tr>
<td>Max Fine Rule</td>
<td>default</td>
</tr>
<tr>
<td>Minimum Available Copy/Hold Ratio</td>
<td></td>
</tr>
<tr>
<td>Minimum Total Copy/Hold Ratio</td>
<td></td>
</tr>
<tr>
<td>Script Test</td>
<td></td>
</tr>
</tbody>
</table>

#### Linked Limit Sets

<table>
<thead>
<tr>
<th>Name</th>
<th>Fallthrough</th>
<th>Active</th>
<th>Remove</th>
<th>Add</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/V Materials</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Buttons:**
- Cancel
- Save
Chapter 66. Copy Status

To navigate to the copy status editor from the staff client menu, select Administration → Server Administration → Copy Statuses.

The Copy Status Editor is used to add, edit and delete statuses of copies in your system.

For each status, you can set the following properties:

- **Holdable** - If checked, users can place holds on copies in this status, provided there are no other flags or rules preventing holds. If unchecked, users cannot place holds on copies in this status.
- **OPAC Visible** - If checked, copies in this status will be visible in the public catalog. If unchecked, copies in this status will not be visible in the public catalog, but they will be visible when using the catalog in the staff client.
- **Sets copy active** - If checked, moving a copy that does not yet have an active date to this status will set the active date. If the copy already has an active date, then no changes will be made to the active date. If unchecked, this status will never set the copy's active date.
- **Is Available** - If checked, copies with this status will appear in catalog searches where "limit to available" is selected as a search filter. Also, copies with this status will check out without status warnings. By default, the "Available" and "Reshelving" statuses have the "Is Available" flag set. The flag may be applied to local/custom statuses via the copy status admin interface.

Evergreen comes pre-loaded with a number of copy statuses.

Table 66.1. Stock copy statuses and default settings

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Holdable</th>
<th>OPAC Visible</th>
<th>Sets copy active</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Available</td>
<td>true</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>1</td>
<td>Checked out</td>
<td>true</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Bindery</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Lost</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>4</td>
<td>Missing</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>5</td>
<td>In process</td>
<td>true</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>6</td>
<td>In transit</td>
<td>true</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>7</td>
<td>Reshelving</td>
<td>true</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>8</td>
<td>On holds shelf</td>
<td>true</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>9</td>
<td>On order</td>
<td>true</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>10</td>
<td>ILL</td>
<td>false</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>11</td>
<td>Cataloging</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>12</td>
<td>Reserves</td>
<td>false</td>
<td>true</td>
<td>true</td>
</tr>
<tr>
<td>13</td>
<td>Discard/Weed</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>
Adding Copy Statuses

1. In the New Status field, enter the name of the new status you wish to add.

2. Click Add.

3. Locate your new status and check the Holdable check box if you wish to allow users to place holds on items in this status. Check OPAC Visible if you wish for this status to appear in the public catalog. Check Sets copy active if you wish for this status to set the active date for new items.

4. Click Save Changes at the bottom of the screen to save changes to the new status.

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
<th>Holdable</th>
<th>OPAC Visible</th>
<th>Sets copy active</th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Damaged</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>15</td>
<td>On reservation shelf</td>
<td>false</td>
<td>false</td>
<td>true</td>
</tr>
<tr>
<td>16</td>
<td>Long Overdue</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
<tr>
<td>17</td>
<td>Lost and Paid</td>
<td>false</td>
<td>false</td>
<td>false</td>
</tr>
</tbody>
</table>
Deleting Copy Statuses

1. Highlight the statuses you wish to delete. Ctrl-click to select more than one status.
2. Click Delete Selected.
3. Click OK to verify.

You will not be able to delete statuses if copies currently exist with that status.

Editing Copy Statuses

1. Double click on a status name to change its name. Enter the new name.
2. To change whether a status is holdable, visible in the OPAC, or sets the copy's active date, check or uncheck the relevant checkbox.
3. Once you have finished editing the statuses, remember to click Save Changes.
Chapter 67. Floating Groups

Before floating groups copies could float or not. If they floated then they floated everywhere, with no restrictions.

After floating groups where a copy will float is defined by what group it has been assigned to.

Floating Groups

Each floating group comes with a name and a manual flag, plus zero or more group members. The name is used solely for selection and display purposes.

The manual flag dictates whether or not the "Manual Floating Active" checkin modifier needs to be active for a copy to float. This allows for greater control over when items float. It also prevents automated checkins via SIP2 from triggering floats.

Floating Group Members

Each member of a floating group references an org unit and has a stop depth, an optional max depth, and an exclude flag.

Org Unit

The org unit and all descendants are included, unless max depth is set, in which case the tree is cut off at the max depth.

Stop Depth

The stop depth is the highest point from the current copy circ library to the checkin library for the item that will be traversed. If the item has to go higher than the stop depth on the tree the member rule in question is ignored.

Max Depth

As mentioned with the org unit, the max depth is the furthest down on the tree from the org unit that gets included. This is based on the entire tree, not just off of the org unit. So in the default tree a max depth of 1 will stop at the system level no matter if org unit is set to CONS or SYS1.

Exclude

Exclude, if set, causes floating to not happen for the member. Excludes always take priority, so you can remove an org unit from floating without having to worry about other rules overriding it.
Examples

Float Everywhere
This is a default floating rule to emulate the previous floating behavior for new installs and upgrades.

One member:
• Org Unit: CONS
• Stop Depth: 0
• Max Depth: Unset
• Exclude: Off

Float Within System
This would permit a copy to float anywhere within a system, but would return to the system if it was returned elsewhere.

One member:
• Org Unit: CONS
• Stop Depth: 1
• Max Depth: Unset
• Exclude: Off

Float To All Branches
This would permit a copy to float to any branch, but not to sublibraries or bookmobiles.

One member:
• Org Unit: CONS
• Stop Depth: 0
• Max Depth: 2
• Exclude: Off

Float To All Branches Within System
This would permit a copy to float to any branch in a system, but not to sublibraries or bookmobiles, and returning to the system if returned elsewhere.
One member:

- Org Unit: CONS
- Stop Depth: 1
- Max Depth: 2
- Exclude: Off

**Float Between BR1 and BR3**

This would permit a copy to float between BR1 and BR3 specifically, excluding sublibraries and bookmobiles.

It would consist of two members, identical other than the org unit:

- Org Unit: BR1 / BR3
- Stop Depth: 0
- Max Depth: 2
- Exclude: Off

**Float Everywhere Except BM1**

This would allow an item to float anywhere except for BM1. It accomplishes this with two members.

The first includes all org units, just like Float Everywhere:

- Org Unit: CONS
- Stop Depth: 0
- Max Depth: Unset
- Exclude: Off

The second excludes BM1:

- Org Unit: BM1
- Stop Depth: 0
- Max Depth: Unset
- Exclude: On

That works because excludes are applied first.
Float into, but not out of, BR2

This would allow an item to float into BR2, but once there it would never leave. Why you would want to allow items to float to but not from a single library I dunno, but here it is. This takes advantage of the fact that the rules say where we can float to, but outside of stop depth don’t care where we are floating from.

One member:

• Org Unit: BR2
• Stop Depth: 0
• Max Depth: Unset
• Exclude: Off
Chapter 68. MARC Import Remove Fields

MARC Import Remove Fields allows staff to configure MARC tags to be automatically removed from bibliographic records when they are imported into Evergreen. This feature allows specific MARC tags to be removed from records that are imported through three different interfaces:

- Cataloging → Import Record from Z39.50
- Cataloging → MARC Batch Import/Export
- Acquisitions → Load MARC Order Records

Create a MARC Import Remove Fields profile

To create a MARC Import Remove Fields profile, go to Administration → Server Administration → MARC Import Remove Fields.

1. Click New Field Group.
2. Assign the Field Group a Label. This label will appear in the import interfaces.
3. Assign an Org Unit Owner.
4. Check the box next to Always Apply if you want Evergreen to apply this Remove Fields profile to all MARC records that are imported through the three affected interfaces. If you do not select Always Apply, staff will have the option to choose which Remove Fields profile to use when importing records.
5. Click Save.
6. The profile that you created will now appear in the list of MARC Import Remove Fields.
7. Click on the hyperlinked ID number. This will bring you into the Remove Fields profile to configure the MARC tags to be removed.
8. Click New Field.
9. In the Field, enter the MARC tag to be removed.
10. Click Save.
11. Add New Fields until you have configured all the tags needed for this profile.
12. Click Return to Groups to go back to the list of Remove Field profiles.
Import Options

The Label for each of the MARC Import Remove Fields profiles will appear on the three affected import screens. To select a profile, check the box next to the desired Label before importing the records.

Cataloging → Import Record from Z39.50
Chapter 68. MARC Import Remove Fields

Report errors in this documentation using Launchpad.
Acquisitions → Load MARC Order Records

Permissions to use this Feature

The following permissions are required to use this feature:

- CREATE_IMPORT_TRASH_FIELD
- UPDATE_IMPORT_TRASH_FIELD
- DELETE_IMPORT_TRASH_FIELD
Chapter 69. Copy Tags (Digital Bookplates)

Copy Tags allow staff to apply custom, pre-defined labels or tags to items. Copy tags are visible in the public catalog and are searchable in both the staff client and public catalog based on configuration. This feature was designed to be used for Digital Bookplates to attach donation or memorial information to items, but may be used for broader purposes to tag items.

Administration

New Permissions:

• ADMIN_COPY_TAG_TYPES: required to create a new tag type under Server Administration→Copy Tag Types
• ADMIN_COPY_TAG: required to create a new tag under Local Administration→Copy Tags

The existing permission UPDATE_COPY is required to assign a tag to a copy

New Library Settings:

• OPAC: Enable Digital Bookplate Search: when set to True for a given org unit, the digital bookplate search option will be available in the catalog.

Creating Copy Tags

There are two components to this feature: Copy Tag Types and Copy Tags.

Copy Tag Types are used to define the type of tag, such as “Bookplates” or “Local History Notes”, as well as the organizational unit scope for use of the tag type.

Copy Tags are associated with a Copy Tag Type and are used to configure the list of tags that can be applied to copies, such as a list of memorial or donation labels, that are applicable to a particular organizational unit.

Create Copy Tag Types

1. Go to Administration→Server Administration→Copy Tag Types.

2. In the upper left hand corner, click New Record. A dialog box will appear. Assign the following to create a new Copy Tag Type:

   a. Code: a code to identify the copy tag type.
   b. Label: a label that will appear in drop down menus to identify the copy tag type.
c. Owner: the organizational unit that can see and use the copy tag type.

3. Click Save and the new Copy Tag Type will appear in the list. Next create the associated Copy Tags.

Create Copy Tags

1. Go to Administration→Local Administration→Copy Tags.

2. In the upper left hand corner, click New Record. A dialog box will appear. Assign the following to create a new Copy Tag:

   a. Copy Tag Type: select the Copy Tag Type with which you want to associate the new Copy Tag.

   b. Label: assign a label to the new copy tag.

   c. Value: assign a value to the new copy tag. This will display in the catalog.

   d. Staff Note: a note may be added to guide staff in when to apply the copy tag.

   e. Is OPAC Visible?: If a copy tag is OPAC Visible, it can be searched for and viewed in the OPAC and the staff catalog. If a copy tag is not OPAC Visible, it can only be searched for and viewed in the staff catalog.

   f. Owner: select the organization unit at which this tag can be seen and used.
3. Click Save and the new Copy Tag will appear in the list.

Managing Copy Tags

Editing Tags

Existing copy tags can be edited by selecting a tag and clicking Actions→Edit Record or right-clicking on a tag and selecting Edit Record. The dialog box will appear and you can modify the copy tag. Click Save to save any changes. Changes will be propagated to any copies that the tag has been attached to.

Deleting Tags

Existing copy tags can be deleted by selecting a tag and clicking Actions→Delete Record or right-clicking on a tag and selecting Delete Record. Deleting a tag will delete the tag from any copies it was attached to in the catalog.
Chapter 70. MARC Record Attributes

The MARC Record Attribute Definitions support the ingesting, indexing, searching, filtering, and delivering of bibliographic record attributes.

To Access the MARC Record Attributes, click Administration → Server Administration → MARC Record Attributes

Managing Fixed Field Drop-down Context Menus

The MARC Editor includes Fixed Field Drop-down Context Menus, which make it easier for catalogers to select the right values for fixed fields in both Bibliographic and Authority records. You can use the MARC Record Attributes interface to modify these dropdowns to make them better suited for catalogers in your consortium.

To edit these menus, you can follow these steps:

1. Click Administration → Server Administration → MARC Record Attributes.
2. If there’s not already a dropdown for your fixed field, click New Attr. Definition and fill out the form using other fixed field attribute definitions as a model.
3. If you can find an attribute definition for your fixed field in the list, click the "Manage" link in the Coded Value Maps column.
4. Click New Map.
5. In the SVF Attribute field, type the name of the Attribute you identified in steps 2-3.
6. In the code field, type the actual value that will go into the fixed field (typically 1-4 characters). You can add an option to keep that fixed field empty by typing a space into this field.
7. In the value field, type the short description you’d like your catalogers to see in the dropdown menu.
8. Optional: add a longer description of this value in the Description field.
9. Check the OPAC Visible checkbox.

Multi Valued Fields and Composite Record Attributes

Multi Valued Fields and Composite Record Attributes expands upon the Record Attribute Definitions feature to include capturing all occurrences of multi-valued elements in a record. Multi Valued Fields allows users to say that a bibliographic record contains multiple entries for a particular record attribute. Composite Record Attributes supports the application of a more complicated and nested form of structure to a record attribute definition.
Multi Valued Fields

Multi Valued Fields allows for the capturing of multi-valued elements of a bibliographic record. Through the use of Multi Valued Fields, Evergreen recognizes that records are capable of storing multiple values. Multi Valued Fields are represented in the Record Attribute Definitions interface by a column named Multi-valued?. With Multi-valued? set to True, Evergreen will recognize the bibliographic records in the database that have multiple values mapping to the record attribute definition; it will also track and search on those values in the catalog. This feature will be particularly handy for bibliographic records representing a Blu-ray / DVD combo pack, since both format types can be displayed in the OPAC (if both formats were cataloged in the record).

To edit an existing record attribute definition and set the Multi-valued? field to True:

1. Click Administration on the menu bar
2. Click Server Administration, then click MARC Record Attributes
3. Double-click on the row of the record attribute definition that needs to be edited
4. Select the Multi-valued? checkbox
5. Click Save

Composite Record Attributes

Composite Record Attributes build on top of Evergreen’s ability to support record attributes that contain multiple entries. The Composite Record Attributes feature enables administrators to take
a record attribute definition and apply a more complicated and nested form of structure to that particular record attribute. Two new Record Attribute Definitions columns have been added to facilitate the management of the Composite Record Attributes. The Composite attribute? column designates whether or not a particular record attribute definition is also a composite record attribute. The Coded Value Maps column contains a Manage link in each row that allows users to manage the Coded Value Maps for the record attributes.

**Coded Value Maps**

To manage the Coded Value Maps of a particular record attribute definition, click the Manage link located under the Coded Value Maps column for that record attribute. This will open the Coded Value Maps interface. What administrators see on the Coded Value Maps screen does not define the structure of the composite record attribute; they must go into the Composite Attribute Entry Definitions screen to view this information.

Within the Coded Value Maps screen, there is a column named Composite Definition. The Composite Definition column contains a Manage link that allows users to configure and to edit Composite Record Attribute definitions. In order to enable the Manage link (i.e. have the Manage link display as an option under the Composite Definition column), the Composite attribute? column (located back in the Record Attributes Definition page) must be set to True.

To edit an existing record attribute definition and set the Composite attribute? field to True:

1. Click Administration on the menu bar
2. Click Server Administration, then click MARC Record Attributes
3. Double-click on the row of the record attribute definition that needs to be edited
4. Select the Composite attribute? checkbox
5. Click Save
Now that the Composite attribute? value is set to True, click on the Manage link located under the Coded Value Maps column for the edited record attribute definition. Back in the Coded Value Maps screen, a Manage link should now be exposed under the Composite Definition column. Clicking on a specific coded value’s Manage link will take the user into the Composite Attribute Entry Definitions screen for that specified coded value.

**Composite Attribute Entry Definitions**

The Composite Attribute Entry Definitions screen is where administrators can locally define and edit Composite Record Attributes for specific coded values. For example: administrators can further refine and distinguish the way a “book” should be defined within their database, by bringing together the right combination of attributes together to truly define what a “book” is in their database.

The top of the Composite Attribute Entry Definitions screen shows a parenthetically defined view of the Composite Data Expression. Below the Composite Data Expression is the Composite Data Tree. The Composite Data Tree is structured off of Boolean Operators, including the support of NOT operations. This nested form can be as deeply defined as it needs to be within the site’s database.

To modify the Composite Attribute Entry Definition, any Boolean Operator can be deleted or have a coded value appended to it. The appended coded value can be any number of Coded Value Maps from any other Record Attribute Definition. So, administrators can choose from all the other existing record attribute definitions and create new nested structures to define entirely new data types.
To modify the Composite Attribute Entry Definition:

1. Click Add Child for the specific Boolean Operator that needs to be modified, and a new window will open

2. Select which Record Attribute needs to be represented in the structure under that particular Boolean Operator

3. Select the Attribute Type from the dropdown options

4. Select the Value of the Attribute Type from the dropdown options (dropdown options will be based on the Attribute Type selected)

5. Click Submit

6. The Composite Data Expression should now include the modification

7. Once all modifications have been made, click Save Changes on the Composite Attribute Entry Definitions page

### Search and Icon Formats

#### Search and Icon Formats

The table below shows all the search and icon formats. In some cases they vary slightly, with the icon format being more restrictive. This is so that things such as a search for "All Books" will include Large Print books yet Large Print books will not show both a "Book" and "Large Print Book" icon.

In the table below "Icon Format Only" portions of the definition are italicized and in square brackets: [Icon format only data]

The definitions use the fixed field types at the end of this document.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Search Label/Icon Label</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Blu-ray" /></td>
<td>Blu-ray</td>
<td>VR Format:s</td>
</tr>
<tr>
<td><img src="image" alt="All books/Book" /></td>
<td>All books/Book</td>
<td>Item Type: a,t Bib Level: a,c,d,m</td>
</tr>
<tr>
<td>Item Form</td>
<td>NOT: Item Form: a,b,c,f,o,q,r,s [,.d]</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Braille</td>
<td>Item Type: a</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Form: f</td>
<td></td>
</tr>
<tr>
<td>Cassette audiobook</td>
<td>Item Type: i</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SR Format: I</td>
<td></td>
</tr>
<tr>
<td>Audiocassette music recording</td>
<td>Item Type: j</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SR Format: I</td>
<td></td>
</tr>
<tr>
<td>CD audiobook</td>
<td>Item Type: i</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SR Format: f</td>
<td></td>
</tr>
<tr>
<td>CD music recording</td>
<td>Item Type: j</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SR Format: f</td>
<td></td>
</tr>
<tr>
<td>DVD</td>
<td>VR Format: v</td>
<td></td>
</tr>
<tr>
<td>E-audio</td>
<td>Item Type: i</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Form: o,q,s</td>
<td></td>
</tr>
<tr>
<td>E-book</td>
<td>Item Type: a,t</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bib Level: a,c,d,m</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Form: o,q,s</td>
<td></td>
</tr>
<tr>
<td>Equipment, games, toys</td>
<td>Item Type: r</td>
<td></td>
</tr>
<tr>
<td>E-video</td>
<td>Item Type: g</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Form: o,q,s</td>
<td></td>
</tr>
<tr>
<td>Kit</td>
<td>Item Type: o,p</td>
<td></td>
</tr>
<tr>
<td>Large print book</td>
<td>Item Type: a,t</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bib Level: a,c,d,m</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Item Form: d</td>
<td></td>
</tr>
<tr>
<td>Map</td>
<td>Item Type: e,f</td>
<td></td>
</tr>
<tr>
<td>Microform</td>
<td>Item Form: a,b,c</td>
<td></td>
</tr>
<tr>
<td>All music/Music sound recording (unknown format)</td>
<td>Item Type: j</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[NOT: SR Format: a,b,c,d,e,f,l]</td>
<td></td>
</tr>
<tr>
<td>Phonograph music recording</td>
<td>Item Type: j</td>
<td></td>
</tr>
</tbody>
</table>
### Record Types

This table shows the record types currently used in determining elements of search and icon formats. They are based on a combination of the MARC Record Type (LDR 06) and Bibliographic Level (LDR 07) fixed fields.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>LDR 06</th>
<th>LDR 07</th>
</tr>
</thead>
<tbody>
<tr>
<td>BKS</td>
<td>a,t</td>
<td>a,c,d,m</td>
</tr>
<tr>
<td>MAP</td>
<td>e,f</td>
<td>a,b,c,d,i,m,s</td>
</tr>
<tr>
<td>MIX</td>
<td>p</td>
<td>c,d,i</td>
</tr>
<tr>
<td>REC</td>
<td>i,j</td>
<td>a,b,c,d,i,m,s</td>
</tr>
<tr>
<td>SCO</td>
<td>c,d</td>
<td>a,b,c,d,i,m,s</td>
</tr>
<tr>
<td>SER</td>
<td>a</td>
<td>b,i,s</td>
</tr>
<tr>
<td>VIS</td>
<td>g,k,r,o</td>
<td>a,b,c,d,i,m,s</td>
</tr>
</tbody>
</table>

### Fixed Field Types

This table details the fixed field types currently used for determining search and icon formats. See the record types section above for how the system determines them.

<table>
<thead>
<tr>
<th>Label</th>
<th>Record Type</th>
<th>Tag</th>
<th>Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Type</td>
<td>ANY</td>
<td>LDR</td>
<td>06</td>
</tr>
<tr>
<td>Bib Level</td>
<td>ANY</td>
<td>LDR</td>
<td>07</td>
</tr>
<tr>
<td>Item Format</td>
<td>BKS</td>
<td>006</td>
<td>06</td>
</tr>
<tr>
<td></td>
<td></td>
<td>008</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>MAP</td>
<td>006</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>008</td>
<td>29</td>
</tr>
</tbody>
</table>

Chapter 70. MARC Record Attributes

Report errors in this documentation using Launchpad.
Multilingual Search in Evergreen

It is now possible to search for items that contain multiple languages in the Evergreen catalog. This will help facilitate searching for bilingual and multilingual materials, including specific translations, alternative languages, and to exclude specific translations from a search.

To identify the language of materials, Evergreen looks at two different fields in the MARC bibliographic record:

- 008/35-37: the language code located in characters 35-37 of the 008 tag
- 041$abdefgm: the 041 tag, subfields $abdefgm, which contain additional language codes

Multilingual searches can be conducted by constructing searches using specific language codes as a filter. To search using specific language codes, use the Record Attribute Definition name item_lang followed by the appropriate MARC Code for Languages. For example, item_lang(spa) will search only for Spanish language materials.

The language filter can be appended to any search. For example, a title search for pippi longstocking item_lang(eng,swe) will search for English or Swedish language publications of the title.

Search Syntax

To search for materials that contain multiple languages (Boolean AND), the search filters can be constructed in the following ways:

1. Implicit Boolean filtering: item_lang(eng) item_lang(spa)
   
   a. Evergreen assumes a Boolean AND between the search filters
2. Explicit Boolean filtering: item_lang(eng) && item_lang(spa)
a. The double ampersands (&&) explicitly tell Evergreen to apply a Boolean AND to the search filters

To search for materials that contain at least one of the searched languages (Boolean OR), the search filters can be constructed in the following ways:

1. List filtering: item_lang(eng,spa)
   a. Listing the language codes, separated by a comma, within the search filter, tells Evergreen to apply a Boolean OR to the search filters

2. Explicit Boolean filtering: item_lang(eng) || item_lang(spa)
   a. The double pipes (||) explicitly tell Evergreen to apply a Boolean OR to the search filters

To search for materials that contain a specific language and exclude another language from the search results (Boolean NOT), the search filters can be constructed as follows:

1. Boolean filtering: item_lang(spa) -item_lang(eng)
   a. The dash (-) explicitly tells Evergreen to apply a Boolean NOT to the English language search filter. Evergreen assumes a Boolean AND between the search filters.

To exclude multiple languages from search results (Boolean NOT), the search filters can be constructed as follows:

1. Boolean filtering: -item_lang(eng) -item_lang(spa)
   a. The dash (-) explicitly tells Evergreen to apply a Boolean NOT to both search filters. Evergreen assumes a Boolean AND between the search filters.

To conduct a search for materials that do not contain at least of the of the languages searched (Boolean “NOT” and “OR”), the search filters can be constructed in the following ways:

1. List filtering: -item_lang(eng,spa)
   a. Explicit Boolean filtering: -item_lang(eng) || -item_lang(spa)

**Advanced Search**

Within the Advanced Search interface, multiple languages can be selected from the Language filter by holding down the Ctrl key on the keyboard and selecting the desired languages. This will apply a Boolean OR operator to the language filters.

**Adding Subfields to the Index**

Additional subfields for the 041 tag, such as h, j, k, and n, can be added to the index through the Record Attribute Definitions interface. Any records containing the additional subfields will need to be reingested into the database after making changes to the Record Attribute Definition.
1. Go to Administration>Server Administration>Record Attribute Definitions.

2. Click Next to locate the item_lang record attribute definition.

3. To edit the definition, double click on the item_lang row and the configuration window will appear.

4. In the MARC Subfields field, add the subfields you want included in the index.

5. Click Save.

Infrastructure Changes to Authority Browse

As part of a larger development and consulting project to improve how authority records are used in public catalog browse, improvements have been made to how authority records are indexed in Evergreen. This will not result in any direct changes to the public catalog, but will create infrastructure for improvements to the browse list. Specifically, a configuration table will be used to specify how browse entries from authority records should be generated. This new tables will supplement the existing authority control set configuration tables but will not replace them.

Backend functionality

The new configuration table, authority.heading_field, specifies how headings can be extracted from MARC21 authority records. The general mechanism is similar to how config.metabib_field specifies how bibliographic records should be indexed: the XML representation of the MARC21 authority record is first passed through a stylesheet specified by the authority.heading_field definition, then XPath expressions are used to extract the heading for generating browse entries for the authority.simple_heading and metabib.browse_entry tables.

The initial set of definitions supplied for authority.heading_field use the MARCXML to MADS 2.1 stylesheet; this helps ensure that heading strings extracted from authority records will match headings extracted from bibliographic records using the MODS stylesheet.

Staff User Interface

An interface for configuring authority headings is available in Server Administration in the web-based staff client, under the name "Authority Headings Fields".

When navigated to, the interface looks like this:

images::media/auth_browse_infra1.png[]

Individual heading field definitions can be edited like this:

images::media/auth_browse_infra2.png[]

The available fields are:
• Heading type: this can be personal_name, corporate_name, meeting_name, uniform_title, named_event, chronology_term, topical_term, geographic_name, genre_form_term, or medium_of_performance_term.

• Heading purpose: this can be main, related, or variant, corresponding to authority record 1XX, 5XX, or 4XX fields respectively.

• Heading field label: Label for use by administrators

• Heading XSLT Format: This core

• Heading XPath: Main XPath expression for selecting a part of the authority record to extract a heading from.

• Heading Component XPath: XPath express for selecting parts of a heading string from the elements selected by Heading XPath.

• Related/Variant Type XPath: Expression used, for variant and related headings, for identifying the specific purpose of the heading (e.g., broader term, narrower term, etc.).

• Thesaurus XPath: Expression used for extracting the thesaurus that controls the heading

• Thesaurus Override XPath: Expression used for identifying the thesaurus that controls a related heading.

• Joiner string: String used to stitch together components of the heading into a single display string. If not set, "—" is used.

It should be noted that unless one has non-standard authority records, it is recommended that changes to the authority heading field definitions be minimized.

Virtual Index Definitions

Virtual index definitions can be configured in Evergreen to create customized search indexes that make use of data collected by other (real) index definitions. Real index definitions use an XPath expression to indicate the bibliographic data that should be included in the index. Virtual index definitions bring together data collected by other index definitions to create a new, virtual index. They can also use an XPath expression to collect data directly for an index, but they are not required to.

All index definitions can be modified by having other indexes map to them. For example, Genre could be added to the All Subjects field definition in the Subject index. This would allow users to search Genre as part of a Subject search.

Keyword Virtual Index Definition

Evergreen now uses a virtual index definition for the Keyword index. This allows libraries to customize the keyword search index by specifying which fields are included in the keyword index, as well as how each field should be weighted for relevance ranking in search results. By default, the keyword index contains all of the search fields other than the keyword definition itself. Each field is assigned a weight of 1, with the exception of Title Proper, which is assigned a weight of 8.
A match on the Title Proper within a keyword search will be given the higher weight and therefore a higher relevance ranking within search results.

1. To view the stock virtual index definition for keyword searches, go to Administration>Server Administration>MARC Search/Facet Fields and select the Keyword Search Class.

2. Locate the field labeled "All searchable fields". This is the general keyword index.

3. The weight of a field can be modified by selecting the field and going to Actions>Edit Record or right-clicking and selecting Edit Record.

   a. The Metabib Field Virtual Map modal will appear. Increase the weight of the field and click Save.

### Configuring Virtual Index Definitions

1. To configure a virtual index definition, go to Administration>Server Administration>MARC Search/Facet Fields.

   a. This interface now has a Search Class filter that allows users to easily select which search class they want to view.

2. Next, locate the field for which you want to create a virtual index definition and click Manage under the column labeled Data Suppliers.

1. A new tab will open that contains the interface for configuring a virtual index definition. This interface can be used to map real index definitions for inclusion in the virtual index.

1. To create a mapping, click New Record. A modal called Metabib Field Virtual Map will appear.

2. Select the Real index definition and the Virtual index definition to which it should be mapped.

3. Assign a Weight to the mapping. This allows Evergreen to calculate the weight that should be applied to each field when searched using the virtual index.

   a. The weight assigned to a field within a virtual index can be different than the weight assigned when searching that field directly. For example, the Title Proper field can have a weight of 2 when a user performs a Title search, but a weight of 5 when a user performs a Keyword search (using the virtual index). This can help move title matches on keyword searches higher up in the search results list.

4. Click Save.

5. Repeat steps 4-7 until all desired fields are mapped to the virtual index definition.

Note: A service restart is required after definitions and mapping are changed. Changes to weight only do not require a restart as they are calculated in real time.
Search Term Highlighting in Search Results

Search terms are now highlighted on the main OPAC search results page, the bibliographic record detail page, and the metarecord grouped results page. This will help users discern why a certain record was included in the search result set, as well as its relevance to the search. Search terms will be highlighted in both real and virtual fields that were searched. Terms that were stemmed or normalized during searching will also be highlighted. Search term highlighting can be turned off within the OPAC by selecting the checkbox to "Disable Highlighting" in the search results interface.

A keyword search for "piano" returns a set of search results:

The search term is highlighted in the search results and indicates why the records were included in the search result set. In this example, the search results interface shows the first three records had matching terms in the title field.

Within the record detail page for "The five piano concertos", we can see the search term also matched on the General Note and Subject fields within the bibliographic record.
Chapter 71. Org Unit Proximity Adjustments

Org Unit Proximity Adjustments

Org Unit Proximity Adjustments allow libraries to indicate lending preferences for holds between libraries in an Evergreen consortium. When a hold is placed in Evergreen, the hold targeter looks for copies that can fill the hold. One factor that the hold targeter uses to choose the best copy to fill the hold is the distance, or proximity, between the capturing library and the pickup library for the request. The proximity is based on the number of steps through the org tree that it takes to get from one org unit to another.

![Org Unit Proximity Diagram]

Org Unit Proximity between BR1 and BR4 = 4

Org Unit Proximity Adjustments allow libraries to customize the distances between org units, which provides more control over which libraries are looked at when targeting copies to fill a hold. Evergreen can also be configured to take Org Unit Proximity Adjustments into account during opportunistic capture through the creation of a custom Best-Hold Selection Sort Order. See documentation <here> for more information on Best-Hold Selection Sort Order.

An Org Unit Proximity Adjustment can be created to tell Evergreen which libraries to look at first for copies to fill a hold or which library to look at last. This may be useful for accounting for true transit costs or physical distances between libraries. It can also be used to identify libraries that have special lending agreements or preferences. Org Unit Proximity Adjustments can be created...
for all holds between two org units, or they can be created for holds on specific Copy Locations and Circulation Modifiers.

### Absolute and Relative Adjustments

Two types of proximity adjustments can be created in Evergreen: Absolute adjustments and Relative adjustments.

Absolute proximity adjustments allow you to replace the default proximity distance between two org units. An absolute adjustment could be made to tell the hold targeter to look at a specific library or library system first to find an item to fill a hold, before looking elsewhere in the consortium.

Relative proximity adjustments allows the proximity between org units to be treated as closer or farther from one another than the default distance. A relative proximity adjustment could be used to identify a library that has limited hours or slow transit times to tell the hold targeter to look at that library last for copies to fill a hold.

### Create an Org Unit Proximity Adjustment

To create an Org Unit Proximity Adjustment between two libraries:

1. In the Administration menu choose Server Administration → Org Unit Proximity Adjustments.
2. Click New OU Proximity Adjustment.
3. Choose an Item Circ Lib from the drop down menu.
4. Choose a Hold Request Lib from the drop down menu.
5. If this proximity adjustment applies to a specific copy location, select the appropriate Copy Location from the drop down menu.
6. If this proximity adjustment applies to a specific material type, select the appropriate Circ Modifier from the drop down menu.
7. If this is an Absolute proximity adjustment, check the box next to Absolute adjustment? If you leave the box blank, a relative proximity adjustment will be applied.
8. Enter the Proximity Adjustment between the Item Circulating Library and the Request Library.
9. Click Save.
This will create a one-way proximity adjustment between Org Units. In this example this adjustment will apply to items requested at by a patron BR4 and filled at BR1. To create the reciprocal proximity adjustment, for items requested at BR1 and filled at BR4, create a second proximity adjustment between the two Org Units.

**Permissions to use this Feature**

To create Org Unit Proximity Adjustments, you will need the following permission:

- ADMIN_PROXIMITY_ADJUSTMENT
Chapter 72. Administering the Physical Characteristics Wizard

The MARC 007 Field Physical Characteristics Wizard enables catalogers to interact with a database wizard that leads the user step-by-step through the MARC 007 field positions. The wizard displays the significance of the current position and provides dropdown lists of possible values for the various components of the MARC 007 field in a more user-friendly way.

The information driving the MARC 007 Field Physical Characteristics Wizard is already a part of the Evergreen database. This data can be customized by individual sites and/or updated when the Library of Congress dictates new values or positions in the 007 field. There are three relevant tables where the information that drives the wizard is stored:

1. config.marc21_physical_characteristic_type_map contains the list of materials, or values, for the positions of the 007 field.

2. config.marc21_physical_characteristic_subfield_map contains rows that list the meaning of the various positions in the 007 field for each Category of Material.

3. config.marc21_physical_characteristic_value_map lists all of the values possible for all of the positions in the config.marc21_physical_characteristic_subfield_map table.
Chapter 73. User and Group Permissions

It is essential to understand how user and group permissions can be used to allow staff to fulfill their roles while ensuring that they only have access to the appropriate level.

Permissions in Evergreen are applied to a specific location and system depth based on the home library of the user. The user will only have that permission within the scope provided by the Depth field in relation to his/her working locations.

Evergreen provides group application permissions in order to restrict which staff members have the ability to assign elevated permissions to a user, and which staff members have the ability to edit users in particular groups.

Staff Accounts

New staff accounts are created in much the same way as patron accounts, using Circulation → Register Patron or Shift+F1. Select one of the staff profiles from the Profile Group drop-down menu.

Each new staff account must be assigned a Working Location which determines its access level in staff client interfaces.

1. To assign a working location, open the newly created staff account using F1 (retrieve patron) or F4 (patron search).

2. Select Other → User Permission Editor
3. Place a check in the box next to the desired working location, then scroll to the bottom of the display and click Save.

In multi-branch libraries it is possible to assign more than one working location.

Staff Account Permissions

To view a detailed list of permissions for a particular Evergreen account go to Administration → User Permission Editor in the staff client.

Granting Additional Permissions

A Local System Administrator (LSA) may selectively grant LSA permissions to other staff accounts. In the example below a Circ + Full Cat account is granted permission to process offline transactions, a function which otherwise requires an LSA login.

1. Log in as a Local System Administrator.

2. Select Administration → User Permission Editor and enter the staff account barcode when prompted.

   OR

   Retrieve the staff account first, then select Other → User Permission Editor

3. The User Permission Editor will load (this may take a few seconds). Greyed-out permissions cannot be edited because they are either a) already granted to the account, or b) not available to any staff account, including LSAs.
1) List of permission names.

2) If checked the permission is granted to this account.

3) Depth limits application to the staff member’s library and should be left at the default.

4) If checked this staff account will be able to grant the new privilege to other accounts (not recommended).

4. To allow processing of offline transactions check the Applied column next to OFFLINE_EXECUTE.

5. Scroll down and click Save to apply the changes.
<table>
<thead>
<tr>
<th>group_application.user.vendor</th>
<th>Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>money.collections_tracker.create</td>
<td>Library</td>
</tr>
<tr>
<td>money.collections_tracker.delete</td>
<td>Library</td>
</tr>
</tbody>
</table>
Chapter 74. SMS Text Messaging

The SMS Text Messaging feature enables users to receive hold notices via text message. Users can opt-in to this hold notification as their default setting for all holds, or they can receive specific hold notifications via text message. Users can also send call numbers and copy locations via text message.

Administrative Setup

You cannot receive text messages from Evergreen by default. You must enable this feature to receive hold notices and copy information from Evergreen via text message.

Enable Text Messages

1. Click Administration → Local Administration → Library Settings Editor.
2. Select the setting, Enable features that send SMS text messages.
3. Set the value to True, and click Update Setting.

Authenticate Patrons

By default, you must be logged into your OPAC account to send a text message from Evergreen. However, if you turn on this setting, you can text message copy information without having to login to your OPAC account.

To disable the patron login requirement:

1. Click Administration → Local Administration → Library Settings Editor.
2. Select the setting, Disable auth requirement for texting call numbers.

3. Set the value to True, and click Update Setting.

Configure SMS Carriers

A list of SMS carriers that can transmit text messages to users is available in the staff client. Library staff can edit this list, or add new carriers.

To add or edit SMS carriers:

1. Click Administration → Server Administration → SMS Carriers.

2. To add a new carrier, click the New Carrier button in the top right corner of the screen. To edit an existing carrier, double click in any white space in the carrier’s row.

3. Enter a (geographical) Region.

4. Enter the carrier’s Name.

5. Enter an Email Gateway. The SMS carrier can provide you with the content for this field. The $number field is converted to the user’s phone number when the text message is generated.
6. Check the Active box to use this SMS Carrier.

Configure Text Message Templates

Library staff control the content and format of text messages through the templates in Notifications/Action Triggers. Patrons cannot add free text to their text messages.

To configure the text of the SMS text message:

1. Click Administration → Local Administration → Notifications/Action Triggers.

2. Create a new A/T and template, or use or modify an existing template. For example, a default template, “Hold Ready for Pickup SMS Notification,” notifies users that the hold is ready for pickup.

3. You can use the default template, or you can edit the template and add content specific to your library. Click the hyperlinked name to edit the Event Environment and Event Parameters. Or double-click the row to edit the hold notice.
Receiving Holds Notices via Text Message

You can receive notification that your hold is ready for pickup from a text message that is sent to your mobile phone.

1. Login to your account.

![Login to Your Account](image)

2. Search the catalog.

3. Retrieve a record, and click the Place Hold link.

4. Select the option to retrieve hold notification via text message.

5. Choose an SMS Carrier from the drop down menu. NOTE: You can enter your SMS carrier and phone number into your Account Preferences to skip steps five and six.
6. Enter a phone number.

7. Click Submit.

Sending Copy Details via Text Message

You can search the catalog for an item, and, after retrieving results for the item, click a hyperlink to send the copy information in a text message.

1. Login to your account in the OPAC. NOTE: If you have disabled the setting that requires patron login, then you do not have to login to their accounts to send text messages. See Administrative Setup for more information.

2. Search the catalog, and retrieve a title with copies.

3. Click the Text link next to the call number.
4. The text of the SMS Text Message appears.

5. Choose an SMS Carrier from the drop down menu. NOTE: You can enter your SMS carrier and phone number into your Account Preferences to skip steps five and six.

6. Enter a phone number.

7. Click Submit. NOTE: Message and data rates may apply.

8. The number and carrier are converted to an email address, and the text message is sent to your mobile phone. The following confirmation message will appear.
Permissions to use this Feature

ADMIN_SMS_CARRIER - Enables users to add/create/delete SMS Carrier entries.
Chapter 75. User Activity Types

The User Activity Types feature enables you to specify the user activity that you want to record in the database. You can use this feature for reporting purposes. This function will also display a last activity date in a user’s account.

Enabling this Feature

Click Administration → Server Administration → User Activity Types to access the default set of user activity types and to add new ones. The default set of user activity types records user logins to the Evergreen ILS and to third party products that communicate with Evergreen.

The Label is a free text field that enables you to describe the activity that you are tracking.

The Event Caller describes the third party software or Evergreen interface that interacts with the Evergreen database and is responsible for managing the communication between the parties.

The Event Type describes the type of activity that Evergreen is tracking. Currently, this feature only tracks user authentication.

The Event Mechanism describes the framework for communication between the third party software or OPAC and the database. Enter an event mechanism if you want to track the means by which the software communicates with the database. If you do not want to track how the softwares communicate, then leave this field empty.

The Enabled field allows you to specify which types of user activity that you would like to track.

The Transient column enables you to decide how many actions you want to track. If you want to track only the last activity, then enter True. If you want to trace all activity by the user, enter False.

Using this Feature

The last activity date for user logins appears in the patron’s summary.
Chapter 76. Z39.50 Servers

Restrict Z39.50 Sources by Permission Group

In Evergreen versions preceding 2.2, all users with cataloging privileges could view all of the Z39.50 servers that were available for use in the staff client. In Evergreen version 2.2, you can use a permission to restrict users' access to Z39.50 servers. You can apply a permission to the Z39.50 servers to restrict access to that server, and then assign that permission to users or groups so that they can access the restricted servers.

Administrative Settings

You can add a permission to limit use of Z39.50 servers, or you can use an existing permission.

You must be authorized to add permission types at the database level to add a new permission.

Add a new permission:

1) Create a permission at the database level.
2) Click Administration → Server Administration → Permissions to add a permission to the staff client.
3) In the New Permission field, enter the text that describes the new permission.
4) Click Add.
5) The new permission appears in the list of permissions.

Restrict Z39.50 Sources by Permission Group

1) Click Administration → Server Administration → Z39.50 Servers
2) Click New Z39.50 Server, or double click on an existing Z39.50 server to restrict its use.
3) Select the permission that you added to restrict Z39.50 use from the drop down menu.
4) Click Save.

5) Add the permission that you created to a user or user group so that they can access the restricted server.

6) Users that log in to the staff client and have that permission will be able to see the restricted Z39.50 server.

As an alternative to creating a new permission to restrict use, you can use a preexisting permission. For example, your library uses a permission group called SuperCat, and only...
members in this group should have access to a restricted Z39.50 source. Identify a permission that is unique to the SuperCat group (e.g. CREATE_MARC) and apply that permission to the restricted Z39.50 server. Because these users are in the only group with the permission, they will be the only group w/ access to the restricted server.

Storing Z39.50 Server Credentials

Staff have the option to apply Z39.50 login credentials to each Z39.50 server at different levels of the organizational unit hierarchy. Credentials can be set at the library branch or system level, or for an entire consortium. When credentials are set for a Z39.50 server, searches of the Z39.50 server will use the stored credentials. If a staff member provides alternate credentials in the Z39.50 search interface, the supplied credentials will override the stored ones. Staff have the ability to apply new credentials or clear existing ones in this interface. For security purposes, it is not possible for staff to retrieve or report on passwords.

To set up stored credentials for a Z39.50 server:

1) Go to Administration → Server Administration → Z39.50 Servers.

2) Select a Z39.50 Source by clicking on the hyperlinked source name. This will take you the Z39.50 Attributes for the source.

3) At the top of the screen, select the org unit for which you would like to configure the credentials.

4) Enter the Username and Password, and click Apply Credentials.
Part VII. Local Administration
Table of Contents

77. Introduction .................................................................................................................. 336
78. Library Settings Editor .................................................................................................. 337
   Introduction .................................................................................................................... 337
   Editing Library Settings ................................................................................................. 337
   Exporting/Importing Library Settings ............................................................................. 338
   Settings Overview ........................................................................................................... 339
   Data Types ....................................................................................................................... 340
79. Address Alert .................................................................................................................. 382
   General Usage Examples ............................................................................................... 382
   Access Control and Scoping ......................................................................................... 382
   Adding a new Address Alert ......................................................................................... 383
   Editing an Address Alert .............................................................................................. 383
   Deleting an Address Alert ............................................................................................ 384
   Staff View of Address Alerts ...................................................................................... 384
   Regular Expressions / Wildcards .................................................................................. 384
   Examples ......................................................................................................................... 384
   Development .................................................................................................................. 385
80. Barcode Completion ....................................................................................................... 386
   Scoping and Permissions ............................................................................................... 386
   Access Points .................................................................................................................. 386
   Check Out Step 1: Lookup Patron by Barcode .............................................................. 387
   Check Out Step 2: Scanning Item Barcodes .................................................................... 387
   Staff Client Place Hold from Catalog ............................................................................ 387
   Check In ............................................................................................................................ 388
   Item Status ....................................................................................................................... 388
   Multiple Matches ............................................................................................................ 388
   Barcode Completion Data Fields .................................................................................... 389
   Create, Update, Filter, Delete/Disable Rules .................................................................. 390
   Create Rules .................................................................................................................... 390
   Update Rules .................................................................................................................... 390
   Filter Rules ....................................................................................................................... 391
   Delete/Disable Rules ....................................................................................................... 391
   Examples ........................................................................................................................... 391
   Barcode With Prefix and Padding .................................................................................. 391
   Barcode With Suffix ........................................................................................................ 391
   Barcode With Left Padding ............................................................................................ 392
   Barcode With Right Padding ......................................................................................... 392
   Barcode of any Length with Prefix and Suffix ............................................................... 393
   Testing ............................................................................................................................... 393
81. Hold-driven recalls ......................................................................................................... 394
   Enabling hold-driven recalls ....................................................................................... 394
   Editing the item recall notification email template ..................................................... 394
82. Notifications / Action Triggers ....................................................................................... 395
   Introduction ...................................................................................................................... 395
   Event Definitions ............................................................................................................. 395
   Table 1: Action Trigger Event Definitions ..................................................................... 395
   Creating Action Triggers ................................................................................................. 396
   Cloning Existing Action Triggers .................................................................................. 398
   Editing Action Triggers .................................................................................................. 398
   Deleting Action Triggers ............................................................................................... 398
   Testing Action Triggers .................................................................................................. 398

Part VII. Local Administration 334
Chapter 77. Introduction

This part covers the options in the Local Administration menu found in the staff client.
Chapter 78. Library Settings Editor

Introduction

With the Library Settings Editor one can optionally customize Evergreen’s behavior for a particular library or library system. For descriptions of available settings see the Settings Overview table below.

Editing Library Settings

1. To open the Library Settings Editor select Admin → Local Administration → Library Settings Editor.

2. Settings having effects on the same function or module are grouped together. You may browse the list or search for the entry you want to edit. Type in your search term in the filter box. You may clear or re-apply the filter by clicking Clear Filter or Filter.

3. To edit an entry click Edit in the line.

4. Read the instruction in the pop-up window. Make the change. Click Update Setting to save the change. Click Delete Setting if you wish to delete it.
5. Click History to view the previous values, if any, of a setting. You can revert back to an old value by clicking revert.

### History

<table>
<thead>
<tr>
<th>Date Changed</th>
<th>Location</th>
<th>Original Value</th>
<th>New Value</th>
<th>Revert</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012-06-01T15:59:49-0700</td>
<td>BW</td>
<td>&quot;1 hours&quot;</td>
<td>&quot;5 hours&quot;</td>
<td>Revert</td>
</tr>
<tr>
<td>2012-06-01T15:59:42-0700</td>
<td>BW</td>
<td>&quot;1 hours&quot;</td>
<td>&quot;1 hours&quot;</td>
<td>Revert</td>
</tr>
<tr>
<td>2012-06-01T15:41:08-0700</td>
<td>BW</td>
<td>&quot;3 hours&quot;</td>
<td>&quot;1 hours&quot;</td>
<td>Revert</td>
</tr>
</tbody>
</table>

Please note that different settings may require different data formats, which are listed in the [Settings Overview] table. Refer to the [Data Types] table at the bottom of this page for more information.

## Exporting/Importing Library Settings

1. To export library settings, click the Export button on the above Library Setting Editor screen. Click Copy in the pop-up window. Those settings displayed on the screen are copied to the clipboard. Paste the contents to a text editor, such as Notepad. Save the file on your computer.

### Export

Copy this to your clipboard and save it to a file to export the settings.

```json
{"circ.offline.skip_checkout_if_newer_status_changed_time":
{"org":"10","value":null},
"circ.claim_return.copy_status":
{"org":1,"value":"107"},
"cat.default_copy_status_normal":
{"org":10,"value":"9"},
"circ.holds.clear_shelf.copy_status":
{
"org":10,"value":null},
"circ.offline.skip_checkin_if_newer_status_changed_time":
{"org":10,"value":null},
"circ.missing_pieces.copy_status":
{
"org":10,"value":null},
"circ.selfcheck.block_checkout_on_copy_status"
{
"org":10,"value":null},
"cat.default_copy_status_fast":
```

[Launchpad]
2. To import library settings, click the Import button on the Library Settings Editor screen. Open your previously saved file and copy the contents. Click Paste in the pop-up window. Click Submit.

---

**Settings Overview**

The settings are grouped together in separate tables based on functions and modules, which are affected by the setting. They are in the same sequence as you see in the staff client. Each table describes the available settings in the group and shows which can be changed on a per-library basis. At the bottom is the table with a list of **data types** with details about acceptable settings values.

**Table 78.1. Acquisitions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow funds to be rolled over without bringing money along</td>
<td>Allow funds to be rolled over without bringing the money along. This makes money left in the old fund disappear, modeling its return to some outside entity.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Allows patrons to create automatic holds from purchase requests.</td>
<td>Allows patrons to create automatic holds from purchase requests.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>Default circulation modifier</td>
<td>Sets the default circulation modifier for use in acquisitions.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Default copy location</td>
<td>Sets the default copy location (shelving location) for use in acquisitions.</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Fund Spending Limit for Block</td>
<td>When the amount remaining in the fund, including spent money and encumbrances, goes below this percentage, attempts to spend from the fund will be blocked.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Fund Spending Limit for Warning</td>
<td>When the amount remaining in the fund, including spent money and encumbrances, goes below this percentage, attempts to spend from the fund will result in a warning to the staff.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Rollover Distribution Formulae Funds</td>
<td>During fiscal rollover, update distribution formulae to use new funds</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Set copy creator as receiver</td>
<td>When receiving a copy in acquisitions, set the copy &quot;creator&quot; to be the staff that received the copy</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Temporary barcode prefix</td>
<td>Temporary barcode prefix added to temporary item records.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Temporary call number prefix</td>
<td>Temporary call number prefix</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Upload Activate PO</td>
<td>Activate the purchase order by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Upload Create PO</td>
<td>Create a purchase order by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Upload Default Insufficient Quality Fall-Thru Profile</td>
<td>Default low-quality fall through profile used during ACQ file upload</td>
<td>Selection List</td>
<td>Match Only Merge and Full Overlay are the selections.</td>
</tr>
<tr>
<td>Upload Default Match Set</td>
<td>Default match set to use during ACQ file upload</td>
<td>Selection List</td>
<td>Can be set to authority test or biblio</td>
</tr>
<tr>
<td>Upload Default Merge Profile</td>
<td>Default merge profile to use during ACQ file upload</td>
<td>Selection List</td>
<td>Match Only Merge and Full Overlay are the selections.</td>
</tr>
<tr>
<td>Upload Default Min. Quality Ratio</td>
<td>Default minimum quality ratio used during ACQ file upload</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Upload Default Provider</td>
<td>Default provider to use during ACQ file upload</td>
<td>Selection List</td>
<td>This list is populated by your Providers.</td>
</tr>
<tr>
<td>Upload Import Non Matching by Default</td>
<td>Import non-matching records by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Upload Load Items for Imported Records by Default</td>
<td>Load items for imported records by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Upload Merge on Best Match by Default</td>
<td>Merge records on best match by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Upload Merge on Exact Match by Default</td>
<td>Merge records on exact match by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Upload Merge on Single Match by Default</td>
<td>Merge records on single match by default during ACQ file upload</td>
<td>True/False</td>
<td></td>
</tr>
</tbody>
</table>

**Table 78.2. Booking and Cataloging**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow email notify</td>
<td>Permit email notification when a reservation is ready for pick-up.</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Elbow room</td>
<td>Elbow room specifies how far in the future you must make a reservation on an item if that item will have to transit to reach its pick-up location. It secondarily defines how soon a reservation on a given item must start before the check-in process will opportunistically capture it for the reservation shelf.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Default Classification Scheme</td>
<td>Defines the default classification scheme for new call numbers: 1 = Generic; 2 = Dewey; 3 = LC</td>
<td>Number</td>
<td>It has effect on call number sorting.</td>
</tr>
<tr>
<td>Default copy status (fast add)</td>
<td>Default status when a copy is created using the &quot;Fast Item Add&quot; interface.</td>
<td>Selection list</td>
<td>Default: In process</td>
</tr>
<tr>
<td>Default copy status (normal)</td>
<td>Default status when a copy is created using the normal volume/copy creator interface.</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Defines the control number identifier used in 003 and 035 fields</td>
<td></td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Delete bib if all copies are deleted via Acquisitions line item cancellation.</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Delete volume with last copy</td>
<td>Automatically delete a volume when the last linked copy is deleted.</td>
<td>True/False</td>
<td>Default TRUE</td>
</tr>
<tr>
<td>Maximum Parallel Z39.50 Batch Searches</td>
<td>The maximum number of Z39.50 searches that can be in-flight at any given time when performing batch Z39.50 searches</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>Maximum Z39.50 Batch Search Results</td>
<td>The maximum number of search results to retrieve and queue for each record + Z39 source during batch Z39.50 searches</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Spine and pocket label font family</td>
<td>Set the preferred font family for spine and pocket labels. You can specify a list of fonts, separated by commas, in order of preference; the system will use the first font it finds with a matching name. For example, &quot;Arial, Helvetica, serif&quot;.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Spine and pocket label font size</td>
<td>Set the default font size for spine and pocket labels</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Spine and pocket label font weight</td>
<td>Set the preferred font weight for spine and pocket labels. You can specify &quot;normal&quot;, &quot;bold&quot;, &quot;bolder&quot;, or &quot;lighter&quot;.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Spine label left margin</td>
<td>Set the left margin for spine labels in number of characters.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Spine label line width</td>
<td>Set the default line width for spine labels in number of characters. This specifies the boundary at which lines must be wrapped.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Spine label maximum lines</td>
<td>Set the default maximum number of lines for spine labels.</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>
Table 78.3. Circulation

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-extend grace periods</td>
<td>When enabled grace periods will auto-extend. By default this will be only when they are a full day or more and end on a closed date, though other options can alter this.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Auto-extending grace periods extend for all closed dates</td>
<td>It works when the above setting &quot;Auto-Extend Grace Periods&quot; is set to TRUE. If enabled, when the grace period falls on a closed date(s), it will be extended past all closed dates that intersect, but within the hard-coded limits (your library’s grace period).</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Auto-extending grace periods include trailing closed dates</td>
<td>It works when the above setting &quot;Auto-Extend Grace Periods&quot; is set to TRUE. If enabled, grace periods will include closed dates that directly follow the last day of the grace period. A backdated check-in with effective date on the closed dates will assume the item is returned after hours on the last day of the grace period.</td>
<td>True/False</td>
<td>Useful when libraries' book drop equipped with AMH.</td>
</tr>
<tr>
<td>Block hold request if hold recipient privileges have expired</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Cap max fine at item price</td>
<td>This prevents the system from charging more than the item price in overdue fines</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>Charge fines on overdue circulations when closed</td>
<td>When set to True, fines will be charged during scheduled closings and normal weekly closed days.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Checkout fills related hold</td>
<td>When a patron checks out an item and they have no holds that directly target the item, the system will attempt to find a hold for the patron that could be fulfilled by the checked out item and fulfills it. On the Staff Client you may notice that when a patron checks out an item under a title on which he/she has a hold, the hold will be treated as filled though the item has not been assigned to the patron’s hold.</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Checkout fills related hold on valid copy only</td>
<td>When filling related holds on checkout only match on items that are valid for opportunistic capture for the hold. Without this set a Title or Volume hold could match when the item is not holdable. With this set only holdable items will match.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Checkout auto renew age</td>
<td>When an item has been checked out for at least this amount of time, an attempt to check out the item to the patron that it is already checked out to will simply renew the circulation. If the checkout attempt is</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>done within this time frame, Evergreen will prompt for choosing Renewing or Check-in then Checkout the item.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display copy alert for in-house-use</td>
<td>Setting to true for an organization will cause an alert to appear with the copy’s alert message, if it has one, when recording in-house-use for the copy.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Display copy location check in alert for in-house-use</td>
<td>Setting to true for an organization will cause an alert to display a message indicating that the item needs to be routed to its location if the location has check in alert set to true.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Do not change fines/fees on zero-balance LOST transaction</td>
<td>When an item has been marked lost and all fines/fees have been completely paid on the transaction, do not void or reinstate any fines/fees EVEN IF &quot;Void lost item billing when returned&quot; and/or &quot;Void processing fee on lost item return&quot; are enabled</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Do not include outstanding Claims Returned circulations in lump sum tallies in Patron Display.</td>
<td>In the Patron Display interface, the number of total active circulations for a given patron is presented in the Summary sidebar and underneath the Items Out navigation button. This setting will prevent Claims Returned circulations</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>Hold shelf status delay</td>
<td>The purpose is to provide an interval of time after an item goes into the on-holds-shelf status before it appears to patrons that it is actually on the holds shelf. This gives staff time to process the item before it shows as ready-for-pick-up.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Include Lost circulations in lump sum tallies in Patron Display.</td>
<td>In the Patron Display interface, the number of total active circulations for a given patron is presented in the Summary sidebar and underneath the Items Out navigation button. This setting will include Lost circulations as counting toward these tallies.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Invalid patron address penalty</td>
<td>When set, if a patron address is set to invalid, a penalty is applied.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Item status for missing pieces</td>
<td>This is the Item Status to use for items that have been marked or scanned as having Missing Pieces. In the absence of this setting, the Damaged status is used.</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Load patron from Checkout</td>
<td>When scanning barcodes into Checkout auto-detect if a new patron barcode is scanned and auto-load the new patron.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>Long-Overdue Check-In Interval Uses Last Activity Date</td>
<td>Use the long-overdue last-activity date instead of the due_date to determine whether the item has been checked out too long to perform long-overdue check-in processing. If set, the system will first check the last payment time, followed by the last billing time, followed by the due date. See also &quot;Long-Overdue Max Return Interval&quot;</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Long-Overdue Items Usable on Checkin</td>
<td>Long-overdue items are usable on check-in instead of going &quot;home&quot; first</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Long-Overdue Max Return Interval</td>
<td>Long-overdue check-in processing (voiding fees, re-instating overdues, etc.) will not take place for items that have been overdue for (or have last activity older than) this amount of time</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Lost check-in generates new overdues</td>
<td>Enabling this setting causes retroactive creation of not-yet-existing overdue fines on lost item check-in, up to the point of check-in time (or max fines is reached). This is different than &quot;restore overdue on lost&quot;, because it only creates new overdue fines. Use both settings together to get the full complement of overdue fines for a lost item</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Lost items usable on checkin</td>
<td>Lost items are usable on checkin instead of going home first</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Max patron claims returned count</td>
<td>When this count is exceeded, a staff override is required to mark the item as claims returned.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Maximum visible age of User Trigger Events in Staff Interfaces</td>
<td>If this is unset, staff can view User Trigger Events regardless of age. When this is set to an interval, it represents the age of the oldest possible User Trigger Event that can be viewed.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Minimum transit checkin interval</td>
<td>In-Transit items checked in this close to the transit start time will be prevented from checking in</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Number of Retrievable Recent Patrons</td>
<td>Number of most recently accessed patrons that can be re-retrieved in the staff client. A value of 0 or less disables the feature. Defaults to 1.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Patron merge address delete</td>
<td>Delete address(es) of subordinate user(s) in a patron merge.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Patron merge barcode delete</td>
<td>Delete barcode(s) of subordinate user(s) in a patron merge.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Patron merge deactivate card</td>
<td>Mark barcode(s) of subordinate user(s) in a patron merge as inactive.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Patron Registration: Cloned patrons get address copy</td>
<td>If True, in the Patron editor, addresses are copied from the cloned user. If False, addresses are linked from the cloned user.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>Printing: custom JavaScript file</td>
<td>Full URL path to a JavaScript File to be loaded when printing. Should implement a print_custom function for DOM manipulation. Can change the value of the do_print variable to false to cancel printing.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Require matching email address for password reset requests</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Restore Overdues on Long-Overdue Item Return</td>
<td>If true when a lost item is checked in overdue fines are charged (up to the maximum fines amount)</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Specify search depth for the duplicate patron check in the patron editor</td>
<td>When using the patron registration page, the duplicate patron check will use the configured depth to scope the search for duplicate patrons.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Suppress hold transits group</td>
<td>To create a group of libraries to suppress Hold Transits among them. All libraries in the group should use the same unique value. Leave it empty if transits should not be suppressed.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Suppress non-hold transits group</td>
<td>To create a group of libraries to suppress Non-Hold Transits among them. All</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Suppress popup-dialogs during check-in.</td>
<td>When set to True, no pop-up window for exceptions on check-in. But the accompanying sound will be played.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Target copies for a hold even if copy’s circ lib is closed</td>
<td>If this setting is true at a given org unit or one of its ancestors, the hold targeter will target copies from this org unit even if the org unit is closed (according to the Org Unit’s closed dates.).</td>
<td>True/False</td>
<td>Set the value to True if you want to target copies for holds at closed circulating libraries. Set the value to False, or leave it unset, if you do not want to enable this feature.</td>
</tr>
<tr>
<td>Target copies for a hold even if copy’s circ lib is closed IF the circ lib is the hold’s pickup lib</td>
<td>If this setting is true at a given org unit or one of its ancestors, the hold targeter will target copies from this org unit even if the org unit is closed (according to the Org Unit’s closed dates) IF AND ONLY IF the copy’s circ lib is the same as the hold’s pickup lib.</td>
<td>True/False</td>
<td>Set the value to True if you want to target copies for holds at closed circulating libraries when the circulating library of the item and the pickup library of the hold are the same. Set the value to False, or leave it unset, if you do not want to enable this feature.</td>
</tr>
<tr>
<td>Truncate fines to max fine amount</td>
<td></td>
<td>True/False</td>
<td>Default: TRUE</td>
</tr>
<tr>
<td>Use Lost and Paid copy status</td>
<td>Use Lost and Paid copy status when lost or long overdue billing is paid</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void Long-Overdue Item Billing When Returned</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void Processing Fee on Long-Overdue Item Return</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Void longoverdue item billing when claims returned</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void longoverdue item processing fee when claims returned</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void lost item billing when claims returned</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void lost item billing when returned</td>
<td>If true, when a lost item is checked in the item replacement bill (item price) is voided.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void lost item processing fee when claims returned</td>
<td>When an item is marked claims returned that was marked Lost, the item processing fee will be voided.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void lost max interval</td>
<td>Items that have been overdue this long will not result in lost charges being voided when returned, and the overdue fines will not be restored, either. Only applies if Circ: Void lost item billing or Circ: Void processing fee on lost item are true.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Void processing fee on lost item return</td>
<td>Void processing fee when lost item returned</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Warn when patron account is about to expire</td>
<td>If set, the staff client displays a warning this number of days before the expiry of a patron account. Value is in number of days.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>AuthorizeNet password</td>
<td>Authorize.Net Password</td>
<td>Text</td>
<td>Obtain from Authorize.Net</td>
</tr>
<tr>
<td>AuthorizeNet server</td>
<td>Required if using a developer/test account with Authorize.Net.</td>
<td>Text</td>
<td>Enter the server name from Authorize.Net. This is for use on test or developer account. If using live, leave blank.</td>
</tr>
<tr>
<td>AuthorizeNet test mode</td>
<td>Places Authorize.Net transactions in Test Mode</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Enable AuthorizeNet payments</td>
<td>This actually enables use of Authorize.Net</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Enable PayPal payments</td>
<td>This will enable use of PayPal payments through the staff client.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Enable PayflowPro payments</td>
<td>This will enable the use of PayPal’s Payflow Pro. This is not the same as PayPal.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Enable Stripe payments</td>
<td>This will enable the use of the stripe credit card processing.</td>
<td>True/False</td>
<td><a href="https://stripe.com">https://stripe.com</a></td>
</tr>
<tr>
<td>Name default credit processor</td>
<td>This might be &quot;AuthorizeNet&quot;, &quot;PayPal&quot;, &quot;PayflowPro&quot;, or &quot;Stripe&quot;.</td>
<td>Text</td>
<td>This sets the company that you will use to process the credit cards.</td>
</tr>
<tr>
<td>PayPal login</td>
<td>Enter the PayPal login Username</td>
<td>Text</td>
<td>Obtain from PayPal</td>
</tr>
<tr>
<td>PayPal password</td>
<td>Enter the PayPal password.</td>
<td>Text</td>
<td>Obtain from PayPal</td>
</tr>
<tr>
<td>PayPal signature</td>
<td>HASH Signature for PayPal</td>
<td>Text</td>
<td>Enter the HASH obtained from PayPal.</td>
</tr>
<tr>
<td>PayPal test mode</td>
<td>Places the PayPal credit card payments in test mode.</td>
<td>True/False</td>
<td>This sends the transactions to PayPal’s development.paypal.com server for testing only.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>PayflowPro login/merchant ID</td>
<td>Enter the PayflowPro Merchant ID</td>
<td>Text</td>
<td>Obtain from Payflow Pro Partner.</td>
</tr>
<tr>
<td>PayflowPro partner</td>
<td>Enter the Partner ID from your Payflow Partner</td>
<td>Text</td>
<td>This will obtained from your Payflow Pro partner. This can be &quot;PayPal&quot; or &quot;VeriSign&quot;, sometimes others.</td>
</tr>
<tr>
<td>PayflowPro password</td>
<td>Password for PayflowPro</td>
<td>Text</td>
<td>Obtain from Payflow Pro Partner</td>
</tr>
<tr>
<td>PayflowPro test mode</td>
<td>Place Payflow Pro in test mode.</td>
<td>True/False</td>
<td>Do not really process transactions, but stay in test mode - uses pilot-payflowpro.paypal.com instead of the usual host.</td>
</tr>
<tr>
<td>PayflowPro vendor</td>
<td>Currently the same as the Payflow Pro login.</td>
<td>Text</td>
<td>Obtain from Payflow Pro partner.</td>
</tr>
<tr>
<td>Stripe publishable key</td>
<td>Publishable API Key from stripe.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Stripe secret key</td>
<td>Secret API key from stripe.</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

Table 78.5. Finances

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow credit card payments</td>
<td>If enabled, patrons will be able to pay fines accrued at this location via credit card.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Charge item price when marked damaged</td>
<td>If true Evergreen bills item price to the last patron who checked out the damaged item. Staff receive an alert with patron information and must confirm the billing.</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Charge lost on zero</td>
<td>If set to True, default item price will be charged when an item is marked lost even though the price in</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>item record is 0.00</td>
<td>(same as no price). If False, only processing fee, if used, will be charged.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charge processing fee for damaged items</td>
<td>Optional processing fee billed to last patron who checked out the damaged item. Staff receive an alert with patron information and must confirm the billing.</td>
<td>Number(Dollar)</td>
<td>Disabled when set to 0</td>
</tr>
<tr>
<td>Default item price</td>
<td>Replacement charge for lost items if price is unset in the Copy Editor. Does not apply if item price is set to $0</td>
<td>Number(dollars)</td>
<td></td>
</tr>
<tr>
<td>Disable Patron Credit</td>
<td>Do not allow patrons to accrue credit or pay fines/fees with accrued credit</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Leave transaction open when long overdue balance equals zero</td>
<td>Leave transaction open when long-overdue balance equals zero. This leaves the lost copy on the patron record when it is paid</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Leave transaction open when lost balance equals zero</td>
<td>Leave transaction open when lost balance equals zero. This leaves the lost copy on the patron record when it is paid</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Long-Overdue Materials Processing Fee</td>
<td>The amount charged in addition to item price when an item is marked Long-Overdue</td>
<td>Number</td>
<td>Currency</td>
</tr>
<tr>
<td>Lost materials processing fee</td>
<td>The amount charged in addition to item price when an item is marked lost.</td>
<td>Number</td>
<td>Currency</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>Maximum Item Price</td>
<td>When charging for lost items, limit the charge to this as a maximum.</td>
<td>Number</td>
<td>Currency</td>
</tr>
<tr>
<td>Minimum Item Price</td>
<td>When charging for lost items, charge this amount as a minimum.</td>
<td>Number</td>
<td>Currency</td>
</tr>
<tr>
<td>Negative Balance Interval (DEFAULT)</td>
<td>Amount of time after which no negative balances (refunds) are allowed on circulation bills. The &quot;Prohibit negative balance on bills&quot; setting must also be set to &quot;true&quot;.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Negative Balance Interval for Lost</td>
<td>Amount of time after which no negative balances (refunds) are allowed on bills for lost/long overdue materials. The &quot;Prohibit negative balance on bills for lost materials&quot; setting must also be set to &quot;true&quot;.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Negative Balance Interval for Overdues</td>
<td>Amount of time after which no negative balances (refunds) are allowed on bills for overdue materials. The &quot;Prohibit negative balance on bills for overdue materials&quot; setting must also be set to &quot;true&quot;.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Prohibit negative balance on bills (Default)</td>
<td>Default setting to prevent negative balances (refunds) on circulation related bills. Set to &quot;true&quot; to prohibit negative balances at all times or, when used in conjunction with an interval setting, to prohibit negative balances.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>balances after a set period of time.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prohibit negative balance on bills for lost materials</td>
<td>Prevent negative balances (refunds) on bills for lost/long overdue materials. Set to &quot;true&quot; to prohibit negative balances at all times or, when used in conjunction with an interval setting, to prohibit negative balances after an interval of time.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Prohibit negative balance on bills for overdue materials</td>
<td>Prevent negative balances (refunds) on bills for lost/long overdue materials. Set to &quot;true&quot; to prohibit negative balances at all times or, when used in conjunction with an interval setting, to prohibit negative balances after an interval of time.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void Overdue Fines When Items are Marked Long-Overdue</td>
<td>If true overdue fines are voided when an item is marked Long-Overdue</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Void overdue fines when items are marked lost</td>
<td>If true overdue fines are voided when an item is marked lost</td>
<td>True/False</td>
<td></td>
</tr>
</tbody>
</table>

Table 78.6. GUI: Graphic User Interface

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert on empty bib records</td>
<td>Alert staff when the last copy for a record is being deleted.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Button bar</td>
<td>If TRUE, the staff client button bar appears by default on all workstations registered</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cap results in Patron Search at this number.</td>
<td>The maximum number of results returned per search. If 100 is set up here, any search will return 100 records at most.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Default Country for New Addresses in Patron Editor</td>
<td>This is the default Country for new addresses in the patron editor.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Default hotkeyset</td>
<td>Default Hotkeyset for clients (filename without the .keyset). Examples: Default, Minimal, and None</td>
<td>Text</td>
<td>Individual workstations' default overrides this setting.</td>
</tr>
<tr>
<td>Default ident type for patron registration</td>
<td>This is the default Ident Type for new users in the patron editor.</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Default showing suggested patron registration fields</td>
<td>Instead of All fields, show just suggested fields in patron registration by default.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Disable the ability to save list column configurations locally.</td>
<td>GUI: Disable the ability to save list column configurations locally. If set, columns may still be manipulated, however, the changes do not persist. Also, existing local configurations are ignored if this setting is true.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Example for Day_phone field on patron registration</td>
<td>The example on validation on the Day_phone field in patron registration.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Example for Email field on patron registration</td>
<td>The example on validation on the Email field in patron registration.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Example for Evening-phone on patron registration</td>
<td>The example on validation on the Evening-phone field in patron registration.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Example for Other-phone on patron registration</td>
<td>The example on validation on the Other-phone field in patron registration.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Example for phone fields on patron registration</td>
<td>The example on validation on phone fields in patron registration. Applies to all phone fields without their own setting.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Example for Postal Code field on patron registration</td>
<td>The example on validation on the Postal Code field in patron registration.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Format Dates with this pattern.</td>
<td>Format Dates with this pattern (examples: &quot;yyyy-MM-dd&quot; for &quot;2010-04-26, &quot;MMM d, yyyy&quot; for &quot;Apr 26, 2010&quot;). Formats are effective in display (not editing) area.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Format Times with this pattern.</td>
<td>Format Times with this pattern (examples: &quot;h:m:s.SSS a z&quot; for &quot;2:07:20.666 PM Eastern Daylight Time&quot;, &quot;HH:mm&quot; for &quot;14:07&quot;). Formats are effective in display (not editing) area.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>GUI: Hide these fields within the Item Attribute Editor.</td>
<td>Sets which fields in the Item Attribute Editor to hide in the staff client.</td>
<td>Text</td>
<td>This is useful to hide attributes that are not used.</td>
</tr>
<tr>
<td>Horizontal layout for Volume/Copy Creator/Editor.</td>
<td>The main entry point for this interface is in Holdings Maintenance, Actions for Selected Rows, Edit Item Attributes / Call Numbers / Replace</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Barcodes</td>
<td>This setting changes the top and bottom panes (if FALSE) for that interface into left and right panes (if TRUE).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Idle timeout</td>
<td>If you want staff client windows to be minimized after a certain amount of system idle time, set this to the number of seconds of idle time that you want to allow before minimizing (requires staff client restart).</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Items Out Claims Returned display setting</td>
<td>Value is a numeric code, describing which list the circulation should appear while checked out and whether the circulation should continue to appear in the bottom list, when checked in with outstanding fines. 1 = top list, bottom list. 2 = bottom list, bottom list. 5 = top list, do not display. 6 = bottom list, do not display.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Items Out Long-Overdue display setting</td>
<td>Value is a numeric code, describing which list the circulation should appear while checked out and whether the circulation should continue to appear in the bottom list, when checked in with outstanding fines. 1 = top list, bottom list. 2 = bottom list, bottom list. 5 = top list, do not display. 6 = bottom list, do not display.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Items Out Lost display setting</td>
<td>Value is a numeric code, describing which list the circulation should appear while checked out and whether the circulation should continue to appear in the bottom list, when checked in with outstanding fines. 1 = top list, bottom list. 2 = bottom list, bottom list. 5 = top list, do not display. 6 = bottom list, do not display.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Max user activity entries to retrieve (staff client)</td>
<td>Sets the maximum number of recent user activity entries to retrieve for display in the staff client.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Maximum previous checkouts displayed</td>
<td>The maximum number of previous circulations the staff client will display when investigating item details.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Patron circulation summary is horizontal</td>
<td></td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Record in-house use: # of uses threshold for Are You Sure? dialog.</td>
<td>In the Record In-House Use interface, a submission attempt will warn if the # of uses field exceeds the value of this setting.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Record In-House Use: Maximum # of uses allowed per entry.</td>
<td>The # of uses entry in the Record In-House Use interface may not exceed the value of this setting.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Regex for barcodes on patron registration</td>
<td>The Regular Expression for validation on</td>
<td>Regular Expression</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Regex for Day_phone field on patron registration</td>
<td>The Regular Expression on validation on the Day_phone field in patron registration.</td>
<td>Regular expression</td>
<td></td>
</tr>
<tr>
<td>Regex for Email field on patron registration</td>
<td>The Regular Expression on validation on the Email field in patron registration.</td>
<td>Regular expression</td>
<td></td>
</tr>
<tr>
<td>Regex for Evening-phone on patron registration</td>
<td>The Regular Expression on validation on the Evening-phone field in patron registration.</td>
<td>Regular expression</td>
<td></td>
</tr>
<tr>
<td>Regex for Other-phone on patron registration</td>
<td>The Regular Expression on validation on the Other-phone field in patron registration.</td>
<td>Regular expression</td>
<td></td>
</tr>
<tr>
<td>Regex for phone fields on patron registration</td>
<td>The Regular Expression on validation on phone fields in patron registration. Applies to all phone fields without their own setting.</td>
<td>Regular expression</td>
<td>^(?:(?([2-9]\d{2}</td>
</tr>
<tr>
<td>Regex for Postal Code field on patron registration</td>
<td>The Regular Expression on validation on the Postal Code field in patron registration.</td>
<td>Regular expression</td>
<td></td>
</tr>
<tr>
<td>Require at least one address for Patron Registration</td>
<td>Enforces a requirement for having at least one address for a patron during registration. If set to False, you need to delete the empty</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Require XXXXX field on patron registration</td>
<td>The XXXXX field will be required on the patron registration screen.</td>
<td>True/False</td>
<td>XXXXX can be Country, State, Day-phone, Evening-phone, Other-phone, DOB, Email, or Prefix.</td>
</tr>
<tr>
<td>Require staff initials for entry/edit of patron standing penalties and messages.</td>
<td>Appends staff initials and edit date into patron standing penalties and messages.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Require staff initials for entry/edit of patron notes.</td>
<td>Appends staff initials and edit date into patron note content.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Require staff initials for entry/edit of copy notes.</td>
<td>Appends staff initials and edit date into copy note content.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Show billing tab first when bills are present</td>
<td>If true accounts for patrons with bills will open to the billing tab instead of check out</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Show XXXXX field on patron registration</td>
<td>The XXXXX field will be shown on the patron registration screen. Showing a field makes it appear with required fields even when not required. If the field is required this setting is ignored.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Suggest XXXXX field on patron registration</td>
<td>The XXXXX field will be suggested on the patron registration screen. Suggesting a field makes it appear when suggested fields are shown. If the field is shown or required this setting is ignored.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Toggle off the patron summary sidebar after first view.</td>
<td>When true, the patron summary sidebar will collapse after a new</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------</td>
</tr>
<tr>
<td>patron sub-interface is selected.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>URL for remote directory containing list column settings.</td>
<td>The format and naming convention for the files found in this directory match those in the local settings directory for a given workstation. An administrator could create the desired settings locally and then copy all the tree_columns_for_*. files to the remote directory.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Uncheck bills by default in the patron billing interface</td>
<td>Uncheck bills by default in the patron billing interface, and focus on the Uncheck All button instead of the Payment Received field.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Unified Volume/Item Creator/Editor</td>
<td>If True, combines the Volume/Copy Creator and Item Attribute Editor in some instances.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Work Log: maximum actions logged</td>
<td>Maximum entries for &quot;Most Recent Staff Actions&quot; section of the Work Log interface.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Work Log: maximum patrons logged</td>
<td>Maximum entries for &quot;Most Recently Affected Patrons...&quot; section of the Work Log interface.</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

Table 78.7. Global

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow multiple username changes</td>
<td>If enabled (and Lock Usernames is not set) patrons will be allowed to change their names.</td>
<td>True/False</td>
<td>Default TRUE.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>username when it does not look like a barcode. Otherwise username changing in the OPAC will only be allowed when the patron’s username looks like a barcode.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Global default locale</td>
<td>Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock Usernames</td>
<td>If enabled username changing via the OPAC will be disabled.</td>
<td>Default</td>
<td>FALSE</td>
</tr>
<tr>
<td>Password format</td>
<td>Defines acceptable format for OPAC account passwords</td>
<td>Regular</td>
<td>expression</td>
</tr>
<tr>
<td></td>
<td>Default requires that passwords &quot;be at least 7 characters in length, contain at least one letter (a-z/A-Z), and contain at least one number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patron barcode format</td>
<td>Defines acceptable format for patron barcodes</td>
<td>Regular</td>
<td>expression</td>
</tr>
<tr>
<td>Patron username format</td>
<td>Regular expression defining the patron username format, used for patron registration and self-service username changing only</td>
<td>Regular</td>
<td>expression</td>
</tr>
</tbody>
</table>

**Table 78.8. Holds**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behind desk pickup supported</td>
<td>If a branch supports both a public holds shelf and behind-the-desk pickups, set this value to true. This gives the patron the option to enable behind-the-desk pickups for their holds by selecting Hold is</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>behind Circ Desk flag in patron record.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Best-hold selection sort order</td>
<td>Defines the sort order of holds when selecting a hold to fill using a given copy at capture time</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Block renewal of items needed for holds</td>
<td>When an item could fulfill a hold, do not allow the current patron to renew</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Cancelled holds display age</td>
<td>Show all cancelled holds that were cancelled within this amount of time</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Cancelled holds display count</td>
<td>How many cancelled holds to show in patron holds interfaces</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Clear shelf copy status</td>
<td>Any copies that have not been put into reshelving, in-transit, or on-holds-shelf (for a new hold) during the clear shelf process will be put into this status. This is basically a purgatory status for copies waiting to be pulled from the shelf and processed by hand</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Default estimated wait</td>
<td>When predicting the amount of time a patron will be waiting for a hold to be fulfilled, this is the default estimated length of time to assume an item will be checked out.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Default hold shelf expire interval</td>
<td>Hold Shelf Expiry Time is calculated and inserted into hold record based on this interval when capturing a hold.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Expire alert interval</td>
<td>Time before a hold expires at which to send an email notifying the patron</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Expire interval</td>
<td>Amount of time until an unfulfilled hold expires</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>FIFO</td>
<td>Force holds to a more strict First-In, First-Out capture. Default is SAVE-GAS, which gives priority to holds with pickup location the same as checkin library.</td>
<td>True/False</td>
<td>Applies only to multi-branch libraries. Default is SAVE-GAS.</td>
</tr>
<tr>
<td>Hard boundary</td>
<td></td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Hard stalling interval</td>
<td></td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Has local copy alert</td>
<td>If there is an available copy at the requesting library that could fulfill a hold during hold placement time, alert the patron.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Has local copy block</td>
<td>If there is an available copy at the requesting library that could fulfill a hold during hold placement time, do not allow the hold to be placed.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Max foreign-circulation time</td>
<td>Time a copy can spend circulating away from its circ lib before returning there to fill a hold</td>
<td>Duration</td>
<td>For multi-branch libraries.</td>
</tr>
<tr>
<td>Maximum library target attempts</td>
<td>When this value is set and greater than 0, the system will only attempt to find a copy at each possible branch the configured number of times</td>
<td>Number</td>
<td>For multi-branch libraries.</td>
</tr>
<tr>
<td>Minimum estimated wait</td>
<td>When predicting the amount of time a</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------</td>
</tr>
<tr>
<td>patron will be waiting</td>
<td>for a hold to be fulfilled, this is the minimum estimated length of time to assume an item will be checked out.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Org unit target weight</td>
<td>Org Units can be organized into hold target groups based on a weight. Potential copies from org units with the same weight are chosen at random.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Reset request time on</td>
<td>When a hold is uncancelled, reset the request time to push it to the end of the queue</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>un-cancel</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skip for hold targeting</td>
<td>When true, don’t target any copies at this org unit for holds</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Soft boundary</td>
<td>Holds will not be filled by copies outside this boundary if there are holdable copies within it.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Soft stalling interval</td>
<td>For this amount of time, holds will not be opportunistically captured at non-pickup branches.</td>
<td>Duration</td>
<td>For multiple branch libraries</td>
</tr>
<tr>
<td>Use Active Date for age</td>
<td>When calculating age protection rules use the Active date instead of the Creation Date.</td>
<td>True/False</td>
<td>Default TRUE</td>
</tr>
<tr>
<td>protection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use weight-based hold</td>
<td>Use library weight based hold targeting</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>targeting</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table 78.9. Library

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change reshelving status interval</td>
<td>Amount of time to wait before changing an</td>
<td>Duration</td>
<td>The default is at midnight each</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>item from “Reshelving” status to “available”</td>
<td>night for items with &quot;Reshelving&quot; status for over 24 hours.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Claim never checked out: mark copy as missing</td>
<td>When a circ is marked as claims-never-checked-out, mark the copy as missing</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Claim return copy status</td>
<td>Claims returned copies are put into this status. Default is to leave the copy in the Checked Out status</td>
<td>Selection list</td>
<td></td>
</tr>
<tr>
<td>Courier code</td>
<td>Courier Code for the library. Available in transit slip templates as the %courier_code% macro.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Juvenile age threshold</td>
<td>Upper cut-off age for patrons to be considered juvenile, calculated from date of birth in patron accounts</td>
<td>Duration (years)</td>
<td></td>
</tr>
<tr>
<td>Library information URL</td>
<td>URL for information on this library, such as contact information, hours of operation, and directions. Use a complete URL, such as &quot;<a href="http://example.com/hours.html">http://example.com/hours.html</a>&quot;.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Mark item damaged voids overdues</td>
<td>When an item is marked damaged, overdue fines on the most recent circulation are voided.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Pre-cat item circ lib</td>
<td>Override the default circ lib of &quot;here&quot; with a pre-configured circ lib for pre-cat items. The value should be the &quot;shortname&quot; (aka policy name) of the org unit</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Telephony: Arbitrary line(s) to include in each notice callfile</td>
<td>This overrides lines from opensrf.xml. Line(s) must be valid for your target server and platform (e.g. Asterisk 1.4).</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

Table 78.10. OPAC

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Patron Self-Registration</td>
<td>Allow patrons to self-register, creating pending user accounts</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Allow pending addresses</td>
<td>If true patrons can edit their addresses in the OPAC. Changes must be approved by staff</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Auto-Override Permitted Hold Blocks (Patrons)</td>
<td>This will allow patrons with the permission &quot;HOLD_ITEM_CHECKED_OVERRIDE&quot; to automatically override permitted holds.</td>
<td>True/False</td>
<td>When a patron places a hold in the OPAC that fails, and the patron has the permission to override the failed hold, this automatically overrides the failed hold rather than requiring the patron to manually override the hold. Default is False.</td>
</tr>
<tr>
<td>Jump to details on 1 hit (OPAC)</td>
<td>When a search yields only 1 result, jump directly to the record details page. This setting only affects the public OPAC</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Jump to details on 1 hit (staff client)</td>
<td>When a search yields only 1 result, jump directly to the record details page. This setting only affects the PAC within the staff client</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>OPAC: Number of staff client saved searches to display on left side</td>
<td>If unset, the OPAC (only when wrapped in the staff client!) will</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>of results and record details pages</td>
<td>default to showing you your ten most recent searches on the left side of the results and record details pages. If you actually don’t want to see this feature at all, set this value to zero at the top of your organizational tree.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPAC: Org Unit is not a hold pickup library</td>
<td>If set, this org unit will not be offered to the patron as an option for a hold pickup location. This setting has no affect on searching or hold targeting.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Org unit hiding depth</td>
<td>This will hide certain org units in the public OPAC if the Original Location (url param &quot;ol&quot;) for the OPAC inherits this setting. This setting specifies an org unit depth, that together with the OPAC Original Location determines which section of the Org Hierarchy should be visible in the OPAC. For example, a stock Evergreen installation will have a 3-tier hierarchy (Consortium/System/Branch), where System has a depth of 1 and Branch has a depth of 2. If this setting contains a depth of 1 in such an installation, then every library in the System in which the Original Location belongs will be visible, and everything else will be hidden.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>hidden. A depth of 0 will effectively make every org visible. The embedded OPAC in the staff client ignores this setting.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paging shortcut links for OPAC Browse</td>
<td>The characters in this string, in order, will be used as shortcut links for quick paging in the OPAC browse interface. Any sequence surrounded by asterisks will be taken as a whole label, not split into individual labels at the character level, but only the first character will serve as the basis of the search.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Patron Self-Reg. Display Timeout</td>
<td>Number of seconds to wait before reloading the patron self-registration interface to clear sensitive data</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Patron Self-Reg. Expire Interval</td>
<td>If set, this is the amount of time a pending user account will be allowed to sit in the database. After this time, the pending user information will be purged</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Payment history age limit</td>
<td>The OPAC should not display payments by patrons that are older than any interval defined here.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Tag Circulated Items in Results</td>
<td>When a user is both logged in and has opted in to circulation history tracking, turning on this setting will cause previous (or currently) circulated</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Tag Circulated Items in Results</td>
<td>When a user is both logged in and has opted in to circulation history tracking, turning on this setting will cause previous (or currently) circulated items to be highlighted in search results.</td>
<td>True/False</td>
<td>Default TRUE</td>
</tr>
<tr>
<td>Use fully compressed serial holdings</td>
<td>Show fully compressed serial holdings for all libraries at and below the current context unit</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Warn patrons when adding to a temporary book list</td>
<td>Present a warning dialogue when a patron adds a book to the temporary book list.</td>
<td>True/False</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skip offline checkin if newer item Status Changed Time.</td>
<td>Skip offline checkin transaction (raise exception when processing) if item Status Changed Time is newer than the recorded transaction time. WARNING: The Reshelving to Available status rollover will trigger this.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Skip offline checkout if newer item Status Changed Time.</td>
<td>Skip offline checkout transaction (raise exception when processing) if item Status Changed Time is newer than the recorded transaction time. WARNING: The Reshelving to Available status rollover will trigger this.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>status rollover will trigger this.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skip offline renewal if newer item Status Changed Time.</td>
<td>Skip offline renewal transaction (raise exception when processing) if item Status Changed Time is newer than the recorded transaction time. WARNING: The Reshelving to Available status rollover will trigger this.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Disable automatic print attempt type list</td>
<td>Disable automatic print attempts from staff client interfaces for the receipt types in this list. Possible values: &quot;Checkout&quot;, &quot;Bill Pay&quot;, &quot;Hold Slip&quot;, &quot;Transit Slip&quot;, and &quot;Hold/Transit Slip&quot;. This is different from the Auto-Print checkbox in the pertinent interfaces in that it disables automatic print attempts altogether, rather than encouraging silent printing by suppressing the print dialogue. The Auto-Print checkbox in these interfaces have no effect on the behavior for this setting. In the case of the Hold, Transit, and Hold/Transit slips, this also suppresses the alert dialogues that precede the print dialogue (the ones that offer Print and Do Not Print as options).</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Retain empty bib records</td>
<td>Retain a bib record even when all attached copies are deleted</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Sending email address for patron notices</td>
<td>This email address is for automatically generated patron notices (e.g. email overdues, email holds notification). It is good practice to set up a generic account, like <a href="mailto:info@nameofyourlibrary.org">info@nameofyourlibrary.org</a>, so that one person’s individual email inbox doesn’t get cluttered with emails that were not delivered.</td>
<td>Text</td>
<td></td>
</tr>
</tbody>
</table>

### Table 78.12. Receipt Templates and SMS Text Message

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content of alert_text include</td>
<td>Text/HTML/Macros to be inserted into receipt templates in place of %INCLUDE(alert_text)%</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Content of event_text include</td>
<td>Text/HTML/Macros to be inserted into receipt templates in place of %INCLUDE(event_text)%</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Content of footer_text include</td>
<td>Text/HTML/Macros to be inserted into receipt templates in place of %INCLUDE(footer_text)%</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Content of header_text include</td>
<td>Text/HTML/Macros to be inserted into receipt templates in place of %INCLUDE(header_text)%</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Content of notice_text include</td>
<td>Text/HTML/Macros to be inserted into receipt templates in place of %INCLUDE(notice_text)%</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Disable auth requirement for texting call numbers.</td>
<td>Disable authentication requirement for sending call number</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>information via SMS from the OPAC.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable features that send SMS text messages.</td>
<td>Current features that use SMS include hold-ready-for-pickup notifications and a &quot;Send Text&quot; action for call numbers in the OPAC. If this setting is not enabled, the SMS options will not be offered to the user. Unless you are carefully silo-ing patrons and their use of the OPAC, the context org for this setting should be the top org in the org hierarchy, otherwise patrons can trample their user settings when jumping between orgs.</td>
<td>True/False</td>
<td></td>
</tr>
</tbody>
</table>

Table 78.13. Security

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default level of patrons' internet access</td>
<td>Enter numbers 1 (Filtered), 2 (Unfiltered), or 3 (No Access)</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Maximum concurrently active self-serve password reset requests</td>
<td>Prevent the creation of new self-serve password reset requests until the number of active requests drops back below this number.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Maximum concurrently active self-serve password reset requests per user</td>
<td>When a user has more than this number of concurrently active self-serve password reset requests for their account, prevent the</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>OPAC Inactivity Timeout (in seconds)</td>
<td>Number of seconds of inactivity before OPAC accounts are automatically logged out.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Obscure the Date of Birth field</td>
<td>When true, the Date of Birth column in patron lists will default to Not Visible, and in the Patron Summary sidebar the value will display as unless the field label is clicked.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Offline: Patron usernames allowed</td>
<td>During offline circulations, allow patrons to identify themselves with usernames in addition to barcode. For this setting to work, a barcode format must also be defined</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Patron opt-in boundary</td>
<td>This determines at which depth above which patrons must be opted in, and below which patrons will be assumed to be opted in.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Patron opt-in default</td>
<td>This is the default depth at which a patron is opted in; it is calculated as an org unit relative to the current workstation.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Patron: password from phone #</td>
<td>If true the last 4 digits of the patron’s phone number will be used for password reset requests.</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>phone number is the password for new accounts (password must still be changed at first OPAC login)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Persistent login duration</td>
<td>How long a persistent login lasts, e.g. 2 weeks</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Self-serve password reset request time-to-live</td>
<td>Length of time (in seconds) a self-serve password reset request should remain active.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Staff login inactivity timeout (in seconds)</td>
<td>Number of seconds of inactivity before staff client prompts for login and password.</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

**Table 78.14. Self Check and Others**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Alerts</td>
<td>Use audio alerts for selfcheck events.</td>
<td>True/false</td>
<td></td>
</tr>
<tr>
<td>Block copy checkout status</td>
<td>List of copy status IDs that will block checkout even if the generic COPY_NOT_AVAILABLE event is overridden.</td>
<td>Number</td>
<td>Look up copy status ID from Server Admin.</td>
</tr>
<tr>
<td>Patron login timeout (in seconds)</td>
<td>Number of seconds of inactivity before the patron is logged out of the selfcheck interface.</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Pop-up alert for errors</td>
<td>If true, checkout/renewal errors will cause a pop-up window in addition to the on-screen message.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Require Patron Password</td>
<td>If true, patrons will be required to enter their password in addition to their username/barcode to log into the selfcheck interface.</td>
<td>True/False</td>
<td>This replaced &quot;Require patron password&quot;</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Require patron password</td>
<td>Require patron password was replaced by &quot;Require Patron Password&quot; and is currently invalid.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Selfcheck override events list</td>
<td>List of checkout/renewal events that the selfcheck interface should automatically override instead of alerting and stopping the transaction.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Workstation Required</td>
<td>All selfcheck stations must use a workstation.</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Default display grouping for serials distributions presented in the OPAC.</td>
<td>Default display grouping for serials distributions presented in the OPAC. This can be &quot;enum&quot; or &quot;chron&quot;.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Previous issuance copy location</td>
<td>When a serial issuance is received, copies (units) of the previous issuance will be automatically moved into the configured shelving location.</td>
<td>Selection List</td>
<td></td>
</tr>
<tr>
<td>Maximum redirect lookups</td>
<td>For URLs returning 3XX redirects, this is the maximum number of redirects we will follow before giving up.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Maximum wait time (in seconds) for a URL to lookup</td>
<td>If we exceed the wait time, the URL is marked as a &quot;timeout&quot; and the system moves on to the next URL</td>
<td>Duration</td>
<td></td>
</tr>
<tr>
<td>Number of URLs to test in parallel</td>
<td>URLs are tested in batches. This number defines the size of each batch and it directly relates to the number of back-end processes performing URL verification.</td>
<td>Number</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td>Data type</td>
<td>Notes</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-----------</td>
<td>-------</td>
</tr>
<tr>
<td>Number of seconds to wait between URL test attempts</td>
<td>Throttling mechanism for batch URL verification runs. Each running process will wait this number of seconds after a URL test before performing the next.</td>
<td>Duration</td>
<td></td>
</tr>
</tbody>
</table>

### Table 78.15. Vandelay

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Data type</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Record Match Set</td>
<td>Sets the Default Record Match set</td>
<td>Selection List</td>
<td>Populated by the Vandelay Record Match Sets</td>
</tr>
<tr>
<td>Vandelay Default Barcode Prefix</td>
<td>Apply this prefix to any auto-generated item barcode</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Vandelay Default Call Number Prefix</td>
<td>Apply this prefix to any auto-generated item call numbers.</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Vandelay Default Circulation Modifier</td>
<td>Default circulation modifier value for imported items</td>
<td>Selection List</td>
<td>Populated by your Circulation Modifiers.</td>
</tr>
<tr>
<td>Vandelay Default Copy Location</td>
<td>Default copy location value for imported items</td>
<td>Selection List</td>
<td>Populated from Shelving Locations</td>
</tr>
<tr>
<td>Vandelay Generate Default Barcodes</td>
<td>Auto-generate default item barcodes when no item barcode is present</td>
<td>True/False</td>
<td></td>
</tr>
<tr>
<td>Vandelay Generate Default Call Numbers</td>
<td>Auto-generate default item call numbers when no item call number is present</td>
<td>True/False</td>
<td>These are pulled from the MARC Record.</td>
</tr>
</tbody>
</table>

### Data Types

Acceptable formats for each setting type are listed below. Quotation marks are never required when updating settings in the staff client.
Table 78.16. Data Types in the Library Settings Editor

<table>
<thead>
<tr>
<th>Data type</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>True/False</td>
<td>Boolean True/False drop down</td>
</tr>
<tr>
<td>Number</td>
<td>Enter a numerical value (decimals allowed in price settings)</td>
</tr>
<tr>
<td>Duration</td>
<td>Enter a number followed by a space and any of the following units: minutes, hours, days, months (30 minutes, 2 days, etc)</td>
</tr>
<tr>
<td>Selection list</td>
<td>Choose from a drop-down list of options (e.g. copy status, copy location)</td>
</tr>
<tr>
<td>Text</td>
<td>Free text</td>
</tr>
</tbody>
</table>

Chapter 78. Library Settings Editor

Report errors in this documentation using Launchpad.
Chapter 79. Address Alert

The Address Alert module gives administrators the ability to notify staff with a custom message when addresses with certain patterns are entered in patron records.

This feature only serves to provide pertinent information to your library system’s circulation staff during the registration process. An alert will not prevent the new patron account from being registered and the information will not be permanently associated with the patron account.

To access the Address Alert module, select Administration → Local Administration → Address Alerts.

You must have Local Administrator permissions or ADMIN_ADDRESS_ALERT permission to access the Address Alert module.

General Usage Examples

• Alert staff when an address for a large apartment is entered to prompt them to ask for unit number.

• Alert staff when the address of a hotel or other temporary housing is entered.

• Alert staff when an address for a different country is entered.

• Alert staff when a specific city or zip code is entered if that city or zip code needs to be handled in a special way. If you have a neighboring city that you don’t have a reciprocal relationship with, you could notify staff that a fee card is required for this customer.

Access Control and Scoping

Each address alert is tied to an Org Unit and will only be matched against staff client instances of that Org Unit and its children.

When viewing the address alerts you will only see the alerts associated with the specific org unit selected in the "Context Org Unit" selection box. You won’t see alerts associated with parent org units, so the list of alerts isn’t a list of all alerts that may effect your org unit, only of the ones that you can edit.

The specific permission that controls access to configuring this feature is ADMIN_ADDRESS_ALERT. Local Administrator level users will already have this permission. It is possible for the Local Administrator to grant this permission to other staff.

Adding a new Address Alert

How to add an address to the alert list:
1. Log into the Evergreen Staff Client using a Local Administrator account or another account that has been granted the proper permission.

2. Click on Administration → Local Administration → Address Alerts.

3. Click "New Address Alert."

4. A form will open with the following fields to fill out:

   Table 79.1. New Address Alert Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Which Org Unit owns this alert. Set this to your system or branch.</td>
</tr>
<tr>
<td>Active</td>
<td>Check-box that controls if the alert is active or not. Inactive alerts are not processed.</td>
</tr>
<tr>
<td>Match All Fields</td>
<td>Check-box that controls if all the fields need to match to trigger the alert(checked), or only at least one field needs to match(unchecked).</td>
</tr>
<tr>
<td>Alert Message</td>
<td>Message that will be displayed to staff when this alert is triggered.</td>
</tr>
<tr>
<td>Street (1)</td>
<td>Street 1 field regular expression.</td>
</tr>
<tr>
<td>Street (2)</td>
<td>Street 2 field regular expression.</td>
</tr>
<tr>
<td>City</td>
<td>City regular expression.</td>
</tr>
<tr>
<td>County</td>
<td>County regular expression.</td>
</tr>
<tr>
<td>State</td>
<td>State regular expression.</td>
</tr>
<tr>
<td>Country</td>
<td>Country regular expression.</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Postal Code regular expression.</td>
</tr>
<tr>
<td>Address Alert ID</td>
<td>Displays the internal database id for alert after the alert has been saved.</td>
</tr>
<tr>
<td>Billing Address</td>
<td>Check-box that specifies that the alert will only match a billing address if checked.</td>
</tr>
<tr>
<td>Mailing Address</td>
<td>Check-box that specifies that the alert will only match a mailing address if checked.</td>
</tr>
</tbody>
</table>

5. Click save once you have finished.

**Editing an Address Alert**

To make changes to an existing alert, double click on the alert in the list. The editing form will appear, make your changes and click save or cancel when you are done.

If you don’t see your alerts, make sure the "Context Org Unit" selection box has the correct Org Unit selected.
Deleting an Address Alert

To delete an alert or many alerts, click the selection check-box for all alerts you would like to delete. Then click the "Delete Selected" button at the top of the screen.

Staff View of Address Alerts

When an Address Alert is triggered by a matching address the staff will see the address block highlighted with a red dashed line, along with an "Address Alert" block which contains the alert message.

Here is an example of what staff would see.

Regular Expressions / Wildcards

All of the patterns entered to match the various address fields are evaluated as case-insensitive regular expressions by default.

**Note**

Address Alerts use POSIX Regular Expressions included in the PostgreSQL database engine. See the PostgreSQL documentation for full details.

If you want to do a case-sensitive match you need to prepend the pattern with "(?c)"

The simplest regular expression that acts as a wildcard is ".\.*", that matches any type of character zero or more times.

Examples

Apartment address. Match an apartment address to prompt for unit number.
1. Choose Owner Org Unit.
2. Active = Checked
3. Match All Fields = Checked
4. Alert Message = "This is a large apartment building, Please ask customer for unit number."
5. Street (1) = "1212 Evergreen Lane."
6. City = "mytown"

All addresses on street. Match all addresses on a certain street. Matches ave and avenue because of ending wildcard.

1. Choose Owner Org Unit.
2. Active = Checked
3. Match All Fields = Checked
4. Alert Message = "This street is in a different county, please setup reciprocal card."
5. Street (1) = ".* Evergreen Ave."
6. City = "mytown"

Match list of cities. Match several different cities with one alert. Could be used if certain cities don’t have reciprocal agreements. Note the use of parentheses and the | character to separate the different options.

1. Choose Owner Org Unit.
2. Active = Checked
3. Match All Fields = Checked
4. Alert Message = "Customer must purchase a Fee card."
5. City = "(Emeryville|San Jose|San Francisco)"

### Development

Links to resources with more information on how and why this feature was developed and where the various source files are located.

- Launchpad ticket for the feature request and development of address alerts - [https://bugs.launchpad.net/evergreen/+bug/898248](https://bugs.launchpad.net/evergreen/+bug/898248)
Chapter 80. Barcode Completion

The Barcode Completion feature gives users the ability to only enter the unique part of patron and item barcodes. This can significantly reduce the amount of typing required for manual barcode input.

This feature can also be used if there is a difference between what the barcode scanner outputs and what is stored in the database, as long as the barcode that is stored has more characters than what the scanner is outputting. Barcode Completion is additive only; you cannot use it to match a stored barcode that has less characters than what is entered. For example, if your barcode scanners previously output a123123b and now exclude the prefix and suffix, you could match both formats using Barcode Completion rules.

Because this feature adds an extra database search for each enabled rule to the process of looking up a barcode, it can add extra delays to the check-out process. Please test in your environment before using in production.

Scoping and Permissions

Local Administrator permission is needed to access the admin interface of the Barcode Completion feature.

Each rule requires an owner org unit, which is how scoping of the rules is handled. Rules are applied for staff users with the same org unit or descendants of that org unit.

Access Points

The admin interface for Barcode Completion is located under Administration → Local Administration → Barcode Completion.

The barcode completion functionality is available at the following interfaces.
Check Out Step 1: Lookup Patron by Barcode

Check Out Step 2: Scanning Item Barcodes

Staff Client Place Hold from Catalog

Search the Catalog  Advanced Search  Browse the Catalog

Search:  Type: Keyword  Format: All Formats

[ Refine My Original Search ]

Place Hold

Place hold for patron by barcode:  
Place this hold for me (Administrator System Account)


Advanced Hold Options

Pickup location: Example Consortium
Check In

Barcode completion is also available during check out if library setting "Load patron from Checkout" is set. (Automatically detects if an actor/user barcode is scanned during check out, and starts a new check out session using that user.)

Barcode Completion does not work in the Search for Patron [by Name] interface.

Multiple Matches

If multiple barcodes are matched, say if you have both "123" and "00000123" as valid barcodes, you will receive a list of all the barcodes that match all the rules that you have configured. It doesn’t stop after the first rule that matches, or after the first valid barcode is found.
Barcode Completion Data Fields

The following data fields can be set for each Barcode Completion rule.

Table 80.1. Barcode Completion Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Check to indicate entry is active. Required</td>
</tr>
<tr>
<td>Owner</td>
<td>Setting applies to this Org Unit and to all children. Required</td>
</tr>
<tr>
<td>Prefix</td>
<td>Sequence that appears at the beginning of barcode.</td>
</tr>
<tr>
<td>Suffix</td>
<td>Sequence that appears at the end of barcode.</td>
</tr>
<tr>
<td>Length</td>
<td>Total length of barcode.</td>
</tr>
<tr>
<td>Padding</td>
<td>Character that pads out non-unique characters in the barcode.</td>
</tr>
<tr>
<td>Padding At End</td>
<td>Check if the padding starts at the end of the barcode.</td>
</tr>
<tr>
<td>Applies to Items</td>
<td>Check if entry applies to item barcodes.</td>
</tr>
<tr>
<td>Applies to Users</td>
<td>Check if entry applies to user barcodes.</td>
</tr>
</tbody>
</table>

Length and Padding. Length and Padding are related, you cannot use one without the other. If a barcode has to be a certain length, then it needs to be able to be padded out to that length. If a barcode has padding, then we need to know the max length that we need to pad out to. If length is set to blank or zero, or padding is left blank then they are both ignored.

Applies to Items/Users. One or both of these options must be checked for the rule to have any effect.
Create, Update, Filter, Delete/Disable Rules

In the Barcode Completion admin interface at Administration → Local Administration → Barcode Completion you can create, update and disable rules.

Create Rules

To create a new rule click on the New button in the upper right corner. When you are done with editing the new rule click the Save button. If you want to cancel the new rule creation click the Cancel button.

Update Rules

To edit a rule double click on the rule in the main list.
Filter Rules

It may be useful to filter the rules list if there are a large number of rules. Click on the filter link to bring up the Filter Results dialog box. You can filter on any of the data fields and you can setup multiple filter rules. Click Apply to enable the filter rules, only the rows that match will now be displayed.

To clear out the filter rules, delete all of the filter rules by clicking the X next to each rule, and then click Apply.

Delete/Disable Rules

It isn’t possible to delete a rule from the database from the admin interface. If a rule is no longer needed set Active to "False" to disable it. To keep the number of rules down, reuse inactive rules when creating new rules.

Examples

In all these examples, the unique part of the barcode is 123. So that is all that users will need to type to match the full barcode.

Barcode With Prefix and Padding

Barcode: 4545000123

To match this 10 character barcode by only typing in 123 we need the following settings.

• Active - Checked
• Owner - Set to your org unit.
• Prefix - 4545 - This is the prefix that the barcode starts with.
• Length - 10 - Total length of the barcode.
• Padding - 0 - Zeros will be used to pad out non significant parts of the barcode.
• Applies to Items and/or Applies to Users - Checked

The system takes the 123 that you entered and adds the prefix to the beginning of it. Then adds zeros between the prefix and your number to pad it out to 10 characters. Then it searches the database for that barcode.

Barcode With Suffix

Barcode: 123000book

To match this 10 character barcode by only typing in 123 we need the following settings.
• Active - Checked
• Owner - Set to your org unit.
• Suffix - book - This is the suffix that the barcode ends with.
• Length - 10 - Total length of the barcode.
• Padding - 0 - Zeros will be used to pad out non significant parts of the barcode.
• Padding at End - Checked
• Applies to Items and/or Applies to Users - Checked

The system takes the 123 that you entered and adds the suffix to the end of it. Then adds zeros between your number and the suffix to pad it out to 10 characters. Then it searches the database for that barcode.

**Barcode With Left Padding**

Barcode: 0000000123

To match this 10 character barcode by only typing in 123 we need the following settings.

• Active - Checked
• Owner - Set to your org unit.
• Length - 10 - Total length of the barcode.
• Padding - 0 - Zeros will be used to pad out non significant parts of the barcode.
• Applies to Items and/or Applies to Users - Checked

The system takes the 123 that you entered, then adds zeros between your number and the left to pad it out to 10 characters. Then it searches the database for that barcode.

**Barcode With Right Padding**

Barcode: 1230000000

To match this 10 character barcode by only typing in 123 we need the following settings.

• Active - Checked
• Owner - Set to your org unit.
• Length - 10 - Total length of the barcode.
• Padding - 0 - Zeros will be used to pad out non significant parts of the barcode.
The system takes the 123 that you entered, then adds zeros between your number and the right to pad it out to 10 characters. Then it searches the database for that barcode.

**Barcode of any Length with Prefix and Suffix**

Barcode: a123b

To match this 5 character barcode by only typing in 123 we need the following settings. This use of Barcode Completion doesn’t save many keystrokes, but it does allow you to handle the case where your barcode scanners at one point were set to output a prefix and suffix which was stored in the database. Now your barcode scanners no longer include the prefix and suffix. These settings will simply add the prefix and suffix to any barcode entered and search for that.

- Active - Checked
- Owner - Set to your org unit.
- Length/Padding - 0/null - Set the length to 0 and/or leave the padding blank.
- Prefix - a - This is the prefix that the barcode starts with.
- Suffix - b - This is the suffix that the barcode starts with.
- Applies to Items and/or Applies to Users - Checked

The system takes the 123 that you entered, then adds the prefix and suffix specified. Then it searches the database for that barcode. Because no length or padding was entered, this rule will add the prefix and suffix to any barcode that is entered and then search for that valid barcode.

**Testing**

To test this feature, setup the rules that you want, then setup items/users with barcodes that should match. Then try scanning the short version of those barcodes in the various supported access points.
In academic libraries, it is common for groups like faculty and graduate students to have extended loan periods (for example, 120 days), while others have more common loan periods such as 3 weeks. In these environments, it is desirable to have a hold placed on an item that has been loaned out for an extended period to trigger a recall, which:

1. Truncates the loan period
2. Sets the remaining available renewals to 0
3. Optionally: Changes the fines associated with overdues for the new due date
4. Optionally: Notifies the current patron of the recall, including the new due date and fine level

**Enabling hold-driven recalls**

By default, holds do not trigger recalls. To enable hold-driven recalls of circulating items, library settings must be changed as follows:

1. Click Administration → Local Administration → Library Settings Editor.
2. Set the Recalls: Circulation duration that triggers a recall (recall threshold) setting. The recall threshold is specified as an interval (for example, "21 days"); any items with a loan duration of less that this interval are not considered for a recall.
3. Set the Recalls: Truncated loan period (return interval) setting. The return interval is specified as an interval (for example, "7 days"). The due date on the recalled item is changed to be the greater of either the recall threshold or the return interval.
4. Optionally: Set the Recalls: An array of fine amount, fine interval, and maximum fine setting. If set, this applies the specified fine rules to the current circulation period for the recalled item.

When a hold is placed and no available copies are found by the hold targeter, the recall logic checks to see if the recall threshold and return interval settings are set; if so, then the hold targeter checks the currently checked-out copies to determine if any of the currently circulating items at the designated pickup library have a loan duration longer than the recall threshold. If so, then the eligible item with the due date nearest to the current date is recalled.

**Editing the item recall notification email template**

The template for the item recall notification email is contained in the Item Recall Email Notice template, found under Administration → Local Administration → Notifications / Action Triggers.
Chapter 82. Notifications / Action Triggers

Introduction

Action Triggers give administrators the ability to set up actions for specific events. They are useful for notification events such as hold notifications.

To access the Action Triggers module, select Administration → Local Administration → Notifications / Action triggers.

You must have Local Administrator permissions to access the Action Triggers module.

You will notice four tabs on this page: Event Definitions, Hooks, Reactors and Validators.

Event Definitions

Event Definitions is the main tab and contains the key fields when working with action triggers. These fields include:

Table 1: Action Trigger Event Definitions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owning Library</td>
<td>The shortname of the library for which the action / trigger / hook is defined.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the trigger event, that links to a trigger event environment containing a set of fields that will be returned to the Validators and/or Reactors for processing.</td>
</tr>
<tr>
<td>Hook</td>
<td>The name of the trigger for the trigger event. The underlying action_trigger.hook table defines the Fieldmapper class in the core_type column off of which the rest of the field definitions “hang”.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Sets the given trigger as enabled or disabled. This must be set to enabled for the Action trigger to run.</td>
</tr>
<tr>
<td>Processing Delay</td>
<td>Defines how long after a given trigger / hook event has occurred before the associated action (“Reactor”) will be taken.</td>
</tr>
<tr>
<td>Processing Delay Context Field</td>
<td>Defines the field associated with the event on which the processing delay is calculated. For example, the processing delay context field on the hold.capture hook (which has a core_type of ahr) is capture_time.</td>
</tr>
<tr>
<td>Processing Group Context Field</td>
<td>Used to batch actions based on its associated group.</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Reactor</td>
<td>Links the action trigger to the Reactor.</td>
</tr>
<tr>
<td>Validator</td>
<td>The subroutines receive the trigger environment as an argument (see the linked Name for the environment definition) and returns either 1 if the validator is true or 0 if the validator returns false.</td>
</tr>
<tr>
<td>Event Repeatability Delay</td>
<td>Allows events to be repeated after this delay interval.</td>
</tr>
<tr>
<td>Failure Cleanup</td>
<td>After an event is reacted to and if there is a failure a cleanup module can be run to clean up after the event.</td>
</tr>
<tr>
<td>Granularity</td>
<td>Used to group events by how often they should be run. Options are Hourly, Daily, Weekly, Monthly, Yearly, but you may also create new values.</td>
</tr>
<tr>
<td>Max Event Validity Delay</td>
<td>Allows events to have a range of time that they are valid. This value works with the Processing Delay to define a time range.</td>
</tr>
<tr>
<td>Message Library Path</td>
<td>Defines the org_unit object for a Patron Message Center message.</td>
</tr>
<tr>
<td>Message Template</td>
<td>A Template Toolkit template that can be used to generate output for a Patron Message Center message. The output may or may not be used by the reactor or another external process.</td>
</tr>
<tr>
<td>Message Title</td>
<td>The title that will display on a Patron Message Center message.</td>
</tr>
<tr>
<td>Message User Path</td>
<td>Defines the user object for a Patron Message Center message.</td>
</tr>
<tr>
<td>Opt-In Settings Type</td>
<td>Choose which User Setting Type will decide if this event will be valid for a certain user. Use this to allow users to Opt-In or Opt-Out of certain events.</td>
</tr>
<tr>
<td>Opt-In User Field</td>
<td>Set to the name of the field in the selected hook’s core type that will link the core type to the actor.usr table.</td>
</tr>
<tr>
<td>Success Cleanup</td>
<td>After an event is reacted to successfully a cleanup module can be run to clean up after the event.</td>
</tr>
<tr>
<td>Template</td>
<td>A Template Toolkit template that can be used to generate output. The output may or may not be used by the reactor or another external process.</td>
</tr>
</tbody>
</table>

## Creating Action Triggers

1. From the top menu, select Administration → Local Administration → Notifications / Action triggers.
2. Click on the New button.
3. Select an Owning Library.
4. Create a unique Name for your new action trigger.

5. Select the Hook.

6. Check the Enabled check box.

7. Set the Processing Delay in the appropriate format. E.g. 7 days to run 7 days from the trigger event or 00:01:00 to run 1 hour after the Processing Delay Context Field.

8. Set the Processing Delay Context Field and Processing Group Context Field.

9. Select the Reactor and Validator.

10. Set the Event Repeatability Delay.

11. Select the Failure Cleanup and Granularity.

12. Set the Max Event Validity Delay.

13. If you wish to send a User Message through the Message Center, set a Message Library Path. Enter text in the Message Template. Enter a title for this message in Message Title, and set a value in Message User Path.

14. Select the Opt-In Setting Type.

15. Set the Opt-In User Field.

16. Select the Success Cleanup.

17. Enter text in the Template text box if required. These are for email messages. Here is a sample template for sending 90 day overdue notices:

   ```
   [%- USE date -%]
   [%- user = target.0.usr -%]
   To: [%- params.recipient_email || user.email %]
   From: [%- helpers.get_org_setting(target.home_ou.id, 'org.bounced_emails') || lib.email ||
          params.sender_email || default_sender %]
   Subject: Overdue Items Marked Lost
   Auto-Submitted: auto-generated
   
   Dear [% user.family_name %], [% user.first_given_name %]
   The following items are 90 days overdue and have been marked LOST.
   [%- params.recipient_email || user.email %][%- params.sender_email || default_sender %]
   [% FOR circ IN target %]
   Title: [% circ.target_copy.call_number.record.simple_record.title %]
   Barcode: [% circ.target_copy.barcode %]
   Due: [% date.format(helpers.format_date(circ.due_date), '%Y-%m-%d') %]
   Item Cost: [% helpers.get_copy_price(circ.target_copy) %]
   Total Owed For Transaction: [% circ.billable_transaction.summary.total_owed %]
   Library: [% circ.circ_lib.name %]
   [% END %]

   [% FOR circ IN target %]
   Title: [% circ.target_copy.call_number.record.simple_record.title %]
   Barcode: [% circ.target_copy.barcode %]
   ```
Once you are satisfied with your new event trigger, click the Save button located at the bottom of the form.

A quick and easy way to create new action triggers is to clone an existing action trigger.

### Cloning Existing Action Triggers

1. Check the check box next to the action trigger you wish to clone.
2. Click Clone Selected on the top left of the page.
3. An editing window will open. Notice that the fields will be populated with content from the cloned action trigger. Edit as necessary and give the new action trigger a unique Name.
4. Click Save.

### Editing Action Triggers

1. Double-click on the action trigger you wish to edit.
2. The edit screen will appear. When you are finished editing, click Save at the bottom of the form. Or click Cancel to exit the screen without saving.

Before deleting an action trigger, you should consider disabling it through the editing form. This way you can keep it for future use or cloning.

### Deleting Action Triggers

1. Check the check box next to the action trigger you wish to delete
2. Click Delete Selected on the top-right of the page.

### Testing Action Triggers

1. Go to the list of action triggers.
2. Click on the blue link text for the action trigger you’d like to test.
3. Go to the Test tab.
4. If there is a test available, fill in the required information.
5. View the output of the test.

If you are testing an email or SMS notification, use a test account and email as an example. Using the Test feature will actually result in the notification being sent if configured correctly. Similarly, use a test item or barcode when testing a circulation-based event like Mark Lost since the test will mark the item as lost.

## Hooks

Hooks define the Fieldmapper class in the core_type column off of which the rest of the field definitions “hang”.

### Table 2. Hooks

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hook Key</td>
<td>A unique name given to the hook.</td>
</tr>
<tr>
<td>Core Type</td>
<td>Used to link the action trigger to the IDL class in fm_IDL.xml</td>
</tr>
<tr>
<td>Description</td>
<td>Text to describe the purpose of the hook.</td>
</tr>
<tr>
<td>Passive</td>
<td>Indicates whether or not an event is created by direct user action or is circumstantial.</td>
</tr>
</tbody>
</table>

You may also create, edit and delete Hooks but the Core Type must refer to an IDL class in the fm_IDL.xml file.

## Reactors

Reactors link the trigger definition to the action to be carried out.

### Table 3. Action Trigger Reactors

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Name</td>
<td>The name of the Module to run if the action trigger is validated. It must be defined as a subroutine in /openils/lib/perl5/OpenILS/Application/Trigger/Reactor.pm or as a module in /openils/</td>
</tr>
</tbody>
</table>
You may also create, edit and delete Reactors. Just remember that there must be an associated subroutine or module in the Reactor Perl module.

### Validators

Validators set the validation test to be performed to determine whether the action trigger is executed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Name</td>
<td>The name of the subroutine in <code>/openils/lib/perl5/OpenILS/Application/Trigger/Reactor.pm</code> to validate the action trigger.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of validation test to run.</td>
</tr>
</tbody>
</table>

You may also create, edit and delete Validators. Just remember that there must be an associated subroutine in the Reactor.pm Perl module.

### Processing Action Triggers

To run action triggers, an Evergreen administrator will need to run the trigger processing script. This should be set up as a cron job to run periodically. To run the script, use this command:

```
/openils/bin/action_trigger_runner.pl --process-hooks --run-pending
```

You have several options when running the script:

- **--run-pending**: Run pending events to send emails or take other actions as specified by the reactor in the event definition.
- **--process-hooks**: Create hook events
- **--osrf-config=[config_file]**: OpenSRF core config file. Defaults to: `/openils/conf/opensrf_core.xml`
- **--custom-filters=[filter_file]**: File containing a JSON Object which describes any hooks that should use a user-defined filter to find their target objects. Defaults to: `/openils/conf/action_trigger_filters.json`
- **--max-sleep=[seconds]**: When in process-hooks mode, wait up to [seconds] for the lock file to go away. Defaults to 3600 (1 hour).
- **--hooks=hook1[,hook2,hook3,...]**: Define which hooks to create events for. If none are defined, it defaults to the list of hooks defined in the --custom-filters option. Requires --process-hooks.
• --granularity=[label]: Limit creating events and running pending events to those only with [label] granularity setting.

• --debug-stdout: Print server responses to STDOUT (as JSON) for debugging.

• --lock-file=[file_name]: Sets the lock file for the process.

• --verbose: Show details of script processing.

• --help: Show help information.

Examples:

• Run all pending events that have no granularity set. This is what you tell CRON to run at regular intervals.
  perl action_trigger_runner.pl --run-pending

• Batch create all "checkout.due" events
  perl action_trigger_runner.pl --hooks=checkout.due --process-hooks

• Batch create all events for a specific granularity and to send notices for all pending events with that same granularity.
  perl action_trigger_runner.pl --run-pending --granularity=Hourly --process-hooks
Chapter 83. Recent Staff Searches

This feature enables you to view your recent searches as you perform them in the staff client. The number of searches that you can view is configurable. This feature is only available through the staff client; it is not available to patrons in the OPAC.

Administrative Settings

By default, ten searches will be saved as you search the staff client. If you want to change the number of saved searches, then you can configure the number of searches that you wish to save through the Library Settings Editor in the Admin module.

To configure the number of recent staff searches:

1. Click Administration → Local Administration → Library Settings Editor.
2. Scroll to OPAC: Number of staff client saved searches to display on left side of results and record details pages
3. Click Edit.
4. Select a Context from the drop down menu.
5. Enter the number of searches that you wish to save in the Value field.
6. Click Update Setting.

To retain this setting, the system administrator must restart the web server.

If you do not want to save any searches, then you can turn off this feature.

To deactivate this feature:

1. Follow steps 1-4 (one through four) as listed in the previous section.
2. In the value field, enter 0 (zero).

3. Click Update Setting. This will prevent you from viewing any saved searches.

# Recent Staff Searches

Evergreen will save staff searches that are entered through either the basic or advanced search fields. To view recent staff searches:

1. Enter a search term in either the basic or advanced search fields.

2. Your search results for the current search will appear in the middle of the screen. The most recent searches will appear on the left side of the screen.

**Search the Catalog**

Enter a search term, select search fields, and click Update Setting. The search results will display in the middle of the screen.

**Your recent searches:**

- bread
- spaghetti
- cooking
- recipe
- dog
- rain

1. Retro kids cooking
   - Perry, Richard
   - c2004
   - Call number: ACC14
   - 0 of 1 copy available

2. Retro kids cooking
   - Perry, Richard
   - c2004
   - 0 of 0 copies available
Chapter 84. Standing Penalties

In versions of Evergreen prior to 2.3, the following penalty types were available by default. When applied to user accounts, these penalties prevented users from completing the following actions:

- CIRC - Users cannot check out items
- HOLD - Users cannot place holds on items
- RENEW - Users cannot renew items

In version 2.3, two new penalty types are available in Evergreen:

- CAPTURE - This penalty prevents a user’s holds from being captured. If the HOLD penalty has not been applied to a user’s account, then the patron can place a hold, but the targeted item will not appear on a pull list and will not be captured for a hold if it is checked in.
- FULFILL - This penalty prevents a user from checking out an item that is on hold. If the HOLD and CAPTURE penalties have not been applied to a user’s account, then the user can place a hold on an item, and the item can be captured for a hold. However, when he tries to check out the item, the circulator will see a pop up box with the name of the penalty type, FULFILL. The circulator must correct the problem with the account or must override the penalty to check out the item.
Chapter 85. Statistical Categories Editor

This is where you configure your statistical categories (stat cats). Stat cats are a way to save and report on additional information that doesn’t fit elsewhere in Evergreen’s default records. It is possible to have stat cats for copies or patrons.

1. Click Administration → Local Administration → Statistical Categories Editor.

2. To create a new stat cat, enter the name of the category and select either patron or copy from the Type dropdown menu. Each category type has a number of options you may set.

Copy Statistical Categories

Copy stat cats appear in the Holdings Editor. You might use copy stat cats to track books you have bought from a specific vendor, or donations.

An example of the Create a new statistical category controls for copies:

- OPAC Visibility: Should the category be displayed in the OPAC?
- Required: Must the category be assigned a value when editing the item attributes?
- Archive with Circs: Should the category and its values for the copy be archived with aged circulation data?
- SIP Field: Select the SIP field identifier that will contain the category and its value
- SIP Format: Specify the SIP format string

Some sample copy stat cats:

<table>
<thead>
<tr>
<th>Statistical Category Name</th>
<th>Owning Library</th>
<th>OPAC Visibility</th>
<th>Required</th>
<th>SIP Field</th>
<th>SIP Format</th>
<th>Circ Archive</th>
<th>Entries</th>
<th>Add Entry</th>
<th>Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gift Item</td>
<td>Example</td>
<td>Off</td>
<td>Off</td>
<td>No SIP</td>
<td>Off</td>
<td>No</td>
<td>No</td>
<td>Add</td>
<td>Edit</td>
</tr>
<tr>
<td>Kids Books</td>
<td>Example</td>
<td>Off</td>
<td>Off</td>
<td>No SIP</td>
<td>Off</td>
<td>(none)</td>
<td>None</td>
<td>Add</td>
<td>Edit</td>
</tr>
<tr>
<td>Vendor</td>
<td>Example</td>
<td>Off</td>
<td>Off</td>
<td>No SIP</td>
<td>Off</td>
<td>Amazon</td>
<td></td>
<td>Add</td>
<td>Edit</td>
</tr>
</tbody>
</table>
To add an entry, select Add. Due to a known bug, individual entries for stat cats cannot be edited in the web client.

Stat cats can be edited or deleted by clicking on Edit.

This is how the copy stat cats appear in the Holdings Editor:

You can use the Filter by Library selector to display copy stat cats owned by a particular library:

Patron Statistical Categories

Patron stat cats can be used to keep track of information such as a patron’s school affiliation, membership in a group like the Friends of the Library, or patron preferences. They appear in the fourth section of the Patron Registration or Edit Patron screen, under the label Statistical Categories.

An example of the Create a new statistical category controls for patrons:

- OPAC Visibility: Should the category be displayed in the OPAC?
- Required: Must the category be assigned a value when registering a new patron or editing an existing one?
- Archive with Circs: Should the category and its values for the patron be archived with aged circulation data?
- Allow Free Text: May the person registering/editing the patron information supply their own value for the category?
- Show in Summary: Display the category and its value in the patron summary view?
- SIP Field: Select the SIP field identifier that will contain the category and its value
• SIP Format: Specify the SIP format string

**WARNING**

If you make a category required and also disallow free text, make sure that you populate an entry list for the category so that the user may select a value. Failure to do so will result in an unsubmittable patron registration/edit form!

Some sample patron stat cats:

To add an entry, click on Add in the category row under the Add Entry column:

Stat cats can be edited or deleted by clicking on Edit.

Due to a known bug, individual entries for stat cats cannot be edited in the web client.

An organizational unit (consortium, library system branch library, sub library, etc.) may create their own categories and entries, or supplement categories defined by a higher-level org unit with their own entries.

An entry can be set as the default entry for a category and for an org unit. If an entry is set as the default, it will be automatically selected in the patron edit screen, provided no other value has been previously set for the patron. Only one default may be set per category for any given org unit.

Lower-level org unit defaults override defaults set for higher-level org units; but in the absence of a default set for a given org unit, the nearest parent org unit default will be selected.

Default entries for the focus location org unit are marked with an asterisk in the entry dropdowns.
This is how patron stat cats appear in the patron registration/edit screen:

<table>
<thead>
<tr>
<th>Statistical Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>High School</td>
</tr>
<tr>
<td>Preferred Library</td>
</tr>
<tr>
<td>Preferred Transportation</td>
</tr>
<tr>
<td>Proof of residence document</td>
</tr>
<tr>
<td>Provide due date slip</td>
</tr>
</tbody>
</table>

The yellow highlight denotes a stat cat that is required, and you will not be allowed to save or create a patron unless a value is entered.

To remove a stat cat value, select the text in the right-hand box and use your keyboard’s backspace or delete key.
Chapter 86. Statistical Popularity Badges

Statistical Popularity Badges allow libraries to set popularity parameters that define popularity badges, which bibliographic records can earn if they meet the set criteria. Popularity badges can be based on factors such as circulation and hold activity, bibliographic record age, or material type. The popularity badges that a record earns are used to adjust catalog search results to display more popular titles (as defined by the badges) first. Within the OPAC there are two new sort options called "Most Popular" and "Popularity Adjusted Relevance" which will allow users to sort records based on the popularity assigned by the popularity badges.

Popularity Rating and Calculation

Popularity badge parameters define the criteria a bibliographic record must meet to earn the badge, as well as which bibliographic records are eligible to earn the badge. For example, the popularity parameter "Circulations Over Time" can be configured to create a badge that is applied to bibliographic records for DVDs. The badge can be configured to look at circulations within the last 2 years, but assign more weight or popularity to circulations from the last 6 months.

Multiple popularity badges may be applied to a bibliographic record. For each applicable popularity badge, the record will be rated on a scale of 1-5, where a 5 indicates the most popular. Evergreen will then assign an overall popularity rating to each bibliographic record by averaging all of the popularity badge points earned by the record. The popularity rating is stored with the record and will be used to rank the record within search results when the popularity badge is within the scope of the search. The popularity badges are recalculated on a regular and configurable basis by a cron job. Popularity badges can also be recalculated by an administrator directly on the server.

Creating Popularity Badges

There are two main types of popularity badges: point-in-time popularity (PIT), which looks at the popularity of a record at a specific point in time—such as the number of current circulations or the number of open hold requests; and temporal popularity (TP), which looks at the popularity of a record over a period of time—such as the number of circulations in the past year or the number of hold requests placed in the last six months.

The following popularity badge parameters are available for configuration:

- Holds Filled Over Time (TP)
- Holds Requested Over Time (TP)
- Current Hold Count (PIT)
- Circulations Over Time (TP)
- Current Circulation Count (PIT)
- Out/Total Ratio (PIT)
- Holds/Total Ratio (PIT)
• Holds/Holdable Ratio (PIT)
• Percent of Time Circulating (Takes into account all circulations, not specific period of time)
• Bibliographic Record Age (days, newer is better) (TP)
• Publication Age (days, newer is better) (TP)
• On-line Bib has attributes (PIT)
• Bib has attributes and copies (PIT)
• Bib has attributes and copies or URIs (PIT)
• Bib has attributes (PIT)

To create a new Statistical Popularity Badge:
1. Go to Administration→Local Administration→Statistical Popularity Badges.
2. Click on Actions→Add badge.
3. Fill out the following fields as needed to create the badge:

   - only Name, Scope, Weight, Recalculation Interval, Importance Interval, and Discard Value Count are required

   - Name: Library assigned name for badge. Each name must be unique. The name will show up in the OPAC record display. For example: Most Requested Holds for Books-Last 6 Months. Required field.

   - Description: Further information to provide context to staff about the badge.

   - Scope: Defines the owning organization unit of the badge. Badges will be applied to search result sorting when the Scope is equal to, or an ancestor, of the search location. For example, a branch specific search will include badges where the Scope is the branch, the system, and the consortium. A consortium level search, will include only badges where the Scope is set to the consortium. Item specific badges will apply only to records that have items owned at or below the Scope. Required field.

   - Weight: Can be used to indicate that a particular badge is more important than the other badges that the record might earn. The weight value serves as a multiplier of the badge rating. Required field with a default value of 1.

   - Age Horizon: Indicates the time frame during which events should be included for calculating the badge. For example, a popularity badge for Most Circulated Items in the Past Two Years would have an Age Horizon of 2 years. The Age Horizon should be entered as a number followed by day(s), month(s), year(s), such as 6 months or 2 years. Use with temporal popularity (TP) badges only.
• Importance Horizon: Used in conjunction with Age Horizon, this allows more recent events to be considered more important than older events. A value of zero means that all events included by the Age Horizon will be considered of equal importance. With an Age Horizon of 2 years, an Importance Horizon of 6 months means that events, such as checkouts, that occurred within the past 6 months will be considered more important than the circulations that occurred earlier within the Age Horizon.

• Importance Interval: Can be used to further divide up the timeframe defined by the Importance Horizon. For example, if the Importance Interval is 1 month, Evergreen will combine all of the events within that month for adjustment by the Importance Scale (see below). The Importance Interval should be entered as a number followed by 'day(s), week(s), month(s), year(s), such as 6 months or 2 years. Required field.

• Importance Scale: The Importance Scale can be used to assign additional importance to events that occurred within the most recent Importance Interval. For example, if the Importance Horizon is 6 months and the Importance Interval is 1 month, the Importance Scale can be set to 6 to indicate that events that happened within the last month will count 6 times, events that happened 2 months ago will count 5 times, etc. The Importance Scale should be entered as a number followed by day(s), week(s), month(s), year(s), such as 6 months or 2 years.

• Percentile: Can be used to assign a badge to only the records that score above a certain percentile. For example, it can be used indicate that you only want to assign the badge to records in the top 5% of results by setting the field to 95. To optimize the popularity badges, percentile should be set between 95-99 to assign a badge to the top 5%-1% of records.

• Attribute Filter: Can be used to assign a badge to records that contain a specific Record Attribute. Currently this field can be configured by running a report (see note below) to obtain the JSON data that identifies the Record Attribute. The JSON data from the report output can be copied and pasted into this field. A new interface for creating Composite Record Attributes will be implemented with future development of the web client.

• To run a report to obtain JSON data for the Attribute Filter, use SVF Record Attribute Coded Value Map as the template Source. For Displayed Fields, add Code, ID, and/or Description from the Source; also display the Definition field from the Composite Definition linked table. This field will display the JSON data in the report output. Filter on the Definition from the Composite Definition liked table and set the Operator to Is not NULL.

• Circ Mod Filter: Apply the badge only to items with a specific circulation modifier. Applies only to item related badges as opposed to "bib record age" badges, for example.

• Bib Source Filter: Apply the badge only to bibliographic records with a specific source.

• Location Group Filter: Apply the badge only to items that are part of the specified Copy Location Group. Applies only to item related badges.

• Recalculation Interval: Indicates how often the popularity value of the badge should be recalculated for bibliographic records that have earned the badge. Recalculation is controlled by a cron job. Required field with a default value of 1 month.
• Fixed Rating: Can be used to set a fixed popularity value for all records that earn the badge. For example, the Fixed Rating can be set to 5 to indicate that records earning the badge should always be considered extremely popular.

• Discard Value Count: Can be used to prevent certain records from earning the badge to make Percentile more accurate by discarding titles that are below the value indicated. For example, if the badge looks at the circulation count over the past 6 months, Discard Value Count can be used to eliminate records that had too few circulations to be considered "popular". If you want to discard records that only had 1-3 circulations over the past 6 months, the Discard Value Count can be set to 3. Required field with a default value of 0.

• Last Refresh Time: Displays the last time the badge was recalculated based on the Recalculation Interval.

• Popularity Parameter: Types of TP and PIT factors described above that can be used to create badges to assign popularity to bibliographic records.

4. Click OK to save the badge.

New Global Flags

OPAC Default Sort: can be used to set a default sort option for the catalog. Users can always override the default by manually selecting a different sort option while searching.

Maximum Popularity Importance Multiplier: used with the Popularity Adjusted Relevance sort option in the OPAC. Provides a scaled adjustment to relevance score based on the popularity rating earned by bibliographic records. See below for more information on how this flag is used.

Sorting by Popularity in the OPAC

Within the stock OPAC template there is a new option for sorting search results called "Most Popular". Selecting "Most Popular" will first sort the search results based on the popularity rating determined by the popularity badges and will then apply the default "Sort by Relevance". This option will maximize the popularity badges and ensure that the most popular titles appear higher up in the search results.

There is a second new sort option called "Popularity Adjusted Relevance", which can be used to find a balance between popularity and relevance in search results. For example, it can help ensure that records that are popular, but not necessarily relevant to the search, do not supersede records that are both popular and relevant in the search results. It does this by sorting search results using an adjusted version of Relevance sorting. When sorting by relevance, each bibliographic record is assigned a baseline relevance score between 0 and 1, with 0 being not relevant to the search query and 1 being a perfect match. With "Popularity Adjusted Relevance" the baseline relevance is adjusted by a scaled version of the popularity rating assigned to the bibliographic record. The scaled adjustment is controlled by a Global Flag called "Maximum Popularity Importance Multiplier" (MPIM). The MPIM takes the average popularity rating of a bibliographic record (1-5) and creates a scaled adjustment that is applied to the baseline relevance for the record. The adjustment can be between

Chapter 8.6 Statistical Popularity Badges
Report errors in this documentation using Launchpad.
1.0 and the value set for the MPIM. For example, if the MPIM is set to 1.2, a record with an average popularity badge score of 5 (maximum popularity) would have its relevance multiplied by 1.2—in effect giving it the maximum increase of 20% in relevance. If a record has an average popularity badge score of 2.5, the baseline relevance of the record would be multiplied by 1.1 (due to the popularity score scaling the adjustment to half way between 1.0 and the MPIM of 1.2) and the record would receive a 10% increase in relevance. A record with a popularity badge score of 0 would be multiplied by 1.0 (due to the popularity score being 0) and would not receive a boost in relevance.

**Popularity Badge Example**

A popularity badge called "Long Term Holds Requested" has been created which has the following parameters:

- **Popularity Parameter**: Holds Requested
- **Over Time Scope**: CONS
- **Weight**: 1 (default)
- **Age Horizon**: 5 years
- **Percentile**: 99
- **Recalculation Interval**: 1 month (default)
- **Discard Value Count**: 0 (default)

This popularity badge will rate bibliographic records based on the number of holds that have been placed on it over the past 5 years and will only apply the badge to the top 1% of records (99th percentile).

If a keyword search for harry potter is conducted and the sort option "Most Popular" is selected, Evergreen will apply the popularity rankings earned from badges to the search results.

Title search: harry potter. Sort by: Most Popular.
The popularity badge also appears in the bibliographic record display in the catalog. The name of the badge earned by the record and the popularity rating are displayed in the Record Details.

A popularity badge of 5.0/5.0 has been applied to the most popular bibliographic records where the search term "harry potter" is found in the title. In the image above, the popularity badge has identified records from the Harry Potter series by J.K. Rowling as the most popular titles matching the search and has listed them first in the search results.
Content descriptions

- **General:** "Year 1"—Spine.
- **Note:** Sequel: Harry Potter and the Chamber of Secrets.
- **Summary:** Rescued from the outrageous neglect of his aunt and uncle, a young boy with a great destiny proves his worth while attending Hogwarts School for Witchcraft and Wizardry.
Chapter 87. Work Log

Expanding the Work Log

In versions of Evergreen prior to 2.3, the work log recorded check ins, checkouts, patron registration, patron editing, and renewals. In version 2.3, the work log also records holds that have been placed and payments that have been received.

In this example, a staff member has collected a fine from a patron. To view this action in the work log, click Administration → Local Administration → Work Log. By default, the work log will record the staff member’s username, the amount that was received, the payment type, the patron’s barcode, and the patron’s last name.

In this example, a staff member has placed a hold for a patron. To view this action in the work log, click Administration → Local Administration → Work Log. By default, the work log will record the staff member’s username, the hold type, the patron’s barcode, and the patron’s last name.
Part VIII. Acquisitions
# Table of Contents

88. Acquisitions .................................................. 419  
   Initial Configuration .......................................... 419  
   Acquisitions Workflow ........................................ 419  
89. Selection Lists and Purchase Orders ......................... 421  
   Selection Lists .................................................. 421  
      Create a selection list ..................................... 421  
      Add items to a selection list .............................. 421  
      Clone selection lists ...................................... 421  
      Merge selection lists ..................................... 421  
      Delete selection lists .................................... 422  
      Mark Ready for Selector ................................... 422  
      Convert selection list to purchase order ............... 423  
   Purchase Orders ............................................... 423  
      Naming your purchase order ............................... 423  
      Activating your purchase order ........................... 425  
      Line item statuses ........................................ 426  
   Brief Records .................................................. 428  
      Add brief records to a selection list .................... 428  
      Add brief records to purchase orders .................... 429  
   MARC Federated Search ........................................ 429  
   Line Items ....................................................... 431  
      Return to Line Item .......................................... 431  
      Display a Count of Existing Copies on Selection List and Purchase Order Lineitems 432  
90. Invoices ....................................................... 433  
   Introduction ..................................................... 433  
   Creating invoices and adding line items ..................... 433  
      Creating a blanket invoice ................................. 433  
      Adding line items from a Purchase Order or search results screen to an invoice ............... 434  
      Search for line items from an invoice .................... 435  
      Create an invoice for a purchase order ................... 439  
      Link an existing invoice to a purchase order .......... 440  
   Electronic Invoicing ........................................... 441  
      View an invoice ............................................... 441  
   Receive Items From an Invoice ................................ 442  
      Receive Items in Batch (List Mode) ....................... 442  
      Receive Specific Copies (Numeric Mode) .................. 444  
91. Load MARC Order Records ..................................... 446  
   Introduction ..................................................... 446  
   Basic Upload Options ......................................... 446  
   Record Matching Options ..................................... 447  
   Default Upload Settings ...................................... 448  
   Sticky Settings ................................................ 449  
   Use Cases for MARC Order Upload form ....................... 450  
92. Placing purchase requests from a patron record .......... 455  
93. Managing patron purchase requests .......................... 456  
   Introduction ..................................................... 456  
   Adding a request ............................................... 456  
   Adding requests to selection lists ........................ 456  
94. "Blanket" Orders ............................................. 458  
   Example .......................................................... 458  
   More details about blanket orders .......................... 458
Chapter 88. Acquisitions

Initial Configuration

Before beginning to use Acquisitions, the following must be configured by an administrator:

• Cancel/Suspend Reasons (optional)
• Claiming (optional)
• Currency Types (defaults exist)
• Distribution Formulas (optional)
• EDI Accounts (optional)
• Exchange Rates (defaults exist)
• Funds and Fund Sources
• Invoice Types (defaults exist) and Invoice Payment Methods
• Line Item Features (optional)
• Merge Overlay Profiles and Record Match Sets
• Providers

More details can be found in the Staff Client System Administration manual.

Acquisitions Workflow

The following diagram shows how the workflow functions in Evergreen. One of the differences in this process you should notice is that when creating a selection list on the vendor site, libraries will be downloading and importing the vendor bibs and item records.
Chapter 89. Selection Lists and Purchase Orders

Selection Lists

Selection lists allow you to create, manage, and save lists of items that you may want to purchase. To view your selection list, click Acquisitions → My Selection Lists. Use the general search to view selection lists created by other users.

Create a selection list

Selection lists can be created in four areas within the module. Selection lists can be created when you Add Brief Records, Upload MARC Order Records, or find records through the MARC Federated Search. In each of these interfaces, you will find the Add to Selection List field. Enter the name of the selection list that you want to create in that field.

Selection lists can also be created through the My Selection Lists interface:

1. Click Acquisitions → My Selection Lists.
2. Click the New Selection List drop down arrow.
3. Enter the name of the selection list in the box that appears.
4. Click Create.

Add items to a selection list

You can add items to a selection list in one of three ways: add a brief record; upload MARC order records; add records through a federated search; or use the View/Place Orders menu item in the catalog.

Clone selection lists

Cloning selection lists enables you to copy one selection list into a new selection list. You can maintain both copies of the list, or you can delete the previous list.

1. Click Acquisitions → My Selection Lists.
2. Check the box adjacent to the list that you want to clone.

3. Click Clone Selected.

4. Enter a name into the box that appears, and click Clone.

**Merge selection lists**

You can merge two or more selection lists into one selection list.

1. Click Acquisitions → My Selection Lists.

2. Check the boxes adjacent to the selection lists that you want to merge, and click Merge Selected.

3. Choose the Lead Selection List from the drop down menu. This is the list to which the items on the other list(s) will be transferred.

4. Click Merge.

**Delete selection lists**

You can delete selection lists that you do not want to save. You will not be able to retrieve these items through the General Search after you have deleted the list. You must delete all line items from a selection list before you can delete the list.

1. Click Acquisitions → My Selection Lists.

2. Check the box adjacent to the selection list(s) that you want to delete.

3. Click Delete Selected.

**Mark Ready for Selector**

After an item has been added to a selection list or purchase order, you can mark it ready for selector. This step is optional but may be useful to individual workflows.
1. If you want to mark part of a selection list ready for selector, then you can check the box(es) of the line item(s) that you wish to mark ready for selector. If you want to mark the entire list ready for selector, then skip to step 2.

2. Click Actions → Mark Ready for Selector.

3. A pop up box will appear. Choose to mark the selected line items or all line items.

4. Click Go.

5. The screen will refresh. The marked line item(s) will be highlighted pink, and the status changes to selector-ready.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>-- Actions --</td>
<td>selector-ready</td>
</tr>
</tbody>
</table>

**Convert selection list to purchase order**

Use the Actions menu to convert a selection list to a purchase order.

1. From a selection list, click Actions → Create Purchase Order.

2. A pop up box will appear.

3. Select the ordering agency from the drop down menu.

4. Enter the provider.

5. Check the box adjacent to prepayment required if prepayment is required.

6. Choose if you will add All Lineitems or Selected Lineitems to your purchase order.

7. Check the box if you want to Import Bibs and Create Copies in the catalog.

8. Click Submit.

**Purchase Orders**

Purchase Orders allow you to keep track of orders and, if EDI is enabled, communicate with your provider. To view purchase orders, click Acquisitions → Purchase Orders.

**Naming your purchase order**

You can give your purchase order a name.
When creating a purchase order or editing an existing purchase order, the purchase order name must be unique for the ordering agency. Evergreen will display a warning dialog to users, if they attempt to create or edit purchase order names that match the names of already existing purchase orders at the same ordering agency. The Duplicate Purchase Order Name Warning Dialog includes a link that will open the matching purchase order in a new tab.

Purchase Order Names are case sensitive.

**Duplicate PO Name Detection When Creating a New Purchase Order**

When a duplicate purchase order name is detected during the creation of a new purchase order, the user may:

- Click View PO to view the purchase order with the matching name. The purchase order will open in a new tab.
- Click Cancel to cancel the creation of the new purchase order.
- Within the Name (optional) field, enter a different, unique name for the new purchase order.

If the purchase order name is unique for the ordering agency, the user will continue filling in the remaining fields and click Save.

If the purchase order name is not unique for the ordering agency, the Save button will remain grayed out to the user until the purchase order is given a unique name.

**Duplicate PO Name Detection When Editing the Name of an Existing Purchase Order**

To change the name of an existing purchase order:

1. Within the purchase order, the Name of the purchase order is a link (located at the top left-hand side of the purchase order). Click the PO Name.
2. A new window will open, where users can rename the purchase order.
3. Enter the new purchase order name.
4. Click OK.

If the new purchase order name is unique for the ordering agency, the purchase order will be updated to reflect the new name. If the purchase order name is not unique for the ordering agency, the purchase order will not be updated with the new name. Instead, the user will see the Duplicate Purchase Order Name Warning Dialog within the purchase order.

When a duplicate purchase order name is detected during the renaming of an existing purchase order, the user may:

- Click View PO to view the purchase order with the matching name. The purchase order will open in a new tab.
- Repeat the steps to change the name of an existing purchase order and make the name unique.

**Activating your purchase order**

When the appropriate criteria have been met the Activate Order button will appear and you can proceed with the following:

1. Click the button Activate Order.

2. When you activate the order the bibliographic records and copies will be imported into the catalogue using the Vandelay interface, if not previously imported. See How to Load Bibliographic Records and Items into the Catalogue for instructions on using the Vandelay interface.

3. The funds associated with the purchases will be encumbered.

After you click Activate Order, you will be presented with the record import interface for records that are not already in the catalog. Once you complete entering in the parameters for the record
import interface, the progress screen will appear. As of Evergreen 2.9, this progress screen consists of a progress bar in the foreground, and a tally of the following in the background of the bottom-left corner:

- Lineitems processed
- Vandelay Records processed
- Bib Records Merged/Imported
- ACQ Copies Processed
- Debits Encumbered
- Real Copies Processed

**Activate Purchase Order without loading items**

It is possible to activate a purchase order without loading items. Once the purchase order has been activated without loading items, it is not possible to load the items. This feature should only be used in situations where the copies have already been added to the catalogue, such as:

- Cleaning up pre-acquisitions backlog
- Direct purchases that have already been catalogued

To use this feature, click the Activate Without Loading Items button.

**Activate Purchase Order with Zero Copies**

By default, a purchase order cannot be activated if a line item on the purchase order has zero copies. To activate a purchase order with line items that have zero copies, check the box Allow activation with zero-copy lineitems.

**Line item statuses**

The purchase orders interface keeps track of various statuses that your line items might be in. This section lists some of the statuses you might see when looking at purchase orders.
Canceled and Delayed Items

In the purchase order interface, you can easily differentiate between canceled and delayed items. Each label begins with Canceled or Delayed. To view the list, click Administration → Acquisitions Administration → Cancel Reasons.

The cancel/delay reason label is displayed as the line item status in the list of line items or as the copy status in the list of copies.

A delayed line item can now be canceled. You can mark a line item as delayed, and if later, the order cannot be filled, you can change the line item’s status to canceled. When delayed line items are canceled, the encumbrances are deleted.

Cancel/delay reasons now appear on the worksheet and the printable purchase order.

Paid PO Line Items

Purchase Order line items are marked as "Paid" in red text when all non-cancelled copies on the line item have been invoiced.
Brief Records

Brief records are short bibliographic records with minimal information that are often used as placeholder records until items are received. Brief records can be added to selection lists or purchase orders and can be imported into the catalog. You can add brief records to new or existing selection lists. You can add brief records to new, pending or on-order purchase orders.

Add brief records to a selection list

1. Click Acquisitions → New Brief Record. You can also add brief records to an existing selection list by clicking the Actions menu on the selection list and choosing Add Brief Record.

2. Choose a selection list from the drop down menu, or enter the name of a new selection list.

3. Enter bibliographic information in the desired fields.

4. Click Save Record.

New Brief Record

Add To Selection List  Business Reference

Title of work  Business Grammar, Style & Usage

Author of work  Abell, Alicia

Language of work

Pagination

ISBN  9781587620263

ISSN

Price

Identifier

Publisher

Publication Date  2003

Edition

UPC

Save Record
Add brief records to purchase orders

You can add brief records to new or existing purchase orders.

1. Open or create a purchase order. See the section on [purchase orders](#) for more information.

2. Click Add Brief Record.

3. Enter bibliographic information in the desired fields. Notice that the record is added to the purchase order that you just created.

4. Click Save Record.

**New Brief Record**

<table>
<thead>
<tr>
<th>Adding to Purchase Order</th>
<th>49</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title of work</td>
<td>Small Business for Dummies</td>
</tr>
<tr>
<td>Author of work</td>
<td>Tyson, Eric</td>
</tr>
<tr>
<td>Language of work</td>
<td></td>
</tr>
<tr>
<td>Pagination</td>
<td></td>
</tr>
<tr>
<td>ISBN</td>
<td>978-0470177471</td>
</tr>
<tr>
<td>ISSN</td>
<td></td>
</tr>
<tr>
<td>Price</td>
<td></td>
</tr>
<tr>
<td>Identifier</td>
<td></td>
</tr>
<tr>
<td>Publisher</td>
<td></td>
</tr>
<tr>
<td>Publication Date</td>
<td>2008</td>
</tr>
<tr>
<td>Edition</td>
<td></td>
</tr>
<tr>
<td>UPC</td>
<td></td>
</tr>
</tbody>
</table>

**MARC Federated Search**

The MARC Federated Search enables you to import bibliographic records into a selection list or purchase order from a Z39.50 source.

1. Click Acquisitions → MARC Federated Search.

2. Check the boxes of Z39.50 services that you want to search. Your local Evergreen Catalog is checked by default. Click Submit.
3. A list of results will appear. Click the "Copies" link to add copy information to the line item. See the section on Line Items for more information.

4. Click the Notes link to add notes or line item alerts to the line item. See the section on Line Items for more information.

5. Enter a price in the "Estimated Price" field.

6. You can save the line item(s) to a selection list by checking the box on the line item and clicking Actions → Save Items to Selection List. You can also create a purchase order from the line item(s) by checking the box on the line item and clicking Actions → Create Purchase Order.
Line Items

Return to Line Item

This feature enables you to return to a specific line item on a selection list, purchase order, or invoice after you have navigated away from the page that contained the line item. This feature is especially useful when you must identify a line item in a long list. After working with a line item, you can return to your place in the search results or the list of line items.

To use this feature, select a line item, and then, depending on the location of the line item, click Return or Return to search. Evergreen will take you back to the specific line item in your search and highlight the line item with a colored box.

For example, you retrieve a selection list, find a line item to examine, and click the Copies link. After editing the copies, you click Return. Evergreen takes you back to your selection list and highlights the line item that you viewed.

This feature is available in General Search Results, Purchase Orders, and Selection Lists, whenever any of the following links are available:

- Selection List
- Purchase Order
- Copies
- Notes
- Worksheet

This feature is available in Invoices whenever any of the following links are available:

- Title
Selection List

Purchase Order

Display a Count of Existing Copies on Selection List and Purchase Order Lineitems

When displaying Acquisitions lineitems within the Selection List and Purchase Order interfaces, Evergreen displays a count of existing catalog copies on the lineitem. The count of existing catalog copies refers to the number of copies owned at the ordering agency and / or the ordering agency’s child organization units.

The counts display for lineitems that have a direct link to a catalog record. Generally, this includes lineitems created as "on order" based on an existing catalog record and lineitems where "Load Bibs and Items" has been applied.

The count of existing copies does not include copies that are in either a Lost or a Missing status.

The existing copy count displays in the link "bar" located below the Order Identifier within the lineitem.

If no existing copies are found, a "0" (zero) will display in plain text.

If the existing copy count is greater than zero, then the count will display in bold and red on the lineitem.

The user may also hover over the existing copy count to view the accompanying tooltip.
Chapter 90. Invoices

Introduction

You can create invoices for purchase orders, individual line items, and blanket purchases. You can also link existing invoices to purchase order.

You can invoice items before you receive the items if desired. You can also reopen closed invoices, and you can print all invoices.

Creating invoices and adding line items

You can add specific line items to an invoice from the PO or acquisitions search results screen. You can also search for relevant line items from within the invoice interface. In addition, you can add all line items from an entire Purchase order to an invoice or you can create a blanket invoice for items that are not attached to a purchase order.

Creating a blanket invoice

You can create a blanket invoice for purchases that are not attached to a purchase order.

1. Click Acquisitions → Create invoice.

2. Enter the invoice information in the top half of the screen.

3. To add charges for materials not attached to a purchase order, click Add Charge... This functionality may also be used to add shipping, tax, and other fees.

4. Select a charge type from the drop-down menu.

   New charge types can be added via Administration → Acquisitions Administration → Invoice Item Types.

5. Select a fund from the drop-down menu.

6. Enter a Title/Description of the resource.

7. Enter the amount that you were billed.

8. Enter the amount that you paid.

9. Save the invoice.
Adding line items from a Purchase Order or search results screen to an invoice

You can create an invoice or add line items to an invoice directly from a Purchase Order or an acquisitions search results screen.

1. Place a checkmark in the box for selected line items from the Purchase Order’ or acquisitions search results page.

2. If you are creating a new invoice, click Actions → Create Invoice From Selected Line Items. Enter the invoice information in the top half of the screen.

3. If you are adding the line items to an existing invoice, click Actions → Link Selected Line Items to Invoice. Enter the Invoice # and Provider and then click the Link button.

4. Evergreen automatically enters the number of items that was ordered in the # Invoiced and # Paid fields. Adjust these quantities as needed.

5. Enter the amount that the organization was billed. This entry will automatically propagate to the Paid field.

6. You have the option to add charge types if applicable. Charge types are additional charges that can be selected from the drop-down menu. Common charge types include taxes and handling fees.

7. You have four options for saving an invoice.
   - Click Save to save the changes you have made while staying in the current invoice.
   - Click Save & Clear to save the changes you have made and to replace the current invoice with a new invoice so that you can continue invoicing items.
   - Click Prorate to save the invoice and prorate any additional charges, such as taxes, across funds, if multiple funds have been used to pay the invoice.
Prorating will only be applied to charge types that have the Prorate? flag set to true. This setting can be adjusted via Administration → Acquisitions Administration → Invoice Item Types.

- Click Close. Choose this option when you have completed the invoice. This option will also save any changes that have been made. Funds will be disencumbered when the invoice is closed.

8. You can re-open a closed invoice by clicking the link, Re-open invoice. This link appears at the bottom of a closed invoice.

**Search for line items from an invoice**

You can open an invoice, search for line items from the invoice, and add your search results to a new or existing invoice. This feature is especially useful when you want to populate an invoice with line items from multiple purchase orders.

In this example, we’ll add line items to a new invoice:

1. Click Acquisitions → Create Invoice.

2. An invoice summary appears at the top of the invoice and includes the number of line items on the invoice and the expected cost of the items. This number will change as we add line items to the invoice.

3. Enter the invoice details (optional). If you do not enter the invoice details, then Evergreen will populate the Provider and Receiver fields with information from the line items.

If you do not want to display the details, click Hide Details.
4. Click the Search tab to add line items to an invoice.

5. Select your search criteria from the drop-down menu.

6. On the right side of the screen, Limit to Invoiceable Items is checked by default. Invoiceable items are those that are on order, have not been cancelled, and have not yet been invoiced. Evergreen also filters out items that have already been added to an invoice. Finally, if this box is checked, and if you entered the invoice details at the top of the screen, then Evergreen will filter your search for items that have the same provider as the one that you entered. If you have not entered the invoice details, then Evergreen removes this limit.

7. Sort by title (optional). By default, results are listed by line item number. Check this box to sort by ascending title.

8. Building the results list progressively (optional). By default, new search results will replace previous results on the screen. Check this box for the search results list to build with each subsequent search. This option is useful for libraries that might search for line items by scanning an ISBN. Several ISBNs can be scanned and then the entire result set can be selected and moved to the invoice in a batch.

9. Click Search.
10 Use the Next button to page through results, or select a line item(s), and click Add Selected Items to Invoice. The rows that you selected are highlighted, and the invoice summary at the top of the screen updates.
11. Click the Invoice tab to see the updated invoice.

12. Evergreen automatically enters the number of items that was ordered in the # Invoiced and # Paid fields. Adjust these quantities as needed.

13. Enter the amount that the organization was billed. This entry will automatically propagate to the Paid field. The Per Copy field calculates the cost of each copy by dividing the amount that was billed by the number of copies for which the library paid.
Create an invoice for a purchase order

You can create an invoice for all of the line items on a purchase order. With the exception of fields with drop-down menus, no limitations on the data that you enter exist.

1. Open a purchase order.
2. Click Create Invoice.
3. Enter a Vendor Invoice ID. This number may be listed on the paper invoice sent from your vendor.
4. Choose a Receive Method from the drop-down menu. The system will default to Paper.
5. The Provider is generated from the purchase order and is entered by default.
6. Enter a note (optional).
7. Select a payment method from the drop-down menu (optional).
8. The Invoice Date is entered by default as the date that you create the invoice. You can change the date by clicking in the field. A calendar drops down.
9. Enter an Invoice Type (optional).
10. The Shipper defaults to the provider that was entered in the purchase order.
11. Enter a Payment Authorization (optional).
12. The Receiver defaults to the branch at which your workstation is registered. You can change the receiver by selecting an org unit from the drop-down menu.

The bibliographic line items are listed in the next section of the invoice. Along with the title and author of the line items is a summary of copies ordered, received, invoiced, claimed,
and cancelled. You can also view the amounts estimated, encumbered, and paid for each line item. Finally, each line item has a line item ID and links to the selection list (if used) and the purchase order.

13 Evergreen automatically enters the number of items that was ordered in the # Invoiced and # Paid fields. Adjust these quantities as needed.

14 Enter the amount that the organization was billed. This entry will automatically propagate to the Paid field. The Per Copy field calculates the cost of each copy by dividing the amount that was billed by the number of copies for which the library paid.

15 You have the option to add charge types if applicable. Charge types are additional charges that can be selected from the drop-down menu. Common charge types include taxes and handling fees.

16 You have four options for saving an invoice.

• Click Save to save the changes you have made while staying in the current invoice.

• Click Save & Clear to save the changes you have made and to replace the current invoice with a new invoice so that you can continue invoicing items.

• Click Prorate to save the invoice and prorate any additional charges, such as taxes, across funds, if multiple funds have been used to pay the invoice.

Prorating will only be applied to charge types that have the Prorate? flag set to true. This setting can be adjusted via Administration → Acquisitions Administration → Invoice Item Types.

• Click Close. Choose this option when you have completed the invoice. This option will also save any changes that have been made. Funds will be disencumbered when the invoice is closed.

17 You can re-open a closed invoice by clicking the link, Re-open invoice. This link appears at the bottom of a closed invoice.

Link an existing invoice to a purchase order

You can use the link invoice feature to link an existing invoice to a purchase order. For example, an invoice is received for a shipment with items on purchase order #1 and purchase order #2. When the invoice arrives, purchase order #1 is retrieved, and the invoice is created. To receive the items on purchase order #2, simply link the invoice to the purchase order. You do not need to recreate it.

1. Open a purchase order.

2. Click Link Invoice.

3. Enter the Invoice # and the Provider of the invoice to which you wish to link.
4. Click Link.

Electronic Invoicing

Evergreen can receive electronic invoices from providers. To access an electronic invoice, you must:

1. Configure EDI for your provider.

2. Evergreen will receive invoices electronically from the provider.

3. Click Acquisitions → Open Invoices to view a list of open invoices, or use the General Search to retrieve invoices. Click a hyperlinked invoice number to view the invoice.

View an invoice

You can view an invoice in one of four ways: view open invoices; view invoices on a purchase order; view invoices by searching specific invoice fields; view invoices attached to a line item.

1. To view open invoices, click Acquisitions → Open invoices. This opens the Acquisitions Search screen. The default fields search for open invoices. Click Search.

2. To view invoices on a purchase order, open a purchase order and click the View Invoices link. The number in parentheses indicates the number of invoices that are attached to the purchase order.
3. To view invoices by searching specific invoice fields, see the section on searching the acquisitions module.

4. To view invoices for a line item, see the section on line item invoices.

**Receive Items From an Invoice**

This feature enables users to receive items from an invoice. Staff can receive individual copies, or they can receive items in batch.

**Receive Items in Batch (List Mode)**

In this example, we have created a purchase order, added line items and copies, and activated the purchase order. We will create an invoice from the purchase order, receive items, and invoice them. We will receive the items in batch from the invoice.

1) Retrieve a purchase order.

2) Click Create Invoice.

3) The blank invoice appears. In the top half of the invoice, enter descriptive information about the invoice. In the bottom half of the invoice, enter the number of items for which you were invoiced, the amount that you were billed, and the amount that you paid.
4) Click Save. You must choose a save option before you can receive items.

5) The screen refreshes. In the top right corner of the screen, click Receive Items.

6) The Acquisitions Invoice Receiving screen opens. By default, this screen enables users to receive items in batch, or Numeric Mode. You can select the number of copies that you want to receive; you are not receiving specific copies in this mode.

7) Select the number of copies that you want to receive. By default, the number that you invoiced will appear. In this example, we will receive one copy of each title.

You cannot receive fewer items than 0 (zero) or more items than the number that you ordered.

8) Click Receive Selected Copies.
Acquisitions Invoice Receiving

Invoice #ABCD1234

[ Use List Mode ]

Receive Selected Copies

One Good Turn, by Atkinson, Kate (9780552772440)
2 Ordered, 0 Received, 2 Invoiced, 0 Claimed, 0 Cancelled
Estimated $10.00, Encumbered $0.00, Paid $10.00
# 36 on 10 11/2/11

Number of copies to receive: 1

When Will There Be Good News?, by Atkinson, Kate (9780552772457)
2 Ordered, 0 Received, 2 Invoiced, 0 Claimed, 0 Cancelled
Estimated $10.00, Encumbered $0.00, Paid $10.00
# 36 on 10 11/2/11

Number of copies to receive: 1

Started Early, Took My Dog, by Atkinson, Kate (9780385608022)
2 Ordered, 0 Received, 2 Invoiced, 0 Claimed, 0 Cancelled
Estimated $10.00, Encumbered $0.00, Paid $10.00
# 36 on 10 11/2/11

Number of copies to receive: 1

Receive Selected Copies

9) When you are finished receiving items, close the screen. You can repeat this process as you receive more copies.

Receive Specific Copies (Numeric Mode)

In this example, we have created a purchase order, added line items and copies, and activated the purchase order. We will create an invoice from the purchase order, receive items, and invoice them. We will receive specific copies from the invoice. This function may be useful to libraries who purchase items that have been barcoded by their vendor.

1) Complete steps 1-5 in the previous section.

2) The Acquisitions Invoice Receiving screen by default enables user to receive items in batch, or Numeric Mode. Click Use List Mode to receive specific copies.

3) Select the check boxes adjacent to the copies that you want to receive. Leave unchecked the copies that you do not want to receive.

4) Click Receive Selected Copies.
The screen will refresh. Copies that have not yet been received remain on the screen so that you can receive them when they arrive.

5) When all copies on an invoice have been received, a message confirms that no copies remain to be received.

6) The purchase order records that all items have been received.
Chapter 91. Load MARC Order Records

Introduction

The Acquisitions Load MARC Order Record interface enables you to add MARC records to selection lists and purchase orders and upload the records into the catalog. You can both create and activate purchase orders in one step from this interface. You can also load bibs and items into the catalog.

Leveraging the match sets available in the cataloging MARC batch Import interface, you can also utilize record matching mechanisms to prevent the creation of duplicate records.

For detailed instructions on record matching and importing, see the cataloging manual.

Basic Upload Options

1. Click Acquisitions → Load MARC Order Records.

2. If you want to upload the MARC records to a new purchase order, then check Create Purchase Order.

3. If you want to activate the purchase order at the time of creation, then check Activate Purchase Order.

4. Enter the name of the Provider. The text will auto-complete.

5. Select an org unit from the drop down menu. The context org unit is the org unit responsible for placing and managing the order. It defines what org unit settings (eg copy locations) are in scope, what fiscal year to use, who is allowed to view/modify the PO, where the items should be delivered and the EDI SAN. In the case of a multi-branch system uploading records for multiple branches, choosing the system is probably best. Single branch libraries or branches responsible for their own orders should probably select the branch.

6. If you want to upload the records to a selection list, you can select a list from the drop down menu, or type in the name of the selection list that you want to create.

7. Select a Fiscal Year from the dropdown menu that matches the fiscal year of the funds that will be used for the order. If no fiscal year is selected, the system will use the organizational unit’s default fiscal year stored in the database. If not fiscal year is set, the system will default to the current calendar year.
Record Matching Options

Use the options below the horizontal rule for the system to check for matching records before importing an order record.

1. Create a queue to which you can upload your records, or add your records to an existing queue.
2. Select a Record Match Set from the drop-down menu.
3. Select a Merge Profile. Merge profiles enable you to specify which tags should be removed or preserved in incoming records.
4. Select a Record Source from the drop-down menu.
5. If you want to automatically import records on upload, select one or more of the following options.
   a. Import Non-Matching Records - import any records that don’t have a match in the system.
   b. Merge on Exact Match (901c) - use only for records that will match on the 901c field.
   c. Merge on Single Match - import records that only have one match in the system.
   d. Merge on Best Match - If more than one match is found in the catalog for a given record, Evergreen will attempt to perform the best match as defined by the match score.
6. To only import records that have a quality equal to or greater than the existing record, enter a Best/Single Match Minimum Quality Ratio. Divide the incoming record quality score, as determined by the match set’s quality metrics, by the record quality score of the best match that exists in the catalog. If you want to ensure that the inbound record is only imported when it has a higher quality than the best match, then you must enter a ratio that is higher than 1, such as 1.1. If you want to bypass all quality restraints, enter a 0 (zero) in this field.

7. Select an Insufficient Quality Fall-Through Profile if desired. This field enables you to indicate that if the inbound record does not meet the configured quality standards, then you may still import the record using an alternate merge profile. This field is typically used for selecting a merge profile that allows the user to import holdings attached to a lower quality record without replacing the existing (target) record with the incoming record. This field is optional.

8. If your order records contain holdings information, by default, Evergreen will load them as acquisitions copies. (Note: These can be overlayed with real copies during the MARC batch importing process.) Or you can select Load Items for Imported Records to load them as live copies that display in the catalog.

Default Upload Settings

You can set default upload values by modifying the following settings in Administration → Local Administration → Library Settings Editor:

- Upload Activate PO
• Upload Create PO
• Upload Default Insufficient Quality Fall-Thru Profile
• Upload Default Match Set
• Upload Default Merge Profile
• Upload Upload Default Min. Quality Ratio
• Upload Default Provider
• Upload Import Non Matching by Default
• Upload Load Items for Imported Records by Default
• Upload Merge on Best Match by Default
• Upload Merge on Exact Match by Default
• Upload Merge on Single Match by Default

Sticky Settings

If the above default settings are not implemented, the selections/values used in the following fields will be sticky and will automatically populate the fields the next time the Load MARC Order Records screen is pulled up:

• Create Purchase Order
• Activate Purchase Order
• Context Org Unit
• Record Match Set
• Merge Profile
• Import Non-Matching Records
• Merge on Exact Match (901c)
• Merge on Single Match
• Merge on Best Match
• Best/Single Match Minimum Quality Ratio
• Insufficient Quality Fall-Through Profile
• Load Items for Imported Records

Use Cases for MARC Order Upload form

You can add items to a selection list or purchase order and ignore the record matching options, or you can use both acquisitions and cataloging functions. In these examples, you will use both functions.

Example 1 Using the Acquisitions MARC Batch Load interface, upload MARC records to a selection list and import queue, and match queued records with existing catalog records.

In this example, an acquisitions librarian has received a batch of MARC records from a vendor. She will add the records to a selection list and a Vandelay record queue.

A cataloger will later view the queue, edit the records, and import them into the catalog.

1. Click Acquisitions → Load MARC Order Records
2. Add MARC order records to a Selection list and/or a Purchase Order. Check the box to create a purchase order if desired.
3. Select a Provider from the drop-down menu, or begin typing the code for the provider, and the field will auto-fill.
4. Select a Context Org Unit from the drop down-menu, or begin typing the code for the context org unit, and the field will auto-fill.
5. Select a Selection List from the drop down menu, or begin typing the name of the selection list. You can create a new list, or the field will auto-fill.
6. Create a new record import queue, or upload the records to an existing queue.

7. Select a Record Match Set.

8. Browse your computer to find the MARC file, and click Upload.

9. The processed items appear at the bottom of the screen.

```
Lineitems Processed       7
Vandelay Records Processed 7
Bib Records Merged/Imported 0
ACQ Copies Processed 0
Debits Encumbered 0
Real Copies Processed 0
Upload Complete!
```

9. You can click the link(s) to access the selection list or the import queue. Click the link to View Selection List.

11. Look at the first line item. The line item has not yet been linked to the catalog, but it is linked to a record import queue. Click the link to the queue to examine the MARC record.
The batch import interface opens in a new tab. The bibliographic records appear in the queue. Records that have matches are identified in the queue. You can edit these records and/or import them into the catalog, completing the process.

Example 2: Using the Acquisitions MARC Batch Load interface, upload MARC records to a selection list, and use the Vandelay options to import the records directly into the catalog. The Vandelay options will enable you to match incoming records with existing catalog records.

In this example, a librarian will add MARC records to a selection list, create criteria for matching incoming and existing records, and import the matching and non-matching records into the catalog.

1. Click Acquisitions → Load MARC Order Records
2. Add MARC order records to a Selection list and/or a Purchase Order. Check the box to create a purchase order if desired.
3. Select a Provider from the drop down menu, or begin typing the code for the provider, and the field will auto-fill.
4. Select a Context Org Unit from the drop down menu, or begin typing the code for the context org unit, and the field will auto-fill.
5. Select a Selection List from the drop down menu, or begin typing the name of the selection list. You can create a new list, or the field will auto-fill.
6. Create a new record import queue, or upload the records to an existing queue.

7. Select a Record Match Set.

8. Select Merge Profile → Match-Only Merge.

9. Check the boxes adjacent to Import Non-Matching Records and Merge on Best Match.

10. Browse your computer to find the MARC file, and click Upload.

11. Click the link to View Selection List Line items that do not match existing catalog records on title and ISBN contain the link, link to catalog. This link indicates that you could link the line item to a catalog record, but currently, no match exists between the line item and catalog records. Line items that do have matching records in the catalog contain the link, catalog.
12. Click the catalog link to view the line item in the catalog.

Permissions to use this Feature

**IMPORT_MARC** - Using batch importer to create new bib records requires the IMPORT_MARC permission (same as open-ils.cat.biblio.record.xml.import). If the permission fails, the queued record will fail import and be stamped with a new "import.record.perm_failure" import error.

**IMPORT_ACQ_LINEITEM_BIB_RECORD_UPLOAD** - This allows interfaces leveraging the batch importer, such as Acquisitions, to create a higher barrier to entry. This permission prevents users from creating new bib records directly from the ACQ vendor MARC file upload interface.
Chapter 92. Placing purchase requests from a patron record

Patrons may wish to suggest titles for your Library to purchase. You can track these requests within Evergreen, whether or not you are using the acquisitions module for other purposes. This section describes how you can record these requests within a patron’s record.

1. Retrieve the patron’s record.

2. Select Other → Acquisition Requests. This takes you to the Requests Screen.

3. The Requests Screen will show any other requests that this patron has made. You may sort the requests by clicking on the column headers.

4. To add the request, click the Create Request button.

You will need the CREATE_PURCHASE_REQUEST permission to add a request.

5. The request type field is required. Every other field is optional, although it is recommended that you enter as much information about the request as possible.

6. The Pickup Library, User, and Request Date/Time field will be filled in automatically.

7. You have the option to automatically place a hold for the patron if your library decides to purchase the item. If you’d like Evergreen to generate this hold, check the Place Hold box.

8. When you have finished entering information about the request, click the Save button.
Chapter 93. Managing patron purchase requests

Introduction

Patrons may wish to suggest titles for your Library to purchase. You can track these requests within Evergreen, whether or not you are using the acquisitions module for other purposes. This section describes how you can manage these requests.

1. Go to Acquisitions → Patron Requests.

2. The Requests Screen will show any other requests that patrons have made. You may sort the requests by clicking on the column headers.

3. You can filter this screen by organizational unit or patron’s barcode. There are additional filter options available if you click on Filter.

4. To remove a user filter, click on User and leave the barcode field blank.

Adding a request

You may add a patron purchase request using this screen.

1. To add the request, click the Create Request button.

   ![Note]
   You will need the CREATE_PURCHASE_REQUEST permission to add a request.

2. If you have not already filtered the search using a patron’s barcode, you will be prompted to enter it before starting the request.

3. The request type field is required. Every other field is optional, although it is recommended that you enter as much information about the request as possible.

4. The Pickup Library, User, and Request Date/Time field will be filled in automatically.

5. You have the option to automatically place a hold for the patron if your library decides to purchase the item. If you’d like Evergreen to generate this hold, check the Place Hold box.

6. When you have finished entering information about the request, click the Save button.

Adding requests to selection lists

If you’d like to purchase a patron’s request, follow these steps:
1. Click on the blue hyperlinked title of the patron's request.

2. Click the Add to Selection List button.

3. Fill out the requested information. You can either add it to an existing selection list or a new one.

4. After you save the record, the request’s Add to Selection List button will change to a View Selection List button that allows you to view the status of this patron request at a later time.

5. You can then use your Library’s typical ordering process to purchase the item your patron has requested.
Chapter 94. "Blanket" Orders

"Blanket" orders allow staff to invoice an encumbered amount multiple times, paying off the charge over a period of time. The work flow supported by this development assumes staff does not need to track the individual contents of the order, only the amounts encumbered and invoiced in bulk.

Example

1. Staff creates PO with a Direct Charge of "Popular Fiction 2015" and a charge type of "Blanket Order".

2. The amount entered for the charge equals the total amount expected to be charged over the duration of the order.

3. When a shipment of "Popular Fiction" items arrive, staff creates an invoice from the "Popular Fiction 2015" PO page and enters the amount billed/paid for the received shipment under the "Popular Fiction 2015" charge in the invoice.

4. When the final shipment arrives, staff select the Final invoice for Blanket Order option on the invoice screen to mark the PO as received and drop any remaining encumbrances to $0.

   a. Alternatively, if the PO needs to be finalized without creating a final invoice, staff can use the new Finalize Blanket Order option on the PO page.

More details about blanket orders

• Any direct charge using a blanket item type will create a long-lived charge that can be invoiced multiple times.

• Such a charge is considered open until its purchase order is "finalized" (received).

• "Finalizing" a PO changes the PO’s state to received (assuming there are no pending lineitems on the PO) and fully dis-encumbers all blanket charges on the PO by setting the fund_debit amount to $0 on the original fund_debit for the charge.

• Invoicing a blanket charge does the following under the covers:

   a. Create an invoice_item to track the payment

   b. Create a new fund_debit to implement the payment whose amount matches the invoiced amount.

• Subtract the invoiced amount from the fund_debit linked to the original blanket po_item, thus reducing the amount encumbered on the charge as a whole by the invoiced amount.

• A PO can have multiple blanket charges. E.g. you could have a blanket order for "Popular Fiction 2015" and a second charge for "Pop Fiction 2015 Taxes" to track / pay taxes over time on a blanket charge.
• A PO can have a mix of lineitems, non-blanket charges, and blanket charges.

• A blanket Invoice Item Type cannot also be a prorate type, since it’s nonsensical. Blanket items are encumbered, whereas prorated items are only paid at invoice time and never encumbered.
Part IX. Cataloging
# Table of Contents

95. Introduction ............................................................................................................ 463
    MARC Tag-table Service ....................................................................................... 463
96. Copy Buckets ........................................................................................................ 464
    Managing Copy Buckets ...................................................................................... 464
    Creating Copy Buckets ......................................................................................... 464
    Editing Copy Buckets ........................................................................................... 465
    Sharing Copy Buckets ........................................................................................... 467
    Deleting Copy Buckets ......................................................................................... 468
Adding Copies to a Bucket ......................................................................................... 469
    From the Copy Bucket Interface ........................................................................ 469
    From a Catalogue Search ...................................................................................... 471
    From the Scan Item Interface ............................................................................. 472
Removing Copies from a Bucket ................................................................................ 473
    Editing Copies in a Bucket ................................................................................... 473
    Deleting Copies from the Catalogue .................................................................... 475
    Placing Holds on Copies in a Bucket .................................................................. 476
Transferring Copies to Volumes ................................................................................ 478
97. Copy Tags ................................................................................................................ 481
    Adding Existing Copy Tags to Copies .................................................................. 481
    Creating and Applying a Copy Tag During Cataloging ......................................... 482
    Removing Copy Tags from Copies ....................................................................... 482
    Adding Copy Tags to Copies in Batch ................................................................... 483
    Searching Copy Tags ............................................................................................ 483
    Digital Bookplate Search Field ............................................................................ 484
    Keyword Search .................................................................................................... 484
98. Working with the MARC Editor ............................................................................. 486
    Editing MARC Records .......................................................................................... 486
    MARC Record Leader and MARC fixed field 008 .................................................. 487
99. Record Buckets ....................................................................................................... 490
    Introduction ............................................................................................................ 490
    Creating Record Buckets ..................................................................................... 490
    Adding Records to a Bucket ................................................................................ 490
    From the Record Bucket Interface ....................................................................... 490
100. MARC 007 Field Physical Characteristics Wizard ............................................. 492
101. Return to Search Results from MARC Record ...................................................... 496
102. Batch Importing MARC Records ........................................................................ 497
    Introduction ........................................................................................................... 497
    Permissions ............................................................................................................ 497
    Record Display Attributes .................................................................................... 497
    Record Match Sets ................................................................................................ 497
    Creating a Match Set ............................................................................................ 497
    Replace Mode ........................................................................................................ 500
    Quality Metrics ..................................................................................................... 501
    Merge/Overlay Profiles ......................................................................................... 501
    Import Item Attributes .......................................................................................... 502
    Import Records ...................................................................................................... 504
    Default Values for Item Import .......................................................................... 510
103. Overlay Existing Catalog Record via Z39.50 Import ............................................ 512
104. Z39.50 Search Enhancements .............................................................................. 516
105. Monograph Parts ................................................................................................ 520
    Add a Monograph Part to an Existing Record ...................................................... 520
Chapter 95. Introduction

This part describes cataloging in Evergreen.

**MARC Tag-table Service**

The tag tables for the web staff client MARC editor are stored in the database. The tag-table service has the following features:

- specifies whether (sub)fields are optional or mandatory
- specifies whether (sub)fields are repeatable or not
- a coded value map can be associated with a subfield to establish a controlled vocabulary for that subfield
- MARC field and subfield definitions can be overridden by institutions further down in the organizational unit hierarchy. This allows, for example, a library to specify definitions for local MARC tags.
- values supplied by the tag-table service are used to populate values in context menus in the web staff client MARC editor.

MARC Tag Tables can be found under Administration → Server Administration → MARC Tag Tables.

MARC Tag Tables Grid:

MARC Tag Tables Detail:

The initial seed data for the in-database tag table is derived from the current tooltips XML file.
Chapter 96. Copy Buckets

Copy buckets are containers copy records can be put into to easily perform batch actions on. Copies stay in buckets until they are removed.

The Copy Bucket interface is accessed by going to Cataloguing → Copy Buckets.

Managing Copy Buckets

Creating Copy Buckets

Copy buckets can be created in the Copy Bucket interface as well as on the fly when adding copies to a bucket from a catalogue search or from within the Item Status interface. For information on creating buckets on the fly see Adding Copies to a Bucket (needs section ID).

1. In the Copy Bucket interface on the click Buckets in either the Pending Copies or Bucket View tab.

2. From the drop down menu select New Bucket.
3. Enter a Name and a Description (optional) for your bucket and click Create Bucket.

The bucket can also be set as Publicly Visible at this time.

The functionality for making buckets publicly visible does not appear to be in place at this time.

**Editing Copy Buckets**

1. In the Copy Bucket interface click Buckets in either the Pending Copies or Bucket View tab.
2. From the drop down menu select the bucket you would like to edit. The bucket will load in the interface.

3. Click on Buckets.

4. From the drop down menu select Edit Bucket.

5. Update the desired information and click Apply Changes.
The functionality for making buckets publicly visible does not appear to be in place at this time.

Sharing Copy Buckets

Finding the Bucket ID

1. With the bucket open, look at the URL for the bucket ID. Share this ID with the staff member who needs access to this bucket.

Opening a Shared Bucket

1. In the Copy Bucket interface click Buckets in either the Pending Copies or Bucket View tab.

2. From the drop down menu select Shared Bucket.

3. Enter the bucket ID and click Load Bucket.
4. The shared bucket will display and can be worked with the same as any bucket you own.

Deleting Copy Buckets

1. In the Copy Bucket interface click Buckets in either the Pending Copies or Bucket View tab.

2. From the drop down menu select the bucket you would like to delete. The bucket will load in the interface.

3. Click on Buckets.

4. From the drop down menu select Delete Bucket.
5. On the confirmation pop up click Delete Bucket.

6. Refresh your screen.

**Adding Copies to a Bucket**

**From the Copy Bucket Interface**

1. In the Copy Bucket interface click on the Pending Copies tab.

2. Scan in all of the items you wish to add to the bucket.

3. Click on Buckets.

4. From the drop down menu select the bucket you wish to add the items to. Alternatively you can create a New Bucket (link back to Copy Bucket Interface section of Creating Copy Buckets).
5. Use the check boxes to select the item(s) you wish to add to the bucket.

6. Click Actions.

7. From the drop down menu select Add To Bucket.

8. The number of items in the bucket, displayed beside the bucket name, will update as will the number on the Bucket View tab.
Once you have added your selected items to a bucket you can deselect them, select other items on your pending list, and add those items to a different bucket.

From a Catalogue Search

1. Retrieve the title through a catalogue search.

2. If it is not your default view click on the Holdings View tab.

3. Use the check boxes to select the item(s) you would like to add to the bucket.

4. Click Actions.

5. From the drop down menu select Add Items to Bucket.
6. Enter a name for your bucket or select an existing from the drop down menu.

7. Click Add To New Bucket or Add To Selected Bucket.

8. Repeat steps 1 through 7 to add additional copies.

**From the Scan Item Interface**

1. Click on Search → Search for Copies by Barcode

2. Scan the barcode(s) of the item(s) you wish to add to the bucket.

3. Make sure that the items you want to add are selected (i.e. that the checkbox on the left side of the screen is checked.

4. Right click on one of the selected items.

5. Click Add items to bucket.

6. Choose the existing bucket that you’d like to add to, or create a new bucket.
Removing Copies from a Bucket

1. Open the Copy Bucket interface. By default you are on the Bucket View tab.

2. Click on Buckets.

3. From the drop down menu select the bucket containing the item(s) you would like to remove.

4. Use the check boxes to select the item(s) you wish to remove from the bucket.

5. Click Actions.

6. From the drop down menu select Remove Selected Copies from Bucket.

7. Your bucket will reload and the selected item(s) will no longer be in the bucket.

Editing Copies in a Bucket

1. Open the Copy Bucket interface. By default you are on the Bucket View tab.
2. Click on Buckets.

3. From the drop down menu select the bucket containing the item(s) you would like to edit.

4. Use the check boxes to select the item(s) you wish to edit.

5. Click Actions.

6. From the drop down menu select Edit Selected Copies.

7. The Copy Editor will open in a new tab. Make your edits and then click Save and Exit.
8. Your items have been updated.

Deleting Copies from the Catalogue

1. Open the Copy Bucket interface. By default you are on the Bucket View tab.

2. Click on Buckets.

3. From the drop down menu select the bucket containing the item(s) you would like to delete from the catalogue.
4. Use the check boxes to select the item(s) you wish to delete.

5. Click Actions.

6. From the drop down menu select Delete Selected Copies from Catalog.

7. On the confirmation pop up click OK/Continue.

8. The items have been deleted from the catalogue.

**Placing Holds on Copies in a Bucket**

1. Open the Copy Bucket interface. By default you are on the Bucket View tab.
2. Click on Buckets.

3. From the drop down menu select the bucket containing the item(s) you would like to place a hold on.

4. Use the check boxes to select the item(s) you wish to delete.

5. Click Actions.

6. From the drop down menu select Request Selected Copies.

7. Enter the barcode for the patron who the hold is for. By default the system enters the barcode of the account logged into the client.
8. Select the correct Pickup Library.

9. Select the correct Hold Type. (More explanation of the hold types needed here.)

10. Click OK.

11. The hold has been placed.

**Transferring Copies to Volumes**

1. Retrieve the title through a catalogue search.

2. If it is not your default view click on the Holdings View tab.

3. Use the check boxes to select the volume you would like to transfer the item(s) to.

4. Click Actions.

5. From the drop down menu select Volume as Item Transfer Destination.
6. Open the Copy Bucket interface. By default you are on the Bucket View tab.

7. Click on Buckets.

8. From the drop down menu select the bucket containing the item(s) you would like to transfer to the volume.

9. Use the check boxes to select the item(s) you wish to transfer.

10. Click Actions.

11. From the drop down menu select Transfer Selected Copies to Marked Volume.
12 The item(s) is transferred.
Chapter 97. Copy Tags

Copy Tags allow staff to apply custom, pre-defined labels or tags to items. Copy tags are visible in the public catalog and are searchable in both the staff client and public catalog based on configuration. This feature was designed to be used for Digital Bookplates to attach donation or memorial information to items, but may be used for broader purposes to tag items.

Copy tags can be created ahead of time in the Administration module (See the Administration section of this documentation for more information.) and then applied to copies or they can be created on the fly during the cataloging process.

Adding Existing Copy Tags to Copies

Copy Tags can be added to existing copies or to new copies as they are cataloged. To add a copy tag:

1. In the Copy Editor, click on Copy Tags. A dialog box called Manage Copy Tags will appear.

1. Select the Tag Type from the drop down menu and start typing in the Tag field to bring up tag suggestions from the existing copy tags. Select the tag and click Add Tag, then click OK.
   a. If you are cataloging a new copy, make any other changes to the item record.

2. Click Save & Exit. The copy tag will now appear in the catalog.
Creating and Applying a Copy Tag During Cataloging

Copy tags can be created in the Copy Editor on the fly while cataloging or viewing an item:

1. In the Copy Editor, click on Copy Tags. A dialog box called Manage Copy Tags will appear.

2. Select the Tag Type from the drop down menu and type in the new Tag you want to apply to the item. Click Add Tag, then click OK. The new tag will be created and attached to the item. It will be owned by the organization unit your workstation is registered to. The tag can be modified under Admin→Local Administration→Copy Tags.

Removing Copy Tags from Copies

To remove a copy tag from a copy:

1. In the Copy Editor, click on Copy Tags. A dialog box called Manage Copy Tags will appear.

2. Click Remove next to the tag you would like to remove, and click OK.

3. Click Save & Exit. The copy tag will now be removed from the catalog.
Adding Copy Tags to Copies in Batch

Copy tags can be added to multiple copies in batch using Copy Buckets. After adding the items to a copy bucket:

1. Go to Cataloging→Copy Buckets→Bucket View and select the bucket from the Buckets drop down menu.

2. Select the copies to which you want to add the copy tag and go to Actions→Apply Tags or right-click and select Apply Tags. The Apply Copy Tags dialog box will appear.

3. Select the Tag Type and enter the Tag. Click Add Tag, then click OK. The copy tag will now be attached to the copies.

It is not possible to remove tags using the Copy Bucket interface.

Searching Copy Tags

Copy Tags can be searched in the public catalog if searching has been enabled via Library Settings. Copy Tags can be searched in the Basic and Advanced Search interfaces by selecting Digital Bookplate as the search field. Specific copy tags can also be searched using a Keyword search and a specific search syntax.
Keyword Search

Copy Tags can also be searched by using a Keyword search in the Basic and Advanced search interfaces. Searches need to be constructed using the following syntax:

copy_tag(copy tag type code, search term)

For example:

copy_tag(bookplate, friends of the library)

It is also possible to conduct a wildcard search across all copy tag types:
copy_tag(*, smith)
Chapter 98. Working with the MARC Editor

Editing MARC Records

1. Retrieve the record.

You can retrieve records in many ways, including:

- If you know its database ID, enter it into Cataloging > Retrieve Bib Record by ID.
- If you know its control number, enter it into Cataloging > Retrieve Bib Record by TCN.
- Searching in the catalog.
- Clicking on a link from the Acquisitions or Serials modules.

2. Click on the MARC Edit tab.

3. The MARC record will display.

4. Select viewing and editing options, if desired.

- Stack subfields to display each subfield on its own line.
- Flat-Text Editor switches to a plain-text (mnemonic) MARC format. This format can be useful when copying and pasting multiple lines. It also allows the use of tools like MarcEdit (http://marcedit.reeset.net/). Uncheck the box to switch back.
- Note that you can use a backslash character as a placeholder in the flat text editor’s indicators and fixed-length fields.
- Add Item allows attaching items quickly with call number and barcode. When Save is clicked, the copy editor will open. NOTE: Browser pop-up blockers will prevent this, please allow pop-ups.

5. Make changes as desired.

- Right click into a tag field to add/remove rows or replace tags.
- To work with the data in a tag or indicator, click or Tab into the required field. Right click to view valid tags or indicators.

You can navigate the MARC Editor using keyboard shortcuts. Click Help to see the shortcut menu from within the MARC Editor.
6. When finished, click Save. The record will remain open in the editor. You can close the browser window or browser tab. Or you can switch to another view from the navigation near the top (for example to view it as it appears in the OPAC choose OPAC View).

**MARC Record Leader and MARC fixed field 008**

You can edit parts of the leader and the 008 field in the MARC Editor via the fixed field editor box displayed above the MARC record.

**To edit the MARC record leader**

1. Retrieve and display the appropriate record in MARC Edit view.
2. Click into any box displayed in the fixed field editor.
3. Press Tab or use the mouse to move between fields.
4. Click Save.
5. The OPAC icon for the appropriate material type will display.

OPAC icons for text, moving pictures and sound rely on correct MARC coding in the leader, 007, and 008, as do OPAC search filters such as publication date, item type, or target audience.

**MARC Fixed Field Editor Right-Click Context Menu Options**

The MARC Fixed Field Editor provides suggested values for select fixed fields based on the record type being edited. Users can right-click on the value control for a fixed field and choose the appropriate value from the menu options. The Evergreen database contains information from the Library of Congress’s MARC 21 format standards that includes possible values for select fixed fields. The right-click context menu options are available for fixed fields whose values are already stored in the database. Fixed fields that do not contain possible values in the database, the user will receive the default web browser menu (such as cut, copy, paste, etc.).

To Access the MARC Fixed Field Editor Right-Click Context Menu Options:

1. Within the bibliographic record that needs to be edited, select MARC Edit.
2. Make sure that the Flat-Text Editor checkbox is not selected and that you are not using the Flat-Text Editor interface.
3. Right-click on the value control for the fixed field that needs to be edited.
4. Select the appropriate value for the fixed field from the menu options.
5. Continue editing the MARC record, as needed. Once you are finished editing the record, click Save.

Changing the values in the fixed fields will also update the appropriate position in the Leader or 008 Field and other applicable fields (such as the 006 Field).

MARC Editor users retain the option of leaving the fixed field value blank or entering special values (such as # or | ).

It may be necessary for MARC Editor users to first correctly pad the fixed fields to their appropriate lengths before making further modifications to the fixed field values.

Administration The Evergreen database already contains information from the Library of Congress’s MARC 21 format standards that includes possible values for select fixed fields. Users may also add values to these and other fixed fields through the MARC Coded Value Maps interface. Once new values are added, the right-click context menu for the selected fixed field will display those values in the MARC Editor for any Record Type that utilizes that fixed field. There are three relevant tables that contain the values that display in the fixed field context menu options:

1. config.marc21_ff_pos_map describes, for the given record type, where a fixed field is located, its start position, and its length.
2. `config.coded_value_map` defines the set of valid values for many of the fixed fields and the translatable, human-friendly labels for them.

3. `config.record_attr_definition` links together the information from the `config.marc21_ff_pos_map` and `config.coded_value_map` tables.
Chapter 99. Record Buckets

Introduction

Record buckets are containers for MARC records. Once records are in a bucket, you can take various types of actions, including:

- Editing all the records at once using the MARC Batch Editor.
- Deleting all the records in the bucket.
- Merging all the records in the bucket.
- Downloading the MARC files for all records in the bucket, so you can edit them in another program like MARCEdit.

Creating Record Buckets

1. Click on Cataloging → Record Buckets.
2. On the Buckets menu, click New Bucket.
3. Give the bucket a name and (optionally) a description.

Adding Records to a Bucket

From the Record Bucket Interface

1. Click on Cataloging → Record Buckets.
2. On the Buckets menu, choose the bucket that you’d like to add records to.
3. Go to the Record Query tab.
4. Enter your query into the Record Query box.
5. Select the records you would like to add.
6. On the Actions menu, click Add to Bucket.
**Advanced record queries**

The Record Query tab allows some advanced search functionality through the use of search keys, which can be combined with one another.

**Table 99.1. Record Bucket search keys**

<table>
<thead>
<tr>
<th>Search key</th>
<th>Abbreviated version</th>
<th>Usage example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author:</td>
<td>au:</td>
<td>au:Anzaldua</td>
<td>An author, creator, or contributor</td>
</tr>
<tr>
<td>available:</td>
<td></td>
<td>available:yes</td>
<td>Limits to available items. There is no way to limit to unavailable items.</td>
</tr>
<tr>
<td>keyword:</td>
<td>kw:</td>
<td>kw:Schirmer</td>
<td>A keyword</td>
</tr>
<tr>
<td>lang:</td>
<td>lang:</td>
<td>lang:Spanish</td>
<td>A language</td>
</tr>
<tr>
<td>series:</td>
<td>se:</td>
<td>se:avatar last airbender</td>
<td>A series title</td>
</tr>
<tr>
<td>site:</td>
<td></td>
<td>site:LIB3</td>
<td>The shortname of the library/system/consortium you’d like to search.</td>
</tr>
<tr>
<td>subject:</td>
<td>su:</td>
<td>su:open source software</td>
<td>A subject</td>
</tr>
<tr>
<td>subject</td>
<td>geographic:</td>
<td>subject</td>
<td>geographic:Uruguay</td>
</tr>
<tr>
<td>title:</td>
<td>ti:</td>
<td>ti:Harry Potter</td>
<td>Title proper or alternate title</td>
</tr>
<tr>
<td>title</td>
<td>proper:</td>
<td>title</td>
<td>proper:Harry Potter</td>
</tr>
</tbody>
</table>

You can combine these in the same query, e.g. **ti:borderlands au:anzaldua available:yes**. However — with the exception of the lang search key, you should not repeat the same search key twice.

---

You can use the same boolean operator symbols that are used in the OPAC (|| for boolean OR, && for boolean AND, and - for boolean NOT).
Chapter 100. MARC 007 Field Physical Characteristics Wizard

The MARC 007 Field Physical Characteristics Wizard enables catalogers to interact with a database wizard that leads the user step-by-step through the MARC 007 field positions. The wizard displays the significance of the current position and provides dropdown lists of possible values for the various components of the MARC 007 field in a more user-friendly way.

To Access the MARC 007 Field Physical Characteristics Wizard for a Record that Does Not Already Contain the 007 Field (i.e. Creating the 007 Field from Scratch):

1. Within the bibliographic record that needs to be edited, select MARC Edit.

2. Make sure that the Flat-Text Editor checkbox is not selected and that you are not using the Flat-Text Editor interface.

3. Right-click in the MARC field column.

4. Click Add/Replace 007. The 007 row will appear in the record.

5. Click the chain link icon to the right of the field.
6. Click Physical Characteristics Wizard.

The MARC 007 Field Physical Characteristics Wizard will open.

Using the Physical Characteristics Wizard:

As the user navigates through the wizard, each position will display its corresponding label that describes the significance of that position. Each position contains a selection of dropdown choices that list the possible values for that particular position. When the user makes a selection from the dropdown options, the value for that position will also change.

The first value defines the Category of Material. Users select the Category of Material for the given record by choosing an option from the Category of Material? dropdown menu. The choices within the remaining character positions will be appropriate for the Category of Material selected.

Once the Category of Material is selected, click Next.

Evergreen will display the result of each selection in the preview above. The affected character will be in red.
By clicking either the Previous or Next buttons, the user may step forward and backward, as needed, through the various positions in the 007 field.

Once the user enters all of the applicable values for the 007 field and is ready to exit the wizard, click Save.

All of the values selected will be stored and displayed within the 007 field of the bibliographic record.
Continue editing the MARC record, as needed. Once the user is finished editing the record, click Save.
Chapter 101. Return to Search Results from MARC Record

This feature enables you to return to your title search results directly from any view of the MARC record, including the OPAC View, MARC Record, MARC Edit, and Holdings Maintenance. You can use this feature to page through records in the MARC Record View or Edit interfaces. You do not have to return to the OPAC View to access title results, simply click the button marked Back To Results.

Record Summary

<table>
<thead>
<tr>
<th>Title:</th>
<th>The camel bookmobile</th>
<th>Edition:</th>
<th>First edition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author:</td>
<td>Hamilton, Masha.</td>
<td>Pub Date:</td>
<td>2007</td>
</tr>
<tr>
<td>Bib Call #:</td>
<td>PS3558 .A44386C36 2007</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Start  Previous  Next  End  Back To Results ( 6 / 166 )
Chapter 102. Batch Importing MARC Records

Introduction

The cataloging module includes an enhanced MARC Batch Import interface for loading MARC (and MARCXML) records. In general, it can handle batches up to 5,000 records without a problem. This interface allows you to specify match points between incoming and existing records, to specify MARC fields that should be overlaid or preserved, and to only overlay records if the incoming record is of higher quality than the existing record. Records are added to a queue where you can apply filters that enable you to generate any errors that may have occurred during import. You can print, email or export your queue as a CSV file.

Permissions

To use match sets to import records, you will need the following permission:

ADMIN_IMPORT_MATCH_SET

Record Display Attributes

This feature enables you to specify the tags and subfields that will display in records that appear in the import queue.

Record Match Sets

This feature enables you to create custom match points that you can use to accurately match incoming records with existing catalog records.

Creating a Match Set

In this example, to demonstrate matching on record attributes and MARC tags and subfields, we will create a record match set that defines a match based on the title of the record, in either the 240 or 245, and the fixed field, Lang. You can add multiple record attributes and MARC tags to customize a record match set.

1. Click Cataloging → MARC Batch Import/Export.

2. Create a new record match set. Click Record Match Sets → New Match Set.

3. Enter a name for the record match set.

4. Select an Owning Library from the drop down menu. Staff with permissions at this location will be able to use this record match set.

5. Select a Match Set Type from the drop down menu. You can create a match set for authority records or bibliographic records.
6. Click Save.

7. The screen will refresh to list the record match set that you created. Click the link to the record match set.

8. Create an expression that will define the match points for the incoming record. You can choose from two areas to create a match: Record Attribute or MARC Tag and Subfield. You can use the Boolean operators AND and OR to combine these elements to create a match set.

9. Select a Record Attribute from the drop-down menu.

10. Enter a Match Score. The Match Score indicates the relative importance of that match point as Evergreen evaluates an incoming record against an existing record. You can enter any integer into this field. The number that you enter is only important as it relates to other match points. Recommended practice is that you create a match score of one (1) for the least important match point and assign increasing match points to the power of 2 to working points in increasing importance.

11. Check the Negate? box if you want to negate the match point. Checking this box would be the equivalent of applying a Boolean operator of NOT to the match point.

12. Click Ok.
13 Drag the completed match point under the folder with the appropriately-named Boolean folder under the Expression tree.

14 Enter another Boolean Operator to further refine your match set.

15 Click Boolean Operator.

16 Select the OR operator from the drop down menu.

17 Click Ok.

18 Drag the operator to the expression tree.

19 Click MARC Tag and Subfield.

20 Enter a MARC tag on which you want the records to match.
21. Enter a subfield on which you want the records to match.

22. Enter a Match Score. The Match Score indicates the relative importance of that match point as Evergreen evaluates an incoming record against an existing record. You can enter any integer into this field. The number that you enter is only important as it relates to other match points. Recommended practice is that you create a match score of one (1) for the least important match point and assign increasing match points to the power of 2 to working points in increasing importance.

23. Check the Negate? box if you want to negate the match point. Checking this box would be the equivalent of applying a Boolean operator of NOT to the match point.

24. Click Ok.

25. Drag the completed match point under the folder with the appropriately-named Boolean folder under the Expression tree. The Expression will build across the top of the screen.

26. Add additional MARC tags or record attributes to build the expression tree.

27. Click Save Changes to Expression.

---

**Replace Mode**

Replace Mode enables you to replace an existing part of the expression tree with a new record attribute, MARC tag, or Boolean operator. For example, if the top of the tree is AND, in Replace Mode, you could change that to an OR.
1. Create a working match point.

2. Click Enter Replace Mode.

3. Highlight the piece of the tree that you want to replace.

4. Drag the replacement piece over the highlighted piece.

5. Click Exit Replace Mode.

**Quality Metrics**

1. Set the Quality Metrics for this Match Set. Quality metrics are used to determine the overall quality of a record. Each metric is given a weight and the total quality value for a record is equal to the sum of all metrics that apply to that record. For example, a record that has been cataloged thoroughly and contains accurate data would be more valuable than one of poor quality. You may want to ensure that the incoming record is of the same or better quality than the record that currently exists in your catalog; otherwise, you may want the match to fail. The quality metric is optional.

2. You can create quality metrics based on the record attribute or the MARC Tag and Subfield.

3. Click Record Attribute.

4. Select an attribute from the drop down menu.

5. Enter a value for the attribute.

6. Enter a match score. You can enter any integer into this field. The number that you enter is only important as it relates to other quality values for the current configuration. Higher scores would indicate increasing quality of incoming records. You can, as in the expression match score, increase the quality points by increasing subsequent records by a power of 2 (two).

7. Click Ok.

### Quality Metrics for this Match Set

- **Record Attribute:** ELvl
- **Value:** K
- **Match Score:** 1

**Merge/Overlay Profiles**

If Evergreen finds a match for an incoming record in the database, you need to identify which fields should be replaced, which should be preserved, and which should be added to the record. Click the Merge/Overlay Profiles button to create a profile that contains this information.
You can use these profiles when importing records through the MARC Batch Importer or Acquisitions Load MARC Order Records interface.

You can create a new profile by clicking the New Merge Profile button. Available options for handling the fields include:

1. Preserve specification - fields in the existing record that should be preserved.
2. Replace specification - fields in existing record that should be replaced by those in the incoming record.
3. Add specification - fields from incoming record that should be added to existing record (in addition to any already there.)
4. Remove specification - fields that should be removed from incoming record.
5. Update bib source - If this value is false, just the bibliographic data will be updated when you overlay a new MARC record. If it is true, then Evergreen will also update the record’s bib source to the one you select on import; the last edit date to the date the new record is imported, and the last editor to the person who imported the new record.

You can add multiple tags to the specification options, separating each tag with a comma.

**Import Item Attributes**

If you are importing copies with your records, you will need to map the data in your holdings tag to fields in the copy record. Click the Holdings Import Profile button to map this information.

1. Click the New Definition button to create a new mapping for the holdings tag.
2. Add a Name for the definition.
3. Use the Tag field to identify the MARC tag that contains your holdings information.
4. Add the subfields that contain specific copy information to the appropriate copy field.
5. At a minimum, you should add the subfields that identify the Circulating Library, the Owning Library, the Call Number and the Barcode.

All fields (except for Name and Tag) can contain a MARC subfield code (such as “a”) or an XPATH query. You can also use the related library settings to set defaults for some of these fields.
### Table 102.1. Holdings Import Profile Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommended</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Yes</td>
<td>Name you will choose from the MARC Batch Import screen</td>
</tr>
<tr>
<td>Tag</td>
<td>Yes</td>
<td>MARC Holdings Tag/Field (e.g. 949). Use the Tag field to identify the MARC tag that contains your holdings information.</td>
</tr>
<tr>
<td>Barcode</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Call Number</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Circulating Library</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Owning Library</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Alert Message</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circulate</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circulate As MARC Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circulation Modifier</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deposit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Deposit Amount</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Recommended</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Holdable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPAC Visible</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overlay Match ID</td>
<td></td>
<td>The copy ID of an existing copy to overlay</td>
</tr>
<tr>
<td>Parts Data</td>
<td></td>
<td>Of the format **PART LABEL 1</td>
</tr>
<tr>
<td>Price</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Private Note</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Public Note</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reference</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shelving Location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stat Cat Data</td>
<td></td>
<td>Of the format **CATEGORY 1</td>
</tr>
<tr>
<td>Status</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Import Records**

The Import Records interface incorporates record match sets, quality metrics, more merging options, and improved ways to manage your queue. In this example, we will import a batch of records. One of the records in the queue will contain a matching record in the catalog that is of lower quality than the incoming record. We will import the record according to the guidelines set by our record match set, quality metrics, and merge/overlay choices that we will select.

1. Select a Record Type from the drop down menu.

2. Create a queue to which you can upload your records, or add you records to an existing queue. Queues are linked to match sets and a holdings import profile. You cannot change a holdings import or record match set for a queue.

3. Select a Record Match Set from the drop down menu.

4. Select a Holdings Import Profile if you want to import holdings that are attached to your records.

5. Select a Record Source from the drop down menu.

6. Select a Merge Profile. Merge profiles enable you to specify which tags should be removed or preserved in incoming records.
7. Choose one of the following import options if you want to auto-import records:

a. Merge on Single Match - Using the Record Match Set, Evergreen will only attempt to perform the merge/overlay action if only one match was found in the catalog.

b. Merge on Best Match - If more than one match is found in the catalog for a given record, Evergreen will attempt to perform the merge/overlay action with the best match as defined by the match score and quality metric.

8. Enter a Best/Single Match Minimum Quality Ratio. Divide the incoming record quality score by the record quality score of the best match that might exist in the catalog. By default, Evergreen will assign any record a quality score of 1 (one). If you want to ensure that the inbound record is only imported when it has a higher quality than the best match, then you must enter a ratio that is higher than 1. For example, if you want the incoming record to have twice the quality of an existing record, then you should enter a 2 (two) in this field. If you want to bypass all quality restraints, enter a 0 (zero) in this field.

9. Select an Insufficient Quality Fall-Through Profile if desired. This field enables you to indicate that if the inbound record does not meet the configured quality standards, then you may still import the record using an alternate merge profile. This field is typically used for selecting a merge profile that allows the user to import holdings attached to a lower quality record without replacing the existing (target) record with the incoming record. This field is optional.

10. Under Copy Import Actions, choose Auto-overlay In-process Acquisitions Copies if you want to overlay temporary copies that were created by the Acquisitions module. The system will attempt to overlay copies that:

- have associated lineitem details (that is, they were created by the acquisitions process),
- that lineitem detail has the same owning_lib as the incoming copy’s owning_lib, and
- the current copy associated with that lineitem detail is In process.

11. Browse to find the appropriate file, and click Upload. The file will be uploaded to a queue. The file can be in either MARC or MARCXML format.
The screen will display records that have been uploaded to your queue. Above the table there are three sections:

- **Queue Actions** lists common actions for this queue. Export Non-Imported Records will export a MARC file of records that failed to import, allowing those records to be edited as needed and imported separately. (Those records can be viewed by clicking the Limit to Non-Imported Records filter.)

- **Queue Summary** shows a brief summary of the records included in the queue.

- **Queue Filters** provides options for limiting which records display in the table.
13. If Evergreen indicates that matching records exist, then click the Matches link to view the matching records. Check the box adjacent to the existing record that you want to merge with the incoming record.

<table>
<thead>
<tr>
<th>View MARC</th>
<th>Matches</th>
<th>Import Failures</th>
<th>Import Time</th>
<th>Imported As</th>
<th>Title of Work</th>
<th>Author of Work</th>
<th>Language of Work</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Gregor and the curse of the warmbloods / Suzanne Collins.</td>
<td>Collins, Suzanne.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Matches</td>
<td></td>
<td></td>
<td></td>
<td>Gregor and the Prophecy of Reba</td>
<td>Collins, Suzanne.</td>
<td></td>
</tr>
</tbody>
</table>

14. Click Back to Import Queue.

15. Check the boxes of the records that you want to import, and click Import Selected Records, or click Import All Records.

16. A pop up window will offer you the same import choices that were present on the Import Records screen. You can choose one of the import options, or click Import.
The screen will refresh. The Queue Summary indicates that the record was imported. The Import Time column records the date that the record was imported. Also, the Imported As column should now display the database ID (also known as the bib record number) for the imported record.
18 You can confirm that the record was imported by using the value of the Imported As column by selecting the menu Cataloging → Retrieve title by database ID and using the supplied Imported As number. Alternatively, you can search the catalog to confirm that the record was imported.
Default Values for Item Import

Evergreen now supports additional functionality for importing items through Cataloging → MARC Batch Import/Export. When items are imported via a Holdings Import Profile in Cataloging → MARC Batch Import/Export, Evergreen will create an item-level record for each copy. If an item barcode, call number, copy location, or circulation modifier is not set in the embedded holdings, Evergreen will apply a default value based on the configured Library Settings. A default prefix can be applied to the auto-generated call numbers and item barcodes.

The following Library Settings can be configured to apply these default values to imported items:

- Vandelay: Generate Default Barcodes —Auto-generate default item barcodes when no item barcode is present
- Vandelay: Default Barcode Prefix —Apply this prefix to any auto-generated item barcodes
- Vandelay: Generate Default Call Numbers —Auto-generate default item call numbers when no item call number is present
- Vandelay: Default Call Number Prefix —Apply this prefix to any auto-generated item call numbers
- Vandelay: Default Copy Location —Default copy location value for imported items
• Vandelay: Default Circulation Modifier —Default circulation modifier value for imported items
Chapter 103. Overlay Existing Catalog Record via Z39.50 Import

This feature enables you to replace a catalog record with a record obtained through a Z39.50 search. No new permissions or administrative settings are needed to use this feature.

To Overlay an Existing Record via Z39.50 Import:

1) Click Cataloging → Import Record from Z39.50

2) Select at least one Service in addition to the Local Catalog in the Service and Credentials window in the top right panel.

3) Enter search terms in the Query window in the top left panel.

4) Click Search.

5) The results will appear in the lower window.

6) Select the record in the local catalog that you wish to overlay.

7) Click Mark Local Result as Overlay Target

8) A confirmation message appears. Click OK.
9) Select the record that you want to replace the existing catalog record.

10) Click Overlay.

11) The record that you selected will open in the MARC Editor. Make any desired changes to the record, and click Overlay Record.

12) The catalog record that you want to overlay will appear in a new window. Review the MARC record to verify that you are overlaying the correct catalog record.

13) If the correct record appears, click Overlay.
14) A confirmation message will appear to confirm that you have overlaid the record. Click Ok.

15) The screen will refresh in the OPAC View to show that the record has been overlaid.
The sealed letter /Emma Donoghue.

Record details
- ISBN: 9780151015498
- ISBN: 015101549X
- Physical Description: 396 p.;24 cm.
- Publisher: Harcourt, c2008.

Search for related items by subject
Subject: Codrington, Henry John, Sir, 1808-1877 — Fiction.
Codrington, Helen d. 1878 — Fiction.
Faithfull, Emily, 1836?-1895 — Fiction.
Triangles (Interpersonal relations) — Fiction.
Divorce — Great Britain — Fiction.
Genre: Domestic fiction.
Chapter 104. Z39.50 Search Enhancements

Abstract

In Evergreen version 2.5, you will be able to search multiple Z39.50 sources simultaneously from record buckets. Using this feature, you can match records from Z39.50 sources to catalog records in your bucket and import the Z39.50 records via Vandelay.

Administration

The following administrative interfaces will enable you to configure Z39.50 search parameters.

Z39.50 Index Field Maps

Click Administration → Server Administration → Z39.50 Index Field Maps to map bib record indexes (metabib fields and record attributes) in your catalog records to Z39.50 search attributes. Metabib fields are typically free form fields found in the body of a catalog record while record attributes typically have only one value and are often found in the leader.

You can map a metabib field or a record attribute to a Z39.50 attribute or a Z39.50 attribute type. To map a specific field in your catalog record to a specific field in a chosen Z39.50 source, you should map to a Z39.50 attribute. For example, if you want the Personal Author in your catalog record to map to the Author field when searching the Library of Congress, then you should do the following:

1. Click New or double-click to edit an existing map.
2. Select the Metabib Field from the drop down menu.
3. Select the appropriate source and field from the Z39.50 Attribute drop down menu.
4. Click Save.

Alternatively, if you want the Personal Author in your catalog record to map to the generic author field of any Z39.50 source, then you should do the following:

1. Click New or double-click to edit an existing map.
2. Select the Metabib Field from the drop down menu.
3. Select the appropriate heading from the Z39.50 Attribute Type drop down menu.
4. Click Save.

Z39.50 servers

Click Admin → Server Admin → Z39.50 Servers to input your Z39.50 server. Click the hyperlinked name of any server to view the Z39.50 search attribute types and settings. These settings describe how the search values (from a metabib field or record attribute) are translated into Z39.50 searches.

Apply Quality Sets to Z30.50 Sources
From this interface, you can rank the quality of incoming search results according to the match set that you have established and their Z39.50 point of origin. By applying a quality score, you tell Evergreen to merge the highest quality records into the catalog.

1. Click Cataloging → MARC Batch Import/Export.

2. Click Record Match Sets. Match Sets specify the MARC attributes, tags, and subfields that you want Evergreen to use to identify matches between catalog and incoming records.

3. Rank the quality of the records from Z39.50 sources by adding quality metrics for the match set. Click MARC Tag and Subfield, and enter the 901z tag and subfield, specify the Z39.50 source, and enter a quality metric. Source quality increases as the numeric quality increases.

Org Unit Settings

Org Unit settings can be set for your local branch, your system, or your consortium. To access these settings, click Administration → Local Administration → Library Settings Editor → Maximum Parallel Z39.50 Batch Searches.

Two new settings control the Z39.50 search enhancements.

1. Maximum Parallel Z39.50 Batch Searches - This setting enables you to set the maximum number of Z39.50 searches that can be in-flight at any given time when performing batch Z39.50 searches. The default value is five (5), which means that Evergreen will perform 5 searches at a given time regardless of the number of sources selected. The searches will be divided between the sources selected. Thus, if you maintain this default and perform a search using two Z39.50 sources, Evergreen will conduct five searches, shared between the two sources.

2. Maximum Z39.50 Batch Search Results - This setting enables you to set the maximum number of search results to retrieve and queue for each record + Z39 source during batch Z39.50 searches. The default value is five (5).

Matching Records in Buckets with Records from Z39.50 Sources

1. Add records to a bucket.

2. Click Bucket Actions → Locate Z39.50 Matches. A pop up window will appear.

3. Select a Z39.50 Server(s).

4. Select a Z39.50 Search Index(es). Note that selecting multiple checkboxes will AND the search indexes.
5. Select a Vandelay queue from the drop down menu to which you will add your results, or create a queue by typing its name in the empty field.

6. Select a Match Set. The Match Set is configured in Vandelay and, in this instance, will only be used to compare the Z39.50 results with the records in your bucket.

7. Click Perform Search.

1. Status information will appear, including the number of records in the bucket that were searched, the matches that were found, and the progress of the search. When the search is complete, click Open Queue.

1. The Vandelay Queue will display. Matching records are identified in the Matches column. From this interface, import records according to your normal procedure. It is suggested that to merge
the incoming records with the catalog records, you should choose an option to import the records. Next, select either merge option from the drop down menu, click Merge on Best Match, and then click Import.

1. The records from the Z39.50 search will merge with the catalog records. NOTE: A new column has been added to this interface to identify the Z39.50 source. When records are imported to the Vandelay queue via a record bucket, Evergreen tags the Z39.50 source and enters the data into the $901z.
Monograph Parts enables you to differentiate between parts of monographs or other multi-part items. This feature enables catalogers to describe items more precisely by labeling the parts of an item. For example, catalogers might identify the parts of a monograph or the discs of a DVD set. This feature also allows patrons more flexibility when placing holds on multi-part items. A patron could place a hold on a specific disc of a DVD set if they want to access a specific season or episode rather than an entire series.

Four new permissions are used by this functionality:

- CREATE_MONOGRAPH_PART
- UPDATE_MONOGRAPH_PART
- DELETE_MONOGRAPH_PART
- MAP_MONOGRAPH_PART

These permissions should be assigned at the consortial level to those groups or users that will make use of the features described below.

Add a Monograph Part to an Existing Record

To add a monograph part to an existing record in the catalog:

1. Retrieve a record.
2. Click the Manage Parts tab.
3. Click the New Monograph Part button

4. Enter the label that you want to appear to the user in the catalog, and click Save. This will create a list of monograph parts from which you can choose when you create a volume and copy.

5. Add a volume and copy. To add a volume and copy to your workstation library, click the Add Volumes button in the Record Summary area above the tabs.
To add a volume and copy to your workstation library or other libraries, click the Holdings View tab, right-click the appropriate library, and choose Add → Volumes and Copies.

6. The Unified Volume/Copy Creator opens. Enter the number of volumes that you want to add to the catalog and the volume description.

7. Enter the number of copies and barcode(s) of each item.

8. Choose the part label from the Part drop down menu.

9. Apply a template to the copies, or edit fields in the Working Copies section below.
10. Click Store Selected when those copies are ready.

11. Review your completed copies on the "Completed Copies" tab.

12. When all copies have been stored and reviewed, click "Save & Exit".

If you are only making one set of changes, you can simply click Save & Exit and skip the Store Selected stage.

13. The Holdings View tab now shows the new part information. These fields also appear in the OPAC View.

<table>
<thead>
<tr>
<th>Location</th>
<th>Call Number / Copy Notes</th>
<th>Part</th>
<th>Barcode</th>
</tr>
</thead>
<tbody>
<tr>
<td>English Section</td>
<td>PR1293 (Text)</td>
<td>Volume 1</td>
<td>012345678911</td>
</tr>
<tr>
<td>English Section</td>
<td>PR1293 (Text)</td>
<td>Volume 2</td>
<td>012345678912</td>
</tr>
</tbody>
</table>

**Monograph Part Merging**

The monograph part list for a bibliographic record may, over time, diverge from the proscribed format, resulting in multiple labels for what are essentially the same item. For instance, Vol. 1 may have variants like V.1, Vol 1, or Vol. 1 (leading space). Merging parts will allow cataloging staff to collapse the variants into one value.

In the Monograph Parts display:

1. Click the checkbox for all items you wish to merge including the one you wish to prevail when done.

2. Click on the “Merge Selected” button. A pop-up window will list the selected items in a monospaced font, with blanks represented by a middle-dot character for more visibility.

3. Click on the item you wish to prevail.
The undesired part labels will be deleted, and any copies that previously used those labels will now use the prevailing label.
Chapter 106. Conjoined Items

Prior to Evergreen version 2.1, items could be attached to only one bibliographic record. The Conjoined Items feature in Evergreen 2.1 enables catalogers to link items to multiple bibliographic records. This feature will enable more precise cataloging. For example, catalogers will be able to indicate items that are printed back to back, are bilingual, are part of a bound volume, are part of a set, or are available as an e-reader pre-load. This feature will also help the user retrieve more relevant search results. For example, a librarian catalogs a multi-volume festschrift. She can create a bibliographic record for the festschrift and a record for each volume. She can link the items on each volume to the festschrift record so that a patron could search for a volume or the festschrift and retrieve information about both works.

In the example below, a librarian has created a bibliographic record for two bestselling items. These books are available as physical copies in the library, and they are available as e-reader downloads. The librarian will link the copy of the Kindle to the bibliographic records that are available on the e-reader.

Using the Conjoined Items Feature

The Conjoined Items feature was designed so that you can link items between bibliographic records when you have the item in hand, or when the item is not physically present. Both processes are described here. The steps are fewer if you have the item in hand, but both processes accomplish the same task. This document also demonstrates the process to edit or delete links between items and bibliographic records. Finally, the permission a cataloger needs to use this feature is listed.

Scenario 1: I want to link an item to another bibliographic record, but I do not have the item in hand

1. Retrieve the bibliographic record to which you would like to link an item.
2. Click Actions for this Record → Mark as Target for Conjoined Items.
3. A confirmation message will appear. Click OK.

4. In a new tab, retrieve the bibliographic record with the item that you want to link to the other record.

5. Click Actions for this Record → Holdings Maintenance.

6. Select the copy that you want to link to the other bibliographic record. Right-click, or click Actions for Selected Rows → Link as Conjoined Items to Previously Marked Bib Record.

7. The Manage Conjoined Items interface opens in a new tab. This interface enables you to confirm the success of the link, and to change the peer type if desired. The Result column indicates that you created a successful link between the item and the bib record.
The default peer type, Back-to-back, was set as the peer type for our item. To change a peer type after the link has been created, right-click or click Actions for Selected Items → Change Peer Type. A drop down menu will appear. Select the desired peer type, and click OK.

8. The Result column will indicate that the Peer Type [has been] Updated.

9. To confirm the link between the item and the desired bib record, reload the tab containing the bib record to which you linked the item. You should now see the copy linked in the copies table.

Location

Meeter Center (foreign item)

- **Bound Volume:** Ioannis Calvin Praelectiones in Librum

Meeter Center
Scenario 2: I want to link an item to another bibliographic record, and I do have the item in hand

1. Retrieve the bibliographic record to which you would like to add the item.

2. Click Actions for this Record → Manage Conjoined Items.

3. A note in the bottom left corner of the screen will confirm that the record was targeted for linkage with conjoined items, and the Manage Conjoined Items screen will appear.

4. Select the peer type from the drop down menu, and scan in the barcode of the item that you want to link to this record.

5. Click Link to Bib (Submit).

6. The linked item will appear in the screen. The Result column indicates Success.
7. To confirm the linkage, click Actions for this Record → OPAC View.

8. When the bibliographic record appears, click Reload. Linked Titles will show the linked title and item.

Scenario 3: I want to edit or break the link between a copy and a bibliographic record

1. Retrieve the bibliographic record that has a copy linked to it.

2. Click Actions for this Record → Manage Conjoined Items.

3. Select the copy that you want to edit, and right-click or click Actions for Selected Items.

4. Make any changes, and click OK.

UPDATE_COPY - Link items to bibliographic records
Chapter 107. Cataloging Electronic Resources — Finding Them in Catalog Searches

There are two ways to make electronic resources visible in the catalog without adding copies to the record:

1. Adding a Located URI to the record

2. Attaching the record to a bib source that is transcendent

The Located URI approach is useful for Evergreen sites where libraries have access to different electronic resources. The transcendent bib source approach is useful if all libraries have access to the same electronic resources.

Another difference between the two approaches is that electronic resources with Located URI’s never appear in results where the search is limited to a specific copy location(s). In contrast, transcendent electronic resources will appear in results limited to any copy location.

Adding a Located URI to the Record

A Located URI allows you to add the short name for the owning library to the 856 field to indicate which organizational units should be able to find the resource. The owning organizational unit can be a branch, system, or consortium.

A global flag called When enabled, Located URIs will provide visibility behavior identical to copies will determine where these resources will appear in search results. This flag is available through Admin → Server Administration → Global Flags.

If the When enabled, Located URIs will provide visibility behavior identical to copies flag is set to False (default behavior):

• When the user’s search scope is set at the owning organizational unit or to a child of the owning organizational unit, the record will appear in search results.

• When a logged-in user’s preferred search library is set to the owning organizational unit or to a child of that owning organizational unit, the record will appear regardless of search scope.

If the When enabled, Located URIs will provide visibility behavior identical to copies flag is set to True:

• When the user’s search scope is set at the owning organizational unit, at a child of the owning organizational unit, or at a parent of the owning organizational unit, the record will appear in search results.

• When a logged-in user’s preferred search library is set to the owning organizational unit, to a child of the owning organizational unit, or to a parent (with the exception of the consortium) of the owning organizational unit, the record will appear regardless of search scope.
To add a located URI to the record:

1. Open the record in MARC Edit

2. Add a subfield 9 to the 856 field of the record and enter the short name of the organizational unit for the value. Make sure there is a 4 entered as the first indicator and a 0 entered as the second indicator. For example:

   856 40 $u http://lwn.net $y Linux Weekly News $9 BR1

   would make this item visible to people searching in a library scope of BR1 or to logged-in users who have set BR1 as their preferred search library.

3. Save the record

   If multiple organizational units own the resource, you can enter more than one subfield 9 to the 856 field or you can enter multiple 856 fields with a subfield 9 to the record

   When troubleshooting located URIs, check to make sure there are no spaces either before or after the organizational unit short name.

Located URI Example 1

The When enabled, Located URIs will provide visibility behavior identical to copies flag is set to False (default behavior)

The Record has two 856 fields: one with SYS1 in subfield 9 and the other with BR4 in subfield 9

- Any user searching SYS1 or any of its children (BR1, BR2, SL1) will find the record. These users will only see the URL belonging to SYS1.

- Any user searching BR4 will find the record. These users will only see the URL belonging to BR4.

- A user searching SYS2 will NOT find the record because SYS2 is a parent of an owning org unit, not a child. The same thing happens if the user is searching the consortium. In this case, the system assumes the user is unlikely to have access to this resource and therefore does not retrieve it.

- A logged-in user with a preferred search library of BR4 will find the record at any search scope. This user will see the URL belonging to BR4. Because this user previously identified a preference for using this library, the system assumes the user is likely to have access to this resource.

- A logged-in user with a preferred search library of BR4 who is searching SYS1 or any of its children will also retrieve the record. In this case, the user will see both URLs, the one belonging to SYS1 because the search library matches or is a child of the owning organizational unit and the one belonging to BR4 because it matches or is a child of the preferred search library. The URL belonging to the search library (if it is an exact match, not a child) will sort to the top.
Located URI Example 2

The When enabled, Located URIs will provide visibility behavior identical to copies flag is set to True

The Record has two 856 fields: one with SYS1 in subfield 9 and the other with BR4 in subfield 9

- Any user searching SYS1 or any of its children (BR1, BR2, SL1) will find the record. These users will only see the URL belonging to SYS1.

- Any user searching BR4 will find the record. These users will only see the URL belonging to BR4.

- Any user searching the consortium will find the record. These users will see both URLs in the record. In this case, the system sees this user as a potential user of SYS2 or BR4 and therefore offers them the option of accessing the resource through either URL.

- A user searching SYS2 will find the record because SYS2 is a parent of an owning org unit. The user will see the URL belonging to BR4. Once again, the system sees this user as a potential user of BR4 and therefore offers them the option of accessing this resource.

- A user searching BR3 will NOT find the record because BR3 is neither a child nor a parent of an owning organizational unit.

- A logged-in user with a preferred search library of BR4 who is searching BR3 will find the record. This user will see the URL belonging to BR4. Because this user previously identified a preference for using this library, the system assumes the user is likely to have access to this resource.

- A logged-in user with a preferred search library of BR4 who is searching SYS1 or any of its children will also retrieve the record. In this case, the user will see both URLs, the one belonging to SYS1 because the search library matches or is a child of the owning organizational unit and the one belonging to BR4 because it matches or is a child of the preferred search library. The URL belonging to the search library (if it is an exact match, not a child) will sort to the top.

Using Transcendant Bib Sources for Electronic Resources

Connecting a bib record to a transcendent bib source will make the record visible in search results regardless of the user’s search scope.

To start, you need to create a transcendent bib source by adding it to config.bib_source in the Evergreen database and setting the transcendant field to true. For example:

```sql
# INSERT INTO config.bib_source(quality, source, transcendant, can_have_copies)
VALUES (50, ‘ebooks’, TRUE, FALSE);
```

If you want to allow libraries to add copies to these records, set the can_have_copies field to TRUE. If you want to prevent libraries from adding copies to these records, set the can_have_copies field to FALSE.
When adding or uploading bib records for electronic resources, set the bibliographic source for the record to the newly-created transcendent bibliographic source. Using the staff client, the bibliographic source can be selected in the MARC Batch Import interface when importing new, non-matching records or in the MARC Edit interface when editing existing records.
Chapter 108. Using the Item Status interface

The Item Status interface is a powerful tool that can give you a lot of information about specific items in your catalog.

Accessing the Item Status interface

There are three ways to access the item status interface:

Through the Search menu

1. Click Search → Search for Copies by Barcode.
2. Scan your barcode.

Through the Circulation menu

1. Click Circulation → Item Status.
2. Scan your barcode.

From the OPAC view

1. Click Search → Search the Catalog.
2. Find a bibliographic record that you are interested in.
3. Make sure you are on the OPAC View tab of that record.
4. Locate the BARCODE column in the holdings session.
5. Click view next to the barcode of the item you’re interested in.

Specific fields

Active date

This date is automatically added by Evergreen the first time an item receives a status that is considered active (i.e. the first date on which patrons could access the copy). While your consortium may customize which statuses are considered active and which are not, statuses like Available and On holds shelf are typically considered active, and statuses like In process or On order are typically not.
Printing spine labels

Before printing spine labels, you will want to install Hatch or turn off print headers and footers in your browser.

Turning off print headers and footers in Firefox

If you are not using Hatch for printing, you will probably want to configure your browser so that Firefox does not add headers and footers to items printed on certain printers. For example, if you are printing spine labels, you likely will not want Firefox to add a date or URL to the margins of your label.

You can turn off these headers and footers using the following steps:

1. In the Firefox menu, click Print… to open the print preview screen.
2. Click the Page Setup… button.
3. Go to the Margins & Header/Footer tab.
4. Make sure that all dropdown menus are set to --blank--.

If you only want to turn off those headers and footers for a specific printer, use these steps:

1. In the Firefox address bar, type about:config.
2. If a warning appears, click I accept the risk.
3. Type print_header into this screen’s search box.
4. Double-click on the relevant print_headerleft, print_headerright, and print_headercenter entries in the grid.
5. Delete any existing data for that setting and click OK.
6. Type print_footer into the screen’s search box and repeat these steps for the footer settings.

Turning off print headers and footers in Chrome

If you are not using Hatch for printing, you will probably want to configure your browser so that Chrome does not add headers and footers to items printed on certain printers. For example, if you are printing spine labels, you likely will not want Chrome to add a date or URL to the margins of your label.

You can turn off these headers and footers using the following steps:
1. In the Chrome menu, click Print… to open the print preview screen.
2. Click More Settings.

**Creating spine labels**

To create spine and item labels for an item (or group of items):

1. Click Circulation → Item Status.
2. Scan your barcode(s).
3. Select all the items you’d like to print labels for.
4. Right-click on the items, or click the Actions drop-down menu.
5. Under Show, click on Print Labels.
6. Take a look at the Label Preview area.
7. When you are satisfied with your labels, click the Print button.
Chapter 109. Using the Volume/Copy Editor

The Volume/Copy Editor is the tool where you can edit all holdings data.

Specific fields

Acquisitions Cost

This field is populated with the invoiced cost of the originating acquisition. This field will be empty until its originating acquisition is connected to an invoice.

Copy Number

If you have multiple copies of the same item, you may want to assign them copy numbers to help distinguish them. If you do not include a copy number in this field, Evergreen will assign your item a default copy number of 1.

Accessing the Volume/Copy Editor by barcode

1. Click Search → Search for Copies by Barcode
2. Scan your barcode.
3. Right click on the entry in the grid.
4. Click Edit → Volumes and Items on the actions menu that appears.

Accessing the Volume/Copy editor from a catalog record

The bibliographic record detail page displays library holdings, including the call number, shelving location, and copy barcode. Within the staff client, the holdings list now displays a new column next to the copy barcode(s). This new column contains two links, view and edit.
Clicking on the view link opens the Item Status screen for that specific copy.

Clicking on the edit link opens the Volume and Copy Creator screen for that specific copy.

The edit link will only be exposed next to copies when the user has the UPDATE_COPY permission at the copy owning or circulating library.

For libraries where the Library Setting: Unified Volume/Item Creator/Editor value is set to True, the unified Volume and Copy Creator screen will open.

For libraries where the Library Setting: Unified Volume/Item Creator/Editor value is set to False, the standard Volume and Copy Creator screen will open.
Chapter 110. MARC Batch Edit

Introduction

This function is used to batch edit MARC records either adding a field, removing a field or changing the contents of a field.

<table>
<thead>
<tr>
<th>What MARC Batch Edit Can and Can’t Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARC Batch Edit is a powerful tool, but it also has some limitations. This tool can do the following tasks to a group of MARC records:</td>
</tr>
<tr>
<td>• Remove all instances of a specific tag (e.g. remove all 992 tags)</td>
</tr>
<tr>
<td>• Remove all instances of a specific tag if a particular subfield has a particular value (e.g. remove all 650 fields in which the $2 is fast)</td>
</tr>
<tr>
<td>• Remove all instances of a specific subfield (e.g. remove all 245$h)</td>
</tr>
<tr>
<td>• Remove all instances of a specific set of subfields</td>
</tr>
<tr>
<td>• Add a field</td>
</tr>
<tr>
<td>• Add a subfield to an existing field</td>
</tr>
<tr>
<td>• Replace data in a specific field or subfield</td>
</tr>
</tbody>
</table>

It cannot do more advanced tasks, such as:

• Swapping data from one field to another
• Deduplicating MARC records
• Complex logic based on existing data

For more advanced projects, you may wish to export your records and use a free tool such as MARCEdit or PyMarc.

Setting Up a Batch Edit Session

Record Source This includes options to batch edit identifying MARC records in a record bucket, CSV file or by record id.

Go! (button) This button runs the action defined by the rule template(s).

Action (Rule Type)

Replace Replaces the value in a MARC field for a batch of records.
Delete Removes a MARC field and its contents from the batch of records.
Add Use this to add a field and its contents to a batch of records.

Other Template Fields

MARC Tag This is used to identify the field for adding, replacing, or deleting.
Subfield (optional) Indicates which subfield is being edited.
MARC Data Use this to indicate the data to add or used in replacing the existing data.

Advanced Matching Restrictions (Optional)

Subfield Regular Expression:: Using PERL syntax for a regular expression to identify the data to be removed or replaced.

Running a Template to Add, Delete, or Replace MARC data
1. Click Cataloging→MARC Batch Edit
2. Select Record source
3. Select the appropriate bucket, load the CSV file or enter record id depending on Record source selected
4. Select the Action Rule
5. Enter the MARC Tag with no indicators (eg. 245)
6. Enter the subfields with no spaces. Subfields are optional. Multiple subfield can be entered such as auz.
7. Enter the MARC Data which is the value in the fields
8. Enter optional Advanced Matching Restrictions
   a. Subfield
   b. Regular Expression (using PERL syntax)
9. Click Go!
10. Results page will display indicating the number of records successfully edited

Examples

Adding a new field to all records
1. In the action menu, choose Add.
2. In MARC Tag, type the MARC tag number.

3. Leave the Subfields field blank.

4. In MARC Data, type the field you would like to add.

**Delete a field if it contains a particular string**

1. In the action menu, choose Delete.

2. In MARC Tag, type the MARC tag number.

3. Leave the Subfields field blank.

4. In MARC Data, type the field you would like to add.

5. In the subfield field under Advanced Matching Restriction, type the subfield code where you expect to see the string.

6. In Regular Expression, type the string you expect to see.
Chapter 111. Managing Authorities

Introduction

This section describes how you can create, import, view, modify, merge, and delete authority records in Evergreen.

Creating Authorities

Currently in Evergreen to create a new authority record, as opposed to importing an authority record, you need to have a bib record open in the bib MARC editor.

• For example, if you want to create a new author authority you need to have a bib record that has a bib 1xx or 7xx tag with the main entry filled out.

• Then you need to right click on that 1xx or 7xx tag. In the context menu that shows up, select Create New Authority from this field, then select either Create Immediately or Create and Edit....

• If you choose Create and Edit..., after the authority MARC editor opens you need to click on the Save button to finally add the new authority record to your system.

Importing Authorities

1. Click Cataloging → MARC Batch Import/Export.

2. You may create a queue to better track this import project. If you do not create a new queue, it will automatically put your records into a default queue named -.

3. Don’t set a value for Holdings Import Profile, because this doesn’t apply to authority records.

4. Select a file of authority data and put it in the File to Upload field.

5. Make sure all the settings are correct, then press Upload.

   The screen displays "Uploading... Processing..." to show that the records are being transferred to the server, then displays a progress bar to show the actual import progress. When the staff client displays the progress bar, you can disconnect your staff client safely. Very large batches of records might time out at this stage.

6. Evergreen will automatically assign a thesaurus based on the Subj fixed field, which is character 11 in the 008 field.

7. Evergreen will also try to determine who edited the record (based on the MARC 905u field or the user performing the import) and set the edit date, which you can view when you examine the record in the future.

8. Once the import is finished, the staff client displays the results of the import process. You can manually display the import progress by selecting the Inspect Queue tab of the MARC
Batch Import/Export interface and selecting the queue name. By default, the staff client does not display records that were imported successfully; it only shows records that conflicted with existing entries in the database. The screen shows the overall status of the import process in the top right-hand corner, with the Total and Imported number of records for the queue.

If you are importing authorities from an external vendor and want to track this, you may wish to set a unique Record Source. This source will be visible in the MARC Editor and in the 901$s field of the imported authority records.

### Setting up Authority Record Match Sets

1. Click Cataloging → MARC Batch Import/Export.
2. Click Record Match Sets.
3. If you have sufficient privileges, you will be able to click on the New Match Set. If you are unable to do so, check that you have the ADMIN_IMPORT_MATCH_SET permission.
4. Give your new set a descriptive name, an owning library, and a match set type of authority.
5. Click on the blue hyperlinked name of the match set you just created to add criteria.
6. You can match against MARC tag/subfield entries or against a record’s normalized heading.

Evergreen’s database stores normalized authority headings in a format that includes the thesaurus. This way, record match sets will not match terms from other thesauri, even if the term is very similar.

Evergreen’s internal identifier is in the 901c field. If you have previously exported authority record — perhaps for an external vendor to do authority cleanup work — and you want to import them back into your catalog, you may wish to include the 901c field in your match set.

### Manage Authorities Interface

In Evergreen to view, edit, merge, and delete authority records you would use the Manage Authorities interface through the Cataloging menu.

### Searching for authorities

To search for authorities in your system, first select the Cataloging menu and then select Manage Authorities. Then proceed to fill out the search form.
1. Type in your Search Term
2. Select an Authority type, types currently include: Author, Subject, Title, Topic
3. Click on the Submit button

The authority search results will include the following elements from left to right:

- Actions menu, which can be used to select actions that affect the corresponding authority record. Actions include: Edit, Mark for Merge, Delete
- Count of how many bibs are linked to the corresponding authority
- Main entry of the authority, i.e the authority tag 1xx value
- Control set value, with LoC being the default, but others can be added
- Authority Subject heading system/thesaurus, for example a value of "a" means authority originated from the Library of Congress (http://www.loc.gov/marc/authority/ad008.html)

Library of Congress list of thesaurus values:
- " = Alternate no attempt to code
- a = Library of Congress Subject Headings
- b = LC subject headings for children’s literature
- c = Medical Subject Headings
- d = National Agricultural Library subject authority file
- k = Canadian Subject Headings
- n = Not applicable
- r = Art and Architecture Thesaurus
- s = Sears List of Subject Headings
- v = Repertoire de vedettes-matiere
- z = Other
- | = No attempt to code

**Editing authority records**

Editing an authority record (or merging two authority records) can cause its linked bibliographic records to also update. For example, if you correct a spelling error in the 150 field of a subject authority record, the relevant 650 field in linked bibliographic records will also be updated to reflect the correct spelling.
When a bib record is automatically updated as a result of the modification of a linked authority record, the bib record’s "Last Edit Date/ Time" and "Last Editing User" fields will be updated to match the time of the update and the editor of the authority record. If you’d prefer that these fields not be automatically updated, you can set the ingest.disable_authority_auto_update_bib_meta setting to true in the Library Settings Editor.
Chapter 112. Link Checker

The Link Checker enables you to verify the validity of URLs stored in MARC records. The ability to verify URLs would benefit locations with large electronic resource collections.

Search for URLs

Search for MARC records that contain URLs that you want to verify.

1. Click Cataloging → Link Checker.
2. Click New Link Checker Session.
3. Create a session name. Note that each session must have a unique name.
4. Select a search scope from the drop down menu. Records that would be retrieved by searching Example Branch 1 (BR1) in an OPAC search would also be retrieved here. For example, a record that describes an electronic resource with a URL in the 856 $u and an org unit code, such as BR1, in the 856 $9, would be retrieved by a search of relevant keywords. Also, records that contain a URL without the $9 subfield, but also have physical copies at BR1, would be retrieved. Note that you can skip this step if you enter the org unit code of the location that you want to search in the Search field.
5. Enter search terms to retrieve records with URLs that you want to verify. You can also add a location filter, such as BR1.
6. You may further limit your search by selecting a saved search. Saved searches are filters made up of specific criteria, such as shelving location or audience. Adding a saved search to your keyword search will narrow your search for records with URLs. This step is optional.
7. Enter tags and subfields that contain URLs in the appropriate boxes. Click Add after you enter the data in the fields. You can add multiple tags and subfields by repeating this process. Evergreen will search for records that match your search terms, and then, from the set that it retrieves, it will extract any URLs from all of the tag/subfield locations you have specified for the session.
8. To view and manually verify the URLs that Evergreen retrieves, leave the Process Immediately button unchecked. If you want Evergreen to automatically verify the URLs that it retrieves, then check the box to Process Immediately.
9. Click Begin to process your search.
View Your Results

If you do not click Process Immediately, then you must select the links that you want to verify, and click Verify Selected URLs. If you click Process Immediately, then you skip this step, and Evergreen jumps directly to the results of the verification attempts as seen in the next step.

Evergreen displays the results of the verification attempts, including the tags that you searched, the URLs that Evergreen retrieved, the Bib Record ID, the request and result time, and the result code and text.

Manage Your Sessions

Edit Columns

You can use the Column Picker to add and remove columns on any of the Link Checker interfaces. To access the Column Picker, right click on any of the column headings. The columns are saved to your user account.
Clone Sessions

You can clone sessions that you run frequently or that have frequently-used parameters that need only minor adjustments to create new searches. To clone a session:

1. Click Cataloging → Link Checker.
2. In the Session ID column, click Clone. A copy of the parameters of that search will appear.

View Verification Attempts

To view the results of a verification attempt after you have closed the session, click Cataloging → Link Checker. Your link checker sessions appear in a list. To view the results of a session, click the Open link in the Session ID column.

Click Filter to refine the results on this page. To add a filter:

1. Select a column from the first drop down menu.
2. Select an operator from the second drop down menu.
3. A third field will appear. Enter the appropriate text.
4. Click Apply to apply the filter to your current results. Click Save Filters to save the filter to your user account for later use.
Chapter 113. Notes about the Bibliographic Schema in the Database

Bibliographic fingerprint

Evergreen creates a fingerprint for each bib record, which can be found in the `fingerprint` column of the `biblio.record_entry` table. This fingerprint is used to group together different bib records in a Group Formats & Editions search in the public catalog.

The bibliographic fingerprint incorporates several subfields to distinguish between different items, including:

- $n and $p from MARC title fields to better distinguish among records of the same series that may share the same title but have a different part.

The bibliographic fingerprint distinguishes among the fields contributing to the fingerprint. This helps the system distinguish between a record for the movie Blue Steel and another record for the book Blue written by Danielle Steel.
Chapter 114. MARC Templates

MARC Templates make the cataloging process more efficient for catalogers. At this time, MARC Templates have to be created on the server, rather than in the Web client.

Adding MARC Templates

1. Create a marc template in the directory `/openils/var/templates/marc/`. It should be in xml format. Here is an example file `k_book.xml`:

   `<record>
     <leader>00620cam a2200205Ka 4500</leader>
     <controlfield tag="008">070101s                            eng d</controlfield>
     <datafield tag="010" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="020" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="082" ind1="0" ind2="4">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="092" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="100" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="245" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="260" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="300" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="500" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="650" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
     <datafield tag="650" ind1="" ind2="">
       <subfield code="v"></subfield>
     </datafield>
     <datafield tag="650" ind1="" ind2="">
       <subfield code="a"></subfield>
     </datafield>
   </record>`

2. Add the template to the to the marctemplates list in the open-ils.cat section of the Evergreen configuration file `opensrf.xml`.

3. Restart perl services for changes to take effect with the command `/openils/bin/osrf_control -l --restart --service=open-ils.cat`
Part X. Serials
Table of Contents

115. Serials .......................................................................................................................... 553
   MFHD Records ............................................................................................................. 553
116. Serials Administration ............................................................................................... 554
   Serial Copy Templates ................................................................................................. 554
      Creating a Serial Copy Template ............................................................................. 554
      Modifying a Serial Copy Template ........................................................................... 556
      Deleting a Serial Copy Template ............................................................................. 556
   Prediction Pattern Templates ....................................................................................... 557
      Creating a Prediction Pattern Template ................................................................... 557
117. Serials Module ............................................................................................................ 563
   Create a Subscription .................................................................................................... 563
   Create and Manage Predictions .................................................................................... 564
      Predict Issues Using a New Prediction Pattern ....................................................... 565
      Predict Issues Using a Prediction Pattern Template ................................................. 566
      Predict Issues Using a Prediction Pattern from a Bibliographic and/or MFHD Record ................................................................................................................ 567
   Manage Issues ................................................................................................................ 569
118. Receiving .................................................................................................................... 570
   Quick Receive ................................................................................................................ 570
   Receiving from the Manage Issues tab ........................................................................ 571
      Receive Next Issue and Barcode .............................................................................. 571
      Receive Next Issue (no barcode) .............................................................................. 571
   Batch Receiving ............................................................................................................ 572
      Batch Receive and Barcode ...................................................................................... 572
      Receive multiple issues (no barcode) ........................................................................ 573
119. Routing Lists .............................................................................................................. 574
120. Special Issues ............................................................................................................. 576
   Adding Extra Copies .................................................................................................... 576
   Adding Special Issues .................................................................................................. 577
121. Binding Issues ............................................................................................................ 579
122. Holdings ...................................................................................................................... 580
   System Generated Holdings Statement ...................................................................... 580
   MARC Format for Holdings Display (MFHD) ............................................................... 580
      Create an MFHD record ............................................................................................ 580
      Edit a MFHD record ................................................................................................ 581
      Delete a MFHD Record ............................................................................................. 581
123. Group Serials Issues in the Template Toolkit OPAC .................................................... 582
   Administration .............................................................................................................. 582
   Displaying Issues in the OPAC .................................................................................... 582
Chapter 115. Serials

MFHD Records

MARC Format for Holdings Display (MFHD) display in the catalog in addition to holding statements generated by Evergreen from subscriptions created in the Serials Module. The MFHDs are editable as MARC but the holdings statements generated from the control view are system generated. Multiple MFHDs can be created and are tied to Organizational Units.
Serial Copy Templates

Serials copy templates enable you to specify item attributes that should be applied by default to copies of serials. Serials copy templates are associated with distributions in a subscription and are applied when serials copies are received. Serial copy templates can also be used as a binding template to apply specific item attributes to copies that are being bound together.

Creating a Serial Copy Template

To create a serial copy template, go to Administration→Serials Administration→Serial Copy Templates:

1. Click Create Template in the upper-right hand corner. A dialog box will appear.

2. Within the dialog box assign the template a Template Name and set any item attributes that you want in the template:
   a. Circulate?: indicate if the items can circulate.
   b. Circulation Library: Select the circulation library from the drop down menu.
   c. Shelving Location: Select the shelving location for the item from the drop down menu. This menu is populated from the locations created in Admin→Local Administration→Copy Locations Editor.
   d. Circulation Modifier: Select the circulation modifier for the item from the drop down menu. This menu is populated from the modifiers created in Admin→Server Administration→Circulation Modifiers.
   e. Loan Duration: Select a loan duration from the drop down menu. This menu is populated from the loan durations created in Admin→Server Administration→Circulation Duration Rules. This field is required.
   f. Circulate as Type: Select a Type of record from the drop down menu if you want to control circulation based on the Type fixed field in the MARC bibliographic record. Most libraries choose to control circulation based on Circulation Modifier instead of Circulate as Type in Evergreen.
   g. Holdable?: Yes or No-- indicate if holds can be placed on the items.
   h. Age-based Hold Protection: Select a rule from the drop down menu. Age-based hold protection allows you to control the extent to which an item can circulate after it has been received. For example, you may want to protect new copies of a serial so that only patrons who check out the item at your branch can use it.
i. Fine Level: Select a fine level from the drop down menu. This menu is populated from the fine levels created in Admin→Server Administration→Circulation Recurring Fine Rules. This field is required.

j. Floating: Select a Floating policy from the drop down menu if the items belong to a floating collection.

k. Status: Select a copy status from the Status drop down menu. This menu is populated from the statuses created in Admin → Server Administration → Copy Statuses.

l. Reference?: Yes or No-- indicate if the item is a reference item.

m. OPAC Visible?: Yes or No-- indicate if the item should be visible in the OPAC.

n. Price: Enter the price of the item.

o. Deposit?: Yes or No-- indicate if patrons must place a deposit on the copy before they can use it.

p. Deposit Amount: Enter a Deposit Amount if patrons must place a deposit on the copy before they can use it.

q. Quality: Good or Damaged-- indicate the physical condition of the item.

3. Click Save.

4. The new serial copy template will now appear in the list of templates.
Modifying a Serial Copy Template

To modify a Serial Copy Template:

1. Select the template to modify by checking the box for the template or clicking anywhere on the template row. Go to Actions→Edit Template or right-click on the template row and select Edit Template.

2. The dialog box will appear. Make any changes to the item attributes and click Save.

Deleting a Serial Copy Template

To delete a Serial Copy Template:
1. Select the template to modify by checking the box for the template or clicking anywhere on the template row.

2. Go to Actions→Delete Template or right-click on the template row and select Delete Template.

Serials copy templates that are being used by subscriptions cannot be deleted.

Prediction Pattern Templates

Prediction pattern templates allow you to create templates for prediction patterns that can be shared with other staff users in your library branch, system, or throughout the consortium. Prediction patterns are used to predict issues on serials subscriptions. Templates can be created in the Administration module, as described below, and can also be created and shared directly in a subscription.

Creating a Prediction Pattern Template

To create a template, go to Administration→Serials Administration→Prediction Pattern Templates:

1. Click New Record in the upper-right hand corner. A dialog box called Prediction Pattern Template will appear.

2. Assign a Name to the template, such as "Monthly", to create a monthly publication pattern.

3. Next to Pattern Code click Pattern Wizard. The Prediction Pattern Code Wizard will appear. This wizard has five tabs that will step you through creating a prediction pattern for your publication.

   a. Enumeration Labels

      i. If the publication does not use enumeration and instead only uses dates, select the radio button adjacent to Use Calendar Dates Only and click Next in the upper right-hand corner and go to b. Chronology Display in this document.

      ii. If the publication uses enumerations (commonly used), select the radio button adjacent to Use enumerations. The enumerations conform to $a-$h of the 853, 854, and 855 MARC tags.

      iii. Enter the first level of enumeration in the field labeled Level 1. A common first level enumeration is volume, or "v.". If there are additional levels of enumeration, click Add Level.

      iv. A second field labeled Level 2 will appear. Enter the second level of enumeration in the field. A common second level enumeration is number, or "no.".

         A. Select if the second level of enumeration is a set Number, Varies, or is Undetermined.

         B. If Number is selected (commonly used):

            i. Enter the number of bibliographic units per next higher level (e.g. 12 no. per v.). This conforms to $u$ in the 853, 854, and 855 MARC tags.
II. Select the radio button for the enumeration scheme: Restarts at unit completion or Increments continuously. This conforms to $v$ in the 853, 854, and 855 MARC tags.

C. You can add up to six levels of enumeration.

v. Check the box adjacent to Add alternative enumeration if the publication uses an alternative enumeration.

vi. Check the box adjacent to First level enumeration changes during subscription year to configure calendar changes if needed. A common calendar change is for the first level of enumeration to increment every January.

A. Select when the Change occurs from the drop down menu: Start of the month, Specific date, or Start of season.

B. From the corresponding drop down menu select the specific point in time at which the first level of enumeration should change.

C. Click Add more to add additional calendar changes if needed.

vii. When you have completed the enumerations, click Next in the upper right-hand corner.

---

a. Chronology Display

i. To use chronological captions for the subscription, check the box adjacent to Use Chronology Captions?

ii. Choose a chronological unit for the first level. If you want to display the term for the unit selected, such as "Year" and "Month" next to the chronology caption in the catalog, then select the checkbox for Display level descriptor? (not commonly used).

iii. To add additional levels of chronology for display, click Add level.

A. Note: Each level that you add must be a smaller chronological unit than the previous level (e.g. Level 1 = Year, Level 2 = Month).
iv. Check the box adjacent to Use Alternative Chronology Captions? If the publication uses alternative chronology.

v. After you have completed the chronology caption, click Next in the upper-right hand corner.

![Edit Prediction Pattern](image)

a. MFHD Indicators

i. Compression Display Options: Select the appropriate option for compressing or expanding your captions in the catalog from the compressibility and expandability drop down menu. The entries in the drop down menu correspond to the indicator codes and the subfield $w$ in the 853 tag. Compressibility and expandability correspond to the first indicator in the 853 tag.

ii. Caption Evaluation: Choose the appropriate caption evaluation from the drop down menu. Caption Evaluation corresponds to the second indicator in the 853 tag.

iii. Click Next in the upper right hand corner.

![Edit Prediction Pattern](image)

a. Frequency and Regularity

i. Indicate the frequency of the publication by selecting one of the following radio buttons:

A. Pre-selected and choose the frequency from the drop down menu.

B. Use number of issues per year and enter the total number of issues in the field.

ii. If the publication has combined, skipped, or special issues, that should be accounted for in the publication pattern, check the box adjacent to Use specific regularity information?.

A. From the first drop down menu, select the appropriate publication information: Combined, Omitted, or Published issues.

B. From the subsequent drop down menus, select the appropriate frequency and issue information.
C. Add additional regularity rows as needed.

D. For a Combined issue, enter the relevant combined issue code. E.g., for a monthly combined issue, enter 02/03 to specify that February and March are combined.

iii. After you have completed frequency and regularity information, click Next in the upper-right hand corner.

![Edit Prediction Pattern](image)

a. Review

i. Review the Pattern Summary to verify that the pattern is correct. You can also click on the expand arrow icon to view the Raw Pattern Code.

ii. If you want to share this pattern, assign it a name and select if it will be shared with your library, the system, or across the consortium.

iii. Click Save.
1. Back in the Prediction Pattern Template dialog box, select the Owning Library, which will default to the workstation library.

2. If you want to share the template, set the Share Depth to indicate how far out into your consortium the template will be shared.
1. The Prediction Pattern will now appear in the list of templates and can be used to create predictions for subscriptions.

Prediction Patterns can be edited after creation as long as all predicted issues have the status of "Expected". Once an issue is moved into a different status, the Prediction Pattern cannot be changed.
Chapter 117. Serials Module

The Serials Module can be used to create subscriptions, distributions, streams, and prediction patterns. As well as to generate predictions and receive issues as they come in to the library.

To access the Serials Module, go to a serials record in the catalog, and click on Serials→Manage Subscriptions. This will open the serials interface for that particular record. In this interface you can:

1. Create and manage subscriptions
2. Create and manage predictions
3. Create and manage issues
4. Create and manage MFHDs

Create a Subscription

1. From a bibliographic record, go to Serials→Manage Subscriptions, view the Manage Subscriptions tab.
2. Within the Manage Subscriptions tab, create a new subscription by clicking New Subscription. The subscription editor will appear:
   a. Select the Owning Library for the subscription. The owning library indicates the organizational unit(s) whose staff can use this subscription. The rule of parental inheritance applies to this list. For example, if a system is made the owner of a subscription, then users, with appropriate permissions, at the branches within the system could also use this subscription. This field is required.
   b. Enter the date that the subscription begins in the Start Date field. This field is required.
   c. An End Date for the subscription may also be entered, but it is not required.
   d. Optionally, enter an Expected Offset. This is the difference between the nominal publishing date of an issue and the date that you expect to receive your copy. For example, if an issue is published the first day of each month, but you receive the copy two days prior to the publication date, then enter "-2 days" into this field.
   e. Next, create a Distribution for the subscription by selecting the Library for the distribution. Distributions identify the branches that will receive copies of a serial.
i. Note: If the Owning Library of the subscription was set at the branch level, the Library will be the same as the Owning Library. If the Owning Library of the subscription was set at the system level, the Library will be set to the holdings library.

f. Enter a Label for the distribution. It may be useful to identify the branch to which you are distributing these issues in this field. This field is not publicly visible and only appears when an item is received. There are no limits on the number of characters that can be entered in this field.

g. Select the preferred OPAC Display for holdings: Chronological or Enumeration.

h. Select the Receiving Template that will be applied to items as they are received. The receiving templates are configured in Administration→Serials Administration→Serial Copy Templates.

i. Next, create a Stream by assigning a label to the stream in the Send to field. The stream indicates the number of copies that should be sent to the distribution library. You can click Add copy stream if the library will receive multiple copies of the serial.

3. After the subscription, distribution, and copy information is configured, click Save and go to the Manage Predictions tab to create the prediction pattern that will be used to generate predictions for this title.

After creating a subscription, you can use the Actions menu to take a variety of actions with the subscription, such as adding Subscription or Distribution Notes, linking it to an MFHD record, or creating routing lists.

Create and Manage Predictions

From the Manage Predictions tab you can create a new prediction pattern from scratch, use an existing pattern template, or use an existing pattern template as the basis for a new prediction pattern.
Predict Issues Using a New Prediction Pattern

1. Within the Manage Predictions tab, Select [a] subscription to work on from the drop down menu.

2. To create a new prediction pattern, click Add New.
   
a. The box next to Active will be checked by default.

b. Select the Type of pattern from the drop down menu and click Create Pattern. The Pattern Wizard will appear.

c. Follow the steps in the section Creating a Pattern Template in this documentation to create a new pattern using the wizard.

1. After creating the pattern in the wizard, click Create. The new prediction pattern will now appear under Existing Prediction Patterns.

2. To create predictions, click Predict New Issues.

   You can also predict new issues from the Manage Issues tab.

   
a. Select the Publication date for the subscription. This will be publication date of the first issue you expect to receive.
b. The Type will correspond to the type of prediction pattern selected.

c. Enter any Enumeration labels for the first expected issue.

d. Enter any Chronology labels for the first expected issue.

e. Enter the Prediction count. This is the number of issues that you want to predict.

2. Click Save.

3. Evergreen will generate the predictions and bring you to the Manage Issues tab to review the predicted issues.

Predict Issues Using a Prediction Pattern Template

1. Within the Manage Predictions tab, Select [a] subscription to work on from the drop down menu.

2. Select a template from the drop down menu that appears under the Add New button and click Create from Template. The pattern information will appear below the drop down menu.
1. If you want to use the pattern "as is" click Create.
   a. If you want to review or modify the pattern, click Edit Pattern. The Pattern Wizard will appear.
   b. The Pattern Wizard will be pre-populated with the pattern template selected. Follow the steps in the section Creating a Pattern Template in this documentation to modify the template or click Next on each tab to review the template.
   c. After modifying or reviewing the pattern in the wizard, click Create. The prediction pattern will now appear under Existing Prediction Patterns.

2. To create predictions, click Predict New Issues.
   a. Note: you can also predict new issues from the Manage Issues tab.

   a. Select the Publication date for the subscription. This will be publication date of the first issue you expect to receive.
   b. The Type will correspond to the type of prediction pattern selected.
   c. Enter any Enumeration labels for the first expected issue.
   d. Enter any Chronology labels for the first expected issue.
   e. Enter the Prediction count. This is the number of issues that you want to predict.

4. Click Save.

5. Evergreen will generate the predictions and bring you to the Manage Issues tab to review the predicted issues.

**Predict Issues Using a Prediction Pattern from a Bibliographic and/or MFHD Record**

Evergreen can also generate a prediction pattern from existing MFHD records attached to a serials record and from MFHD patterns embedded directly in the bibliographic record.

1. Within the Manage Predictions tab, Select [a] subscription to work on from the drop down menu.
2. Click Import from Bibliographic and/or MFHD Records.
1. A dialog box will appear that presents the available MFHD records and the prediction pattern that will be imported.

2. Check the box adjacent to the MFHD record that you would like to import and click Import. The new prediction pattern will now appear under Existing Prediction Patterns.

1. If you want to review or modify the pattern, click Edit Pattern. The Pattern Wizard will appear.
   a. The Pattern Wizard will be pre-populated with the pattern from the MFHD selected. Follow the steps in the section "Creating a Pattern Template" in this documentation to modify the template or click Next on each tab to review the template.

2. To create predictions, click Predict New Issues.
   a. Note: you can also predict new issues from the Manage Issues tab.

   a. Select the Publication date for the subscription. This will be publication date of the first issue you expect to receive.
   b. The Type will correspond to the type of prediction pattern selected.
   c. Enter any Enumeration labels for the first expected issue.
   d. Enter any Chronology labels for the first expected issue.
   e. Enter the Prediction count. This is the number of issues that you want to predict.
4. Click Save.

5. Evergreen will generate the predictions and bring you to the Manage Issues tab to review the predicted issues.

**Manage Issues**

After generating predictions in the Manage Predictions tab, you will see a list of the predicted issues in the Manage Issues tab. A variety of actions can be taken in this tab, including receiving issues, predicting new issues, adding special issues.
Chapter 118. Receiving

Issues can be received through the Manage Issues tab or through the Quick Receive option located in the bibliographic record display. While receiving, staff can select if issues should be barcoded during receipt.

Quick Receive

1. From a serials record in the catalog, go to Serials→Quick Receive.

2. A dialog box will appear. Select the Library and Subscription for which you are receiving issues from the drop down menu and click OK/Continue.

3. A Receive items dialog box will appear with the next expected issue.
   a. To receive the item(s) and barcode them:
      i. The Copy Location and Circulation Modifier will be pre-populated from the Receive Template associated with the Distribution. Changes can be made to the pre-populated information.
         A. Note: Copy location, call number, and circulation modifier can be applied to multiple copies in batch using the batch modify.
      ii. Call Number: Enter a call number. Any item with a barcode must also have a call number.
      iii. Barcode: Scan in the barcode that will be affixed to the issue.
      iv. The box adjacent to Receive the issue will be checked by default.
      v. Check the box adjacent to Routing List to print an existing routing list.
      vi. Click Save to receive the issue. The Status of the issue will update to "Received" and a Date Received will be recorded. The barcoded copy will now appear in the holdings area of the catalog and the Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issue.
   b. To receive the item(s) without barcoding them:
      i. Uncheck the box adjacent to Barcode Items and click Save. The Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issue.
Receiving from the Manage Issues tab

The Manage Issues tab can be used to receive the next expected issue and to receive multiple expected issues. This tab can be accessed by retrieving the serial record, going to Serials→Manage Subscriptions, and selecting the Manage Issues tab.

Receive Next Issue and Barcode

1. Within the Manage Issues tab, Select [a] subscription to work on from the drop down menu. The list of predicted issues for the subscription will appear.

2. Check the box adjacent to Barcode on receive.

3. Click Receive Next.

4. A Receive items dialog box will appear with the next expected issue and item(s).

5. The Copy Location and Circulation Modifier will be pre-populated from the Receive Template associated with the Distribution. Changes can be made to the pre-populated information.

6. Call Number: Enter a call number. Any item with a barcode must also have a call number.

7. Barcode: Scan in the barcode that will be affixed to the item(s).

8. The box to Receive the item(s) will be checked by default.

9. Check the box adjacent to Routing List to print an existing routing list.

10. Click Save to receive the item(s). The Status of the issue will update to "Received" and a Date Received will be recorded. The barcoded item(s) will now appear in the holdings area of the catalog and the Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issue.

Receive Next Issue (no barcode)

1. In the Manage Issues tab, make sure the box adjacent to Barcode on receive is unchecked and click Receive Next.
2. A Receive items dialog box will appear with the message "Will receive # item(s) without barcoding."

3. Click OK/Continue to receive the issue. The Status of the issue will update to "Received" and a Date Received will be recorded. The Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issue.

Batch Receiving

Multiple issues can be received at the same time using the Manage Issues tab.

Batch Receive and Barcode

1. Within the Manage Issues tab, Select [a] subscription to work on from the drop down menu. The list of predicted issues for the subscription will appear.

2. Check the box adjacent to Barcode on receive.

3. Check the boxes adjacent to the expected issues you want to receive.

4. Go to Actions→Receive selected or right-click on the rows and select Receive selected from the drop down menu.

5. A Receive items dialog box will appear with the selected issues and items.

6. The Copy Location and Circulation Modifier will be pre-populated from the Receive Template associated with the Distribution. Changes can be made to the pre-populated information.

7. Call Number: Enter a call number. Any item with a barcode must also have a call number.

8. Barcode: Scan in the barcodes that will be affixed to the items.

9. The box to Receive the items will be checked by default.

10. Check the box adjacent to Routing List to print an existing routing list.

11. Click Save to receive the items. The Status of the items will update to "Received" and a Date Received will be recorded. The barcoded items will now appear in the holdings area of the catalog and the Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issues.
Receive multiple issues (no barcode)

1. Within the Manage Issues tab, Select [a] subscription to work on from the drop down menu. The list of predicted issues for the subscription will appear.

2. Make sure the box next to Barcode on receive is unchecked and check the boxes adjacent to the expected issues you want to receive.

3. A Receive items dialog box will appear with the message "Will receive # item(s) without barcoding."

4. Click OK/Continue to receive the issues. The Status of the issue will update to "Received" and a Date Received will be recorded. The Holdings Summary in the Issues Held tab in the catalog will reflect the newly received issues.
Chapter 119. Routing Lists

Routing lists enable you to designate specific users and/or departments that serial items need to be routed to upon receiving.

Create a Routing List

1. To create a routing list for a subscription, go to the Manage Subscriptions tab for a serials record, select the subscription from the list and go to Actions→Additional Routing, or right-click and select Additional Routing. A dialog box will appear where you can create the routing list.

   a. Scan or type in the barcode of the user the items should be routed to in the Reader (barcode) field and click Add Route. Continue adding barcodes until the list is complete.

   b. To route items to a location, click the radio button next to Department, type in the routing location, and click Add Route.

   c. A Note may be added along with each addition to the list.

   d. The names and departments on the list will appear at the top of the dialog box and can be reordered by clicking the arrows or removed by clicking the x next to each name or department.

2. When the list is complete, click Update.
Routing lists can be printed as items are received (see the documentation on Receiving for more information). They can also be printed directly from the Manage Issues tab in a subscription by selecting the item(s) and going to Actions→Print routing lists or right-clicking on the item(s) and selecting Print routing lists from the menu.
Chapter 120. Special Issues

Adding Extra Copies

If the library receives an extra copy of an expected issue, the extra copy can be added to the list of predicted issues so it can be received through the serials module.

To add an extra copy of an expected issue:

1. In the Manage Issues tab, select the issuance that precedes the issuance that you received an extra copy of and go to Actions→Add following issue or right-click on the issuance and select Add following issue from the menu.

2. A dialog box will appear. Verify that the Publication date, Type, and Chronology labels are correct. The Enumeration labels will be filled in automatically when the issue is created.

3. Click Save to create the extra copy of the following issue.

4. The extra copy will appear in the list of issues and can be received using your typical workflow.
Adding Special Issues

If the library receives an unexpected issue of a subscription, such as Summer Issue or Holiday Issue, it can be added to the list of predicted issues as a Special Issue so it can be received through the serials module.

To add a special issue:

1. In the Manage Issues tab, click Add Special Issue. A dialog box will appear.
2. Enter the Publication date of the special issue.
3. Select the Type (typically Basic).
4. Add an Issuance Label to identify the special issue, such as "Holiday Issue 2017".

5. Click Save.

6. The special issue will appear in the list of issues and can be received using your typical workflow.

A special issue may also be added as an ad hoc issue by following the instructions for Adding Extra Copies. Enter the Publication date and Type and check the box adjacent to Ad hoc issue? The form will update to allow you to enter an Issuance Label.
Chapter 121. Binding Issues

Apply a binding template:

To bind issues, first a binding template needs to be applied to the associated Distribution.

1. Go to the Manage Subscriptions tab and from the grid, select the Distribution(s) with issues you’d like to bind.
2. Right-click on the Distribution(s) or go to Actions and select Apply Binding Template.
3. In the dialog box that appears, select the Serial Copy Template you’d like to use from the dropdown and click Update.

To bind received issues together:

1. Go to the Manage Issues tab and select the issues you want to bind together.
2. Right-click on the issues or go to Actions and select Bind.
3. The Bind Items interface will appear and all items will be represented on the screen. The first item’s fields will be editable. Modify the Call Number if needed. Replace the Barcode and click Save.

The barcode must be replaced with a new barcode. The binding will fail if you attempt to reuse an existing barcode from one of the items being bound. Evergreen views it as a duplicate barcode.
Chapter 122. Holdings

System Generated Holdings Statement

As issues are received, Evergreen creates a holding statement in the OPAC based on what is set up in the Caption and Patterns of the subscription. The systems generated holdings can only be edited by changing caption and pattern information and there is no ability to edit the statement as free text.

MARC Format for Holdings Display (MFHD)

Evergreen users can create, edit and delete their own MFHD.

Create an MFHD record

To create a MFHD record:

1. From a serials record in the catalog, go to Serials→Manage MFHDs. This will bring you to the Manage MFHD tab within the serials module.

2. Click Create MFHD.

1. A Create new MFHD dialog box will appear. Select the library for which you are creating the MFHD record and click Create.

2. The MFHD record will appear in the list. Go to Actions→Edit MFHD or right-click on the row and select Edit MFHD from the drop down menu.

1. The MARC Editor will appear. Modify the MFHD record as needed and click Save.

2. The Textual Holdings statement will appear in the Issues Held tab in the catalog.
Edit a MFHD record

1. Open a serial record, go to Serials → MFHD Record → Manage MFHDs and select the appropriate MFHD.

2. Go to Actions or right-click on the MFHD and select Edit MFHD.

3. The MARC Editor will appear. Modify the MFHD record as needed and click Save.

Delete a MFHD Record

1. Open a serial record, go to Serials → MFHD Record → Manage MFHDs and select the appropriate MFHD.

2. Go to Actions or right-click on the MFHD and select Delete Selected MFHDs.

3. Click OK/Continue to delete the record.
Chapter 123. Group Serials Issues in the Template Toolkit OPAC

In previous versions of Evergreen, issues of serials displayed in a list ordered by publication date. The list could be lengthy if the library had extensive holdings of a serial. Using the Template Toolkit OPAC that is available in version 2.2, you can group issues of serials in the OPAC by chronology or enumeration. For example, you might group issues by date published or by volume. Users can expand these hyperlinked groups to view holdings of specific issues. The result is a clean, easy-to-navigate interface for viewing holdings of serials with a large quantity of issues.

This feature is only available in the Template Toolkit OPAC.

Administration

Enable the following organizational unit settings to use this feature:

1. Click Administration → Local Administration → Library Settings Editor.
2. Search or scroll to find Serials: Default display grouping for serials distributions presented in the OPAC.
3. Click Edit.
4. Enter enum to display issues by enumeration, or enter chron to display issues in chronological order. This value will become your default setting for display issues in the OPAC.
5. Click Update Setting.
6. Search or scroll to find OPAC: Use fully compressed serials holdings.
7. Select the value, True, to view a compressed holdings statement.
8. Click Update Setting.

Displaying Issues in the OPAC

Your library system has a subscription to the periodical, Bon Appetit. The serials librarian has determined that the issues at the Forest Falls branch should display in the OPAC by month and year. The issues at the McKinley branch should display by volume and number. The serials librarian will create two distributions for the serial that will include these groupings.

1. Retrieve the bibliographic record for the serial, and click Actions for this Record → Alternate Serial Control.
2. Create a New Subscription or click on the hyperlinked ID of an existing subscription.

3. Click New Distribution.

4. Create a label to identify the distribution.

5. Select the holding library from the drop down menu that will own physical copies of the issues.

6. Select a display grouping. Select chronology from the drop down menu.

7. Select a template from the drop down menu to receive copies.

8. Click Save.

9. Click New Distribution and repeat the process to send issues to the McKinley Branch. Choose enumeration in the Display Grouping field to display issues by volume and number.

10. Complete the creation of your subscription.

11. Retrieve the record from the catalog.

12. Scroll down to and click the Issues Held link. The issues label for each branch appears.

13. Click the hyperlinked issues label.
The issues owned by the Forest Falls branch are grouped by chronology:

The issues owned by the McKinley branch are grouped by enumeration:
Part XI. Circulation
Table of Contents

124. Introduction .................................................................................................................. 589
125. Circulating Items .......................................................................................................... 590
    Check Out .................................................................................................................... 590
    Regular Items ......................................................................................................... 590
    Pre-cataloged Items ............................................................................................... 590
    Due Dates ................................................................................................................ 591
    Email Checkout Receipts ......................................................................................... 592
    Check In .................................................................................................................... 595
    Regular check in ..................................................................................................... 595
    Backdated check in ................................................................................................ 596
    Backdate Post-Checkin ........................................................................................... 596
    Renewal and Editing the Item’s Due Date .............................................................. 598
    Renewing via a Patron’s Account ......................................................................... 598
    Renewing by Item Barcode .................................................................................... 599
    Editing Due Date ..................................................................................................... 599
    Marking Items Lost and Claimed Returned .............................................................. 600
    Lost Items ................................................................................................................ 600
    Refunds for Lost Items ......................................................................................... 601
    Claimed Returned Items ....................................................................................... 602
    In-house Use (F6) ..................................................................................................... 603
    Item Status ................................................................................................................ 605
    Checking item status .............................................................................................. 605
    Viewing past circulations ...................................................................................... 607
    Marking items damaged or missing and other functions .................................... 608
    Item alerts ................................................................................................................ 608
    Long Overdue Items ................................................................................................. 608
126. Holds Management ........................................................................................................ 611
    Placing Holds .......................................................................................................... 611
    Holds Levels ........................................................................................................... 611
    Title Level Hold ...................................................................................................... 611
    Patron Search from Place Hold ............................................................................. 613
        To use Patron Search From Place Holds: ......................................................... 614
    Parts Level Hold ....................................................................................................... 617
    Placing Holds in Patron Records .......................................................................... 618
        Placing Multiple Holds on Same Title .............................................................. 618
    Managing Holds ...................................................................................................... 619
        Actions for Selected Holds ............................................................................. 619
        Transferring Holds ......................................................................................... 623
        Cancelled Holds ............................................................................................... 623
        Viewing Details & Adding Notes to Holds ...................................................... 624
        Displaying Queue Position ............................................................................ 626
        Managing Holds in Title Records .................................................................. 626
        Retargeting Holds ............................................................................................. 627
        Pulling & Capturing Holds ............................................................................. 627
        Handling Missing and Damaged Item ............................................................. 631
        Holds Notification Methods .......................................................................... 631
        Clearing Shelf-Expired Holds ....................................................................... 633
        Alternate Hold Pick up Location .................................................................... 635
        Display Hold Types on Pull Lists .................................................................... 636
127. Booking Module ............................................................................................................ 638
    Creating a Booking Reservation ............................................................................. 638
To create a reservation from a patron record .......................................................... 638
To create a reservation from a booking resource .................................................. 643
Search the catalogue to create a reservation ......................................................... 648
Reservation Pull List .............................................................................................. 648
Capturing Items for Reservations ......................................................................... 650
Picking Up Reservations ....................................................................................... 651
Returning Reservations ....................................................................................... 652
Cancelling a Reservation ...................................................................................... 654
Cancel a reservation from the patron record ....................................................... 654
Cancel a reservation on reservation creation screen ........................................... 655
128. Circulation - Patron Record ........................................................................... 656
   Searching Patrons .............................................................................................. 656
   Retrieve Recent Patrons .................................................................................... 658
      Setting up Retrieve Recent Patrons ................................................................. 658
      Retrieving Recent Patrons ............................................................................ 658
   Registering New Patrons ................................................................................. 658
   Patron Self-Registration .................................................................................. 660
   Updating Patron Information ....................................................................... 661
   Renewing Library Cards ............................................................................... 662
   Lost Library Cards ......................................................................................... 664
   Resetting Patron’s Password ....................................................................... 665
   Barring a Patron .............................................................................................. 666
   Barred vs. Blocked ......................................................................................... 666
   Staff-Generated Messages .......................................................................... 667
   Patron Alerts ................................................................................................ 667
   Patron Notes .................................................................................................. 669
   Staff-Generated Penalties/Messages ............................................................. 670
      Add a Message ............................................................................................... 671
      Modify a Message ......................................................................................... 672
      Archive a Message ....................................................................................... 673
      Remove a Message ...................................................................................... 674
   User Buckets ................................................................................................... 674
      Create a User Bucket .................................................................................. 675
      Batch Edit All Users .................................................................................... 677
      Batch Modify Statistical Categories ........................................................... 679
      Batch Delete Users ..................................................................................... 679
      View Batch Changes .................................................................................... 680
      Roll Back Batch Changes ....................................................................... 680
      Sharing Buckets .......................................................................................... 681
      Permissions ................................................................................................ 682
129. Patron self-registration administration ......................................................... 683
   Library Settings ................................................................................................ 683
130. Triggered Events and Notices ........................................................................ 685
   Introduction ..................................................................................................... 685
   Access and View .............................................................................................. 685
   Filter ................................................................................................................ 686
   Sort .................................................................................................................. 686
   Print ................................................................................................................. 687
   Reset .............................................................................................................. 687
131. Offline Circulation ............................................................................................ 688
   Introduction ..................................................................................................... 688
   Using Offline Circulation ............................................................................... 688
   Checkout .......................................................................................................... 689
   Renew ............................................................................................................. 690
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>In-House Use</td>
<td>691</td>
</tr>
<tr>
<td>Checkin</td>
<td>691</td>
</tr>
<tr>
<td>Patron Registration</td>
<td>692</td>
</tr>
<tr>
<td>Managing Offline Transactions</td>
<td>693</td>
</tr>
<tr>
<td>Offline Block List</td>
<td>693</td>
</tr>
<tr>
<td>Exporting Offline Transactions</td>
<td>693</td>
</tr>
<tr>
<td>Processing Offline Transactions</td>
<td>693</td>
</tr>
<tr>
<td>Uploading Previously Exported Transactions</td>
<td>695</td>
</tr>
<tr>
<td>132. Self checkout</td>
<td>698</td>
</tr>
<tr>
<td>Introduction</td>
<td>698</td>
</tr>
<tr>
<td>Initializing the self check</td>
<td>698</td>
</tr>
<tr>
<td>Basic Check Out</td>
<td>698</td>
</tr>
<tr>
<td>View Items Out</td>
<td>700</td>
</tr>
<tr>
<td>View Holds</td>
<td>701</td>
</tr>
<tr>
<td>View Fines</td>
<td>702</td>
</tr>
</tbody>
</table>
Chapter 124. Introduction

Use this section for understanding the circulation procedures in the Evergreen system.
Chapter 125. Circulating Items

Check Out

Regular Items

1) To check out an item click Check Out Items from the Circulation and Patrons toolbar, or select Circulation → Check Out.

2) Scan or enter patron’s barcode and click Submit if entering barcode manually. If scanning, number is submitted automatically.

3) Scan or enter item barcode manually, clicking Submit if manual.

4) Due date is now displayed.

5) When all items are scanned, click the Done button to generate slip receipt or to exit patron record if not printing slip receipts.

Pre-cataloged Items

1) Go to patron’s Check Out screen by clicking Circulation → Check Out Items.
2) Scan the item barcode.

3) At prompt, enter the required information click Precat Checkout.

On check-in, Evergreen will prompt staff to re-route the item to cataloging.

This screen does not respond to the enter key or carriage return provided by a barcode scanner when the cursor is in the ISBN field. This behavior prevents pre-cataloged items from being checked out before you are done entering all the desired information.

**Due Dates**

Circulation periods are pre-set. When items are checked out, due dates are automatically calculated and inserted into circulation records if the Specific Due Date checkbox is not selected on the Check Out screen. The Specific Due Date checkbox allows you to set a different due date to override the pre-set loan period.
Before you scan the item, select the Specific Due Date checkbox. Enter the date in yyyy-mm-dd format. This date applies to all items until you change the date, de-select the Specific Due Date checkbox, or quit the patron record.

Email Checkout Receipts

This feature allows patrons to receive checkout receipts through email at the circulation desk and in the Evergreen self-checkout interface. Patrons need to opt in to receive email receipts by default and must have an email address associated with their account. Opt in can be staff mediated at the time of account creation or in existing accounts. Patrons can also opt in directly in their OPAC account or through patron self-registration. This feature does not affect the behavior of checkouts from SIP2 devices.

Staff Client Check Out

When a patron has opted to receive email checkout receipts by default, an envelope icon representing email will appear next to the receipt options in the Check Out screen. A printer icon representing a physical receipt appears if the patron has not opted in to the default email receipts.

Staff can click Quick Receipt and the default checkout receipt option will be triggered—an email will be sent or the receipt will print out. The Quick Receipt option allows staff to stay in the patron account after completing the transaction. Alternatively, staff can click Done to trigger the default checkout receipt and close out the patron account. By clicking on the arrow next to the Quick Receipt or Done buttons, staff can select which receipt option to use, regardless of the selected default. The email receipt option will be disabled if the patron account does not have an email address.

Self Checkout

In the Self Checkout interface, patrons will have the option to select a print or email checkout receipt, or no receipt. The radio button for the patron’s default receipt option will be selected automatically in the interface. Patrons can select a different receipt option if desired. The email receipt radio button will be disabled if there is no email address associated with the patron’s account.
Opt In

Staff Mediated Opt In At Registration

Patrons can be opted in to receive email checkout receipts by default by library staff upon the creation of their library account. Within the patron registration form, there is a new option below the Email Address field to select Email checkout receipts by default?. Select this option if the patron wants email checkout receipts to be their default. Save any changes.

Staff Mediated Opt In After Registration

Staff can also select email checkout receipts as the default option in a patron account after initial registration. Within the patron account go to Edit and select Email checkout receipts by default?. Make sure the patron also has an email address associated with their account. Save any changes.
Patron Opt In – Self-Registration Form

If your library offers patrons the ability to request a library card through the patron self-registration form, they can select email checkout receipts by default in the initial self-registration form:

Request a Library Card

<table>
<thead>
<tr>
<th>Home Library</th>
<th>Example Consortium</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td></td>
</tr>
<tr>
<td>Middle Name</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
</tr>
<tr>
<td>Street Address</td>
<td></td>
</tr>
<tr>
<td>Street Address (2)</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>Zip Code</td>
<td></td>
</tr>
<tr>
<td>Requested Username</td>
<td></td>
</tr>
<tr>
<td>Email checkout receipts by default?</td>
<td>☐</td>
</tr>
</tbody>
</table>

Patron Opt In - OPAC Account
Patrons can also opt in to receive email checkout receipts by default directly in their OPAC account. After logging in, patrons can go to Account Preferences→Notification Preferences and enable Email checkout receipts by default? and click Save.

Email Checkout Receipt Configuration

Email checkout receipts will be sent out through a Notifications/Action Trigger called Email Checkout Receipt. The email template and action trigger can be customized by going to Administration→Local Administration→Notifications/Action Trigger→Email Checkout Receipt.

Check In

Regular check in

1) To check in an item click Check In Items from the Circulation and Patrons toolbar, or select Circulation→Check In.

2) Scan item barcode or enter manually and click Submit.
3) If there is an overdue fine associated with the checkin, an alert will appear at the top of the screen with a fine tally for the current checkin session. To immediately handle fine payment, click the alert to jump to the patron’s bill record.

4) If the checkin is an item that can fill a hold, a pop-up box will appear with patron contact information or routing information for the hold.

5) Print out the hold or transit slip and place the item on the hold shelf or route it to the proper library.

6) If the item is not in a state acceptable for hold/transit (for instance, it is damaged), select the line of the item, and choose Actions → Cancel Transit. The item will then have a status of Canceled Transit rather than In Transit.

**Backdated check in**

This is useful for clearing a book drop.

1) To change effective check-in date, select Circulation → Check In Items. In Effective Date field enter the date in yyyy-mm-dd format.

2) The new effective date is now displayed in the red bar above the Barcode field.

3) Move the cursor to the Barcode field. Scan the items. When finishing backdated check-in, change the Effective Date back to today’s date.

**Backdate Post-Checkin**

After an item has been checked in, you may use the Backdate Post-Checkin function to backdate the check-in date.

1) Select the item on the Check In screen, click Actions → Backdate Post-Checkin.
2) In Effective Date field enter the date in yyyy-mm-dd format. The check-in date will be adjusted according to the new effective check-in date.

At the right bottom corner there is a Checkin Modifiers pop-up list. The options are:

- Ignore Pre-cat Items: no prompt when checking in a pre-cat item. Item will be routed to Cataloguing with Cataloguing status.

- Suppress Holds and Transit: item will not be used to fill holds or sent in transit. Item has Reshelving status.

- Amnesty Mode/Forgive Fines: overdue fines will be voided if already created or not be inserted if not yet created (e.g. hourly loans).

- Auto-Print Hold and Transit Slips: slips will be automatically printed without prompt for confirmation.

- Clear Holds Shelf. Checking in hold-shelf-expired items will clear the items from the hold shelf (holds to be cancelled).
Retarget Local Holds. When checking in in process items that are owned by the library, attempt to find a local hold to retarget. This is intended to help with proper targeting of newly-catalogued items.

Retarget All Statuses. Similar to Retarget Local Holds, this modifier will attempt to find a local hold to retarget, regardless of the status of the item being checked in. This modifier must be used in conjunction with the Retarget Local Holds modifier.

Capture Local Holds as Transits. With this checkin modifier, any local holds will be given an in transit status instead of on holds shelf. The intent is to stop the system from sending holds notifications before the item is ready to be placed on the holds shelf and item will have a status of in-transit until checked in again. If you wish to simply delay notification and allow time for staff to process item to holds shelf, you may wish to use the Hold Shelf Status Delay setting in Library Settings Editor instead. See Local Administration section for more information.

These options may be selected simultaneously. The selected option is displayed in the header area.

Renewal and Editing the Item’s Due Date

Checked-out items can be renewed if your library’s policy allows it. The new due date is calculated from the renewal date. Existing loans can also be extended to a specific date by editing the due date or renewing with a specific due date.

Renewing via a Patron’s Account

1) Retrieve the patron record and go to the Items Out screen.

2) Select the item you want to renew. Click on Actions → Renew. If you want to renew all items in the account, click Renew All instead.
3) If you want to specify the due date, click Renew with Specific Due Date. You will be prompted to select a due date. Once done, click Apply.

**Renewing by Item Barcode**

1) To renew items by barcode, select Circulation → Renew Items.

2) Scan or manually enter the entire item barcode.

3) If you want to specify the due date, click Specific Due Date and enter a new due date in yyyy-mm-dd format.

**Editing Due Date**

1) Retrieve the patron record and go to the Items Out screen.

2) Select the item you want to renew. Click on Actions → Edit Due Date.
3) Enter a new due date in yyyy-mm-dd format in the pop-up window, then click OK.

Editing a due date is not included in the renewal count.

Marking Items Lost and Claimed Returned

Lost Items

1) To mark items Lost, retrieve patron record and click Items Out.

2) Select the item. Click on Actions → Mark Lost (by Patron).

3) The lost item now displays as lost in the Items Checked Out section of the patron record.

4) The lost item also adds to the count of Lost items in the patron summary on the left (or top) of the screen.
Lost Item Billing

- Marking an item Lost will automatically bill the patron the replacement cost of the item as recorded in the price field in the item record, and a processing fee as determined by your local policy. If the lost item has overdue charges, the overdue charges may be voided or retained based on local policy.

- A lost-then-returned item will disappear from the Items Out screen only when all bills linked to this particular circulation have been resolved. Bills may include replacement charges, processing fees, and manual charges added to the existing bills.

- The replacement fee and processing fee for lost-then-returned items may be voided if set by local policy. Overdue fines may be reinstated on lost-then-returned items if set by local policy.

Refunds for Lost Items

If an item is returned after a lost bill has been paid and the library’s policy is to void the replacement fee for lost-then-returned items, there will be a negative balance in the bill. A refund needs to be made to close the bill and the circulation record. Once the outstanding amount has been refunded, the bill and circulation record will be closed and the item will disappear from the Items Out screen.

If you need to balance a bill with a negative amount, you need to add two dummy bills to the existing bills. The first one can be of any amount (e.g. $0.01), while the second should be of the
absolute value of the negative amount. Then you need to void the first dummy bill. The reason for using a dummy bill is that Evergreen will check and close the circulation record only when payment is applied or bills are voided.

Claimed Returned Items

1) To mark an item Claimed Returned, retrieve the patron record and go to the Items Out screen.

2) Select the item, then select Actions → Mark Claimed Returned from the dropdown menu.

3) Enter date in yyyy-mm-dd format and click Submit.

4) The Claimed Returned item now displays in the Other/Special Circulations section of the patron record.

5) The Claimed Returned item adds to the count of items that are Claimed Returned in the patron summary on the left (or top) of the screen. It also adds to the total Other/Special Circulations that is displayed when editing the patron’s record.
More on Claimed Returned Items

• The date entered for a Claimed Returned item establishes the fine. If the date given has passed, bills will be adjusted accordingly.

• When a Claimed Returned item is returned, if there is an outstanding bill associated with it, the item will not disappear from the Items Out screen. It will disappear when the outstanding bills are resolved.

• When an item is marked Claimed Returned, the value in Claims-returned Count field in the patron record is automatically increased. Staff can manually adjust this count by editing the patron record.

In-house Use (F6)

1) To record in-house use, select Circulation → Record-In House Use, click Check Out → Record In-House Use on the circulation toolbar, or press F6.
2) To record in-house use for cataloged items, enter number of uses, scan barcode or type barcode and click Submit.

![Screenshot of a library system interface showing options like Check Out, Check In, Capture Holds, etc.]

There are two independent library settings that will allow copy alerts to display when scanned in In-house Use: Display copy alert for in-house-use set to true will cause an alert message to appear, if it has one, when recording in-house-use for the copy. Display copy location check in alert for in-house-use set to true will cause an alert message indicating that the item needs to be routed to its location if the location has check in alert set to true.

3) To record in-house use for non-cataloged items, enter number of uses, choose non-cataloged type from drop-down menu, and click Submit.
The statistics of in-house use are separated from circulation statistics. The in-house use count of cataloged items is not included in the items' total use count.

## Item Status

The Item Status screen is very useful. Many actions can be taken by either circulation staff or catalogers on this screen. Here we will cover some circulation-related functions, namely checking item status, viewing past circulations, inserting item alert messages, marking items missing or damaged, etc.

### Checking item status

1) To check the status of an item, select Search → Search for copies by Barcode.

2) Scan the barcode or type it and click Submit. The current status of the item is displayed with selected other fields. You can use the column picker to select more fields to view.
3) Click the Detail View button and the item summary and circulation history will be displayed.

4) Click List View to go back.

If the item’s status is “Available”, the displayed due date refers to the previous circulation’s due date.

Upload From File allows you to load multiple items saved in a file on your local computer. The file contains a list of the barcodes in text format. To ensure smooth uploading and further processing on the items, it is recommended that the list contains no more than 100 items.
Viewing past circulations

1) To view past circulations, retrieve the item on the Item Status screen as described above.

2) Select Detail view.

3) Choose Recent Circ History. The item’s recent circulation history is displayed.

4) To retrieve the patron(s) of the last circulations, click on the name of the patron. The patron record will be displayed.

The number of items that displays in the circulation history can be set in Local Administration → Library Settings Editor.

You can also retrieve the past circulations on the patron’s Items Out screen and from the Check In screen.
Marking items damaged or missing and other functions

1) To mark items damaged or missing, retrieve the item on the Item Status screen.

2) Select the item. Click on Actions for Selected Items → Mark Item Damaged or Mark Item Missing.

3) Following the above procedure, you can check in and renew items by using the Check in Items and Renew Items on the dropdown menu.

Item alerts

The Edit Item Attributes function on the Actions for Selected Items dropdown list allows you to edit item records. Here, we will show you how to insert item alert messages by this function. See cataloging instructions for more information on item editing. 1) Retrieve record on Item Status screen.

2) Once item is displayed, highlight it and select Actions for Selected Items → Edit Item Attributes.

3) The item record is displayed in the Copy Editor.

4) Click Alert Message in the Miscellaneous column. The background color of the box changes. Type in the message then click Apply.

5) Click Modify Copies, then confirm the action.

Long Overdue Items

Items Marked Long Overdue

Once an item has been overdue for a configurable amount of time, Evergreen will mark the item long overdue in the borrowing patron’s account. This will be done automatically through a Notification/Action Trigger. When the item is marked long overdue, several actions will take place:

1. The item will go into the status of “Long Overdue”

2. The accrual of overdue fines will be stopped

Optionally the patron can be billed for the item price, a long overdue processing fee, and any overdue fines can be voided from the account. Patrons can also be sent a notification that the item was marked long overdue. And long-overdue items can be included on the "Items Checked Out" or "Other/Special Circulations" tabs of the "Items Out" view of a patron’s record. These are all controlled by library settings.
Checking in a Long Overdue item

If an item that has been marked long overdue is checked in, an alert will appear on the screen informing the staff member that the item was long overdue. Once checked in, the item will go into the status of “In process”. Optionally, the item price and long overdue processing fee can be voided and overdue fines can be reinstated on the patron’s account. If the item is checked in at a library other than its home library, a library setting controls whether the item can immediately fill a hold or circulate, or if it needs to be sent to its home library for processing.

Notification/Action Triggers

Evergreen has two sample Notification/Action Triggers that are related to marking items long overdue. The sample triggers are configured for 6 months. These triggers can be configured for any amount of time according to library policy and will need to be activated for use.

• Sample Triggers
  • 6 Month Auto Mark Long-Overdue—will mark an item long overdue after the configured period of time
  • 6 Month Long Overdue Notice—will send patron notification that an item has been marked long overdue on their account

Library Settings

The following Library Settings enable you to set preferences related to long overdue items:
• Circulation: Long-Overdue Check-In Interval Uses Last Activity Date —Use the long-overdue last-activity date instead of the due_date to determine whether the item has been checked out too long to perform long-overdue check-in processing. If set, the system will first check the last payment time, followed by the last billing time, followed by the due date. See also the "Long-Overdue Max Return Interval" setting.

• Circulation: Long-Overdue Items Usable on Checkin —Long-overdue items are usable on checkin instead of going "home" first

• Circulation: Long-Overdue Max Return Interval —Long-overdue check-in processing (voiding fees, re-instating overdues, etc.) will not take place for items that have been overdue for (or have last activity older than) this amount of time

• Circulation: Restore Overdues on Long-Overdue Item Return

• Circulation: Void Long-Overdue item Billing When Returned

• Circulation: Void Processing Fee on Long-Overdue Item Return

• Finances: Leave transaction open when long overdue balance equals zero —Leave transaction open when long-overdue balance equals zero. This leaves the lost copy on the patron record when it is paid

• Finances: Long-Overdue Materials Processing Fee

• Finances: Void Overdue Fines When Items are Marked Long-Overdue

• GUI: Items Out Long-Overdue display setting

Learn more about these settings in the chapter about the Library Settings Editor.

Permissions to use this Feature

The following permissions are related to this feature:

• COPY_STATUS_LONG_OVERDUE.override
  • Allows the user to check-in long-overdue items thus removing the long-overdue status on the item
Chapter 126. Holds Management

Placing Holds

Holds can be placed by staff in the Staff Client and by patrons in the OPAC. In this chapter we demonstrate placing holds in the Staff Client.

Holds Levels

Evergreen has different levels of holds. Library staff can place holds at all levels, while patrons can only place title-level holds, and parts-level holds. The chart below summarizes the levels of holds.

<table>
<thead>
<tr>
<th>Hold level</th>
<th>Abbreviation</th>
<th>When to use</th>
<th>How to use</th>
<th>Who can use</th>
<th>Hold tied to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>T</td>
<td>Patron wants first available copy of a title</td>
<td>Staff or patron click on Place Hold next to title.</td>
<td>Patron or staff</td>
<td>Holdings attached to a single MARC (title) record</td>
</tr>
<tr>
<td>Parts</td>
<td>P</td>
<td>Patron wants a particular part of title (e.g. volume or disk number)</td>
<td>Staff or patron selects part on the create/edit hold screen when setting holds notification options.</td>
<td>Patron or staff</td>
<td>Holdings with identical parts attached to a single MARC (title) record</td>
</tr>
<tr>
<td>Volume</td>
<td>V</td>
<td>Patron or staff want any title associated with a particular call number</td>
<td>In the staff client, click on Volume Hold under Holdable?</td>
<td>Staff only</td>
<td>Holdings attached to a single call number (volume)</td>
</tr>
<tr>
<td>Copy</td>
<td>C</td>
<td>Patron or staff want a specific copy of an item</td>
<td>In the staff client, click on Copy Hold under Holdable?</td>
<td>Staff only</td>
<td>A specific copy (barcode)</td>
</tr>
</tbody>
</table>

Title Level Hold

A default hold expiration date will be displayed if the library has set up a default holds expiration period in their library settings. Uncaptured holds will not be targeted after the expiration date.

If you select the Suspend this Hold checkbox, the hold will be suspended and not be captured until you activate it.

1. To place a title level hold, retrieve the title record on the catalog and click the Place Hold link beside the title on the search results list, or click the Place Hold link on the title summary screen.
2. Scan or type patron’s barcode into the Place hold for patron by barcode box, or choose Place this hold for me.

3. If this title contains multiple parts, you can specify which part to request. If you do not select a part, the hold will target any of the other copies on this record, that is, those with no parts attached. Those copies are usually the complete set, containing all the parts.

4. Edit patron hold notification and expiration date fields as required. Be sure to choose a valid Pickup location.

5. Click Submit.

6. A confirmation screen appears with the message "Hold was successfully placed".
Advanced Hold Options

Clicking the Advanced Hold Options link will take you into the metarecord level hold feature, where you can select multiple formats and/or languages, if available.

Selecting multiple formats will not place all of these formats on hold. For example, selecting CD Audiobook and Book implies that either the CD format or the book format is the acceptable format to fill the hold. If no format is selected, then any of the available formats may be used to fill the hold. The same holds true for selecting multiple languages.

Patron Search from Place Hold

Patron Search from Place Hold allows staff members, when placing a hold on behalf of a patron in the web staff client, to search for patrons by names and other searchable patron information, rather than relying on barcode alone.
To use Patron Search From Place Holds:

1. After performing a search in the catalog, staff will retrieve a bibliographic record.

2. Click Place Hold either in the search results or within the detailed bibliographic record. The Place Hold Screen will appear. Note: this feature also appears when placing volume level holds and copy level holds.

3. Next to Place Hold for patron by barcode, click on Patron Search. Please note that Patron Search will only appear in this interface when using the web-based staff client. It will not appear in the patron-facing OPAC.

4. A dialog box will appear with the patron search interface used elsewhere in the staff client. By default, the search scopes to your workstation org unit, and you can search by patron last name, first name, and middle name.
5. To search for a patron, fill out the relevant search fields, and click Search or hit ENTER on your keyboard. Results will appear below in Patron Search Results in the lower half of the screen.
6. Click the row of the desired patron account, and click Select.

7. The dialog box will close and the selected patron’s barcode will appear next to Place Hold by barcode. This will cause the patron’s hold notification preferences to appear in the relevant fields in the bottom half of the screen. Changes to the Hold Notification preferences can be made before clicking Submit to finish placing a hold for the patron.
Parts Level Hold

1. To place a parts level hold, retrieve a record with parts-level items attached to the title, such as a multi-disc DVD, an annual travel guide, or a multi-volume book set.

2. Place the hold as you would for a title-level hold, including patron barcode, notification details, and a valid pickup location.

3. Select the applicable part from the Select a Part dropdown menu.

4. Click Submit.
Requested formats are listed in the Holdable Part column in hold records. Use the Column Picker to display it when the hold record is displayed.

Placing Holds in Patron Records

1. Holds can be placed from patron records too. In the patron record on the Holds screen, click the Place Hold button on the left top corner.

2. The catalog is displayed in the Holds screen to search for the title on which you want to place a hold.

3. Search for the title and click the Place Hold link.

4. The patron’s account information is retrieved automatically. Set up the notification and expiration date fields. Click Place Hold and confirm your action in the pop-up window.

5. You may continue to search for more titles. Once you are done, click the Holds button on the top to go back to the Holds screen. Click the Refresh button to display your newly placed holds.

Placing Multiple Holds on Same Title

After a successful hold placement, staff have the option to place another hold on the same title by clicking the link Place another hold for this title. This returns to the hold screen, where a different patron’s information can be entered.
This feature can be useful for book groups or new items where a list of waiting patrons needs to be transferred into the system.

**Managing Holds**

Hold can be cancelled at any time by staff or patrons. Before holds are captured, staff or patrons can suspend them or set them as inactive for a period of time without losing the hold queue position, activate suspended holds, change notification method, phone number, pick-up location (for multi-branch libraries only), expiration date, activation date for inactive holds, etc. Once a hold is captured, staff can change the pickup location and extend the hold shelf time if required.

Staff can edit holds in either patron’s records or the title records. Patrons can edit their holds in their account on the OPAC.

If you use the column picker to change the holds display from one area of the staff client (e.g. the patron record), it will change the display for all parts of the staff client that deal with holds, including the title record holds display, the holds shelf display, and the pull list display.

**Actions for Selected Holds**

1. Retrieve the patron record and go to the Holds screen.
2. Highlight the hold record, then select Actions.
3. Manage the hold by choosing an action on the list.

a. If you want to cancel the hold, click Cancel Hold from the menu. You are prompted to select a reason and put in a note if required. To finish, click Apply.

b. If you want to suspend a hold or activate a suspended hold, click the appropriate action on the list. You will be prompted to confirm your action. Suspended holds have a No value in the Active? column.

A captured hold with a status of On Hold Shelf can be cancelled by either staff or patrons. But the status of the item will not change until staff check it in.
Suspended holds will not be filled but its hold position will be kept. They will automatically become active on the activation date if there is an activation date in the record. Without an activation date, the holds will remain inactive until staff or a patron activates them manually.

c. You may edit the Activation Date and Expiration Date by using the corresponding action on the Actions dropdown menu. You will be prompted to enter the new date. Use the calendar widget to choose a date, then click Apply. Use the Clear button to unset the date.

d. Hold shelf expire time is automatically recorded in the hold record when a hold is filled. You may edit this time by using the Edit Shelf Expire Time on the Actions dropdown menu. You will be prompted to enter the new date. Use the calendar widget to choose a date, then click Apply.

e. If you want to enable or disable phone notification or change the phone number, click Edit Notification Settings. You will be prompted to enter the new phone number. Make sure you enter a valid and complete phone number. The phone number is used for this hold only and can be different from the one in the patron account. It has no impact on the patron account. If you leave it blank, no phone number will be printed on the hold slip. If you want to enable or disable email notification for the hold, check Send Emails on the prompt screen.
f. Pickup location can be changed by clicking Edit Pickup Library. Click the dropdown list of all libraries and choose the new pickup location. Click Submit.

g. The item’s physical condition is recorded in the copy record as Good or Mediocre in the Quality field. You may request that your holds be filled with copies of good quality only. Click Set Desired Copy Quality on the Actions list. Make your choice in the pop-up window.
Transferring Holds

1. Holds on one title can be transferred to another with the hold request time preserved. To do so, you need to find the destination title and click Mark for: → Title Hold Transfer.

2. Select the hold you want to transfer. Click Actions → Transfer to Marked Title.

Cancelled Holds

1. Cancelled holds can be displayed. Click the Recently Cancelled Holds button on the Holds screen.
2. You can un-cancel holds.

Based on your library’s setting, hold request time can be reset when a hold is un-cancelled.

**Viewing Details & Adding Notes to Holds**

1. You can view details of a hold by selecting a hold then clicking the Detail View button on the Holds screen.

2. You may add a note to a hold in the Detail View.
3. Notes can be printed on the hold slip if the Print on slip? checkbox is selected. Enter the message, then click OK.
Displaying Queue Position

Using the Column Picker, you can display Queue Position and Total number of Holds.

Managing Holds in Title Records

1. Retrieve and display the title record in the catalog.
2. Click Actions → View Holds.
3. All holds on this title to be picked up at your library are displayed. Use the Pickup Library to view holds to be picked up at other libraries.
4. Highlight the hold you want to edit. Choose an action from the Actions menu. For more information see the Actions for Selected Holds section. For example, you can retrieve the hold requestor’s account by selecting Retrieve Patron from this menu.

Retargeting Holds

Holds need to be retargeted whenever a new item is added to a record, or after some types of item status changes, for instance when an item is changed from On Order to In Process. The system does not automatically recognize the newly added items as available to fill holds.

1. View the holds for the item.

2. Highlight all the holds for the record, which have a status of Waiting for Copy. If there are a lot of holds, it may be helpful to sort the holds by Status.

3. Click on the head of the status column.

4. Under Actions, select Find Another Target.

5. A window will open asking if you are sure you would like to reset the holds for these items.

6. Click Yes. Nothing may appear to happen, or if you are retargeting a lot of holds at once, your screen may go blank or seem to freeze for a moment while the holds are retargeted.

7. When the screen refreshes, the holds will be retargeted. The system will now recognize the new items as available for holds.

Pulling & Capturing Holds

Holds Pull List

There are usually four statuses a hold may have: Waiting for Copy, Waiting for Capture, In Transit and Ready for Pickup.
1. Waiting-for-copy: all holdable copies are checked out or not available.

2. Waiting-for-capture: an available copy is assigned to the hold. The item shows up on the Holds Pull List waiting for staff to search the shelf and capture the hold.

3. In Transit: holds are captured at a non-pickup branch and on the way to the pick-up location.

4. Ready-for-pick-up: holds are captured and items are on the Hold Shelf waiting for patrons to pick up. Besides capturing holds when checking in items, Evergreen matches holds with available items in your library at regular intervals. Once a matching copy is found, the item’s barcode number is assigned to the hold and the item is put on the Holds Pull List. Staff can print the Holds Pull List and search for the items on shelves.

5. To retrieve your Holds Pull List, select Circulation → Pull List for Hold Requests.

6. The Holds Pull List is displayed. You may re-sort it by clicking the column labels, e.g. Title. You can also add fields to the display by using the column picker.
Column adjustments will only affect the screen display and the CSV download for the holds pull list. It will not affect the printable holds pull list.

7. The following options are available for printing the pull list:

- **Print Full Pull List** prints Title, Author, Shelving Location, Call Number and Item Barcode. This method uses less paper than the alternate strategy.

- **Print Full Pull List (Alternate Strategy)** prints the same fields as the above option but also includes a patron barcode. This list will also first sort by copy location, as ordered under Admin → Local Administration → Copy Location Order.

- **Download CSV** - This option is available from the List Actions button (adjacent to the Page ")" button) and saves all fields in the screen display to a CSV file. This file can then be opened in Excel or another spreadsheet program. This option provides more flexibility in identifying fields that should be printed.

With the CSV option, if you are including barcodes in the holds pull list, you will need to take the following steps to make the barcode display properly: in Excel, select the entire barcode column, right-click and select Format Cells, click Number as the category and then reduce the number of decimal places to 0.

8. You may perform hold management tasks by using the Actions dropdown list.
The Holds Pull List is updated constantly. Once an item on the list is no longer available or a hold on the list is captured, the items will disappear from the list. The Holds Pull List should be printed at least once a day.

**Capturing Holds**

Holds can be captured when a checked-out item is returned (checked in) or an item on the Holds Pull List is retrieved and captured. When a hold is captured, the hold slip will be printed and if the patron has chosen to be notified by email, the email notification will be sent out. The item should be put on the hold shelf.

1. To capture a hold, select Circulation → Capture Holds (or press Shift-F2).

![Circulation Menu](image)

2. Scan or type barcode and click Submit.

![Barcode Scan](image)

3. The following hold slip is automatically printed. If your workstation is not setup for silent printing (via Hatch), then a print window will appear.
4. If the item should be sent to another location, a hold transit slip will be printed. If your workstation is not setup for silent printing (via Hatch), then another print window will appear.

If a patron has an OPAC/Staff Client Holds Alias in his/her account, it will be used on the hold slip instead of the patron’s name. Holds can also be captured on the Circulation → Check In Items screen where you have more control over automatic slip printing.

Handling Missing and Damaged Item

If an item on the holds pull list is missing or damaged, you can change its status directly from the holds pull list.

1. From the Holds Pull List, right-click on the item and either select Mark Item Missing or Mark Item Damaged.

2. Evergreen will update the status of the item and will immediately retarget the hold.

Holds Notification Methods

1. In Evergreen, patrons can set up their default holds notification method in the Account Preferences area of My Account. Staff cannot set these preferences for patrons; the patrons must do it when they are logged into the public catalog.
2. Patrons with a default notification preference for phone will see their phone number at the time they place a hold. The checkboxes for email and phone notification will also automatically be checked (if an email or phone number has been assigned to the account).

3. The patron can remove these checkmarks at the time they place the hold or they can enter a different phone number if they prefer to be contacted at a different number. The patron cannot change their e-mail address at this time.

4. When the hold becomes available, the holds slip will display the patron’s e-mail address only if the patron selected the Notify by Email by default when a hold is ready for pickup? checkbox. It will display a phone number only if the patron selected the Notify by Phone by default when a hold is ready for pickup? checkbox.
If the patron changes their contact telephone number when placing the hold, this phone number will display on the holds slip. It will not necessarily be the same phone number contained in the patron’s record.

Clearing Shelf-Expired Holds

1. Items with Ready-for-Pickup status are on the Holds Shelf. The Holds Shelf can help you manage items on the holds shelf. To see the holds shelf list, select Circulation → Holds Shelf.

2. The Holds Shelf is displayed. Note the Actions menu is available, as in the patron record.
   You can cancel stale holds here.
3. Use the column picker to add and remove fields from this display. Two fields you may want to display are Shelf Expire Time and Shelf Time.

4. Click the Show Clearable Holds button to list expired holds, wrong-shelf holds and canceled holds only. Expired holds are holds that expired before today’s date.
5. Click the Print Full List button if you need a printed list. To format the printout customize the Holds Shelf receipt template. This can be done in Administration → Workstation → Print Templates.

6. The Clear These Holds button becomes enabled when viewing clearable holds. Click it and the expired holds will be canceled.

7. Bring items down from the hold shelf and check them in.

If you cancel a ready-for-pickup hold, you must check in the item to make it available for circulation or trigger the next hold in line.

Hold shelf expire time is inserted when a hold achieves on-hold-shelf status. It is calculated based on the interval entered in Local Admin → Library Settings → Default hold shelf expire interval.

The clear-hold-shelf function cancels shelf-expired holds only. It does not include holds canceled by patron. Staff needs to trace these items manually according to the hold slip date.

### Alternate Hold Pick up Location

**Abstract**

This feature enables libraries to configure an alternate hold pick up location. The alternate pick up location will appear in the staff client to inform library staff that a patron has a hold waiting at that location. In the stock Evergreen code, the default alternate location is called "Behind Desk".

**Configuration**

The alternate pick up location is disabled in Evergreen by default. It can be enabled by setting Holds: Behind Desk Pickup Supported to True in the Library Settings Editor.

Libraries can also choose to give patrons the ability to opt-in to pick up holds at the alternate location through their OPAC account. To add this option, set the OPAC/Patron Visible field in the User Setting Type Hold is behind Circ Desk to True. The User Setting Types can be found under Administration → Server Administration → User Setting Types.

**Display**

When enabled, the alternate pick up location will be displayed under the Holds button in the patron account.
If configured, patrons will see the option to opt-in to the alternate location in the Account Preferences section of their OPAC Account.

Display Hold Types on Pull Lists

This feature ensures that the hold type can be displayed on all hold interfaces.

You will find the following changes to the hold type indicator:
1. The hold type indicator will display by default on all XUL-based hold interfaces. XUL-based hold interfaces are those that number the items on the interface. This can be overridden by saving column configurations that remove the Type column.

2. The hold type indicator will display by default on the HTML-based pull list. To access, click Circulation → Pull List for Hold Requests → Print Full Pull List (Alternate Strategy).

3. The hold type indicator can be added to the Simplified Pull List. To access, click Circulation → Pull List for Hold Requests → Simplified Pull List Interface.

To add the hold type indicator to the simplified pull list, click Simplified Pull List Interface, and right click on any of the column headers. The Column Picker appears in a pop up window. Click the box adjacent to Hold Type, and Click Save. The Simplified Pull List Interface will now include the hold type each time that you log into the staff client.
Chapter 127. Booking Module

Creating a Booking Reservation

Only staff members may create reservations. A reservation can be started from a patron record, or a booking resource. To reserve catalogued items, you may start from searching the catalogue, if you do not know the booking item’s barcode.

To create a reservation from a patron record

1) Retrieve the patron’s record.

2) Select Other → Booking → Create or Cancel Reservations. This takes you to the Reservations Screen.

3) For non-catalogued items, choose a Bookable Resource Type and click Next. For catalogued items, enter the barcode in Enter the barcode of a catalogued, bookable resource box, then click Next beside the box.
4) For non-catalogued resources, the Bookable Resource Type and the items associated with the type will appear.
For catalogued items, the title and the item will display in the box.

5) Select the date and time for the reservation in I need this resource... area. Click the date field. A calendar widget will be displayed for you to choose a date. Click the time field to choose time from the dropdown list.
If incorrect date and time is selected, the date/time boxes will appear in red. For example, if the time for which the reservation is set has already passed, the boxes will appear in red. There must be at least 15 minutes between the creation of the reservation and the start time of the reservation.

6) For non-catalogued resources, patrons may specify special feature(s), if any, of the resource. With these attributes: allows you to do so. For example, if a patron is booking a laptop he/she can choose between PC and Mac and even choose a specific operating system if they need to. Click the drop down arrow to select your option from the list.

7) Select the pickup location from the dropdown list.
8) If there are multiple copies of the resource and any item listed is acceptable, click Reserve Any. To choose a specific item, select it and then click Reserve Selected.

9) A message will confirm that the action succeeded. Click OK on the prompt.

10) The screen will refresh and the reservation will appear below the patron’s name at the bottom of the screen.
To create a reservation from a booking resource

You need to know the barcode of the patron when you create a reservation for him/her from a booking resource.

1) From the Booking menu, select Create Reservations

2) Choose a Bookable Resource Type and click Next or enter the barcode of a catalogued resource and click Next.
3) For non-catalogued resources, a screen showing the Bookable Resource Type and the items associated with the type will appear.

For catalogued resources, the title and item will appear.

4) Enter the user’s barcode in the Reserve to patron barcode box. The user’s existing reservations, if any, will appear at the bottom of the screen.
5) Select the date and time for the reservation in the I need this resource... area. Click the date field. A calendar widget will be displayed for you to choose a date. Click the time field to choose time from the dropdown list.
If incorrect date and time is selected, the date/time boxes will appear in red. For example, if the time for which the reservation is set has already passed, the boxes will appear in red. The times must be set correctly for the reservation to be created. There must be at least 15 minutes between the creation of the reservation and the start time of the reservation.

6) For non-catalogued resources, patrons may specify special feature(s), if any, of the resource. The With these attributes: allows you to do so. For example, if a patron is booking a laptop they can choose between PC and Mac and even choose a specific operating system if they need to. Click the dropdown arrow to select your option from the list.

7) Select the pickup location from the dropdown list.

8) If there are multiple copies of the resource and any item listed is acceptable, click Reserve Any. To choose a specific item, select it and then click Reserve Selected.
9) A message will confirm that the action succeeded. Click OK on the prompt.

10) The screen will refresh and the reservation will appear below the patron’s name at the bottom of the screen.
Search the catalogue to create a reservation

If you would like to reserve a catalogued item but do not know the item barcode, you may start with a catalogue search.

1) In the staff client, select Cataloguing → Search the Catalogue or keyboard shortcut F3 to search for the item you wish to reserve. You may search by any bibliographic information.

2) Click the title to display the record summary. In the Copy Summary, select Copy Details in Actions column.

3) The Copy Details will appear in a new row. In the barcode column, click the book now link.

4) A screen showing the title and barcodes of available copies will appear.

5) Enter the user’s barcode in the Reserve to patron barcode box. The user’s existing reservations, if any, will appear at the bottom of the screen.

6) Select the date and time in I need this resource... section. If the date and time set is incorrect the boxes appear in red. For example, if the time for which the reservation is set has already passed, the boxes will appear in red.

7) Select pickup location. If there are multiple copies and any of the listed items is acceptable, click Reserve Any. To choose a specific item, select it and then click Reserve Selected.

8) A message will confirm that the action succeeded. Click OK on the prompt.

9) The screen will refresh, and the reservation will appear below the user’s name.

---

Reservation Pull List

Reservation pull list can be generated dynamically on the Staff Client.

1) To create a pull list, select Booking → Pull List.
2) You can decide how many days in advance you would like to pull reserved items. Enter the number of days in the box adjacent to Generate list for this many days hence. For example, if you would like to pull items that are needed today, you can enter 1 in the box, and you will retrieve items that need to be pulled today.

3) Click Fetch to retrieve the pull list.

4) The pull list will appear. Click Print to print the pull list.
Capturing Items for Reservations

Reservations must be captured before they are ready to be picked up by the patron.

Always capture reservations in Booking Module. Check In function in Circulation does not function the same as Capture Resources.

1) In the staff client, select Booking -> Capture Resources.

2) Scan the item barcode or type the barcode then click Capture.

3) The message Capture succeeded will appear to the right. Information about the item will appear below the message. Click Print button to print a slip for the reservation.
Picking Up Reservations

Always use the dedicated Booking Module interfaces for tasks related to reservations. Items that have been captured for a reservation cannot be checked out using the Check Out interface, even if the patron is the reservation recipient.

1) Ready-for-pickup reservations can be listed from Other → Booking → Pick Up Reservations within a patron record or Booking → Pick Up Reservations.
2) Scan the patron barcode if using Booking → Pick Up Reservations.

3) The reservation(s) available for pickup will display. Select those you want to pick up and click Pick Up.

4) The screen will refresh to show that the patron has picked up the reservation(s).

Returning Reservations

⚠️ When a reserved item is brought back, staff must use the Booking Module to return the reservation.

1) To return reservations, select Booking → Return Reservations
2) You can return the item by patron or item barcode. Here we choose Resource to return by item barcode. Scan or enter the barcode, and click Go.

3) A pop up box will tell you that the item was returned. Click OK on the prompt.

4) If we select Patron on the above screen, after scanning the patron’s barcode, reservations currently out to that patron are displayed. Highlight the reservations you want to return, and click Return.

5) The screen will refresh to show any resources that remain out and the reservations that have been returned.
Reservations can be returned from within patron records by selecting Other → Booking → Return Reservations

Cancelling a Reservation

A reservation can be cancelled in a patron’s record or reservation creation screen.

**Cancel a reservation from the patron record**

1) Retrieve the patron’s record.

2) Select Other → Booking → Create or Cancel Reservations.

3) The existing reservations will appear at the bottom of the screen.

4) Highlight the reservation that you want to cancel. Click Cancel Selected.
5) A pop-up window will confirm the cancellation. Click OK on the prompt.

6) The screen will refresh, and the cancelled reservation(s) will disappear.

**Cancel a reservation on reservation creation screen**

1) Access the reservation creation screen by selecting Booking → Create Reservations.
2) Select any Bookable Resource Type, then click Next.
3) Scan or type in the patron barcode in Reserve to Patron box then hit Enter.
4) Patron’s existing reservations will display at the bottom of the screen.
5) Select those that you want to cancel, then click Cancel Selected.
To search for a patron, select Search → Search for Patrons from the menu bar.

The Patron Search screen will display. It will contain options to search on the following fields:

- Last Name
- First Name
- Middle Name

Next to the Clear Form button there is a button with an arrow pointing down that will display the following additional search fields:

- Barcode
- Alias
- Username
- Email
- Identification
- database ID
- Phone
- Street 1
- Street 2
- City
- State
- Postal Code
- Profile Group
- Home Library
• DOB (date of birth) year
• DOB month
• DOB day

To include patrons marked “inactive”, click on the Include Inactive? checkbox.

Tips for searching

• Search one field or combine fields for more precise results.
• Truncate search terms for more search results.
• Search ignores punctuation such as diacritics, apostrophes, hyphens and commas.
• Searching by Date of Birth: Year searches are “contains” searches. E.g. year "15" matches 2015, 1915, 1599, etc. For exact matches use the full 4-digit year. Day and month values are exact matches. E.g. month "1" (or "01") matches January, "12" matches December.

Once you have located the desired patron, click on the entry row for this patron in the results screen. A summary for this patron will display on the left hand side.
Retrieving Recent Patrons

Retrieving Recent Patrons

• Once the library setting has been configured to a number greater than 1, the option Retrieve Recent Patrons will appear below the Retrieve Last patron option in the Circulation drop-down from the Menu Bar (Circulation → Retrieve Recent Patrons).

• When selected, a grid will appear listing patrons accessed by that workstation in the current session. The length of the list will be limited by the value configured in the Library Settings Editor. If no patrons have been accessed, the grid will display "No Items To Display."

Registering New Patrons

To register a new patron, select Circulation → Register Patron from the menu bar. The Patron Registration form will display.
Mandatory fields display in yellow.

The Show: Required Fields and Show: Suggested Fields links may be used to limit the options on this page.

When finished entering the necessary information, select Save to save the new patron record or Save & Clone to register a patron with the same address. When Save & Clone is selected, the address information is copied into the resulting patron registration screen. It is linked to the original patron. Address information may only be edited through the original record.
Patron Self-Registration

Abstract

Patron Self-Registration allows patrons to initiate registration for a library account through the OPAC. Patrons can fill out a web-based form with basic information that will be stored as a “pending patron” in Evergreen. Library staff can review pending patrons in the staff-client and use the pre-loaded account information to create a full patron account. Pending patron accounts that are not approved within a configurable amount of time will be automatically deleted.

Patron Self-Registration

1. In the OPAC, click on the link to Request Library Card
2. Fill out the self-registration form to request a library card, and click Submit Registration.
3. Patrons will see a confirmation message: “Registration successful! Please see library staff to complete your registration.”
Managing Pending Patrons

1. In the staff client select Circulation → Pending Patrons.

2. Select the patron you would like to review. In this screen you have the option to Load the pending patron information to create a permanent library account.

3. To create a permanent library account for the patron, click on the patron’s row, click on the Load Patron button at the top of the screen. This will load the patron self-registration information into the main Patron Registration form.

4. Fill in the necessary patron information for your library, and click Save to create the permanent patron account.

Updating Patron Information

Retrieve the patron record as described in the section Searching Patrons.

Click on Edit from the options that display at the top of the patron record.
Edit information as required. When finished, select Save.

After selecting Save, the page will refresh. The edited information will be reflected in the patron summary pane.

• To quickly renew an expired patron, click the Update Expire Date button. You will need a Main (Profile) Permission Group selected for this to work, since the permission group determines the expiration date.

Renewing Library Cards

Expired patron accounts when initially retrieved – an alert stating that the “Patron account is EXPIRED.”
Open the patron record in edit mode as described in the section Updating Patron Information.

Navigate to the information field labeled Privilege Expiration Date. Enter a new date in this box. Or click the calendar icon, and a calendar widget will display to help you easily navigate to the desired date.
Select the date using the calendar widget or key the date in manually. Click the Save button. The screen will refresh and the “expired” alerts on the account will be removed.

Lost Library Cards

Retrieve the patron record as described in the section Searching Patrons.

Open the patron record in edit mode as described in the section Updating Patron Information.

Next to the Barcode field, select the Replace Barcode button.

This will clear the barcode field. Enter a new barcode and Save the record. The screen will refresh and the new barcode will display in the patron summary pane.
If a patron’s barcode is mistakenly replaced, the old barcode may be reinstated. Retrieve the patron record as described in the section Searching Patrons. Open the patron record in edit mode as described in the section Updating Patron Information.

Select the See All button next to the Replace Barcode button. This will display the current and past barcodes associated with this account.

Check the box(es) for all barcodes that should be “active” for the patron. An “active” barcode may be used for circulation transactions. A patron may have more than one “active” barcode. Only one barcode may be designated “primary.” The “primary” barcode displays in the patron’s summary information in the Library Card field.

Once you have modified the patron barcode(s), Save the patron record. If you modified the “primary” barcode, the new primary barcode will display in the patron summary screen.

### Resetting Patron’s Password

A patron’s password may be reset from the OPAC or through the staff client. To reset the password from the staff client, retrieve the patron record as described in the section Searching Patrons.

Open the patron record in edit mode as described in the section Updating Patron Information.

Select the Generate Password button next to the Password field.

The existing password is not displayed in patron records for security reasons.
A new number will populate the Password text box. Make note of the new password and Save the patron record. The screen will refresh and the new password will be suppressed from view.

**Barring a Patron**

A patron may be barred from circulation activities. To bar a patron, retrieve the patron record as described in the section [Searching Patrons](#).

Open the patron record in edit mode as described in the section [Updating Patron Information](#).

Check the box for Barred in the patron account.

Save the user. The screen will refresh.

---

To unbar a patron, uncheck the Barred checkbox.

**Barred vs. Blocked**

Barred: Stops patrons from using their library cards; alerts the staff that the patron is banned/barred from the library. The “check-out” functionality is disabled for barred patrons (NO option to override – the checkout window is unusable and the bar must be removed from the account before the patron is able to checkout items). These patrons may still log in to the OPAC to view their accounts.

Blocked: Often, these are system-generated blocks on patron accounts.

Some examples:
• Patron exceeds fine threshold

• Patron exceeds max checked out item threshold

A notice appears when a staff person tries to checkout an item to blocked patrons, but staff may be given permissions to override blocks.

**Staff-Generated Messages**

There are several types of messages available for staff to leave notes on patron records.

**Patron Notes:** These notes are added via Other → Notes in the patron record. These notes can be viewable by staff only or shared with the patron. Staff initials can be required. (See the section **Patron Notes** for more.)

**Patron Alerts:** This type of alert is added via Edit button in the patron record. There is currently no way to require staff initials for this type of alert. (See the section **Patron Alerts** for more.)

**Staff-Generated Penalties/Messages:** These messages are added via the Messages button in the patron record. They can be a note, alert or block. Staff initials can be required. (See the section **Staff-Generated Penalties/Messages** for more.)

**Patron Alerts**

When an account has an alert on it, a Stop sign is displayed when the record is retrieved.

Navigating to an area of the patron record using the navigation buttons at the top of the record (for example, Edit or Bills) will clear the message from view.

If you wish to view these alerts after they are cleared from view, they may be retrieved. Use the Other menu to select Display Alert and Messages.
There are two types of Patron Alerts:

System-generated alerts: Once the cause is resolved (e.g. patron’s account has been renewed), the message will disappear automatically.

Staff-generated alerts: Must be added and removed manually.

To add an alert to a patron account, retrieve the patron record as described in the section Searching Patrons.

Open the patron record in edit mode as described in the section Updating Patron Information.

Enter the alert text in the Alert Message field.

Save the record. The screen will refresh and the alert will display.

To remove the alert, retrieve the patron record as described in the section Searching Patrons.

Open the patron record in edit mode as described in the section Updating Patron Information.
Delete the alert text in the Alert Message field.

Save the record.

The screen will refresh and the indicators for the alert will be removed from the account.

**Patron Notes**

Notes are strictly communicative and may be made visible to the patron via their account on the OPAC. In the OPAC, these notes display on the account summary screen in the OPAC.

<table>
<thead>
<tr>
<th>Note title</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test public note</td>
<td>test public note content</td>
</tr>
</tbody>
</table>

To insert or remove a note, retrieve the patron record as described in the section [Searching Patrons](#). Open the patron record in edit mode as described in the section [Updating Patron Information](#). Use the Other menu to navigate to Notes.

Select the Add New Note button. A Create a new note window displays.
Your system administrator can add a box in the Add Note window for staff initials and require those initials to be entered. They can do so using the "Require staff initials..." settings in the Library Settings Editor.

Enter note information.

Select the check box for Patron Visible to display the note in the OPAC.

Select OK to save the note to the patron account.

To delete a note, go to Other → Notes and use the Delete button on the right of each note.

Staff-Generated Penalties/Messages

To access this feature, use the Messages button in the patron record.
Add a Message

Click Apply Penalty/Message to begin the process of adding a message to the patron.

There are three options: Notes, Alerts, Blocks

- **Note:** This will create a non-blocking, non-alerting note visible to staff. Staff can view the message by clicking the Messages button on the patron record. (Notes created in this fashion will not display via Other → Notes, and cannot be shared with the patron. See the [Patron Notes] section for notes which can be shared with the patron.)
• Alert: This will create a non-blocking alert which appears when the patron record is first retrieved. The alert will cause the patron name to display in red, rather than black, text. Alerts may be viewed by clicking the Messages button on the patron record or by selecting Other → Display Alerts and Messages.

• Block: This will create a blocking alert which appears when the patron record is first retrieved, and which behaves much as the non-blocking alert described previously. The patron will be also blocked from circulation, holds and renewals until the block is cleared by staff.

After selecting the type of message to create, enter the message body into the box. If Staff Initials are required, they must be entered into the Initials box before the message can be added. Otherwise, fill in the optional Initials box and click OK.

The message should now be visible in the Staff-Generated Penalties/Messages list. If a blocking or non-blocking alert, the message will also display immediately when the patron record is retrieved.

Modify a Message

Messages can be edited by staff after they are created.

Click to select the message to be modified, then click Actions → Modify Penalty/Message. This menu can also be accessed by right-clicking in the message area.
To change the type of message, click on Note, Alert, Block to select the new type. Edit or add new text in the message body. Enter Staff Initials into the Initials box (may be required.) and click OK to submit the alterations.

Archive a Message

Messages which are no longer current can be archived by staff. This action will remove any alerts or blocks associated with the message, but retains the information contained there for future reference.

Click to select the message to be archived, then click Actions → Archive Penalty/Message. This menu can also be accessed by right-clicking in the message area.
Archived messages will be shown in the section labelled Archived Penalties/Messages. To view messages, click Retrieve Archived Penalties. By default, messages archived within the past year will be retrieved. To retrieve messages from earlier dates, change the start date to the desired date before clicking Retrieve Archived Penalties.

**Remove a Message**

Messages which are no longer current can be removed by staff. This action removes any alerts or blocks associated with the message and deletes the information from the system.

Click to select the message to be removed, then click Actions → Remove Penalty/Message. This menu can also be accessed by right-clicking in the message area.

**User Buckets**

User Buckets allow staff to batch delete and make batch modifications to user accounts in Evergreen. Batch modifications can be made to selected fields in the patron account:

- Home Library
- Profile Group
- Network Access Level
- Barred flag
- Active flag
- Juvenile flag
- Privilege Expiration Date
- Statistical Categories

Batch modifications and deletions can be rolled back or reversed, with the exception of batch changes to statistical categories. Batch changes made in User Buckets will not activate any Action/Trigger event definitions that would normally be activated when editing an individual account.

User accounts can be added to User Buckets by scanning individual user barcodes or by uploading a file of user barcodes directly in the User Bucket interface. They can also be added to a User Bucket from the Patron Search screen. Batch changes and batch edit sets are tied to the User Bucket itself, not to the login of the bucket owner.
Create a User Bucket

To add users to a bucket via the Patron Search screen:

1. Go to Search→Search for Patrons.

2. Enter your search and select the users you want to add to the user bucket by checking the box next to each user row. You can also hold down the CTRL or SHIFT on your keyboard and select multiple users.

3. Click Add to Bucket and select an existing bucket from the drop down menu or click New Bucket to create a new user bucket.

   a. If creating a new user bucket, a dialog box called Create Bucket will appear where you can enter a bucket Name and Description and indicate if the bucket is Staff Shareable?. Click Create Bucket.

4. After adding users to a bucket, an update will appear at the bottom-right hand corner of the screen that says "Successfully added # users to bucket [Name]".
To add users to a bucket by scanning user barcodes in the User Bucket interface:

1. Go to Circulation→User Buckets and select the Pending Users tab at the top of the screen.

2. Click on Buckets and select an existing bucket from the drop down menu or click New Bucket to create a new user bucket.
   a. If creating a new user bucket, a dialog box called Create Bucket will appear where you can enter a bucket Name and Description and indicate if the bucket is Staff Shareable?. Click Create Bucket.
   b. After selecting or creating a bucket, the Name, Description, number of items, and creation date of the bucket will appear above the Scan Card field.

3. Scan in the barcodes of the users that you want to add to the selected bucket into the Scan Card field. Each user account will be added to the Pending Users tab. Hit ENTER on your keyboard after manually typing in a barcode to add it to the list of Pending Users.

4. Select the user accounts that you want to add to the bucket by checking the box next to each user row or by using the CTRL or SHIFT key on your keyboard to select multiple users.

5. Go to Actions→Add To Bucket or right-click on a selected user account to view the Actions menu and select Add To Bucket. The user accounts will move to the Bucket View tab and are now in the selected User Bucket.
To add users to a bucket by uploading a file of user barcodes:

1. Go to Circulation→User Buckets and select the Pending Users tab at the top of the screen.

2. Click on Buckets and select an existing bucket from the drop down menu or click New Bucket to create a new user bucket.
   a. If creating a new user bucket, a dialog box called Create Bucket will appear where you can enter a bucket Name and Description and indicate if the bucket is Staff Shareable?. Click Create Bucket.
   b. After selecting or creating a bucket, the Name, Description, number of items, and creation date of the bucket will appear above the Scan Card field.

3. In the Pending Users tab, click Choose File and select the file of barcodes to be uploaded.
   a. The file that is uploaded must be a .txt file that contains a single barcode per row.

4. The user accounts will automatically appear in the list of Pending Users.

5. Select the user accounts that you want to add to the bucket by checking the box next to each user row or by using the CTRL or SHIFT key on your keyboard to select multiple users.

6. Go to Actions→Add To Bucket or right-click on a selected user account to view the Actions menu and select Add To Bucket. The user accounts will move to the Bucket View tab and are now in the selected User Bucket.

**Batch Edit All Users**

To batch edit all users in a user bucket:

1. Go to Circulation→User Buckets and select the Bucket View tab.

2. Click Buckets and select the bucket you want to modify from the list of existing buckets.
   a. After selecting a bucket, the Name, Description, number of items, and creation date of the bucket will appear at the top of the screen.

3. Verify the list of users in the bucket and click Batch edit all users. A dialog box called Update all users will appear where you can select the batch modifications to be made to the user accounts.
4. Assign a Name for edit set. This name will allow staff to identify the batch edit for future verification or rollbacks.

5. Set the values that you want to modify. The following fields can be modified in batch:

- Home Library
- Profile Group
- Network Access Level
- Barred flag
- Active flag
- Juvenile flag
- Privilege Expiration Date

6. Click Apply Changes. The modification(s) will be applied in batch.
Batch Modify Statistical Categories

To batch modify statistical categories for all users in a bucket:

1. Go to Circulation→User Buckets and select the Bucket View tab.

2. Click Buckets and select the bucket you want to modify from the list of existing buckets.
   a. After selecting a bucket, the Name, Description, number of items, and creation date of the bucket will appear at the top of the screen.

3. Verify the list of users in the bucket and click Batch modify statistical categories. A dialog box called Update statistical categories will appear where you can select the batch modifications to be made to the user accounts. The existing patron statistical categories will be listed and staff can choose:
   a. To leave the stat cat value unchanged in the patron accounts.
   b. To select a new stat cat value for the patron accounts.
   c. Check the box next to Remove to delete the current stat cat value from the patron accounts.

4. Click Apply Changes. The stat cat modification(s) will be applied in batch.

Batch Delete Users

To batch delete users in a bucket: . Go to Circulation→User Buckets and select the Bucket View tab. . Click on Buckets and select the bucket you want to modify from the list of existing buckets. .. After selecting a bucket, the Name, Description, number of items, and creation date of the bucket will appear at the top of the screen. . Verify the list of users in the bucket and click Delete all users. A dialog box called Delete all users will appear. . Assign a Name for delete set. This name will allow staff to identify the batch deletion for future verification or rollbacks. . Click Apply Changes. All users in the bucket will be marked as deleted.
Batch deleting patrons from a user bucket does not use the Purge User functionality, but instead marks the users as deleted.

View Batch Changes

1. The batch changes that have been made to User Buckets can be viewed by going to Circulation→User Buckets and selecting the Bucket View tab.

2. Click Buckets to select an existing bucket.

3. Click View batch changes. A dialog box will appear that lists the Name, date Completed, and date Rolled back of any batch changes made to the bucket. There is also an option to Delete a batch change. This will remove this batch change from the list of actions that can be rolled back. It will not delete or reverse the batch change.

4. Click OK to close the dialog box.

Roll Back Batch Changes

1. Batch Changes and Batch Deletions can be rolled back or reversed by going to Circulation→User Buckets and selecting the Bucket View tab.
2. Click Buckets to select an existing bucket.

3. Click Roll back batch edit. A dialog box will appear that contains a drop down menu that lists all batch edits that can be rolled back. Select the batch edit to roll back and click Roll Back Changes. The batch change will be reversed and the roll back is recorded under View batch changes.

Batch statistical category changes cannot be rolled back.

Sharing Buckets

If a User Bucket has been made Staff Shareable, it can be retrieved via bucket ID by another staff account. The ID for each bucket can be found at the end of the URL for the bucket. For example, in the screenshot below, the bucket ID is 32.
A shared bucket can be retrieved by going to Circulation→User Buckets and selecting the Bucket View tab. Next, click Buckets and select Shared Bucket. A dialog box called Load Shared Bucket by Bucket ID will appear. Enter the ID of the bucket you wish to retrieve and click Load Bucket. The shared bucket will load in the Bucket View tab.

Permissions

All permissions must be granted at the organizational unit that the workstation is registered to or higher and are checked against the users’ Home Library at when a batch modification or deletion is executed.

Permissions for Batch Edits:

• To batch edit a user bucket, staff accounts must have the VIEW_USER, UPDATE_USER, and CONTAINER_BATCH_UPDATE permissions for all users in the bucket.

• To make a batch changes to Profile Group, staff accounts must have the appropriate group application permissions for the profile groups.

• To make batch changes to the Home Library, staff accounts must have the UPDATE_USER permission at both the old and new Home Library.

• To make batch changes to the Barred Flag, staff accounts must have the appropriate BAR_PATRON or UNBAR_PATRON permission.

Permissions for Batch Deletion:

• To batch delete users in a user bucket, staff accounts must have the UPDATE_USER and DELETE_USER permissions for all users in the bucket.
Chapter 129. Patron self-registration administration

Library Settings

Three Library Settings are specific to patron self-registration:

• OPAC: Allow Patron Self-Registration must be set to True to enable use of this feature.

• OPAC: Patron Self-Reg. Expire Interval allows each library to set the amount of time after which pending patron accounts should be deleted.

• OPAC: Patron Self-Reg. Display Timeout allows each library to set the amount of time after which the patron self-registration screen will timeout in the OPAC. The default is 5 minutes.

Several more Library Settings can be used to determine if a field should be required or hidden in the self-registration form:

• GUI: Require day_phone field on patron registration

• GUI: Show day_phone on patron registration

• GUI: Require dob (date of birth) field on patron registration

• GUI: Show dob field on patron registration

• GUI: Require email field on patron registration

• GUI: Show email field on patron registration

• GUI: Require State field on patron registration

• GUI: Show State field on patron registration

• GUI: Require county field on patron registration

• GUI: Show county field on patron registration [New Setting]

Several more Library Settings can be used to verify values in certain fields and provide examples for data format on the registration form:

• Global: Patron username format

• GUI: Regex for phone fields on patron registration OR GUI: Regex for day_phone field on patron registration

• GUI: Regex for email field on patron registration

• GUI: Regex for post_code field on patron registration
• GUI: Example for email field on patron registration
• GUI: Example for post_code field on patron registration
• GUI: Example for day_phone field on patron registration OR GUI: Example for phone fields on patron registration
Chapter 130. Triggered Events and Notices

Introduction

Improvements to the Triggered Events interface enables you to easily filter, sort, and print triggered events from the patron’s account or an item’s details. This feature is especially useful when tracking notice completion from a patron’s account.

Access and View

You can access Triggered Events from two Evergreen interfaces: a patron’s account or an item’s details.

To access this interface in the patron’s account, open the patron’s record and click Other → Triggered Events / Notifications.

To access this interface from the item’s details, enter the item barcode into the Item Status screen, and click Actions → Show → Triggered Events.

Information about the patron, the item, and the triggered event appear in the center of the screen. Add or delete columns to the display by right clicking on any column. The Column Picker appears in a pop up box and enables you to select the columns that you want to display.
## Filter

The triggered events that display are controlled by the filters on the right side of the screen. By default, Evergreen displays completed circulation events. Notice that the default filters display Event State is Complete and Core Type is Circ.

To view completed hold-related events, such as hold capture or hold notice completion, choose Event State is Complete and Core Type is Hold from the drop down menu.

You can also use the Event State filter to view circs and holds that are pending or have an error.

Add and delete filters to customize the list of triggered events that displays. To add another filter, click Add Row. To delete a filter, click the red X adjacent to a row.

---

### Sort

You can sort your results by clicking the column name.

## Triggered Event Log (patron specific)

Show events at and below: **Algona-Pacific**

<table>
<thead>
<tr>
<th>#</th>
<th>Event Name</th>
<th>Reactor</th>
<th>Event Run Time</th>
<th>Event State</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Hold Ready for Pickup Email Notification</td>
<td>ProcessTemp</td>
<td>2012-07-27T1: complete</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Hold Ready for Pickup SMS Notification</td>
<td>SendSMS</td>
<td>2012-07-27T1: complete</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Hold Ready for Pickup Email Notification</td>
<td>ProcessTemp</td>
<td>2012-07-27T1: complete</td>
<td></td>
</tr>
</tbody>
</table>
Print

You can select the events that you want to print, or you can print all events. To print selected events, check the boxes adjacent to the events that you want to print, and click Print Selected Events. To print all events, simply click Print All Events.

Reset

If the triggered event does not complete or the notice is not sent and the trigger needs to be run again, then select the event, and click Reset Selected Events.
Chapter 131. Offline Circulation

Introduction

Evergreen’s Offline Circulation interface is designed to log transactions during a network or server outage. Transactions can be uploaded and processed once connectivity is restored.

Offline Circulation in the Web Staff Client relies on the use of web service workers to store information for offline use. Prior to using Offline Circulation you must have access to your production server and register your workstation on the computer and in the browser you intend to use. You must also log in from that browser at least once and visit Search → Search for Patrons. Perform a search, select a user from the results, and open the Patron Edit interface. This will allow the Offline interface to collect the information it needs, such as workstation information and the patron registration form.

The web service workers will refresh the cache every 24 hours under normal use. Offline Circulation information is stored via IndexedDB.

Using Offline Circulation

The Offline Circulation interface can be found by navigating to Circulation → Offline Circulation.

The permanent link for the Offline Circulation is https://<yourhostname>/eg/staff/offline-interface and it is recommended that this link be bookmarked on staff workstations. This is the location for both entering transactions while offline as well as processing them later. You will see a slightly different version of this interface depending on whether or not you are logged in.

If you are logged out, you will see the tab default to Checkout and the button on the top-right will read Export Transactions.

If you are logged in, you will see an additional tab on the left for Session Management and this will be the default tab. The top-right button will read Download Block List.
If you are logged in and attempt to click on any tab other than Session Management, you will see a warning alerting you that you are about to enter offline mode.

![Warning](image)

This warning is not network-aware and it will appear regardless of network connection state. You must be logged out to record offline transactions. If you see this warning and wish to record offline transactions, click Proceed in order to log out.

## Checkout

To check out items in Offline Circulation:

1. Click the Checkout tab.

2. If you wish to use Strict Barcode for patron and item barcodes, check the box labelled Strict Barcode.

3. Enter a value in the Due Date field or select a date from the Calendar widget. You may also select an option from the Offset Dropdown. The date field entry will honor the format set in the Library Settings Editor.

4. Scan the Patron Barcode in the box labelled Patron Barcode.

5. Check out items:
   a. For cataloged items, scan the item barcode in the box labelled Item Barcode. Each item barcode will appear on the right side of the screen, along with its due date and the patron barcode. If you are manually typing barcodes, you need to click the Checkout button or hit the Enter key on your keyboard after each Item Barcode entry in order to record the transaction.
   b. For non-cataloged items, select a Non-cataloged Type from the dropdown and enter the number of items you wish to check out. Click Checkout. In the list to the right, the item barcode will appear blank since this item is unbarcoded. The due date and patron barcode will appear, however.
   c. If you make an error in entry, click Clear to reset the Patron Barcode and Item Barcode fields.

6. To print a receipt, check the box labelled Print Receipt.

7. Click Save Transactions in the upper-right of the screen to complete the checkout.
Note that Save Transactions will save any unsaved transactions across the Offline tabs Checkout, Renew, In-House Use, and Checkin.

In the screenshot, the first two items in the right-hand list are regular checkout items. The third item is a non-cataloged item.

A value entered in the Due Date field will take precedence over an existing value in the Offset Dropdown; however, if you change the Offset after setting the Due Date field, the Due Date field will update to reflect the Offset value.

Due Date and Offset values are sticky between the Checkout and Renew tabs, and also sticky between transactions. Strict Barcode and Print Receipt are sticky among the Checkout, Renew, In-House Use, and Checkin tabs and are also sticky between transactions.

Pre-cataloged item checkout is not available in Offline Circulation. Any pre-cataloged item checked out through Offline Circulation will result in an entry in the Exception List and will not successfully check out. Pre-cataloged items which are checked in through offline will also result in an entry in the Exception List, but will successfully check in.

**Renew**

To renew an item, you must know the item’s barcode number. The patron’s barcode is optional.

To renew items in Offline Circulation:

1. Click the Renew tab.
2. Ensure that the Due Date value is correct.
3. (Optional): Enter the patron’s library card barcode in the Patron Barcode field by scanning or typing the barcode.
4. For each item to be renewed, scan the item’s barcode in the Item Barcode field. If you are typing the item barcode, click the Renew button or hit the Enter key on your keyboard after each item barcode.
5. The item barcode, due date, and patron barcode (if entered) appear on the right side of the screen.
6. To print a receipt, check the box labelled Print Receipt.
7. Click Save Transactions in the upper-right of the screen to complete the renewal.

**In-House Use**

To record in-house use transactions in Offline Circulation:

1. Click the In-House Use tab.

2. Enter the number of uses to record for the item in the Use Count field.

3. For each item to be recorded as in-house use, scan the item’s barcode in the Item Barcode field. If you are typing the item barcode, click the Record Use button or hit the Enter key on your keyboard after each item barcode.

4. The item barcode and use count will appear on the right side of the screen.

5. To print a receipt, check the box labelled Print Receipt.

6. Click Save Transactions in the upper-right of the screen to record the in-house use. The date of the in-house use is automatically recorded.

**Checkin**

To checkin items in Offline Circulation:

1. Click the Checkin tab.
2. Ensure that the Due Date value is correct. It will default to today’s date.

3. For each item to be checked in, scan the item’s barcode in the Item Barcode field. If you are typing the item barcode, click the Checkin button or hit the Enter key on your keyboard after each item barcode.

4. To print a receipt, check the box labelled Print Receipt.

5. Click Save Transactions in the upper-right of the screen when you are finished entering checkins.

Note that existing pre-cataloged items can be checked in through the Offline interface, but they will generate an entry in the Exceptions list when offline transactions are uploaded and processed.

Items targeted for holds will be captured for their holds when the offline transactions are uploaded and processed; however, there will be no indication in the Exceptions list about this unless the item is also transiting.

**Patron Registration**

Patron registration in Evergreen Offline Circulation records patron information for later upload. In the web staff client, the Patron Registration form in Offline is the same as the regular Patron Registration interface.

All fields in the normal Patron Registration interface are available for entry. Required fields are marked in yellow and adhere to Required Fields set in the Library Settings Editor. Patron Registration defaults also adhere to settings in the Library Settings Editor. Stat cats are not recognized by the Offline Interface, even if they are required.
Enter patron information and click the Save button in the top-right of the Patron Registration interface. You may checkout items to this patron right away, even if you are still in offline mode.

Managing Offline Transactions

Offline Block List

While logged in and still online, you may download an Offline Block List. This will locally store a list of all patrons with blocks at the time of the download. If this list is present, the Offline Circulation interface will check transactions against this list.

To download the block list, navigate to Circulation → Offline Circulation and click the Download Block List button in the top-right of the screen.

If you attempt a checkout or a renewal for a patron on the block list, you will get a modal informing you that the patron has penalties. Click the Allow button to override this and proceed with the transaction. Click the Reject button to cancel the checkout or renewal.

Exporting Offline Transactions

If you anticipate a multi-day closing or if you plan to process your offline transactions at a different workstation, you will want to export your offline transactions.

To export transactions while you are offline, navigate to Circulation → Offline Circulation and click Export Transactions in the top-right of the screen. This will save a file entitled pending.xacts to your browser’s default download location. If you will be processing these transactions on another workstation, move this file to an external device like a thumb drive.

To export transactions while you are logged in, navigate to Circulation → Offline Circulation and click on the Session Management tab. Click on the Export Transactions button to generate the pending.xacts file as above. If you wish, you can at this point click Clear Transactions to clear the list of pending transactions.

Processing Offline Transactions

Once connectivity is restored, navigate back to your Evergreen Login Page. You will see a message telling you that there are unprocessed Offline Transactions waiting for upload.
Sign in and navigate to Circulation → Offline Circulation. Since you are logged in, you will now see a Session Management tab to the left of the Register Patron tab. The Session Management tab includes Pending Transactions and Offline Sessions.

In the Pending Transactions tab you will see a list of all transactions recorded on that browser.

If you click Clear Transactions, you will be prompted with a warning.

If you are processing transactions right away and from the same browser you recorded them in, follow the steps below:
1. Click on the Offline Sessions tab and then on the Create Session button.

2. Enter a descriptive name for your session in the modal and click OK/Continue to proceed. You will see your new session at the top of the Session List. The Session List may be sorted ascending or descending by clicking on one of the following column headers: Organization, Created By, Description, Date Created, or Date Completed. The default sort is descending by Date Created.

3. Click Upload to upload everything listed in the Pending Transactions tab.

4. Once all transactions are uploaded, the Upload Count column will update to show the number of uploaded transactions.

5. Click Process to process the offline transactions. Click Refresh to see the processing progress. Once all transactions are processed the Date Completed column will be updated.

6. Scroll to the bottom of the screen to see if there are any entries in the Exception List. Some of these may require staff follow up.

**Uploading Previously Exported Transactions**

If you had previous exported your offline transactions you can upload them for processing.

To import transactions:

1. Log in to the staff client via your Login Page
2. Navigate to Circulation → Offline Circulation
3. Click on the Session Management tab.
4. Click on the Import Transactions button.
5. Navigate to the location on your computer where the pending.xacts file is saved.
6. Select the file for importing.
7. The Pending Transactions list will populate with your imported transactions.
8. You may now proceed according to the instructions under Processing Offline Transactions.
Exceptions

Exceptions are problems that were encountered during processing. For example, a mis-scanned patron barcode, an open circulation, or an item that was not checked in before it was checked out to another patron would all be listed as exceptions. Those transactions causing exceptions might not be loaded into Evergreen database. Staff should examine the exceptions and take necessary action.

These are a few notes about possible exceptions. It is not an all-inclusive list.

- Checking out an item with the wrong date (i.e. the Offline Checkout date is +2 weeks and the item’s regular circulation period is +1 week) does not cause an exception.

- Overdue books are not flagged as exceptions.

- Checking out a reference book or another item set to not circulate does not cause an exception.

- Checking out an item belonging to another library does not cause an exception.

- An item that is targeted for a patron hold and captured via offline checkin will not cause an exception unless that item also goes to an In Transit status.

- An item that is on hold for Patron A but checked out to Patron B will not cause an exception. Patron A’s hold will be reset and will retarget the next time the hold targeter is run. In order to avoid this it is recommended to not check out holds to other patrons.

- If you check out a book to a patron using a previous barcode for that patron, it will cause an exception and you will have to retrieve that patron while online and re-enter the item barcode in order to check out the item.

- The Offline Interface can recognize blocked, barred, and expired patrons if you have downloaded the Offline Block List in the browser you are using. You will get an error message indicating the patron status from within the Standalone Interface at check-out time. See the section on the Offline Block List for more information.

At the right side of each exception are buttons for Item, Patron, and Debug. Clicking the Item button will retrieve the associated item in a new browser window. Clicking on the Patron button will retrieve the associated patron in a new browser window. Clicking the Debug button will result in a modal with detailed debugging information.
Common event names in the Exceptions List include:

- **ROUTE-ITEM** - Indicates the book should be routed to another branch or library system. You’ll need to find the book and re-check it in while online to get the Transit Slip to print.

- **COPY_STATUS_LOST** - Indicates a book previously marked as lost was found and checked in. You will need to find the book and re-check it in while online to correctly clear it from the patron’s account.

- **CIRC_CLAIMS_RETURNED** - Indicates a book previously marked as claimed-returned was found and checked in. You will need to find the book and re-check it in while online to correctly clear it from the patron’s account.

- **ASSET_COPY_NOT_FOUND** - Indicates the item barcode was mis-scanned/mis-typed.

- **ACTOR_CARD_NOT_FOUND** - Indicates the patron’s library barcode was mis-scanned, mis-typed, or nonexistent.

- **OPEN_CIRCULATION_EXISTS** - Indicates a book was checked out that had never been checked in.

- **MAX_RENEWALS_REACHED** - Indicates the item has already been renewed the maximum times allowed. Note that if the staff member processing the offline transaction set has the `MAX_RENEWALS_REACHED.override` permission at the appropriate level, the system will automatically override the error and will allow the renewal.
Chapter 132. Self checkout

Introduction

Evergreen includes a self check interface designed for libraries that simply want to record item circulation without worrying about security mechanisms like magnetic strips or RFID tags.

Initializing the self check

The self check interface runs in a web browser. Before patrons can use the self check station, a staff member must initialize the interface by logging in.

1. Open your self check interface page in a web browser. By default, the URL is https://[hostname]/eg/circ/selfcheck/main, where [hostname] represents the host name of your Evergreen web server.

2. Log in with a staff account with circulation permissions.

Basic Check Out

1. Patron scans their barcode.

2. Optional Patron enters their account password.
3. Patron scans the barcodes for their items OR Patron places items, one at a time, on the RFID pad.

4. Items will be listed below with a check out confirmation message.

5. If a check out fails a message will advise patrons.

6. Patron clicks Logout to print a checkout receipt and logout. OR Patron clicks Logout (No Receipt) to logout with no receipt.
If the patron forgets to logout the system will automatically log out after the time period specified in the library setting Patron Login Timeout (in seconds). An inactivity pop-up will appear to warn patrons 20 seconds before logging out.

View Items Out

1. Patrons are able to view the items they currently have checked out by clicking View Items Out
2. The items currently checked out will display with their due dates. Using the Print List button patrons can print out a receipt listing all of the items they currently have checked out.

2. The items currently checked out will display with their due dates. Using the Print List button patrons can print out a receipt listing all of the items they currently have checked out.

<table>
<thead>
<tr>
<th>Barcode</th>
<th>Title</th>
<th>Author</th>
<th>Due Date</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>G800410001542</td>
<td>Harry Potter and the goblet of fire</td>
<td>Rowling, J. K.</td>
<td>4/28/16</td>
<td>Checkout</td>
</tr>
</tbody>
</table>

View Holds

1. Patrons are able to view their current holds by clicking View Holds
2. Items currently on hold display. Patrons can also see which, if any, items are ready for pickup.

Using the Print List button patrons can print out a receipt listing all of the items they currently have on hold.

![Print List](image)

View Fines

1. Patrons are able to view the fines they currently owe by clicking View Details
2. Current fines owed by the patron display.

<table>
<thead>
<tr>
<th>Type</th>
<th>Details</th>
<th>Total Billed</th>
<th>Total Paid</th>
<th>Balance Owed</th>
</tr>
</thead>
<tbody>
<tr>
<td>circulation</td>
<td>Le Concerto 12345</td>
<td>5.00</td>
<td>0.30</td>
<td>4.70</td>
</tr>
</tbody>
</table>

Selected total: $4.70
Part XII. Reports
# Table of Contents

133. Introduction ........................................................................................................ 706
134. Starting and Stopping the Reporter Daemon .................................................... 707
   Starting the Reporter Daemon ......................................................................... 707
   Stopping the Reporter Daemon ..................................................................... 707
135. Folders ................................................................................................................ 709
   Creating Folders .............................................................................................. 709
   Managing Folders ........................................................................................... 710
136. Creating Templates ............................................................................................ 711
   Choosing Report Fields .................................................................................. 711
   Applying Filters ............................................................................................... 721
   Using Base Filters ........................................................................................... 721
137. Generating Reports from Templates ................................................................. 726
   Viewing and Editing Report Parameters .......................................................... 729
138. Viewing Report Output ....................................................................................... 731
139. Cloning Shared Templates ................................................................................ 734
140. Adding Data Sources to Reporter ...................................................................... 735
   Create a PostgreSQL, view, or table for your data source ......................... 735
   Add a new class to fm_IDL.xml for your data source .................................... 737
   Restart the affected services to see the new data source in the reporter .......... 738
141. Running Recurring Reports .............................................................................. 740
142. Template Terminology ...................................................................................... 741
   Data Types ...................................................................................................... 741
      `timestamp` .................................................................................................. 741
      `link` ........................................................................................................... 741
      `text` ........................................................................................................... 741
      `bool` .......................................................................................................... 741
      `org_unit` ................................................................................................. 742
      `id` ............................................................................................................ 742
      `money` .................................................................................................... 742
      `int` ........................................................................................................... 742
      `interval` .................................................................................................... 742
   Field Transforms ............................................................................................... 742
143. Template Enhancements ..................................................................................... 744
   Documentation URL .......................................................................................... 744
   Field Hints ....................................................................................................... 744
144. Exporting Report Templates Using phpPgAdmin ............................................. 746
   Dump the Entire Reports Template Table ........................................................ 746
   Dump Data with an SQL Statement ................................................................... 746
Chapter 133. Introduction

Learn how to create and use reports in Evergreen.
Chapter 134. Starting and Stopping the Reporter Daemon

Before you can view reports, the Evergreen administrator must start the reporter daemon from the command line of the Evergreen server.

The reporter daemon periodically checks for requests for new reports or scheduled reports and gets them running.

Starting the Reporter Daemon

To start the reporter daemon, run the following command as the opensrf user:

```
clark-kent.pl --daemon
```

You can also specify other options:

- `sleep=interval`: number of seconds to sleep between checks for new reports to run; defaults to 10
- `lockfile=filename`: where to place the lockfile for the process; defaults to `/tmp/reporter-LOCK`
- `concurrency=integer`: number of reporter daemon processes to run; defaults to 1
- `bootstrap=filename`: OpenSRF bootstrap configuration file; defaults to `/openils/conf/opensrf_core.xml`

The open-ils.reporter process must be running and enabled on the gateway before the reporter daemon can be started.

Remember that if the server is restarted, the reporter daemon will need to be restarted before you can view reports unless you have configured your server to start the daemon automatically at start up time.

Stopping the Reporter Daemon
To stop the reporter daemon, you have to kill the process and remove the lockfile. Assuming you’re running just a single process and that the lockfile is in the default location, perform the following commands as the opensrf user:

```
kill `ps wax | grep "Clark Kent" | grep -v grep | cut -b1-6`
rm /tmp/reporter-LOCK
```
Chapter 135. Folders

There are three main components to reports: Templates, Reports, and Output. Each of these components must be stored in a folder. Folders can be private (accessible to your login only) or shared with other staff at your library, other libraries in your system or consortium. It is also possible to selectively share only certain folders and/or subfolders.

There are two parts to the folders pane. The My Folders section contains folders created with your Evergreen account. Folders that other users have shared with you appear in the Shared Folders section under the username of the sharing account.

Creating Folders

Whether you are creating a report from scratch or working from a shared template you must first create at least one folder.

The steps for creating folders are similar for each reporting function. It is easier to create folders for templates, reports, and output all at once at the beginning, though it is possible to do it before each step. This example demonstrates creating a folder for a template.

1. Click on Templates in the My Folders section.
2. Name the folder. Select Share or Do not share from the dropdown menu.
3. If you want to share your folder, select who you want to share this folder with from the dropdown menu.
4. Click Create Sub Folder.

5. Click OK.

6. Next, create a folder for the report definition to be saved to. Click on Reports.

7. Repeat steps 2-5 to create a Reports folder also called Circulation.

8. Finally, you need to create a folder for the report’s output to be saved in. Click on Output.

9. Repeat steps 2-5 to create an Output folder named Circulation.

Using a parallel naming scheme for folders in Templates, Reports, and Output helps keep your reports organized and easier to find

The folders you just created will now be visible by clicking the arrows in My Folders. Bracketed after the folder name is whom the folder is shared with. For example, Circulation (BNCLF) is shared with the North Coast Library Federation. If it is not a shared folder there will be nothing after the folder name. You may create as many folders and sub-folders as you like.

Managing Folders

Once a folder has been created you can change the name, delete it, create a new subfolder, or change the sharing settings. This example demonstrates changing a folder name; the other choices follow similar steps

1. Click on the folder that you wish to rename.

2. Click Manage Folder.

3. Select Change folder name from the dropdown menu and click Go.

4. Enter the new name and click Submit.

5. Click OK.

6. You will get a confirmation box that the Action Succeeded. Click OK.
Chapter 136. Creating Templates

Once you have created a folder, the next step in building a report is to create or clone a template. Templates allow you to run a report more than once without building it anew every time, by changing definitions to suit current requirements. For example, you can create a shared template that reports on circulation at a given library. Then, other libraries can use your template and simply select their own library when they run the report.

It may take several tries to refine a report to give the output that you want. It can be useful to plan out your report on paper before getting started with the reporting tool. Group together related fields and try to identify the key fields that will help you select the correct source.

It may be useful to create complex queries in several steps. For example, first add all fields from the table at the highest source level. Run a report and check to see that you get results that seem reasonable. Then clone the report, add any filters on fields at that level and run another report. Then drill down to the next table and add any required fields. Run another report. Add any filters at that level. Run another report. Continue until you’ve drilled down to all the fields you need and added all the filters. This might seem time consuming and you will end up cloning your initial report several times. However, it will help you to check the correctness of your results, and will help to debug if you run into problems because you will know exactly what changes caused the problem. Also consider adding extra fields in the intermediate steps to help you check your results for correctness.

This example illustrates creating a template for circulation statistics. This is an example of the most basic template that you can create. The steps required to create a template are the same every time, but the tables chosen, how the data is transformed and displayed, and the filters used will vary depending on your needs.

Choosing Report Fields

1. Click on the My Folder template folder where you want the template to be saved.
2. Click on Create a new Template for this folder.

![Create a new Template for this folder](image1)

3. You can now see the template creating interface. The upper half of the screen is the Database Source Browser. The top left hand pane contains the database Sources drop-down list. This is the list of tables available as a starting point for your report. Commonly used sources are Circulation (for circ stats and overdue reports), ILS User (for patron reports), and Item (for reports on a library’s holdings).

![Database Source Browser](image2)

The Enable source nullability checkbox below the sources list is for advanced reporting and should be left unchecked by default.

4. Select Circulation in the Sources dropdown menu. Note that the Core Sources for reporting are listed first, however it is possible to access all available sources at the bottom of this dropdown menu. You may only specify one source per template.
5. Click on Circulation to retrieve all the field names in the Field Name pane. Note that the Source Specifier (above the middle and right panes) shows the path that you took to get to the specific field.
6. Select Circ ID in the middle Field Name pane, and Count Distinct from the right Field Transform pane. The Field Transform pane is where you choose how to manipulate the data from the selected fields. You are counting the number of circulations.

Field Transforms have either an Aggregate or Non-Aggregate output type. See the section called Field Transforms for more about Count, Count Distinct, and other transform options.

7. Click Add Selected Fields underneath the Field Transform pane to add this field to your report output. Note that Circ ID now shows up in the bottom left hand pane under the Displayed Fields tab.
8. Circ ID will be the column header in the report output. You can rename default display names to something more meaningful. To do so in this example, select the Circ ID row and click Alter Display Header.

Double-clicking on the displayed field name is a shortcut to altering the display header.

9. Type in the new column header name, for example Circ count and click OK.
Add other data to your report by going back to the Sources pane and selecting the desired fields. In this example, we are going to add Circulating Item → Shelving Location to further refine the circulation report.

In the top left hand Sources pane, expand Circulation. Depending on your computer you will either click on the + sign or on an arrow to expand the tree.

Click on the + or arrow to expand Circulating Item. Select Shelving Location.
When you are creating a template take the shortest path to the field you need in the left hand Sources pane. Sometimes it is possible to find the same field name further in the file structure, but the shortest path is the most efficient.

In the Field Name pane select Name.

In the upper right Field Transform pane, select Raw Data and click Add Selected Fields. Use Raw Data when you do not wish to transform field data in any manner.
Name will appear in the bottom left pane. Select the Name row and click Alter Display Header.

11. Enter a new, more descriptive column header, for example, Shelving location. Click OK.

12. Note that the order of rows (top to bottom) will correspond to the order of columns (left to right) on the final report. Select Shelving location and click on Move Up to move Shelving location before Circ count.
13. Return to the Sources pane to add more fields to your template. Under Sources click Circulation, then select Check Out Date/Time from the middle Field Name pane.

14. Select Year + Month in the right hand Field Transform pane and click Add Selected Fields.

15. Check Out Date/Time will appear in the Displayed Fields pane. In the report it will appear as a year and month (YYYY-MM) corresponding to the selected transform.
16. Select the Check Out Date/Time row. Click Alter Display Header and change the column header to Check out month.

17. Move Check out month to the top of the list using the Move Up button, so that it will be the first column in an MS Excel spreadsheet or in a chart. Report output will sort by the first column.
Note the Change Transform button in the bottom left hand pane. It has the same function as the upper right Field Transform pane for fields that have already been added.

---

**Applying Filters**

Evergreen reports access the entire database, so to limit report output to a single library or library system you need to apply filters.

After following the steps in the previous section you will see three fields in the bottom left hand Template Configuration pane. There are three tabs in this pane: Displayed Fields (covered in the previous section), Base Filters and Aggregate Filters. A filter allows you to return only the results that meet the criteria you set.

Base Filters apply to non-aggregate output types, while Aggregate Filters are used for aggregate types. In most reports you will be using the Base Filters tab. For more information on aggregate and non-aggregate types see the section called “Field Transforms”.

There are many available operators when using filters. Some examples are Equals, In list, is NULL, Between, Greater than or equal to, and so on. In list is the most flexible operator, and in this case will allow you flexibility when running a report from this template. For example, it would be possible to run a report on a list of timestamps (in this case will be trimmed to year and month only), run a report on a single month, or run a report comparing two months. It is also possible to set up recurring reports to run at the end of each month.

In this example we are going to use a Base Filter to filter out one library’s circulations for a specified time frame. The time frame in the template will be configured so that you can change it each time you run the report.

**Using Base Filters**

1. Select the Base Filters tab in the bottom Template Configuration pane.
2. For this circulation statistics example, select Circulation → Check Out Date/Time → Year + Month and click on Add Selected Fields. You are going to filter on the time period.

3. Select Check Out Date/Time. Click on Change Operator and select In list from the dropdown menu.

4. To filter on the location of the circulation select Circulation → Circulating library → Raw Data and click on Add Selected Fields.
5. Select Circulating Library and click on Change Operator and select Equals. Note that this is a template, so the value for Equals will be filled out when you run the report.

For multi-branch libraries, you would select Circulating Library with In list as the operator, so you could specify the branch(es) when you run the report. This leaves the template configurable to current requirements. In comparison, sometimes you will want to hardcode true/false values into a template. For example, deleted bibliographic records remain in the database, so perhaps you want to hardcode deleted=false, so that deleted records don’t show up in the results. You might want to use deleted=true, for a template for a report on deleted items in the last month.

6. Once you have configured your template, you must name and save it. Name this template Circulations by month for one library. You can also add a description. In this example, the title is descriptive enough, so a description is not necessary. Click Save.
7. Click OK.

8. You will get a confirmation dialogue box that the template was successfully saved. Click OK.

The bottom right hand pane is also a source specifier. By selecting one of these rows you will limit the fields that are visible to the sources you have specified. This may be helpful when reviewing templates with many fields. Use Ctrl+Click to select or deselect items.
Chapter 137. Generating Reports from Templates

Now you are ready to run the report from the template you have created.

1. In the My Folders section click the arrow next to Templates to expand this folder and select circulation.

2. Select the box beside Circulations by month for one library. Select Create a new report from selected template from the dropdown menu. Click Submit.

3. Complete the first part of report settings. Only Report Name and Choose a folder... are required fields.
1) Template Name, Template Creator, and Template Description are for informational purposes only. They are hard coded when the template is created. At the report definition stage it is not possible to change them.

2) Report Name is required. Reports stored in the same folder must have unique names.

3) Report Description is optional but may help distinguish among similar reports.

4) Report Columns lists the columns that will appear in the output. This is derived from the template and cannot be changed during report definition.

5) Pivot Label Column and Pivot Data Column are optional. Pivot tables are a different way to view data. If you currently use pivot tables in MS Excel it is better to select an Excel output and continue using pivot tables in Excel.

6) You must choose a report folder to store this report definition. Only report folders under My Folders are available. Click on the desired folder to select it.

4. Select values for the Circulation > Check Out Date/Time. Use the calendar widget or manually enter the desired dates, then click Add to include the date on the list. You may add multiple dates.
The Transform for this field is Year + Month, so even if you choose a specific date (2009-10-20) it will appear as the corresponding month only (2009-10).

It is possible to select relative dates. If you select a relative date 1 month ago you can schedule reports to automatically run each month. If you want to run monthly reports that also show comparative data from one year ago, select a relative date 1 month ago, and 13 months ago.

5. Select a value for the Circulating Library.

6. Complete the bottom portion of the report definition interface, then click Save.

1) Select one or more output formats. In this example the report output will be available as an Excel spreadsheet, an HTML table (for display in the staff client or browser), and as a bar chart.

2) If you want the report to be recurring, check the box and select the Recurrence Interval as described in Recurring Reports. In this example, as this is a report that will only be run once, the Recurring Report box is not checked.

3) Select Run as soon as possible for immediate output. It is also possible to set up reports that run automatically at future intervals.

4) It is optional to fill out an email address where a completion notice can be sent. The email will contain a link to password-protected report output (staff login required). If you have an email address in your Local System Administrator account it will automatically appear in the email notification box. However, you can enter a different email address or multiple addresses separated by commas.

7. Select a folder for the report’s output.

8. You will get a confirmation dialogue box that the Action Succeeded. Click OK.
Once saved, reports stay there forever unless you delete them.

**Viewing and Editing Report Parameters**

New options to view or edit report parameters are available from the reports folder.

To view the parameters of a report, select the report that you want to view from the Reports folder, and click View. This will enable you to view the report, including links to external documentation and field hints. However, you cannot make any changes to the report.

To edit the parameters of a report, select the report that you want to view from the Reports folder, and click Edit. After making changes, you can Save [the] Report or Save as New. If you Save the Report, any subsequent report outputs that are generated from this report will reflect the changes that you have made.

In addition, whenever there is a pending (scheduled, but not yet started) report output, the interface will warn you that the pending output will be modified. At that point, you can either continue or choose the alternate Save as New option, leaving the report output untouched.
If, after making changes, you select, Save as New, then you have created a new report by cloning and amending a previously existing report. Note that if you create a new report, you will be prompted to rename the new report. Evergreen does not allow two reports with the same name to exist. To view or edit your new report, select the reports folder to which you saved it.
Chapter 138. Viewing Report Output

When a report runs Evergreen sends an email with a link to the output to the address defined in the report. Output is also stored in the specified Output folder and will remain there until manually deleted.

1. To view report output in the staff client, open the reports interface from Administration → Local Administration → Reports.

2. Click on Output to expand the folder. Select Circulation (where you just saved the circulation report output).

3. View report output is the default selection in the dropdown menu. Select Recurring Monthly Circ by Location by clicking the checkbox and click Submit.
4. A new tab will open for the report output. Select either Tabular Output or Excel Output. If Bar Charts was selected during report definition the chart will also appear.

5. Tabular output looks like this:

<table>
<thead>
<tr>
<th>Check out month</th>
<th>Shelving location</th>
<th>Circ count</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009-10</td>
<td>Adult Fiction</td>
<td>10</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Fiction - Second Floor</td>
<td>1125</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Non-Fiction</td>
<td>1188</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Non-fiction</td>
<td>12</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Paperbacks - Mystery</td>
<td>1</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Videos</td>
<td>368</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Videos - Educational</td>
<td>66</td>
</tr>
<tr>
<td>2009-10</td>
<td>Biographies</td>
<td>34</td>
</tr>
<tr>
<td>2009-10</td>
<td>CD-ROMs</td>
<td>3</td>
</tr>
<tr>
<td>2009-10</td>
<td>CDs</td>
<td>144</td>
</tr>
<tr>
<td>2009-10</td>
<td>Children's Videos</td>
<td>232</td>
</tr>
<tr>
<td>2009-10</td>
<td>Children's Videos - Educational</td>
<td>2</td>
</tr>
<tr>
<td>2009-10</td>
<td>Christmas Storage</td>
<td>5</td>
</tr>
<tr>
<td>2009-10</td>
<td>DVDs</td>
<td>981</td>
</tr>
<tr>
<td>2009-10</td>
<td>JP Basement Storage</td>
<td>56</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Easy Readers</td>
<td>152</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Fiction</td>
<td>476</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Non-Fiction</td>
<td>199</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Picture Books</td>
<td>934</td>
</tr>
<tr>
<td>2009-10</td>
<td>Large Print</td>
<td>73</td>
</tr>
</tbody>
</table>

6. If you want to manipulate, filter or graph this data, Excel output would be more useful. Excel output will generate a ".xlsx" file. Excel output looks like this in Excel:
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check out month</td>
<td>Shelving location</td>
<td>Circ count</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Fiction</td>
<td>10</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Fiction - Second Floor</td>
<td>1125</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Non-Fiction</td>
<td>1188</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Non-fiction</td>
<td>12</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Paperbacks - Mystery</td>
<td>1</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Videos</td>
<td>398</td>
</tr>
<tr>
<td>2009-10</td>
<td>Adult Videos - Educational</td>
<td>66</td>
</tr>
<tr>
<td>2009-10</td>
<td>Biographies</td>
<td>34</td>
</tr>
<tr>
<td>2009-10</td>
<td>CD-ROMs</td>
<td>3</td>
</tr>
<tr>
<td>2009-10</td>
<td>CDs</td>
<td>144</td>
</tr>
<tr>
<td>2009-10</td>
<td>Children’s Videos</td>
<td>232</td>
</tr>
<tr>
<td>2009-10</td>
<td>Children’s Videos - Education</td>
<td>2</td>
</tr>
<tr>
<td>2009-10</td>
<td>Christmas Storage</td>
<td>5</td>
</tr>
<tr>
<td>2009-10</td>
<td>DVDs</td>
<td>981</td>
</tr>
<tr>
<td>2009-10</td>
<td>JP Basement Storage</td>
<td>56</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Easy Readers</td>
<td>152</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Fiction</td>
<td>476</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Non-Fiction</td>
<td>199</td>
</tr>
<tr>
<td>2009-10</td>
<td>Juvenile Picture Books</td>
<td>634</td>
</tr>
<tr>
<td>2009-10</td>
<td>Large Print</td>
<td>73</td>
</tr>
<tr>
<td>2009-10</td>
<td>Literacy Collection</td>
<td>4</td>
</tr>
<tr>
<td>2009-10</td>
<td>Multilingual Collection</td>
<td>32</td>
</tr>
<tr>
<td>2009-10</td>
<td>Multilingual, Juvenile French</td>
<td>22</td>
</tr>
</tbody>
</table>
Chapter 139. Cloning Shared Templates

This chapter describes how to make local copies of shared templates for routine reports or as a starting point for customization. When creating a new template it is a good idea to review the shared templates first: even if the exact template you need does not exist it is often faster to modify an existing template than to build a brand new one. A Local System Administrator account is required to clone templates from the Shared Folders section and save them to My Folders.

The steps below assume you have already created at least one Templates folder. If you haven’t done this, please see Creating Folders.

1. Access the reports interface from Administration → Reports

2. Under Shared Folders expand the Templates folder and the subfolder of the report you wish to clone. To expand the folders click on the grey arrow or folder icon. Do not click on the blue underlined hyperlink.

3. Click on the subfolder.

4. Select the template you wish to clone. From the dropdown menu choose Clone selected templates, then click Submit.

By default Evergreen only displays the first 10 items in any folder. To view all content, change the Limit output setting from 10 to All.

5. Choose the folder where you want to save the cloned template, then click Select Folder. Only template folders created with your account will be visible. If there are no folders to choose from please see Creating Folders.

6. The cloned template opens in the template editor. From here you may modify the template by adding, removing, or editing fields and filters as described in Creating Templates. Template Name and Description can also be edited. When satisfied with your changes click Save.

7. Click OK in the resulting confirmation windows.

Once saved it is not possible to edit a template. To make changes, clone a template and change the clone.
Chapter 140. Adding Data Sources to Reporter

You can further customize your Evergreen reporting environment by adding additional data sources.

The Evergreen reporter module does not build and execute SQL queries directly, but instead uses a data abstraction layer called Fieldmapper to mediate queries on the Evergreen database. Fieldmapper is also used by other core Evergreen DAO services, including cstore and permacrud. The configuration file fm_IDL.xml contains the mapping between Fieldmapper class definitions and the database. The fm_IDL.xml file is located in the /openils/conf directory.

There are 3 basic steps to adding a new data source. Each step will be discussed in more detail in the

1. Create a PostgreSQL query, view, or table that will provide the data for your data source.
2. Add a new class to fm_IDL.xml for your data source.
3. Restart the affected services to see the new data source in Reporter.

There are two possible sources for new data sources:

• An SQL query built directly into the class definition in fm_IDL.xml. You can use this method if you are only going to access this data source through the Evergreen reporter and/or cstore code that you write.

• A new table or view in the Evergreen PostgreSQL database on which a class definition in fm_IDL.xml. You can use this method if you want to be able to access this data source through directly through SQL or using other reporting tool.

Create a PostgreSQL query, view, or table for your data source

You need to decide whether you will create your data source as a query, a view, or a table.

1. Create a query if you are planning to access this data source only through the Evergreen reporter and/or cstore code that you write. You will use this query to create an IDL only view.
2. Create a view if you are planning to access this data source through other methods in addition to the Evergreen reporter, or if you may need to do performance tuning to optimize your query.

3. You may also need to use an additional table as part of your data source if you have additional data that’s not included in the base Evergreen, or if you need to use a table to store the results of a query for performance reasons.

To develop and test queries, views, and tables, you will need

- Access to the Evergreen PostgreSQL database at the command line. This is normally the psql application. You can access the Postgres documentation at the Official Postgres documentation for more information about PostgreSQL.

- Knowledge of the Evergreen database structure for the data that you want to access. You can find this information by looking at the Evergreen schema Evergreen schema

If the views that you are creating are purely local in usage and are not intended for contribution to the core Evergreen code, create the Views and Tables in the extend_reporter schema. This schema is intended to be used for local customizations and will not be modified during upgrades to the Evergreen system.

You should make sure that you have an appropriate version control process for the SQL used to create your data sources.

Here’s an example of a view created to incorporate some locally defined user statistical categories:

element view for reports.

```sql
create view extend_reporter.patronstats as
select u.id,
grp.name as "ptype",
rl.stat_cat_entry as "reg_lib",
gr.stat_cat_entry as "gender",
ag.stat_cat_entry as "age_group",
EXTRACT(YEAR FROM age(u.dob)) as "age",
hl.id as "home_lib",
u.create_date,
u.expire_date,
ms_balance_owed
from actor.usr u
join permission.grp_tree grp
  on (u.profile = grp.id and (grp.parent = 2 or grp.name = 'patron'))
join actor.org_unit hl on (u.home_ou = hl.id)
left join money.open_usr_summary ms
  on (ms.usr = u.id)
left join actor.stat_cat_entry_usr_map rl
  on (u.id = rl.target_usr and rl.stat_cat = 4)
left join actor.stat_cat_entry_usr_map bt
  on (u.id = bt.target_usr and bt.stat_cat = 3)
left join actor.stat_cat_entry_usr_map gr
  on (u.id = gr.target_usr and gr.stat_cat = 3)
left join actor.stat_cat_entry_usr_map gr
  on (u.id = gr.target_usr and gr.stat_cat = 2)
left join actor.stat_cat_entry_usr_map ag
  on (u.id = ag.target_usr and ag.stat_cat = 1)
where u.active = 't' and u.deleted <> 't';
```
Add a new class to fm_IDL.xml for your data source

Once you have your data source, the next step is to add that data source as a new class in fm_IDL.xml.

You will need to add the following attributes for the class definition:

- id. You should follow a consistent naming convention for your class names that won’t create conflicts in the future with any standard classes added in future upgrades. Evergreen normally names each class with the first letter of each word in the schema and table names. You may want to add a local prefix or suffix to your local class names.

- controller=“open-ils.cstore”

- oils_obj:fieldmapper="extend_reporter::long_name_of_view”

- oils_persist.readonly="true”

- reporter:core="true” (if you want this to show up as a “core” reporting source)

- reporter:label. This is the name that will appear on the data source list in the Evergreen reporter.

- oils_persist:source_definition. If this is an IDL-only view, add the SQL query here. You don’t need this attribute if your class is based on a PostgreSQL view or table.

- oils_persist:tablename="schemaname.viewname or tablename" If this class is based on a PostgreSQL view or table, add the table name here. You don’t need this attribute is your class is an IDL-only view.

For each column in the view or query output, add field element and set the following attributes. The fields should be wrapped with <field> </field>:

- reporter:label. This is the name that appears in the Evergreen reporter.

- name. This should match the column name in the view or query output.

- reporter:datatype (which can be id, bool, money, org_unit, int, number, interval, float, text, timestamp, or link)

For each linking field, add a link element with the following attributes. The elements should be wrapped with <link> </link>:

- field (should match field.name)

- reltype (“has_a”, “might_have”, or “has_many”)

- map (““)

- key (name of the linking field in the foreign table)
• class (ID of the IDL class of the table that is to be linked to)

The following example is a class definition for the example view that was created in the previous section.

eample class definition for reports.

```xml
<class id="erpstats" controller="open-ils.reporter-store"
    oils_obj:fieldmapper="extend_reporter::patronstats"
    oils_persist:tablename="extend_reporter.patronstats" oils_persist:readonly="true"
    reporter:label="Patron Statistics" reporter:core="true">
    <fields oils_persist:primary="id">
        <field reporter:label="Patron ID" name="id" reporter:datatype="link" />
        <field reporter:label="Patron Type" name="ptype" reporter:datatype="text" />
        <field reporter:label="Reg Lib" name="reg_lib" reporter:datatype="text" />
        <field reporter:label="Boro/Twp" name="boro_twp" reporter:datatype="text" />
        <field reporter:label="Gender" name="gender" reporter:datatype="text" />
        <field reporter:label="Age Group" name="age_group" reporter:datatype="text" />
        <field reporter:label="Age" name="age" reporter:datatype="int" />
        <field reporter:label="Home Lib ID" name="home_lib_id"
            reporter:datatype="link" />
        <field reporter:label="Home Lib Code" name="home_lib_code"
            reporter:datatype="text" />
        <field reporter:label="Home Lib" name="home_lib"
            reporter:datatype="text" />
        <field reporter:label="Create Date" name="create_date"
            reporter:datatype="timestamp" />
        <field reporter:label="Expire Date" name="expire_date"
            reporter:datatype="timestamp" />
        <field reporter:label="Balance Owed" name="balance_owed"
            reporter:datatype="money" />
    </fields>
    <links>
        <link field="id" reltype="has_a" key="id" map="" class="au"/>
        <link field="home_lib_id" reltype="has_a" key="id" map="" class="aou"/>
    </links>
</class>
```

fm_IDL.xml is used by other core Evergreen DAO services, including cstore and permacrud. So changes to this file can affect the entire Evergreen application, not just reporter. After making changes fm_IDL.xml, it is a good idea to ensure that it is valid XML by using a utility such as xmllint – a syntax error can render much of Evergreen nonfunctional. Set up a good change control system for any changes to fm_IDL.xml. You will need to keep a separate copy of your local class definitions so that you can reapply the changes to fm_IDL.xml after Evergreen upgrades.

**Restart the affected services to see the new data source in the reporter**

The following steps are needed to for Evergreen to recognize the changes to fm_IDL.xml

1. Copy the updated fm_IDL.xml into place:
   ```bash
   cp fm_IDL.xml /openils/conf/.
   ```

2. (Optional) Make the reporter version of fm_IDL.xml match the core version. Evergreen systems supporting only one interface language will normally find that /openils/var/web/reports/
fm_IDL.xml is a symbolic link pointing to /openils/conf/fm_IDL.xml, so no action will be required. However, systems supporting multiple interfaces will have a different version of fm_IDL.xml in the /openils/var/web/reports directory. The right way to update this is to go through the Evergreen internationalization build process to create the entity form of fm_IDL.xml and the updated fm_IDL.dtd files for each supported language. However, that is outside the scope of this document. If you can accept the reporter interface supporting only one language, then you can simply copy your updated version of fm_IDL.xml into the /openils/var/web/reports directory:

\texttt{cp \{openils\}/conf/fm\_IDL.xml \{openils\}/var/web/reports/}.

3. As the opensrf user, run Autogen to update the Javascript versions of the fieldmapper definitions.

\texttt{/openils/bin/autogen.sh}

4. As the opensrf user, restart services:

\texttt{osrf\_control --localhost --restart\_services}

5. As the root user, restart the Apache web server:

\texttt{service apache2 restart}

6. As the opensrf user, restart the Evergreen reporter. You may need to modify this command depending on your system configuration and PID path:

\texttt{opensrf\_perl.pl -l -action restart -service open-ils.reporter -config \{openils\}/conf/opensrf\_core.xml -pid\_dir \{openils\}/var/run}

7. Restart the Evergreen staff client, or use Admin $\rightarrow$ For Developers $\rightarrow$ Clear Cache
Chapter 141. Running Recurring Reports

Recurring reports are a useful way to save time by scheduling reports that you run on a regular basis, such as monthly circulation and monthly patron registration statistics. When you have set up a report to run on a monthly basis you’ll get an email informing you that the report has successfully run. You can click on a link in the email that will take you directly to the report output. You can also access the output through the reporter interface as described in Viewing Report Output.

To set up a monthly recurring report follow the procedure in Generating Reports from Templates but make the changes described below.

1. Select the Recurring Report check-box and set the recurrence interval to 1 month.
2. Do not select Run ASAP. Instead schedule the report to run early on the first day of the next month. Enter the date in YYYY-MM-DD format.
3. Ensure there is an email address to receive completion emails. You will receive an email completion notice each month when the output is ready.
4. Select a folder for the report’s output.
5. Click Save Report.
6. You will get a confirmation dialogue box that the Action Succeeded. Click OK.

You will get an email on the 1st of each month with a link to the report output. By clicking this link it will open the output in a web browser. It is still possible to login to the staff client and access the output in Output folder.

How to stop or make changes to an existing recurring report? Sometimes you may wish to stop or make changes to a recurring report, e.g. the recurrence interval, generation date, email address to receive completion email, output format/folder or even filter values (such as the number of days overdue). You will need to delete the current report from the report folder, then use the above procedure to set up a new recurring report with the desired changes. Please note that deleting a report also deletes all output associated with it.

Once you have been on Evergreen for a year, you could set up your recurring monthly reports to show comparative data from one year ago. To do this select relative dates of 1 month ago and 13 months ago.
Chapter 142. Template Terminology

Data Types

The information in Evergreen’s database can be classified in nine data types, formats that describe the type of data and/or its use. These were represented by text-only labels in prior versions of Evergreen. Evergreen 3.0 has replaced the text labels with icons. When building templates in Reports, you will find these icons in the Field Name Pane of the template creation interface.

timestamp

An exact date and time (year, month, day, hour, minutes, and seconds). Remember to select the appropriate date/time transform. Raw Data includes second and timezone information, which is usually more than is required for a report.

link

A link to another database table. Link outputs a number that is a meaningful reference for the database but not of much use to a human user. You will usually want to drill further down the tree in the Sources pane and select fields from the linked table. However, in some instances you might want to use a link field. For example, to count the number of patrons who borrowed items you could do a count on the Patron link data.

text

A field of text. You will usually want to use the Raw Data transform.

bool

A field that contains boolean values (true or false)
True or False. Commonly used to filter out deleted item or patron records.

**org_unit**

Organizational Unit - a number representing a library, library system, or federation. When you want to filter on a library, make sure that the field name is on an org_unit or id data type.

**id**

A unique number assigned by the database to identify each record. These numbers are meaningful references for the database but not of much use to a human user. Use in displayed fields when counting records or in filters.

**money**

A monetary amount.

**int**

Integer (a number)

**interval**

A period of time.

Field Transforms
A Field Transform tells the reporter how to process a field for output. Different data types have different transform options.

Raw Data. To display a field exactly as it appears in the database use the Raw Data transform, available for all data types.

Count and Count Distinct. These transforms apply to the id data type and are used to count database records (e.g. for circulation statistics). Use Count to tally the total number of records. Use Count Distinct to count the number of unique records, removing duplicates.

To demonstrate the difference between Count and Count Distinct, consider an example where you want to know the number of active patrons in a given month, where "active" means they borrowed at least one item. Each circulation is linked to a Patron ID, a number identifying the patron who borrowed the item. If we use the Count Distinct transform for Patron IDs we will know the number of unique patrons who circulated at least one book (2 patrons in the table below). If instead, we use Count, we will know how many books were circulated, since every circulation is linked to a patron ID and duplicate values are also counted. To identify the number of active patrons in this example the Count Distinct transform should be used.

<table>
<thead>
<tr>
<th>Title</th>
<th>Patron ID</th>
<th>Patron Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Harry Potter and the Chamber of Secrets</td>
<td>001</td>
<td>John Doe</td>
</tr>
<tr>
<td>Northern Lights</td>
<td>001</td>
<td>John Doe</td>
</tr>
<tr>
<td>Harry Potter and the Philosopher’s Stone</td>
<td>222</td>
<td>Jane Doe</td>
</tr>
</tbody>
</table>

Output Type. Note that each transform has either an Aggregate or Non-Aggregate output type.

Selecting a Non-Aggregate output type will return one row of output in your report for each row in the database. Selecting an Aggregate output type will group together several rows of the database and return just one row of output with, say, the average value or the total count for that group. Other common aggregate types include minimum, maximum, and sum.

When used as filters, non-aggregate and aggregate types correspond to Base and Aggregate filters respectively. To see the difference between a base filter and an aggregate filter, imagine that you are creating a report to count the number of circulations in January. This would require a base filter to specify the month of interest because the month is a non-aggregate output type. Now imagine that you wish to list all items with more than 25 holds. This would require an aggregate filter on the number of holds per item because you must use an aggregate output type to count the holds.
Chapter 143. Template Enhancements

Documentation URL

You can add a link to local documentation that can help staff create a report template. To add documentation to a report template, click Admin → Local Administration → Reports, and create a new report template. A new field, Documentation URL, appears in the Template Configuration panel. Enter a URL that points to relevant documentation.

The link to this documentation will also appear in your list of report templates.

Field Hints

Descriptive information about fields or filters in a report template can be added to the Field Hints portion of the Template Configuration panel. For example, a circulation report template might include the field, Circ ID. You can add content to the Field hints to further define this field for staff and provide a reminder about the type of information that they should select for this field.

To view a field hint, click the Column Picker, and select Field Hint. The column will be added to the display.
To add or edit a field hint, select a filter or field, and click Change Field Hint. Enter text, and click Ok.
Chapter 144. Exporting Report Templates Using phpPgAdmin

Once the data is exported, Database Administrators/Systems Administrators can easily import this data into the templates folder to make it available in the client.

Dump the Entire Reports Template Table

The data exported in this method can create issues importing into a different system if you do not have a matching folder and owner. This is going to export report templates created in your system. The most important fields for importing into the new system are name, description, and data. Data defines the actual structure of the report. The owner and folder fields will unique to the system they were exported from and will have to be altered to ensure they match the appropriate owner and folder information for the new system.

1. Go to the Reporter schema. Report templates are located in the Template table.

2. Click on the link to the Template table.

3. Click the export button at the top right of the phpPgAdmin screen.

4. Make sure the following is selected:
   a. Data Only (checked)
   b. Format: Select CSV or Tabbed did get the data in a text format
   c. Download checked

5. Click export button at the bottom.

6. A text file will download to your local system.

Dump Data with an SQL Statement

The following statement could be used to grab the data in the folder and dump it with admin account as the owner and the first folder in your system.

```
SELECT 1 as owner, name, description, data, 1 as folder FROM reporter.template
```

or use the following to capture your folder names for export:

```
SELECT 1 as owner, t.name, t.description, t.data, f.name as folder
FROM reporter.template t
JOIN reporter.template_folder f ON t.folder=f.id
```

1. Run the above query.
2. Click the download link at the bottom of the page
3. Select the file format (CSV or Tabbed)
4. Check download
5. A text file with the report template data will be downloaded.
Part XIII. Using the Public Access Catalog
Table of Contents

145. Introduction .................................................................................................................. 751
146. Using the Public Access Catalog ................................................................................ 752
    Basic Search .................................................................................................................... 752
    Formats ............................................................................................................................. 752
    Advanced Search ............................................................................................................. 754
    Sort Results .................................................................................................................... 754
    Search Library ................................................................................................................ 754
    Limit to Available .......................................................................................................... 754
    Exclude Electronic Resources ....................................................................................... 754
    Search Filter ................................................................................................................... 755
    Numeric Search .............................................................................................................. 756
    Expert Search ................................................................................................................ 756
    Boolean operators .......................................................................................................... 757
    Search Tips ...................................................................................................................... 757
    Search Methodology ....................................................................................................... 758
    Stemming ......................................................................................................................... 759
    Order of Results .............................................................................................................. 759
    Search Results ................................................................................................................ 759
    Facets: Subjects, Authors, and Series ........................................................................... 760
    Availability ...................................................................................................................... 761
    Viewing a record .............................................................................................................. 762
    Details ............................................................................................................................... 763
    Placing Holds .................................................................................................................. 764
    Permalink .......................................................................................................................... 765
    SMS Call Number ......................................................................................................... 765
    Going back ....................................................................................................................... 766

147. My Lists ........................................................................................................................... 768
    Create New Lists ........................................................................................................... 768
    Local Call Number in My Lists ...................................................................................... 770
    My Lists Preferences ..................................................................................................... 771

148. Kids OPAC ...................................................................................................................... 772
    Introduction ...................................................................................................................... 772
    Choose a Skin .................................................................................................................. 772
    Search the Catalog ......................................................................................................... 773
    Place a Hold ...................................................................................................................... 777
    Save Items to a List ......................................................................................................... 780
    Third Party Content ....................................................................................................... 782
    Configuration Files ......................................................................................................... 784

149. Catalog Browse .............................................................................................................. 785

150. Bibliographic Search Enhancements ........................................................................... 786
    Use the Catalog to Retrieve Records with Specified Date Ranges: .............................. 786
        Search by Create Date or Range .............................................................................. 786
        Search by Edit Date or Range ............................................................................... 786
        Search by Deleted Status ...................................................................................... 787
    Use a Feed to Retrieve Records with Specified Date Ranges: .................................. 787

151. Binary MARC21 Feeds ................................................................................................. 788

152. TPAC Metarecord Search and Metarecord Level Holds ............................................ 789

153. Library Information Pages ........................................................................................... 794

154. Adding Evergreen Search to Web Browsers .............................................................. 795
    Adding OpenSearch to Firefox browser ....................................................................... 795

155. Adding an Evergreen search form to a web page ....................................................... 797
Chapter 145. Introduction

Evergreen has a public OPAC that meets WCAG guidelines (http://www.w3.org/WAI/intro/wcag), which helps make the OPAC accessible to users with a range of disabilities. This part of the documentation explains how to use the Evergreen public OPAC. It covers the basic catalog and more advanced search topics. It also describes the “My Account” tools users have to find information and manage their personal library accounts through the OPAC. This section could be used by staff and patrons but would be more useful for staff as a generic reference when developing custom guides and tutorials for their users.
Chapter 146. Using the Public Access Catalog

Basic Search

From the OPAC home, you can conduct a basic search of all materials owned by all libraries in your Evergreen system.

This search can be as simple as typing keywords into the search box and clicking the Search button. Or you can make your search more precise by limiting your search by fields to search, material type or library location.

The Homepage contains a single search box for you to enter search terms. You can get to the Homepage at any time by clicking the Another Search link from the leftmost link on the bar above your search results in the catalogue, or you can enter a search anywhere you see a search box.

You can select to search by:

- **Keyword**: finds the terms you enter anywhere in the entire record for an item, including title, author, subject, and other information.
- **Title**: finds the terms you enter in the title of an item.
- **Journal Title**: finds the terms you enter in the title of a serial bib record.
- **Author**: finds the terms you enter in the author of an item.
- **Subject**: finds the terms you enter in the subject of an item. Subjects are categories assigned to items according to a system such as the Library of Congress Subject Headings.
- **Series**: finds the terms you enter in the title of a multi-part series.

To search an item copy call number, use [Advanced Search: Numeric](#).

Formats

You can limit your search by formats based on MARC fixed field type:
• All Books
• All Music
• Audiocassette music recording
• Blu-ray
• Braille
• Cassette audiobook
• CD Audiobook
• CD Music recording
• DVD
• E-audio
• E-book
• E-video
• Equipment, games, toys
• Kit
• Large Print Book
• Map
• Microform
• Music Score
• Phonograph music recording
• Phonograph spoken recording
• Picture
• Serials and magazines
• Software and video games
• VHS

Libraries

If you are using a catalogue in a library or accessing a library’s online catalogue from its homepage, the search will return items for your local library. If your library has multiple branches, the result will display items available at your branch and all branches of your library system separately.
Advanced Search

Advanced searches allow users to perform more complex searches by providing more options. Many kinds of searches can be performed from the Advanced Search screen. You can access by clicking Advanced Search on the catalogue Homepage or search results screen.

The available search options are the same as on the basic search. But you may use one or many of them simultaneously. If you want to combine more than three search options, use Add Search Row button to add more search input rows. Clicking the X button will close the search input row.

Sort Results

By default, the search results are in order of greatest to least relevance, see Order of Results. In the sort results menu you may select to order the search results by relevance, title, author, or publication date.

Search Library

The current search library is displayed under Search Library drop down menu. By default it is your library. The search returns results for your local library only. If your library system has multiple branches, use the Search Library box to select different branches or the whole library system.

Limit to Available

This checkbox is at the bottom line of Search Library. Select Limit to Available to limit results to those titles that have items with a circulation status of "available" (by default, either Available or Reshelving).

Exclude Electronic Resources

This checkbox is below Limit to Available. Select Exclude Electronic Resources to limit results to those bibliographic records that do not have an "o" or "s" in the Item Form fixed field (electronic forms) and overrides other form limiters.

This feature is optional and will not appear for patrons or staff until enabled.

To display the Exclude Electronic Resources checkbox in the advance search page and search results, set the ctx.exclude_electronic_checkbox setting in config.tt2 to 1.
Search Filter

You can filter your search by Item Type, Item Form, Language, Audience, Video Format, Bib Level, Literary Form, Search Library, and Publication Year. Publication year is inclusive. For example, if you set Publication Year Between 2005 and 2007, your results can include items published in 2005, 2006 and 2007.

For each filter type, you may select multiple criteria by holding down the CTRL key as you click on the options. If nothing is selected for a filter, the search will return results as though all options are selected.

Search Filter Enhancements

Enhancements to the Search Filters now makes it easier to view, remove, and modify search filters while viewing search results in the Evergreen OPAC. Filters that are selected while conducting an advanced search in the Evergreen OPAC now appear below the search box in the search results interface.

For example, the screenshot below shows a Keyword search for "violin concerto" while filtering on Item Type: Musical sound recording and Shelving Location: Music.
In the search results, the Item Type and Shelving Location filters appear directly below the search box.

Each filter can be removed by clicking the X next to the filter name to modify the search within the search results screen. Below the search box on the search results screen, there is also a link to Refine My Original Search, which will bring the user back to the advanced search screen where the original search parameters selected can be viewed and modified.

**Numeric Search**

If you have details on the exact item you wish to search for, use the Numeric Search tab on the advanced search page. Use the drop-down menu to select your search by ISBN, ISSN, Bib Call Number, Call Number (Shelf Browse), LCCN, TCN, or Item Barcode. Enter the information and then click the Search button.

**Expert Search**

If you are familiar with MARC cataloging, you may search by MARC tag in the Expert Search option on the left of the screen. Enter the three-digit tag number, the subfield if relevant, and the value or
text that corresponds to the tag. For example, to search by publisher name, enter 260 b Random House. To search several tags simultaneously, use the Add Row option. Click Submit to run the search.

Use the MARC Expert Search only as a last resort, as it can take much longer to retrieve results than by using indexed fields. For example, rather than running an expert search for "245 a Gone with the wind", simply do a regular title search for "Gone with the wind".

Boolean operators

Classic search interfaces (that is, those used primarily by librarians) forced users to learn the art of crafting search phrases with Boolean operators. To a large extent this was due to the inability of those systems to provide relevancy ranking beyond a "last in, first out" approach. Thankfully, Evergreen, like most modern search systems, supports a rather sophisticated relevancy ranking system that removes the need for Boolean operators in most cases.

By default, all terms that have been entered in a search query are joined with an implicit **AND** operator. Those terms are required to appear in the designated fields to produce a matching record: a search for golden compass will search for entries that contain both golden and compass.

Words that are often considered Boolean operators, such as **AND**, **OR**, and **NOT**, are not special in Evergreen: they are treated as just another search term. For example, a title search for golden and compass will not return the title Golden Compass.

However, Evergreen does support Boolean searching for those rare cases where you might require it, using symbolic operators as follows:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbol</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>&amp;&amp;</td>
<td>a &amp;&amp; b</td>
</tr>
<tr>
<td>OR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOT</td>
<td>-term</td>
<td>a -b</td>
</tr>
</tbody>
</table>

**Search Tips**

Evergreen tries to approach search from the perspective of a major search engine: the user should simply be able to enter the terms they are looking for as a general keyword search, and Evergreen should return results that are most relevant given those terms. For example, you do not need to enter author’s last name first, nor do you need to enter an exact title or subject heading. Evergreen
is also forgiving about plurals and alternate verb endings, so if you enter dogs, Evergreen will also find items with dog.

The search engine has no stop words (terms are ignored by the search engine): a title search for **to be or not to be** (in any order) yields a list of titles with those words.

- Don’t worry about white space, exact punctuation, or capitalization.

1. White spaces before or after a word are ignored. So, a search for `[ golden compass ]` gives the same results as a search for `[golden compass]`.

2. A double dash or a colon between words is reduced to a blank space. So, a title search for `golden:compass` or `golden — compass` is equivalent to `golden compass`.

3. Punctuation marks occurring within a word are removed; the exception is _. So, a title search for `gol_den com_pass` gives no result.

4. Diacritical marks and solitary & or | characters located anywhere in the search term are removed. Words or letters linked together by . (dot) are joined together without the dot. So, a search for `go|l|den & comp.ass` is equivalent to `golden compass`.

5. Upper and lower case letters are equivalent. So, Golden Compass is the same as golden compass.

- Enter your search words in any order. So, a search for compass golden gives the same results as a search for golden compass. Adding more search words gives fewer but more specific results.

  - This is also true for author searches. Both David Suzuki and Suzuki, David will return results for the same author.

- Use specific search terms. Evergreen will search for the words you specify, not the meanings, so choose search terms that are likely to appear in an item description. For example, the search luxury hotels will produce more relevant results than nice places to stay.

- Search for an exact phrase using double-quotes. For example “golden compass”.

  - The order of words is important for an exact phrase search. golden compass is different than compass golden.

  - White space, punctuation and capitalization are removed from exact phrases as described above. So a phrase retains its search terms and its relative order, but not special characters and not case.

  - Two phrases are joined by and, so a search for "golden compass" "dark materials" is equivalent to golden compass and dark materials.

- Truncation Words may be right-hand truncated using an asterisk. Use a single asterisk * to truncate any number of characters. (example: environment* agency)

**Search Methodology**
Stemming

A search for dogs will also return hits with the word dog and a search for parenting will return results with the words parent and parental. This is because the search uses stemming to help return the most relevant results. That is, words are reduced to their stem (or root word) before the search is performed.

The stemming algorithm relies on common English language patterns - like verbs ending in ing - to find the stems. This is more efficient than looking up each search term in a dictionary and usually produces desirable results. However, it also means the search will sometimes reduce a word to an incorrect stem and cause unexpected results. To prevent a word or phrase from stemming, put it in double-quotes to force an exact search. For example, a search for parenting will also return results for parental, but a search for "parenting" will not.

Understanding how stemming works can help you to create more relevant searches, but it is usually best not to anticipate how a search term will be stemmed. For example, searching for gold compass does not return the same results as golden compass, because -en is not a regular suffix in English, and therefore the stemming algorithm does not recognize gold as a stem of golden.

Order of Results

By default, the results are listed in order of relevance, similar to a search engine like Google. The relevance is determined using a number of factors, including how often and where the search terms appear in the item description, and whether the search terms are part of the title, subject, author, or series. The results which best match your search are returned first rather than results appearing in alphabetical or chronological order.

In the Advanced Search screen, you may select to order the search results by relevance, title, author, or publication date before you start the search. You can also re-order your search results using the Sort Results dropdown list on the search result screen.

Search Results

The search results are a list of relevant works from the catalogue. If there are many results, they are divided into several pages. At the top of the list, you can see the total number of results and go back and forth between the pages by clicking the links that say Previous or Next on top or bottom of the list. You can also click on the adjacent results page number listed. These page number links allow you to skip to that results page, if your search results needed multiple pages to display. Here is an example:
Brief information about the title, such as author, edition, publication date, etc. is displayed under each title. The icons beside the brief information indicate formats such as books, audio books, video recordings, and other formats. If you hover your mouse over the icon, a text explanation will show up in a small pop-up box.

Clicking a title goes to the title details. Clicking an author searches all works by the author. If you want to place a hold on the title, click Place Hold beside the format icons.

On the top right, there is a Limit to Available checkbox. Checking this box will filter out those titles with no available copies in the library or libraries at the moment. Usually you will see your search results are re-displayed with fewer titles.

When enabled, under the Limit to Available checkbox, there is an Exclude Electronic Resources checkbox. Checking this box will filter out materials that are cataloged as electronic in form.

The Sort by dropdown list is found at the top of the search results, beside the Show More Details link. Clicking an entry on the list will re-sort your search results accordingly.

**Facets: Subjects, Authors, and Series**

At the left, you may see a list of Facets of Subjects, Authors, and Series. Selecting any one of these links filters your current search results using that subject, author, or series to narrow down your current results. The facet filters can be undone by clicking the link a second time, thus returning your original results before the facet was activated.
Availability

The number of available copies and total copies are displayed under each search result’s call number. If you are using a catalogue inside a library or accessing a library’s online catalogue from its homepage, you will see how many copies are available in the library under each title, too. If the library belongs to a multi-branch library system you will see an extra row under each title showing how many copies are available in all branches.
You may also click the Show More Details link at the top of the results page, next to the Limit to available items check box, to view each search result’s copies' individual call number, status, and shelving location.

**Viewing a record**

Click on a search result’s title to view a detailed record of the title, including descriptive information, location and availability, current holds, and options for placing holds, add to my list, and print/email.
The record shows details such as the cover image, title, author, publication information, and an abstract or summary, if available.

Near the top of the record, users can easily see the number of copies that are currently available in the system and how many current holds are on the title.

If there are other formats and editions of the same work in the database, links to those alternate formats will display. The formats used in this section are based on the configurable catalog icon formats.
The Record Details view shows how many copies are at the library or libraries you have selected, and whether they are available or checked out. It also displays the Call number and Copy Location for locating the item on the shelves. Clicking on Text beside the call number will allow you to send the item’s call number by text message, if desired. Clicking the location library link will reveal information about owning library, such as address and open hours.

Below the local details you can open up various tabs to display more information. You can select Reviews and More to see the book’s summaries and reviews, if available. You can select Shelf Browser to view items appearing near the current item on the library shelves. Often this is a good way to browse for similar items. You can select MARC Record to display the record in MARC format. If your library offers the service, clicking on Awards, Reviews, and Suggested Reads will reveal that additional information.

Copies are sorted by (in order): org unit, call number, part label, copy number, and barcode.

**Placing Holds**

Holds can be placed on either title results or search results page. If the item is available, it will be pulled from the shelf and held for you. If all copies at your local library are checked out, you will be placed on a waiting list and you will be notified when items become available.

On title details page, you can select the Place Hold link in the upper right corner of the record to reserve the item. You will need your library account user name and password. You may choose to be notified by phone or email.

In the example below, the phone number in your account will automatically show up. Once you select the Enable phone notifications for this hold checkbox, you can supply a different phone number for this hold only. The notification method will be selected automatically if you have set it up in your account references. But you still have a chance to re-select on this screen. You may also suspend the hold temporarily by checking the Suspend box. Click the Help beside it for details.

You can view and cancel a hold at anytime. Before your hold is captured, which means an item has been held waiting for you to pick up, you can edit, suspend or activate it. You need log into your
patron account to do it. From your account you can also set up a Cancel if not filled by date for your hold. Cancel if not filled by date means after this date, even though your hold has not been fulfilled you do not need the item anymore.

### Place Hold

Harry Potter and the goblet of fire / by J.K. Rowling ; illustrations by Mary GrandPré.

**Pickup location:** Example Branch 1

**Notify when hold is ready for pickup?**

- [x] Yes, by Email
  
  Email Address: jane@yahoo.com

- [x] Yes, by Phone
  
  Phone Number: 617-123-4567

[Submit] [Cancel]

#### Permalink

The record summary page offers a link to a shorter permalink that can be used for sharing the record with others. All URL parameters are stripped from the link with the exception of the locg and copy_depth parameters. Those parameters are maintained so that people can share a link that displays just the holdings from one library/system or displays holdings from all libraries with a specific library’s holdings floating to the top.

### SMS Call Number

If configured by the library system administrator, you may send yourself the call number via SMS message by clicking on the Text link, which appears beside the call number.
### Available copies

- 26 copies at Example Consortium.

<table>
<thead>
<tr>
<th>Location</th>
<th>Call Number / Copy Notes</th>
<th>Barcode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example Branch 1</td>
<td>780 B92 (Text)</td>
<td>CONC40000628</td>
</tr>
<tr>
<td>Example Branch 1</td>
<td>780 B92 (Text)</td>
<td>CONC41000628</td>
</tr>
<tr>
<td>Example Branch 1</td>
<td>ML 2533 B34 C92 (Text)</td>
<td>CONC40000128</td>
</tr>
<tr>
<td>Example Branch 1</td>
<td>ML 2533 B34 C92 (Text)</td>
<td>CONC41000128</td>
</tr>
<tr>
<td>Example Branch 1</td>
<td>ML 2533 B34 C92 (Text)</td>
<td>CONC42000128</td>
</tr>
<tr>
<td>Example Branch 1</td>
<td>ML 2533 B34 C92 (Text)</td>
<td>CONC43000128</td>
</tr>
</tbody>
</table>

### Current holds

1 current hold with 31 total copies.

---

*Carrier charges may apply when using the SMS call number feature.*

---

### Going back

When you are viewing a specific record, you can always go back to your title list by clicking the link Search Results on the top right or left bottom of the page.
Subject: Concertos (Violin)

Search for related items by series

- Columbia Masterworks

You can start a new search at any time by entering new search terms in the search box at the top of the page, or by selecting the Another Search or Advanced Search links in the left-hand sidebar.
Chapter 147. My Lists

The My Lists feature replaces the bookbag feature that was available in versions prior to 2.2. The My Lists feature is a part of the Template Toolkit OPAC that is available in version 2.2. This feature enables you to create temporary and permanent lists; create and edit notes for items in lists; place holds on items in lists; and share lists via RSS feeds and CSV files.

There is now a direct link to My Lists from the My Account area in the top right part of the screen. This gives users the ability to quickly access their lists while logged into the catalog.

Create New Lists

1) Log in to your account in the OPAC.
2) Search for titles.
3) Choose a title to add to your list. Click Add to My List.

4. Justice denied
   Tappenbaum, Robert
   0 of 6 copies available

5. Rage of angels
   Sheridan, Sydney
   2010.
   0 of 6 copies available

6. Irresistible impulse
   Tappenbaum, Robert
   0 of 6 copies available
4) Scroll up to the gray row on top of the Search Results. Click View My List.

5) Items are added to a temporary list. Your temporary list appears at the bottom of the screen.

6) The Actions for these items menu on the right side of the screen demonstrates the actions that you can apply to this list. You can place holds on items in your temporary list; remove items from the list; or move selected items to a permanent list.

To place a hold or remove items from the list, check the box adjacent to the title of the item, and select the desired function.

To move selected items into an existing list, check the box adjacent to the title, and highlight the list in which you will store the item.

7) If you do not want to place the item into an existing list, you can create a new list to contain the item. Enter the name of the new list, and, if desired, enter a description.

8) Click Submit.

9) The new list appears beneath the temporary list.

10) Select the title(s) of the items that you want to add to the list, and click Actions for these items. Select the permanent list that you created from the drop down menu.

11) Click Go.

12) Your existing lists appear. Click on a list to view the items in the list. You can sort the items in the permanent list. You can also add, edit, and remove notes.
13) Click Edit to add or edit a note.

14) Enter desired notes, and click Save Notes.

15) You can keep your list private, or you can share it. To share your list, click Share, and click the orange RSS icon to share through an RSS reader. You can also click HTML View to share your list as an HTML link.

You can also download your list into a CSV file by clicking Download CSV.

16) When you no longer need a list, click Delete List.

**Local Call Number in My Lists**

When a title is added to a list in the TPAC, a local call number will be displayed in the list to assist patrons in locating the physical item. Evergreen will look at the following locations to identify the most relevant call number to display in the list:

1) Physical location - the physical library location where the search takes place

2) Preferred library - the Preferred Search Location, which is set in patron OPAC account Search and History Preferences, or the patron’s Home Library

3) Search library - the search library or org unit that is selected in the OPAC search interface

The call number that is displayed will be the most relevant call number to the searcher. If the patron is searching at the library, Evergreen will display a call number from that library location. If the patron is not searching at a library, but is logged in to their OPAC account, Evergreen will display a call number from their Home Library or Preferred Search Location. If the patron is not searching at the library and is not signed in to their OPAC account, then Evergreen will display a call number from the org unit, or library, that they choose to search in the OPAC search interface.

The local call number and associated library location will appear in the list:
My Lists Preferences

Patrons can adjust the number of lists or list items displayed in a page. This setting can be found under the Account Preferences tab, in the My Lists Preferences section.
Introduction

The Kids OPAC (KPAC) is a public catalog search that was designed for children and teens. Colorful menu items, large buttons, and simple navigation make this an appealing search interface for kids. Librarians will appreciate the flexible configuration of the KPAC. Librarians can create links to canned search results for kids and can apply these links by branch. The KPAC uses the same infrastructure as the Template Toolkit OPAC (TPAC), the adult catalog search, so you can easily extend the KPAC using the code that already exists in the TPAC. Finally, third party content, such as reader reviews, can be integrated into the KPAC.

Choose a Skin

Two skins, or design interfaces, have been created for the KPAC. The KPAC was designed to run multiple skins on a single web server. A consortium, then, could allow each library system to choose a skin for their patrons.

Default Skin:

In this skin, the search bar is the focal point of the top panel and is centered on the screen. The search grid appears beneath the search bar. Help and Login links appear at the top right of the interface. You can customize the appearance and position of these links with CSS. After you login, the user name is displayed in the top right corner, and the Login link becomes an option to Logout.

Alternate Monster Skin:
In this skin, the search bar shares the top panel with a playful monster. The search grid appears beneath the search bar. Help and Login links appear in bold colors at the top right of the interface although you can customize these with CSS. After you login, the Login button disappears.

Search the Catalog

You can search the catalog using only the search bar, the search grid, or the search bar and the collection drop down menu.

Search using the Search Bar

To search the catalog from the home page, enter text into the search bar in the center of the main page, or enter text into the search bar to the right of the results on a results page. Search indices are configurable, but the default search indices include author, title and (key)word.

You can use this search bar to search the entire catalog, or, using the configuration files, you can apply a filter so that search queries entered here retrieve records that meet specific criteria, such as child-friendly copy locations or MARC audience codes.

Search using the Grid

From the home page, you can search the catalog by clicking on the grid of icons. An icon search can link to an external web link or to a canned search. For example, the icon, Musical Instruments, could link to the results of a catalog search on the subject heading, Musical instruments.

The labels on the grid of icons and the content that they search are configurable by branch. You can use the grid to search the entire catalog, or, using the configuration files, you can apply a filter so that search queries entered here retrieve records associated with specific criteria, such as child-friendly copy locations or MARC audience codes.
You can add multiple layers of icons and searches to your grid:
Search using the Search Bar and the Collection Drop Down Menu

On the search results page, a search bar and drop down menu appear on the right side of the screen. You can enter a search term and into the search bar and select a collection from the drop down menu to search these configured collections. Configured collections might provide more targeted searching for your audience than a general catalog search. For example, you could create collections by shelving location or by MARC audience code.

Using any search method, the search results display in the center of the screen. Brief information displays beneath each title in the initial search result. The brief information that displays, such as title, author, or publication information, is configurable.
For full details on a title, click More Info. The full details displays the configured fields from the title record and copy information. Click Show more copies to display up to fifty results. Use the breadcrumbs at the top to trace your search history.
Place a Hold

From the search results, click the Get it! link to place a hold.
The brief information about the title appears, and, if you have not yet logged in, the Get It! panel appears with fields for username and password. Enter the username and password, and select the pick up library. Then click Submit. If you have already logged into your account, you need only to select the pick up location, and click Submit.
GET IT!

If you would like to place a hold on this item, please enter the following information and click Submit below:

Library Card Number without spaces:
98989898

Password

Choose a Pickup Library:
Algona-Pacific

Submit

A confirmation of hold placement appears. You can return to the previous record or to your search results.
Save Items to a List

You can save items to a temporary list, or, if you are logged in, you can save to a list of your own creation. To save items to a list, click the Get it button on the Search Results page.

Select a list in the Save It! panel beneath the brief information, and click Submit.
A confirmation of the saved item appears. To save the item to a list or to manage the lists, click the My Lists link to return to the list management feature in the TPAC.
Third Party Content

Third party content, such as reader reviews, can be viewed in the Kids OPAC. The reviews link appears adjacent to the brief information.

Click the Reviews link to view reader reviews from a third party source. The reader reviews open beneath the brief information.
Harry Potter and the deathly hallows
by Rowling, J. K.

Close reviews
PP1YCPQN-ODXD
x, 759 p. ill. ;24 cm.

Add a review for this!

Reader rating: 4.55 out of 5 (183 reviews, 234 ratings)

Harry Potter and the deathly hallows /
Author: J. K. Rowling ; illustrations by Mary GrandPre.
Rate this item: ★★★★★

0 out of 183 users would recommend this to a friend.

★★★★★ The best one yet
By: memyselfandI
Issaquah, Washington (US)

The Deathly Hallows is by far, the best one yet. Full of action, adventure, and well timed comic relief. Loved the series so much I'm now reading it to my daughter. She's gone up 2 1/2 grade levels in reading in one year and I have to give some

Summaries and reviews from other publications appear in separate tabs beneath the copy information.
Configuration Files

Configuration files allow you to define labels for canned searches in the icon grid, determine how icons lead users to new pages, and define whether those icons are canned searches or links to external resources. Documentation describing how to use the configuration files is available in the Evergreen repository.

Chapter 148. Kids OPAC
Report errors in this documentation using Launchpad.
Chapter 149. Catalog Browse

Abstract

Catalog Browse enables you to browse bibliographic headings available in your catalog. You can click the hyperlinked bibliographic headings to retrieve catalog records that contain these headings. Also, if a given bibliographic heading is linked to an authority record, and if that authority is linked to another one via the first authority’s See and See Also tags, the additional variants of (e.g.) an author’s name will appear in your search results.

Use Catalog Browse

1. To access this feature, navigate to the catalog search page, and click the link, Browse the Catalog. By default, you can browse by title, author, subject, or series. System administrators can revise this list by editing the file at the location opac/parts/qtype_selector.tt2, and they can even make use of custom indices based on definitions in the database’s config.metabib_field table.

2. Enter a term or part of a term to browse. Evergreen will retrieve a list of bibliographic headings that match your query. Click the Back and Forward buttons to page through your results. To limit your browse results to a specific branch or copy location group, select the appropriate unit from the drop down menu, and click Go.

3. Select a link from the search results. Each linked heading displays the number of bibliographic records associated with the heading. Appropriate information from linked authority records, if any, appears below the main entry heading.

4. To return to your list of results, click the browser’s back button or Browse the Catalog. Evergreen will return you to your previous position in your list of results.

Administration

A new global flag warns users when they are entering a browse term that begins with an article. System administrators can create a regular expression to configure articles matched with specific indices that would prompt a warning for the user. By default, this setting is not enabled.

1. To enable this feature, click Administration → Server Administration → Global Flags.

2. Double click Map of search classes to regular expressions to warn user about leading articles.

3. Make changes, and click Save.
Chapter 150. Bibliographic Search Enhancements

Enhancements to the bibliographic search function enable you to search for records that were created, edited, or deleted within a date range. You can use the catalog interface or the record feed to search for records with specific date ranges.

Note that all dates should be formatted as YYYY-MM-DD and should be included in parentheses.

Use the Catalog to Retrieve Records with Specified Date Ranges:

Search by Create Date or Range

To find records that were created on or after a specific date, enter the term, create_date, and the date in the catalog search field. For example, to find records that were created on or after April 1, 2013, enter the following into the catalog search field:

create_date(2013-04-01)

To find records that were created within a specific date range, enter the term, create_date, followed by comma-separated dates in parentheses. For example, to find records that were created between April 1, 2013 and April 8, 2013, enter the following into the catalog search field:

create_date(2013-04-01,2013-04-08)

Search by Edit Date or Range

To find records that were edited on or before a specific date, enter the term, edit-date, and the date in the catalog search field. The date should be preceded by a comma. For example, to find records that were edited on or before April 1, 2013, enter the following into the catalog search field:

edit_date(,2013-04-01)

To find records that were edited on or after a specific date, enter the term, edit_date, and the date in the catalog search field. For example, to find records that were edited on or after April 1, 2013, enter the following into the catalog search field:

edit_date(2013-04-01)

To find records that were edited within a specific range, enter the term, edit_date, followed by comma-separated dates in parentheses. For example, to find records that were edited between April 1, 2013 and April 8, 2013, enter the following into the catalog search field:

edit_date(2013-04-01,2013-04-08)
Search by Deleted Status

To search for deleted records, enter in your catalog search field the term, edit_date, the date that you want to search, and the term, #deleted. For example, to find records that were deleted on or after April 1, 2013, enter the following into the catalog search field:

`edit_date(2013-04-01)#deleted`

To find records that were deleted within a specific range, enter the term, edit_date, followed by comma-separated dates in parentheses. For example, to find records that were deleted between April 1, 2013 and April 8, 2013, enter the following into the catalog search field:

`edit_date(2013-04-01,2013-04-08)#deleted`

Use a Feed to Retrieve Records with Specified Date Ranges:

You can use a feed to retrieve records that were created, edited, or deleted within specific date ranges by adding the dates to the catalog’s URL. You can do this manually, or you can write a script that would automatically retrieve this information.

To manually retrieve records that were created, edited, or deleted within a specific date, enter the terms and dates as specified above within the search terms in the URL. For example, to retrieve records created on or after April 1, 2013, enter the following in your URL:

`http://test.esilibrary.com/opac/extras/opensearch/1.1/-/html-full?searchTerms=create_date(2013-04-01)&searchClass=keyword`

To retrieve deleted records, replace the # with %23 in your URL.
Chapter 151. Binary MARC21 Feeds

Evergreen’s OpenSearch service can return search results in many formats, including HTML, MARCXML, and MODS. As of version 2.4, it can also return results in binary MARC21 format.

When making an HTTP request to an Evergreen system using the OpenSearch API, you must include the term "marc21" in the appropriate location within the URL to retrieve a feed of MARC21 records in a binary format. The following example demonstrates the appropriate form of the URL:

http://test.esilibrary.com/opac/extras/opensearch/1.1/-/marc21?searchTerms=create_date%282013-04-01%29&searchClass=keyword

You can add this term manually to the URL produced by a catalog search, or you can create a script that would retrieve this information automatically.
Chapter 152. TPAC Metarecord Search and Metarecord Level Holds

Metarecords are compilations of individual bibliographic records that represent the same work. This compilation allows for several records to be represented on a single line on the TPAC search results page, which can help to reduce result duplications.

Advanced Search Page

Selecting the Group Formats and Editions checkbox on the Advanced Search page allows the user to perform a metarecord search.

Administrators can also configure the catalog to default to a Group Formats and Editions search by enabling the relevant config.tt2 setting on the server. Setting this option will pre-select the checkbox on the Advanced Search and Search Result Pages. Users can remove the checkmark, but new searches will revert to the default search behavior.

Search Results Page

Within the Search Results page, users can also refine their searches and filter on metarecord search results by selecting the Group Formats and Editions checkbox.
The metarecord search results will display both the representative metarecord bibliographic data and the combined metarecord holdings data (if the holdings data is OPAC visible).

The number of records represented by the metarecord are displayed in parenthesis next to the title.

The formats contained within the metarecord are displayed under the title.

For the metarecord search result, the Place Hold link defaults to a metarecord level hold.

To place a metarecord level hold:
1. Click the Place Hold link.

2. Users who are not logged into their accounts will be directed to the Log in to Your Account screen, where they will enter their username and password. Users who are already logged into their accounts will be directed to the Place Hold screen.

3. Within the Place Hold screen, users can select the multiple formats and/or languages that are available.

4. Continue to enter any additional hold information (such as Pickup Location), if needed.

5. Click Submit.

**Place Hold**

*Harry Potter and the goblet of fire / by J.K. Rowling ; illustrations by Mary GrandPré.*

Selecting multiple formats will not place all of these formats on hold for the user. For example, a user cannot select CD Audiobook and Book and expect to place both the CD and book on hold at the same time. Instead, the user is implying that either the CD format or the book format is the acceptable format to fill the hold. If no format is selected, then any of the available formats may be used to fill the hold. The same holds true for selecting multiple languages.

**Advanced Hold Options**

When users place a hold on an individual bibliographic record they will see an Advanced Hold Options link within the Place Hold screen. Clicking the Advanced Hold Options link will take the users into the metarecord level hold feature, enabling them to select multiple formats and/or languages.

**Place Hold**

*Harry Potter and the goblet of fire [video recording]/ J.K. Rowling.*

[Advanced Hold Options]

**Pickup location:** Example Branch 3

Notify when hold is ready for pickup?

- [ ] Yes, by Email
  
  No configured Email address. See "My Account" for setting your Email address.

- [x] Yes, by Phone

  **Phone Number:**

**Submit**  **Cancel**
The TPAC now includes a Metarecord Constituent Records page, which displays a listing of the individual bibliographic records grouped within the metarecord. Access the Metarecord Constituent Records page by clicking on the metarecord title on the Search Results page.

This will allow the user to view the results for grouped records.
Show Holds on Bib

Within the staff client, Show Holds on Bib for a metarecord level hold will take the staff member into the Metarecord Constituent Records page.

Global Flag: OPAC Metarecord Hold Formats Attribute

To utilize the metarecord level hold feature, the Global Flag: OPAC Metarecord Hold Formats Attribute must be enabled and its value set at mr_hold_format, which is the system’s default configuration.
Chapter 153. Library Information Pages

The branch name displayed in the copy details section of the search results page, the record summary page, and the kids catalog record summary page will link to a library information page. This page is located at http://hostname/eg/opac/library/<SHORTNAME> and at http://hostname/eg/opac/library/<ID>.

Evergreen automatically generates this page based on information entered in Administration → Server Administration → Organizational Units (actor.org_unit).

The library information page displays:

• The name of the library
• Opening hours
• E-mail address
• Phone number
• Mailing address
• The branch’s parent library system

An Evergreen site can also display a link to the library’s web site on the information page.

To display a link:

1. Go to Administration → Local Administration → Library Settings Editor.
2. Edit the Library Information URL setting for the branch.

If you set the URL at the system level, that URL will be used as the link for the system and for all child branches that do not have its own URL set. Enter the URL in the following format: http://example.com/about.html.

An Evergreen site may also opt to link directly from the copy details section of the catalog to the library web site, bypassing the automatically-generated library information page. To do so:

1. Add the library’s URL to the Library Information URL setting as described above.
2. Go to Administration → Local Administration → Library Settings Editor.
3. Set the Use external "library information URL" in copy table, if available setting to true.

The library information pages publish schema.org structured data, as do parts of the OPAC bibliographic record views, which can enable search engines and other systems to better understand your libraries and their resources.
Chapter 154. Adding Evergreen Search to Web Browsers

Adding OpenSearch to Firefox browser

OpenSearch is a collection of simple formats for the sharing of search results. More information about OpenSearch can be found on their [website](#).

The following example illustrates how to add an OpenSearch source to the list of search sources in a Firefox browser:

1. Navigate to any catalog page in your Firefox browser and click on the top right box’s dropdown and select the option for Add "Example Consortium OpenSearch". The label will match the current scope.

![Add OpenSearch option](image)

2. At this point, it will add a new search option for the location the catalog is currently using. In this example, that is CONS (searching the whole consortium).

![Search option added](image)

3. Enter search terms to begin a keyword search using this source. The next image illustrates an example search for "mozart" using the sample bib record set.

![Search results](image)
4. You can select which search source to use by clicking on the dropdown picker.
Chapter 155. Adding an Evergreen search form to a web page

Introduction

To enable users to quickly search your Evergreen catalog, you can add a simple search form to any HTML page. The following code demonstrates how to create a quick search box suitable for the header of your web site:

Simple search form

```html
<form action="http://example.com/eg/opac/results" method="get" accept-charset="UTF-8">
    <input type="search" alt="Catalog Search" maxlength="200" size="20" name="query" placeholder="Search catalog for..." />
    <input type="hidden" name="qtype" value="keyword" />
    <input type="hidden" name="locg" value="4" />
    <input type="submit" value="Search" />
</form>
```

1. Replace 'example.com' with the hostname for your catalog. To link to the Kid’s OPAC instead of the TPAC, replace 'opac' with 'kpac'.
2. Replace 'keyword' with 'title', 'author', 'subject', or 'series' if you want to provide more specific searches. You can even specify 'identifier|isbn' for an ISBN search.
3. Replace '4' with the ID number of the organizational unit at which you wish to anchor your search. This is the value of the 'locg' parameter in your normal search.

Advanced search form

```html
<form role="search" id="searchForm" method="get" class="searchform" action="http://your_catalog/eg/opac/results" accept-charset="UTF-8">
    <label id="searchLabel" for="search">Search the Catalog: </label>
    <input type="search" value="" name="query" id="search" size="30">
    <label id="search_qtype_label">Type: </label>  
    <select name='qtype' id='qtype' aria-label="Select query type:">
        <option value='keyword' selected="selected">Keyword</option>
        <option value='title'>Title</option>
        <option value='jtitle'>Journal Title</option>
        <option value='author'>Author</option>
        <option value='subject'>Subject</option>
        <option value='series'>Series</option>
    </select>  
    <label id="search_itype_label">Format: </label>  
    <select id='item_type_selector' name='fi:item_type' aria-label="Select item type:">
        <option value=''>All Formats</option>
        <option value='a'>Books and Journals</option>
        <option value='i'>Nonmusical Sound Recording</option>
        <option value='j'>Musical Sound Recording</option>
        <option value='g'>Video</option>
    </select>
</form>
```
Encoding

For non English characters it is vital to set the attribute `accept-charset="UTF-8"` in the form tag (as in the examples above). If the parameter is not set, records with non English characters will not be retrieved.

Setting the document type

You can set the document types to be searched using the attribute `option value=` in the form. For the value use MARC 21 code defining the type of record (i.e. Leader, position 06).

For example, for musical recordings you could use `<option value='j'>Musical Sound Recording</option>`

Setting the library

Instead of searching the entire consortium, you can set the Library to be searched in using the attribute `option value=` in the form. For the value use Evergreen database.organization unit ID.
Part XIV. Developer Resources
### Table of Contents

#### Prerequisites
- Importing Authority Records from Command Line
- Juvenile-to-adult batch script
- marc_export: Exporting Bibliographic Records into MARC files

#### Options
- Stateless and stateful connections
- OpenSRF communication flows over XMLP
- Programming language support
- Accepting and returning more interesting data types
- Accepting and returning Evergreen objects
- Registering OpenSRF methods
- Getting under the covers with Evergreen
- Evergreen after one year: reflections on OpenSRF

#### Strengths of OpenSRF
- Weaknesses
- Summary

#### Appendix: Python client

### 157. Support Scripts

- authority_control_fields: Connecting Bibliographic and Authority records
- marc_export: Exporting Bibliographic Records into MARC files

### 158. Developing with pgTAP tests

- Setting up pgTAP on your development server
- Running pgTAP tests

### 159. Easing gently into OpenSRF

- Abstract
- Introducing OpenSRF
  - Introducing Evergreen
  - Evergreen-specific OpenSRF services
  - Evergreen after one year: reflections on OpenSRF

### 160. Updating translations using Launchpad

- Applying translations using Launchpad
- Updating the translations

---

**Part XIV. Developer Resources**
Chapter 156. Introduction

Developers can use this part to learn more about the programming languages, communication protocols and standards used in Evergreen.
Various scripts are included with Evergreen in the /openils/bin/ directory (and in the source code in Open-ILS/src/support-scripts and Open-ILS/src/extras). Some of them are used during the installation process, such as eg_db_config, while others are usually run as cron jobs for routine maintenance, such as fine_generator.pl and hold_targeter.pl. Others are useful for less frequent needs, such as the scripts for importing/exporting MARC records. You may explore these scripts and adapt them for your local needs. You are also welcome to share your improvements or ask any questions on the Evergreen IRC channel or email lists.

Here is a summary of the most commonly used scripts. The script name links to more thorough documentation, if available.

- **action_trigger_runner.pl** — Useful for creating events for specified hooks and running pending events

- **authority_authority_linker.pl** — Links reference headings in authority records to main entry headings in other authority records. Should be run at least once a day (only for changed records).

- **authority_control_fields.pl** — Links bibliographic records to the best matching authority record. Should be run at least once a day (only for changed records). You can accomplish this by running authority_control_fields.pl --days-back=1

- **autogen.sh** — Generates web files used by the OPAC, especially files related to organization unit hierarchy, fieldmapper IDL, locales selection, facet definitions, compressed JS files and related cache key

- **clark-kent.pl** — Used to start and stop the reporter (which runs scheduled reports)

- **eg_db_config** — Creates database and schema, updates config files, sets Evergreen administrator username and password

- **fine_generator.pl**

- **hold_targeter.pl**

- **marc2are.pl** — Converts authority records from MARC format to Evergreen objects suitable for importing via pg_loader.pl (or parallel_pg_loader.pl)

- **marc2bre.pl** — Converts bibliographic records from MARC format to Evergreen objects suitable for importing via pg_loader.pl (or parallel_pg_loader.pl)

- **marc2sre.pl** — Converts serial records from MARC format to Evergreen objects suitable for importing via pg_loader.pl (or parallel_pg_loader.pl)

- **marc_export** — Exports authority, bibliographic, and serial holdings records into any of these formats: USMARC, UNIMARC, XML, BRE, ARE

- **osrf_control** — Used to start, stop and send signals to OpenSRF services
authority_control_fields: Connecting Bibliographic and Authority records

This script matches headings in bibliographic records to the appropriate authority records. When it finds a match, it will add a subfield 0 to the matching bibliographic field.

Here is how the matching works:

<table>
<thead>
<tr>
<th>Bibliographic field</th>
<th>Authority field it matches</th>
<th>Subfields that it examines</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>100</td>
<td>a,b,c,d,f,g,j,k,l,n,p,q,t,u</td>
</tr>
<tr>
<td>110</td>
<td>110</td>
<td>a,b,c,d,f,g,k,l,n,p,t,u</td>
</tr>
<tr>
<td>111</td>
<td>111</td>
<td>a,c,d,e,f,g,j,k,l,n,p,t,u</td>
</tr>
<tr>
<td>130</td>
<td>130</td>
<td>a,d,f,g,h,k,l,m,n,o,p,r,s,t</td>
</tr>
<tr>
<td>600</td>
<td>100</td>
<td>a,b,c,d,f,g,h,j,k,l,m,n,o,p,q,r,s,t,v,x,y,z</td>
</tr>
<tr>
<td>610</td>
<td>110</td>
<td>a,b,c,d,f,g,h,k,l,m,n,o,p,r,s,t,v,w,x,y,z</td>
</tr>
<tr>
<td>611</td>
<td>111</td>
<td>a,c,d,e,f,g,h,j,k,l,n,p,q,s,t,v,x,y,z</td>
</tr>
<tr>
<td>630</td>
<td>130</td>
<td>a,d,f,g,h,k,l,m,n,o,p,r,s,t,v,x,y,z</td>
</tr>
<tr>
<td>648</td>
<td>148</td>
<td>a,v,x,y,z</td>
</tr>
<tr>
<td>650</td>
<td>150</td>
<td>a,b,v,x,y,z</td>
</tr>
<tr>
<td>651</td>
<td>151</td>
<td>a,v,x,y,z</td>
</tr>
<tr>
<td>655</td>
<td>155</td>
<td>a,v,x,y,z</td>
</tr>
<tr>
<td>700</td>
<td>100</td>
<td>a,b,c,d,f,g,j,k,l,n,p,q,t,u</td>
</tr>
<tr>
<td>710</td>
<td>110</td>
<td>a,b,c,d,f,g,k,l,n,p,t,u</td>
</tr>
<tr>
<td>711</td>
<td>111</td>
<td>a,c,d,e,f,g,j,k,l,n,p,q,t,u</td>
</tr>
<tr>
<td>730</td>
<td>130</td>
<td>a,d,f,g,h,j,k,m,n,o,p,r,s,t</td>
</tr>
<tr>
<td>751</td>
<td>151</td>
<td>a,v,x,y,z</td>
</tr>
<tr>
<td>800</td>
<td>100</td>
<td>a,b,c,d,e,f,g,j,k,l,n,p,q,t,u,4</td>
</tr>
<tr>
<td>830</td>
<td>130</td>
<td>a,d,f,g,h,k,l,m,n,o,p,r,s,t</td>
</tr>
</tbody>
</table>

marc_export: Exporting Bibliographic Records into MARC files
The following procedure explains how to export Evergreen bibliographic records into MARC files using the marc_export support script. All steps should be performed by the opensrf user from your Evergreen server.

Processing time for exporting records depends on several factors such as the number of records you are exporting. It is recommended that you divide the export ID files (records.txt) into a manageable number of records if you are exporting a large number of records.

1. Create a text file list of the Bibliographic record IDs you would like to export from Evergreen. One way to do this is using SQL:

```
SELECT DISTINCT bre.id FROM biblio.record_entry AS bre
 JOIN asset.call_number AS acn ON acn.record = bre.id
WHERE bre.deleted='false' and owning_lib=101 \g /home/opensrf/records.txt;
```

This query creates a file called records.txt containing a column of distinct IDs of items owned by the organizational unit with the id 101.

2. Navigate to the support-scripts folder

```
cd /home/opensrf/Evergreen-ILS*/Open-ILS/src/support-scripts/
```

3. Run marc_export, using the ID file you created in step 1 to define which files to export. The following example exports the records into MARCXML format.

```
cat /home/opensrf/records.txt | ./marc_export --store -i -c /openils/conf/opensrf_core.xml \
-x /openils/conf/fm_IDL.xml -f XML --timeout 5 > exported_files.xml
```

marc_export does not output progress as it executes.

**Options**

The marc_export support script includes several options. You can find a complete list by running `./marc_export -h`. A few key options are also listed below:

---descendants and --library

The marc_export script has two related options, --descendants and --library. Both options take one argument of an organizational unit

The --library option will export records with holdings at the specified organizational unit only. By default, this only includes physical holdings, not electronic ones (also known as located URIs).

The descendants option works much like the --library option except that it is aware of the org. tree and will export records with holdings at the specified organizational unit and all of its descendants. This is handy if you want to export the records for all of the branches of a system. You can do that by specifying this option and the system’s shortname, instead of specifying multiple --library options for each branch.
Both the --library and --descendants options can be repeated. All of the specified org. units and their descendants will be included in the output. You can also combine --library and --descendants options when necessary.

--items

The --items option will add an 852 field for every relevant item to the MARC record. This 852 field includes the following information:

<table>
<thead>
<tr>
<th>Subfield</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>$b (occurrence 1)</td>
<td>Call number owning library shortname</td>
</tr>
<tr>
<td>$b (occurrence 2)</td>
<td>Item circulating library shortname</td>
</tr>
<tr>
<td>$c</td>
<td>Shelving location</td>
</tr>
<tr>
<td>$g</td>
<td>Circulation modifier</td>
</tr>
<tr>
<td>$j</td>
<td>Call number</td>
</tr>
<tr>
<td>$k</td>
<td>Call number prefix</td>
</tr>
<tr>
<td>$m</td>
<td>Call number suffix</td>
</tr>
<tr>
<td>$p</td>
<td>Barcode</td>
</tr>
<tr>
<td>$t</td>
<td>Copy number</td>
</tr>
<tr>
<td>$x</td>
<td>Miscellaneous item information</td>
</tr>
<tr>
<td>$y</td>
<td>Price</td>
</tr>
</tbody>
</table>

--since

You can use the --since option to export records modified after a certain date and time.

--store

By default, marc_export will use the reporter storage service, which should work in most cases. But if you have a separate reporter database and you know you want to talk directly to your main production database, then you can set the --store option to cstore or storage.

--uris

The --uris option (short form: -u) allows you to export records with located URIs (i.e. electronic resources). When used by itself, it will export only records that have located URIs. When used in conjunction with --items, it will add records with located URIs but no items/copies to the output. If combined with a --library or --descendants option, this option will limit its output to those records with URIs at the designated libraries. The best way to use this option is in combination with the --items and one of the --library or --descendants options to export all of a library’s holdings both physical and electronic.

Importing Authority Records from Command Line
The major advantages of the command line approach are its speed and its convenience for system administrators who can perform bulk loads of authority records in a controlled environment. For alternate instructions, see the cataloging manual.

1. Run marc2are.pl against the authority records, specifying the user name, password, MARC type (USMARC or XML). Use STDOUT redirection to either pipe the output directly into the next command or into an output file for inspection. For example, to process a file with authority records in MARCXML format named auth_small.xml using the default user name and password, and directing the output into a file named auth.are:

```bash
cd Open-ILS/src/extras/import/
perl marc2are.pl --user admin --pass open-ils --marctype XML auth_small.xml > auth.are
```

The MARC type will default to USMARC if the --marctype option is not specified.

2. Run parallel_pg_loader.pl to generate the SQL necessary for importing the authority records into your system. This script will create files in your current directory with filenames like pg_loader-output.are.sql and pg_loader-output.sql (which runs the previous SQL file). To continue with the previous example by processing our new auth.are file:

```bash
cd Open-ILS/src/extras/import/
perl parallel_pg_loader.pl --auto are --order are auth.are
```

To save time for very large batches of records, you could simply pipe the output of marc2are.pl directly into parallel_pg_loader.pl.

3. Load the authority records from the SQL file that you generated in the last step into your Evergreen database using the psql tool. Assuming the default user name, host name, and database name for an Evergreen instance, that command looks like:

```bash
psql -U evergreen -h localhost -d evergreen -f pg_loader-output.sql
```

**Juvenile-to-adult batch script**

The batch juv_to_adult.srfsh script is responsible for toggling a patron from juvenile to adult. It should be set up as a cron job.

This script changes patrons to adult when they reach the age value set in the library setting named "Juvenile Age Threshold" (global.juvenile_age_threshold). When no library setting value is present at a given patron’s home library, the value passed in to the script will be used as a default.

**MARC Stream Importer**
The MARC Stream Importer can import authority records or bibliographic records. A single running instance of the script can import either type of record, based on the record leader.

This support script has its own configuration file, marc_stream_importer.conf, which includes settings related to logs, ports, uses, and access control.

The importer is even more flexible than the staff client import, including the following options:

- --bib-auto-overlay-exact and --auth-auto-overlay-exact: overlay/merge on exact 901c matches
- --bib-auto-overlay-1match and --auth-auto-overlay-1match: overlay/merge when exactly one match is found
- --bib-auto-overlay-best-match and --auth-auto-overlay-best-match: overlay/merge on best match
- --bib-import-no-match and --auth-import-no-match: import when no match is found

One advantage to using this tool instead of the staff client Import interface is that the MARC Stream Importer can load a group of files at once.
Chapter 158. Developing with pgTAP tests

Setting up pgTAP on your development server

Currently, Evergreen pgTAP tests expect a version of pgTAP (0.93) that is not yet available in the packages for most Linux distributions. Therefore, you will have to install pgTAP from source as follows:

1. Download, make, and install pgTAP on your database server. pgTAP can be downloaded from [http://pgxn.org/dist/pgtap/](http://pgxn.org/dist/pgtap/) and the instructions for building and installing the extension are available from [http://pgtap.org/documentation.html](http://pgtap.org/documentation.html)

2. Create the pgTAP extension in your Evergreen database. Using `psql`, connect to your Evergreen database and then issue the command:

   ```sql
   CREATE EXTENSION pgtap;
   ```

Running pgTAP tests

The pgTAP tests can be found in subdirectories of `Open-ILS/src/sql/Pg/` as follows:

- **t**: contains pgTAP unit tests that can be run on a freshly installed Evergreen database
- **live_t**: contains pgTAP unit tests meant to be run on an Evergreen database that also has had the "concerto" sample data loaded on it

To run the pgTAP unit and regression tests, use the `pg_prove` command. For example, from the Evergreen source directory, you can issue the command: `pg_prove -U evergreen Open-ILS/src/sql/Pg/t Open-ILS/src/sql/Pg/t/regress`
Chapter 159. Easing gently into OpenSRF

Abstract

The Evergreen open-source library system serves library consortia composed of hundreds of branches with millions of patrons - for example, the Georgia Public Library Service PINES system. One of the claimed advantages of Evergreen over alternative integrated library systems is the underlying Open Service Request Framework (OpenSRF, pronounced "open surf") architecture. This article introduces OpenSRF, demonstrates how to build OpenSRF services through simple code examples, and explains the technical foundations on which OpenSRF is built.

Introducing OpenSRF

OpenSRF is a message routing network that offers scalability and failover support for individual services and entire servers with minimal development and deployment overhead. You can use OpenSRF to build loosely-coupled applications that can be deployed on a single server or on clusters of geographically distributed servers using the same code and minimal configuration changes. Although copyright statements on some of the OpenSRF code date back to Mike Rylander's original explorations in 2000, Evergreen was the first major application to be developed with, and to take full advantage of, the OpenSRF architecture starting in 2004. The first official release of OpenSRF was 0.1 in February 2005 (http://evergreen-ils.org/blog/?p=21), but OpenSRF's development continues a steady pace of enhancement and refinement, with the release of 1.0.0 in October 2008 and the most recent release of 1.2.2 in February 2010.

OpenSRF is a distinct break from the architectural approach used by previous library systems and has more in common with modern Web applications. The traditional "scale-up" approach to serve more transactions is to purchase a server with more CPUs and more RAM, possibly splitting the load between a Web server, a database server, and a business logic server. Evergreen, however, is built on the Open Service Request Framework (OpenSRF) architecture, which firmly embraces the "scale-out" approach of spreading transaction load over cheap commodity servers. The initial GPLS PINES hardware cluster, while certainly impressive, may have offered the misleading impression that Evergreen is complex and requires a lot of hardware to run.

This article hopes to correct any such lingering impression by demonstrating that OpenSRF itself is an extremely simple architecture on which one can easily build applications of many kinds – not just library applications – and that you can use a number of different languages to call and implement OpenSRF methods with a minimal learning curve. With an application built on OpenSRF, when you identify a bottleneck in your application's business logic layer, you can adjust the number of the processes serving that particular bottleneck on each of your servers; or if the problem is that your service is resource-hungry, you could add an inexpensive server to your cluster and dedicate it to running that resource-hungry service.

Programming language support

If you need to develop an entirely new OpenSRF service, you can choose from a number of different languages in which to implement that service. OpenSRF client language bindings have been written for C, Java, JavaScript, Perl, and Python, and server language bindings have been...
written for C, Perl, and Python. This article uses Perl examples as a lowest common denominator programming language. Writing an OpenSRF binding for another language is a relatively small task if that language offers libraries that support the core technologies on which OpenSRF depends:

- **Extensible Messaging and Presence Protocol** (XMPP, sometimes referred to as Jabber) - provides the base messaging infrastructure between OpenSRF clients and servers
- **JavaScript Object Notation** (JSON) - serializes the content of each XMPP message in a standardized and concise format
- **memcached** - provides the caching service
- **syslog** - the standard UNIX logging service

Unfortunately, the OpenSRF reference documentation, although augmented by the OpenSRF glossary, blog posts like the description of OpenSRF and Jabber, and even this article, is not a sufficient substitute for a complete specification on which one could implement a language binding. The recommended option for would-be developers of another language binding is to use the Python implementation as the cleanest basis for a port to another language.

### OpenSRF communication flows over XMPP

The XMPP messaging service underpins OpenSRF, requiring an XMPP server such as ejabberd. When you start OpenSRF, the first XMPP clients that connect to the XMPP server are the OpenSRF public and private routers. OpenSRF routers maintain a list of available services and connect clients to available services. When an OpenSRF service starts, it establishes a connection to the XMPP server and registers itself with the private router. The OpenSRF configuration contains a list of public OpenSRF services, each of which must also register with the public router. Services and clients connect to the XMPP server using a single set of XMPP client credentials (for example, opensrf@private.localhost), but use XMPP resource identifiers to differentiate themselves in the Jabber ID (JID) for each connection. For example, the JID for a copy of the opensrf.simple-text service with process ID 6285 that has connected to the private.localhost domain using the opensrf XMPP client credentials could be opensrf@private.localhost/opensrf.simple-text_drone_at_localhost_6285.

### OpenSRF communication flows over HTTP

Any OpenSRF service registered with the public router is accessible via the OpenSRF HTTP Translator. The OpenSRF HTTP Translator implements the OpenSRF-over-HTTP proposed specification as an Apache module that translates HTTP requests into OpenSRF requests and returns OpenSRF results as HTTP results to the initiating HTTP client.

Issuing an HTTP POST request to an OpenSRF method via the OpenSRF HTTP Translator.

```bash
# curl request broken up over multiple lines for legibility
curl -H "X-OpenSRF-service: opensrf.simple-text" 
    --data "osrf-msg={
        "__c":"osrfMessage","__p":{"threadTrace":0,"locale":"en-CA","type":"REQUEST","payload": {
            "__c":"osrfMethod","__p":{
                "method":"opensrf.simple-text.reverse","params":{"foobar"}}
        }}
    "
```

Chapter 159. Easing gently into OpenSRF

Report errors in this documentation using Launchpad.
The X-OpenSRF-service header identifies the OpenSRF service of interest.

The POST request consists of a single parameter, the osrf-msg value, which contains a JSON array.

The first object is an OpenSRF message ("__c":"osrfMessage") with a set of parameters ("__p":{}) containing:

- the identifier for the request ("threadTrace":0); this value is echoed back in the result
- the message type ("type":"REQUEST")
- the locale for the message; if the OpenSRF method is locale-sensitive, it can check the locale for each OpenSRF request and return different information depending on the locale
- the payload of the message ("payload":{}) containing the OpenSRF method request ("__c":"osrfMethod") and its parameters ("__p":{}), which in turn contains:
  - the method name for the request ("method":"opensrf.simple-text.reverse")
  - a set of JSON parameters to pass to the method ("params":["foobar"]; in this case, a single string "foobar"

The URL on which the OpenSRF HTTP translator is listening, /osrf-http-translator is the default location in the Apache example configuration files shipped with the OpenSRF source, but this is configurable.

Results from an HTTP POST request to an OpenSRF method via the OpenSRF HTTP Translator.

```json
# HTTP response broken up over multiple lines for legibility
[
{"__c":"osrfMessage","__p":
{"threadTrace":0, "payload":
{"__c":"osrfResult","__p":
{"status":"OK","content":"raboof","statusCode":200}
,"type":"RESULT","locale":"en-CA"}
,"type":"REQUEST","locale":"en-CA"}
],
{"__c":"osrfMessage","__p":
{"threadTrace":0,"payload":
{"__c":"osrfConnectStatus","__p":
{"status":"Request Complete","statusCode":205}
,"type":"STATUS","locale":"en-CA"}
,"type":"STATUS","locale":"en-CA"}
]
```

The OpenSRF HTTP Translator returns an array of JSON objects in its response. Each object in the response is an OpenSRF message ("__c":"osrfMessage") with a collection of response parameters ("__p":).

The OpenSRF message identifier ("threadTrace":0) confirms that this message is in response to the request matching the same identifier.

The message includes a payload JSON object ("payload":) with an OpenSRF result for the request ("__c":"osrfResult").

The result includes a status indicator string ("status":"OK"), the content of the result response - in this case, a single string "raboof" ("content":"raboof") - and an integer status code for the request ("statusCode":200).
The message also includes the message type ("type":"RESULT") and the message locale ("locale":"en-CA").

The second message in the set of results from the response.

Again, the message identifier confirms that this message is in response to a particular request.

The payload of the message denotes that this message is an OpenSRF connection status message ("__c":"osrfConnectStatus"), with some information about the particular OpenSRF connection that was used for this request.

The response parameters for an OpenSRF connection status message include a verbose status ("status":"Request Complete") and an integer status code for the connection status ("statusCode":205).

The message also includes the message type ("type":"RESULT") and the message locale ("locale":"en-CA").

Before adding a new public OpenSRF service, ensure that it does not introduce privilege escalation or unchecked access to data. For example, the Evergreen open-ils.cstore private service is an object-relational mapper that provides read and write access to the entire Evergreen database, so it would be catastrophic to expose that service publicly. In comparison, the Evergreen open-ils.pcrud public service offers the same functionality as open-ils.cstore to any connected HTTP client or OpenSRF client, but the additional authentication and authorization layer in open-ils.pcrud prevents unchecked access to Evergreen’s data.

Stateless and stateful connections

OpenSRF supports both stateless and stateful connections. When an OpenSRF client issues a REQUEST message in a stateless connection, the router forwards the request to the next available service and the service returns the result directly to the client.
REQUEST flow in a stateless connection.

When an OpenSRF client issues a `CONNECT` message to create a stateful connection, the router returns the Jabber ID of the next available service to the client so that the client can issue one or more `REQUEST` messages directly to that particular service and the service will return corresponding `RESULT` messages directly to the client. Until the client issues a `DISCONNECT` message, that particular service is only available to the requesting client. Stateful connections are useful for clients that need to make many requests from a particular service, as it avoids the intermediary step of contacting the router for each request, as well as for operations that require a controlled sequence of commands, such as a set of database INSERT, UPDATE, and DELETE statements within a transaction.
CONNECT, REQUEST, and DISCONNECT flow in a stateful connection.

**Enough jibber-jabber: writing an OpenSRF service**

Imagine an application architecture in which 10 lines of Perl or Python, using the data types native to each language, are enough to implement a method that can then be deployed and invoked seamlessly across hundreds of servers. You have just imagined developing with OpenSRF – it is truly that simple. Under the covers, of course, the OpenSRF language bindings do an incredible amount of work on behalf of the developer. An OpenSRF application consists of one or more OpenSRF services that expose methods: for example, the `opensrf.simple-text` demonstration service exposes the `opensrf.simple-text.split()` and `opensrf.simple-text.reverse()` methods. Each method accepts zero or more arguments and returns zero or one results. The data types supported by OpenSRF arguments and results are typical core language data types: strings, numbers, booleans, arrays, and hashes.

To implement a new OpenSRF service, perform the following steps:

1. Include the base OpenSRF support libraries
2. Write the code for each of your OpenSRF methods as separate procedures
3. Register each method
4. Add the service definition to the OpenSRF configuration files
For example, the following code implements an OpenSRF service. The service includes one method named `opensrf.simple-text.reverse()` that accepts one string as input and returns the reversed version of that string:

```perl
#!/usr/bin/perl

package OpenSRF::Application::Demo::SimpleText;
use strict;

use OpenSRF::Application;
use parent qw/OpenSRF::Application/;

sub text_reverse {
    my ($self, $conn, $text) = @_;  
    my $reversed_text = scalar reverse($text);
    return $reversed_text;
}
__PACKAGE__->register_method(
    method => 'text_reverse',
    api_name => 'opensrf.simple-text.reverse'
);
```

Ten lines of code, and we have a complete OpenSRF service that exposes a single method and could be deployed quickly on a cluster of servers to meet your application’s ravenous demand for reversed strings! If you're unfamiliar with Perl, the `use OpenSRF::Application; use parent qw/OpenSRF::Application/;` lines tell this package to inherit methods and properties from the `OpenSRF::Application` module. For example, the call to `__PACKAGE__->register_method()` is defined in `OpenSRF::Application` but due to inheritance is available in this package (named by the special Perl symbol `__PACKAGE__` that contains the current package name). The `register_method()` procedure is how we introduce a method to the rest of the OpenSRF world.

### Registering a service with the OpenSRF configuration files

Two files control most of the configuration for OpenSRF:

- `opensrf.xml` contains the configuration for the service itself as well as a list of which application servers in your OpenSRF cluster should start the service

- `opensrf_core.xml` (often referred to as the "bootstrap configuration" file) contains the OpenSRF networking information, including the XMPP server connection credentials for the public and private routers; you only need to touch this for a new service if the new service needs to be accessible via the public router

Begin by defining the service itself in `opensrf.xml`. To register the `opensrf.simple-text` service, add the following section to the `<apps>` element (corresponding to the XPath `/opensrf/default/apps/`):

```
<apps>
    <opensrf.simple-text>
        <!-- 1 -->
        <keepalive>3</keepalive>
        <!-- 2 -->
        <stateless>1</stateless>
        <!-- 3 -->
        <language>perl</language>
        <!-- 4 -->
        <implementation>OpenSRF::Application::Demo::SimpleText</implementation>
        <!-- 5 -->
        <max_requests>100</max_requests>
        <!-- 6 -->
```
The element name is the name that the OpenSRF control scripts use to refer to the service.

Specifies the interval (in seconds) between checks to determine if the service is still running.

Specifies whether OpenSRF clients can call methods from this service without first having to create a connection to a specific service backend process for that service. If the value is 1, then the client can simply issue a request and the router will forward the request to an available service and the result will be returned directly to the client.

Specifies the programming language in which the service is implemented.

Specifies the name of the library or module in which the service is implemented.

(C implementations): Specifies the maximum number of requests a process serves before it is killed and replaced by a new process.

(Perl implementations): Specifies the maximum number of requests a process serves before it is killed and replaced by a new process.

The name of the log file for language-specific log messages such as syntax warnings.

The name of the UNIX socket used for inter-process communications.

The name of the PID file for the master process for the service.

The minimum number of child processes that should be running at any given time.

The maximum number of child processes that should be running at any given time.

The minimum number of child processes that should be available to handle incoming requests. If there are fewer than this number of spare child processes, new processes will be spawned.

The maximum number of child processes that should be available to handle incoming requests. If there are more than this number of spare child processes, the extra processes will be killed.

To make the service accessible via the public router, you must also edit the opensrf_core.xml configuration file to add the service to the list of publicly accessible services:

Making a service publicly accessible in opensrf_core.xml.

```
<router> <!-- 1 -->
  <!-- This is the public router. On this router, we only register applications which should be accessible to everyone on the opensrf network -->
  <name>router</name>
  <domain>public.localhost</domain> <!-- 2 -->
  <services> <!-- 3 -->
    <service>opensrf.math</service>
    <service>opensrf.simple-text</service>
  </services>
</router>
```

1 This section of the opensrf_core.xml file is located at XPath /config/opensrf/routers/.

2 public.localhost is the canonical public router domain in the OpenSRF installation instructions.
Each `<service>` element contained in the `<services>` element offers their services via the public router as well as the private router.

Once you have defined the new service, you must restart the OpenSRF Router to retrieve the new configuration and start or restart the service itself.

**Calling an OpenSRF method**

OpenSRF clients in any supported language can invoke OpenSRF services in any supported language. So let’s see a few examples of how we can call our fancy new `opensrf.simple-text.reverse()` method:

**Calling OpenSRF methods from the srfsh client**

`srfsh` is a command-line tool installed with OpenSRF that you can use to call OpenSRF methods. To call an OpenSRF method, issue the `request` command and pass the OpenSRF service and method name as the first two arguments; then pass a list of JSON objects as the arguments to the method being invoked.

The following example calls the `opensrf.simple-text.reverse` method of the `opensrf.simple-text` OpenSRF service, passing the string "foobar" as the only method argument:

```
$ srfsh
srfsh # request opensrf.simple-text opensrf.simple-text.reverse "foobar"

Received Data: "raboof"

------------------------------------
Request Completed Successfully
Request Time in seconds: 0.016718
------------------------------------
```

**Getting documentation for OpenSRF methods from the srfsh client**

The `srfsh` client also gives you command-line access to retrieving metadata about OpenSRF services and methods. For a given OpenSRF method, for example, you can retrieve information such as the minimum number of required arguments, the data type and a description of each argument, the package or library in which the method is implemented, and a description of the method. To retrieve the documentation for an opensrf method from `srfsh`, issue the `introspect` command, followed by the name of the OpenSRF service and (optionally) the name of the OpenSRF method. If you do not pass a method name to the `introspect` command, `srfsh` lists all of the methods offered by the service. If you pass a partial method name, `srfsh` lists all of the methods that match that portion of the method name.

```
srfsh# introspect opensrf.simple-text "opensrf.simple-text.reverse"
```

The quality and availability of the descriptive information for each method depends on the developer to register the method with complete and accurate information. The quality varies across the set of OpenSRF and Evergreen APIs, although some effort is being put towards improving the state of the internal documentation.
-- opensrf.simple-text

Received Data: {
  "__c":"opensrf.simple-text",
  "__p":{
    "api_level":1,
    "stream":0, \ # 1
    "object_hint":"OpenSRF_Application_Demo_SimpleText",
    "remote":0,
    "package":"OpenSRF::Application::Demo::SimpleText", \ # 2
    "api_name":"opensrf.simple-text.reverse", \ # 3
    "server_class":"opensrf.simple-text",
    "signature":{
      "params":[
        { \ # 4
          "desc":"The string to reverse",
          "name":"text",
          "type":"string"
        }
      ],
      "desc":"Returns the input string in reverse order\n", \ # 5
      "return":{ \ # 6
        "desc":"Returns the input string in reverse order",
        "type":"string"
      }
    },
    "method":"text_reverse", \ # 7
    "argc":1 \ # 8
  }
}

1. **stream** denotes whether the method supports streaming responses or not.
2. **package** identifies which package or library implements the method.
3. **api_name** identifies the name of the OpenSRF method.
4. **signature** is a hash that describes the parameters for the method.
5. **params** is an array of hashes describing each parameter in the method; each parameter has a description (**desc**), name (**name**), and type (**type**).
6. **desc** is a string that describes the method itself.
7. **return** is a hash that describes the return value for the method; it contains a description of the return value (**desc**) and the type of the returned value (**type**).
8. **method** identifies the name of the function or method in the source implementation.
9. **argc** is an integer describing the minimum number of arguments that must be passed to this method.

### Calling OpenSRF methods from Perl applications

To call an OpenSRF method from Perl, you must connect to the OpenSRF service, issue the request to the method, and then retrieve the results.

```perl
#/usr/bin/perl
use strict;
use OpenSRF::AppSession;
use OpenSRF::System;

OpenSRF::System->bootstrap_client(config_file => '/openils/conf/opensrf_core.xml'); \ # 1

my $session = OpenSRF::AppSession->create("opensrf.simple-text"); \ # 2

print "substring: Accepts a string and a number as input, returns a string\n";
my $result = $session->request("opensrf.simple-text.substring", "foobar", 3); \ # 3
```

Chapter 159. Easing gently into OpenSRF

Report errors in this documentation using [Launchpad](https://launchpad.net).
The `OpenSRF::System->bootstrap_client()` method reads the OpenSRF configuration information from the indicated file and creates an XMPP client connection based on that information.

The `OpenSRF::AppSession->create()` method accepts one argument - the name of the OpenSRF service to which you want to make one or more requests - and returns an object prepared to use the client connection to make those requests.

The `OpenSRF::AppSession->request()` method accepts a minimum of one argument - the name of the OpenSRF method to which you want to make a request - followed by zero or more arguments to pass to the OpenSRF method as input values. This example passes a string and an integer to the `opensrf.simple-text.substring` method defined by the `opensrf.simple-text` OpenSRF service.

The `gather()` method, called on the result object returned by the `request()` method, iterates over all of the possible results from the result object and returns a single variable.

This `request()` call passes two strings to the `opensrf.simple-text.split` method defined by the `opensrf.simple-text` OpenSRF service and returns (via `gather()`) a reference to an array of results.

The `opensrf.simple-text.split()` method is a streaming method that returns an array of results with one element per `recv()` call on the result object. We could use the `gather()` method to retrieve all of the results in a single array reference, but instead we simply iterate over the result variable until there are no more results to retrieve.

While the `gather()` convenience method returns only the content of the complete set of results for a given request, the `recv()` method returns an OpenSRF result object with `status`, `statusCode`, and `content` fields as we saw in the HTTP results example.

This `request()` call passes an array to the `opensrf.simple-text.statistics` method defined by the `opensrf.simple-text` OpenSRF service.

The result object returns a hash reference via `gather()`. The hash contains the `length` and `word_count` keys we defined in the method.

The `OpenSRF::AppSession->disconnect()` method closes the XMPP client connection and cleans up resources associated with the session.
Accepting and returning more interesting data types

Of course, the example of accepting a single string and returning a single string is not very interesting. In real life, our applications tend to pass around multiple arguments, including arrays and hashes. Fortunately, OpenSRF makes that easy to deal with; in Perl, for example, returning a reference to the data type does the right thing. In the following example of a method that returns a list, we accept two arguments of type string: the string to be split, and the delimiter that should be used to split the string.

Text splitting method - streaming mode.

```perl
sub text_split {
    my $self = shift;
    my $conn = shift;
    my $text = shift;
    my $delimiter = shift || ' ';  
    my $split_text = split $delimiter, $text;
    return $split_text;
}
```

__PACKAGE__->register_method(
    method    => 'text_split',
    api_name  => 'opensrf.simple-text.split',
);

We simply return a reference to the list, and OpenSRF does the rest of the work for us to convert the data into the language-independent format that is then returned to the caller. As a caller of a given method, you must rely on the documentation used to register to determine the data structures - if the developer has added the appropriate documentation.

Accepting and returning Evergreen objects

OpenSRF is agnostic about objects; its role is to pass JSON back and forth between OpenSRF clients and services, and it allows the specific clients and services to define their own semantics for the JSON structures. On top of that infrastructure, Evergreen offers the fieldmapper: an object-relational mapper that provides a complete definition of all objects, their properties, their relationships to other objects, the permissions required to create, read, update, or delete objects of that type, and the database table or view on which they are based.

The Evergreen fieldmapper offers a great deal of convenience for working with complex system objects beyond the basic mapping of classes to database schemas. Although the result is passed over the wire as a JSON object containing the indicated fields, fieldmapper-aware clients then turn those JSON objects into native objects with setter / getter methods for each field.

All of this metadata about Evergreen objects is defined in the fieldmapper configuration file (/$openils/conf/fm_IDL.xml), and access to these classes is provided by the open-ils.cstore, open-ils.pcrud, and open-ils.reporter-store OpenSRF services which parse the fieldmapper configuration file and dynamically register OpenSRF methods for creating, reading, updating, and deleting all of the defined classes.

Example fieldmapper class definition for "Open User Summary".

```
<class id="mous" controller="open-ils.cstore open-ils.pcrud"
    oils_obj:fieldmapper="money::open_user_summary"
    oils_persist:tablename="money.open_usr_summary"
```
The `<class>` element defines the class:

- The `id` attribute defines the class hint that identifies the class both elsewhere in the fieldmapper configuration file, such as in the value of the `field` attribute of the `<link>` element, and in the JSON object itself when it is instantiated. For example, an "Open User Summary" JSON object would have the top level property of "__c":"mous".

- The `controller` attribute identifies the services that have direct access to this class. If `open-ils.pcrud` is not listed, for example, then there is no means to directly access members of this class through a public service.

- The `oils_obj:fieldmapper` attribute defines the name of the Perl fieldmapper class that will be dynamically generated to provide setter and getter methods for instances of the class.

- The `oils_persist:tablename` attribute identifies the schema name and table name of the database table that stores the data that represents the instances of this class. In this case, the schema is `money` and the table is `open_usr_summary`.

- The `reporter:label` attribute defines a human-readable name for the class used in the reporting interface to identify the class. These names are defined in English in the fieldmapper configuration file; however, they are extracted so that they can be translated and served in the user’s language of choice.

The `<fields>` element lists all of the fields that belong to the object.

- The `oils_persist:primary` attribute identifies the field that acts as the primary key for the object; in this case, the field with the name `usr`.

- The `oils_persist:sequence` attribute identifies the sequence object (if any) in this database provides values for new instances of this class. In this case, the primary key is defined by a field that is linked to a different table, so no sequence is used to populate these instances.

Each `<field>` element defines a single field with the following attributes:

- The `name` attribute identifies the column name of the field in the underlying database table as well as providing a name for the setter / getter method that can be invoked in the JSON or native version of the object.
• The **reporter:datatype** attribute defines how the reporter should treat the contents of the field for the purposes of querying and display.

• The **reporter:label** attribute can be used to provide a human-readable name for each field; without it, the reporter falls back to the value of the **name** attribute.

The **<links>** element contains a set of zero or more **<link>** elements, each of which defines a relationship between the class being described and another class.

• The **field** attribute identifies the field named in this class that links to the external class.

• The **reltype** attribute identifies the kind of relationship between the classes; in the case of **has_a**, each value in the **usr** field is guaranteed to have a corresponding value in the external class.

• The **key** attribute identifies the name of the field in the external class to which this field links.

• The rarely-used **map** attribute identifies a second class to which the external class links; it enables this field to define a direct relationship to an external class with one degree of separation, to avoid having to retrieve all of the linked members of an intermediate class just to retrieve the instances from the actual desired target class.

• The **class** attribute identifies the external class to which this field links.

The **<permacrud>** element defines the permissions that must have been granted to a user to operate on instances of this class.

The **<retrieve>** element is one of four possible children of the **<actions>** element that define the permissions required for each action: create, retrieve, update, and delete.

• The **permission** attribute identifies the name of the permission that must have been granted to the user to perform the action.

• The **contextfield** attribute, if it exists, defines the field in this class that identifies the library within the system for which the user must have privileges to work. If a user has been granted a given permission, but has not been granted privileges to work at a given library, they can not perform the action at that library.

The rarely-used **<context>** element identifies a linked field (**link** attribute) in this class which links to an external class that holds the field (**field** attribute) that identifies the library within the system for which the user must have privileges to work.

When you retrieve an instance of a class, you can ask for the result to flesh some or all of the linked fields of that class, so that the linked instances are returned embedded directly in your requested instance. In that same request you can ask for the fleshed instances to in turn have their linked fields fleshed. By bundling all of this into a single request and result sequence, you can avoid the network overhead of requiring the client to request the base object, then request each linked object in turn.

You can also iterate over a collection of instances and set the automatically generated **isdeleted**, **isupdated**, or **isnew** properties to indicate that the given instance has been deleted, updated, or created respectively. Evergreen can then act in batch mode over the collection to perform the requested actions on any of the instances that have been flagged for action.
Returning streaming results

In the previous implementation of the `opensrf.simple-text.split` method, we returned a reference to the complete array of results. For small values being delivered over the network, this is perfectly acceptable, but for large sets of values this can pose a number of problems for the requesting client. Consider a service that returns a set of bibliographic records in response to a query like "all records edited in the past month"; if the underlying database is relatively active, that could result in thousands of records being returned as a single network request. The client would be forced to block until all of the results are returned, likely resulting in a significant delay, and depending on the implementation, correspondingly large amounts of memory might be consumed as all of the results are read from the network in a single block.

OpenSRF offers a solution to this problem. If the method returns results that can be divided into separate meaningful units, you can register the OpenSRF method as a streaming method and enable the client to loop over the results one unit at a time until the method returns no further results. In addition to registering the method with the provided name, OpenSRF also registers an additional method with `.atomic` appended to the method name. The `.atomic` variant gathers all of the results into a single block to return to the client, giving the caller the ability to choose either streaming or atomic results from a single method definition.

In the following example, the text splitting method has been reimplemented to support streaming; very few changes are required:

Text splitting method - streaming mode.

```perl
sub text_split { # 1
    my $self = shift;
    my $conn = shift;
    my $text = shift;
    my $delimiter = shift || ' ';
    my @split_text = split $delimiter, $text;
    foreach my $string (@split_text) {
        $conn->respond($string);
    }
    return undef;
}

__PACKAGE__->register_method(
    method => 'text_split', # 2
    api_name => 'opensrf.simple-text.split',
    stream => 1
);
```

Rather than returning a reference to the array, a streaming method loops over the contents of the array and invokes the `respond()` method of the connection object on each element of the array.

Registering the method as a streaming method instructs OpenSRF to also register an atomic variant (`opensrf.simple-text.split.atomic`).

**Error! Warning! Info! Debug!**

As hard as it may be to believe, it is true: applications sometimes do not behave in the expected manner, particularly when they are still under development. The server language bindings for
OpenSRF include integrated support for logging messages at the levels of ERROR, WARNING, INFO, DEBUG, and the extremely verbose INTERNAL to either a local file or to a syslog logger service. The destination of the log files, and the level of verbosity to be logged, is set in the `opensrf_core.xml` configuration file. To add logging to our Perl example, we just have to add the `OpenSRF::Utils::Logger` package to our list of used Perl modules, then invoke the logger at the desired logging level.

You can include many calls to the OpenSRF logger; only those that are higher than your configured logging level will actually hit the log. The following example exercises all of the available logging levels in OpenSRF:

```perl
use OpenSRF::Utils::Logger;
my $logger = OpenSRF::Utils::Logger;
# some code in some function
{
    $logger->error("Hmm, something bad DEFINITELY happened!");
    $logger->warn("Hmm, something bad might have happened.");
    $logger->info("Something happened.");
    $logger->debug("Something happened; here are some more details.");
    $logger->internal("Something happened; here are all the gory details.")
}
```

If you call the mythical OpenSRF method containing the preceding OpenSRF logger statements on a system running at the default logging level of INFO, you will only see the INFO, WARN, and ERR messages, as follows:

Results of logging calls at the default level of INFO.

```
```

If you then increase the the logging level to INTERNAL (5), the logs will contain much more information, as follows:

Results of logging calls at the default level of INTERNAL.

```
[2010-03-17 22:48:11] opensrf.simple-text [DEBG:5934:SimpleText.pm:280:] Something happened; here are some more
details.
[2010-03-17 22:48:11] opensrf.simple-text [INTL:5934:SimpleText.pm:281:] Something happened; here are all the
gory details.
 => "here" in memcached server
[OpenSRF::Application::Demo::SimpleText::test_cache] has been run
[2010-03-17 22:48:21] opensrf.simple-text [DEBG:5934:Application.pm:586:] A top level Request object is
responding de nada
text.test_cache]: 10.005
[2010-03-17 22:48:21] opensrf.simple-text [INTL:5934:AppSession.pm:780:] Calling queue_wait(0)
opensrf@private.localhost/_dan-karmic-liblap_1268880489.752154_5943 with threadTrace [1]
opensrf@private.localhost/_dan-karmic-liblap_1268880489.752154_5943 with threadTrace [1]
...
To see everything that is happening in OpenSRF, try leaving your logging level set to INTERNAL for a few minutes - just ensure that you have a lot of free disk space available if you have a moderately busy system!

**Caching results: one secret of scalability**

If you have ever used an application that depends on a remote Web service outside of your control—say, if you need to retrieve results from a microblogging service—you know the pain of latency and dependability (or the lack thereof). To improve response time in OpenSRF applications, you can take advantage of the support offered by the `OpenSRF::Utils::Cache` module for communicating with a local instance or cluster of memcache daemons to store and retrieve persistent values.

```perl
use OpenSRF::Utils::Cache;                                       # 1
sub test_cache {
    my $self = shift;
    my $conn = shift;
    my $test_key = shift;
    my $cache = OpenSRF::Utils::Cache->new('global');            # 2
    my $cache_key = "opensrf.simple-text.test_cache.$test_key";  # 3
    my $result = $cache->get_cache($cache_key) || undef;         # 4
    if ($result) {
        $logger->info("Resolver found a cache hit");
        return $result;
    }
    sleep 10;                                                    # 5
    my $cache_timeout = 300;                                     # 6
    $cache->put_cache($cache_key, "here", $cache_timeout);       # 7
    return "There was no cache hit.";
}
```

This example:

1. Imports the OpenSRF::Utils::Cache module
2. Creates a cache object
3. Creates a unique cache key based on the OpenSRF method name and request input value
4. Checks to see if the cache key already exists; if so, it immediately returns that value
5. If the cache key does not exist, the code sleeps for 10 seconds to simulate a call to a slow remote Web service, or an intensive process
6. Sets a value for the lifetime of the cache key in seconds
7. When the code has retrieved its value, then it can create the cache entry, with the cache key, value to be stored ("here"), and the timeout value in seconds to ensure that we do not return stale data on subsequent calls

**Initializing the service and its children: child labour**

When an OpenSRF service is started, it looks for a procedure called `initialize()` to set up any global variables shared by all of the children of the service. The `initialize()` procedure is typically used to retrieve configuration settings from the `opensrf.xml` file.

An OpenSRF service spawns one or more children to actually do the work requested by callers of the service. For every child process an OpenSRF service spawns, the child process clones the parent environment and then each child process runs the `child_init()` process (if any) defined in the OpenSRF service to initialize any child-specific settings.
When the OpenSRF service kills a child process, it invokes the `child_exit()` procedure (if any) to clean up any resources associated with the child process. Similarly, when the OpenSRF service is stopped, it calls the `DESTROY()` procedure to clean up any remaining resources.

## Retrieving configuration settings

The settings for OpenSRF services are maintained in the `opensrf.xml` XML configuration file. The structure of the XML document consists of a root element `<opensrf>` containing two child elements:

- `<default>` contains an `<apps>` element describing all OpenSRF services running on this system — see the section called “Registering a service with the OpenSRF configuration files” --, as well as any other arbitrary XML descriptions required for global configuration purposes. For example, Evergreen uses this section for email notification and inter-library patron privacy settings.

- `<hosts>` contains one element per host that participates in this OpenSRF system. Each host element must include an `<activeapps>` element that lists all of the services to start on this host when the system starts up. Each host element can optionally override any of the default settings.

OpenSRF includes a service named `opensrf.settings` to provide distributed cached access to the configuration settings with a simple API:

- `opensrf.settings.default_config.get`: accepts zero arguments and returns the complete set of default settings as a JSON document

- `opensrf.settings.host_config.get`: accepts one argument (hostname) and returns the complete set of settings, as customized for that hostname, as a JSON document

- `opensrf.settings.xpath.get`: accepts one argument (an XPath expression) and returns the portion of the configuration file that matches the expression as a JSON document

For example, to determine whether an Evergreen system uses the opt-in support for sharing patron information between libraries, you could either invoke the `opensrf.settings.default_config.get` method and parse the JSON document to determine the value, or invoke the `opensrf.settings.xpath.get` method with the XPath `/opensrf/default/share/user/opt_in` argument to retrieve the value directly.

In practice, OpenSRF includes convenience libraries in all of its client language bindings to simplify access to configuration values. C offers `osrfConfig.c`, Perl offers `OpenSRF::Utils::SettingsClient`, Java offers `org.opensrf.util.SettingsClient`, and Python offers `osrf.set`. These libraries locally cache the configuration file to avoid network roundtrips for every request and enable the developer to request specific values without having to manually construct XPath expressions.

## Getting under the covers with OpenSRF

Now that you have seen that it truly is easy to create an OpenSRF service, we can take a look at what is going on under the covers to make all of this work for you.
Get on the messaging bus - safely

One of the core innovations of OpenSRF was to use the Extensible Messaging and Presence Protocol (XMPP, more colloquially known as Jabber) as the messaging bus that ties OpenSRF services together across servers. XMPP is an "XML protocol for near-real-time messaging, presence, and request-response services" (http://www.ietf.org/rfc/rfc3920.txt) that OpenSRF relies on to handle most of the complexity of networked communications. OpenSRF achieves a measure of security for its services through the use of public and private XMPP domains; all OpenSRF services automatically register themselves with the private XMPP domain, but only those services that register themselves with the public XMPP domain can be invoked from public OpenSRF clients.

In a minimal OpenSRF deployment, two XMPP users named "router" connect to the XMPP server, with one connected to the private XMPP domain and one connected to the public XMPP domain. Similarly, two XMPP users named "opensrf" connect to the XMPP server via the private and public XMPP domains. When an OpenSRF service is started, it uses the "opensrf" XMPP user to advertise its availability with the corresponding router on that XMPP domain; the XMPP server automatically assigns a Jabber ID (JID) based on the client hostname to each service’s listener process and each connected drone process waiting to carry out requests. When an OpenSRF router receives a request to invoke a method on a given service, it connects the requester to the next available listener in the list of registered listeners for that service.

The opensrf and router user names, passwords, and domain names, along with the list of services that should be public, are contained in the opensrf_core.xml configuration file.

Message body format

OpenSRF was an early adopter of JavaScript Object Notation (JSON). While XMPP is an XML protocol, the Evergreen developers recognized that the compactness of the JSON format offered a significant reduction in bandwidth for the volume of messages that would be generated in an application of that size. In addition, the ability of languages such as JavaScript, Perl, and Python to generate native objects with minimal parsing offered an attractive advantage over invoking an XML parser for every message. Instead, the body of the XMPP message is a simple JSON structure. For a simple request, like the following example that simply reverses a string, it looks like a significant overhead: but we get the advantages of locale support and tracing the request from the requester through the listener and responder (drone).

A request for opensrf.simple-text.reverse("foobar"):

```xml
<message from='router@private.localhost/opensrf.simple-text' 
to='opensrf@private.localhost/opensrf.simple-text_listener_at_localhost_6275' 
router_from='router@private.localhost/_karmic_126678.3719_6288' 
router_to='' router_class='' router_command='' osrf_xid='' >
  <thread>1266781414.366573.12667814146288</thread>
  <body>
    {
      "__c":"osrfMessage","__p":
      {
        "threadTrace":"1","locale":"en-US","type":"REQUEST","payload":
        {
          "__c":"osrfMethod","__p":
          {
            "method":"opensrf.simple-text.reverse","params":{"foobar"}
          }
        }
      }
    }
  </body>
</message>
```
A response from opensrf.simple-text.reverse("foobar").

The content of the <body> element of the OpenSRF request and result should look familiar; they match the structure of the OpenSRF over HTTP examples that we previously dissected.

Registering OpenSRF methods in depth

Let’s explore the call to __PACKAGE__\-\>register\_method(); most of the elements of the hash are optional, and for the sake of brevity we omitted them in the previous example. As we have seen in the results of the introspection call, a verbose registration method call is recommended to better enable the internal documentation. So, for the sake of completeness here, is the set of elements that you should pass to __PACKAGE__\-\>register\_method():

- **method**: the name of the procedure in this module that is being registered as an OpenSRF method
- **api\_name**: the invocable name of the OpenSRF method; by convention, the OpenSRF service name is used as the prefix
- **api\_level**: (optional) can be used for versioning the methods to allow the use of a deprecated API, but in practical use is always 1
- **argc**: (optional) the minimal number of arguments that the method expects
- **stream**: (optional) if this argument is set to any value, then the method supports returning multiple values from a single call to subsequent requests, and OpenSRF automatically creates a corresponding method with ".atomic" appended to its name that returns the complete set of results in a single request; streaming methods are useful if you are returning hundreds of records and want to act on the results as they return
- **signature**: (optional) a hash describing the method’s purpose, arguments, and return value
  - **desc**: a description of the method’s purpose
• **params**: an array of hashes, each of which describes one of the method arguments

  • **name**: the name of the argument
  
  • **desc**: a description of the argument’s purpose
  
  • **type**: the data type of the argument: for example, string, integer, boolean, number, array, or hash
  
  • **return**: a hash describing the return value of the method

    • **desc**: a description of the return value
  
    • **type**: the data type of the return value: for example, string, integer, boolean, number, array, or hash

## Evergreen-specific OpenSRF services

Evergreen is currently the primary showcase for the use of OpenSRF as an application architecture. Evergreen 2.6.0 includes the following set of OpenSRF services:

• **open-ils.acq**: Supports tasks for managing the acquisitions process

• **open-ils.actor**: Supports common tasks for working with user accounts and libraries.

• **open-ils.auth**: Supports authentication of Evergreen users.

• **open-ils.auth_proxy**: Support using external services such as LDAP directories to authenticate Evergreen users.

• **open-ils.cat**: Supports common cataloging tasks, such as creating, modifying, and merging bibliographic and authority records.

• **open-ils.circ**: Supports circulation tasks such as checking out items and calculating due dates.

• **open-ils.collections**: Supports tasks to assist collections services for contacting users with outstanding fines above a certain threshold.

• **open-ils.cstore**: Supports unrestricted access to Evergreen fieldmapper objects. This is a private service.

• **open-ils.fielder**

• **open-ils.justintime**: Support tasks for determining if an action/trigger event is still valid

• **open-ils.pcrud**: Supports access to Evergreen fieldmapper objects, restricted by staff user permissions. This is a private service.

• **open-ils.permacrud**: Supports access to Evergreen fieldmapper objects, restricted by staff user permissions. This is a private service.
• **open-ils.reporter**: Supports the creation and scheduling of reports.

• **open-ils.reporter-store**: Supports access to Evergreen fieldmapper objects for the reporting service. This is a private service.

• **open-ilsresolver**: Support tasks for integrating with an OpenURL resolver.

• **open-ils.search**: Supports searching across bibliographic records, authority records, serial records, Z39.50 sources, and ZIP codes.

• **open-ils.serial**: Support tasks for serials management

• **open-ils.storage**: A deprecated method of providing access to Evergreen fieldmapper objects. Implemented in Perl, this service has largely been replaced by the much faster C-based **open-ils.cstore** service.

• **open-ils.supercat**: Supports transforms of MARC records into other formats, such as MODS, as well as providing Atom and RSS feeds and SRU access.

• **open-ils.trigger**: Supports event-based triggers for actions such as overdue and holds available notification emails.

• **open-ils.url_verify**: Support tasks for validating URLs

• **open-ils.vandelay**: Supports the import and export of batches of bibliographic and authority records.

• **opensrf.settings**: Supports communicating opensrf.xml settings to other services.

Of some interest is that the **open-ils.reporter-store** and **open-ils.cstore** services have identical implementations. Surfacing them as separate services enables a deployer of Evergreen to ensure that the reporting service does not interfere with the performance-critical **open-ils.cstore** service. One can also direct the reporting service to a read-only database replica to, again, avoid interference with **open-ils.cstore** which must write to the master database.

There are only a few significant services that are not built on OpenSRF, such as the SIP and Z39.50 servers. These services implement different protocols and build on existing daemon architectures (Simple2ZOOM for Z39.50), but still rely on the other OpenSRF services to provide access to the Evergreen data. The non-OpenSRF services are reasonably self-contained and can be deployed on different servers to deliver the same sort of deployment flexibility as OpenSRF services, but have the disadvantage of not being integrated into the same configuration and control infrastructure as the OpenSRF services.

**Evergreen after one year: reflections on OpenSRF**

*Project Conifer* has been live on Evergreen for just over a year now, and as one of the primary technologists I have had to work closely with the OpenSRF infrastructure during that time. As such, I am in a position to identify some of the strengths and weaknesses of OpenSRF based on our experiences.
Strengths of OpenSRF

As a service infrastructure, OpenSRF has been remarkably reliable. We initially deployed Evergreen on an unreleased version of both OpenSRF and Evergreen due to our requirements for some functionality that had not been delivered in a stable release at that point in time, and despite this risky move we suffered very little unplanned downtime in the opening months. On July 27, 2009 we moved to a newer (but still unreleased) version of the OpenSRF and Evergreen code, and began formally tracking our downtime. Since then, we have achieved more than 99.9% availability - including scheduled downtime for maintenance. This compares quite favourably to the maximum of 75% availability that we were capable of achieving on our previous library system due to the nightly downtime that was required for our backup process. The OpenSRF "maximum request" configuration parameter for each service that kills off drone processes after they have served a given number of requests provides a nice failsafe for processes that might otherwise suffer from a memory leak or hung process. It also helps that when we need to apply an update to a Perl service that is running on multiple servers, we can apply the updated code, then restart the service on one server at a time to avoid any downtime.

As promised by the OpenSRF infrastructure, we have also been able to tune our cluster of servers to provide better performance. For example, we were able to change the number of maximum concurrent processes for our database services when we noticed that we seeing a performance bottleneck with database access. Making a configuration change go live simply requires you to restart the opensrf.setting service to pick up the configuration change, then restart the affected service on each of your servers. We were also able to turn off some of the less-used OpenSRF services, such as open-ils.collections, on one of our servers to devote more resources on that server to the more frequently used services and other performance-critical processes such as Apache.

The support for logging and caching that is built into OpenSRF has been particularly helpful with the development of a custom service for SFX holdings integration into our catalogue. Once I understood how OpenSRF works, most of the effort required to build that SFX integration service was spent on figuring out how to properly invoke the SFX API to display human-readable holdings. Adding a new OpenSRF service and registering several new methods for the service was relatively easy. The support for directing log messages to syslog in OpenSRF has also been a boon for both development and debugging when problems arise in a cluster of five servers; we direct all of our log messages to a single server where we can inspect the complete set of messages for the entire cluster in context, rather than trying to piece them together across servers.

Weaknesses

The primary weakness of OpenSRF is the lack of either formal or informal documentation for OpenSRF. There are many frequently asked questions on the Evergreen mailing lists and IRC channel that indicate that some of the people running Evergreen or trying to run Evergreen have not been able to find documentation to help them understand, even at a high level, how the OpenSRF Router and services work with XMPP and the Apache Web server to provide a working Evergreen system. Also, over the past few years several developers have indicated an interest in developing Ruby and PHP bindings for OpenSRF, but the efforts so far have resulted in no working code. Without a formal specification, clearly annotated examples, and unit tests for the major OpenSRF communication use cases that could be ported to the new language as a base set of expectations for a working binding, the hurdles for a developer new to OpenSRF are significant. As a result,
Evergreen integration efforts with popular frameworks like Drupal, Blacklight, and VuFind result in the best practical option for a developer with limited time — database-level integration — which has the unfortunate side effect of being much more likely to break after an upgrade.

In conjunction with the lack of documentation that makes it hard to get started with the framework, a disincentive for new developers to contribute to OpenSRF itself is the lack of integrated unit tests. For a developer to contribute a significant, non-obvious patch to OpenSRF, they need to manually run through various (undocumented, again) use cases to try and ensure that the patch introduced no unanticipated side effects. The same problems hold for Evergreen itself, although the Constrictor stress-testing framework offers a way of performing some automated system testing and performance testing.

These weaknesses could be relatively easily overcome with the effort through contributions from people with the right skill sets. This article arguably offers a small set of clear examples at both the networking and application layer of OpenSRF. A technical writer who understands OpenSRF could contribute a formal specification to the project. With a formal specification at their disposal, a quality assurance expert could create an automated test harness and a basic set of unit tests that could be incrementally extended to provide more coverage over time. If one or more continual integration environments are set up to track the various OpenSRF branches of interest, then the OpenSRF community would have immediate feedback on build quality. Once a unit testing framework is in place, more developers might be willing to develop and contribute patches as they could sanity check their own code without an intense effort before exposing it to their peers.

**Summary**

In this article, I attempted to provide both a high-level and detailed overview of how OpenSRF works, how to build and deploy new OpenSRF services, how to make requests to OpenSRF method from OpenSRF clients or over HTTP, and why you should consider it a possible infrastructure for building your next high-performance system that requires the capability to scale out. In addition, I surveyed the Evergreen services built on OpenSRF and reflected on the strengths and weaknesses of the platform based on the experiences of Project Conifer after a year in production, with some thoughts about areas where the right application of skills could make a significant difference to the Evergreen and OpenSRF projects.

**Appendix: Python client**

Following is a Python client that makes the same OpenSRF calls as the Perl client:

```python
#!/usr/bin/env python
"""OpenSRF client example in Python"
import osrf.system
import osrf.ses

def osrf_substring(session, text, sub):
    """Substring: Accepts a string and a number as input, returns a string"
    request = session.request('opensrf.simple-text.substring', text, sub)

    # Retrieve the response from the method
    # The timeout parameter is optional
    response = request.recv(timeout=2)

    request.cleanup()
    # The results are accessible via content()
```
return response.content()

def osrf_split(session, text, delim):
    """split: Accepts two strings as input, returns an array of strings""
    request = session.request('opensrf.simple-text.split', text, delim)
    response = request.recv()
    request.cleanup()
    return response.content()

def osrf_statistics(session, strings):
    """statistics: Accepts an array of strings as input, returns a hash""
    request = session.request('opensrf.simple-text.statistics', strings)
    response = request.recv()
    request.cleanup()
    return response.content()

if __name__ == "__main__":
    file = '/openils/conf/opensrf_core.xml'
    # Pull connection settings from <config><opensrf> section of opensrf_core.xml
    osrf.system.System.connect(config_file=file, config_context='config.opensrf')
    # Set up a connection to the opensrf.settings service
    session = osrf.ses.ClientSession('opensrf.simple-text')
    result = osrf_substring(session, "foobar", 3)
    print(result)

    result = osrf_split(session, "This is a test", " ")
    print("Received %d elements: [% % len(result)),
    print('), '.join(result)), ']'

    many_strings = (  
        "First I think I'll have breakfast",
        "Then I think that lunch would be nice",
        "And then seventy desserts to finish off the day"
    )
    result = osrf_statistics(session, many_strings)
    print("Length: %d" % result["length"])
    print("Word count: %d" % result["word_count"])

    # Cleanup connection resources
    session.cleanup()

Python’s dnspython module refuses to read /etc/resolv.conf, so to access hostnames that are not served up via DNS, such as the extremely common case of localhost, you may need to install a package like dnsmasq to act as a local DNS server for those hostnames.
Chapter 160. Updating translations using Launchpad

This document describes how to update the translations in an Evergreen branch by pulling them from Launchpad, as well as update the files to be translated in Launchpad by updating the POT files in the Evergreen master branch.

Prerequisites

You must install all of the Python prerequisites required for building translations, per http://evergreen-ils.org/dokuwiki/doku.php?id=evergreen-admin:customizations:i18n

- polib
- translate-toolkit
- levenshtein
- setuptools
- simplejson
- lxml

Updating the translations

1. Check out the latest translations from Launchpad by branching the Bazaar repository:

   ```
   bzr branch lp:~denials/evergreen/translation-export
   ```

   This creates a directory called "translation-export".

2. Ensure you have an updated Evergreen release branch.

3. Run the `build/i18n/scripts/update_pofiles` script to copy the translations into the right place and avoid any updates that are purely metadata (dates generated, etc).

4. Commit the lot! And backport to whatever release branches need the updates.

5. Build updated POT files:

   ```
   cd build/i18n
   make newpot
   ```

   This will extract all of the strings from the latest version of the files in Evergreen.

6. (This part needs automation): Then, via the magic of `git diff` and `git add`, go through all of the changed files and determine which ones actually have string changes. Recommended approach is to re-run `git diff` after each `git add`. 
7. Commit the updated POT files and backport to the pertinent release branches.
Part XV. Getting Data from Evergreen
# Table of Contents

161. Introduction ................................................................. 838
162. Using Supercat ............................................................. 839
   Introduction ................................................................. 839
   ISBNs ................................................................................ 839
   Records ............................................................................ 840
   Record formats ................................................................. 840
   Retrieve records ............................................................... 840
   Recent records ................................................................. 842
163. Using UnAPI ................................................................. 844
   URL format ........................................................................ 844
164. Using Opensearch as a developer .................................... 846
   Introduction ...................................................................... 846

Part XV. Getting Data from Evergreen 837
Chapter 161. Introduction

You may be interested in re-using data from your Evergreen installation in another application. This part describes several methods to get the data you need.
Chapter 162. Using Supercat

Introduction

You can use SuperCat to get data about ISBNs, metarecords, bibliographic records, and authority records.

Throughout this section, replace `<hostname>` with the domain or subdomain of your Evergreen installation to try these examples on your own system.

ISBNs

Given one ISBN, Evergreen can return a list of related records and ISBNs, including alternate editions and translations. To use the Supercat oISBN tool, use http or https to access the following URL.


For example, the URL http://gapines.org/opac/extras/oisbn/0439136350 returns the following list of catalog record IDs and ISBNs:

```xml
<?xml version='1.0' encoding='UTF-8' ?>
<idlist metarecord='436139'>
  <isbn record='5652044'>9780606323475</isbn>
  <isbn record='5767568'>9780780673809</isbn>
  <isbn record='1350528'>97807806786029</isbn>
  <isbn record='5708164'>9780780669642</isbn>
  <isbn record='2372013'>043965548X</isbn>
  <isbn record='5804511'>8498386969</isbn>
  <isbn record='4132282'>9780780622274</isbn>
  <isbn record='1530458'>9788478885190</isbn>
  <isbn record='2003291'>0736650962</isbn>
  <isbn record='1993002'>8478885196</isbn>
  <isbn record='1187595'>97804395554923</isbn>
  <isbn record='4591175'>8478885196</isbn>
  <isbn record='5676282'>0807282324</isbn>
  <isbn record='2363352'>8478885196</isbn>
  <isbn record='2315122'>1480614998</isbn>
  <isbn record='2304130'>8478886559</isbn>
  <isbn record='2043258'>9780606323475</isbn>
  <isbn record='5767568'>9780780673809</isbn>
  <isbn record='1350528'>97807806786029</isbn>
  <isbn record='5708164'>9780780669642</isbn>
  <isbn record='2372013'>043965548X</isbn>
  <isbn record='5804511'>8498386969</isbn>
  <isbn record='4132282'>9780780622274</isbn>
  <isbn record='1530458'>9788478885190</isbn>
  <isbn record='2003291'>0736650962</isbn>
  <isbn record='1993002'>8478885196</isbn>
  <isbn record='1187595'>97804395554923</isbn>
  <isbn record='4591175'>8478885196</isbn>
  <isbn record='5676282'>0807282324</isbn>
  <isbn record='2363352'>8478885196</isbn>
  <isbn record='2315122'>1480614998</isbn>
  <isbn record='2304130'>8478886559</isbn>
  <isbn record='2043258'>9780606323475</isbn>
</idlist>
```
Records

Record formats

First, determine which format you’d like to receive data in. To see the available formats for bibliographic records, visit

http://<hostname>/opac/extras/supercat/formats/record

Similarly, authority record formats can be found at http://libcat.linnbenton.edu/opac/extras/supercat/formats/authority and metarecord formats can be found at http://libcat.linnbenton.edu/opac/extras/supercat/formats/metarecord

For example, http://gapines.org/opac/extras/supercat/formats/authority shows that the Georgia Pines catalog can return authority records in the formats opac, marc21, marc21-full, and marc21-uris. Supercat also includes the MIME type of each format, and sometimes also refers to the documentation for a particular format.

<?xml version='1.0' encoding='UTF-8' ?>
<formats>
  <format>
    <name>opac</name>
    <type>text/html</type>
  </format>
  <format>
    <name>marc21</name>
    <type>application/xml</type>
    <docs>http://www.loc.gov/marc/</docs>
  </format>
  <format>
    <name>marc21-full</name>
    <type>application/xml</type>
    <docs>http://www.loc.gov/marc/</docs>
  </format>
  <format>
    <name>marc21-uris</name>
    <type>application/xml</type>
    <docs>http://www.loc.gov/marc/</docs>
  </format>
</formats>

atom-full is currently the only format that includes holdings and availability data for a given bibliographic record.

Retrieve records

You can retrieve records using URLs in the following format:

http://<hostname>/opac/extras/supercat/retrieve/<format>/<record-type>/<record-ID>

For example, http://gapines.org/opac/extras/supercat/retrieve/mods/record/33333 returns the following record.

<?xml version="1.0"?>
<modsCollection xmlns="http://www.loc.gov/mods/" xmlns:mods="http://www.loc.gov/mods/" version="3.0">
Chapter 162. Using Supercat

Report errors in this documentation using Launchpad.
Recent records

SuperCat can return feeds of recently edited or created authority and bibliographic records:

http://<hostname>/opac/extras/feed/freshmeat/<feed-type>/<record-type>/<import-or-edit>/<limit>/<date>

Note the following features:

• The limit records imported or edited following the supplied date will be returned. If you do not supply a date, then the most recent limit records will be returned.

• If you do not supply a limit, then up to 10 records will be returned.

• feed-type can be one of atom, html, htmlholdings, marcxml, mods, mods3, or rss2.


Filtering by Org Unit

You can generate a similar list, with the added ability to limit by Org Unit, using the item-age browse axis.

To produce an RSS feed by item date rather than bib date, and to restrict it to a particular system within a consortium:

Example: http://gapines.org/opac/extras/browse/atom/item-age/ARL-BOG/1/10

Note the following:

• ARL-BOG should be the short name of the org unit you’re interested in

• 1 is the page (since you are browsing through pages of results)

• 10 is the number of results to return per page

Modifying the atom portion of the URL to atom-full will include catalog links in the results:

Example: http://gapines.org/opac/extras/browse/atom-full/item-age/ARL-BOG/1/10

Modifying the atom portion of the URL to html-full will produce an HTML page that is minimally formatted:

Example: http://gapines.org/opac/extras/browse/html-full/item-age/ARL-BOG/1/10

Additional Filters

If you’d like to limit to a particular status, you can append ?status=0 where 0 is the ID number of the status you’d like to limit to. If a number of statuses, you can append multiple status parameters (for example, ?status=0&status=1 will limit to items with a status of either 0 or 1).
Limiting to status is a good way to weed out on-order items from your feeds.

You can also limit by item location (\texttt{?copyLocation=227} where 227 is the ID of your item location).
Chapter 163. Using UnAPI

URL format

Evergreen’s unAPI support includes access to many record types. For example, the following URL would fetch bib 267 in MODS32 along with holdings, volume, copy, and record attribute information:

https://example.org/opac/extras/unapi?
id=tag::U2@bre/267{holdings_xml,acn,acp,mra}&format=mods32

To access the new unAPI features, the unAPI ID should have the following form:

- `tag::U2@`
- followed by class name, which may be
  - `bre` (bibs)
  - `biblio_record_entry_feed` (multiple bibs)
  - `acl` (copy locations)
  - `acn` (volumes)
  - `acnp` (call number prefixes)
  - `acns` (call number suffixes)
  - `acp` (copies)
  - `acpn` (copy notes)
  - `aou` (org units)
  - `ascecm` (copy stat cat entries)
  - `auri` (located URIs)
  - `bmp` (monographic parts)
  - `cbs` (bib sources)
  - `ccs` (copy statuses)
  - `circ` (loan checkout and due dates)
  - `holdings_xml` (holdings)
  - `mmr` (metarecords)
  - `mmr_holdings_xml` (metarecords with holdings)
• **mmr_mra** (metarecords with record attributes)
• **mra** (record attributes)
• **sbsum** (serial basic summaries)
• **sdist** (serial distributions)
• **siss** (serial issues)
• **sisum** (serial index summaries)
• **sitem** (serial items)
• **sssum** (serial supplement summaries)
• **sstr** (serial streams)
• **ssub** (serial subscriptions)
• **sunit** (serial units)

• followed by /

• followed by a record identifier (or in the case of the **biblio_record_entry_feed** class, multiple IDs separated by commas)

• followed, optionally, by limit and offset in square brackets

• followed, optionally, by a comma-separated list of "includes" enclosed in curly brackets. The list of includes is the same as the list of classes with the following addition:
  
  • **bre.extern** (information from the non-MARC parts of a bib record)

• followed, optionally, by / and org unit; ":-:" signifies the top of the org unit tree

• followed, optionally, by / and org unit depth

• followed, optionally, by / and a path. If the path is **barcode** and the class is **acp**, the record ID is taken to be a copy barcode rather than a copy ID; for example, in **tag::U2@acp/ACQ140{acn,bre,mra}/-0/barcode**, ACQ140 is meant to be a copy barcode.

• followed, optionally, by **&format=** and the format in which the record should be retrieved. If this part is omitted, the list of available formats will be retrieved.
Chapter 164. Using Opensearch as a developer

Introduction

Evergreen responds to OpenSearch requests. This can be a good way to get search results delivered in a format that you prefer.

Throughout this section, replace <hostname> with the domain or subdomain of your Evergreen installation to try these examples on your own system.

Opensearch queries will be in the format http://<hostname>/opac/extras/opensearch/1.1/-/html-full?searchTerms=item_type(r)&searchClass=keyword&count=25

In this example,

• html-full is the format you would like. html-full is a good view for troubleshooting your query.

• searchTerms is a url-encoded search query. You can use limiters in the limiter(value) format. For example, you can use a query like item_lang(spa)

• count is the number of results per page. The default is 10, and the maximum is 25.

Other options include:

• searchSort and searchSortDir, which can be used to display the results in a different order (e.g. for an RSS feed).
Appendix A. Attributions

Copyright © 2009-2018 Evergreen DIG
Copyright © 2007-2018 Equinox
Copyright © 2007-2018 Dan Scott
Copyright © 2009-2018 BC Libraries Cooperative (SITKA)
Copyright © 2008-2018 King County Library System
Copyright © 2009-2018 Pioneer Library System
Copyright © 2009-2018 PALS
Copyright © 2009-2018 Georgia Public Library Service
Copyright © 2008-2018 Project Conifer
Copyright © 2009-2018 Bibliomation
Copyright © 2008-2018 Evergreen Indiana
Copyright © 2008-2018 SC LENDS
Copyright © 2012-2018 CW MARS

DIG Contributors

• Hilary Caws-Elwitt, Susquehanna County Library
• Karen Collier, Kent County Public Library
• George Duimovich, NRCan Library
• Lynn Floyd, Anderson County Library
• Sally Fortin, Equinox Software
• Wolf Halton, Lyrasis
• Jennifer Pringle, SITKA
• June Rayner, eiNetwork
• Steve Sheppard
• Ben Shum, Bibliomation
• Roni Shwaish, eiNetwork
• Robert Soulliere, Mohawk College
• Remington Steed, Calvin College
• Jeanette Lundgren, CW MARS
• Tim Spindler, CW MARS
• Jane Sandberg, Linn-Benton Community College
• Lindsay Stratton, Pioneer Library System
• Yamil Suarez, Berklee College of Music
• Jenny Turner, PALS
Appendix B. Licensing

This work is licensed under a Creative Commons Attribution-ShareAlike 3.0 Unported License.
Appendix C. Admonitions

• Note

• warning

• caution

• tip
Index

A
accounts, 243, 243
acquisitions
claiming, 239
currency types, 241
distribution formulas
templates, 242
EDI
accounts, 243
messages, 248
exchange rates, 248
funding sources, 251
funds, 252
fiscal rollover, 255
reports, 254
tags, 250
invoices, 256, 433
electronic, 441
searching for lineitems, 435
line item
cancellation, 238
lineitems
adding, 435
searching for, 435
line items, 257
MARC federated search, 249
permissions, 238
purchase order
cancellation, 238
Acquisitions
Library Settings Editor, 339
acquisitions cost, 537
action triggers
event definitions
notifications, 395
activating, 534, 534
active date, 534
adding, 435
adding data sources, 735
address alerts, 382
advanced search
exclude electronic resources, 754
expert search, 756
limit to available, 754
numeric search, 756
search filters, 755
search library, 754
sort results, 754
Age Protection, 261
aggregate filters, 721
Alerts, 667
AND operator, 757
Apache, 87
applying filters, 721
aggregate filters, 721
base filter, 721, 721
audiobooks, 752
authentication
LDAP, 170
proxy, 170
author, 752
authority control, 803
authors, 760
Automated Circulation System, 183
Automated Material Handling, 183
Automated Material Handling (AMH), 192
availability, 761
B
Barcode Completion
Lazy Circ, 386
barring, 666, 666
base filter, 721, 721
bib call number, 752
blocking, 666
Booking
Library Settings Editor, 341
books, 752
boolean, 757
C
call numbers
editing, 537
cancellation, 238, 238
Cataloging
Library Settings Editor, 341
checkout, 226
choosing reports fields, 711
Circulation
Library Settings Editor, 343
circulation
recalls
hold-driven, 394
claiming, 239
cloning, 734
Column Picker, 218
configuration, 222, 222, 222
configuration files
  oils_sip.xml, 183, 184
configuring, 300, 316
copies, 534
  activating, 534
  editing, 537
copy editor
  shelving location, 222
copy number, 537
count, 743
creating, 709
creating templates, 711
  choosing reports fields, 711
Credit Card Processing
  Library Settings Editor, 352
currency types, 241

database schema, 87, 736
Data Types
  Library Settings Editor, 380
data types, 741
Debian, 86
details, 763
distribution formulas
  templates, 242

EDI
  accounts, 243, 243
  messages, 248, 248
editing, 537, 537, 537, 537
electronic, 441
event definitions
  notifications, 395
Excel, 731
exchange rates, 248
exclude electronic resources, 754
expert search, 756
Exporting
  Library Settings Editor, 338
exporting
  using the command line, 803
exporting templates, 746

F
facets: subjects
  authors, 760
  fieldmapper, 737
  field transform, 714
  field transforms, 742
    count, 743
    output type, 743, 743, 743
    raw data, 743
    raw distinct, 743
Finances
  Library Settings Editor, 354
  fiscal rollover, 255
Fixed fields, 300
fm_IDL.xml, 735, 737
folders, 709
  creating, 709
  managing, 710
fonts
  zooming, 222
footers, 215, 216, 535, 535
formats
  audiobooks, 752
  books, 752
  music, 752
  video, 752
funding sources, 251
funds, 252, 254
  fiscal rollover, 255
reports, 254
tags, 250

generating, 726
Global
  Library Settings Editor, 364
  going back, 766
Graphic User Interface
  Library Settings Editor, 357
GUI
  Library Settings Editor, 357

H
headers, 215, 216, 535, 535
hold-driven, 394
hold-driven recalls, 394
Holds, 261
  Age Protection, 261
  Library Settings Editor, 365
hotkeys, 223
I
Importing
  Library Settings Editor, 338
importing
    using the command line, 805, 806
    using the staff client, 497
invoices, 256, 433
    electronic, 441
    searching for lineitems, 435
item labels, 535, 535
items, 534
    activating, 534
    editing, 537

J
journal title, 752

K
keyword, 752

L
Lazy Circ, 386
LDAP, 170
Library
  Library Settings Editor, 368
library cards
    renewing, 662
    replacing, 664
limit to available, 754
line item
    cancellation, 238
lineitems
    adding, 435
    searching for, 435
line items, 257
Linux
  Debian, 86
  Ubuntu, 86
logging in, 213
logging out, 213

M
macros, 226
magnetic media, 191
managing, 710
marc_export, 803
marc2are.pl, 805
MARC editor
  configuring, 300, 316
MARC federated search, 249
MARC records
  exporting
    using the command line, 803
  importing
    using the command line, 805, 806
    using the staff client, 497
messages, 248, 248, 667
music, 752

N
Notes, 669
notifications, 395
NOT operator, 757
numeric search, 756

O
Offline
  Library Settings Editor, 373
oils_sip.xml, 183, 184
OPAC, 752
  Library Settings Editor, 370
order of results, 759
OR operator, 757
output, 731
  Excel, 731
  spreadsheet, 731
  tabular, 731
output type, 743, 743, 743

P
passwords, 665
Patron Registration Settings
  Library Settings Editor, 357
patrons
  Alerts, 667
  barring, 666, 666
  blocking, 666
  messages, 667
Notes, 669
passwords, 665
purchase requests, 455
registering, 658
retrieving recent, 658
searching for, 656
  updating, 661
permissions, 238
pg_loader.pl, 805
Physical characteristics wizard, 316
placing holds, 764
pocket labels, 535
Populate Address by ZIP Code
  ZIP code, 175
PostgreSQL, 735, 735
printers, 224
printing
  footers, 215, 216, 535, 535
  headers, 215, 216, 535, 535
  item labels, 535
  spine labels, 535
print templates, 226, 226
Program
  Library Settings Editor, 373
proxy, 170
purchase order
  cancellation, 238
purchase requests, 455, 456

R
raw data, 743
raw distinct, 743
recalls
  hold-driven, 394
receipt template editor, 226, 226
  checkout, 226
  macros, 226
Receipt Templates
  Library Settings Editor, 375
recurring, 740
registering, 658
registering a workstation, 213
renewing, 662
replacing, 664
reporter
  starting, 707
  starting daemon, 707
  stopping daemon, 707
reports, 254
  adding data sources, 735
  applying filters, 721
    aggregate filters, 721
    base filter, 721, 721
  cloning, 734
  creating templates, 711
    choosing reports fields, 711
data types, 741
exporting templates, 746
field transform, 714
field transforms, 742
  count, 743
  output type, 743, 743, 743
  raw data, 743
  raw distinct, 743
folders, 709
  creating, 709
  managing, 710
funds, 254
generating, 726
output, 731
  Excel, 731
  spreadsheet, 731
  tabular, 731
recurring, 740
starting server application, 707
stopping server application, 707
report sources, 737
retrieving recent, 658

S
search
  AND operator, 757
  author, 752
  bib call number, 752
  boolean, 757
  journal title, 752
  keyword, 752
  NOT operator, 757
  order of results, 759
  OR operator, 757
  series, 752
  stemming, 759
  stop words, 757
  subject, 752
  title, 752
  truncation, 757
search box, 752
search filters, 755
searching for, 435, 656
searching for lineitems, 435
search library, 754
search results, 759
  availability, 761
details, 763
facets: subjects
  authors, 760
going back, 766
placing holds, 764
viewing a record, 762
Security
  Library Settings Editor, 376
SelfCheck, 183, 189
Self Check
  Library Settings Editor, 378
series, 752
shelving location, 222
SIP, 185, 186, 188
SIP Communication, 188
SIP Server
  SIP Communication, 188
SMS Settings
  Library Settings Editor, 375
sort results, 754
sounds, 222
spine labels, 535, 535
spreadsheet, 731
SQL, 735
staff client
  configuration, 222
  fonts
    zooming, 222
hotkeys, 223
logging in, 213
logging out, 213
printers, 224
registering a workstation, 213
sounds, 222
starting, 707
starting daemon, 707
starting server application, 707
stemming, 759
stopping daemon, 707
stopping server application, 707
stop words, 757
subject, 752
syslog, 185
syslog-NG, 186

T
  tabular, 731
tags, 250
templates, 242

Text Messaging
  Library Settings Editor, 375
title, 752
truncation, 757

U
Ubuntu, 86
updating, 661
using the command line, 803, 805, 806
using the staff client, 497

V
Vandelay
  Library Settings Editor, 380
video, 752
viewing a record, 762
volumes
  editing, 537

W
web client
  print templates, 226
  receipt template editor, 226
workstation
  configuration, 222

Z
  ZIP code, 175
zips.txt
    Populate Address by ZIP Code
      ZIP code, 175
zooming, 222